# Table of Contents

## 1 Introduction .................................................................................................................. 1
   About ModelVision ........................................................................................................ 1
   About this Manual ........................................................................................................ 2

## 2 Installing ModelVision .................................................................................................. 3
   Computer Hardware Requirements.................................................................................. 3
   Installing ModelVision.................................................................................................. 3
       Installing from the Web.............................................................................................. 3
       Installation Folders..................................................................................................... 4
   Licensing......................................................................................................................... 4
       Licensing Procedures................................................................................................. 4
       Installing a Hard-disk License for the First Time ...................................................... 4
       Upgrading an Existing License.................................................................................. 5
       Transferring a Hard-Disk License ............................................................................. 5
       Displaying License Information ............................................................................... 7
   Troubleshooting ............................................................................................................. 7

## 3 Getting Started .............................................................................................................. 8
   Introduction and Guidelines............................................................................................ 8
   Using the Tutorials .......................................................................................................... 9
   Starting and Closing ModelVision .................................................................................. 9

## 4 Getting Help .................................................................................................................... 11
   Online Help..................................................................................................................... 11
   User Guide...................................................................................................................... 11
   Tutorials.......................................................................................................................... 11
   Technical Support and Updates...................................................................................... 12
   Using Adobe Reader........................................................................................................ 12

## 5 Understanding the Interface .......................................................................................... 13
   Main Menu...................................................................................................................... 13
       File Menu.................................................................................................................. 14
       Edit Menu............................................................................................................... 15
       View Menu............................................................................................................ 15
       Layout Menu.......................................................................................................... 15
       Model Menu........................................................................................................... 15
       Filters Menu........................................................................................................... 17
       Utility Menu........................................................................................................... 17
       Tools Menu............................................................................................................ 18
       Modules Menu........................................................................................................ 19
       Window Menu......................................................................................................... 19
       Help Menu.............................................................................................................. 19
   Toolbars........................................................................................................................ 20
       View Control Tools................................................................................................. 20
       Body Creation and Editing Tools.............................................................................. 21
       Computation Tools................................................................................................... 21
       Utility Tools............................................................................................................ 22
       Modelling Tools...................................................................................................... 23
6 Managing Projects and Data Files ................................................. 26

About Projects and Session Files .................................................. 26
Creating, Saving, and Restoring Sessions ........................................ 26
AutoSave ................................................................. 27
Importing, Exporting, and Linking Data Files .................................... 27
Importing Data ........................................................................... 28
Profile Data .............................................................................. 29
General ASCII Data .................................................................. 29
Drillhole Data .......................................................................... 29
Geosoft Database ...................................................................... 30
ASEG GDF Data Exchange Standard ......................................... 30
Point Data ............................................................................. 30
Grids .................................................................................... 30
Exporting Models and Data .......................................................... 31
Profile Export .......................................................................... 31
Grid Export ............................................................................ 31
Drillhole Data Export ................................................................ 32
Point Data Export .................................................................... 32
DXF Export ............................................................................. 32
External Links ........................................................................... 33
Reading Directly from External Files with ModelVision ............... 33
Writing Directly to External Files with ModelVision .................... 33
Displaying ModelVision Data in Discover PA ............................... 33
Data Management ........................................................................ 35
Maintaining Data Sets .................................................................. 35
Using the Clip Grid Tool ............................................................. 38
Using the Clip Project Tool .......................................................... 38
Direct Targeting Workflow ............................................................ 39
Before You Run the Target Wizard ............................................. 40
Target Wizard .......................................................................... 41
The Target Workspace ............................................................... 42
Modelling and Inversion ............................................................. 45
Target Feature Maintenance ........................................................ 47
Project Settings ........................................................................... 48
Project Directory ........................................................................ 49
Units ...................................................................................... 50
Magnetic Field Specification ....................................................... 51
IGRF Calculator ....................................................................... 52
IGRF Grid Creator ..................................................................... 53
Generating IGRF Grids .............................................................. 53
Using an Existing Grid .............................................................. 53
Using an Elevation Grid ............................................................ 53
Map Projections and Datums ....................................................... 54
Project Description ................................................................. 54
Default Settings ....................................................................... 54
Default Settings File ................................................................. 55

7 Controlling the View ..................................................................... 56

Managing Windows ..................................................................... 56
Navigating the View ................................................................. 57
Panning and Zooming ............................................................... 57
Zoom Mode ............................................................................... 57
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zooming In and Out</td>
<td>57</td>
</tr>
<tr>
<td>Vertical Scale</td>
<td>58</td>
</tr>
<tr>
<td>Zoom Previous</td>
<td>58</td>
</tr>
<tr>
<td>Pan Mode</td>
<td>58</td>
</tr>
<tr>
<td>Pan</td>
<td>59</td>
</tr>
<tr>
<td>Fit</td>
<td>59</td>
</tr>
<tr>
<td>Redraw</td>
<td>59</td>
</tr>
<tr>
<td>Interrupt Redraw</td>
<td>59</td>
</tr>
<tr>
<td>Map Linking</td>
<td>59</td>
</tr>
<tr>
<td>Using the Colour Table Editor</td>
<td>62</td>
</tr>
<tr>
<td>Creating or Editing a Colour Look-up Table</td>
<td>63</td>
</tr>
<tr>
<td>Selecting Objects</td>
<td>64</td>
</tr>
<tr>
<td>View Types</td>
<td>65</td>
</tr>
<tr>
<td>Custom Tiling and Scaling</td>
<td>67</td>
</tr>
<tr>
<td>Cross-section View</td>
<td>72</td>
</tr>
<tr>
<td>Opening a Cross-section View</td>
<td>73</td>
</tr>
<tr>
<td>Cross-section Controls</td>
<td>73</td>
</tr>
<tr>
<td>StatWatch</td>
<td>83</td>
</tr>
<tr>
<td>Export Cross-sections as Georeferenced Images</td>
<td>83</td>
</tr>
<tr>
<td>Map View</td>
<td>84</td>
</tr>
<tr>
<td>Configuring Map Displays</td>
<td>86</td>
</tr>
<tr>
<td>AutoMag Points</td>
<td>91</td>
</tr>
<tr>
<td>Body Labels</td>
<td>92</td>
</tr>
<tr>
<td>BMP Backdrops</td>
<td>95</td>
</tr>
<tr>
<td>Drillhole Displays</td>
<td>96</td>
</tr>
<tr>
<td>Vector Presentations</td>
<td>98</td>
</tr>
<tr>
<td>Drillhole Vector Map</td>
<td>98</td>
</tr>
<tr>
<td>ERV Backdrop</td>
<td>99</td>
</tr>
<tr>
<td>Grid Contour</td>
<td>99</td>
</tr>
<tr>
<td>Grid Images</td>
<td>102</td>
</tr>
<tr>
<td>Grid Profiles</td>
<td>105</td>
</tr>
<tr>
<td>Legend Box</td>
<td>106</td>
</tr>
<tr>
<td>Regional Fix Points</td>
<td>106</td>
</tr>
<tr>
<td>North Arrow</td>
<td>106</td>
</tr>
<tr>
<td>Points Set</td>
<td>107</td>
</tr>
<tr>
<td>Polygon Boundary</td>
<td>109</td>
</tr>
<tr>
<td>Profile Vectors</td>
<td>109</td>
</tr>
<tr>
<td>Stacked Profiles</td>
<td>111</td>
</tr>
<tr>
<td>Title Block</td>
<td>112</td>
</tr>
<tr>
<td>Export Maps to Georeferenced Images (.EGB)</td>
<td>112</td>
</tr>
<tr>
<td>Bodies</td>
<td>113</td>
</tr>
<tr>
<td>Perspective View</td>
<td>113</td>
</tr>
<tr>
<td>3D Grids</td>
<td>114</td>
</tr>
<tr>
<td>Perspective Drillhole Display</td>
<td>117</td>
</tr>
<tr>
<td>Profile Vectors</td>
<td>118</td>
</tr>
<tr>
<td>AutoMag and Standard Points</td>
<td>120</td>
</tr>
<tr>
<td>Multi-Track View</td>
<td>122</td>
</tr>
<tr>
<td>Opening a Multi-track Window</td>
<td>122</td>
</tr>
<tr>
<td>Functional Elements of a Multi-Track Display</td>
<td>124</td>
</tr>
<tr>
<td>Hole View</td>
<td>128</td>
</tr>
<tr>
<td>Opening a Drill Log Window</td>
<td>128</td>
</tr>
<tr>
<td>Functional Elements of a Drill Log Display</td>
<td>131</td>
</tr>
<tr>
<td>Spreadsheet Table</td>
<td>131</td>
</tr>
<tr>
<td>Tracks</td>
<td>131</td>
</tr>
<tr>
<td>Channels within Tracks</td>
<td>132</td>
</tr>
<tr>
<td>Reference Track</td>
<td>133</td>
</tr>
<tr>
<td>Page Layout View</td>
<td>134</td>
</tr>
</tbody>
</table>
Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Extents of Strata Bodies</td>
<td>188</td>
</tr>
<tr>
<td>Considerations for Defining Strata Models</td>
<td>188</td>
</tr>
<tr>
<td>Converting Point Attributes to Models</td>
<td>189</td>
</tr>
<tr>
<td>Testing Response with Synthetic Data</td>
<td>191</td>
</tr>
<tr>
<td>Synthetic Lines</td>
<td>192</td>
</tr>
<tr>
<td>Synthetic Drillholes</td>
<td>194</td>
</tr>
<tr>
<td>Graphical Drillhole Design</td>
<td>194</td>
</tr>
<tr>
<td>Specific Drillhole Design</td>
<td>195</td>
</tr>
<tr>
<td>Synthetic Grid</td>
<td>195</td>
</tr>
<tr>
<td>Displaying Curves and Tracks</td>
<td>196</td>
</tr>
<tr>
<td>Adding Curves</td>
<td>196</td>
</tr>
<tr>
<td>Displaying Responses</td>
<td>197</td>
</tr>
<tr>
<td>Enclosed Bodies</td>
<td>198</td>
</tr>
<tr>
<td>Drillhole Modelling</td>
<td>199</td>
</tr>
<tr>
<td>Defining a Drillhole</td>
<td>199</td>
</tr>
<tr>
<td>Importing Drillhole Data</td>
<td>199</td>
</tr>
<tr>
<td>Using Synthetic Drillholes</td>
<td>200</td>
</tr>
<tr>
<td>Modelling Downhole Data</td>
<td>200</td>
</tr>
<tr>
<td>Input and Output Channel Entries</td>
<td>201</td>
</tr>
<tr>
<td>Use Sensor Z Channel</td>
<td>201</td>
</tr>
<tr>
<td>Select Holes</td>
<td>202</td>
</tr>
<tr>
<td>Drill Log Displays</td>
<td>203</td>
</tr>
<tr>
<td>Drill Log User Interaction</td>
<td>206</td>
</tr>
<tr>
<td>Resample from Hole</td>
<td>206</td>
</tr>
<tr>
<td>Point Modelling</td>
<td>208</td>
</tr>
<tr>
<td>Hints and Modelling Tips</td>
<td>209</td>
</tr>
<tr>
<td>Manipulating Models to Fit the Data</td>
<td>209</td>
</tr>
<tr>
<td>Optimizing Computations While Modelling</td>
<td>210</td>
</tr>
<tr>
<td>Finalizing a Model</td>
<td>210</td>
</tr>
<tr>
<td>3D Model Generator</td>
<td>210</td>
</tr>
<tr>
<td>3D Extrusion Wizard</td>
<td>211</td>
</tr>
<tr>
<td>Synthetic Body Array</td>
<td>216</td>
</tr>
<tr>
<td>Defining Reference Point Extents</td>
<td>218</td>
</tr>
<tr>
<td>Body Position (Map View Only)</td>
<td>220</td>
</tr>
<tr>
<td>Body Parameters</td>
<td>220</td>
</tr>
<tr>
<td>Depth to Basement Model Example</td>
<td>220</td>
</tr>
<tr>
<td>Magnetic Source Example</td>
<td>222</td>
</tr>
<tr>
<td>Body Array Colour Modulation</td>
<td>223</td>
</tr>
<tr>
<td>Introductory Modelling Tutorial</td>
<td>226</td>
</tr>
<tr>
<td>Setting Up the Tutorial</td>
<td>226</td>
</tr>
<tr>
<td>Background</td>
<td>227</td>
</tr>
<tr>
<td>Step-by-Step</td>
<td>227</td>
</tr>
</tbody>
</table>

9 Working with Models ........................................................................ 235

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Models</td>
<td>235</td>
</tr>
<tr>
<td>Model Types</td>
<td>236</td>
</tr>
<tr>
<td>Importing Models</td>
<td>237</td>
</tr>
<tr>
<td>Checking the Integrity of Imported DXF Models</td>
<td>238</td>
</tr>
<tr>
<td>Input File</td>
<td>238</td>
</tr>
<tr>
<td>List View</td>
<td>239</td>
</tr>
<tr>
<td>Surface</td>
<td>239</td>
</tr>
<tr>
<td>Global</td>
<td>239</td>
</tr>
<tr>
<td>Rendering</td>
<td>240</td>
</tr>
<tr>
<td>3D View Controls</td>
<td>240</td>
</tr>
<tr>
<td>Exporting Models</td>
<td>241</td>
</tr>
<tr>
<td>Modelling Tools</td>
<td>242</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Using the Active Line Tool</td>
<td>243</td>
</tr>
<tr>
<td>Using the Traverse Tool</td>
<td>243</td>
</tr>
<tr>
<td>Using the Next Line Tool</td>
<td>244</td>
</tr>
<tr>
<td>Using the Active Points Tool</td>
<td>244</td>
</tr>
<tr>
<td>Potential Field Modelling Controls</td>
<td>248</td>
</tr>
<tr>
<td>Data Compression</td>
<td>248</td>
</tr>
<tr>
<td>Differential Mode</td>
<td>249</td>
</tr>
<tr>
<td>Inversion</td>
<td>249</td>
</tr>
<tr>
<td>Line Control</td>
<td>249</td>
</tr>
<tr>
<td>Grid Control</td>
<td>249</td>
</tr>
<tr>
<td>Edit Regional</td>
<td>250</td>
</tr>
<tr>
<td>Magnetic Field</td>
<td>250</td>
</tr>
<tr>
<td>Gravity and Magnetic Components</td>
<td>250</td>
</tr>
<tr>
<td>Defaults</td>
<td>250</td>
</tr>
<tr>
<td>Profile Modelling Controls</td>
<td>250</td>
</tr>
<tr>
<td>Line Controls</td>
<td>251</td>
</tr>
<tr>
<td>Grid Controls</td>
<td>254</td>
</tr>
<tr>
<td>Drillhole Controls</td>
<td>255</td>
</tr>
<tr>
<td>Point Controls</td>
<td>256</td>
</tr>
<tr>
<td>Regional Field Controls</td>
<td>257</td>
</tr>
<tr>
<td>Using a Regional Field</td>
<td>257</td>
</tr>
<tr>
<td>Computing a Regional Surface</td>
<td>259</td>
</tr>
<tr>
<td>Magnetic Field Controls</td>
<td>262</td>
</tr>
<tr>
<td>IGRF Calculator</td>
<td>262</td>
</tr>
<tr>
<td>Remanence</td>
<td>263</td>
</tr>
<tr>
<td>Demagnetisation</td>
<td>263</td>
</tr>
<tr>
<td>Full Tensor Magnetic Gradiometer Computation</td>
<td>264</td>
</tr>
<tr>
<td>Enabling Magnetic Tensor Computations</td>
<td>264</td>
</tr>
<tr>
<td>Computing Magnetic Field Tensor Components</td>
<td>264</td>
</tr>
<tr>
<td>The Magnetic Field Gradient Tensor</td>
<td>265</td>
</tr>
<tr>
<td>Magnetic Gradiometer Units</td>
<td>265</td>
</tr>
<tr>
<td>Working with Magnetic Field Tensor Computations</td>
<td>265</td>
</tr>
<tr>
<td>Full Tensor Gravity Gradiometer Computation</td>
<td>266</td>
</tr>
<tr>
<td>Enabling Gravity Tensor Computations</td>
<td>266</td>
</tr>
<tr>
<td>Computing Tensor Components</td>
<td>266</td>
</tr>
<tr>
<td>The Gravity Gradient Tensor</td>
<td>267</td>
</tr>
<tr>
<td>Gravity Gradiometer Units</td>
<td>267</td>
</tr>
<tr>
<td>Working with Gravity Tensor Computations</td>
<td>267</td>
</tr>
<tr>
<td>Examples of Gravity Tensor Computations</td>
<td>268</td>
</tr>
<tr>
<td>Default Model Parameters</td>
<td>269</td>
</tr>
<tr>
<td>Model Parameters</td>
<td>270</td>
</tr>
<tr>
<td>Cross-section Defaults</td>
<td>271</td>
</tr>
<tr>
<td>Inversion</td>
<td>272</td>
</tr>
<tr>
<td>About Potential Field Data Inversion</td>
<td>272</td>
</tr>
<tr>
<td>Inversion Techniques</td>
<td>273</td>
</tr>
<tr>
<td>Quick Inversion</td>
<td>274</td>
</tr>
<tr>
<td>Creating the Seed Body</td>
<td>275</td>
</tr>
<tr>
<td>Improving the Fit</td>
<td>276</td>
</tr>
<tr>
<td>Auto Mode Inversion</td>
<td>276</td>
</tr>
<tr>
<td>Manual Adjustment of Body Parameters</td>
<td>277</td>
</tr>
<tr>
<td>Restoring Previous Models</td>
<td>277</td>
</tr>
<tr>
<td>Manual Mode Inversion</td>
<td>277</td>
</tr>
<tr>
<td>Modelling Other Anomalies</td>
<td>277</td>
</tr>
<tr>
<td>Data and Body Selection</td>
<td>277</td>
</tr>
<tr>
<td>Regional Removal</td>
<td>278</td>
</tr>
</tbody>
</table>
Table of Contents

Local Regional ................................................................. 278
Regional Extent .......................................................... 279
Inversion on First Vertical Derivative ............................... 279
General 3D Inversion ...................................................... 279
Inversion Strategies ....................................................... 280
Treatment of Regional Fields ........................................... 281
Limitations ...................................................................... 281
Inversion Controls ......................................................... 282
The Inversion Toolbar ..................................................... 282
Inversion Progress Bar .................................................... 284
Standard Inversion Data Control ................................. 284
Joint Inversion Data Control ............................................ 285
Using Joint Inversion for Single Channel Data ................. 286
Configure Standard Inversion ......................................... 287
Configure Joint Inversion ................................................ 288
Free Parameters in Inversions ......................................... 290
Inversion Tolerances ..................................................... 292
Inversion Constraint Parameters Spreadsheet ................. 293
Setting Vertex Tolerances Graphically ............................ 294
Remanence Inversion ..................................................... 295
Remanence as an Exploration Parameter ....................... 296
Geological Parameters from Remote Remanence Detection 296
An Exploration Definition for Remanence ...................... 297
Physical Expressions of Remanence Maps ..................... 298
Remanent Inversion ....................................................... 301
Specifying the Remanent Magnetisation ......................... 302
Inverting on Resultant Magnetisation ............................. 303
Remanence Inversion Test Session ................................. 305
Remanence Calculator ................................................... 306
Theory .......................................................................... 307
ModelVision Procedure ................................................ 309
The Remanence Calculator Dialog ................................. 310
Initial setup for Remanence Calculator dialog ................ 311
Anomaly Analysis Steps ............................................... 311
Removal of Regional Magnetic Field .............................. 314
Export Remanence Results ........................................... 314
Work Tips ...................................................................... 316
Joint Inversion .............................................................. 318
Joint Inversion Limits .................................................... 318
Theory .......................................................................... 319
Performing an Inversion ............................................... 321
Selecting the Data ........................................................ 321
Selecting Free Parameters ............................................ 322
Controlling Parameter Variation .................................... 322
Running the Inversion .................................................. 323

11 Page Layout .............................................................. 324
The Layout Window ........................................................ 324
Creating a New Layout ................................................... 325
Setting Page Size .......................................................... 326
Adding Map Frames ....................................................... 326
Creating a Frame ........................................................... 327
Moving and Resizing Frames ........................................... 330
Changing Layout Properties ......................................... 331
Controlling the Redraw Speed ....................................... 331
Zooming In and Out ..................................................... 331
Adding Text and Drawing Objects ................................................................. 332
Drawing Operations ...................................................................................... 332
Drawing Tools .............................................................................................. 332
Adding and Editing Text .............................................................................. 334
Editing Multiple Text Objects ..................................................................... 335
Changing the Display Order ....................................................................... 335
Aligning Objects ........................................................................................... 335
Saving a Layout ............................................................................................. 336

12 Using Filters ............................................................................................ 337
About Filters ................................................................................................ 337
Convolution Filters ....................................................................................... 338
Convolution Filter Operation ..................................................................... 340
FFT Filters .................................................................................................... 342
In-Line Filters .............................................................................................. 344
Grid Filters .................................................................................................... 347
2-D Convolution Filters .............................................................................. 348
Grid Filter Tool ............................................................................................. 348
How to Use the Grid Filter Tool ................................................................. 349
Using the Preview Windows ....................................................................... 349
Grid Information ........................................................................................... 350
Altering Settings .......................................................................................... 351
Fill Holes Operation ..................................................................................... 352
Noise Generator ............................................................................................ 352
Normalised Source Strength ........................................................................ 352

13 Data Analysis and Processing ................................................................. 356
Computing New Channels ........................................................................... 356
Reserved Channel Names ............................................................................ 357
Errors ............................................................................................................. 358
Object Selection ........................................................................................... 358
Special Functions .......................................................................................... 358
GINT ............................................................................................................... 359
Axis Translation ........................................................................................... 360
Interpolating Values Along Lines and Drillholes ......................................... 361
Generating Grids from Channel Data .......................................................... 361
Gridding Fundamentals ................................................................................ 362
Initial surface generation ............................................................................ 362
Smoothing of the original surface ............................................................... 363
Reduction of the grid cell size ...................................................................... 363
Minimum curvature ..................................................................................... 364
Grid Computation Procedure ...................................................................... 365
Interpolating Channel Values from a Grid .................................................. 367
Manipulating Gridded Data ......................................................................... 367
Classify .......................................................................................................... 370
Clip ................................................................................................................ 371
Convert ......................................................................................................... 371
Create RGB .................................................................................................. 372
Curvature ....................................................................................................... 372
Edit ................................................................................................................. 373
Fill Holes ....................................................................................................... 374
Flip ............................................................................................................... 374
Merge .......................................................................................................... 374
Overlay ......................................................................................................... 375
Replace ......................................................................................................... 376
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reproject</td>
<td>376</td>
</tr>
<tr>
<td>Resample</td>
<td>377</td>
</tr>
<tr>
<td>Rotate</td>
<td>377</td>
</tr>
<tr>
<td>Shift</td>
<td>378</td>
</tr>
<tr>
<td>Split</td>
<td>378</td>
</tr>
<tr>
<td>Reporting and Statistics</td>
<td>378</td>
</tr>
<tr>
<td>Calculating Statistics</td>
<td>378</td>
</tr>
<tr>
<td>Project and Line Statistics</td>
<td>379</td>
</tr>
<tr>
<td>Drillhole Statistics</td>
<td>380</td>
</tr>
<tr>
<td>Point Statistics</td>
<td>380</td>
</tr>
<tr>
<td>Grid Statistics</td>
<td>380</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>380</td>
</tr>
<tr>
<td><strong>14 Graphical Output</strong></td>
<td>382</td>
</tr>
<tr>
<td>Printing</td>
<td>382</td>
</tr>
<tr>
<td>Print Scaling</td>
<td>382</td>
</tr>
<tr>
<td>Print Setup</td>
<td>384</td>
</tr>
<tr>
<td>Printer Error</td>
<td>384</td>
</tr>
<tr>
<td>Making a Movie</td>
<td>385</td>
</tr>
<tr>
<td><strong>15 UBC Model Mesh Designer (Optional Module)</strong></td>
<td>387</td>
</tr>
<tr>
<td>About UBC Software</td>
<td>387</td>
</tr>
<tr>
<td>Working with UBC Software</td>
<td>390</td>
</tr>
<tr>
<td>Installing UBC Software</td>
<td>390</td>
</tr>
<tr>
<td>Before You Start</td>
<td>391</td>
</tr>
<tr>
<td>Preparing Your Data</td>
<td>391</td>
</tr>
<tr>
<td>Subset a Project</td>
<td>392</td>
</tr>
<tr>
<td>Regional Modelling</td>
<td>392</td>
</tr>
<tr>
<td>Model Conditioning for UBC Inversion</td>
<td>394</td>
</tr>
<tr>
<td>UBC Mesh and Data File Creation</td>
<td>394</td>
</tr>
<tr>
<td>Mesh Design</td>
<td>395</td>
</tr>
<tr>
<td>Density Bounds</td>
<td>397</td>
</tr>
<tr>
<td>Data Outputs</td>
<td>398</td>
</tr>
<tr>
<td>GRAV3D and MAG3D Interface</td>
<td>399</td>
</tr>
<tr>
<td>Generated Files</td>
<td>400</td>
</tr>
<tr>
<td><strong>16 QuickDepth (Optional Module)</strong></td>
<td>401</td>
</tr>
<tr>
<td>About QuickDepth</td>
<td>401</td>
</tr>
<tr>
<td>Background Theory</td>
<td>402</td>
</tr>
<tr>
<td>Magnetic Tensor</td>
<td>402</td>
</tr>
<tr>
<td>Euler 2D Method</td>
<td>404</td>
</tr>
<tr>
<td>Peters’ Length Method</td>
<td>405</td>
</tr>
<tr>
<td>Werner Deconvolution Method</td>
<td>406</td>
</tr>
<tr>
<td>Tilt Depth Method</td>
<td>406</td>
</tr>
<tr>
<td>Euler 3D Method</td>
<td>407</td>
</tr>
<tr>
<td>Preparing Your Data</td>
<td>408</td>
</tr>
<tr>
<td>Line Data Channels</td>
<td>409</td>
</tr>
<tr>
<td>QuickDepth Depth Interpretation</td>
<td>411</td>
</tr>
<tr>
<td>Anomaly Selection</td>
<td>414</td>
</tr>
<tr>
<td>Depth Computation</td>
<td>415</td>
</tr>
<tr>
<td>Depth Statistics</td>
<td>416</td>
</tr>
<tr>
<td>Save Your Best Result</td>
<td>416</td>
</tr>
<tr>
<td>Save Other Results</td>
<td>418</td>
</tr>
</tbody>
</table>
17 AutoMag (Optional Module) .......................................................... 422

About AutoMag ................................................................. 422
AutoMag Overview ......................................................... 422
AutoMag Versus Other Methods .................................. 423
AutoMag Theory ............................................................. 423
Single Anomaly Tutorial .............................................. 424
Setup the Data ............................................................... 425
Set the Parameters ....................................................... 426
  Background Control .................................................... 426
  Operational Parameters ............................................ 428
  Anomaly Location ..................................................... 428
  Depth Estimation ...................................................... 431
  Use Quick Inversion to Estimate Parameters ............. 431
Run the Analysis ......................................................... 432
Display the Solution .................................................... 432
Modulate and Annotate the Solution ......................... 433
Test the Solution ......................................................... 434
Save Your Solutions .................................................... 434
AutoMag Controls ......................................................... 435
AutoMag Tool ............................................................... 435
Parameters Set from the AutoMag Run Dialog .......... 437
AutoMag Reporting ....................................................... 442
Filtering Solutions ........................................................ 443
Point Modulation of Solutions .................................... 444
Annotation ................................................................. 446
Strike Correction .......................................................... 446
Point to Body Conversion ............................................. 449
Running AutoMag in Batch Mode ......................... 449
Profile Results ............................................................. 449
Map Results ............................................................... 450

Appendices ........................................................................ 452

A File Formats ................................................................. 453

Conventions ................................................................. 453
Null Values ................................................................. 453
Channel Naming Conventions ................................... 454
Importing General ASCII Data ................................. 454
Importing Fixed-Width Data ....................................... 456
Importing Delimited Data .......................................... 457
Importing Data with Interspersed Line Numbers ...... 457
Importing Point Data .................................................. 458
Reading Field Names from the Header ................. 459
Input Null Values ...................................................... 459
Saving and Reloading a Current Layout .................. 460
Auto Classification ..................................................... 460
Other Features ............................................................ 461
Importing the File ....................................................... 461
Supported Single- and Multi-Line Data Formats ........ 462
TOOLKIT Format (TK) .................................................. 462
Table of Contents

Single Line Geosoft Format (DAT) ......................................................... 463
ER Mapper ASCII Format Profile .......................................................... 464
Simple XYZ Line Format (LIN) ............................................................... 465
XYZ Multi-line Format with Separate Header (LIN+HDR) ..................... 466
Multi-line Geosoft XYZ File (XYZ) .................................................... 467
Geosoft Database (GDB) .................................................................... 468
ASEG-GDF2 File Format ................................................................. 469
AMIRA Multi-line Format (TEM) ..................................................... 470
Point Data Format .............................................................................. 471
Drillhie Data Format .......................................................................... 472
Supported Grid Formats ....................................................................... 473
Encom Grid Format ............................................................................ 474
ER Mapper Grid Format .................................................................... 475
Geosoft Binary Grid Format ............................................................... 476
ASEG GXF format ............................................................................. 477
Geopak Grid File Format .................................................................... 478
USGS Binary Grid File ....................................................................... 479

B Body Descriptions ............................................................................. 477
General Guidelines .............................................................................. 477
Polygonal ......................................................................................... 477
Plunging Prism .................................................................................. 478
Frustum ............................................................................................. 479
Elliptic and Circular Pipe ................................................................. 480
Tabular ............................................................................................. 480
Sphere ............................................................................................... 481
General 3D Ellipsoid ......................................................................... 482
Polyhedron ....................................................................................... 483

C External Data Links .......................................................................... 485
External Link Operation ....................................................................... 485
Creation of External Link Programs ................................................... 487
Examples of Link Definitions in MVISION.INI File ............................. 487
Linking to Intrepid Databases .............................................................. 488
Example Intrepid Link Definition in MVISION.INI File ....................... 489
External Model Link ........................................................................... 490
Input File Preparation ......................................................................... 490
Running the External Link ................................................................ 491
Specifying External Link in MVISION.INI and TOPO2.INI ............... 494

D Defaults and Settings ....................................................................... 496
System Defaults (MVISION.INI) .......................................................... 496
Example .......................................................................................... 498
Project Defaults (MVPROJ.INI) ............................................................. 499
Example .......................................................................................... 501
Datums and Projections ..................................................................... 502
Supported Map Projections and Datums ............................................. 503
Universal Transverse Mercator Zone Locations ................................ 503
USA Map Projections ........................................................................ 504
Australian Map Projections .............................................................. 508
Spheroids .......................................................................................... 509
Projections File (PROJECT.DAT) ....................................................... 510
Datum File (DATUM.DAT) ............................................................... 515
IGRF Settings .................................................................................................................. 518

E Model Files .............................................................................................................. 519
ModelVision Model File Format .................................................................................... 519
Previous Versions ........................................................................................................ 523

F Symbols ...................................................................................................................... 524

G Filter Descriptions .................................................................................................. 525
Convolution Filters ....................................................................................................... 525
The Convolultion Filtering Process ............................................................................ 525
Convolution Filter Descriptions ................................................................................. 526
Smoothing Filters ........................................................................................................ 526
Enhancement Filters .................................................................................................... 527
Applying Convolution Filters in ModelVision ............................................................ 530
One-Dimensional FFT Line Filter Descriptions ......................................................... 534
The General Linear Filter ............................................................................................ 534
The 1D FFT Vertical Continuation Filter $G_{VC}(k)$ ......................................................... 535
General Expression for the 1D FFT Directional Derivative Filter $G_{qd}(k)$ .................. 535
The 1D FFT Vertical Derivative Filters $G_{vdd}(k)$ and $G_{1vd}(k)$ ................................. 536
The 1D FFT Horizontal Derivative Filters .................................................................... 536
The General 1D Phase Transformation Filter $G_{T2q}(k)$ ............................................... 536
The $B_T(k)$ to $B_H(k)$ Transformation Filter $G_{T2H}(k)$ .............................................. 537
The $B_T(k)$ to $B_z(k)$ Transformation Filter ............................................................... 537
The 1D FFT Reduction to the Magnetic Pole Filter $G_{rtP}(k)$ .......................................... 537
The 1D FFT Reduction to the Magnetic Equator Filter $G_{rte}(k)$ ............................... 538
The 1D FFT Pseudogravity Filter $G_{psg}(k)$ .............................................................. 538
The 1D FFT Pseudomagnetic Filter $G_{psm}(k)$ .......................................................... 539
The 1D FFT Low-Pass and High-Pass Butterworth Filters ........................................... 539
Two Dimensional FFT Filter Descriptions .................................................................. 539
FFT Derivative Filters ................................................................................................. 540
Derivative Filter of nth Order (Advanced) .................................................................. 540
The General Expression for FFT Directional Derivative Filters ................................. 541
The FFT TMI Reduction to the Pole Filter $G_{rtP}(k)$ .................................................... 542
The FFT TMI Reduction to the Equator Filter $G_{rte}(k)$ ................................................ 543
The FFT Pseudo-gravity Transform Filter $G_{psg}(k)$ .................................................. 544
The 2D FFT Pseudo-magnetic Transform Filter $G_{psm}(k)$ .......................................... 544
FFT Magnetic Component or Phase Transformation Filters ........................................ 545
The TMI General Phase Transformation $G_{T2q}(k)$ ...................................................... 546
The $B_T(k)$ to $B_x(k)$ Transformation Filter $G_{T2x}(k)$ ................................................. 546
The $B_T(k)$ to $B_y(k)$ Transformation Filter $G_{T2y}(k)$ ................................................. 546
The $B_T(k)$ to $B_z(k)$ Transformation Filter $G_{T2z}(k)$ ................................................ 546
The FFT Vertical Continuation Filter $G_{uc}(k)$ and $G_{dc}(k)$ ........................................ 546
The 2D FFT Low-Pass and High-Pass Butterworth Filters ........................................... 547
The FFT Band-Pass and Band-Reject Directional Cosine Filters ................................. 547
The First Order Magnetic Moment Transformation ...................................................... 548
The FFT Filters for Transforming TMI Grids to Any Element of the Magnetic Gradient
Tensor (MGT) .............................................................................................................. 549
The $B_T(k)$ to $B_{pq}(k)$ MGT Transformation Filters ..................................................... 552
The FFT Filters for Transforming Grids of Gravity Measurements $g_z(k)$ to Any
Element of the Gravity Gradient Tensor (GGT) .......................................................... 553
FFT TMI Reduction to the Pole (Low Latitude) Processing ......................................... 556
Aspects of Numerical Computation ............................................................................. 559
Computation of the Magnetic Moments ..................................................................... 561
1 Introduction

In this section:

- About ModelVision
- About this Manual

About ModelVision

ModelVision is an interactive geophysical modelling package for the display, analysis and simulation of magnetic and gravity data. ModelVision includes many features.

Visualization and graphics presentation

- 3D visualization in full colour for field data, grid surfaces, topography, drillholes and airborne flight paths
- Fast graphic presentation of complex rendered surfaces and models enabling rapid inversion and interactive modelling
- Overlay map representations - contours, stacked profiles, flight paths, images, scanned bitmap images.

Data import and export

- Comprehensive data import/export support for both line and grid data.
- Data processing utilities for filtering, statistical analysis, re-sampling and calculated variable manipulation.
- Seamless data transfer with support for imports and links to other geoscience software systems such as OASIS montaj™ and Intrepid™.

Modelling

- Interactive and compute-on-demand operation.
- Forward and inverse gravity and magnetic modelling. Specification of the inducing magnetic field via an interactive IGRF function.
- Powerful multi-line inversion using an active zone concept to enable the automatic inversion of bodies within a defined area.
- Implementation of demagnetisation, remanence and topographic simulation with the ability to apply these on a wide range of 3D body types and geological situations
- Computation of magnetic and gravity response for all data lines, points and drillhole readings. In addition, responses can be computed to match the extent, location and node points of grids.
- An optional automatic magnetic depth analysis (AutoMag) integrated with modelling. This procedure uses a modified Naudy method but provides a high degree of user control and graphic interaction.
Hard-copy output

• Improved hard-copy incorporating a CAD layout facility to facilitate production of report quality graphics.

• Incorporation of any displayed windows in the graphic layout with generation of profile and map displays at user defined scales.

• Publish the content of ModelVision sections, profiles and maps into Discover PA.

ModelVision operates under Microsoft Windows® 7 and 8 operating systems. Within these computer environments, the user interface is functionally identical.

About this Manual

The information in this manual applies to ModelVision only. Tensor Research Pty Ltd has taken care to ensure that the information is accurate at the time of release. From time-to-time, both major and minor releases of ModelVision are made. Changes made after release of the program are not always reflected in the accompanying documentation.

This manual is available in several different formats. For more information about how to get help, see Getting Help.
2 Installing ModelVision

This section describes the installation and operation of the software under the Microsoft Windows 8 and 10 operating systems.

- Computer Hardware Requirements
- Installing ModelVision
- Licensing

Computer Hardware Requirements

We recommend that you operate this software on a modern, fast PC. At least 512 megabytes of memory is required to operate ModelVision, but larger memory will significantly boost the operation of this and other Windows application software.

A high-quality graphics monitor of at least SVGA capability (800 x 600 pixel screen display) is required. Higher screen resolution is preferred as it improves the appearance and ease of use of ModelVision.

The ModelVision software requires approximately 170 megabytes of available disk space to store the executable and library files. A number of example data files are also supplied with the software and these require significant additional disk storage.

ModelVision is a 32-bit program will operate on Windows 8 and 10 32-bit and 64-bit operating systems. It does not operate under earlier Windows operating systems.

Installing ModelVision

The software, documentation, tutorials, and other resources can be downloaded from the Tensor Research website www.tensor-research.com.au.

Software installation is a two-stage process:

Stage 1: Install the software

- Installing from the Web

Stage 2: License the software

For instructions on how to perform different types of licensing procedures, see:

- Licensing Procedures

Installing from the Web

The ModelVision installation files can be downloaded from the Tensor Research website. To download ModelVision, visit www.tensor-research.com.au and select the Downloads page. ModelVision components are documented and their size indicates the time it will take to download.
When you have completed downloading the installation file, from Windows Explorer, double-click the file name to initiate the installation procedure.

**Installation Folders**

We recommend that you install this ModelVision application in the default Encom installation folder under the `\Program Files (x86)` folder on your local drive.

The Encom folder can be placed under another folder by changing the default installation drive and folder name in the **ModelVision Installation Folder** option when ModelVision is installed.

**Licensing**

ModelVision is protected under international copyright law. The licensing systems are designed to protect against unlawful copying and use of the software. To provide you with a flexible but effective license system, ModelVision is supplied with a hard-disk license system.

The licensing procedures are described in *Licensing Procedures*.

**Licensing Procedures**

When installing a license, choose from the following licensing procedures:

- **Display information about Tensor Research affiliated software installed**
  - *Displaying License Information*

- **Re-installing ModelVision**

  If ModelVision is installed on the computer with a valid hard-disk license, the software does not need to be re-licensed when you re-install the software.

- **ModelVision has not been previously licensed on the computer**

  In this case, a hard-disk license is requested. For detailed instructions, see:
  - *Installing a Hard-disk License for the First Time*

- **The license is being transferred from another computer**

  You can transfer a license from one computer to another without contacting Tensor Research. For detailed instructions, see:
  - *Transferring a Hard-Disk License*

- **A later version of the software has been installed**

  If you are upgrading an installation with a valid license to a later version of the software, see
  - *Upgrading an Existing License*

**Installing a Hard-disk License for the First Time**

Follow this licensing procedure if you are installing ModelVision for the first time:
Start ModelVision:

1. Start ModelVision from either the Windows Start button, or from the icon on the Desktop.

   A message is displayed indicating no license was found. Click OK to display the notice that the program is running in demonstration mode.

2. Close the message, and then, from the File menu, choose License.

Create a new license:

3. The Create License File dialog box is displayed. Type in the company name and click OK. The License Manager is displayed.

4. Select the Activate License tab.

5. Type in both the 7-digit Customer Number and 10-digit Serial Number supplied with the software.

6. Type in your User Name and E-mail.

7. Click the Automatically send request and activate button to automatically email an activation request to Tensor Research. Alternatively, for off-line or e-mail activations, click the Save request button to manually activate your license.

8. Your license request will be received by the technical support team at Tensor Research and an email containing the activation code will be sent to the email address you provided. When this email is received copy and paste the activation code into the Activation Code box in the Activate Software dialog of the Licence Manager and press the Activate button. When prompted, click OK on the license notification, and close the License Manager.

ModelVision is now ready to use.

Upgrading an Existing License

After installing ModelVision, if a license for an earlier version exists, a 20-day grace period is granted, during which you can continue to use the software. However, you must upgrade your license by contacting Tensor Research (see Technical Support and Updates) and activate the upgraded license before this grace period expires.

The procedure is otherwise the same as Installing a Hard-disk License for the First Time.

Transferring a Hard-Disk License

If a hard-disk license is operating effectively on one computer (the source), you can transfer the license to a second computer (the destination). The process of transferring the license does not require contact with Tensor Research for an Activation Code. Follow the steps below to transfer a valid license from one computer to another.
Install the software on the destination computer:

1. Install ModelVision on the second, destination computer. The version of the software on the source and destination computers must be identical.

Start ModelVision on the destination computer:

2. On the destination computer, start ModelVision from either the Windows Start button, or from the icon on the Desktop.

   A message is displayed indicating no license was found. Click OK to display the notice that the program is running in demonstration mode.

3. Close the message, and then, from the File menu, choose License.

Create a new license:

4. The Create License File dialog is displayed. Type the company name and click OK.

   The License Manager is displayed, which lists all programs installed on this computer using the current licensing system.

Obtain the hardware ID of the destination computer:

5. Select the Activate License tab.

6. Write down the 7-digit code displayed in the Hardware ID box.

Transfer the license from the source computer:

7. In the License Manager, click Transfer.

8. At Step 2 of the Transfer License tab, type in the Destination Hardware ID you recorded earlier.

   To return or “park” the license with Tensor Research, type 4666666 as the destination ID.

Important The license transfer will disable the license on the source machine. The source computer license cannot be reactivated unless the license is transferred back from the destination computer or a new activation code is obtained from Tensor Research.

9. At Step 3 of the Transfer License tab, click Create Transfer Activation Code. You will be prompted to confirm the destination hardware ID.

   The activation code for the destination computer is displayed.

Important The license on the source computer is now disabled.

10. Write down the activation code.
Activate the license on the destination computer:

11. On the **Activate License** tab, type in the **Activation Code** that you obtained from the source computer.

12. Click the **Activate** button. A message is displayed confirming that the license has been successfully transferred.

13. Click **OK**.

ModelVision is now ready to use.

If the transfer was not successful, on the source computer, browse to the C:\ProgramData\Encom folder and open the file Transfer_Log.txt file. This contains a copy of the activation code generated for the license transfer.

---

**Note**

If you need to transfer the ModelVision license back to the original machine, you must repeat the transfer procedure.

**Displaying License Information**

After you have installed and licensed the software, to display information about the Tensor Research licenses installed on the computer, from the **File** menu, choose **License**.

The **Licensed Software** tab provides details of what License Types are available on the computer, and what Product Licenses are activated/available. When you select a product, the product options and details will be displayed.

**Troubleshooting**

If you believe ModelVision licensing is correctly installed but are unable to correctly operate ModelVision, you should contact Tensor Research. Tensor Research will respond with a solution to your problem or with a request for further information. For contact details, see *Contacting Tensor Research*. 
3 Getting Started

In this section:

- Introduction and Guidelines
- Using the Tutorials
- Starting and Closing ModelVision

Introduction and Guidelines

ModelVision is used for data display and potential field (magnetic and gravity) modelling. A number of guidelines are provided below to assist in your operation of this software. These guidelines apply throughout ModelVision.

Display the same data in multiple windows

Data and models can be displayed in a number of windows at any one time. One window (the one with the highlighted banner at the top) is active. You are able to set display and object attributes only within the active window. To make a window active, move the cursor to the window and click the left mouse button.

Use the shortcut menus

Alteration of the display appearance is controlled by pop-up dialog boxes, which can be displayed from a shortcut menu. To open a shortcut menu, right-click inside the window that you want to modify. The options available on the shortcut menu will change according to the type of window and where you clicked. For example, a display may contain multiple tracks. To control the display attributes of a specific track, position the cursor in the track before right-clicking. The shortcut menu specific to the track object will be displayed.

Double-click to configure objects

Configuring individual selectable objects such as models, titles, legends, readings etc is done by positioning the cursor over the object and double-clicking. In each case a dialog is presented that controls the selected item.

Use standard Windows keyboard shortcuts

Standard Microsoft Windows keyboard usage applies for selecting items in lists and graphical objects. This means that the SHIFT key in combination with the left mouse button can be used to select multiple items or objects. The CTRL key can also be used in combination with the left mouse button when selecting non-consecutive items in a list.

Use Ctrl+click to cycle through overlapping objects

If selected graphics objects overlap (such as a title box and a body), use the CTRL key and left mouse button to cycle through the overlapping objects.

Changes are shown immediately in every window type

All of the window display types in ModelVision present models as they are created and edited. As changes to body shapes are made or new bodies are added, each window is automatically updated to reflect that change.
Five basic window types exist in ModelVision:

- Profile displays (multi-track presentations)
- Section displays (profiles with cross-sections beneath)
- Map displays (contours, stacked profiles, images etc)
- Perspective views of models, surfaces, drillholes etc
- Page Layout displays which combine the other types for reports.

Using the Tutorials

To assist you in learning how to use ModelVision, we provide a set of tutorials in the installation. The tutorials are composed of documents that explain the operation and steps to follow, plus data that are used in the tutorial exercises. All tutorials are based on real exploration situations in which ModelVision can be used to display, model and interpret potential field data.

The tutorials are available as PDF documents. The PDF files can be accessed from the C:\Program Files (x86)\Encom\Mvis 16.0\Documentation folder. You need to have Adobe Acrobat Reader installed to view and print the PDF files. Refer to Using Adobe Reader for additional information. When available, you can open the ModelVision Tutorials.pdf file to access all tutorials.

When the ModelVision tutorials are installed the tutorial datasets are available from the C:\ProgramData\Encom\Mvis\Tutorials folder. A total of 70 Mbytes of disk space is required to install the tutorial data. As you work through the tutorials additional storage is required for session, model, grid and exported data.

Starting and Closing ModelVision

To start ModelVision:

You can start ModelVision in several ways:

- Double-click the ModelVision icon. This icon is added to the Windows Desktop when the program is installed.
- From the Windows Start button, choose Programs>Encom Programs>ModelVision.
- Other methods of creating shortcuts to executables are available in the Windows environment. Refer to Windows Help for additional information.

When ModelVision starts, the Startup Option dialog is displayed, from which you can choose:

- Demo - Open a demo session: this opens a demonstration session consisting of a tabular body displayed in both 2D map and cross-section view. The modelling parameters (e.g. Model>Line Control) are setup so that moving the body around in either display views modifies the modelled output.
- Last Session - Open the previously loaded session: this opens the last session which was opened and saved in ModelVision. If this is the first time ModelVision has been used then this will open the first tutorial session.
• **Open Session** – Choose a session file to open: this will display the Load Session File dialog and allow you to browse for a desired session file.

If you close the Startup Option dialog (by clicking the Close button in the top right hand corner), the New Project Folder dialog is displayed, from which you can create a new project and import data into the project.

You can then choose tools from the main menu:

• **File** - File handling for projects, data import and export are controlled using the options on this menu item. Setting of project directories, licensing, printing and exiting are also available.

• **Edit** - Standard Windows editing functions

• **View** - Create displays of data, images, drillholes and models.

• **Layout** - Access to the CAD layout window

• **Model** - Access potential field modelling controls from this item

• **Filters** - Standard geophysical filtering functionality is provided

• **Utility** - Obtain project and data statistics, status and default information from this menu item. Data maintenance (delete, rename) of channels, lines and grids plus generation of grids is available.

• **Tools** - Control buttons, toolbar and operations dialogs

• **Window** - Control of the position and selection of windows and toolbars

• **Help** - Online help and reference facility.

---

**Note**

The main menu and toolbars will change when a project or session file are opened.

For more information about using these tools, refer to *Understanding the Interface*

**To exit ModelVision:**

• From the **File** menu, choose **Exit**. You are asked to save the current workspace in a binary session file. Session files are useful to quickly resume the same project files and workspace when next you use ModelVision.

The window close button at the top right of the window and the ModelVision icon at the top left of the window will perform the same function.

**Demonstration Mode**

If you have not licensed your installation, ModelVision runs initially in Demonstration mode. This mode permits access to specific session files supplied with the installation but not external data. To enable the software to operate on your data and projects, ModelVision must be licensed.

For information about licensing your installation, see *Licensing.*
4 Getting Help

Should difficulties or questions arise while using ModelVision, there are several sources of help available.

In this section:

• Online Help
• User Guide
• Tutorials
• Technical Support and Updates
• Using Adobe Reader

Online Help

This form of help is provided in a comprehensive subset of the main ModelVision documentation. You can view help in several ways:

• From the Help menu, select Help. This will open online help at the introduction topic.
• From a dialog, select the Help button. This displays the topic related to the use of the open dialog.
• Press the F1 key. The topic displayed will depend on what part of the software you are working from.

The help provided is categorized into subjects (displayed on the Contents tab) and an alphabetical index (click the Index tab). You can also search for keywords from the Search tab.

This form of context sensitive help is simple and fast to use. Detailed instructions on using Help can be found in the Microsoft Windows Users Manual. Alternatively, the help menus themselves provide extensive information on its use.

User Guide

This comprehensive user guide provides all the required information for the operation of ModelVision. The User Guide is supplied as a PDF electronic document. For more information, see Using Adobe Reader.

Tutorials

Tutorials are organized with step-by-step instructions to solve various common exploration and data analysis problems. We recommend that you review the tutorial exercises as an aid to problem-solving with ModelVision. The tutorial data and example data can be found in the C:\ProgramData\Encom\Mvis folder and the tutorial instructions can be found in the C:\Program Files (x86)\Encom\Mvis 16.0\Documentation folder.
Technical Support and Updates

Purchasers of ModelVision are entitled to free Standard Support for the first 12 months after purchase. Standard support provides:

- Support for software installation and configuration queries.
- Support for resolving software errors, bugs and failures encountered in the operation of ModelVision.

A response to a support contact is provided within two business days and may consist of:

- An answer to a support query.
- An estimate of how long it takes to answer the query.
- A request by Tensor Research for additional information.
- An explanation of why the query cannot be answered.
- A suggestion on where further information can be obtained.

Tensor Research notifies you at the end of the first year following your purchase of ModelVision to inform you of the details and benefits of our annual support and updates subscription.

Contacting Tensor Research

E-mail support@tensor-research.com.au
Web www.tensor-research.com.au

Using Adobe Reader

The manuals are in the form of PDF files (Portable Document Files) that can be viewed on-screen, or once displayed, can be printed in part or in full. To view or print the files, Adobe Reader must be installed on your computer. Adobe Reader is available (at no cost) from the Adobe website www.adobe.com.

To view the User Guide with Acrobat Reader:

1. On the disk where ModelVision is installed, in Windows Explorer, navigate to the .\Program Files (x86)\Encom\MVis 16.0\Documentation folder.
2. Double-click the file name ModelVision User Guide.PDF. Alternatively, right-click the file name and choose Open.
Understanding the Interface

ModelVision user interface

This section provides an overview and quick reference guide to the ModelVision user interface. The main components of the user interface are:

- **Main Menu**
- **Toolbars**
- **Speed Tool**
- **Status Bar**

**Main Menu**

- **File Menu**
- **Edit Menu**
- **View Menu**
- **Layout Menu**
- **Model Menu**
- **Filters Menu**
- **Utility Menu**
- **Tools Menu**
- **Window Menu**
- **Help Menu**
## File Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Erases existing data and models and commences a session with empty memory.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Restores a previously saved session file.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the current session.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the current work session in the current session file if one is already open.</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Creates a new session file. A dialog box appears that allows you to enter a file name or overwrite an existing session file.</td>
</tr>
<tr>
<td><strong>Revert to Saved</strong></td>
<td>Restores the previously saved work session without saving the current session. (If no session file is currently being used, this option is identical to <strong>New</strong>).</td>
</tr>
<tr>
<td><strong>Import</strong></td>
<td>Import datasets for use with modelling, including profile data, gridded data, drillhole data and point data.</td>
</tr>
<tr>
<td><strong>Export</strong></td>
<td>Export datasets currently in use with the current session including profile data, gridded data, drillhole data and point data.</td>
</tr>
<tr>
<td><strong>Setup</strong></td>
<td>Edit the default settings used in ModelVision sessions, including display parameters and magnetic and gravity property units.</td>
</tr>
<tr>
<td><strong>Project Properties</strong></td>
<td>Examine or edit the settings associated with the current project. For information describing the project and its use, refer to Project Settings. This option permits editing of certain aspects of a project (including magnetic field, descriptions etc) but does not allow changing of a project and its associated directory.</td>
</tr>
<tr>
<td><strong>Recent Projects</strong></td>
<td>Displays the path list of the previous four accessed projects. You can select any of the displayed paths and ModelVision immediately accesses the selected project. Checks are internally made to ensure project projection and default values are consistent between projects. The last four project paths are retained in the <strong>MVISION.INI</strong> defaults file.</td>
</tr>
<tr>
<td><strong>Print</strong></td>
<td>Sends a copy of the active window to a printer (where connected) or to a print file.</td>
</tr>
<tr>
<td><strong>Print Setup</strong></td>
<td>Select a printer device and select printing options.</td>
</tr>
<tr>
<td><strong>License</strong></td>
<td>Displays the License Manager, from which you can activate and transfer your ModelVision license.</td>
</tr>
<tr>
<td><strong>Recent sessions</strong></td>
<td>Displays your most recent sessions.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes ModelVision.</td>
</tr>
</tbody>
</table>
Edit Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Undo last editing action performed.</td>
</tr>
<tr>
<td>Cut</td>
<td>Remove the selected object and place on the Windows clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected object to the Windows clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Copy an object from the Windows clipboard and insert in the active view.</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected object.</td>
</tr>
</tbody>
</table>

View Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Layout</td>
<td>Open a new layout view window.</td>
</tr>
<tr>
<td>Multi-Track</td>
<td>Open a new multi-track view window.</td>
</tr>
<tr>
<td>X-Section</td>
<td>Open a new cross-section view window. Line Control must be enabled before a new cross-section view can be created.</td>
</tr>
<tr>
<td>Perspective</td>
<td>Open a new 3D perspective view window.</td>
</tr>
<tr>
<td>Map</td>
<td>Open a new 2D plan view window.</td>
</tr>
<tr>
<td>Hole</td>
<td>Open a new Drill Log window. Hole Control must be enabled before a new drill log view can be created.</td>
</tr>
</tbody>
</table>

Layout Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Select from pre-set or user-defined magnification.</td>
</tr>
<tr>
<td>Bring to Front</td>
<td>Move the selected object to the front of the display list.</td>
</tr>
<tr>
<td>Send to Back</td>
<td>Move the selected object to the back of the display list.</td>
</tr>
<tr>
<td>Align</td>
<td>Vertically or horizontally align the selected objects.</td>
</tr>
<tr>
<td>Layers</td>
<td>View the layers available in the active Layout window.</td>
</tr>
<tr>
<td>Configure</td>
<td>Edit the configuration settings of the active Layout window.</td>
</tr>
</tbody>
</table>

Model Menu

Most model controls are available through the Model menu options. Controls that you need to access often should be added to the Speed Tool. This particularly applies to the tools for manipulating the regional field.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Control</td>
<td>Displays the Line Control tool, which is used to configure the modelling parameters for line data.</td>
</tr>
<tr>
<td>Grid Control</td>
<td>Displays the Grid Control tool, which is used to configure the modelling parameters for gridded data.</td>
</tr>
<tr>
<td>Hole Control</td>
<td>Displays the Hole Control tool, which is used to configure the modelling parameters for drillhole data.</td>
</tr>
<tr>
<td>Point Control</td>
<td>Displays the Point Control tool, which is used to configure the modelling parameters for point data.</td>
</tr>
<tr>
<td>Edit Regional</td>
<td>Compute and edit the regional computation for line or gridded data.</td>
</tr>
<tr>
<td>Magnetic Field</td>
<td>Edit defaults for the magnetic field parameters, including earth's magnetic fields properties, remanence, demagnetisation and modelled components.</td>
</tr>
<tr>
<td>Gravity Component</td>
<td>Specify which supplementary gravity component channels will be generated during modelling.</td>
</tr>
<tr>
<td>Defaults</td>
<td>Edit defaults for model parameters (e.g. background properties and default susceptibility and density values) and default appearance of cross-section views.</td>
</tr>
<tr>
<td>Import</td>
<td>Import a model in a selected input format using TKM (ModelVision), 3D DXF, Gemcom BT2, ESRI TIN, GoCAD Tsurf, Datamine, Vulcan, 3D Studio and attributed points.</td>
</tr>
<tr>
<td>Export</td>
<td>Export a model in a selected output format using TKM (ModelVision), 3D DXF, GoCAD, spreadsheet (CSV) and UBC 3D mesh.</td>
</tr>
<tr>
<td>Body Operations</td>
<td>Select from the available operations that can be performed on modelled bodies, including: Create Body, Reshape Body, Body Table, Create Strata, 3D Model generator, Body Conversion, Topology Checker, Synthetic Body Array and Terrain Correction.</td>
</tr>
<tr>
<td>Inversion</td>
<td>Displays the Inversion toolbar.</td>
</tr>
<tr>
<td>Joint Inversion</td>
<td>Opens the joint inversion toolbar.</td>
</tr>
<tr>
<td>Quick Inversion</td>
<td>Opens the Quick Inversion toolbar. This tool provides a quick tabular body inversion procedure for limited segments of a line of data. Optionally use a quick model to seed and open the AutoMag tuning dialog.</td>
</tr>
<tr>
<td>Data Compression</td>
<td>Specify the compression of loaded line data.</td>
</tr>
<tr>
<td>Diff Mode</td>
<td>Set the differential computation mode, which provides increased performance when working with a large number of complex bodies. Diff Mode requires more available memory and system resources.</td>
</tr>
</tbody>
</table>

For more information about the options available from the Model menu, see *Working with Models.*
### Filters Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter List Maintenance</td>
<td>Edit filter parameters and add and order in-line filters.</td>
</tr>
<tr>
<td>Convolution Filters</td>
<td>Apply a convolution filter to a field in a dataset.</td>
</tr>
<tr>
<td>FFT Filters</td>
<td>Apply a fast fourier transform filter to a field in a dataset.</td>
</tr>
<tr>
<td>Grid Filters</td>
<td>Apply a convolution or FFT filter to a grid using the Grid Filter tool.</td>
</tr>
</tbody>
</table>

### Utility Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculator</td>
<td>Open the Calculator tool, which allows mathematical computations to be applied to fields within, line, grid, drillhole or point datasets.</td>
</tr>
<tr>
<td>Program</td>
<td>Specify your own programs for calculation and manipulation of channels and grid data.</td>
</tr>
<tr>
<td>Interpolate</td>
<td>Change the sample spacing between individual readings in a line dataset stored in memory.</td>
</tr>
<tr>
<td>Synthetic Lines</td>
<td>Generate user-defined survey lines based on specified coordinates and elevation (see Synthetic Lines).</td>
</tr>
<tr>
<td>Synthetic Drillholes</td>
<td>Generate user-defined drillhole traces based on specified coordinates and elevation (see Synthetic Drillholes).</td>
</tr>
<tr>
<td>Synthetic Grid</td>
<td>Generate user-defined grid based on specified cell size, coordinates and elevation (see Synthetic Grid).</td>
</tr>
<tr>
<td>Synthetic Body Array</td>
<td>Generate user-defined array of bodies using either tabular or sphere types in cross-section or map views.</td>
</tr>
<tr>
<td>Grid Channel Data</td>
<td>Generate a grid of a data channel within ModelVision.</td>
</tr>
<tr>
<td>Sample from Grid</td>
<td>Interpolate grid values into a channel for readings along selected lines.</td>
</tr>
<tr>
<td>Grid Utility</td>
<td>Display the Grid Utility tool for manipulating loaded grids, for example reprojecting, merging, resampling, etc.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Display details on the current memory contents of the ModelVision session.</td>
</tr>
<tr>
<td>Data Maintenance</td>
<td>Rename or delete loaded channels, lines or grids. Line data and grids can also be interpolated or subsampled.</td>
</tr>
<tr>
<td>Body Table</td>
<td>Display individual body properties graphically while modelling.</td>
</tr>
<tr>
<td>Reports</td>
<td>Generate statistical reports of models, grids, and data fields.</td>
</tr>
</tbody>
</table>
The Tools menu can be accessed from the main menu bar or by right-clicking in an empty section of the ModelVision workspace.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email System Info</td>
<td>Generate text with user comments, problems, enhancements and system information that you can copy and paste into an email when requesting support.</td>
</tr>
<tr>
<td>Colour Table Editor</td>
<td>Create look-up tables (.LUT files) for use in ModelVision to define the palette of bodies, contour maps, drillhole vectors or any colour grading presentation (see Using the Colour Table Editor).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoMag</td>
<td>Display AutoMag depth interpretation tool (see AutoMag (Optional Module)).</td>
</tr>
<tr>
<td>Speed</td>
<td>Display user-defined shortcut tool (see Speed Tool).</td>
</tr>
<tr>
<td>Active Line</td>
<td>Displays a toolbar for graphically selecting and making active data lines for modelling, regional computation, AutoMag, or X-section display (see Using the Active Line Tool).</td>
</tr>
<tr>
<td>Inversion - Magnetic</td>
<td>Opens the magnetic inversion tool for controlling standard magnetic inversion modelling, including line or map selection, inversion initiation, and control of body parameters (see Inversion).</td>
</tr>
<tr>
<td>Inversion - Gravity</td>
<td>Opens the gravity inversion tool for controlling standard gravity inversion modelling, including line or map selection, inversion initiation, and control of body parameters (see Inversion).</td>
</tr>
<tr>
<td>Joint Inversion Magnetic</td>
<td>Starts the multi-channel joint inversion engine which can be used on one or more channels of magnetic data (magnetic tensor, cross gradient, vertical derivative, etc.) (see Inversion).</td>
</tr>
</tbody>
</table>
### Tool Description

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Joint Inversion Gravity</td>
<td>Starts the multi-channel joint inversion engine which can be used on one or more channels of gravity data (gravity tensor) (see Inversion).</td>
</tr>
<tr>
<td>Terrain Correction</td>
<td>Opens the high-precision gravity terrain correction tool that uses multi-resolution grids for local and far corrections (see Terrain Correction Calculator).</td>
</tr>
<tr>
<td>Remanence Calculator</td>
<td>Start the remanence calculator which uses the magnetic moment method to calculate the resultant magnetisation direction for a sequence of magnetic anomalies in a grid image (see Remanence Calculator).</td>
</tr>
</tbody>
</table>

### Modules Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoMag</td>
<td>Display the AutoMag toolbar for the optional AutoMag module.</td>
</tr>
<tr>
<td>Terrain Correction</td>
<td>Display the Terrain Correction Calculator tool.</td>
</tr>
<tr>
<td>UBC Model-Mesh Designer</td>
<td>Display the optional UBC Model-Mesh Designer tool.</td>
</tr>
</tbody>
</table>

### Window Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
<td>Rearrange and resize all open views to fill the display area of ModelVision in a tiled fashion.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Rearrange and resize all open views to fill the display area of ModelVision in a cascading fashion.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arrange icons in ModelVision to their default locations.</td>
</tr>
</tbody>
</table>

### Help Menu

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>Open online help.</td>
</tr>
<tr>
<td>Search For Help On</td>
<td>Search online help for a keyword.</td>
</tr>
<tr>
<td>Special Keys</td>
<td>Display information about ModelVision hot keys.</td>
</tr>
<tr>
<td>Guides</td>
<td>Access the ModelVision guides, including the user guide, tutorials and geophysical interpreters guide.</td>
</tr>
<tr>
<td>About</td>
<td>Displays information about the version and license of ModelVision installed on this computer.</td>
</tr>
</tbody>
</table>
Toolbars

ModelVision toolbar

ModelVision uses toolbars extensively for controlling the various aspects of displays, modelling and data analysis. Toolbars are accessible from two sources. If the cursor is placed in a background ‘grey’ portion of ModelVision’s main screen and the right mouse button is clicked, a toolbar menu configuration dialog is displayed. Alternatively, you can select the main menu Tools option.

ModelVision uses toolbars for all the major operations associated with display, analysis and modelling. One toolbar is even provided to allow you to design your own toolbar (the Speed Tool). Some operations that are unique to toolbars are also described. For example, the Traverse option creates lines from interpolated data derived from a grid.

The toolbar is generally used as a fast method of performing and controlling numerous ModelVision operations. In some instances, options contained on the toolbar are also available from the menus and dialog windows. In other circumstances, the only way to perform certain functions are by using the toolbar.

- View Control Tools
- Body Creation and Editing Tools
- Computation Tools
- Utility Tools
- Modelling Tools

View Control Tools

Pointer
Resets the cursor after operations such as zoom or pan. This is the default cursor mode. It is recommended that the Pointer cursor mode be always used for body selection, titling control etc. Other modes such as zoom in or out can inadvertently perform the wrong action if a mistake is made while selecting the required item. Selecting Objects.

Zoom In
Initiates a zoom-in operation. See Zooming In and Out.

Zoom Out
Initiates a zoom-out operation. See Zooming In and Out.

Zoom Previous
Undo the last zoom to the Previous Zoom level. This can be repeated up to 10 times. See Zoom Previous.

Pan
Enables a display window view to be roamend. See Pan.
3D Rotation
Perspective displays can be rotated, zoomed and panned by using the cursor control button. See 3D Grids.

Fit
Fit the data contents to the available window space. This allocates approximately 95% of the available window area to make the data and models fit within the viewing area. This is useful when you have zoomed in to look at detail and want to return to a view of all the data. See Fit.

Redraw
Forces the data and models in a window to be redrawn. This can be useful after various editing options are performed such that artefacts or vertex symbols may be left on the screen. There are various contexts where the graphics display is not automatically updated so that time is not wasted in redraws of complex displays. You can override this by using the Redraw option. See Redraw.

For more information on using the view control tools, see Navigating the View.

Body Creation and Editing Tools

Undo – Undoes incremental body edits (see Undoing Edits).

Create Body – display the create body dialog (see Creating Bodies).

Reshape – initiates reshape operation for selected bodies (see Reshaping a Polygroup Body).

Polygon Split – split a polygon in two across vertices (see Splitting a Polygroup Body).

Properties – edit the properties of a selected body (see Editing Bodies.).

Create strata – from imported depth grids (see Strata Modelling).

Computation Tools

Compute - initiates a response computation, irrespective of computation mode setting (Immediate, Differential or Manual). After the model response has been computed the display windows are automatically updated.


• In Manual mode, the model response can only be computed by clicking the Compute button. Manual mode is the default.

• With Immediate mode selected, the model response is recalculated and redisplayed after each editing operation. The time taken to recalculate and redisplay the response after each edit operation depends on the speed of the computer, the complexity of the model, model compression, and the number of data points and active lines or grids.
**Publish Model** – automatically updates the current model file (TKM) when changes are made to a model. This allows programs such as Discover PA to update their display as soon as the model changes.

**Utility Tools**

**Active Line** – select lines to toggle activity (see *Using the Active Line Tool*).

**Traverse** – create traverses across displayed grids. See *Using the Traverse Tool*.

**Next line section** – creates a profile X-section of the next sequential line from the currently displayed X-section. See *Using the Next Line Tool*.

**Select active points** – nominate active points from a map window. See *Using the Active Points Tool*.

**Grid clipping** – interactive grid clipping. See *Using the Clip Grid Tool*.

**Clip a project** – select a rectangular area from a project. See *Using the Clip Project Tool*.

**Measure tool** – measures distances, areas and perimeters in map and cross-section views

**IGRF Utilities** – provides access to the *IGRF Calculator* and *IGRF Grid Creator*.

**Calculator** – provides one click access to the *Computing New Channels*.

**Lighting switch** – turns directional illumination of bodies on or off. With lighting turned off, and assuming colour modulation by property is not being used, the body colours will match those in the body table.

**Publish Model** – exports the current model and overwrites the previously saved version. Use this for live updates of your model in Discover PA which constantly looks for updates to files connected to profile, maps and 3D views.

**Statistics Watch** – updates various statistics for a line segment whenever it is updated via modelling or a computation.

**Remanence Calculator** – Starts the remanence calculator dialog which uses the magnetic moment method to calculate the resultant magnetisation direction of a magnetic anomaly selected from a grid image. See *Remanence Calculator*.

**Direct Target Wizard** – Use this wizard to undertake full 3D modelling and inversion using multiple cross-sections, an integrated regional and simple active point selection. The technique bundles multiple single steps into a rapid workflow procedure that allows you to target an anomaly or anomaly complex for forward modelling and inversion. See *Direct Targeting Workflow*.
Movie Mode – Use this tool to capture every change you make to a model and then play it back at a suitable speed and observe the changes to your model output. This is a useful tool to illustrate the sensitivity of a model to various body properties. Use a video capture utility like Camtasia to capture the replay. See Making a Movie.

Layer Table – shortcut for opening the map or cross-section layer table for changing the visible attributes of the display.

Modelling Tools

Create Body
(see Creating Bodies).

Reshape
When a body is selected while the Reshape tool is active, its shape can be modified graphically rather than through numeric in a dialog box. The precise nature of the reshape option is dependent upon the body type (see Reshaping a Polygroup Body).

Create Strata
This button permits layer models to be created from imported depth grids (see Strata Modelling).

Property (Body Table)
If a body is selected when this tool is chosen, a dialog box that is relevant to the particular body type appears on screen. You can change the display and physical properties of the selected body. Note that you can also achieve the same result by double clicking with the left mouse button when the point is over a body (see Editing Bodies.).

3D Model Generator and Extrusion Wizard Will generate a 3D model from a simple or complex polygon drawn in a map window or else imported with a vector file (see 3D Model Generator).

Quick Inversion This button executes a utility which produces a starting tabular in a x-section view by dragging the cursor across a magnetic anomaly (see Quick Inversion).

You can also edit common body properties from a spreadsheet editor that is available from the menu Utility>Body Table. Refer to Editing Polygroup Bodies for additional information.

Speed Tool

The Speed tool is a useful facility which enables you to assign various menu items to push buttons. The button assignments are restricted to menu options. Up to ten (10) commonly performed menu operations can be defined by the push buttons on the Speed tool.
Available buttons on the Speed tool are not initially displayed. ModelVision has an internal list of frequently used menu options and also stores the last menu operation performed. If the “+” button is pressed then the last operation will be added to the toolbar or if it is already there then one will be added from the internal list. The “-” button removes the last item from the toolbar. More comprehensive control over the toolbar is available by selecting the Set button. A scrollable list of the available menu items is displayed with an empty list area at the base of the dialog.

List of menu items which can be assigned to Speed buttons

To assign items to a push button, locate the cursor over the required item and click the left mouse button to highlight (select) it. Click the Select button and the selected item transfers to the bottom scrollable list. If an item is selected which is no longer required, you can select it and click the Deselect button.

When the menu items contained in the Selected list are as required, click the OK push button and the newly configured Speed bar is displayed.

Once a Speed toolbar is displayed, the contents of the push button items can be edited by clicking the Set button and redefining the Selected list. To use the toolbar, clicking any of the defined buttons immediately displays the requested dialog or perform the specified action. In many circumstances the Speed toolbar can save many mouse movements and button clicks.
If the combination of button settings are of ongoing use, they can be saved by enabling the **Load at Startup** option. The individual menu item specifications for a Speed toolbar are saved by entries made in the `MVI SI ON. INI` defaults file. Refer to *Appendix D: Defaults and Settings* for additional information.

## Status Bar

The status bar is positioned along the bottom of the work area and provides useful information on many different components of ModelVision. The status bar is split into a left section that responds to the cursor position and the right section which provides overview information on the current session.

The left section of the status bar provides information on the location of the cursor in x, y or x, y, z space depending upon the context and works in all graphics windows apart from the perspective view. To the right of the cursor information, the line name may be displayed for the line that is closest to the current cursor position. This is very helpful when zoomed in and you want to identify a particular line for modelling. The values of any grid displayed in the map view will be displayed after the line name.

The right section of the status bar provides summary information on the current session with important information on the IGRF magnetic field values, magnetic and gravity units. It also keeps track of the total number of bodies, lines, active lines and grids. The current cursor type is also highlighted for pointer, zoom in, zoom out and pan modes. The current model computation mode is displayed to match the toggle status of the manual/immediate mode toolbar button.

If you hover over any box, the left hand end of the status bar will show the meaning of the field.
Managing Projects and Data Files

In this section:

- About Projects and Session Files
- Creating, Saving, and Restoring Sessions
- Importing, Exporting, and Linking Data Files
- Data Management
- Direct Targeting Workflow
- Project Settings

About Projects and Session Files

ModelVision can be used for many tasks. The tasks may be varied and range in complexity from simple data reformatting to large geophysical integration projects. For this reason, ModelVision uses two different operational concepts for its use. These are:

- **Projects** consist of the summary information used for a task. Defaults, magnetic property information, units and task descriptions are retained in project files which reside in specific task directories.

- **Session files** reside in project directories and relate to specific projects. The files contain data sets, models and defaults implemented or modified during a session of ModelVision. At the conclusion of a session, all associated material that is used by ModelVision to that point can be saved. Later, the session file can be recovered such that the work undertaken to that point is not lost. A number of sessions can exist within a project.

Session files allow you to save snapshots of work in progress. All the information in memory and your windows are captured in this file and are restored in a fraction of the time required to load and process the original data. Since the session file is stored in a binary format, it cannot be loaded into a text editor.

Project and session file management is controlled by the New, Open, Save, Save As and Revert to Saved items on the File Menu.

Creating, Saving, and Restoring Sessions

The File items New, Open, Save, Save As and Revert to Saved relate to the use of project session files. Session files are used to store the full work environment including data, models, configuration options and screen windows. Session files are especially useful when a project continues over a long period and you wish to restart the project without reloading data and resetting all the options.

The following dialog is used to Load session files. After highlighting the required session file, select Load.
If only the data and models of a session file are to be loaded and no windows (which may have been present when the session file was saved) displayed, deselect the Restore Displays option.

If a session file from a different directory is required, select the Browse button. A dialog with directory access is displayed. Highlight the required directory containing the correct session file and select OK.

**AutoSave**

ModelVision now comes with an AutoSave option with settings in the File/Setup dialog box. When turned on (default), it will save a temporary session file in the project directory at the nominated time intervals. If ModelVision crashes or is terminated in an abnormal way by the user, this temporary session file is automatically loaded when ModelVision is next started.

There is also an option to turn on a beep when the save is performed (default). This allows you to know when the save is being performed.

**Note**

The AutoSave is not performed whenever a progress bar is displayed. During these times, ModelVision data is in a state of change and saving a session file may lead to unpredictable results. If you are performing multiple calculations or operations, the AutoSave may not occur for some time.

**Important**

It is strongly recommended that you do not rely on the AutoSave and that you manually save sessions on a regular basis.

**Importing, Exporting, and Linking Data Files**

One of the most important aspects of using ModelVision is the simple importing and exporting of data (ASCII, grids, points, binary project files etc). The various data types and supported formats are described briefly with more complete format descriptions (with examples) available in Appendix A: File Formats. The use of external program links for input of data from other software systems is also described.

You can export important information such as data, grids and models to external ASCII files or standard data formats. It is recommended you export and save grids in ER Mapper or Geosoft format since these formats are widely used. In particular, note that ER Mapper grid formats use projection information that is compatible with ModelVision.
## Importing Data

ModelVision can import a variety of external data. Different data types available include:

- Line data in a variety of formats or from external software systems (such as OASIS© montaj™ (Geosoft), Intrepid and ER Mapper)
- Grids in numerous standard industry formats
- Drillhole data for measurements taken from drillholes
- Randomly located data from point readings

Data to be manipulated, displayed and modelled is loaded by the **File>Import** option. Selection of this option displays a second menu list containing ASCII formats and the possible sources of data. With line, point, and grid data, ModelVision will automatically display the data in the most appropriate format. When more than one channel is available, you will be asked to make a selection. For example, if you use the general ASCII import, the line statistics will be shown first and then you can select a channel for display in a stacked profile map.

For more information refer to:

- **Profile Data**
- **General ASCII Data**
- **Drillhole Data**
- **Geosoft Data**
- **ASEG GDF Data Exchange Standard**
- **Point Data**
- **Grids**
The formats supported and procedures for importing these files are described in Appendix A: File Formats.

Profile Data

Fourteen line-oriented ASCII data file types are available for profile import. These options can be divided into the following categories:

- **Single Line** - files that contain multi-column data but with columns relating to only one profile or traverse
- **Multi Line** - combined traverses of multi-column data can be read using this style of input
- **Geosoft Oasis montaj™** database import
- **External Link sources** – access and import data from software applications external to ModelVision.

Detailed descriptions of these file formats and corresponding import procedures is provided in Appendix A: File Formats.

General ASCII Data

The text import tool can handle a wide range of file types and has these additional features:

- Flexible import format definition that can accommodate any number of ASCII data columns and up to 32,000 characters per record
- It can read ASCII files with either fixed width (defined by column size) or delimited by characters you choose
- It has in-built intelligence to interrogate a specified file and ‘classify’ it as one of a range of types. A number of interpretations based on these types is then attempted to assist the decoding and recognition of the file.
- Easy interface for column naming can use a header line or interactive dialogs. Unwanted header records can be skipped during the import.
- Comment lines are accommodated as are various data formats such as real, and scientific notation.
- Use or save Geosoft templates to describe the data format for re-use. Comments, headers and nulls are all handled in the templates.

Procedures for using the ASCII file import tool are described in Appendix A: File Formats.

Drillhole Data

Drillhole data can be imported into ModelVision by reading a file that contains X, Y and Z data location coordinates plus sensor channels. The X and Y coordinates refer to horizontal positioning as for a conventional line oriented dataset and the Z data contains depth information beneath a nominated datum. The default sense of direction is positive down for increasing depth.
Examples of drillhole data files are provided in *Appendix A: File Formats*. Note that throughout the ModelVision documentation, the words downhole, drillhole and borehole are all synonymous. For further information on modelling magnetics and gravity at the reading locations of drillhole data, refer to *Drillhole Modelling*.

**Geosoft Database**

A Geosoft Oasis montaj™ database can be loaded directly into ModelVision. These files typically have the file extension .GDB and are created using the import utilities associated with the Oasis montaj™ software. For details, see *Appendix A: File Formats*.

**ASEG GDF Data Exchange Standard**

The ASEG-GDF2 data exchange and archive standard for geophysical point and line data is fully supported. The ASEG-GDF is a self defining format that allows located data to be automatically identified and loaded. An ASEG-GDF2 data exchange contains a decodable description of the data in one file plus the geophysical data in one or more additional files. The description file defines information such as field names, units of measurement, format, comments and missing data substitution values (nulls). The data is contained in simple, multi-column ASCII files (tables). For more information, see *Appendix A: File Formats*.

**Point Data**

Certain data collection procedures acquire data at random locations. Examples of this are regional gravity surveys or geochemical assaying projects. With these data types there are no line-related methods of collating the data and so each record of the input data file is dealt with individually. There is however, a requirement that point data sets have an associated number similar to the line specification. This number is referred to as a ‘point set identifier’ and is used to associate records with similar properties (for example, gravity datasets, gold assay datasets, magnetic solution points etc). Note that each data point can have its own identifier if this is more convenient, rather be grouped. The input data type is of a definable XYZ format where the X and Y coordinates specify the easting and northing location of the sample point. A number of Z channels corresponding to measurements at each sample location can be loaded.

Points can be modelled for their gravity or magnetic response either individually or collectively. Use the Model>Point Control option to select the points or groups of points to model. Results from modelling cannot easily be displayed within a section, and so results are usually presented in map format with modulated symbols, labelled points or as contours or images (after gridding results).

Additional information and examples of point data files and their format are provided in *Appendix A: File Formats*.

**Grids**

ModelVision is capable of importing various grid formats, some of which are written in ASCII although most are in binary. In most grid formats, the first few lines of the file are assigned to a header. The header contains information relating to origin, extent, numbers of rows and columns, grid mesh size, rotation etc.

The grid formats and supported by ModelVision are described in *Appendix A: File Formats*. 
Exporting Models and Data

The Export option enables various output formats to be written using data which has been loaded or created in ModelVision. When selected, the menu options that appear are shown here.

The File>Export options available in ModelVision

Profile Export

The available profile export options include:

- TOOLKIT single line format
- ASCII (LIN xe) Multi-line format
- Geosoft database (GDB) - Geosoft Oasis montaj™ database
- Geosoft Multi Line (XYZ)
- Geosoft Single Line (DAT)
- ASEG-GDF2 ASCII files
- All cross-sections (BMP and EGB) – Export bitmaps and their georeferenced locations for use in Discover PA. See Displaying ModelVision Data in Discover PA.
- AMIRA format for TEM files

See Appendix A: File Formats, for details of these formats.

Grid Export

The available Grid Export options include:

- Encom Grids
- ER Mapper
• Geosoft Binary
• ASEG GXF
• Geopak Binary
• USGS Binary

See Appendix A: File Formats, for details of these formats.

Drillhole Data Export

Drillhole data can be exported as an XYZ data file. The data contained in the file is in ASCII multi columns with the X and Y coordinates referring to horizontal positioning as for a conventional line oriented dataset. The Z data contains depth information beneath a nominated datum. The default sense of direction is positive for increasing depth. Additional data columns are created which record the nominated output channels requested by the user. Examples of drillhole data files are provided in Appendix A: File Formats.

Alternatively, drillholes can be exported as a Geosoft Oasis montaj™ database (with filename extension .GDB).

Point Data Export

ModelVision can create ASCII multi column output files which contain point or random location data (file extension default .PTS). This data type usually has no line name recorded and so each record of the created data file is written individually with no relationship to any other record. The output data file is of a definable XYZ format where the X and Y coordinates specify the easting and northing location of each point. A number of Z channels corresponding to requested data channels at each sample location can be created. Examples of point data files and their format are provided in Appendix A: File Formats.

Alternatively, points can be exported as a Geosoft Oasis montaj™ database (with filename extension .GDB).

DXF Export

ModelVision can export models in AutoCAD digital exchange format (DXF). The file is a three-dimensional DXF format that can imported into other software such as mine planning applications or 3D modelling or visualization systems (such as Noddy and Discover PA). Facets of each body are represented by polygons in the DXF. An option is available to decompose all polygons into triangular facets. This option is available from the Modelling>Export>DXF Format menu option.
External Links

- Reading Directly from External Files with ModelVision
- Writing Directly to External Files with ModelVision

Reading Directly from External Files with ModelVision

ModelVision enables access to data contained in other software systems and databases. This access is available through a user definable 'external link'. An external link is an executable program that implements the calling and data retrieval routines of the external software system. This link is initiated by ModelVision that opens and accesses the storage facility of the external data. You are able to interrogate the contents of the external database and select the data required based on line ranges and channels. Once specified, the link program extracts the required data and stores it in a temporary file that ModelVision can read and input.

A number of example link programs are provided with the ModelVision installation. An example of this type of link is to the Intrepid processing system.

A second form of link is the Geosoft OASIS montaj add-in. With this form of link, ModelVision is run from the Geosoft program menus. The montaj add-in is supplied with ModelVision.

The use of all external link programs and add-ins are described in Appendix C: External Data Links.

Writing Directly to External Files with ModelVision

ModelVision can export data to other software systems or databases through external links. An external link is an executable program written by the user or a third party that implements the calling and data retrieval routines of the external software system. This link is initiated by ModelVision and opens and writes data to the storage facility of the external database or software system. The user can specify the line ranges and channel data to export. Once specified, the link program writes the required data from ModelVision and stores it in a temporary file. The external link passes the data in this file into the external database or software system.

The construction and use of external link programs is detailed in Appendix C: External Data Links. Example link programs are provided with the ModelVision installation.

Displaying ModelVision Data in Discover PA

The Discover PA software is a powerful display environment that is capable of displaying nearly all the data used in ModelVision but with additional visualization capability such as interactive 3D and anomaly management.

Data that can be displayed from ModelVision as well as Discover PA includes:

- Line-based output from ModelVision when exported using the Geosoft GDB format
- All grid formats (ER Mapper, Geosoft, Surfer, etc.)
- ModelVision models when exported as DXF vector files (see Exporting Models)
- Drillholes used in ModelVision when exported in GDB or ASCII line formats compatible with the import utility of Discover PA (see Profile Export).
Bitmap cross-sections as geo-referenced files with (WHOLE) or without (DEPTH) their response tracks (use File>Export>Profiles>EGB Profiles). The bitmap file (geo-referenced) is accompanied by a secondary file with the filename extension of EGB. Discover PA uses the EGB file to display the bitmap saved from ModelVision and to correctly position it for display. The bitmap has the format of a Windows BMP file.

An example of an Discover PA three-dimensional view using data exported from ModelVision is shown below. This is an interactive display allowing zoom in/out, pan and fly through capability.

![An example of air photo, drilling and ModelVision bodies displayed in Discover PA](image)

To export the various items that may be displayed or available for use in Discover PA, the File>Export>Profile Analyst option displays the following dialog:

![Export to Profile Analyst](image)

If requested the following formats are used to output the various entities and are saved in the project directory:

- **Grids** – Created as ER Mapper format files (.ERS)
- **Lines** – Saved in a Geosoft database called MV_LINES.GDB
- **Holes** – Saved in a Geosoft database called MV_HOLES.GDB
- **Points** – Saved in a Geosoft database called MV_POINTS.GDB
- **Models** – Exported as AutoCad DXF format called MV_MODEL.DXF
• **Profiles** – For each displayed cross-section, an EGB and a bitmap file are created. The bitmap can contain both the profile data and model cross-section (if WHOLE is selected) or just the model cross-section (DEPTH option).

**Note**

Profiles that are iconized in a display in ModelVision are not exported as a bitmap. To create bitmaps of these, maximize their profile windows before requesting the Discover PA export option.

---

## Data Management

- **Maintaining Data Sets**
- **Using the Clip Grid Tool**
- **Using the Clip Project Tool**

### Maintaining Data Sets

The Data Maintenance option enables projects, channels, lines, points, drillholes and grids to be renamed, interpolated, deleted or arranged into subsets.

**Utility**

```
Data Maintenance   Project
Body Table          Line
Reports             Drillholes
Email System Info   Points
Colour Table Editor Grid
```

*Data Maintenance menu selection*

Select a data type from the menu item displayed. Different data maintenance operations are provided depending on the data type selected. Below is an example of the displayed dialog for line data (a similar dialog is used for drillhole maintenance).
Dialog for Line Maintenance

Lines can be renamed or deleted. Multiple selection of lines is possible. The Delete option requires you to confirm your selection before any data is deleted. The Interpolate option performs the same operation as the Interpolate menu item. Refer to the section on Interpolate for information on this feature.

Channels can be renamed or deleted by selecting the Channel Maintenance push button. When selected, the following window is displayed:

Channel Maintenance dialog

As for lines, you are required to confirm your channel selection before a deletion is done.

An option is also provided to Generate Lines from the rows of a grid (in the Utility>Data Maintenance>Grid).

Grid Maintenance dialog
This process automatically creates traverse lines (suitable for modelling) with data values interpolated from the nominated grid(s). You can use the **File>Export>Profiles** option if desired to create an ASCII file with easting and northing locations for the grid. ModelVision can use any of the supported import grid formats and the content of an exported file can be controlled in the **Export>Profiles** dialog.

The line names are row_1, row_2 etc. and the sample spacing is equal to the row cell size. These can be renamed in the **Utilities>Data Maintenance>Line** utility if required. This method of creating lines is similar to the Traverse and Synthetic options, but the grid rows are used instead of a user defined traverse. Also note that null values of the grid is included in the line data as –99999.

Clipping of line, grid or project data to rectangular geographic coordinates is also possible by selecting the **Clip** option. This option presents a window which enables clipping of the project or line area as shown.

**Important**
If a project, grid or line data is clipped using this option, the original data in memory is destroyed. Save the original data in a work session file if data security is required.

When Data Maintenance of a grid is requested, it is possible to sub-sample a grid using the **Clip** option. The following dialog is displayed:

Grid resampling (specifying a different **Spacing**) or grid reduction can be undertaken with this feature. This is particularly useful where a large grid is loaded but only a portion of it is required for modelling.
Using the Clip Grid Tool

The Grid Clipping option enables you to graphically define a polygon for clipping a displayed grid. Any map window (contour, image etc) of a grid can be used for clipping. You can use this tool to draw a polygon in a map view and apply the tool to clip the grid either inside or outside the mask area. Null values are assigned to the excluded area. The size of the grid in memory is not changed by the boundary of the clip operation.

To use this tool, select a map window, click the **Grid Clip** button, and then position the cursor in the map window (which is now a ‘+’ shape). Position the cursor at the first vertex of the polygon outline and click the left mouse button. Drag the cursor to the next vertex, click the mouse button again and repeat until the polygon shape is drawn. To close a polygon, double click the left mouse button, or bring it close to the first vertex and click.

**Important**

If a grid is clipped or sub-sampled using this option, the original grid in memory is destroyed. Use the Calculator option to create a copy of the original grid before performing any clipping so subsequent grid clipping can be achieved without having to reload the original grid.

Using the Clip Project Tool

Use this tool to reduce the data in a project to a rectangular clip boundary. All grids, points and lines are clipped to this data range. Note that the clip investigates each point independently. For large data sets, it is faster to first delete any lines that do not include any points to be retained.

The Clip Project option operates in map displays only. To use this tool, select the map window, click the **Clip Project** button, and then position the cursor (which is now a ‘+’ in the map window). Locate the cursor at a corner of the new project, click the left mouse button and drag the cursor to the opposite corner of a rectangular area. When the button is released, the clip dialog is presented:
Once the clip dialog is displayed, you can edit the four project limits to precise values or use the Snap to button to force the limits to adjust to the next largest limit.

**Direct Targeting Workflow**

The direct targeting workflow methodology is the preferred way for undertaking full 3D modelling using multiple cross-sections, an integrated regional and simple active point selection. The technique bundles multiple single steps into a rapid workflow procedure that allows you to target an anomaly or anomaly complex for forward modelling and inversion. This process can save 5 to 15 minutes per anomaly in preparing your data for modelling and inversion. You can move easily between anomaly targets and as you complete each target, the models are added to the master session.
Illustration of the steps involved in selecting a target, running the Target tool, and returning the model to the master session.

**Before You Run the Target Wizard**

You will first create a master session that has all your line data, grids and a primary image view of the whole survey area. The Target tool will then be used to focus on individual anomalies or anomaly groups and their associated data without the overheads of a full project. Each time a target is completed, the new bodies are returned to the master session from which you can then pick another anomaly. The process is very easy to work with and the sub-session created for each target is saved for later use.

Before you work with the Target modelling tool, you need to ensure that your modelling and line control parameters are set in the same way as for modelling a single line. This requires the IGRF values to be set in the project properties dialog (File>Project Properties) and the line control parameters to be set (Model>Line Control).

Make sure you turn on the regional and set the default value for first order. This can be changed later if necessary from the Target dialog.
Target Wizard

Select the Target Wizard toolbar button to access the control dialog shown below. Note that you can change your map view that you will use to select the target anomaly at any time during this process. You can zoom, pan and change map layer parameters to enhance the features that you want in your target view.

![Target Wizard Dialog](image)

Each target area has a named polygon associated with it so that you can return to the exact area selection at a later time. You create the polygon or rectangle in a map view after selecting the Draw Polygon or Draw Rectangle buttons in the wizard dialog. If you want to change the polygon, you can delete it and draw it again or just draw a new one. The polygon is more flexible because you can skirt around interfering anomalies to reduce their impact during inversion. Note that the vertices of the polygons are not selectable for editing.

You can also select a previously drawn polygon from the list or the map (if they are displayed as a Map Layers>Polygon Boundary layer) and use it to define the working area of the Target Wizard process.

The Preview button will turn the survey lines red for the bounding rectangle of the selected area which includes the polygon plus the data expansion margin surrounding the polygon. Only the points selected within the polygon will be activated during the modelling and inversion procedure, but the full area is used to determine the local regional. You can change the percentage expansion margin, but 40% provides a reasonable area for estimating the first order regional because it is less biased by the target anomaly within the polygon.
A map view showing the active polygon and active line segments within the bounding rectangle.

The Options section of the dialog provides control over the number of cross-sections, minimum line length, data scaling and regional order. You should experiment with the setting to determine the display style that best suits your needs. If you want to optimise the display it is easy to quit the Target session and return to the master to reselect your parameters.

The Activate open Windows only checkbox allows you to restrict the inversion and model updates to the open cross-section windows. This is very useful when selecting large data areas with many lines and it also helps with the precision of depth modelling by ensuring there are more data samples over the edges of the target bodies. Use the Show button to see which Cross-sections are selected for computation and visualisation. If you change the value of Open windows on lines. Max = and press Show again, it will also show the change in selected lines.

If the same target has been processed before, you can use the previous regional that was saved with the sub-session by turning off the checkbox Compute new regional. If you have selected an existing target boundary, then a regional of the same name would have been saved during the previous target session.

When you select the Apply button, ModelVision creates a target subset of the data using the bounding rectangle and automatically opens a new target session with the data, cross-sections and map windows ready to start modelling. All points inside the polygon are activated for modelling and those outside are deactivated. ModelVision automatically saves the master session prior to opening the target sub-session and the master can be reopened when you have finished the target modelling with the new bodies added to the master model.

The Target Workspace

As soon as you select the Apply button, the following automated steps are applied to prepare the target workspace:

- Save the master session.
• Clips the project to the bounding rectangle.
• Models are not clipped but deactivated outside the bounding rectangle.
• Activates line data points within the bounding polygon.
• Deactivated line data points outside the bounding polygon.
• Activates any bodies that exist within the bounding rectangle.
• Automatically opens the optimum number of cross-sections.
• Automatically scales each cross-section.
• Opens the clipped version of your map view.
• Opens any other window type from the master session.
• Automatically tiles and positions the map and section to fit the workspace.
• Fits a first order regional to the lines within the bounding rectangle.
• Saves the target session using the master file name + polygon name.

Target workspace created automatically from the polygon selection.

The vertical scaling of each cross-section is identical in the depth section, but any graph track is scaled according to the data range of the line. There are various global layout options that are simple to use to control your view.
Matching data scales is applied by using the right mouse click within the graph area to access the cross-section configuration menu. Select Apply Scale to All and all windows will be redrawn at the same scale as your selected cross-section profile. You normally select the section with the largest dynamic range, but in some cases this may not be optimal. You can also use the manual scaling option on one section and then apply the global scaling function. You can also use the Apply STYLE to All option if you want to change characteristics such as line thickness, colour, style plus a range of other section properties such as body property colour modulation. The style of the selected cross-section window is propagated across all open cross-section windows.

Right-click to access the Apply Scale to All function.

Sections after global scaling of the profiles.

Layout options for the workspace are controlled from the View menu. These global functions allow you to:

- Refit all the cross section views.
- Re-tile the windows after adding or deleting windows.
• Change the global tiling defaults.
• Remove all sections from the workspace.

View menu with global window options.

You can match the scales of all the sections with optimisation of the vertical range of each section graph and model depth section views. This is useful if your workspace is becoming untidy and you need to reset it. You may need to reapply the Apply Scale to All function following this option because each section can have different data ranges. For more details on these options, see Custom Tiling and Scaling.

Modelling and Inversion

Once your windows are configured, you are ready to start modelling and inversion of the target anomaly. You can insert new bodies in the map or a cross-section, but make sure that you start the inversion from the map view as this ensures that all lines are included in the inversion. All bodies from the master session are available to you, but they are normally deactivated and made invisible while you are working on a specific target. You can use the Body Parameters toolbar option to access and activate individual bodies that may influence the target inversion.

Body Parameters table activated from the ModelVision Toolbar

For more details on modelling and inversion across multiple lines, see Modelling Techniques, Working with Models, and Inversion. In the example below, a vertical circular pipe has been inserted into the map between the high and the low and it is used as the starting model for inversion.
Workspace layout after inserting a pipe model.
After you have run your modelling and inversion processes you may have a workspace that looks something like the following image.

![Workspace layout following modelling and inversion.](image)

You return the model to the master session by selecting the **File>Restore subsession to master** menu option. You will be asked if you want to save the sub-session for later use which updates the initial sub-session file. The updated model will be returned to the master session regardless.

**Target Feature Maintenance**

Each target polygon that you create is stored in memory and may become untidy with unwanted targets or multiple polygons over the same target. You can remove them by selecting them in the map view and followed by the **DELETE** key.
Alternatively, you can delete unwanted target polygons using the Feature Maintenance dialog which is accessed from the Utility>Data Maintenance>Feature menu.

You can rename and delete individual polygons from the list and change the display properties of the polygons either globally or individually.

**Project Settings**

The dialog for entering and reporting the project properties

ModelVision requires you to organize your work into project directories. When you create a new project using the File>New>Project menu item, a project definition file (MVPROJ.INI) is created in a pre-existing directory. Information specific to the project is stored in the file and updated whenever you exit ModelVision. For details on the content of this file, refer to Appendix D: Defaults and Settings.
The magnetic field parameters are entered manually or via the IGRF calculator button. Once you set the magnetic and gravity modelling units, they are maintained for all projects. Coordinate projection details are used for export grids that support projection parameters. If you do not require this information, turn on the Local Grid option.

Project settings include:

- **Project Directory**
- **Units**
- **Magnetic Field Specification**
- **IGRF Calculator**
- **IGRF Grid Creator**
- **Map Projections and Datums**
- **Project Description**

**Project Directory**

Project details are written to a file called MVPROJ.INI. Each project must be created in its own folder. If you create a project in a folder containing an existing ModelVision project, the details of that previous project are overwritten. MVPROJ.INI contains coordinate projection and data details, a project description, magnetic field details, and default values for bodies and AutoMag settings. Some of this information may also exist in session files (see below).

The Browse button can be used to graphically select a folder. After clicking this button, a folder tree is displayed. Highlight the required folder for saving the project and click OK.

Selection of a project directory can be made from the Browse option of the Projects dialog

Whenever a session file is opened, ModelVision performs a compatibility check. It flags any discrepancies between the project and session file settings and allows you to select either the project or session file settings.

You can save multiple sessions files within a project either to keep a historical record of your work and/or to save details of work performed on specific anomalies.
Units

ModelVision uses many specific measurements for data and modelling. Specification of the units of these measurements is an essential part of correctly determining model responses. The following units are used:

- **Distance** - metre (m) in the SI system or centimetre (cm) in the emu or cgs system of units. Note: imperial units such as feet are not supported.

- **Mass** - kilogram (kg) in the SI system or gram (g) in the emu or cgs system of units.

- **Gravity field** - milligal (mgal) in cgs units or micrometre per second squared ($\mu$m·s$^{-2}$) in SI units. This is referred to as gu for gravity units. 1 milligal is equivalent to $10^{-3}$ cm·s$^{-2}$ or $10 \mu$m·s$^{-2}$ or 10 gu.

- **Gravity gradient** - Eotvos (Eo) units for model computations and units per kilometre for gradient filters. Note 1 Eotvos unit is defined as 0.1 mgal·km$^{-1}$ or 1 gu·km$^{-1}$ which is also $10^{-9}$ s$^{-2}$ in both the SI and cgs system of units.

- **Magnetic gradient** - units per kilometre for both model calculations and gradient filters.

- **Density** - g·cm$^{-3}$ or kg·m$^{-3}$ in SI units.

- **Magnetic field strength** - gamma for emu/cgs units or nanotesla (nT) for SI units

- **Magnetic volume susceptibility** - cgs or SI units. Note that 1 emu (cgs) unit is equivalent to $4\pi$ SI units.

- **magnetisation** – emu (cgs) units of gamma or SI units of ampere per metre ($A\cdot m^{-1}$)

To assist in conversion between cgs and SI units the following table provides additional information.

**Table of Unit Conversions**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>cgs Unit</th>
<th>SI Unit</th>
<th>Conversion (multiply cgs unit to derive SI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance</td>
<td>centimetre (cm)</td>
<td>metre (m)</td>
<td>0.01</td>
</tr>
<tr>
<td>Density</td>
<td>gram per cubic centimetre</td>
<td>kilogram per cubic metre</td>
<td>1000.0</td>
</tr>
<tr>
<td>Susceptibility (k)</td>
<td>-</td>
<td>-</td>
<td>$4\pi$</td>
</tr>
<tr>
<td>Magnetic field (B)</td>
<td>gamma</td>
<td>nanotesla</td>
<td>1.0</td>
</tr>
<tr>
<td>Gravitational</td>
<td>milligal (mgal)</td>
<td>gravity unit (gu)</td>
<td>10.0</td>
</tr>
</tbody>
</table>

The terms cgs and emu (electromagnetic units) are synonymous. In the SI system, the unit of magnetisation ($J$) is ampere per metre ($A\cdot m^{-1}$) and in the emu or cgs system it is the gauss, where

$1$ gauss = $10^6$ gamma = $10^3$ A·m$^{-1}$

Hence the unit conversion for these quantities is:

$J_{SI} (A\cdot m^{-1}) = 1000 \times J_{emu}(\text{gauss}) = 0.01 \times J_{emu}(\text{gamma})$
When the presence of remanence is suspected, the natural remanent magnetisation (NRM) \( J_{nrm} \) is specified in terms of magnetic volume susceptibility \( k \) and the Koenigsberger Ratio \( (Q) \) which can be defined as:

\[
Q = \frac{J_{nrm}}{J_{ind}} \text{ where } J_{ind} = k F
\]

\[
J_{nrm} \text{ (SI)} = Q \left( k_{SI} F \right) / 400 \pi (A \cdot m^{-1})
\]

\[
J_{nrm} \text{ (cgs)} = Q \left( k_{cgs} F \right) (\text{gamma})
\]

where the parameter \( F \) is the magnitude of the local geomagnetic field measured in nanoteslas (gammas) and \( J_{nrm} \) and \( J_{ind} \) are the magnitudes of the remanent and induced magnetisations respectively. Note that the Koenigsberger ratio is dimensionless and identical in both the SI and cgs system of units.

**Magnetic Gradiometer Units**

Magnetic gradiometer units used in ModelVision are in units of gammas or nanotesla per metre.

**Gravity Gradiometer Units**

Gravity gradiometer units used in ModelVision are:

- The gravity components \( gx, gy, gz \) milligals or \( mm \cdot s^{-2} \)
- The Tensor components \( G_{uv}, G_H, G_{CEotvos} \)
- The directions \( AH, AC \) degrees clockwise from north

**Magnetic Field Specification**

Magnetic bodies interact with the Earth's magnetic field to produce an opposing induced magnetic field. The magnitude of this opposing field is proportional to the magnetic susceptibility of the body.

![Magnetic anomalies by induction in fields of different inclination](image)
Source bodies generate different induced magnetisations at different latitudes due to variation in the inclination of the Earth’s magnetic field. At high latitudes bodies produce predominantly positive total field anomalies, at low latitudes the anomalies are predominantly negative, and at mid latitudes anomalies are dipolar. In order to correctly compute induced magnetisations the strength and direction of the primary field must be specified. In ModelVision, the local magnetic field is specified as intensity with its direction being defined by an inclination and declination in degrees.

If strong remanent magnetisation exists in the body, the total magnetisation is computed as the vector sum of the remanent and induced magnetisation components. Information on remanent magnetisation is often not available and pure induction is assumed in most modelling. ModelVision can compute the influence of remanence if the data is available.

**IGRF Calculator**

Magnetic modelling in ModelVision requires specification of the intensity, inclination and declination of the average magnetic field for the area under study. Only the total magnetic intensity information is available from most aeromagnetic surveys.

ModelVision provides an IGRF calculator to estimate the magnetic field parameters required for modelling. The International Geomagnetic Reference Field (IGRF) is a standard specification of the harmonic component values and their rates of change from which the background strength and direction of the earth’s field can be derived as functions of space and time.

The IGRF model has been updated to be consistent with the definition and code provided by IAGA, the International Association of Geomagnetism and Aeronomy. Details of the model can be found in Finlay et al., 2010.
An extensive set of maps is provided at varying scales to cover the world. If you wish to use your own area map please contact Tensor Research Pty Ltd and we can provide details on how to do this.

**IGRF Grid Creator**

Grids can be created for the Earth’s magnetic field intensity, declination and inclination for any region of the Earth. This can be done for a specified date and altitude or, if an elevation grid is available, for the elevations at all grid points.

**Generating IGRF Grids**

This tool is activated from the IGRF tool on the toolbar. Select the **Grid Creator tab** and the most suitable map from the drop down list of maps. The limits displayed will automatically change to the latitude and longitude limits of that map. You can change these and set the grid interval, a date between 1970 and the present and the altitude. When you hit the OK button the IGRF values will be computed and three grids will be produced with fixed names of IGRFint, IGRFdec and IGRFinc.

---

**Note**

These grids have latitude and longitude limits in degrees. They can be displayed as grid images and contours in a map view but cannot be combined in that window with data or models which are defined in metres.

**Using an Existing Grid**

If you have a grid with degree limits already in memory you can use that grid instead of specifying new limits. Tick the **Set from Grid** checkbox, select the grid and the values displayed will update to the grid limits and intervals. A button linked to the synthetic grid creator is provided to assist if you want to create a new synthetic grid without leaving the IGRF utility.

---

**Using an Elevation Grid**

If you have an elevation grid with altitudes above sea level in metres you can compute the IGRF values for all points using that elevation data. To do this select the elevation grid and make sure the **Fixed** checkbox is not ticked.
Map Projections and Datums

ModelVision stores map projection and datum information for reference purposes and is reproduced in export formats that require this information. The projection information is used for any internal calculations within ModelVision.

The selection lists for datum and projection are derived from the data files DATUM.DAT and PROJECT.DAT. The format specification for these files is identical to those used in ER Mapper and is detailed in Appendix D: Defaults and Settings. These files can be edited to remove all datums and projections that are of no interest in your project areas. This reduces the length of the selection list.

Project Description

The project description (60 chars) allows you to save descriptive information that is retrieved each time you open the project. The description is saved in the project and session files and is displayed in the project dialog.

Other information can be entered which details the date of project creation, modification date, who created the project and a brief title.

Default Settings

The File>Setup option enables ModelVision default options to be edited.

File>Setup dialog to define ModelVision defaults of a project

Default settings can be controlled for:
• The directories for default access to help, look-up table and convolution filter files
• The units to be used in either magnetic or gravity modelling
• The annotation and tick sizes for map, multi-channel profiles and X-section displays
• The precision for displaying length parameters on various dialogs
• The colour palettes used for displaying bodies, curves and as default for modulation by property and for general display purposes wherever a colour choice is available
• A switch to disable automatic line flipping. By default ModelVision analyses the directions of lines in a survey and chooses a consistent direction for viewing all lines. This is especially useful for airborne surveys with alternating line directions.

The default values displayed in the dialog are stored in the MVISION.INI defaults file (see Default Settings File).

**Default Settings File**

A number of parameters are defined in a default file called MVISION.INI. This file is used by ModelVision when it is initially executed. The file is updated at the end of a ModelVision session so that any changes made to the parameters during the course of the session are saved. MVISION.INI is an ASCII file which may be edited by the user to assign preferred defaults but this is not recommended since they may change whenever ModelVision is exited and the file rewritten.

The purpose of the MVISION.INI file is to provide logical control over a number of operational defaults when ModelVision is initially executed. The defaults file must be called MVISION.INI to be recognized by ModelVision. It must reside in the directory that contains the MVIS executable as defined by the Properties setup within Microsoft Windows.

If no default file is found, ModelVision uses defaults set within the program. Details and additional information associated with the MVISION.INI file are provided in Appendix D: Defaults and Settings.
7 Controlling the View

Learn how to control the appearance of the data and models that are displayed in the various views. Although the models are controlled interactively within the views, this section does not teach you how to model. It shows you how to control the presentation and attributes of your model and data.

In this section:

- Managing Windows
- Navigating the View
- Map Linking
- Using the Colour Table Editor
- Selecting Objects
- View Types

Managing Windows

Because most time is spent interacting with graphical displays there are several controls and toolbars that change the appearance of your windows and speed up the operation of ModelVision. It is important to note that not all options are accessible through the menu at the top of the main ModelVision window.

Conventional Windows behaviour has been adopted wherever possible so that the operations are similar to other Windows programs.

ModelVision allows you to have many windows open at a time, but only one can be active for user input at any one time. The window bar at the top of each window changes colour when it is selected with the mouse. The colour of this bar is determined by the Windows Properties settings.

When an action is selected from a toolbar, the action applies to the currently active window.
Navigating the View

The behaviour of the mouse, mouse buttons and keyboard are fundamental to the operations of graphics manipulation in ModelVision. The program behaviour also changes according to the mode of operation such as pointer, zoom or pan. The behaviour can be further modified when a mouse operation is performed in conjunction with the keyboard.

Panning and Zooming

- **Zooming In and Out**
- **Zoom Previous**
- **Pan**
- **Fit**
- **Redraw**

Zoom Mode

Zoom in all five window types. In multitrack and cross-section windows it is sensitive to which track has the cursor.

- Left click - zooms in by a factor of 2 about the selection point. (Not profile or multitrack).
- Left click + SHIFT key - zooms out by a factor of 2 about the selection point. Reverses the zoom in to zoom out. (Not profile or multitrack).
- Left click and drag - selects an area for enlargement. (Not perspective).
- Left click, drag + SHIFT key - zooms out by the ratio of the size of the window divided by the size of the selected area. (Not perspective).

If Zoom Out is selected, the behaviour is the reverse of the above.

Zooming In and Out

Zooming operations can be performed on all display windows. Depending on whether Zoom In or Zoom Out button is selected, the cursor shape changes to appear as a magnifying glass containing a minus (zoom out - reduce view) or a plus (zoom in - magnify). The cursor changes shape to zoom in or out relative to the active window.

There are two alternative procedures for zooming:

**Zoom Procedure 1**

1. Activate the window you want to zoom by clicking while the cursor is positioned within the window. The active window has a highlighted top window bar.

2. Select either the Zoom In or Zoom Out button. Move the cursor to the active window and click the left mouse button on the point about which you wish to zoom. The window is redrawn and a 2-times zoom in or out is performed. (This method does not apply to track windows i.e. cross-section and multitrack.)
The zoom cursor remains active for the window until the Pointer button is selected.

**Zoom Procedure 2**

1. Activate the window you want to zoom by clicking while the cursor is positioned within the window. The active window has a highlighted top window bar.

2. Position the cursor on a location which represents a corner of a ‘zoom window’. Click the left mouse button and drag out a zoom rectangle while the mouse button remains depressed. When the zoom rectangle encloses the required area, release the mouse button and the window scales and redraws the selected area. (This method applies to all windows except the perspective display.)

In the cross-section window and multitrack window the zoom rectangle is track specific. It will rescale the vertical axis for the specified track only. It also uses a minimum tolerance enabling you to zoom independently on either axis. (see Functional Elements of a Multi-Track Display)

In the Zoom Out option, ModelVision scales the rectangle to the available window space by taking the ratio of the sides and matching this to the ratio of the sides of the available window.

---

**Note**

When zooming out, it is possible to position the second defining corner of the zoom rectangle (using Procedure 2 above) outside the window being used. This means that the selected area is not only zoomed, but also panned to redraw the defined area.

When the SHIFT key is depressed as the cursor is moved, the mode of operation of the mouse changes from Zoom In to Zoom Out and vice versa.

Zooming in a Multi-Track display, when in Zoom In or Zoom Out mode, can be performed using the Reference Track combined with zoom box windowing without using the Zoom In or Zoom Out buttons. For further information on this, refer to the Multi-Track View.

**Vertical Scale**

- 1,2,3,4,5,6,7,8,9,0 - Vertical scale multiplier for perspective view.

**Zoom Previous**

The **Zoom Previous** button automatically causes a redisplay of the active window and use the zoom level previously displayed. Multiple zoom levels are retained for this operation so repeated selection of the option causes the display to revert to earlier levels of zooming.

**Pan Mode**

In pan mode you hold the left mouse button down and drag the point to another location. This shifts the initial point to the final position of the mouse when the mouse button was released.
Pan

The Pan option enables the contents of a display window to be roammed. If selected, the cursor changes to a + when moved over the active window. Panning is achieved by positioning the cursor over a point, clicking the left mouse button, and moving the cursor to a new location. When the mouse button is released, the initial point is moved to the new location. Panning is not operational in the Multi-Track display option although the reference track can be used similarly.

Fit

The Fit button rescales a window to accommodate the data and models displayed. The option operates on all display formats (Multi-Track, X-section and Maps). If a zoom or pan operation has been performed, the Fit option can be used to return to a manageable display. In some instances, where two datasets of different geographic origins and extents are imported into ModelVision and a Fit is requested, the rescaling operation may seemingly not display anything. In this circumstance, Fit attempts to enclose all data in the display window and with widely differing origins this is inappropriate.

Redraw

In instances where a window display is not updated by a particular operation, or is redisplayed with zoomed or fitted presentations which are inappropriate, the Redraw option can be used to ‘clean-up’ the display.

Interrupt Redraw

- Q - Interrupts the drawing of a map so that another operation can be performed. If very fine contour maps or images are being drawn this key can save considerable time.

Map Linking

The ability to link map windows in a session is available via the context pop-up menu (right mouse button) on the map view. Alternatively, the same map linking options can be accessed from the Window option in the Map Layers table. This option can be used to transmit the map range (X and Y) of one map to other maps. When combined with the Tile Options in the View menu this capability makes it easy to compare data visualisations.
To link multiple maps together select the **Link All Maps** option from the pop-up menu in one of the maps. The next navigation (e.g. pan, zoom in, zoom out, zoom fit) performed on any one of the maps will transmit the map range to the other linked maps.

When a new map window is created select the **Link Map** option from the pop-up menu of this map to include this in the map linking. All maps which are linked will have a "tick" symbol next to the Link Map option in the menu.

To unlink a map view from the series of linked maps select the **Link Map** option in the map view to remove the tick symbol.

![Map Menu](image)

*A tick mark next to the Link Map option indicates a map is linked.*

When resizing a map window from any of the edges or corners of the window the Xmin and Xmax limits are kept constant. Therefore, if you make the map window narrower the scale will get smaller and vice versa.
The Link All Maps option transmits the x and y map range of one map to all other maps.
Using the Colour Table Editor

The colour table editor is accessed from the Utility>Colour Table Editor menu and is used to create and edit colour look-up tables (LUTs). Look-up tables used by ModelVision use the same format as the ER Mapper format by default, but MapInfo "clr" and Oasis montaj "tbl" formats are also supported. If you create an LUT file it is stored with the set supplied at installation and is available to be used for the display of bodies, contours, grid images, track displays, etc. An example of a colour look-up table file is shown below:

```
LookUpTable Begin
Version = '1.0'
Name = 'Step Contour'
Description = '16 bit Step Contoured'
NrEntries = 16
LUT = {
    0 0 0 65535
    1 0 12287 65535
    2 0 24575 65535
    3 0 36863 65535
    4 0 49151 65535
    5 0 61439 65535
    6 8447 65535 57088
    7 20735 65535 44800
    8 33023 65535 32512
    10 57599 65535 57936
    11 65535 60928 0
    12 65535 48640 0
    14 65535 24064 0
    15 65535 11776 0
}  
LookUpTable End
```

Colours are assigned a value of Red:Green:Blue in the range from 0 to 65535. The above example breaks the data range linearly into 16 separate colour ranges. Larger numbers of colour assignments can be entered if required.
Creating or Editing a Colour Look-up Table

Select the Colour Table Editor from the Utility menu.

This utility allows the creation of a table with any number of colours. Each colour can be set by clicking on the colour patch to bring up a colour chart, or by setting exact red, green and blue values if the Show RGB box is ticked.

The comment field is optional and in ModelVision the comment field is only used if the LUT is used for body display. The names will be used when creating new bodies and the colours and names can appear in a lithology legend in either map or cross-section views. The order in which they appear in the LUT Editor will be the same as they appear in the ModelVision legend.
An example of a colour look-up table file which could be used for body lithologies is shown below:

```
LookUpTable Begin
Version   = '1.0'
Name      = 'Rock-1'
Description= 'Test Rock Types'
NrEntries = 16
LUT = {
    0  22784  22784  22784  #Slate
   1  65280   0     32768  #Tuff
   2     0      0     59904  #Gabbro
   3  49408  65280  49408  #Quartzite
   4  57088  51712  44032  #Siltstone
   5  24832  49152  49152  #Schist
   6  63488  64256  46848  #Chalk
   7  39168  52224  59392  #Dolomite
   8  32000  40448  49152  #Greywacke
   9  65280  55040     0  #Mudstone
  10     0  26112  26112  #Basalt
  11  35584  35584     0  #Shale
  12  65280  44288  23296  #Sandstone
  13  58880  58880  64000  #Limestone
  14  65280     0      0  #Granite
  15  65280  32768  32768  #Diorite
}
LookUpTable End
```

**Note**

This table need not be restricted to 16 entries. If labels are missing for some colours a label "Cn" is used for the default body name where n = the sequence number.

**Selecting Objects**

The mouse selection behaviour listed below is important to the correct operation of the program and should be familiar to regular uses of Windows programs.

- **Click** - select an object.
- **CTRL+click** - select next object below current object.
- **Click-and-drag** - select a group of objects.
- **Double-click** - display the properties of an object.
- **Right-click** - display the properties of the window.
CTRL+click is also used in the Multi-track view to select a region of a line for enlargement (zoom). When an object is selected, the four corner points of the bounding rectangle are highlighted.

Multiple objects (bodies or drawing objects) can be layered over each other often 2 to 3 deep. If you hold the CTRL key while selecting with the left mouse button, multiple left mouse clicks tunnels down through the layers until the one you want is selected. Each object is highlighted in turn by the four corners of its bounding rectangle. These change in turn as the objects are selected and deselected.

**View Types**

The View menu provides the visual interface to the model and various data layers stored in memory. Here you can look at your models in plan, section and 3D perspective views. These views also allow you to visualize your line, grid, image and vector data layers in the same context as your models.

Visualization of models in the context of your data is the key to professional interpretation. Features that you have extracted from your favourite image processing or mapping system can be viewed as a backdrop to your model.

The main menu presents the View item as follows:

<table>
<thead>
<tr>
<th>View main menu option</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Layout</td>
</tr>
<tr>
<td>Multi-Track</td>
</tr>
<tr>
<td>X-section</td>
</tr>
<tr>
<td>Perspective</td>
</tr>
<tr>
<td>Map</td>
</tr>
<tr>
<td>Hole</td>
</tr>
<tr>
<td>Fit all X-sections</td>
</tr>
<tr>
<td>Tile windows (custom)</td>
</tr>
<tr>
<td>Tiling options</td>
</tr>
<tr>
<td>Remove all X-section windows</td>
</tr>
</tbody>
</table>

There are six classes of graphical views accessible through this menu:

- **New Layout** – Compose multiple scaled source windows into a single layout page and add drawing elements for report quality plots
- **Multi-Track** – tool for detailed graphing of individual lines (see Multi-Track View)
- **X-section** – Cross-section modelling and data visualization (see Cross-section View)
- **Perspective** – Full 3D visualization of model, lines and surfaces
- **Map** – Map view modelling with images, stacked profiles, contours, points, lines and backdrops (see Map View)
• **Hole** – Drill log view for modelling downhole data (see *Hole View*). The View menu also provides productivity tools for matching scales across all cross-sections and window tiling options that place windows in logical positions compared with the standard windows tiling function.

• **Fit all X-sections** – match the vertical scale of the curve tracks and cross-sections to the currently selected section (master cross-section).

• **Tile windows (custom)** – organises the cross-section in line order which can be either ascending or descending.

• **Tiling options** – controls the windows to be included in the custom tiling process and line sequence ordering.

• **Remove all X-section windows** – removes all cross-section windows including minimised windows. This is useful when using the *Target Wizard* to open many cross-sections at one time.

For more information on custom tiling and scaling options, see *Custom Tiling and Scaling*.

---

**Multi-window view of data and model showing clockwise multi-track, cross-section, 3D perspective and map views**

Modelling is performed in the map and section views while the 3D perspective view is used only for visualization. The Layout window is used for producing report quality graphics presentations where individual source windows can be plotted to scale within the layout page. The Multi-track view is used for detailed graph analysis of multi-channel data sets. It is very useful for understanding the fine detail that exists in magnetic data by comparison of different high pass filter outputs.

Each view has its own window and you can open multiple windows with the same type of view. Dynamic links are maintained between the map and section windows so that changes in models are reflected in all visible windows.
The above figure shows the four main working views that are used during interpretation analysis and modelling. Each of these windows can be presented in a layout view where each source window becomes an object on a printer page.

Example of a layout window where each of the source windows is positioned on a printer page

The layout window has a different function to other display windows. It is used to prepare report quality graphics where each source window can have its own output scale within the page and documentation and interpretive layers can be drawn over the top of windows.

**Custom Tiling and Scaling**

The multi-window tiling and scaling makes it much easier to work with multiple views when doing complex multi-line 3D modelling. The new features allow you more control over window tiling and placement and improves productivity and data comparison across windows.

The following images show a sequence whereby you open multiple cross-sections from a map view, tile the cross-sections in line order and then match the cross-section data and depth tracks to a common reference section.
Initial cascaded cross-section windows open from the map view.

Tiled window view of the sections after using the menu View>Tile Windows (custom) feature.
The dramatic change in the magnetic intensity scale of the off-target sections is very important when trying to understand the sensitivities associated with each line of data. The scale matching is activated using the right mouse click in the master section followed by selection of the **Apply Scale to All** option.

Once you have scaled all your sections, you may want to change the style of the graphics as well. To do this set up one section the way you want, use the right mouse click on the section and select the option **Apply STYLE to All**. In the figure below, the line thickness, EW indicators and line name was added to all sections.
Example of the use of the Apply STYLE to All to set the EW indicators, line name and curve thickness.

At present the following attributes can be propagated across all open sections with the Apply STYLE to All function.

- Curve colour
- Curve thickness and all other curve attributes
- Curves on or off (e.g. regional)
- Regional Fixpoints
- Line Name
- Axis Annotations
- Orientation Labels
- Track Titles
- AutoMag points
- AutoMag similarity coefficient traces

Auxiliary traces and in-line filters are not propagated by this function.

The custom tiling functions are controlled from the **View** > **Tiling** options dialog, where you select which window styles will be included, line ordering and other miscellaneous parameters.
There is a buffer set on the right and bottom margins to avoid windows automatically inserting scroll bars for panning around the workspace area. It also allows for setting up unused areas that can be assigned to other window types.

You can select the type of window view that will be included in the optimised tiling process. When working with the Target Wizard, you normally use one map and multiple cross-sections. Multitrack and 3D views would clutter the workspace in this context. You can also select size options for the windows. In this example, the map will have twice the vertical height of the cross-section windows.

When opening multiple cross-sections you can organise them in ascending or descending line number.
Cross-section View

Example of a cross-section display showing the intersection with two tabular bodies. The total magnetic field, model response and regional magnetic field are displayed in the track above the cross-section. The next track contains the residual anomaly difference and the last track shows the first vertical derivative for the field and model data.

The cross-section window (sometimes also referred to as X-section) is the fundamental tool used for building models and refining the depth distribution of bodies within the model. Each window is made up of a depth section, data track and optional auxiliary tracks. The configuration of the initial window is determined by the setting in the Model>Line control menu. Configuration of the window is subsequently controlled by the window configuration dialog box that is accessed via a right mouse button selection.

This section includes:

- Opening a Cross-section View
- Cross-section Controls for adding tracks, in-line filters, body labels, title blocks etc.

Note

The X-section is drawn along a line between the start and end points of the selected profile. The distance displayed on the section is the distance between these two end points. If the traverse departs from a straight line, the true X, Y and Z locations are used for modelling. The computed results are projected onto the section as a function of distance.
Opening a Cross-section View

To open a section use the View>X-section menu option and select the line you want to model from the X-section Select dialog. Multiple lines can be opened from the pull down list beside Line. A separate window is opened for each line that is selected.

The defaults defined in the Model>Line Control menu dialog are already selected but you have the opportunity to override them by turning individual options off. You can perform modelling without field data by turning the Display Input Channel off.

You can select additional channels that are displayed in extra tracks above the standard model channels. These are accessed through the Aux Channels dialog. You can also add auxiliary channels to an open X-section view.

Cross-section Controls

Once a cross-section has been opened, its appearance is controlled from the Cross Section Layer table, which is accessed by clicking the Layer Table button on the main toolbar or the Configure Layers option from the shortcut menu (right-click in window to display).

Note

Shortcut menus are available in many locations to access special properties or perform actions on the selected window.
The Cross Section Layers dialog provides in-depth control over the various component tracks, section and curves that make up the cross-section view.

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Type</th>
<th>Visible</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: Axon Annotations</td>
<td>Graticule</td>
<td></td>
</tr>
<tr>
<td>2: Orientation Labels</td>
<td>Orientation Labels</td>
<td></td>
</tr>
<tr>
<td>3: Line Name</td>
<td>Line Name</td>
<td></td>
</tr>
<tr>
<td>4: Track Titles</td>
<td>Track Titles</td>
<td></td>
</tr>
<tr>
<td>5: Polygroup Boundary</td>
<td>Group Polygon</td>
<td></td>
</tr>
<tr>
<td>6: Bodies</td>
<td>Body Section</td>
<td></td>
</tr>
<tr>
<td>7: Profile Legend</td>
<td>Legend Box</td>
<td></td>
</tr>
<tr>
<td>8: Curves</td>
<td>Tracks</td>
<td></td>
</tr>
<tr>
<td>9: 0: GFS</td>
<td>curve</td>
<td></td>
</tr>
<tr>
<td>10: 0: DTM</td>
<td>curve</td>
<td></td>
</tr>
<tr>
<td>11: 1: FA</td>
<td>curve</td>
<td></td>
</tr>
<tr>
<td>12: 1: GFAY_REGIONAL</td>
<td>curve</td>
<td></td>
</tr>
<tr>
<td>13: 1: GFAY_MUD</td>
<td>curve</td>
<td></td>
</tr>
<tr>
<td>14: Regional Fixpoints</td>
<td>Grav Reg Fks</td>
<td></td>
</tr>
</tbody>
</table>

Cross-section layer configuration dialog

Most of the layers in the configuration table can be individually configured. This controls the appearance of the section during modelling. The appearance for report-quality hard-copy might require a change to some of the default values.

Double-click on the layer number (left of Layer Name) to display the controls for that layer. These controls are discussed later in this chapter. Right-click anywhere on a layer to display the shortcut menu, from which commonly used actions can be accessed.

Layer shortcut menu showing Track 1 submenu

The Add submenu provides the opportunity to include other data in the curve tracks or cross-section. Only the data type that currently exists in memory will be accessible in this submenu.
The **Window** submenu is very important because it provides access to properties that are global to the window along with a facility to export the section to an image file for use in other products such as Discover PA.

In general, the default settings are suitable for most modelling operations unless additional information is needed. Items such as Standard Filters and drillholes can provide important control information. Modification of the regional field can also be made through this configuration table.

**Important**

Tracks are numbered from 0 to 8 from the bottom up where the cross-section is track 0.

**Note**

Where single or multiple consecutive rows are selected in the Cross Section Layer table, the DEL key can be used to remove those objects from the table and the view.
When a cross-section view is first created, the default layers present in the Cross-section Layer table are:

**Axis Annotations**

The axis annotation control dialog provides access to the tick mark and annotation styles. This allows you to prepare graphic outputs to suit different requirements such as reports, slide shows and publications.

**Orientation Labels**

When made visible this layer displays “E” and “W” or “N” and “S” representing the survey line orientation. To make this visible click on the tick box in the Visible column on the layer table for this type.

**Line Name**

When made visible this layer displays the line number or name of the profile being displayed. To make this visible click on the tick box in the Visible column on the layer table for this type.

**Track Titles**

When made visible this layer displays the name of the curves being shown in the tracks. To make this visible click on the tick box in the Visible column on the layer table for this type.

**Curves**

This layer expands and contracts alternately to show/remove all curves in the window each time the layer is selected. The symbol preceding the name Curves alternates between "+" and "-" with each selection.
Expansion of the Curves layer provides access to all curves in the window.

Right-click on any curve to display the shortcut menu, from which you can configure or remove the curve and change characteristics of the track. The configuration dialog for the curve provides control over a broad range of display characteristics. One special feature is the curve offset which helps align similar data with different ranges. This feature is useful for Free Air gravity modelling where the full earth model can produce a large vertical shift in the data relative to the original Free Air data.

The curve configuration dialog illustrating a DC offset for Free Air modelling.

The Window option will allow you to:

- **Arrange Legends** that are present,
- Change the **line number** being displayed,
- Set the **Horizontal Range** for the cross-section view. By default, the complete line is shown in cross-section but you may wish to display only a subset. You can specify a distance range for precision or use the Zoom tool to expand a limited range of the profile.
- **Export** the full cross-section, depth section or body intersections to graphics files that can be utilised in other products such as Discover PA. There is a text file option that lists the vertices of all body intersections along with the body properties.
- **Flip Line** horizontally so that the line orientation is reversed. The feature is useful when modelling a data line which is oriented from north west to south east, or with a slight deviation from due north-south. ModelVision makes decisions about the correct way to display a profile by examining the start and end coordinates of a profile. It also compares these end-points with adjacent lines (if available). At certain orientations, the program may display the profile in a form that is not intuitive to the interpreter. In this case, use the Flip Line option to reverse the sense of the line display.
• **Print** to hardcopy, and

• **Resize Auxiliary Tracks** that may be present

Click on the left mouse button while the cursor is positioned over the "+ Curves" layer name and the Tracks layer will divide into multiple layers representing each curve being displayed. This will allow you to configure the curve attributes for each track separately.

The ability to add other data objects to the cross-section view is provided by the **Add** pop-up menu option when any layer in the Cross Section Layer table is clicked with the right mouse button. The following data types can be added:

*Adding a layer to a cross-section view.*

**AutoMag Coefficients**

This layer type can only be added when the AutoMag module for automatic model generation is enabled with a ModelVision license. This controls the display of similarity curve traces. For more information on this option refer to the section on AutoMag depth solutions.

**AutoMag Labels**

This layer type can only be added when the AutoMag module for automatic model generation is enabled with a ModelVision license. This controls the display of labels for AutoMag solutions. Once the labels have been created, their sizes can be adjusted globally with the Size slider bar and the Arrange button. Each label is treated as an object that can be edited by changing its position or attributes. This is normally used for report preparation to improve over-posting problems. For further information on AutoMag labels see *Appendix: Modulate and Annotate the Solution*.

**AutoMag Points**

This layer type can only be added when the AutoMag module for automatic model generation is enabled with a ModelVision license. This controls the display of depth solutions. For more information on this option refer to the section on AutoMag.
**Auxiliary Tracks**

If you want to view data channels other than GRAV or MAG, you can add them to the cross-section display as an additional track. You can also insert additional channels into a track by positioning the mouse cursor in the new track and clicking the right mouse button. From the pop-up dialog that appears, select another data channel.

You can delete individual auxiliary tracks by clicking the right mouse button on the appropriate Curve layer in the Cross Section Layer table and selecting Remove Curve from the pop-up menu that appears.

**BMP Image**

You can display an RGB bitmap in the cross-section component of the window as a backdrop. When you select **Add** a dialog appears that requests information on the world coordinate limits of the .BMP file. You can use this feature for adding depth converted seismic sections, mine cross-sections or inversion sections from other geophysical products.

Where you register a BMP image file as a backdrop into a cross-section window it will create a .EGB (Encom Georeferenced Bitmap) file containing the registration coordinates. If you subsequently load that bmp file into a new session, it will search for an .EGB file with the same name and use those values. EGB files are generated for cross sections in Discover PA (formerly Profile Analyst) and Discover for MapInfo. This means you should be able to load BMP files generated by these packages directly into ModelVision and ModelVision sections can be viewed in these other products. When reading Discover PA EGB files check the format of the associated bitmap as it must be in BMP format, so you may need to use an image conversion tool to convert a JPEG or PNG file to BMP format.

**Note**

ModelVision uses depth below sea level as its reference, while Discover PA and Discover use elevation above sea level.
You can use the BMP backdrop to provide reference information such as mine cross-sections or depth converted seismic sections. The x and y locations of the end points of the section are projected onto the line of section. Zmin and Zmax values allow you to register the vertical position of the image.

![Example of a registered BMP image in the cross-section view along with the gravity model.](image)

**Body Section**

This is only visible when a body is created in the cross-section view. You often need to make bodies transparent so that you can see overlapping bodies yet final presentation is generally better done in solid colour. You can change the rendering of all bodies in the section view with this layer option. With the cursor positioned on this layer click the right mouse button to select Configure from the pop-up menu and display the Default Body Mode dialog. You can override this setting for individual bodies though the Body Properties dialog box.

**Body Labels**

This layer can only be added if a body is already visible in the cross-section view. By default the body label displays the name of the body, the susceptibility value and the density value of the body. For additional labelling click the right mouse button while the cursor is positioned over the Body Section layer of the Cross Section Layer table and select the Configure pop-up menu option to display the Edit Body Annotation dialog.

**Drillhole**

This option allows you to add selected drillholes to the display. You can configure the display characteristics for each hole with the Configure option from the pop-up menu. Where the drillhole is not directly on the line of section, it is projected onto the section.
Vectors derived from drillhole modelling of components can be displayed in X-sections. The drillholes are projected onto the relevant section if they are not aligned precisely. To display the drillhole on a section, view the Cross Section Layers table by selecting the appropriate button from the main toolbar and then click the right mouse button while the cursor is positioned over any of the layers of the table to select the **Add>Drillhole** option. Select any available drillholes from the dialog that appears and to configure the appearance of the drillholes click the right mouse button while the cursor is positioned over the Drillhole layer of the Cross Section Layers table to select **Configure Drillholes** from the pop-up menu.

*Vector displays derived from the computed response of magnetic components of a sphere.*

**Add Legend**

Add a legend box that annotates the name of each data channel alongside a line drawn in the same colour as the curve colour.

**Standard Filters**

Provides you with a method of visualizing your model and field data through use of an In-Line filter. These filters are applied in real time and provide an improved sensitivity in a variety of field and modelling situations. If you are trying to model overlapping anomalies or there is a strong regional gradient, use the first vertical derivative filter. This filter improves the precision of depth and edge location. Since it is a high pass filter, it also enhances noise.
In areas of laterite, you may want to model a long wavelength anomaly that is blurred by the high frequency noise from the laterites. Use the upward continuation filter to reduce the influence of surface noise. Since the same filter is applied to the field and model data you do not have to adjust the model depths for the amount of upward continuation that has been applied.

A choice of low pass, high pass, first vertical derivative and upward continuation convolution filters are available using this method.

The **Operator Length** and **Wavelength cut-off** or other appropriate parameters for specifying the filter can be defined. Once the filter and its parameters are selected, click the OK button. The selected Standard Filter output of both the observed and theoretical responses automatically compute and display in a new track above the normal X-section traces.

The standard filter for the model output is automatically updated each time a new model result is computed. An example of the first vertical derivative filter output is shown in the figure at the beginning of this section.

**Note**

That any convolution filter can be added as an auxiliary channel. This also applies to In Line filters specified prior to modelling and X-section display. This method enables any filter type to be specified and to be applied to any channel. Details on using this method of applying filters are described in In Line Filters.

**Regional Fix Points**

Provides access to the regional parameters dialog box that is outlined in Regional Field Controls.

**Title Block**

Increase the amount of annotation on your model section by adding one or more lines of title information. You can also use the Layout window for this purpose where you have more control over font size, style and positioning.
StatWatch

The StatWatch or Data Comparator is a tool to compare statistics of two curves or a subset of the data. Accessed from either the toolbar or a cross-section window it selects the first two curves in that track.

Multiple instances of StatWatch are supported for different data and statistics, and are updated as the data changes.

Use the Data Comparator to display the rms value between two fields.

StatWatch has the following options:

- **RMS [1-2] / range**: This is the root mean square difference of channel 1 and channel 2 divided by the range of either channel 1 or 2 (whichever radio button is selected). This is the statistic reported as RMS during inversion.

- **Correlation Coefft**: This is the correlation coefficient between channels 1 and 2 and will be in the range from -1 to 1.

- **RMS[1-2] / SD[*]**: This is the root mean square difference of channel 1 and channel 2 divided by the standard deviation of either channel 1 or 2 (*whichever radio button is selected).

- **RMS[1-2]**: This is the root mean square difference of channel 1 and channel 2.

- **Mean[1-2]**: This is the mean of the differences between channels 1 and 2. Its sign is dependant on the radio button selection.

**Export Cross-sections as Georeferenced Images**

An option exists in map and cross-section views to export the display as a geo-referenced map or cross-section in the format of .EGB (Encom Georeferenced Bitmap) and .BMP (Bitmap) files. The export option is accessed by a right-mouse click on the x-section window and an option is presented to either:

- Export the **Whole section** including the depth section and Input and Modeled curves
- Export the **Depth section** only.
The Export Bitmap dialog is displayed:

Specifying a prefix or suffix to the file name for the Export Bitmap option.

The options exist in this dialog to display annotations and to add a prefix or suffix to the output files.

**Map View**
The map view provides a standard suite of mapping tools for visualization of models in the context of the data. Where possible we have maintained presentation techniques that are equivalent to popular mapping systems. In particular we have adopted the same colour look-up table that is used by ER Mapper along with support for their filter kernels, image and vector file formats.

Sample maps displays showing stacked profile, contour and pseudocolour image views. The stacked profile map has a BMP backdrop from a Landsat TM scene. The bi-colour contour maps has a BMP backdrop from a scanned topographic map. The variable area stacked profile maps displays the results of a high pass filter.

The map display is very flexible with a wide range of options for each display type. You can mix any type of display in a single window once a window has been opened. The main menu allows you to select an empty map view or one of the main display types. Once the display type is selected from the menu, a quarter window is opened covering the project data extents. You can change the default settings for the window, increase its size and zoom in for a more detailed view.

For information on configuring the map view, see Configuring Map Displays. For information on configuring components in a map view, see:

- AutoMag Points
- Body Labels
- BMP Backdrops
- Drillhole Displays
- Vector Presentations
- Drillhole Vector Map
- Perspective Drillhole DisplayERV Backdrop
- Grid Contour
- Grid Images
- Grid Profiles
• Legend Box
• Regional Fix Points
• North Arrow
• Points Set
• Stacked Profiles
• Title Block
• Export Maps to Georeferenced Images (.EGB)
• Bodies

Configuring Map Displays

Each map view can contain one or more of the data driven elements listed in the table below:

<table>
<thead>
<tr>
<th>Map Object Type</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stacked Profile Channel</td>
<td>Graph</td>
<td>of channel displayed along the base line</td>
</tr>
<tr>
<td>Contours</td>
<td>Grid</td>
<td>Mono or coloured contours</td>
</tr>
<tr>
<td>Grid profiles</td>
<td>Grid</td>
<td>Stacked profiles from grid rows, columns or both</td>
</tr>
<tr>
<td>ERV Backdrops</td>
<td>.ERV</td>
<td>ER Mapper vector file</td>
</tr>
<tr>
<td>Vector Files</td>
<td>.SHP</td>
<td>ESRI Shape files</td>
</tr>
<tr>
<td></td>
<td>.DXF</td>
<td>AutoCad DXF files</td>
</tr>
<tr>
<td></td>
<td>.MID/MIF</td>
<td>MapInfo files</td>
</tr>
<tr>
<td>Drillholes</td>
<td>Hole</td>
<td>Drill hole path and data display</td>
</tr>
<tr>
<td>Image</td>
<td>Grid</td>
<td>Pseudocolour images with 8 sector illumination</td>
</tr>
<tr>
<td>BMP Backdrops</td>
<td>.BMP</td>
<td>RGB reference image file.</td>
</tr>
<tr>
<td>Points</td>
<td>Point</td>
<td>Standard points with symbol, size, colour, orientation and annotation</td>
</tr>
<tr>
<td>AutoMag Solutions</td>
<td>Point</td>
<td>Display AutoMag symbols with depth, property, strike.</td>
</tr>
<tr>
<td>Profile Vectors</td>
<td>Channel</td>
<td>A computed multiple vector resulting from eg. Magnetic or gravity component modelling (refer to Full Tensor Gravity Gradiometer Computation)</td>
</tr>
</tbody>
</table>

As well as these data objects there are many other attributes, such as flight lines, north pointers, annotated grids, title blocks, colour legends and model bodies that can be added to each window.
Once a map window has been opened, its appearance is controlled from the Map Layers table. To access these controls for the map window click on the Layer Table button on the main toolbar or else a right mouse click inside the window displays a short menu that provides access to the Map Layers Table. The standard pop-up menu also provides access to the hardcopy dialog and help system.

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Type</th>
<th>Visible</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis Annotations</td>
<td>Grid/Label</td>
<td></td>
</tr>
<tr>
<td>Flight Lines</td>
<td>Flight Line</td>
<td></td>
</tr>
<tr>
<td>Base Lines</td>
<td>Base Line</td>
<td></td>
</tr>
<tr>
<td>Station Symbols</td>
<td>Station Pos</td>
<td></td>
</tr>
<tr>
<td>NAG</td>
<td>Stacked Profile</td>
<td></td>
</tr>
<tr>
<td>Map Legend</td>
<td>Legend Box</td>
<td></td>
</tr>
<tr>
<td>Bodies</td>
<td>Body</td>
<td></td>
</tr>
</tbody>
</table>

**Map Layers Table**

Most of the layers listed in this table have their own individual configuration layers, accessed by a right mouse click on each layer. These are used to configure the appearance of the map during modelling. The appearance for report quality hard copy may require a change to some of the default values.

In general the default appearance of the map view is suitable for most modelling operations unless additional information is needed. Items such as Stacked Profiles and drill holes may provide important control information. Modification of the regional field can also be made through this table.

The Map Layers Table allows you to quickly build simple or complex map displays. The layers in this table have evolved over time to cater for the needs of interactive modelling and report quality map displays. These are often significantly different requirements.

**Note**

Where single or multiple consecutive rows are selected in the Cross Section Layer table, the DEL key can be used to remove those objects from the table and the view.

When the Map Layers table is initially opened, the following standard layers are present:

**Axis Annotations**

Use this option to change the grid and annotation style. To view the Map Annotations control dialog click on the Axis Annotations layer in the Map Layer table with the right mouse button and select **Configure** from the pop-up menu.
Map annotation control dialog

**Flight Line**

This layer presents the true location of all data points along a line in sequence from first to last. The controls allow you to separately set the line thickness and colour for standard and active model points display. You also have a check box for turning the line name on or off.

If mag is active, the default line colour is red and blue for gravity and thickness is 2 points. By default the flight line layer is set to on.

**Base Line**

This layer displays a straight line from the first to the last location points of each survey line. This line represents the reference base from which the stacked profiles is scaled. The control dialog for base lines is the same as for the flight lines.
If mag is active, the default line colour is green and yellow for gravity and thickness is 2 points. By default the base line layer is set to on.

**Station Pos (Positions)**

This layer plots a symbol at the location of each data point along survey lines. This does not refer to the Point data type. Use this option with discretion as a complete airborne survey takes a long time to display. If you do this inadvertently, use CTRL Q to abort the draw operation.

**Standard Map Window Option**

Click on the right mouse button with the cursor positioned over this layer to display the pop-up menu containing options for Configure, Add and Window.

The **Configure** option will appear when you have clicked on a layer for a data object that has an associated dialog for controlling the display of this layer. For more information on these data objects see Data Objects below.

The **Add** option will allow you to place additional data object layers in the map view.

The **Window** option will allow you to:

- **Arrange Legends** that are present. You can use this button to relocate legends to their default position. ModelVision attempts to position these on the right hand margin of the map window. This operation is applicable to the title bar and colour bar legends.

- The **Display Range** is set to the current project range when you open the window, but you can override these setting by typing new values in the Map Display Range dialog. This is accessed by clicking the right mouse button while the cursor is positioned over any of the layers in the Map Layer table and selecting Window>Display Range from the pop-up menu that appears.
Accessing the Map Display Range dialog for a map window.

Only one of the data ranges match exactly the ones that you entered because the aspect ratio of the window is likely to be different from the entered ranges.

Set the Display Range for the map view. By default, the complete map area is shown in the map view but you may wish to display only a subset. You can specify a distance range for precision or use the Zoom tool to expand a limited range of the profile.

- Specify the **Drawing Order** of the different layers in the map view. The Drawing Order option displays a dialog with a list of layer types in the order of priority. The top of the list is drawn last and is always visible. The bottom of the list is drawn first.

The **Drawing Order** dialog.

You can change the drawing order by moving a selected Object Type up or down with the **Up** and **Down** buttons.
The line in the object list box is used to reduce the redrawing of objects that normally take a lot of time to draw. For example, images and contours can be slow to draw. If you select a drawing object above Grid Contour and double click on the item a threshold (indicated by a horizontal line) is set where all lower objects are written into a virtual image in memory. Instead of redrawing all the vectors each time the map is changed, the image is quickly refreshed from the virtual image in memory.

A side effect of this method is a pause while the virtual image is created before it is written to the screen.

This method of operation is recommended when you are editing models in a map view. If you have both an image and a contour object, it is recommended to have the body object above the contours while editing. When you want to produce hardcopy, move the contours above the body so you can see the context of the bodies relative to the contours.

- Display the location of the mouse cursor in the map window by turning on or off the Mouse Co-ords option. The easting and northing of the location of the cursor appears in the Status Bar.

**AutoMag Points**

![Example display of AutoMag points showing the oriented symbols colour coded by LEVEL with annotations on the right hand side of the symbol. Large annotations have been picked manually and resized.](image)

- **AutoMag Points**
Body Labels

Labels can be created for AutoMag points or model bodies by selecting the appropriate option and the Create button. Each label is treated as an object that means it can be selected with the mouse, re-positioned or modified. If you select the object with the left mouse and use a double left mouse click, a dialog appears that allows you to change the label information.

Body label dialog controls the presentation of the selected body label. A label for an individual body can be turned on via the body properties dialog (double click on the body or select the Property button on the toolbar).

Body label dialog controls the presentation of the selected body label.

A label for an individual body can be turned on via the body properties dialog (double click on the body or select the Property button on the toolbar).
A default 3 line label similar to that shown above is generated for each body. The contents of the label can be changed with the dialog controls. The text can be changed by altering the number of lines and template text. For example:

- If you only want the body name displayed, change the number of lines to 1
- If you only want to display magnetic susceptibility, cut the second line and paste it into the first line and set the number of lines to 1. $S = @(\text{susc}, \%6.4f)$.
- If you want to change the template to just show the numeric value, change the above line to read: $@\text{(susc}, 6.4f)$.
- Keywords which can be used for all body types are:
  - label body name
  - susc susceptibility
  - dens density
  - x X value of centroid
  - y Y value of centroid
  - depth Z value (position is dependent on body type)
  - vol Volume in m$^3$ (If calculated.)
  - vkm Volume in km$^3$ (If calculated.)
- Additional keywords for some body types are:
  - azim strike azimuth or plunge azimuth
  - strike Strike length
  - extent Depth extent
  - plunge Plunge angle
  - thickn Width of tabular body
  - dip Dip angle
  - rad Radius – for ellipsoid or pipe bodies with more than one radius this will be the volume or area equivalent radius.

By selecting **Apply to All Labels**, the format changes that you make on one label, are automatically applied to all the remaining body labels. Note that if using mixed body types some labels may not be appropriate, e.g. the radius of a tabular body would display as zero.
The Default Body Mode dialog.

In circumstances where body labels have been moved in a display, they can be re-positioned over the body by selecting the Arrange button. This feature is useful for a rapid clean up of labels which are scattered in a map display. Note that if the Labels checkbox is not enabled, body labels are not displayed.

To change the appearance of all bodies in the map view with this dialog you can make bodies solid or wire frame. Alternatively instead of using the standard colour for the body, you can modulate the colour of the body as a function of its magnetic susceptibility or density. To do this select the Modulation option in the Body Colours section of the dialog and then press the Configure button.

This is very useful during inversion where properties are continually changing. A dual colour or continuous colour scheme can be used. In Table Look-up mode, you can also add a colour legend.

Body labels can be deleted from a map display by selecting the Remove Body Labels option in the pop-up menu of the Map Layers table or disabling the tick box for the Visible column.
BMP Backdrops

For multi-disciplinary interpretation sessions and final reports it is helpful, if the models and geophysical data can be displayed in the context of surface features derived from conventional mapping or satellite imagery.

When you select a BMP backdrop display, a registration dialog appears where you enter the easting and northing range for the image. The BMP image is stretched uniformly across this range.

If you load a bmp file as a backdrop into a map window in this manner it will create a .EGB (Encom Georeferenced Bitmap) file containing the registration coordinates. If you subsequently load the BMP image file into a new session it will search for an EGB file with the same name and use those coordinates.
Drillhole Displays

Sample drillhole displays in map view using the colour modulated track, single channel graph and 3 component vector display.

Drillholes can be added to a map view as individual holes or groups of holes. The displays can be used to track the hole, colour modulate the track by a channel value or display 1, 2 or 3 component vectors. Data for drillholes can be imported (see Importing, Exporting, and Linking Data Files) or their downhole magnetic and gravity responses calculated within synthetic drillholes. Multiple drillhole component responses can also be computed (refer to Drillhole Modelling).

Since multiple component displays of drillhole data is provided, it can also be used to display geochemistry data and directional physical property data such as magnetic susceptibility and density logs plus 2 and 3 component magnetic data.

You can also load airborne magnetic gradiometer data as drillholes and display the data as vectors. The import format is defined as type LIN with a header line that starts with HOLE rather than LINE (refer to Appendix A: File Formats).
Display controls available include:

- **Track** - This option controls whether a trace of the drillhole is shown. A drillhole trace is presented as a line that joins the hole locations as defined by the X, Y and depth channels in the loaded data. The trace can be colour modulated.

- **Symbols** - Displays a symbol at each hole measurement location.

- **Vectors** - Vectors are referred to in ModelVision by three components parallel to the X, Y and Z axes with default names of VX, VY and VZ. Scaling of the length of the vector is controlled by the Auto Scale option. Selection of the vector components is defined in the Vector Component Selection option. The individual vectors can be represented as lines or arrows radiating out from the drillhole trace. Refer to the section on Vector Presentations for additional information.

- The **Auto Scale** option is used to allow ModelVision to scale the vector sizes relative to the size of the display window. If the option is disabled, the Scale entry is used.

- **Colour Mode** - Three modes of representing the vector displays of drillhole data are available. These are:
  - Mono (single colour)
  - High/Low (dual colours)
  - Table look-up (channel modulation)

The colours used to display the vectors can also be modulated by a selected channel. For example, if the three component magnetic vectors are VX, VY and VZ but the display is coloured according to the total magnetic vector, the Compute operation could be used to calculate a new channel that represents the total vector amplitude *(VX2 + VY2 + VZ2). The new channel could be used to control the colour of the vector display.

A colour legend can be displayed to show the relationship between colour and amplitude.
Vector Presentations

Vectors of drillhole components can be displayed in either map, perspective or cross-section views. The presentation software assumes that vector components are orthogonal and parallel to the X, Y and Z axes. The Z component is vertical with the convention of positive down (see diagram below).

Drillhole Vector Map

Vector displays of drillhole components either imported or computed can be displayed in a map similarly to X-sections. To display the drillhole on a map view, view the Map Layers table by selecting the appropriate button from the main toolbar and then click the right mouse button while the cursor is positioned over any of the layers of the table to select the Add>Drillhole option. Select any available drillholes from the dialog that appears and to configure the appearance of the drillholes click the right mouse button while the cursor is positioned over the Drillhole layer of the Map Layers table to select Configure Drillholes from the pop-up menu.

Use the Configure button to define the drillhole vector appearance as described in Drillhole Displays.

Once the required drillholes are selected and added, they can be configured using the Configure button and the option described in Drillhole Displays.
ERV Backdrop

Vector files in ER Mapper format can be referenced and displayed in a map view. By default, this layer appears at the bottom of the map layers and may need to be re-ordered in the Drawing Order dialog that is accessed from the map configuration dialog.

You can use ER Mapper to convert other vector formats such as AutoCAD's .DXF format to .ERV format. ER Mapper 4 and 5 formats are supported.

Grid Contour

Contour maps are generated from grids stored in memory. These grids are either imported from an external source such as ER Mapper or Geosoft format files, or generated internally from line or point data using the Utility>Grid Channel Data option. Alternatively, they may be created by a grid modelling set up using the Model>Grid Control option.

Note

The vertical scaling of the nominated channel is in units/centimetre of the screen. This means that if a larger scale of the displayed amplitudes is desired, the Z Scale value must be reduced accordingly. The vertical scaling of the response occurs after subtraction of a Baseline Value. Initially the baseline value defaults to the average of the channel dataset.
Contour map window display of gridded data

You can display more than one contour map in a given display but this can be untidy unless designed for a specific purpose. You can use two contours to compare model and field data in the one map by using different colours for the two grids. You can also mosaic two grids that only partially overlap. Grids can have different origins and cell sizes, but they should have the same datum and projection as all other data, models and images in the session file.

To control the appearance of a contoured grid, in the window containing the contour display, click the right mouse button and select the Configure Layers option from the pop-up menu within the map view or select the Layer Table button in the toolbar. Display the Configure Contours dialog by right mouse clicking on the Contour row in the Map Layers table and selecting Configure from the pop-up menu.

Contour map control dialog
Contour spacing defaults to **Auto Spacing** mode and allocates contours uniformly across the data range. The **Manual Spacing** mode can be used to change the contour interval and modify the data range spanned by the contours. If a colour look-up table is in use, its limits are mapped to the Min and Max values set in the dialog.

**Colour Mode** offers three methods of operation:

- **Mono** allows you to select a specific colour for all contours in this data layer
- **High/Low** allows you to define a colour for high values and another colour for low values. The changeover value is the mid-point of the data range.
- **Table Look-up** assigns a different colour to each contour level. The look-up table is selected from a list of ER Mapper compatible tables. Some tables are restricted to a discrete number of colours such as Step, Solid and VGA, while other such as Pseudocolour are continuous. The best results are achieved on displays with colour resolutions of 16 or 24-bit graphics adapters.

**Dropout** determines the line density in lines/cm where contours are not continued across grid cells. By default, ModelVision uses limits of 5-250 for dropout and 3-15 for decimation.

**Decimate** is an option that improves drawing speed by decreasing the number of grid cells that need to be used in the contouring process. The best results are normally achieved with a setting of 3.

**Line Thickness** is used to define the contour line thickness in points. If major and minor contours are to be created, different line thickness levels can be assigned for improved appearance.

**Heavy Contours** define a major contour level. To enable heavy contours, select the **On** check box to display a tick icon in the box and then choose from the following parameters:

- **Step** allows you to specify the major contour interval where the following parameters are applied.
- **Thickness** is used to define the major contour line thickness in points. Note that a heavy contour thickness of 3 or greater is required to distinguish them from the general contour line thickness.
- **Colour** allows you to select a specific colour for the major contours in this data layer. This will only apply if the Mono method is specified in the **Colour Mode** parameter for general contours.
Grid Images

Image displays are used extensively for the qualitative part of an interpretation. Much of this work is performed in image processing systems such as ER Mapper. When selecting magnetic anomalies for modelling, it is helpful to be able to reproduce the context of the original anomalies during the modelling.

Images are drawn at the lowest level, with vector overlays drawn on top. Models, stacked profiles, flight lines and contours can be added to the display for different visual effects. You can change the drawing order of layers from the Window>Drawing Order option from the pop-up menu in the Map Layers table.
Example of a model superimposed over an illuminated monochrome image. The image configuration dialog provides controls for illumination, colour mode, histogram equalization, data range clipping and decimation.

**Grid Image Configuration - mag**

- **Light Source** - Data values stored in a grid are presented in the image display as a surface that is artificially illuminated. The inclination or intensity of the light source is controlled by a slider control. Illumination directions are restricted to 0, 45, 90, 135, 180, 225, 270 and 315 degrees.

- **Colour Mode** - Three colour modes are available for the image display - Mono, High/Low and Table Look-up.

- **Mono** - A single colour is used to present the image and shades of grey are overprinted to provide gradient information. This is useful when you are interested in trend information and not amplitude. The colour used in this mode is definable by the Set Colour push button.

- **High/Low** - Colours are split into high and low values where the changeover value is set at the mid-point of the Min-Max range.
**Table Look-up** - This method is commonly used in image processing to assign specific colours to amplitude values (or ranges) in a source grid. Different colour schemes or palettes can be used to achieve a variety of colour effects. We use ER Mapper palettes to retain the same presentation style for images. Further information on the format of these palettes is described in the Open Standards Manual for ER Mapper.

- **Image Range** entries are used to control colour distribution for the High/Low and Look-up Table modes. The colours are allocated linearly across the range. This is not used in histogram equalization where the whole data range is used.

- **Decimate** is an option that improves drawing speed by decreasing the number of grid cells that need to be used in the image drawing process. The optimum results are normally achieved with a setting of 2. For fine resolution on screen use 1. Do not use 1 when printing as this can increase the time required producing hardcopy.

- **Modulate Colour by** - allows you to associate the Table Look-up colour with a grid that is different from that used to control the illumination.

- **Shadow Enhancement** – increases the contrast applied to the illumination shadows

- **Shadow Highlights** - increases the contrast applied to the illumination highlights

---

**Note**
The appearance of a screen image is determined by the colour depth available with the computer hardware used. Displays with only 256 levels of colour do not produce high quality images. With colour levels greater than 256, the quality of the image is significantly enhanced. On most computer video hardware, the colour depth can be increased but at the expense of reduced screen resolution.

---

**Note**
Although a reduced colour depth image may be displayed on screen, ModelVision uses the full resolution and colour depth available when output to a printer or plotter.

---

**Example image where the potassium grid is colour modulated and the illumination channel is the magnetic grid shown previously.**
You must remember to reset the Min/Max limits to suit the colour modulation channel as the range defaults to that of the primary illumination channel.

**Grid Profiles**

ModelVision can display a stacked profile representation of the rows or columns of an imported or generated grid. This form of presentation is useful for grid modelling since attempting to model by other grid display means (such as contours or imagery) is difficult. It is possible to control the number of rows and columns displayed thus making the presentation easier to visualize and faster to display. Control is also available to alter vertical scaling, display either rows, columns or both and the colour of the profiles.

![Grid Profile display window with rows of grid shown](image)

After selecting the Grid Profiles option, choose one or more grids and whether rows, columns or both are to be used. The direction of the rows (horizontal) or columns (vertical) always matches the orientation of the input grid. An example of a Grid Profile display is shown above.

**Note**

Large grids are decimated automatically, as the display of every row or column is often too dense for the display resolution.

Control on the amplitude, decimation factor and colour of the display is accessed from the map window dialog which is invoked by clicking the right button while the cursor is positioned in the Grid Profile window, and selecting the Configure option for Grid Profiles. The dialog appears as follows:
If you select rows and have the column decimation factor set to 2, it only displays every second point along the row profile. If you want full resolution of sampling, make sure that the column spacing is set to 1. Apply the same principle to column display.

The vertical scaling (ZScale) and Baseline Value of the display are automatically computed using line data, if available, such that a stacked profile display has the same vertical scaling as the grid profiles if they are displayed together.

**Note**

The vertical scaling uses units/centimetre as its unit measurement. Computed values can be overwritten.

**Legend Box**

This option adds a small box that lists the various overlays that are present in the map view. This legend is drawn by default and it can be deleted with the DELETE key.

**Regional Fix Points**

Displays the regional fix point handles. Each handle is associated with an active line (regional) and the handles can be moved perpendicular to the base line to change the shape of the regional. See the section on Regional Computation for more details on this method.

**North Arrow**

Plots a north arrow symbol in the Map window. The direction of the arrow is to grid and magnetic north of the coordinate system being referenced in the Map. This information is entered via the File>Properties menu.
Points Set

Example of colour modulated points for Bouguer gravity values. Contours of the gridded gravity values have been modulated with the same data range and colour look-up table.

Points are either imported using the File>Import>Point Data, computed magnetic or gravity responses (refer to Point Modelling) or generated by conversion of AutoMag points to standard points (refer to AutoMag and Standard Points).

Point data is used to represent measurement locations that are not constrained to lines and are often referred to as random locations. The most common use of points is to track the location of gravity stations, but it can be used for other information such as ground geochemistry, drillhole locations and spot heights.

You can have more than one point set on a map.

Points have two major plotting attributes:

- Symbol modulation
- Point annotation

Each symbol can be modulated by type, size and colour. These options are shown in the control dialog below.
Controlling the View

Point modulation dialog showing modulation controls and the Channel Annotation button. This modulation dialog is shared with AutoMag that has different symbol modulation requirements. When modulating standard points, the Angle modulation is not available.

- **Type** - You can choose from a pull down list of symbols the type of symbol that you want to display at each point. If the **Type** check box is enabled, the symbol can be selected automatically from the modulation channel. Each symbol is selected from a table mapped by its value to a symbol. See Appendix F: Symbols for a list of the symbol numbers.

- **Size** - The size of a symbol is fixed or modulated by its value in the selected point data channel. The size is scaled across the range Min to Max where the maximum is the symbol size and the minimum is set to approximately 20% of Max. A logarithmic scale can be applied to channels with large dynamic range such as magnetic susceptibility.

- **Colour** - The colour of the symbol can be set to a predetermined colour using the colour selection dialog. You can modulate the colour of the symbol according to values in the selected channel for the point set. Use the channel and palette selectors if this modulation option is turned on.

- **Channel Annotation** - Allows you to plot numeric values from point channels in various positions around the symbol location. You can plot any number of channel values, but you must ensure that an offset is added to separate the plotting locations. See the dialog box below for the list of available controls.

Example point posting of annotations for elevation and Bouguer gravity with a negative offset applied to
Controlling the View

Elevation to position it on the left side of the symbol.

**Polygon Boundary**

Polygon boundaries created by the Target Wizard, Extrusion Wizard or Remanence Calculator can be selected and displayed on a map window using the Add>Polygon Boundary from the Map layer Configuration dialog.

**Profile Vectors**

Three dimensional vectors are projected onto the map view along the flight line trace. You have control over the display style, vector components and colour of the vectors as shown in the following dialog accessed from the Map Configuration>Add>Profile Vectors option. You can also plot a symbol at the base of the vector.
Map Profile Vector Configuration dialog showing controls for the display style, component selection and colour mode.

The following image shows the component vector display of Bx, By, Bz projected over a colour map of the total magnetic intensity. The components are derived by resampling Bx, By, Bz component grids onto the flight lines. The component grids are generated using the FFT Grid Filter utility.

Map image of TMI with an overlay of the projected Bx, By, Bz component vector.
Stacked Profiles

Stacked profile displays of a data channel are controlled from the stacked profile configuration dialog.

You can set the base level, vertical scaling, line colour, line thickness and fill colour from this dialog.

Shading produces a variable area fill above and/or below a set value. This is useful when displaying the results of high pass filters.

Multiple channels can be added to a single map window, but two is the maximum recommended since too many can cause confusion in a display.

Note

The vertical scaling of the nominated channel is in units/centimetre of the screen. This means that if a larger scale of the displayed amplitudes is desired, the Z Scale value must be reduced accordingly. The vertical scaling of the response occurs after subtraction of a Baseline Value. Initially the baseline value defaults to the average of the channel dataset.
The **Connect Segments** checkbox ensures the stacked profile display extends across any data gaps to give a continuous trace. If the checkbox is disabled, the profile display is discontinuous where there are large gaps in the data.

Stacked Profiles can be labelled with Line Names. If the **Line Name** checkbox is enabled, the line names are displayed. Two radio buttons provide the option of locating the line name annotation near the baseline for each traverse, or near the drawn trace for each channel. This selection is significant where large excursions between baseline and channel data exist at the ends of traverses.

**Title Block**

Title boxes can be added to map displays. These editable boxes are similar to body labels in that they can be moved, sized and positioned where required. Once selected by clicking the push button, a dialog box is displayed as shown below which enables entry of from one to ten title lines of text.

![Edit Legend Title Text](image1.png)

*Example of the Title Block text entry dialog*

**Export Maps to Georeferenced Images (.EGB)**

An option exists in map and x-section views to export the display appearance as a georeferenced map or x-section in the format of .EGB (Encom Georeferenced Bitmap) and .BMP (Bitmap) files. The export option is accessed by a right-mouse click on the map or x-section window to display the pop-up menu and the Export Bitmap dialog as illustrated below will appear.

![Export Bitmap](image2.png)

*Specifying a prefix or suffix to the file name for the Export Bitmap option*

The options exist in this dialog to display annotations and to add a prefix or suffix to the output files.
Bodies

When a body is created for modelling a **Body** layer is automatically added to the Map Layers (or Cross-Section Layers) table. The display of all bodies can be controlled by the tick box located in the **Visible** column for this layer. If this tick box is disabled then no bodies appear in the map view.

**Perspective View**

The Perspective option displays a three-dimensional representation of models, drillholes, flight lines and grids. The above example shows a complex model where rugged terrain is partially transparent. Draped above the terrain are the flight lines with one active line shown. Above this is a simulation of the total magnetic intensity of the model and the measured total magnetic intensity.

The view can be rotated, zoomed and panned. Navigation and views are controlled by cursor movement and combinations of mouse button operations. A description of the cursor and button combinations are described in **3D Grids**.

You open a perspective view from the **View>Perspective** menu selection. The initial view displays a 3D box enclosing the model and flight lines.

**Note**

Flight line elevations are assumed to be zero unless an elevation channel is assigned in the **Model>Line control>Use Z sensor channel** field.

Use the right mouse button to access the configuration menu shown below. From the dialog, you can turn on individual grids, symbols and drillholes.

The Perspective Configuration dialog has a set of check boxes for turning on and off various display types, including modeled bodies, a wire frame bounding box, survey flightlines, shadows and a preview of a UBC Mesh design (enabled when the UBC additional module is activated for the ModelVision license). These bodies, flightlines and UBC Mesh models will update in real time when any change is made in another display.
Controlling the View

3D perspective configuration dialog

3D Grids

Example of four 3D grid displays showing total magnetic intensity (a), 800m HP filter (c), 1500m HP filter (c) and 5000m HP filter (d) grids. The filter grids were generated by gridding the output from convolution filters applied to the flight line data.

You can attach one or more grids to the 3D display. Select the 3D Grid option, followed by the Add button and choose one grid from the displayed list. The names of the grids appear in the configuration field window. If you have more than one grid in the list, select the one you require with the left mouse button.

Manipulation and orientation of the view point of images displayed in a 3D perspective window can be interactively altered using the 3D cursor.

Note

While the 3D cursor is invoked, a right mouse click causes a zoom operation to occur. If you wish to access the Configuration pop-up menu, hold the CTRL key down while right mouse clicking.

The control of the 3D cursor is governed by mouse movement plus a combination of the left or right mouse buttons. In general, the speed of navigation of the 3D image increases if the cursor is moved from the centre of the display window. Similarly, if an image motion is started, it will move in the opposite direction if you move the cursor to the opposite side of the screen. For example, a zoom into the image is controlled by holding the right mouse button down and moving the cursor up the screen. If the cursor is moved vertically down the action is to zoom out.

The navigation actions and their corresponding image movements are:

- **Zoom In** – Right mouse depressed and cursor move up the screen
- **Zoom Out** - Right mouse depressed and cursor move down the screen
- Rotate About Vertical Axis – Clockwise (looking down) if left mouse button depressed and cursor moved right. Anticlockwise movement if cursor moved left.
- Rotate About Horizontal Axis – Hold left mouse button and move cursor up or down the screen.
- Pan Across Screen – Hold both left and right mouse buttons and move cursor left or right. Pan is in opposite direction to mouse movement.
- Pan With Zoom – Hold both left and right mouse buttons and move cursor up, or across screen. This action is useful as a means of performing a fly-through.
- SHIFT key held while cursor movement up/down the screen causes the image to vertically shift up or down.
- CTRL key held with right mouse click – Displays the Perspective Configuration pop-up menu.

Vertical exaggeration or colour control is provided by the 3D Grid Configure dialog (presented from selecting the 3D Grid option and selecting the **Configure** button).
Colour Mode

Example of flight lines over a terrain elevation grid colour modulated by a grid of the radar altimeter channel (terrain clearance)

Standard colour controls are provided for the grid colour. See the section Image Display for more details on the colour mode. The elevation of the surface is derived from the grid. In **Table Look-up** mode, the colour is derived from the elevation grid by default, but you can use another grid to control the colour distribution. An example of this would be colour modulating of the terrain clearance from an airborne survey over a 3D view of the terrain grid. The above figure shows an example of how this could be used as a quality control tool to evaluate is a survey has been flown within specification. You need to set the dynamic range to suit the second grid as the default value is set to the primary elevation grid. Use the **Utility>Statistics>Grid Data** menu function to determine a suitable range.

**Decimate**

You can accelerate the refresh times for 3D grids by decimating the number of cells displayed. Every nth row and column are used in the surface display where n is the value entered in the decimation field. The best value to use is a function of the grid size, but for large grids, a value of 3 to 5 typically gives satisfactory response times. Use a high decimation factor while you are configuring the display.

**Scale and Offset**

Use the **Scale** factor to change the apparent vertical exaggeration of the surface. If you increase the scale factor, the vertical exaggeration increases.

Use the **Offset** value to shift the surface up and down relative to the zero reference. Negative values shift the surface upwards.

Note that the scale factor is applied to the offset as well and it is possible for your surface to disappear from the field of view if your Scale or Offset is too large.

**Transparency and Illumination**

You can make a surface partially transparent so that you can see objects that would otherwise be obscured. The following figure illustrates different visualization methods where the terrain fully or partially obscures a model body.
Example visualization of terrain transparency using surface transparency, mesh and combined options. The model is allowed to break through the surface to illustrate the contrast between transparency and direct visualization.

The transparency slider defaults to 30%. You can change it to non-transparent (opaque) by sliding it fully to the left or 100% transparent by sliding it to the right. If you set the Full option on it achieves the same result as transparency set to opaque.

In the example above, a mesh of the terrain is draped over the surface by applying a small offset to ensure that it remains above the imaged surface. The mesh was created from a second identical grid using a decimation value of 5. Note that you can duplicate a grid by using the Utility>Calculator menu option. To do this set the calculator mode to Grid and type grid2=grid1 followed by compute. This duplicates Grid1 to Grid 2.

Note that the options From Top and From Bottom are options that control transparency depending on the view direction.

Smooth

Although slow, this option improves the interpolation of colours across the surface facets by using a smooth interpolation method.

Perspective Drillhole Display

Vector displays of drillhole components are perhaps best suited to perspective displays as they can be rotated and viewed in 3 dimensions. The drillhole vector data can be either imported or computed (see Drillhole Modelling). From a Perspective Configuration dialog (right-click or CTRL+right-click to display) the mouse with the cursor inside a perspective window), you can select the Drillhole and Add button.
Use the **Configure** button to define the drillhole vector appearance as described in *Drillhole Displays*.

An example of a ribbon of vectors modelled down a drillhole

**Profile Vectors**

Vectors can be displayed in 3D along the flight path using three vector components. First select the lines you want to display with the Profile Vector Selection dialog accessed from the Add>Profile Vector option. This dialog allows you to decimate the lines by taking every second third or fourth line to reduce clutter in the 3D display.
Line selection dialog for 3D perspective views.

The vector configuration dialog allows you to sub-sample the line data to reduce clutter, change the line thickness, select the vector components and choose the colour modulation as shown in the following dialog.

Profile Vector configuration dialog.

One of the most useful is the Bx, By, Bz components derived from component processing of a total magnetic intensity grid.
Example three component $B_x$, $B_y$, $B_z$ vector with inverted $B_z$ component to show how the vectors point to the magnetic anomaly source.

**AutoMag and Standard Points**

Example of AutoMag solutions displayed on a 3D surface

You can display point data and AutoMag solutions as prismatic shapes in the 3D perspective view. If you have points with a $Z$ attribute and other associated channels such as Euler 3D solutions you can import this data into a point data set for 3D visualization.
Dialog control for 3D point attributes

Other suitable point data sets include z attributed geochemistry, gravity stations and geological sample locations.

Example of 3D point display in a semi-transparent surface

The only symbol shape available for 3D points is the rectangular block. This shape can be displayed as a wire frame or solid block. You can modulate the colour and size of the symbol using auxiliary channel data.

Colour modulation can be indexed or continuous. The index case is used to match integer values to specific colours such as the AutoMag operator expansion value of LEVEL. You could use magnetic susceptibility to modulate the Size of the block.
Multi-Track View

The Multi-track view complements the other display tools by providing a powerful data presentation tool that can be used to compare and contrast data channels. It is used routinely to analyse the fine detail in data, investigate the behaviour of line filters and present data for reports. The addition of a spreadsheet track has provided access to the underlying numbers with the ability to edit individual values.

Typical applications include:

- Quality control analysis of noise in aeromagnetic data
- Comparison of different filters
- Comparison of radiometric, elevation, altimeter and magnetic data
- Valuation of fine detail in magnetic data
- Location of bad data points.

Opening a Multi-track Window

The Multi-track dialog allows you to select the line, data channels, number of tracks and the optional spreadsheet display.
Multi-channel display options menu

Once the desired channel names are highlighted, they can be selected for display by clicking the Select>> push button. When this is done, the highlighted names transfer from the Available area to the Selected area. Individual channels can be selected multiple times.

Note

If all channels are to be displayed the Select All push button can be used.

The first nominated channel in the Selected box appears in the bottom track, the second channel in the second from the bottom track etc. The same channel can be multiply selected for display in different tracks if required.

If one or more selected channels are not required for display, they can be highlighted and deleted using the Deselect push button. Note that channels can be deleted from the multi-track display after the window has been created.

Horizontal Axis - By default, the DIST_ABS channel is selected as the horizontal axis. Other channels such as east or north can also be for location purposes.

A cross plot display can be achieved by selecting non-distance based channels for the horizontal axis. Only the vertical axis can be set to log scaling.
**Track Control** - You can control the number of allocated tracks in the window by overriding the default Auto control. A reference track is added to the bottom of the display if the check box is left on.

**Add Table** - Provides a spreadsheet track on top of the multi-track display. This table can be scrolled to any part of the line and when a record is selected, a cursor appears in the reference track that indicates the location of the record within the line.

**Functional Elements of a Multi-Track Display**

The multi-track display has a number of functional elements:

- **Spreadsheet Table**
- **Tracks**
- **Channels within Tracks**
- **Reference Track**

**Spreadsheet Table**

The spreadsheet provides access to the numeric values within the selected data channels. Individual values can be edited to remove spikes or detect problems in the data. Special properties of the table include:

- Show graphics cursor when record row selected
- Scroll up and down the spreadsheet
- Resize columns
- Edit cells

**Tracks**

One or more data channels occupy each graphics track. Each track is allocated the same proportion of available space, but can be re-sized by selecting and dragging a horizontal bar at the top of the track.
The Track Configuration dialog

The properties of a track can be changed by accessing the configuration dialog with a right mouse selection within the track area.

See the multi-track view that follows for an example of individual control of the grid characteristics. The annotation increments are set by default but can be changed from the annotation dialog.

The Annotation Increments dialog to define the range of vertical and horizontal scales

Channels within Tracks

Each channel is treated as an object that has its attributes controlled from the channel header. The control dialog is accessed with a double left mouse selection while the mouse is positioned inside the channel header.

Editing the selected channel for style, shading, clip and data range
Examples of different channel and track styles for the same data channel

A wide range of channel styles is available from the channel control dialog. The above example shows the same data presented with five different styles.

A symbol chooser and colour selection dialog provides additional style controls.

Symbol chooser with size control
Colour selection dialog for changing line and fill colours

**Reference Track**

The reference track at the bottom of the window always displays the first channel of data across the complete width of the line. You can zoom into a small segment of the line by holding down the CTRL key and dragging the mouse with left button depressed across the segment of interest. The other tracks also zoom to the area selected, while the same segment is highlighted within the reference track.

The CTRL key is required because the standard left mouse button select is required for manipulation of the spreadsheet track. You can pan across the line using the horizontal slider and return to full view by using the fit option in the graphics toolbar.

The zoom-in and zoom-out tools on the toolbar allow zooming in the multitrack window using the left-click and drag out a rectangle method. In the x direction (along the line) all tracks will zoom together. But in the y direction only the track with the cursor will be rescaled. If one dimension of the drawn out rectangle is very small (less than 20 pixels) that dimension will not be rescaled. This enables independent x and y adjustments.

If more precise setting of the track limits is required then the Channel Edit dialog can be used.
Hole View

Sample drill log view of downhole channels with table of data values

The Hole view complements the other display tools by providing a powerful data presentation tool that can be used to compare and contrast drilling data channels. It is used routinely to analyse the fine detail in data and present data for reports. The addition of a spreadsheet track allows access to the underlying numbers with the ability to edit individual values.

Opening a Drill Log Window

The Multi-track dialog allows you to select the hole, data channels, number of tracks and the optional spreadsheet display.
Once the desired channel names are highlighted, they can be selected for display by clicking the **Select>>** button. When this is done, the highlighted names transfer from the **Available** area to the **Selected** area. Individual channels can be selected multiple times. If all channels are to be displayed, the **Select All** button can be used.

The first nominated channel in the Selected box appears in the bottom track, the second channel in the second from the bottom track etc. The same channel can be multiply selected for display in different tracks if required.

If one or more selected channels are not required for display, they can be highlighted and deleted using the **Deselect** button. Note that channels can be deleted from the multi-track display after the window has been created.
Example of a drill log display

- **Horizontal Axis** - By default, the DIST_STRING channel is selected as the horizontal axis.

- **Track Control** - You can control the number of allocated tracks in the window by overriding the default Auto control. A reference track is added to the right of the display before the Model track if the check box is left on.

- **Add Table** - Provides a spreadsheet track on top of the drill log display. This table can be scrolled to any part of the hole and when a record is selected, a cursor appears in the reference track that indicates the location of the record within the hole.
Functional Elements of a Drill Log Display

The drill log display has a number of functional elements:

• **Spreadsheet Table**

• **Tracks**

• **Channels within Tracks**

• **Reference Track**

**Spreadsheet Table**

The spreadsheet provides access to the numeric values within the selected data channels. Individual values can be edited to remove spikes or detect problems in the data. Special properties of the table include:

• Show graphics cursor when record row selected

• Scroll up and down the spreadsheet

• Resize columns

• Edit cells

**Tracks**

One or more data channels occupy each graphics track. Each track is allocated the same proportion of available space, but can be resized by selecting and dragging a horizontal bar at the top of the track.
The Track Configuration dialog

The properties of a track can be changed by accessing the configuration dialog by clicking inside the track area. The annotation increments are set by default but can be changed from the annotation dialog.

The Annotation Increments dialog to define the range of vertical and horizontal scales

Channels within Tracks

Each channel is treated as an object that has its attributes controlled from the channel header. The control dialog is accessed by double-clicking inside the channel header.

Editing the selected channel for style, shading, clip and data range

A wide range of channel styles is available from the channel control dialog. A Symbol Selection and Colour Select dialogs provide additional style controls.
Reference Track

The reference track at the bottom of the window always displays the first channel of data across the complete width of the hole. You can zoom into a small segment of the hole by holding down the CTRL key and dragging the mouse with left button depressed across the segment of interest. The other tracks also zoom to the area selected, while the same segment is highlighted within the reference track.

The CTRL key is required because the standard left mouse button select is required for manipulation of the spreadsheet track. You can pan down the hole using the vertical slider and return to full view by using the fit option in the graphics toolbar. The zoom-in and zoom-out tools on the toolbar allow zooming in the drill log window using the left-click and drag out a rectangle method. In the z direction (adown the hole) all tracks will zoom together.

If more precise setting of the track limits is required then the Channel Edit dialog can be used.
Page Layout View

Example of the page layout window with 4 source window objects

You can prepare your report quality plots using the Layout window. When you select this option, you must also choose a printer and output page size. On this page, you can add source windows such as sections, maps, perspective and multi-track windows. You can position and size each of the windows on the layout page. All window objects apart from the perspective can be assigned a precise scale.

Once you have the window objects positioned, add a layer of drafting information that includes text and interpretation elements. Use the line drawing tools to add geological information to a model. Highlight important features in the model.

For more information about creating a layout, using the page payout drawing tools and printing, see Page Layout.
Modelling Techniques

This section provides an introduction to the philosophy of modelling as implemented in ModelVision.

Body edit controls are described for map and section views. You will learn about changing the location, size, shape and physical properties, colour, appearance and labelling of bodies. The theoretical response of the whole model or individual bodies can also be displayed and analysed. The individual bodies used to simulate a geological situation constitute a ‘model’. The computed response interactions of the various bodies, especially as they are affected by physical properties, are discussed.

To provide modelling experience and assist you in gaining effective techniques, a section on hints and modelling tips has been provided. These tips lead into an introductory modelling tutorial for a ‘real’ exploration situation. Regional analysis, forward model development and refinement using inversion are demonstrated.

In this section:

- Modelling with ModelVision
- Modelling Guidelines
- Before You Start
- Creating Bodies
- Cloning Bodies
- Editing Bodies
- Polygroup Bodies
- Moving and Snapping Vertices
- Editing Multiple Bodies
- Body Conversion and Subdivision
- Terrain Correction Calculator
- Strata Modelling
- Converting Point Attributes to Models
- Testing Response with Synthetic Data
- Displaying Curves and Tracks
- Enclosed Bodies
- Drillhole Modelling
- Point Modelling
- Hints and Modelling Tips
Modelling with ModelVision

ModelVision allows you to develop complex multi-body models to match the observed field variations of large data sets. Ultimately field variations due to every body may be computed at every station, but such computations are intensive and may not be necessary. To speed up model development you should adapt a strategy of selective computation. ModelVision allows field variations to be assigned to a regional field that is not modelled. It also provides for selection of bodies that are to have their responses computed plus selection of the stations at which the computations are to be made. The AutoMag module can provide rapid starting models for magnetic interpretation. Inversion is also a powerful tool to speed up the final stage of model development. In addition to these tools, you may be able to reduce complex models to local components that can be developed independently, exported and amalgamated for final adjustment.

A wide range of model controls can be manipulated to provide versatility in potential field modelling. You are able to use ModelVision most efficiently if you learn to use each of these controls and adapt an efficient and versatile approach to each modelling exercise. This gives you more time to optimize and check models and to model alternative concepts. An efficient way to learn how to use ModelVision is to first experiment on a single profile to master the primary model controls. Following this, test each of the adjustment controls using a multi-line data set.

ModelVision can be set to compute model fields at profile stations using the settings in the Line Control dialog and at grid nodes using the settings in the Grid Control dialog. Most geophysical data is acquired along lines and so it is usually most appropriate to model along profiles. Profile model output can be gridded or computed on a grid if required. Points randomly sampled in an area can also be modelled as well as readings specified down drillholes.

Many actual applications of potential field modelling are provided in the Users Guide. Applications include:

- Targeting anomalies
- Modelling multiple source models
- Regional simulation
- Basin modelling
- Developing geological cross-sections
- Modelling specific body types such as 3D intrusives, salt domes and orebodies.

Modelling Guidelines

To assist in configuring ModelVision displays and body editing a few simple guidelines are adopted. These guidelines apply throughout ModelVision.
Guideline 1

Potential field responses of all bodies are computed at stations selected as active. Unless a body is specifically set to be inactive for computation, it contributes to the model response regardless of whether or not it is visible in any of the display windows currently open. Although bodies are created in specific windows, they exist within the model space. Following any change or modification, their appearance is updated automatically in any window that displays the body. Moving a body may cause it to disappear from a map or cross-section display but as long as it is active, its response is still computed and contributes to the model output.

Guideline 2

Amplitudes of the potential fields of a body are proportional to the physical property contrasts between that body and the background properties. A body with property equal to background generates a zero response. Field variations of each body are computed independently and do not take into account the effect of any overlap. The combined field of two or more bodies irrespective of overlap is the sum of the fields of those bodies.

Guideline 3

On computation, ModelVision writes a channel of the currently selected output name at each station or grid cell that is active. This overwrites any previous values for a channel of the same name. If only a subset of stations within a line is active for modelling, the output channel is deleted at inactive stations. This prevents output channel reporting of an incorrect mix of results for different model computations. If however a complete line is removed from computation, any existing model output channels are retained. It is possible to have a model output channel that reports the output of different models on different lines.

Guideline 4

Computations at profile stations are made at the horizontal location of the station. The computations are made at specified station elevations if the Use Sensor Z Channel option is enabled. In all other cases, computations are made at zero elevation. In cross-section view, the input and output model profiles are projected onto the base line that joins the first and last points of a profile.

Guideline 5

Pop-up dialog boxes control the display window appearance. Clicking the right mouse button while the cursor is positioned in the relevant window accesses these dialogs.

Guideline 6

Configuring individual features and objects such as bodies, titles, legends etc. is done by positioning the cursor over the object and double clicking the left mouse button. In each case, a dialog is presented which controls the selected object.

Guideline 7

Standard Microsoft Windows keyboard usage applies. This means that the SHIFT key in combination with the left mouse button can be used to multiply select objects or items in a list. Similarly, when more than one object is overlapped by others and selection is difficult, the CTRL key in combination with the mouse button can be used to select covered items.
Before You Start

You must complete several steps before you can compute a model. All model settings have defaults that can be altered if necessary. More details of the prerequisites required for modelling are provided in the Users Guide.

- **Confirm Model Settings**
- **Select the Points for Model Response Computation**
- **Create or Import a Starting Model**

Confirm Model Settings

ModelVision computes the response of a body according to its physical property contrast compared with the background. Typically, background magnetic susceptibility is zero and background density is a representative value for the area. These values can be reset as required in the File>Project Properties or Model>Defaults options.

If you are undertaking magnetic modelling the strength, inclination and declination of the Earth’s magnetic field need to be defined. These values are displayed on the base of the ModelVision window frame.

Select the Points for Model Response Computation

For line-based modelling, you need to set a line or lines as active for computation. This can be done in several ways. When a cross-section window is opened the line is made active for modelling according to the current Line Control settings. You can also select and deselect lines in the Line Control dialog or toggle line selection using the Active Line tool (see Using the Active Line Tool) in a map view. If you deselect a line for line computation, the output channel for that line is not updated as you make any subsequent changes to the model. The output channel can therefore be inconsistent between lines deselected at different stages of model development.

You can also select stations in either map or cross-section view using the Active Points tool (see Using the Active Points Tool) to focus on particular anomalies. To select active points you need to deselect points outside the active area. Conversely, you can also select active points within an active region. For those lines with both selected and deselected points, any occurrence of the current model output channel is deleted to prevent inconsistencies between those channel values within individual lines.

Create or Import a Starting Model

To start modelling you need to make interpretive decisions about the number, properties and type of bodies to construct. This can vary from a simple to a complex exercise that may involve digitizing models to topography or incorporating constraints from seismic cross-sections and/or drillholes. Bodies can be positioned, oriented and matched to the extents of an anomaly in image or contour displays. You can represent bodies of a complex plan view with plunging prisms that can be digitized to match geophysical anomaly extents or features in scanned geology map backdrops.
The vertical position and depth extent of bodies is best set in cross-sectional views. For near-surface models, you can display terrain elevation along the line to relate the bodies to the ground surface. For airborne surveys, it is also informative to display the sensor elevation to recognize field variations that might be related to changes in sensor elevation rather than changes in the model. For complex models with many bodies, you may find that a perspective view is useful to check the locations of bodies.

Creating Bodies

Fundamental to ModelVision is the ability to create and manipulate bodies. ModelVision supports a range of body types and their creation procedure differs depending on whether an cross-section or a map view is being used. For example, a body having a complex polygonal cross section can be created in a map, but only a default cross-sectional shape is assigned. If the same body type were generated in a cross-section display, the individual vertices of the polygonal shape can be specified. When a new body is created, it is difficult to achieve the required shape and parameters immediately. After creation, bodies can be edited to manipulate their shape and physical properties. A description with information defining the various body types is provided in Appendix B: Body Descriptions.

Bodies can be created from the Create Body dialog, which can be accessed by selecting either the Body button or from the Create Body option in the Model>Body Operations menu.

The types of bodies you can create are:

- Polygon
- Sphere and Ellipsoid
- Tabular
- Plunging Prism and Frustum
- Elliptical and Circular Pipe

The Create Body dialog by default displays a preview window and available modelling parameters for the selected body type. To hide the preview click the Hide Preview button, and to view the preview again click the Show Preview button.
In the list of body types, the **Clone Selected** option will clone a body selected in a map or cross-section view. When a body is cloned, the model parameters for the selected body are duplicated in each clone. For more information, refer to the *Cloning Bodies* section later in this chapter.

**Note**
The Create dialog enables body creation only in the window that was active at the time the **Create** dialog was accessed. All body types can be created in either cross-section or map views.

Beneath the list of body types, is a checkbox that is enabled by default. The **One body only** check box enables you to create a single body or to create successive bodies in the available cross-section or map display.

**Note**
When multiple bodies are to be created (with the one body only option unchecked), you can force the dialog to vanish by selecting the **Pointer** button or toolbox button. Alternatively, you can check the one body only box and create only a single body.

At the base of the dialog are default physical properties that vary depending on the type of body selected. Edit these parameters to assign properties to a selected body. Initially, these body parameters are defaulted from the **MVISION.INI** file and the **Model>Defaults** and **File>Project Properties** options. Refer to *Appendix D: Defaults and Settings* for additional information.

The colour patch indicates what colour will be assigned to the next body created. This can be changed by clicking on the patch to bring up the colour picker dialog. See also, *Controlling Body Colours*.

The **Edit** button below the colour patch shows the label which will be assigned to the body. Bodies must have unique labels so if this name has already been assigned the new label will have a sequential number appended to it.

**Controlling Body Colours**

Body colours are chosen sequentially from a colour look-up table (LUT) which may optionally have labels attached to each colour entry. You may use a standard colour table or set up your own colour table for the lithology of your project area. (See *Using the Colour Table Editor*).

The LUT that controls body colour is set in the **Setup** option of the **File** menu. If the LUT does have labels, they are displayed in the drop-down list of the edit button and also in the drop down list of the colour picker dialog. The colour and the label are linked so that changing one will change the other.
The Setup dialog contains many default settings for displays and file paths.

**Note**

The colour picker is context sensitive. If it is a body colour choice it loads the body palette. The picker will only display labels if one or more labels are in the table. If labels are missing for some colours a label "Cn" is used where n = the sequence number.

A setting in the **Setup** dialog allows body colours to be advanced or kept fixed for each new body.

The lithology LUT with its labels can be displayed as a legend in the map and cross-section windows. The whole sequence or a subset of it can be displayed.

The lithology LUT for bodies is global to all windows and the displayed colours are independent of property. However each window can still have its body colour modulated by property using an LUT which can be specific to that window. This would enable a user to have body colours modulated by density in one window and by susceptibility in another.

**Polygon**

For cross-section polygon body creation, position the cursor in the section area of the active window and locate the cursor at the first vertex to be defined. Use the left mouse button to register the vertex. By moving the cursor and repeating the left mouse click, additional vertices can be defined. Complete the body outline by positioning the final point near the first point and clicking the left mouse button to close the polygon. An alternative method to close the polygon is to double click the left mouse button. If an error is made while placing vertices, click the right mouse button to delete the previously entered vertex. Repeat to delete additional vertices. There is no requirement to define the polygon in a clockwise or anti-clockwise direction.
After creation, the polygon body lies horizontally and has two vertical end faces. The strike length of the body is defaulted and the azimuth is perpendicular to that of the cross-section in which it was created. The plunge and azimuth of the polygon can be edited. See the section on Editing Bodies for details.

For map views, placing the cursor into the active map display and clicking the left mouse button can create a polygon body. You can simply create polygon body of default size by a single mouse click or for a definable size, click the left button and drag a rectangle. When the button is released, the body assumes the rectangle dimensions and has a strike azimuth of zero.

Note that it is possible to associate the vertices used to define a polygonal body between adjacent polygons. This linking of vertices and synchronous movement is described in Moving and Snapping Vertices and Editing Vertices.

Example of a polygonal body in perspective view

Example of a polygroup body in perspective view
Sphere and Ellipsoid

To create circular cross-section bodies (spheres and ellipsoids), a different method of defining the location and size is used compared with polygonal bodies. These body types are created by positioning the cursor in an active cross-section or map area and expanding an 'entry' box with the cursor. This is done by clicking the mouse button where required and moving the mouse to dynamically define a creation box. The initial placement of the cursor defines the centre of the circular or spherical body. The size of the box defines the axes of the cross-section of the body type. If a rectangle is drawn, the ellipsoid uses the longer side as its major axis.

An alternative method of spherical body creation is to position the cursor and click the left mouse button. When this is done, a body with default size and parameters displayed in the Create dialog is created.

An example of a spherical body in perspective view

An example of an ellipsoid body in perspective view
Tabular

To create a tabular body, a similar method of defining the location and cross-sectional size is used as for the circular bodies. After defining the enclosing 'box', release the left mouse button to form the cross-sectional area of a tabular body type.

An alternative method of tabular body creation is to position the cursor and click the left mouse button. When this is done a body with the default size and parameters displayed in the Create dialog is created.

If the created body is too wide or high, select a corner handle and resize the body with the left mouse button depressed. When the mouse button is released, the tabular body is re-sized automatically.

For map creation, the depth and depth extent of the tabular body are defaulted.

An example of a tabular body in perspective view

Plunging Prism and Frustum

The plunging prism and frustum body types are not usually created from an cross-section window, although they can be. These body types are most often created and edited in a map window. To define the Plunging Prism or Frustum in this manner, ensure that the Create dialog is enabled while the Map window is active.

In a map view, plunging prism or frustum bodies are created by positioning the cursor in the window and locating it at the first vertex to be defined. Use the left mouse button to register the first vertex. By moving the cursor and repeating the left mouse click, additional vertices can be defined. If an error is made while defining the body outline, click the right mouse button to delete the previously entered vertex. Repeat to delete additional vertices. Completion of the body is made by positioning the cursor near the first point and clicking the left mouse button to close the area. An alternative method to close the polygon is to double click the left mouse button. There is no requirement to define the polygon in a clockwise or anticlockwise direction.
An example of a plunging prism body in perspective view

An example of a frustrum body in perspective view

To create the plunging prism or frustum body types within a cross-section, use the same technique as for the tabular body. The created plunging prism or frustum has only a simple four corner prism cross-section but this can be edited from the body editing dialog. See the section on Editing Bodies for detail on achieving this.

After creation, the mapped horizontal shape of the body plunges vertically and lies a default distance below the surface. Editing of the plunging prism can be used to control the azimuth, plunge and depth, and the top surface of the plunging prism can also be made to dip at a desired angle with the exception that it cannot intersect the bottom face of the body (which is flat lying). In the event that the bottom surface is intersected by the top surface by too large a dip angle, an error message is displayed.

If an error is displayed, reduce the top surface dip angle and retry the configuration. Editing of the frustum can be used to control the vertical extent, plunge, plunge azimuth and taper of the body. The taper value defines the relative horizontal distances of equivalent vertices on top and bottom faces from the centroid. If the taper is less than one the cross-section of the body reduces with depth, and if the taper is greater than one the cross-section increases with depth.

Note

The colour picker is context sensitive. If it is a body colour choice it loads the body palette. The picker will only display labels if one or more labels are in the table. If labels are missing for some colours a label "Cn" is used where n = the sequence number.
Note that it is possible to associate the vertices used to define a plunging prism body between adjacent plunging prisms. This linking of vertices and synchronous movement is described in *Moving and Snapping Vertices*.

**Elliptical and Circular Pipe**

The elliptical and circular pipe body is a frustum body whose top and bottom faces are constrained to be circular or ellipses. This body is also most commonly created in a map view, although it can be created in a cross-section window. To create a pipe body in the map window, a similar method of defining the location and cross-sectional size is used as for the circular bodies. After defining the enclosing 'box', release the left mouse button to define the cross-section of the pipe body.

An alternative method of creating a pipe body is to position the cursor and click the left mouse button. When this is done a body with the default size and parameters displayed in the Create dialog is created, and the depth, depth extent, plunge and taper of the pipe body are defaulted.

The circular pipe body type contains two less parameters than the elliptical pipe. Parameters which can be manipulated are: Vertical Extent, Plunge Azimuth, Plunge, Radius and Taper.

The present elliptical pipe is not easily constrained in single profile because of the two radii, therefore the use of the circular pipe is recommended to be able to edit a single radius.
Cloning Bodies

The Clone Selected option, available on the list displayed in the Create Body dialog, is useful to create a duplicate of a selected body. To create a duplicate body, initially select the body to be cloned (see Selecting Bodies). After choosing the Clone Selected item move the cursor to the active window (the cursor shape is ‘+’), and position it where the new body is to be located. Click the left mouse button and a new, cloned body is created. The cloned body has identical body properties to the ‘source body’ except for its location.

Editing Bodies

Bodies in ModelVision can be edited in either cross-section or map displays. As some bodies (such as the polygonal body) can have complex cross-sectional shape it is not appropriate that they be modified in map form and the opposite is true for Plunging Polygonal Prisms.

- Selecting Bodies
- Moving Bodies
- Changing Physical Parameters
- Changing Remanence Properties
- Deconstruct Resultant Magnetisation
- Changing Anisotropy Properties
- Changing Spatial Properties
- Changing Display Properties
- Editing Vertices
- Undoing Edits
- Locking Bodies

See also Editing Multiple Bodies

Selecting Bodies

Instructing ModelVision which body is to be edited precedes all model editing. This is done by initially selecting the body. Bodies can be selected individually or multiply. Once selected, they can be shifted, re-sized and have various parameters altered. Body selection operates identically both in cross-section and Map displays.

To select a body, ensure the display in which the selection is to be performed is active and that ModelVision is in Pointer mode.

Note

The Status Bar reports if ModelVision is in Pointer mode. If ModelVision is in the incorrect mode, select the Pointer button.
Position the cursor over the required body and click with the left mouse button. To indicate a body is selected, four surrounding handles are drawn around the body or the body’s outline is drawn with a thickened bold line.

To select more than one body, use the SHIFT key and the left mouse button. To indicate which bodies have been selected, a ‘select’ box, indicated by four handles, are drawn around each body as well as the bold outline. In the case of polygons the various vertices are also highlighted. Multiple bodies can also be selected by drawing out a containing rectangle with the left mouse button held down.

Where bodies overlap and it is difficult to select a particular one, use the CTRL key with the left mouse button to cycle through the bodies in the relevant area.

As an added aid to selecting bodies where overlap occurs, a selected body which is drawn ‘in front’ of another body can be forced to ‘the back’ of the display by pressing the keyboard B key.

Additional ways of selecting a single or multiple bodies are available from the Body Parameters Table (see Editing Multiple Bodies).

**Moving Bodies**

Individual bodies can be moved in cross-section (or map views) by selecting the body and moving the cursor while keeping the button depressed. This ‘drag and drops’ the body to a new location when the mouse button is released. When repositioned, the response of the new model is automatically computed if in Immediate mode. If in Manual mode, select the Compute function to recompute and update the response.

If more than one body is to be shifted, select the required bodies (see Selecting Bodies). Once the required bodies are selected, they can all be moved together by clicking the left mouse button with the cursor over one of the bodies. The selected bodies can be ‘dragged and dropped’ at the new location.
Changing Physical Parameters

Individual body parameters can be defined using a common dialog. By double clicking on the body, the Body Properties dialog box is displayed:

![Body Properties dialog](image)

At the top of the dialog window, the **Label name** of the selected body is displayed. This name can be modified to be more meaningful if desired, for example ‘Syncline Body’ or ‘Ore Zone’. The actual body type is specified lower in the dialog.

The primary physical properties of the selected body are indicated in the dialog. The body density and magnetic susceptibility can be altered if required. The **Add Label** button is used to display the label with the body.

The radio buttons tagged **Spatial**, **NRM**, **Aniso**, **Pos** and **UBC** change the right side of the dialog and display fields that are relevant to the selected option. When Pos is selected, only summary parameters for the body are shown and right hand expansion area is not present.

- **Spatial** – shows spatial parameters such as dip, azimuth, width, etc.
- **NRM** – natural remanent magnetisation properties if enabled (refer to Magnetic Field Controls).
- **Aniso** – magnetic anisotropy parameters.
- **Pos** – shows a property summary and centroid position.
- **UBC** – set the upper and lower density and magnetic susceptibility properties to be included in exported UBC models. See chapter on the UBC Model Mesh Designer (Optional Module) option.

The check boxes tagged **Active**, **Locked**, **Visible** and **Regional** control the computational and display properties of the selected body:
• If the **Active** check box is disabled, the response for this body is not computed.

• If the **Locked** check box is enabled, this body cannot be moved in the display. This prevents accidental movement of a body when editing or moving other bodies.

• If the **Visible** check box is enabled, the body is visible in section and plan. Note that the calculation of the bodies response will still take place if the body is invisible and the checkbox is enabled.

• If the **Regional** check box is enabled, this body will be treated as a regional body. (This is used primarily in Inversion. Refer to the *Inversion* section for more information.)

An example of the Spatial parameters for a tabular body is shown below:

![Body properties dialog with spatial parameters for tabular bodies selected.](image)

The **Add Label** button is used to display the label with the body. The button toggles to **Delete Label**, which can be clicked to switch the label off. Refer to the section on *Body Labels* for editing the content of body labels.

Additional channel buttons control the addition (**Display**) or removal (**Delete**) of **Associated Channels** into a profile (see *Displaying Curves and Tracks*). A button is also provided to control **Display Properties**. The operation of this function is described in *Changing Display Properties*.

Use the **Next Body** arrow buttons to select the next or previous bodies in the list of available models. The displayed dialog parameters will alter appropriately as this is done.

Use the **Auto** option to apply changes immediately a field is completed, otherwise use the **Apply** button.
Changing Remanence Properties

Modelling of magnetic remanence must first be activated from the menu Model>Magnetic Field dialog or the Remanence check box in the NRM body properties dialog (below) before remanence properties can be changed when the NRM radio button is selected.

In the absence of demagnetisation, the figure below shows how the induced magnetisation (Jind) and remanent magnetisation (Jnrm) vectors are summed to produce the total resultant magnetisation vector (Jres), each of which lie on a plane. Any change in the induced or remanent vectors will change the direction of the resultant vector (Jnrm).

![Figure illustrating the relationship between the induced, remanent and resultant magnetic field vectors.](image)

These vector interactions are reproduced in the NRM dialog, shown below.

![Body properties dialog showing the NRM remanence parameters.](image)

Departure angles between the induced, remanent and resultant field vectors are list in the bottom right of the dialog. If you are inverting on resultant magnetisation the apparent resultant rotation angle (ARRA) is an important indicator of the presence of remanent magnetisation. The ARRA value is defined by the field Jres-Jind. Refer to Pratt, McKenzie & White (2012) for a more detailed explanation of the use of the resultant magnetisation vector.
The distribution of ARRA values in a project area can help better understand the existence of remanence within a range of target types. The example below shows a map created from the Jres-JInd values exported from ModelVision for display in Discover PA.

![Image of map showing ARRA values calculated in ModelVision for 100 intrusive pipes.]

*This image was created in Discover PA from ARRA values calculated in ModelVision for 100 intrusive pipes.*

A non-zero Koenigsberger ratio Q is required before the NRM values can be calculated or alternatively the NRM intensity must be non-zero before a Q value can be computed. If either is changed the resultant magnetisation vector will be updated. Conversely, if the resultant magnetisation amplitude Jres is changed, then both Q and the NRM values will be updated. Use the View button to activate a 3D view of the vectors. Click on the 3D view and then select the left mouse button and while holding it down drag the 3D sphere around until you achieve an optimum view.

![Image of 3D vector visualization from View button.]  
*Visualization of the induced (red), remanent (green) and resultant field (blue) vectors activated from the View button.*

Note also that if you change the susceptibility, the value of Q and the resultant magnetisation amplitude Jres will change but the remanence vector NRM and resultant magnetisation vector directions will remain unchanged.
Deconstruct Resultant Magnetisation

The resultant magnetisation vector is the vector sum of the induced magnetisation and remanent magnetisation. ModelVision inversion is able to recover the resultant magnetisation vector as a unique attribute of the magnetic source rock for an isolated magnetic anomaly.

Of course that does not provide us with a unique solution for the magnetic susceptibility or natural remanent magnetisation \((J_{nrm})\). We need at least one more parameter to deconstruct the resultant magnetisation vector into its two components. To help with this process, we have provided a tool with five different methods for deconstructing the resultant into magnetic susceptibility and remanent magnetisation.

- Susceptibility
- Koenigsberger ratio
- NRM intensity
- NRM inclination
- NRM declination and inclination

The measured or estimated resultant magnetisation and induced magnetisation vectors define a plane which must also contain the remanent magnetisation vector. This plane is an important part of understanding how the remanence information can be deconstructed into its component parts.

*Great Circle Plane defined by the \(J_{res}\) (resultant) and \(J_{ind}\) (induced) field vectors. The \(J_{nrm}\) (remanent) vector must lie on the same plane.*

The five options are accessed from the Deconstruct button on the NRM tab of the Body Properties dialog (previous figure). This button opens the modeless dialog shown below. We recommend that you first activate the 3D vector display window as it will automatically update while you are experimenting with the deconstruction entries.
Remanence deconstruction dialog showing the five methods.

Each time you select a parameter from the five options and enter a value, the fields beside the other four options will update.

Susceptibility - you may have estimates of susceptibility from outcrop, drilling or rock type. You can enter a range of values around your best estimate and determine the sensitivity of the Q and NRM vector Intensity, Inclination and Declination.

Q - If you have a knowledge of the probable Koenigsberger ratio, then you can resolve the susceptibility, NRM remanence vector Intensity, Inclination and Declination.

NRM Intensity - If you have a measurement for the NRM Intensity from an un-oriented core, then you can use this information to resolve the magnetic susceptibility, Q, NRM Inclination and NRM Declination. Where two possible solutions exist, the higher Q value is accepted.

NRM Inclination - If you have un-oriented core from a vertical drillhole you can still measure the inclination of the NRM vector. You do not know the declination of the vector, but the cone of the vector will intersect the great circle plane in two places. From one intersection you can resolve the magnetic susceptibility, Q, NRM Intensity and NRM Declination. One of the intersections is likely to be invalid, but if two are possible, then the lower Q value is selected.

NRM Inclination and Declination - If you have paleowander data for your sample area, then you can enter the transformed inclination and declination values for the field. This unit vector will be projected onto the great circle plane that contains the induced field vector and resultant magnetisation vector. The projected unit vector is assumed to be the local direction of the remanent vector which then allows calculation of susceptibility, Q and remanent magnetisation intensity.
The dialog replaces your initial inclination and declination with the projected values and displays the departure angle from the plane containing the induced magnetisation and resultant magnetisation vectors. The latter is the angular separation of the estimated paleowander vector and the great circle plane. If this value exceeds 10 to 15 degrees, then the estimated values for susceptibility, Q and remanent magnetisation intensity are likely to be poor. You can experiment with changes in the angles to determine the sensitivity of the estimates. Where two possible solutions exist, the higher Q value is accepted.

Some Limitations of Deconstruction

There are some situations where the input information may not be able to produce a valid solution, or there may be a second possible solution. When this situation occurs, ModelVision will produce a warning message with a brief explanation of the situation.

Case 21  Q has been increased to the lowest realizable value.

The entered value is not physically realisable and the lowest possible value is computed and returned.

Case 31  No valid Q, specify $|\text{jrm}| > |\text{Jres}|$ for anti-parallel vectors.

When the remanent magnetisation vector is 180 degrees away from the inducing field, the amplitude must be increased to make sure the vectors do not cancel.

Case 32  No valid Q: specify $|\text{jrm}| > |\text{Jres}|$ for $90 < \text{resultant departure angle} < 180$ degrees.

If the departure angle is greater than 90 degrees, the remanent magnetisation must be greater than the resultant magnetisation.

Case 51  No unique solution since vectors $\text{Jind}$ and $\text{Jres}$ are parallel. Use Q option.

If the resultant is sub-parallel to the inducing field then the only option you can use is a change in the Q value.

Case 52  No unique solution since vectors $\text{Jind}$ and $\text{Jres}$ are antiparallel. Use Q option with $Q > 1$.

If the resultant is in the reverse direction to the inducing field, then you also need to use the Q option.
Changing Anisotropy Properties

Magnetic anisotropy occurs in many rocks and is particularly strong in banded iron formations where the foliation of the magnetic minerals produces a differing induced magnetisation response as the inducing field direction is changed. Thus the effective magnetic susceptibility varies according to the local IGRF field direction. See Emerson et al. (1985 pp. 39 – 42), Clark (1997), and Clark and Schmidt (1993) for background information on magnetic anisotropy.

Laboratory measurements of magnetic anisotropy produce magnetic susceptibility values for the major, intermediate and minor vector directions. The axes are orthogonal and an example of this is shown in the following figure.
The vectors are normally entered into the dialog illustrated below in order of decreasing amplitude, i.e. $k_1 \geq k_2 \geq k_3$ as shown on the right-hand side of the following figure.

The anisotropy radio button ($Aniso$) is used to turn on the feature for the selected body and must be active for each body that you wish to model with magnetic anisotropy. The magnetic susceptibility value shown in the left hand side of the dialog is computed from the anisotropy entries. It is the effective magnetic susceptibility ($k_{eff}$) that would be computed from the following relationship:

$$k_{eff} = \frac{|K.F|}{|F|}$$

Where,
**K** is the anisotropic magnetic susceptibility tensor. 
**F** is the geomagnetic field vector.

**Note**
Inversion on anisotropy is not supported in release 12 of ModelVision.

Anisotropy causes a rotation of the resultant magnetisation vector away from the inducing field direction and can produce an effect that is equivalent to remanent magnetisation.

**Changing Spatial Properties**

The spatial properties appear at the right side of the Body Properties dialog when the *Spatial* radio button is enabled (refer to *Changing Physical Parameters*). The dialog entries are different for various body types. In each case, attributes such as radius, axis lengths, strike length, azimuth etc. can be edited to modify the selected body.

Depending on the body selected, the Spatial Properties dialog displays one of the following dialogs:

![Tabular body editing dialog](image)

*Tabular body editing dialog. This window permits entry of location, thickness, depth extent, dip, strike length and azimuth.*
Sphere Spatial Properties dialog. Modification of location and radius is available.

Polygon body editing dialog

The polygon body editing dialog is shown above. This dialog permits modification of the reference point location, azimuth, plunge and strike length of the body. Modification of the positions of individual vertices is accessed from the Vertex Edit button in the bottom right of the dialog. Note that editing and display of body vertices can be performed in either geographic or relative axis coordinate systems. Note also that the Modify Point button must be clicked after changes to each vertex in order to activate those changes.
The vertex editing dialog for the Polygon body

The plunging prism body editing dialog

The plunging prism body editing dialog is shown above. This dialog permits modification of the reference point location, azimuth, strike length, plunge, azimuth and dip of both the body and its top face. As with the Polygon body, access to the individual vertices is via the Vertex Edit button in the bottom right of the dialog. Editing and displaying body vertices can be performed in either geographic or relative axis coordinate systems. The Modify Point button must be clicked after editing each vertex in order to apply those changes.
The vertex editing dialog for the Plunging Prism body

The Frustum body editing dialog
The Circular Pipe body editing dialog

The Elliptical Pipe body editing dialog
Ellipsoid edit dialog. This dialog permits specification of location, cross-section axes and their lengths.

Changing Display Properties

The Body Display option controls how bodies are represented on the screen. Selection of the Display Properties button presents a dialog as below:

The available display modes are:

- **Solid** - this display type represents the body by a colour-filled, shaded solid object
- **Wire Frame** - the bodies have the same representation as the solid form, but without the shaded colour fill. Hidden boundaries are drawn
- **Outline** - the body appears with only its outer boundaries drawn. Hidden boundaries are not drawn. The bodies are drawn only in monochrome in this mode.
• **Intersection** - displays the colour filled body where it intersects a vertical plane through the line of the profile

• **Intersection plus all outlines** - displays the body in intersection mode if it intersects the profile otherwise in outline mode if within the specified range. This is especially useful when creating polygon bodies and you want to see the position of the bodies or adjacent lines.

• **Intersection Outline** - displays the outline of the body where it intersects a vertical plane through the line of the profile

• **Default** - sets the selected display mode to be the default for the selected body

For circular cross-sectional body types (spheres, ellipsoids and horizontal cylinders) the number of divisions or facets can be defined. This parameter refers to the number of facets that are used to display the body types. The greater the number of facets used, the smoother the surface of the body appears. As the number of facets increase however the redraw speed is reduced.

Body colours can be modified by selecting the **Colour** button. Use of this option is described in the **Controlling Body Colours** section.

Body display modes may be associated with a body or a view. If a body has a display mode other than Default,, this takes precedence over the display mode of the view. It is normally preferable to leave body display mode as Default, and specify the mode for each view. This allows different modes to be used for different views and means that changing the mode only requires one operation instead of making a change for each body in the view. However, on some occasions it may be necessary to associate a display mode with a particular body. This allows one body to be displayed in a different mode from others in the view. Note that changing the display mode of a body affects its display in all views, not just in the one from which the body was selected.

**Editing Vertices**

In the Body Property dialogs above, the polygonal body types (Polygon and Plunging Prism) have the additional control of enabling their vertices to be edited. Select the **Vertex Edit** button and a display of the vertices defining the body is displayed.
Body vertices can be modified using either Geographic or Relative entries. Relative values refer to the displayed vertex location within a cross-section. You can insert, modify or remove a vertex as required.

**Undoing Edits**

Most editing operations related to the various body types supported in ModelVision can have editing steps undone incrementally. The Undo feature is initiated from the Undo button and can undo an unlimited number of body edits. Body editing that can be undone includes all graphical moves, reshapes of vertices, property assignments (susceptibility or density), creation and deletion of bodies.

**Locking Bodies**

In complex modelling circumstances, you may wish to lock the editing of a body. The lock status of a body can be invoked from the Lock entry of the body Properties dialog, or from the Body Table (see Editing Polygroup Bodies). This action prevents accidental deletion, or alteration since setting the Body Lock property makes a body unselectable. To recommence editing, turn off the locked status of the body in the Body Table or open the Body Properties dialog from the Body Table by double clicking the left margin next to the body properties.

**Polygroup Bodies**

A polygroup body is a collection of polygon bodies that share common edges and vertices. Each component body can have its own gravity and magnetic properties but its geometry is linked to the group. Changes made to the geometry of a component body are applied to the whole polygroup. This allows easy creation of complex models and the manipulation of internal vertices in a cross-section view.

- Creating Polygroup Bodies
- Editing Polygroup Bodies
• Reshaping a Polygroup Body
• Multiple Section Modelling
• Deleting Polygroup Bodies
• Disassociating Polygroup Components
• Merging Polygroups
• Polygroup Outline

Creating Polygroup Bodies

Polygroups are created by adding a new polygon body to an existing one. Firstly create a polygon in a cross-section window in the normal way using the Body button. The “one body only” checkbox may be unchecked to save having to bring up the Create Body tool each time. The vertices of the first body will be highlighted. It is usually easier to start the second body from a new point outside the first body than on an existing vertex. When the cursor and rubber band line from the first vertex comes close to a vertex on body 1 it will snap to that vertex and a beep will be heard. Left click to create the attached point.

Move to another point on body 1 and left click when the beep is heard. The rubber band line will connect along the edge of body 1 taking in any other vertices along the way with an audible beep for each point.
Creating a polygroup model – automatic edge following for second body.

Note

The automatic edge following will choose the shorter of the two routes around the model. If the rubber band does not take the intended route click the right mouse button to undo that string and redo choosing an intermediate vertex.

Add more points as required and double-click or click on the starting point to end body 2. This is accompanied by a final high-pitched beep.

It should be noticed that the outside edge of the polygroup is indicated by a heavy blue line, whereas internal edges are displayed by thin black lines. In create mode the outer vertices are also highlighted by a symbol to show which vertices can be connected to in order to produce a solid non-overlapping model.

A polygroup model after adding second polygon

It may be useful at times to temporarily disable the vertex snapping in order to create a vertex close to another. This can be achieved by holding down the CTRL key while the mouse is being moved.

Editing Polygroup Bodies

Polygroup bodies can be edited graphically in cross-section or from the Body Properties dialog.
Using the Body Properties dialog changes to density, susceptibility, remanent properties, label or colour will apply to the selected polygon body only whereas changes to position, length, azimuth or plunge will be applied to the polygroup.

Reshaping a Polygroup Body

Graphically choose the **Reshape** button. In reshape mode bodies cannot be edited until one of the component bodies is selected and the vertices of that body will be highlighted by a small black symbol.

Left click on one of these symbols. A beep will be heard and the point can be dragged to a new position. Any adjoining edges will be moved as well.

**Note**

If the edit causes edges to cross thus forming an illegal solid model the thick blue outer edge lines will enter the body and the model should be restored using the **Undo** button.

New points can be added to any edge of the selected body by clicking close to the edge but away from an existing vertex. If too close to a vertex that vertex will be moved instead.

Vertices common to more than one body can be deleted in the usual way by selecting and pressing the **DEL** key.

Using the Re-shape Tool

The **Re-shape** option is used to alter the shapes of bodies. Select the body to be re-shaped with a single left mouse button click after positioning the cursor over the body. If difficulty is experienced in selecting the required body, use the **CTRL** key while clicking the mouse button and ModelVision cycles through the selectable bodies. Other techniques for selecting bodies are described in **Selecting Bodies**.

The operation of Re-shape changes depending on the type of body selected:
For spheres, ellipsoids and horizontal cylinders, a selected body appears with a single 'pick handle' which can be used to resize and reshape the body. After clicking the Re-shape button, position the cursor inside the body to be edited and click the left mouse button. The pick handle should display and this can be selected and repositioned. When the handle is 'dropped' at a new location the body is resized and redrawn. After clicking the Re-shape button, the handle appears with bodies in both the Map and X-section displays. The handle can be used to alter the internal axes lengths of these body types.

Editing of a polygon cross-sectional shape is undertaken in X-section displays. Editing the azimuth and strike length can be undertaken interactively in the Map views.

Selecting a polygon in X-section display mode highlights all vertices of the polygon with small black squares. Select a vertex by clicking the left mouse button on or near the required vertex. Note that the selected vertex is highlighted in white.

To delete a vertex:

Once a vertex is selected, it can be deleted by either pressing the Del key, or using the Delete option in the Edit menu. Once a vertex is deleted, the next vertex defining the polygon is highlighted in white.

To move a vertex:

To move a vertex, first select it by moving the cursor close to it and clicking the left mouse button. With the left mouse button still depressed, drag the vertex to a new location and release the button. The vertex is positioned where dropped.

To add a vertex:

If a new vertex is to be added, simply position the cursor between two vertices but close to the boundary of the body. A new vertex is automatically added which can be edited.

To adjust azimuth and strike length:

The polygon azimuth and strike length can be adjusted in a Map display (such as a stacked profile window) by clicking the Re-shape button and moving the 'grab point'. To do this, locate the cursor over the grab point, depress the left mouse button and drag the point to a new location. The length of the line adjusts the strike length, while the direction alters the azimuth.

For tabular bodies the editing of strike length and azimuth is the same as for polygons and is undertaken in Map displays. In section, the editing of a tabular body is different because its top and bottom faces are, by definition, horizontal. After selecting a tabular body, it has four handles surrounding it. The handles can be used to adjust the dip and the depth extent of the body by clicking and dragging any of the pick handles.

In the case of plunging prism bodies, edit operations are best performed in a map window. The vertices of the selected body are highlighted by small black squares. Move or delete existing vertices and add new vertices in the same way as described above for polygons.

Editing of the top dipping surface, plunge and azimuth of the plunging prism must be performed by using the Body Edit dialog that is displayed by double left clicking on the body. For additional information, see the section on Changing Spatial Properties.
Splitting a Polygroup Body

Choose the **Polygon Split** button. Select the first of two vertices of the polygon that you wish to split and then drag the mouse pointer to the second vertex as shown in the following figure.

Example of splitting a salt dome polygon by selection of two vertices that will form the basis for separation.

In this example the objective is to provide a basis for splitting the salt into a low density shallow salt section and higher density lower section as shown in the following figure.

Assignment of a lower density to the upper part of the salt dome

The individual polygon shapes can be edited separately according to the geological objectives.
Multiple Section Modelling

Once you have mastered the single-section polygroup model, you can use the technique to build a complex 3D model using multiple, parallel cross-sections. The example below illustrate part of a full 3D model under construction where four cross-sections have been used to build four polygroup bodies, where the strike length is equal to the line spacing.

![Example of a complex basement model built on four parallel cross-sections](image)

This method can be used to model steeply dipping basement below a sedimentary sections to accommodate simultaneous modelling of gravity and magnetic data.

The same technique can be used to model mine plan data where the geological sections can be digitized on screen at whatever resolution is appropriate to the study. Initial properties can be assigned from drillhole data and inverted to obtain the best overall match with the field data. Unexplained anomalous data in the magnetics and gravity can on occasions be useful for looking for mineralization extensions to existing mines.
When modifying an individual section, it useful to be able to see the context of the neighbouring cross-sections. Use the **Body Display Mode** button, accessed from the "Bodies" layer in the X-Section Layer Table ("Configure Layers" pop-up menu).

In this example, each cross-section is 5000 metres apart and the **Intersection + all outlines** check box selection has been set with a window width of 7000 metres. This means that sections within plus or minus 7000 metres of the current section will appear as an outline on the section.

The figure below shows a model cross-section in colour, with outlines of the polygroup bodies from the two adjacent sections. In this way you can build continuous models of the subsurface and simulate complex geological property changes.

Discontinuities between each line of section occurs midway between each section and the impact of the discontinuity should be minimal if the vertical displacement is small relative to the section spacing.

![Current cross-section in colour with outlines of the two adjacent cross-sections](image)

**Deleting Polygroup Bodies**

A component body of a polygroup can be deleted in the usual way by pressing the DEL key after selecting the body in a cross-section or map or in the Body Parameters table. When there is only one body remaining in a polygroup it reverts to being an ordinary polygon and the thick blue outer edge will disappear.

It is possible to delete bodies leaving isolated components. Although non-contiguous the polygroup will still act as one so that moving one will move the whole. If this is not intended bodies can be disassociated from the group.

**Disassociating Polygroup Components**

Enter the Body Properties dialog either by double-clicking on the body in cross-section or from the Body Parameters table. Choose the **Spatial** page and click the **Disconnect** button.
The group status will either disappear or be shown as Group 0. That body becomes a normal polygon and will act independently of the polygroup.

**Merging Polygroups**

Polygroups and polygons can be merged into the same polygroup. This can be done either by snapping a vertex from one to the other in reshape mode or by adding a bridging polygon in create mode.

It is required that the resulting polygroup has common geometry so the order in which this operation is done is important. If a vertex from group 1 is moved to join onto group 2 the geometry of group 2 will override.

---

**Note**

Situations may occur where a merge will not be allowed. This will usually be noticed by the thick blue outer polygon not encompassing the intended bodies. The reason may be that the principal cross-sections of the bodies are not in the same plane. This could arise if the bodies were created on different lines or if one was moved in map view.

---

**Polygroup Outline**

The thick line used to display the outer polygon of polygroups can be configured in colour and thickness or turned off if required.

The default setting which applies to all new cross-sections is found in the X-section Defaults dialog from the menu **File>Project Properties X-section** button.

It is also configurable for individual cross-section displays from the X-section Configuration dialog obtained by clicking the right mouse button in the cross-section window and going to the Body Display Mode dialog.

**Moving and Snapping Vertices**

- **Snap Settings**
- **Snap Toggle Buttons**
- **Snapping and Moving Vertices in Map View (Plunging Prisms)**
- **What Can Be Snapped?**
- **How to Snap Vertices and Move Them Together**
- **Vertex Snapping Considerations for Plunging Prisms**

**Snap Settings**

The Setup dialog from the menu **File>Setup** allows the snap tolerance to be set in pixels and the beep to be disabled.
Snap Toggle Buttons

The buttons Snap Vertex and Synchronize Vertex Move have been removed from the toolbar. Snapping of points and synchronized moving of vertices is now the normal mode of operation with the introduction of polygroup bodies. If they are required for any reason they can be put back onto the toolbar by setting a value in the mvision.ini file.

Snapping and Moving Vertices in Map View (Plunging Prisms)

ModelVision does not support grouped plunging prisms in map view. However a simple snapping and synchronous movement of plunging prism vertices is available.

What Can Be Snapped?

The vertices of adjacent polygons can be snapped together and moved in conjunction while reshaping bodies in a cross-section view. Vertices of plunging prisms can similarly be snapped together and moved in conjunction when reshaping bodies in a map window. Other body types cannot be snapped together but they can be moved in conjunction by dragging a multi-body selection. Note that snapped vertices still exist as separate entities in both bodies.

How to Snap Vertices and Move Them Together

To snap two vertices together from separate polygons drag one vertex close to the other. When the vertices are within a set tolerance of the vertex being moved, it snaps to the stationary vertex with a sound to alert that the snap has been made.

Movement of one vertex subsequently drags the other to keep them joined. The controls on vertex snapping and synchronous movement are accessible from the File>Setup entry on the main menu. The controls are to turn on or off sound on snapping and to set the tolerance limit in screen pixels that is the threshold for snapping vertices and producing synchronous movement of two vertices.

Vertices from more than one body can be snapped together and moved synchronously provided all the vertices are within the tolerance radius of the selected vertex. If the synchronous move button is depressed, any vertex on another body that is within the proximity of a moved vertex moves synchronously with it even if they have not been snapped. In this case the two vertices move together and retain their initial separation.

Vertex Snapping Considerations for Plunging Prisms

A few of operational considerations are placed on snapped vertices to make their movement manageable. For example:

- Two vertices from the same body cannot be snapped together.
• Vertices from separate bodies only snap if the bodies have the same strike azimuth and plunge, and if there is no significant displacement between the bodies in the strike direction.

• Synchronous movement of vertices only operates while in reshape mode

• Once a complete body is shifted, any snapped vertices disengage.

• Synchronous movement is automatically disengaged on activating inversion.

Editing Multiple Bodies

Editing of multiple bodies is controlled from the Body Properties Table and allows you to change certain properties of a contiguous sequence of bodies. If the required bodies are not contiguous their order in the table can be changed using the "U" or "D" keys on the keyboard.

Density, susceptibility, remanent properties, display properties and active and locked status can be changed.

Currently body labels and geometric parameters cannot be edited for multiple bodies.

Step 1

Select the body sequence by dragging down the numbered row header column with the left mouse button held down. The selected rows will be highlighted.

Step 2

Right-click in the highlighted area. The action is sensitive to where you click.

• If you click on an active or locked checkbox all the selected boxes in that column will be toggled.

• If you click on a colour box the colour selector will appear.

• If you click elsewhere the body properties dialog will appear for the first body in that range. Only certain parameters will be available and when set for this body they will be applied to the whole selection.
Setting parameters for several bodies

Active and locked status and visibility can also be toggled without preselecting the group. In order to do this click the left mouse button down in the starting checkbox and release it in the final checkbox.

**Note**

Bodies can be moved as a group in either a map or cross-section window by selecting a contiguous group in the body table or by individual selection in the active window, and moving one of the bodies in that window. (Hold the **SHIFT** key down while clicking on bodies to add extra bodies to a selection.)

The Body Parameters dialog has the ability to sort the listing of the bodies or filter the visibility of the bodies based on their physical properties. To sort the bodies either ascending or descending order the Body Sorting dialog can be accessed either directly from the headers of the Body Parameters table or from the pull-down list of the dialog. The bodies can be sorted on any parameter including colour and computed values such as magnetic moment or volume.

An option also exists within the Body Parameters table to set the visibility of the listed bodies based on the range of a particular parameter, such as susceptibility or depth. The ability to delete the visible or invisible bodies within a set range is also available and includes the option to undo that deletion.
For more information, see *Body Parameters Table*.

**Body Parameters Table**

The **Model>Body Operations>Body Table** option is a powerful tool for modifying the display and properties of the bodies. It is a useful tool to have displayed when interactively modelling as changes can be made without body selection and dialog access. It is also useful for identifying and selecting bodies in complex models because there is a direct link between the table and the active window. E.g. if a cross-section is active selecting a body in the table causes the body in the cross-section to be selected and vice versa.

When selected, the following dialog is displayed:

![Body Parameters Table](image)

Entries appearing in the Body Table dialog can be edited by positioning the cursor in the relevant entry and double-clicking. Double-clicking on a row header of the Body Table will display the Body Properties dialog for the chosen body, which will give access to additional body properties not displayed in the table.

Right-clicking on a row heading will display a pop-up menu allowing you to display the Body Properties dialog for the body in the selected row, delete the body in the selected row, convert the body in the selected row to another body type, edit the colour of the body in the selected row and add another body type.

<table>
<thead>
<tr>
<th>Configure</th>
<th>Delete Body</th>
<th>Body Conversion</th>
<th>Colour Select</th>
<th>Add Body</th>
</tr>
</thead>
</table>

Right-click on row heading in Body Parameters Table to display shortcut menu.

The properties available for editing in the table are:

- **Label** – Body label
- **Type** – Body type, allows certain body conversions (see *Body Conversions* and *Body Subdivision*)
• Colour
• Suscept – Magnetic susceptibility
• Density – Specific density
• Depth – depth to reference point of body)

Check boxes indicate properties which are either off or on. These are:

• Active – enables or disables bodies from computation
• Lock – prevents bodies from being modified
• Vis – controls the visibility of bodies in all displays. This is independent of the active status so invisible bodies can still be active for computation. It can also be used to exclude bodies when exporting the model (see Exporting Models).

As properties are altered in the Body Table, body displays and labels etc. alter to reflect the changes in other windows. Conversely, if properties are altered in other windows, the Body Table is updated (see also Editing Multiple Bodies).

Note
The Active and Visibility attributes, when applied to a polyGroup body can be made to act on just the specified component body or to the whole polyGroup. The switches to set which way you would like to work are in the Model Parameters dialog of the Model>Defaults menu.

Body Conversion and Subdivision

Conversion between various body types can be performed via the body parameters table. This table has a column ‘Type’. A right mouse click or double left click in that column opens the ‘Body Conversion’ dialog for the body in the selected row. Any body can be converted to a general polyhedron body type, and conversions to alternative body types are available in a drop-down list for selected body types (the sphere, tabular, plunging prism and frustum). The conversion dialog has a Delete input body check box. If the box is checked the original body will be deleted, if left empty the original body is retained. Also in this dialog is a Subdivide into setting which allows the body conversion or copy to be subdivided vertically into a specified number of horizontal slices. This subdivision option is only available for tabular and plunging prism body types.

• Body Conversions
• Body Subdivision

Body Conversions

<table>
<thead>
<tr>
<th>Old Body</th>
<th>New Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polygon</td>
<td>Polygon</td>
</tr>
<tr>
<td>Tabular</td>
<td>Tabular</td>
</tr>
<tr>
<td>Ellipsoid</td>
<td>Ellipsoid</td>
</tr>
<tr>
<td>Sphere</td>
<td>Sphere</td>
</tr>
<tr>
<td>Plunging Prism</td>
<td>Plunging Prism</td>
</tr>
<tr>
<td>Frustum</td>
<td>Frustum</td>
</tr>
<tr>
<td>Elliptical Pipe</td>
<td>Elliptical Pipe</td>
</tr>
<tr>
<td>Circular Pipe</td>
<td>Circular Pipe</td>
</tr>
<tr>
<td>General Polyhedron</td>
<td>General Polyhedron</td>
</tr>
</tbody>
</table>
Also available in the Body Conversion dialog is a **Subdivide** setting which allows the body conversion or copy to be subdivided in three planes into a specified number of bodies. This subdivision option is only available for tabular and plunging prism body types. The multiple bodies that are produced by the sub-division have their own independent parameters which can be manipulated. The density and/or susceptibility can be specified to vary linearly from one end body to the other by specifying the **Top** and **Bottom** fields. The default is to have all bodies with the same properties as the original.

**Body Subdivision**

![Before and after examples of the subdivision of a tabular body](image)

**Legend**

<table>
<thead>
<tr>
<th>Body Type</th>
<th>1</th>
<th>1</th>
<th>1</th>
<th>1S</th>
<th>1S</th>
<th>1S*</th>
<th>1S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polygon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tabular</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td>1S*</td>
<td>1S</td>
</tr>
<tr>
<td>Ellipsoid</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sphere</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plunging Prism</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Frustum</td>
<td>1Snt</td>
<td>1S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliptical Pipe</td>
<td>1nt</td>
<td>1S</td>
<td>1S</td>
<td>1S*</td>
<td>1S</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circular Pipe</td>
<td>1nt</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td>1S</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>General Polyhedron</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Dipping top surface of a plunging prism should only be retained for the top layer if the body is subdivided.

**Note**

Previously available cylinder body can be replicated by an elliptical pipe.
The sub-division is performed with reference to a body’s sub-division planes. For example a tabular body has three sets of parallel faces and the sub-division planes are parallel to these. The top and bottom faces are referred to as the **Horizontal plane**, the dipping sides are referred to as **Dip plane**, and the vertical end faces are referred to as **Strike plane**.

The original body can be subdivided based on the dip plane, strike plane or horizontal plane of the body.

The Body Conversion dialog with the Subdivide operation enabled.

**Terrain Correction Calculator**

- **Background**
- **Approach**
- **Operation**

**Background**

When conducting gravity surveys, it is necessary to correct for the effect of terrain. The Terrain correction is usually done by calculating the forward model of the terrain using a constant density. This effect is then removed from the gravity response as one of the corrections performed when processing raw gravity into a product used for interpretation.

The usual approach is to convert the terrain into a body by faceting the terrain surface and giving it some thickness down to a flat base level below the lowest elevation value. The extents of this body need to be extended out from the margins of the survey to avoid edge effects.

One approach to faceting this body is to use a constant mesh width over the whole of the terrain. However, the response from distant terrain variations have less effect than close variations. When using constant facet dimensions over the whole terrain, calculation time is wasted calculating a fine response at distance when a coarse mesh could be used at distance with negligible impact.

Using the fine mesh everywhere takes a considerable time to calculate, especially for large surveys.

The terrain response calculator significantly reduces the amount of calculation time needed by using larger mesh sizes at larger distances from the calculation point.
Approach

The algorithm uses three different grids of successively wider mesh.

![Relationship between the three grids (fine - red crosses, medium - green triangles and coarse - blue circles)](image)

It is a requirement that all grids coincide such that finer grid nodes coincide with nodes of the next coarser grid. The fulfilment of this requirement is up to the operator as the program does not check for this coincidence. If the grids do not coincide, a result will still be generated but is likely to have errors at certain locations, which usually manifest as jumps in the terrain response.

For each survey point, the fine grid is used to create facets close to the body for maximum resolution. The fine grid is used to a user-defined distance, called the near field distance. Beyond the near field distance, the medium grid is used to a second user-defined distance, called the far field distance. Beyond the far field distance, the coarse grid is used to create facets. All these facets are combined to create a general polyhedron body which is then fed to the response calculator to generate the response for that survey point.

Multiple components can be calculated at the same time and it is more efficient to calculate multiple components in a single pass rather than making multiple passes for each component.

![Example of facets created using successively coarser grids.](image)

Operation

The Terrain Response operation is initiated under the menu Modules>Terrain Correction.
This will bring up the Terrain Response dialog box as shown below:

![Terrain Response dialog box]

To begin using the Terrain response calculator the user should select three overlapping DTM grids which have cell sizes as multiples of each other, e.g. 50, 200, 400m cell size.

![Specification of three mandatory terrain grids]

Next, the **Near Field** and **Far Field** values should be set such that they are multiples of the next largest cell size e.g. 800 and 1600. If the distances are chosen such that they are not a multiple of the next largest grid cell size, then cells are chosen out to a node of the next largest grid during computation. While this will not change the accuracy of the computation, it is worth choosing a distance that is a multiple so you have control over what is happening.
Specification of the Near and Far fields

To assist with these decisions, the minimum and maximum values are displayed for all grids. Selecting the Coverage button will display the limits for each grid using the current line selection and the near and far field parameters specified. The limits for the near and far fields are the limits for the selected stations plus the near and far field distances respectively. Your grids must cover the respective areas before the computation will proceed.

Note

If you have an irregularly shaped grid and/or selected stations, you may need to the grids larger than needed to avoid problems with the computation.

Selecting the Coverage button will display the grid coverage for each grid.

The Elevation of Bottom Surface should be chosen to be lower than any of the elevations in any grid, but not too low as this will increase edge effects. The Density Relative to Air should be chosen appropriately. It may be best to change the line or point selection to be a limited set for the first run to check the appropriateness of the parameters chosen. By choosing a limited set, you can also run several density trials to determine the most appropriate density to use for the whole survey.
Specifications of the Elevation of bottom surface and Density

An **Elevation Channel** should be specified to set the elevation of the Sensor Stations.

Nomination of an Elevation Channel for the sensor stations

Lines to be used from the database can be selected by clicking on the **Select Lines** button. This affects the **Line Control** selections for ModelVision. The extents for these lines are shown for the X and Y coordinates.

Selection of lines to be used from a loaded database.
The components calculated for each survey station can be selected using the **Components** button. This affects the components used for all ModelVision calculations as et in the Line Control dialog.

Open the **Gravity Components** dialog by pressing the Components button.

The Gravity Components are selected in the usual way from the Gravity Components dialog box as shown below. For a description of the components, see [Profile Modelling Controls](#).

The **Gravity Components** dialog

When the **Compute** button is clicked, checks are run on the dimensions of the grids and the survey to see if the coverage is satisfactory. The number of facets is calculated and the computation is initiated for all survey points. The line and survey points are shown incrementing at the bottom of the dialog box. The number of facets may change depending on how the facets are positioned for the current survey point is calculated.
When the survey point does not fall directly on a fine grid node, there may need to be more facets created in a particular direction and the combined body may not be symmetrical. This is needed to preserve the resolution out to the nominated near or far field distances.

**Strata Modelling**

ModelVision allows models to be generated from grid interpolation. In both gravity and magnetic studies anomalies generated by terrain variations can be significant. To assist in modelling terrain effects the strata model utility allows you to generate polygonal models with tops and bottoms interpolated from grid surfaces. The grids used are usually the ground surface, bathymetry or geological interfaces derived from seismic or drillhole data. If the strata tool is activated from within an active window map the bodies created are general polyhedra.

If the strata tool is activated within an active X-section window the bodies created are polygons with cross-sections defined by the intersection of that profile with the grid surfaces.

The Create Strata dialog can be accessed with either a map window or a cross-section window active. The dialog is activated from the Create Strata button on the button toolbar (refer to Toolbars).

- Positioning of Strata Bodies
- Vertical Extents of Strata Bodies
- Considerations for Defining Strata Models
Positioning of Strata Bodies

If the command to create strata is issued with a map window active, the instruction appears to ‘drag out a rectangle in the map view’. And the pointer changes to a crosshair. The first operation is to drag a rectangle in the map by placing the crosshair cursor at one corner of the intended rectangle, clicking the left mouse button and dragging to the opposite corner. When completed, the Create Strata dialog appears with the parameters for creation of general polyhedron bodies. The Pad out parameter allows you to define a perimeter around the selected grid area to which the bodies will be extended to reduce any end-effects of computations near the grid margins.

If the command to create strata is issued with a cross-section window active a different dialog appears to create polygon bodies from the intersection of the grid surfaces with that profile. This dialog includes parameters to set parameters for those bodies. The strata bodies are generated with the base line of the profile as their centre line. The location, extent and orientation of the bodies can be reset by editing the displayed parameters. The Pad out parameter is the distance beyond either end of the profile that bodies are extended with horizontal top and base. The objective of this extension is to reduce end-effects in the in-line direction. As a general rule, an extension of 3 times the depth extent of the model is usually sufficient to reduce the end-effects to a negligible level. The Compression factor, if set active, removes any model vertices that have vertical displacements less than the set tolerance from the depth predicted by interpolation of adjacent vertices. This utility allows you to reduce the complexity of models so as to reduce computation times.
Vertical Extents of Strata Bodies

Strata bodies are defined between bounding top and bottom surfaces. These surfaces may be defined either from intersections of the profile line with existing grids or by user-supplied depth limits. Before defining the surfaces, you should select the depth (positive downwards) or elevation (positive upwards) convention and the option of Interleaved or Overlapping beds.

The Elevation (+ve up) option should be selected if your primary surface is a terrain surface that has maximum values at its highest elevation points. The Depth (+ve down) option is used for surfaces that have values increasing with depth. If you have grids of mixed convention, use the calculator in grid mode to convert them to a single convention (see Computing New Channels).

Surfaces are defined either by selecting from the list of available grids or by typing a depth/elevation value and clicking the Make horizon button.

The option Interleaved beds produce bodies that extend only between two adjacent surfaces so that the top of one body is the base of another. The alternative, Overlapping beds, uses the topmost surface as the top surface for all bodies. Models produced in this way are more convenient for editing as there is a single interface rather than two to represent each contact between layers. To model with overlapping bodies requires that density and susceptibility contrasts be set so that they sum to that required for the body. While editing bodies created with the Interleaved setting you generally need to use synchronous vertex movement to lock together the coincident top and bottom surfaces (see Moving and Snapping Vertices).

The Depth sorting facility should usually be enabled. This option checks the depth or elevation values of the various interfaces to ensure that they are in their correct sequence. With this facility switched off the surfaces are used according to their position in the Selected Horizons list that depends on the sequence in which they have been selected and created.

Considerations for Defining Strata Models

The polygonal bodies used to create strata models have uniform cross-section across their strike width. These bodies can be created to have parallel axes and horizontal spacings equal to their widths to create a continuous block of bodies. Between adjacent bodies there are step discontinuities. The step discontinuities are not evident if field computations are restricted to profiles along the axes of the strata bodies, but are encountered on any oblique profiles that cross the body edges. Using a larger number of narrow bodies to more closely represent a surface reduces the amplitude of these steps. Using general polyhedron bodies avoids any step discontinuities, but it is not possible to subsequently edit the vertices of a general polyhedron. General polyhedron bodies are most appropriate where the grid surfaces defining the body surfaces will not need editing. If the grid surfaces may need adjustment as part of the modelling process, a series of polygon bodies is more appropriate for building the model.

A stratigraphic body must conform to the requirement of a polygonal body. That is, it has finite thickness at all points. Any attempted crossing of the top and bottom surfaces renders the body computationally illegal and should not be generated. A current limitation is that no two surfaces are allowed to intersect. To generate a terrain model it is therefore necessary to have the bottom surface below the minimum elevation of the terrain so that only a single body is created.
Converting Point Attributes to Models

You can build a collection of 3D tabular bodies from an attributed point dataset that may have been exported from AutoMag, a Euler 3D application or another modelling system. Follow these basic steps:

- Import point data into a single line of data.
- Check the point data attributes in a map display.
- Run the point to model import menu option.
- Display the model in map and 3D.

The figure below shows an example of an ASCII point import dialog that will import an attribute point dataset from a csv format file. Note that the Line type is highlighted by default in this example. Turn the line attribute off so that all points are loaded into a single dataset. This makes it easier to control the annotation of all points in a map view.

Once loaded, check the point data from the **Utility>Statistics>Points** data menu option and then display the data in a map view.
Map view of point data with depth annotation turned on.

Now run the **Model>Import>Bodies from Points** menu options to access the conversion dialog shown below.

Point to tabular body conversion dialog illustrating the mapping between the body attributes and the point data channels.

The attribute mapping for the tabular body is shown in the **Channel** column and if no equivalent channel is available, then you can enter a fixed value in the right hand column. The models should be immediately visible in your map view. A **D/U** toggle is displayed next to the **Depth** as the vertical position of a dataset may be defined as depth below ground (D) or elevation above sea level (U).
Next view the data in 3D perspective from the View>Perspective menu option and check the suitability of your model.

Inappropriate bodies can be deleted from the model in map view. The model is now ready for forward modelling in point, line or grid modes and export to a TKM model file.

Testing Response with Synthetic Data

- Synthetic Lines
- Synthetic Drillholes
• **Synthetic Grid**

**Synthetic Lines**

ModelVision permits you to create an artificial survey with fictitious data readings so theoretical responses can be computed without the need for observed data.

After selecting the **Utility>Synthetic lines** option the dialog presented is shown below: This dialog allows you to specify a full synthetic survey. If you only want a single line, clicking 1 line changes the dialog so that you can enter parameters to define a single profile. The dialog also appears differently if opened when a map view is active. In this case a select in map button is available which allows you to drag-out the extent of the survey or profile in the map window.

*Dialog for creating synthetic data*
The dataset lines are appended to a **Name Prefix**. The Name Prefix can be either character or numeric but cannot be blank. Specify an origin to the survey, azimuth (with angle positive from true north), number of lines, samples per line, line spacing and sample spacing. Once these parameters are entered, select OK and ModelVision creates a new set of survey lines and sample points.

Lines created using this facility can be made active by using the Active toolbar, using the **Line Control** option, or selected from the **X-section View** option.
If an elevation grid is available checking Sample from DTM grid allows you to select the grid from a list of available grids. If a grid is selected the Terrain Clearance check box also becomes active to allow you to nominate a fixed clearance above the elevation grid. This allows you to emulate a drape flown airborne survey.

The synthetic data is created by clicking the Create Survey button. If a map window is open the new survey lines will be displayed. If you detect any mistake in creating the survey the Delete Lines button allows you to delete the newly created lines and to repeat the operation after adjusting the settings. The dialog also contains a Line Maintenance button to provide convenient access for editing the line data.

**Synthetic Drillholes**

ModelVision permits you to create an artificial drillholes with fictitious data readings so theoretical responses can be computed without the need for observed data.

After selecting the Utility>Synthetic Drillholes option the dialog presented is shown below:

![Dialog for creating synthetic drillholes and data](image)

The drillholes are appended to a Name Prefix. The Name Prefix can be either character or numeric but cannot be blank. Drillholes can be specified graphically (by using the cursor) or specifically (from entries in the dialog).

**Graphical Drillhole Design**

To interactively design drillholes, you will need to have an active map window displayed. The map can be empty but if you are attempting to locate the drillhole to intersect a particular body, have the bodies displayed as well.
Once the **Utility>Synthetic Drillholes** option has been selected and the dialog is displayed, move the cursor into the active map window. The cursor changes shape to become a cross (+). Position the cursor at the site of the proposed drillhole collar and drag it with the left mouse button depressed to the map representation of the bottom of the hole. The base of the hole is represented by the vertical point on the map directly above the hole base. If you want to apply a specific dip (inclination) to the hole, enter this into the dialog and select an alternative entry to register the entry. Adjust any other parameters such as sample interval or collar adjustment.

If a specific collar height is to be used to account for topography, you can enter a Z value (positive up), or you can specify a particular data grid (that represents a digital terrain model) and select the **from grid** option and grid name.

When you have specified the drillhole parameters above, click the **Save** button. If you wish to create additional drillholes, deselect the **one hole only** option and design a second and subsequent drillholes.

**Specific Drillhole Design**

To apply specific data locations to synthetic drillholes, enter the collar, azimuth (with angle positive from true north) and dip values directly into the dialog. Note that changes and entries to the drillhole are not displayed until you position the entry to another data field. As changes are made the display in a map updates.

You can apply the same drillhole parameters of topography and multiple holes as described above. When completed, select the Save button to create the drillhole.

---

**Note**

The **Synthetic Drillhole** option creates data points at each of the required drillhole reading points as defined by the drillhole design and reading specifications, sample interval etc. When each sample point is created, a channel with the name specified (MAG in the above example) is created. This channel can be used for modelling or display purposes.

**Synthetic Grid**

Allows you to create a grid with exact limits, cell sizes and number of cells in X and Y directions and to fill it with either nulls or a fixed value.
ModelVision assumes all grid dimensions are in metres but if you click the LL radio button you can specify latitude and longitude limits in degrees. The edit fields will accept +, -, N, S, E, W and decimal degrees or d:m:s format. Once created the grid can be further manipulated using the ModelVision calculator in grid mode.

**Note**

If you use a geodetic grid in a map display, you will be warned that no projection conversion to metres will be done. You must therefore be careful not to mix geodetic and XY data in the same display.

### Displaying Curves and Tracks

In a cross-section display it is possible to add curves in additional tracks above the response and observed data. The additional tracks can contain two types of curves:

- Specifically selected channels held in ModelVision memory
- The theoretical response of a selected body. See the section on Single Body Responses for information on displaying a body response.

For more information, see:

- Adding Curves
- Displaying Responses

### Adding Curves

Position the cursor in an active profile window track and click the right mouse button. A menu with options applicable to the displayed track is presented.

- **Configuration** – Selecting this item displays the main X-section configuration dialog. Refer to Cross-section Controls.

- **Print** – Create a print of the profile and X-section window.

- **Change Line** – From a displayed line list dialog, select an alternative line to display. Note that this feature replaces the existing profile display with data from the selected line and uses the same display settings. This is a useful option for rapidly scanning adjacent lines that are currently being modelled. To assist rapidly scanning through lines, you can also use the UP and DOWN keyboard keys.
• **Add Curve** – This option displays a channel list as shown. You can select the channel required and when OK is chosen the channel is displayed in the initially selected track. When additional traces are added to existing cross-section displays, the vertical scaling of the data must be considered. For correct displays to be achieved with suitable vertical scaling, similar data ranges for channels should only be used together.

• **Export** - This option allows the export of the whole or depth section of the window to a Windows .BMP file which can be imported into Discover PA as a georeferenced image (*Displaying ModelVision Data in Discover PA*).

• **Fit Track** - This allows the independent fitting of the horizontal scale or the vertical scale of each track to the displayed data.

• **Help** – Context sensitive help for this item.

**Displaying Responses**

This option provides the useful facility of displaying the theoretical response derived from individual bodies. Either gravity or magnetic responses can be displayed. The responses from single bodies can be displayed using the following procedure:

1. From a cross-section display with bodies present, (one of which is to have its response displayed), position the cursor and click the right mouse button to display the X-section Configuration dialog.

2. Select the option in the dialog called **Single Body Response**. This sets the response computation of bodies for the cross-section to be available for individual display.

3. Close the X-section Configuration dialog and position the cursor over the body required for its theoretical response to be displayed. Double left click the body to select it and display the Body Configuration dialog.

4. Click the **Display** button of the **Associated Channels** group item. When OK is clicked on the dialog, the cross-section redisplay with an additional track containing the body’s theoretical response.

![Image of three individual body responses plus their summed response](image-url)
A second method of adding individual body responses to an existing cross-section track is provided in *Adding Curves* described above.

While the Single Body Response track is displayed, edits and changes made to the relevant body alter the response displayed when a recomputation is requested (by clicking the **Compute** button or automatically in **Immediate mode**).

To delete the track displaying the Single Body Response, select the DEL button on the **Associated Channels** group of the relevant body. Alternatively, to delete the tracks of each of the displayed individual responses, select the X-section Configuration dialog and deselect the **Single Body Responses** option.

**Enclosed Bodies**

Occasionally modelling situations may exist where bodies overlap in volume or are totally enclosed by a larger body. Where bodies are only partially enclosed by another, no compensation is made within ModelVision. In the latter case, the following steps are necessary:

- The volume of the enclosed body must have its volume response calculated, relative to the background and this response is subtracted from the enclosing body response.
- The inserted body has its volume response added to the enclosing body response. Note all bodies have responses computed with properties relative to the default background.

To perform these steps, the relative physical properties to be assigned to the bodies must be carefully computed. Below is a formula to compute the necessary physical properties for enclosing bodies. Assume body B3 is enclosed by B2 and B1, as shown.

\[ B'_{2} = B_{\text{gnd}} + B_{2} - B_{1} \]

Where,

- \( B'_{2} \) is the property to enter into ModelVision
- \( B_{\text{gnd}} \) is the assigned background value
- \( B_{1} \) and \( B_{2} \) are the absolute property values required.

Note for body B3, the calculation need only be made relative to its enclosing body (B2) therefore the formula used would be:

\[ B'_{3} = B_{\text{gnd}} + B_{3} - B'_{2} \]
The above formula applies equally for both gravity and magnetics but is made simpler for magnetics since the background value is usually zero.

As an example, if a default background density of 2.85 g/cm³ has been defined and a body with absolute density of 3.00 g/cm³ is enclosed by another lower density body of 2.65 g/cm³, what density is to be assigned to the innermost body? Using the above formula, the density to assign the enclosed body is:

Enclosed Density
= B_{bgnd} + B_2 - B_1
= 2.85 + 3.00 - 2.65
= 3.20 g/cm³

Drillhole Modelling

ModelVision allows you to model magnetic and gravity responses at readings within a drillhole. Note that magnetic field calculations are only valid outside the bodies due to the anomalous influence of the drillhole cavity. Gravity calculations are valid inside and outside the drillhole. The drillhole location, shape and readings can be input from an external file or they can be created synthetically to simulate a drillhole.

- Defining a Drillhole
- Importing Drillhole Data
- Using Synthetic Drillholes
- Modelling Downhole Data

Defining a Drillhole

The specification of a drillhole is usually from a hole survey that details the location of a hole collar plus a number of survey points down the trace of the hole. These survey controls usually have dip, azimuth and a distance down the hole.

Importing Drillhole Data

In ModelVision, data from existing drillholes can be imported from an ASCII file with the following format:

<table>
<thead>
<tr>
<th>HOLE</th>
<th>EAST</th>
<th>NRTH</th>
<th>DEPTH</th>
<th>VX</th>
<th>VY</th>
<th>VZ</th>
<th>MAG</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDH1800</td>
<td>-20.000</td>
<td>54200.000</td>
<td>20.00</td>
<td>0.00</td>
<td>-5.98</td>
<td>0.00</td>
<td>56507.109</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-18.000</td>
<td>54201.000</td>
<td>25.00</td>
<td>2.00</td>
<td>-6.69</td>
<td>2.00</td>
<td>56507.082</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-17.000</td>
<td>54202.000</td>
<td>29.00</td>
<td>4.00</td>
<td>-7.53</td>
<td>4.00</td>
<td>56507.066</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-16.000</td>
<td>54202.000</td>
<td>32.00</td>
<td>6.00</td>
<td>-8.52</td>
<td>6.00</td>
<td>56507.053</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-15.000</td>
<td>54203.000</td>
<td>37.00</td>
<td>8.00</td>
<td>-9.69</td>
<td>8.00</td>
<td>56507.055</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-12.000</td>
<td>54203.000</td>
<td>40.00</td>
<td>0.00</td>
<td>11.07</td>
<td>0.00</td>
<td>56507.066</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-9.000</td>
<td>54204.000</td>
<td>43.00</td>
<td>2.00</td>
<td>12.63</td>
<td>2.00</td>
<td>56507.090</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-7.000</td>
<td>54204.000</td>
<td>47.00</td>
<td>4.00</td>
<td>14.33</td>
<td>4.00</td>
<td>56507.129</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-4.000</td>
<td>54205.000</td>
<td>51.00</td>
<td>6.00</td>
<td>16.06</td>
<td>6.00</td>
<td>56507.188</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-2.000</td>
<td>54205.000</td>
<td>54.00</td>
<td>8.00</td>
<td>17.59</td>
<td>8.00</td>
<td>56507.273</td>
</tr>
<tr>
<td>DDH1800</td>
<td>0.000</td>
<td>54206.000</td>
<td>57.00</td>
<td>0.00</td>
<td>18.65</td>
<td>0.00</td>
<td>56507.395</td>
</tr>
</tbody>
</table>
The import process is initiated from the File>Import>Drillholes menu option. Note that the file has a HOLE identification column (entries can be alphanumeric) plus reading locations down the hole in East, North and vertical Depth. Component data values can also be imported.

Using Synthetic Drillholes

For drillhole design and siting of drillholes to intersect a specific target, you can create artificial drillholes using the Utility>Synthetic Drillholes option. Refer to the section on Synthetic Drillholes. Drillholes can be designed specifically or graphically. You can use the new tool to sample the body properties into the synthetic drillhole to produce a predictive log for use when drilling.

Modelling Downhole Data

You create your bodies in either map or cross-section windows, but you can now use the Model track in the hole window to select, move and edit individual bodies within the 3D model. Further information on creating bodies in cross-section or maps views can be found in Creating Bodies.

The Hole Control option is accessed from the Model menu and provides control over drillhole modelling. Once this menu option is selected, a warning message appears alerting to the fact that model computations when a drillhole intersects a body are not valid. ModelVision only supports off-hole body locations because magnetic field calculations are only valid outside the bodies due to the anomalous influence of the drillhole cavity. Therefore, if a body's location intersects the drillhole the forward model calculation is invalid without hole compensation.

When selected, the Hole Control option presents the following dialog:
Gravity and magnetic modelling are activated independently in the Hole Control dialog.

The message below acts as a warning, but body properties can be still reported as part of the Sample from Bodies option onto the drillholes.

**Input and Output Channel Entries**

The input channel name is displayed as the observed data in a hole display. If there is no channel to be input (when modelling synthetic data, this entry should be blank). If there are channels other than easting, northing and the channel DIST_STRING, one must be selected for input. There are several instances in ModelVision where channels named GRAV and MAG are recognized as default input channels and it is recommended you follow this convention (channels can be renamed using the Utility>Data Maintenance>Hole menu option. The output channel is the name given to the computed model output. Again, there are advantages to retaining the default names of GRAV_MOD and MAG_MOD.

**Use Sensor Z Channel**

This control toggles on and off the selection of a channel in the line data to provide a Z (elevation) value at which to make the first drillhole station computation. If this control is toggled off, the computations are made at a zero elevation.
Select Holes

As for grids and lines, drillholes must be made active before they can have model responses computed for their reading locations. This is enabled from the Select Holes button of the Hole Control dialog.

Selecting drillholes for modelling

The Select Holes Active for Modelling setting applies to both gravity and magnetic modelling. Hole model responses are only computed for holes selected to be active.

With the drillholes selected for modelling, if you are to be magnetically modelling, you must also nominate which response components are to be calculated. These are specified initially from the Supplementary Channels button in the Model>Magnetic Field menu option or in the Components button in the Hole Control dialog.

Magnetic Field Parameters dialog to compute supplementary magnetic components
Drillhole magnetic component responses can be in the X (mx), Y (my) or vertical (mz) orientations. The drillhole total field vector can also be derived (mh). The various components can be displayed in the drill log view and vector plots in Perspective displays.

When a Hole display is opened, the hole is made active for modelling according to the current Hole Control settings. You can also select and deselect holes in the Hole Control dialog. If you deselect a hole for computation, the output channel for that hole is not updated as you make any subsequent changes to the model. The output channel can therefore be inconsistent between holes deselected at different stages of model development.

Select the Components button to specify the responses to be computed.

**Specification of magnetic components to be computed**

A similar dialog is available for gravity component computation.

**Specification of gravity components to be computed**

**Drill Log Displays**

A Drill Log window in Hole mode (Hole Display) is required for modelling drillholes to show the data and the intersected bodies (if any) in the same context. This is similar in design and operation to the Multi-Track display for line data but uses a DIST_STRING channel for distance down the hole. This parameter provides the base coordinate system (depth) for the plotting of logs. The hole data must be de-surveyed and the true x, y, z locations for each sensor measurement are supplied as part of the data. In this context, you can compute cumulative distance through integration along the hole and ignore hole curvature.
The following channels for a hole are mandatory:

- East
- North
- Elevation
- Distance from hole collar (can be computed if not available)
- Hole diameter
- At least one sensor value.

Note
Upon importing, ModelVision creates the Depth, Elev and Dist_String channels.

The following channels will require computation:

- Distance (if not available with imported data)
- Azimuth of down dip hole axis
- Dip of hole
- Unit vector may be desirable in discussions with Blair.

Below is an example of data channels required by ModelVision for displaying data down a hole.

To open a Drill Log use the View>Hole menu option. The Hole (Drill Log) Display dialog allows you to select the hole, data channels, number of tracks and the optional spreadsheet display.
Once the desired channel names are highlighted, they can be selected for display by clicking the Select>> button. When this is done, the highlighted names transfer from the Available area to the Selected area. The first nominated channel in the Selected box appears in the track on the right, the second channel in the second from the right, etc. The same channel can be multiply selected for display in different tracks if required.

Drill log showing a log of mag, Bz, By and Bx channels with a Model track indicating a model is intersecting the hole.
If one or more selected channels are not required for display, they can be highlighted in the **Selected** list and deleted using the **Deselect** button. Note that channels can be deleted from the multi-track display after the window has been created. To delete a channel from the Hole display highlight the channel name at the top of the column and press the **Delete** key.

- **Vertical Axis** – By default, the DIST_STRING channel is selected as the vertical axis.
- **Track Control** – You can control the number of allocated tracks in the window by overriding the default **Auto** control. A reference track is added to the right of the display if the **Reference track** check box is left on.
- **Add Table** – Provides a spreadsheet track to the left of the channels in the Hole Display. This table can be scrolled to any part of the line and when a record is selected, a cursor appears in the reference track that indicates the location of the record within the line.

Once the Hole window is displayed a **Model** column appears (based upon the **Hole Control** settings) and this becomes the body for selection and editing in the window.

**Drill Log User Interaction**

The **Model** column of the hole display provides the user with the ability to interact with the bodies in the model space. The region of colour in these columns is a representation of the position down the hole where the body is located. If there is no region of colour present, then this indicates that the body is located off hole somewhere. The map, cross-section and perspective (3D) views can help to locate the body when it is away from the drillhole. The body representation in the Model track can be moved up and down with the mouse to edit the depth position of the body. The **Body Properties** dialog for the body can be viewed by clicking on the left mouse button twice. To delete a body from the Hole display simply select it in the Model track of the **Hole Display** and press the **Delete** key.

**Resample from Hole**

The **Sample from Bodies** option from the pop-up menu (right mouse button click) for a drillhole window permits the data locations of a drillhole to have data interpolated from an active body and assigned to a data channel for that drillhole.

You can specify which body property channels are to be interpolated to the drillhole. The operation works by computing the distances from each hole depth data point to the body surrounding it. Based on the data values of the body for each depth location, a value is computed, distance weighted and assigned to that reading. The values are placed in a named channel. The dialog for this operation is:
Sample drillhole from bodies dialog for selecting computed channels for addition to the data and/or the display.

Once the **Sample** button in the dialog is clicked a message reporting the result of the sampling appears. When the **OK** button is selected from this message the selected channels from the **Channel** column are sampled and if also selected in the **Display** column they are added as a new channel in the hole display. The new channel is displayed in the track that the Sample from **Bodies** menu option was initiated from. If more than one new curve is to be added then it cycles through the existing tracks, placing a new curve in one of the already existing tracks.

Confirmation message that data has been sampled from a present body to the dataset.
Point Modelling

Random sample point data can be imported into ModelVision (see Importing, Exporting, and Linking Data Files). This data type requires no geometric or line-based distribution and may be derived from such surveys as gravity or geochemical sampling where the reading location is dictated by factors other than a local survey grid.

ModelVision can use the point locations to compute the magnetic and gravitational responses. The selection of the points and the modelling undertaken is controlled from the Model>Point Control menu option (refer to Point Controls for details on using this feature). Gravity tensor components or magnetic components can be computed as well as total field responses and these are controlled by the Components option within the Point Control dialog.

Display of modelled responses is usually not applicable to cross-sections since the random distribution of points does not lie on a line suitable for a cross-section display. Consequently, maps are used to present the computed point responses. You can use modulated symbols (refer to Points Set) or the data can be gridded (from the Utility>Grid item) and displayed as a contour or image map. Data points can have labels of the required value displayed to give an actual indication of the modelled data values.
Hints and Modelling Tips

- Manipulating Models to Fit the Data
- Optimizing Computations While Modelling
- Finalizing a Model

Manipulating Models to Fit the Data

Geophysical modelling is an exercise in successive approximation. You may learn during modelling that a starting model cannot be amended to explain the observed data and that you need to start again. It is important to continually bear in mind that the models you manipulate must have some geological representation and therefore must conform to geological guidelines of geometry, scale and physical property. Model development therefore requires continuous interpretation even (or especially) when the model is automatically manipulated by inversion.

Having created a model and selected the stations for response computation, you can calculate and display the model output to determine what changes to the model might result in a closer match between the observed and computed data. The most reliable models match complete anomalies, not only specific profiles. You should not spend too much effort on matching a model to one profile without inspecting how it explains the complete anomaly. It is quite easy to develop a model that perfectly fits one profile but poorly matches adjacent profiles.

When developing a model, and in particular when running an inversion, it is worth displaying any images you want beneath the draw-below limit for that window (refer to Configuring Map Displays). This prevents the images from being continually re-drawn. Stacked profile map displays of input and output channels can be useful in multi-line modelling as they reveal which part of the data is poorly matched without the need to grid the data.
Optimizing Computations While Modelling

There are several controls available to reduce the time of model computations. Appropriate controls can be used at different stages of model development.

While focussing on one part of the model there may be some other bodies that you can set to be inactive. Bodies set inactive remain as part of the model but do not have their responses computed until they are set active again.

You can speed up model development by reducing the number of stations at which computations are made. Stations can be removed from the active computation list by deseleting individual lines, by sub-sampling the selected lines using the Model>Model Compression control or by sub-setting on geographic range using Active Point selection. When you develop a model by matching the data on only one or a few cross-sections you should set other lines inactive for computation as the model response on those lines is not being evaluated. Another means of selecting stations (but which is irreversible within that session file) is to delete and/or clip lines to focus on an individual anomaly or set of anomalies. If you decide that the station spacing is closer than required at any stage of modelling, you can also reduce computation times by interpolating the line data to a wider station spacing.

Finalizing a Model

Final stages of model development may be best undertaken using inversion. If you have already achieved a reasonable match to the data using forward modelling, you should be able to set tight constraints on the free variables and invert with confidence. Once you are satisfied with a model or decide that it is not warranted to spend further time in improving it, the model should be saved. You should check that the model output channels on all lines refer to the current model.

Output of different models can be retained by resetting the model output channel name between changes to the model, renaming the output channel using data utilities, or creating a new channel equal to the current output channel using the Computing New Channels.

The results of line-based modelling can be gridded for matching against grids of the input data. The capabilities and failures of the model in matching the data can be shown in both cross-section and map views. You can create map view image displays of observed and modelled grids with identical display parameters to be shown side by side in a layout window. Alternatively you can show observed and computed fields together in the same view using stacked profiles and/or monochrome contours. You can also use perspective displays to show spatial relationships within the models and between the model and magnetic depth estimates and/or drillholes. Annotated model results in a combination of cross-section and map views can be presented in a layout window.

3D Model Generator

It is often useful to have two dimensional map polygonal interpretations transferred to meaningful three-dimensional displays when the objects can be associated with properties of height or volume. Polygonal objects drawn in a map may have an elevation, but with the addition of size or volume, a 3D display can be much more appealing, allowing visual comparisons between areas. For example, a geological map showing polygons of interpreted geology may be overlain over a topographic surface. However, a 3D representation of geology is more useful if thickness and volume can be displayed. With the ability to associate the volumes with physical properties such as density or magnetic susceptibility the volumes can be geophysically modelled.
The **3D Model Generator** tool in ModelVision allows the creation of a body given a polygon or multiple polygons and two surfaces which can be grids or fixed heights. Polygon input can either come from an external vector file or by drawing a polygon in the map window. The latter creates a file `mv_temp.tab`.

The tool has been designed to run in a "simple" mode where the Top and Bottom surfaces can be set as grids or fixed values and the model is created without any further interaction. However it can also be run as a wizard, where the "simple" data is passed to the wizard but the user has full access to all the features of the **3D Extrusion Wizard** for associating additional data such as input density, susceptibility, azimuth and dip and input colour for multiple polygons. The extrusion process can operate both above (+) or below (-) a surface.

An extruded volume is created as a ModelVision .TKM file that is loaded directly into ModelVision or as an AutoCAD .DXF file that is available externally or can be imported into ModelVision using the **Model>Import** option.

An example of an extruded series of interpreted polygons from a geological map is shown below. In this case an estimate of the depth-to-top, density, susceptibility and thickness of the individual geological regions has been associated with the individual polygonal regions.

**3D Extrusion Wizard**

Select the Wizard button in the 3D Model Generator dialog to initiate the external 3D Extrusion Wizard utility.
Step 1 - Choose Input Data

The polygon loaded within the 3D Model Generator is displayed by the Wizard. Otherwise select the **Browse** button and select an external vector file containing the polygonal outlines that are to be displayed as 3D extruded volumes.

Select the vector file with 2D outlines of items to be extruded

Select a table that has suitable map object outlines such as polygons, closed polylines (eg. Contours) or regular objects such as rectangles, squares or circles.

If the table or selection contains point objects the 3D Extrusion Wizard can create three-dimensional objects such as ‘curtains’ or vertical bars using point data. Click OK.

Step 2 - Set Primary Surface Properties

The Base Z value of the objects to be extruded can be specified in one of three ways:

- **Primary Z**: enter a fixed primary Z value to be applied to the objects to be extruded. Note that the elevation uses a positive up sense of height.

- **Plus Field Value**: use a Primary Z value from a field contained within the imported vector for each map object to be extruded. For example, if geological units were to be used, these could be stored in the selected table with a data column called ‘Vert_base’ or ‘Thickness’. The values are in metres and are added to any entry in the Primary Z field.

- **Plus Grid Value**: use a Primary Z value calculated from a surface grid for each map object to be extruded. For items that you wish to lie on top of a topographic surface, use this surface as the base height. The values are in metres. Check the **Generate flat surface using centre grid line** to use a constant grid value as the Primary Z value. Note that these values are added to any Primary Z and Field Value entries.
3D Extrusion Wizard Step 2 defines the base of the extruded object

You can apply a scaling or add field or grid values to the data values of the base. This is useful when attempting to match the elevations of other objects you may wish to import into your three dimensional views. The Scale factor is multiplicative such that a value of 2 doubles the offset height of the base of the object. To use field or grid Base Z values only leave Primary Z as 0.

The **Generate Primary Surface** option is turned on by default. This option creates a base for the extruded object. If this option is left unchecked the extruded object is left open at the base. Click **Next** to continue.

**Step 3 - Set Extruded Surface Properties**

The Extruded Z value (or upper surface value) of the objects to be extruded can be specified in one of three ways:

- **Extruded Z**: enter a fixed value of height to be applied to the objects to be extruded. Note that the elevation uses a positive up sense of height.

- **Plus Field Value**: use an extruded Z value from a field contained within the vector file for each map object to be extruded. For example, if a geological depth below surface were to be used, these could be stored in the selected table with a data column called ‘Depth_to_Top’ or ‘Depth’. The values are in metres.

- **Plus Grid Value**: use an Extruded Z value calculated from a surface grid for each map object to be extruded. The values are in metres. Check the **Generate flat surface using centre grid line** to use a constant grid value as the Extruded Z value.

You can apply a scaling or add field or grid values to the data values of the Extruded surface. This is useful when attempting to match the elevations of other objects you may wish to import into your three dimensional views. The **Scale factor** multiplies the dimensions; for example, a value of 2 doubles the offset height or depth of the base or top of the object. To use field or grid Extruded Z values only leave **Extruded Z** as 0.
8 Modelling Techniques

Step 3 - Define the extruded surface of the objects

The height of the upper surface can also be chosen **Relative to primary** (ie. An object height from bottom to top) or in **Absolute** terms such that the actual elevation of the top surface is defined.

The **Generate Extruded Surface** option is turned on by default. This option will create a top for the extruded object. If this option is left unchecked the extruded object will be open at the top.

**Step 4 – Set Azimuth and Dip**

The dip of the extruded polygons can be set to tilt the volumes with a dip in the azimuthal directions defined. Both the azimuth and the dip can be constant or specified individually for each polygon. In this case the angles are required to be defined in the vector file or Feature dataset.

**Step 5 – Choose Body Properties**

The physical properties of extruded objects can be controlled by the following wizard screen. The input fields can be assigned from the loaded external vector file or else from the **Boundary & Parameters** section of the 3D Model Generator dialog.
Step 5 – Choose body properties for each polygonal body to be extruded

Step 6 - Set Appearance

The colour and appearance of individual extruded objects can be controlled by the following wizard screen.

Step 6 - Specify the appearance properties of the extruded objects

The extruded objects are drawn as 3D .DXF objects in the 3D Map display.

Three options are provided to allow the colour of the objects to be controlled:

- **From input** - the individual objects obtain their colour from the default list of standard colours.
- **Fixed** - all the created objects are of the same colour. Select the required colour from the pull-down palette.
- **Modulated by Field** - individual objects are coloured using the data value in the specified field and a selected look-up Colour table. A wide range of look-up tables is provided.
Step 7 - Choose Output File

This wizard screen specifies the output file. The output uses the ModelVision .TKM file format. This format will automatically load the extruded model into the open ModelVision session. The AutoCad 3D DXF file format is also available but will not be automatically displayed in ModelVision. To display this file the DXF file must be imported using the Model>Import>DXF Format menu option.

![Image of Extrusion Wizard Step 7: Choose output file]

Step 7 - Specify an output file name and location

If the Finish button is clicked, the extruded objects are created and if in TKM format will be automatically displayed in a map, cross-section or perspective view window. The Extrusion Wizard is then exited.

![Image of 3D model created from external vector file and extruded using the Extrusion Wizard]

An example of a 3D model created from an external vector file and extruded using the Extrusion Wizard to assign input rock unit colours and density and susceptibility.

Synthetic Body Array

The Synthetic Body Array generator creates an array of simple bodies in cross-section or map windows using tabular or sphere shapes. These shapes can be used as input for inversion of properties, depth to top or depth extent.
Examples of a tabular body synthetic array in section and map views.

The Synthetic Body Array is accessed with either a map window or a cross-section window active and activated from either the Utility menu or the Model>Body Operations menu.
A **Name Prefix** is nominated to assist identification of the bodies forming the body array with a default prefix of "B_". Each body that is created using the Synthetic Body Array tool will then start with "B_". See an example of this in the Body Parameters table below.

**Defining Reference Point Extents**

In the **Body array ref. point extents** section of the dialog, the array framework is defined by specifying the data area to be used in either a map or cross-section view.
The Reference Point Extents section of the Body Array Generator dialog for a cross-section (left) and a map (right)

To specify a data range in a map view, the **X range** (easting) and **Y range** (northing) is specified either manually (enter min/max for each) or by drawing a polygonal or rectangular region on the Map window using either the **New Poly** or **New Rect** button. After drawing the array body extents in either map or cross-section view, the **Snap** button will adjust the range for the array body extents to the nearest increment specified in the box next to it.

The X and Y range determines if a body in the array is in or out of the defined region based upon where the body's reference point is located. The reference point is defined as the centre of the body. This means that a body can extend outside the defined region by up to half its width if its reference point lies just on the region boundary. Alternatively, if a body's reference point is located just outside or the defined region then then it won't be created.

Data Extents specified for the synthetic body array in a map (left) and a cross-section (right)

When generating the body array from a map view, the **X spacing** and **Y spacing** determines the number of bodies that will be generated. The **Y azimuth** setting allows the interpreter to generate bodies which are aligned differently to 0 degrees (north-south).

To specify a data range in a cross-section view, the **Horiz range** (horizontal) and **Z range** (depth) must be specified either manually (min/max for each) or by dragging out a region in the Depth area (bottom half) of the cross-section using the **New limits** button. The **Horiz spacing** and **Z spacing** of the body array being generated in a cross-section determines the number of bodies that will be generated.
The number of bodies is automatically calculated after entering the X/Y/Z spacing assuming the data range has already been specified. A readout of the number of bodies is displayed in the dialog to assist the interpreter with the design before proceeding to the creation of the bodies.

**Body Position (Map View Only)**

In the **Body Position** section (visible only when creating in a map view) the interpreter can nominate the depth position for the top of the body array. The **Sample from DTM** grid allows the depth to the top of each body in the array to vary based upon a loaded elevation grid surface. With this option, a **Depth Offset** can be applied to the gridded values. Alternatively a **Fixed Elevation** value can be applied where the depth to the top of each body in the array is the same value.

**Body Parameters**

The **Body Parameters** section in both map view and cross-section view allows the interpreter to set a default property value for susceptibility and density. Each body in the array will be created with this property assigned to it. The **Body Types** available for generation are Tabular and Sphere. The thickness of each tabular body is calculated by the X and Y spacing parameters in the **Body Array Extents** section. If working with a tabular body, the **Strike extent** of each body in the array must be specified. If working with a sphere, the **Radius** of each body in the array must be specified.

The **Create Bodies** button will compute and display the body array based on the parameters specified in the dialog. If the interpreter wishes to change any of the parameters and recreate the body array, delete the bodies by clicking the **Delete bodies** button.

**Depth to Basement Model Example**

The example below demonstrates the calculation of the depth to basement for a basin model using a body array model computed in a map view of gravity data. The default position (X body, Y Body and Z body) of each tabular body was fixed and the default density value of 2.27 (background density 2.77) was kept fixed. The X and Y spacing for the body array was set at the value equivalent to the line spacing of the data.
The Depth Extent parameter for all bodies was freed during inversion to model the data and achieve a rms cut-off of 1.0%.

The resulting basin model in cross-section view (left) and Perspective view (right) from inversion on a body array with the Depth Extent parameter free.

The depth extents from each tabular body in the body array were exported in a CSV point dataset and then gridded to produce a depth to basement gridded surface.

Gridded surface of the Depth Extent parameter for each tabular body (cross symbols) in the Body Array model, representing the depth to basement shown in a map (left) and 3D gridded surface of basement depth shown in perspective view (right).

The data was also modelled using polygonal bodies in multiple cross-sections and the inversion results from both methods produced a close match. The variable depth extent voxel model is much faster for building an initial model that can be used later to provide a framework for polygonal section inversion.

Note

Ensure the voxel spacing is either equivalent to or greater than the line spacing to prevent unstable behaviour of voxel rows positioned between data lines.
Magnetic Source Example

The examples below demonstrate equivalent source computation using a body array model computed on a single line of magnetic data. The body array, consisting of a single layer of voxels (tabular bodies), was generated from an active cross-section view using a default susceptibility setting of 0.01 SI and horizontal spacing of 100 m. To begin modelling the body array, the body properties for each tabular body were edited using the Body Properties dialog. To maintain the body array, the position of each body should be kept the same, however the property (susceptibility and density) can be changed to model the data. When performing inversion on the body array in the Free Parameters dialog from the Inversion toolbar, click on the Toler. (Tolerance) button to better manage the property range. The inversion tolerances are the range by which each parameter can vary about its current value. For this example, the Inversion Tolerances dialog susceptibility property range setting was set to ±0.125 SI.
The Inversion Tolerances dialog for setting a range for the Property (susceptibility) values

Run the inversion with the Property parameter free to observe the model computation of the body array.

**Body Array Colour Modulation**

The bodies in the array are coloured by Lithology by default. The body colours can be modulated by another parameter such as susceptibility using the Body Colours>Modulation option in the Default Body Mode dialog accessed via the Bodies object in the Layer Table.
After running the inversion using these parameters, the single layer voxel model converged in one iteration to better than 1% cut-off. Note that if the cut-off is set to a lower value, the properties may oscillate on the surface layer of voxels because the bodies are narrower than the height above the magnetic geology. This is common when there is no smoothing constraint. If the spacing (thickness) of the voxels is set to about 150 m, the problem decreases.

A single layer body array (voxel model) can produce a model which completely explains the line of data.

In the next example, a 2-layer voxel model was generated in a cross-section view with a default susceptibility value of 0.01 SI and horizontal spacing of 100 m. This was inverted with only the property (susceptibility) value free with a 1% RMS cut-off. Like the first example, the tolerance range setting for the property was set to ±0.125 SI. The resulting single line voxel model provides more geological information on the magnetic data, suggesting dipping magnetic sources.

A 2-layer body array (voxel model) of tabular bodies can improve the detail of the magnetic source of the data.

The third example was a 4-layer voxel model using the same default parameters as the previous two examples. The result provides more useful structural information on the magnetic source. The colour scale for susceptibility of the bodies was set to range from 0.0 to 0.03 to highlight the anomalous areas.
A 4-Layer body array (voxel model) can produce a modelling result which completely explains the line of data.

The above set of examples provides a useful demonstration of equivalence where only one layer of voxels is required to completely explain the line of data.

The example below shows a scenario using a voxel model and independently modelled tabular bodies. After modelling, the tabular bodies in the body array model were made inactive using the Body Parameters spreadsheet and double clicking on the "Active" column title. Then an additional five tabular bodies were added to the cross-section and inverted with the regional to get a match less than 1.0% RMS. The five dipping tabular bodies explain the anomalies and illustrate some important points regarding constrained inversion:

- The tabular bodies are more sensitive to the depth to the top of each feature.
- The dip information is much more reliable than you can infer from the voxel inversion.
- The lateral detail associated with the body width is also more sensitive than the voxel model.

A comparison of modelling results between a 4-layer body array (voxel model) example in cross-section with five tabular bodies. The 4-layer body array is colour modulated by susceptibility.
The three examples above demonstrate the significance of equivalence in magnetic interpretation and only by applying realistic geological models can you get definitive information about the attitude and distribution of magnetic material below the surface.

**Introductory Modelling Tutorial**

This tutorial is to illustrate the various presentation formats available in ModelVision and to introduce the concepts of multi-line displays and modelling. Geologically, the area to be studied is complex with a number of steeply dipping interbedded volcanics trending NNE to SSW. In some instances, the units are faulted, typically with NE-SW trending structures. Granitic intrusives are evident within the data and these are typified by low magnetic responses. Surrounding these intrusives are magnetic aureoles and demagnetizing affects associated with intersected volcanics.

The aim of this tutorial is to identify and investigate a specific anomaly that has been isolated by regional geochemical surveys and which lies adjacent to a granitic margin. Nearby are known sites of tin deposits and base metal occurrences.

Note

In Demo mode you cannot import your own data. You can, however, load one of the supplied binary session files which contains data. For access to the tutorial you are required to load a session file (see Background).

- Setting Up the Tutorial
- Background
- Step-by-Step

**Setting Up the Tutorial**

Initially, ModelVision requires a project to define location, magnetic properties and a description of the work. ModelVision stores project information in a file (MVPROJ.INI) which resides in the project directory. Before any data can be imported or a session with ModelVision is commenced, a project must be created.

Select the File>New Project option and enter the information as required. Initially, select the Browse button and navigate to the \Program Files\ENCOM\MVIS_PRO\EXAMPLES folder. The dialog below illustrates the browse facility. It is important at the commencement of a project that you know the location of the data to be used in the session. You can enter the project datum and projection information plus you can supply the location to derive the local Earth’s magnetic field using the IGRF tool (refer to Magnetic Field Controls and IGRF Calculator).
Background

The data file for this tutorial was acquired from a small airborne survey flown in 1989 in south western New South Wales (near West Wyalong). This survey data has been acquired with traverses that are oriented northeast to southwest with line spacing of 1200 metres (only every fourth line has been retained for this tutorial). Within the data file are Australian Metric Grid (AMG) coordinates (using AMG Zone 54), Fiducials, Magnetics, Altimeter and the spectrometer channel for Potassium (K40). The survey was over relatively flat grazing and intensely cultivated agricultural areas. Known granites, volcanics and metamorphosed units predominate in the area with some minor basic intrusives and dyking. Extensive structural deformation and faulting exist in the survey coverage.

Note

In Demo mode you cannot import your own data. For this tutorial, you are required to directly access the binary session file `TUTORIAL.SES` in the `EXAMPLES` directory. This file contains the necessary information of the project. Once loaded, you can check this by selecting the `File>Project Properties` item. After the data is loaded, skip forward to Step 2. For this tutorial you are required to load a session file.

Step-by-Step

The following tasks should be undertaken for this tutorial:

Step 1

Load the data with the `File>Import>Profiles>Sep. Header (HDR & LIN)` option. The import file is the `TUTE.LIN` dataset but the Separate Header option uses the `TUTE.HDR` file. This import file format illustrates how large multi-column data files can be loaded without extensive editing of the data file. The header and data file appear as below:

**Header File**

```
LINE X Y FID MAG K40 ALT
```
After loading the data file, examine the data ranges and statistics of the channels. You can analyse the statistics of any individual line by double clicking on the nominated line.

**Step 2**

Produce a stacked profile map of the data to indicate the general trends and main features of the data. Use the **View>Map>Stacked Profiles** option and select the MAG data channel. Once a map is presented you can adjust the vertical scaling to highlight features in low gradient areas. This is done by locating the cursor in the map window and clicking the right mouse button. Select the **Configuration** option and edit the dialog entry accordingly.

From regional geochemical sampling, the location of an area with anomalously high tin and base metal associations is known (see above). The anomaly correlates with a magnetic trend produced by mildly magnetized volcanics and was covered by the airborne survey along line 1500.

**Step 3**

To prepare line 1500 and the anomaly for modelling, it is necessary to define a regional trend. Select the **Model>Edit Regional>Magnetics** option.
The regional is used to ensure the background level for modelling is precisely matched. For this situation, only a single line is to be modelled. In other circumstances, a two-dimensional regional surface can be created and used for multi-line modelling (see *Regional Field Controls*).

**Regional specification for the selected line (1500)**

Using the *Active Lines* button, nominate line 1500. Once selected, click OK and click the *Compute from Data* button using a polynomial order of 2.

**Step 4**

With the regional created, you can now display line 1500 with a track beneath to be used as a cross-section below the flight line (use the *View>X-Section* option). The displayed dialog allows you to select line 1500 from a pull-down list. Note also that the dialog enables magnetic modelling on the line and uses the regional in the computation of magnetic body responses.
Nominate the line (1500) and specify magnetic modelling using a regional

Once specified, click the OK button. Line 1500 is displayed in a profile window with a cross-sectional area beneath. This area is used to create and edit the magnetic model. The model response is superimposed on the regional trace (indicated by three regional 'handles').

Profile display with cross-sectional area beneath

The location of the magnetic anomaly is at the left margin of the profile. In preparation for modelling, you need to zoom into the anomaly. You also need to instruct ModelVision that only this anomaly is to be modelled and not the whole profile.

Step 5

Zoom into the anomaly by right-clicking and Configuring the display. Specify the Min and Max range of the Distance Along Profile.
Configuration dialog and profile of specified anomaly

**Note**

Make the required portion of the profile active for modelling by using the Active Points button (or menu item). Select the **Draw Profile Region** button and position the cursor in the profile window at the start of the area to be modelled.

Click the left mouse button and drag an area along the profile for modelling. Ensure the complete anomaly is defined with any side lobes that may affect the source modelling.

After the bounding lines of the active region have been defined, release the mouse button and you notice the model response curve changes colour.

**Step 6**

To create a model and compute a magnetic response, select the body **Create** button (or menu option). As the geological source is not defined, the simplest body type should be used initially. From the Create Body dialog, select the tabular body.
Create a body from the Create Body dialog

Notice that within the dialog the body default properties are displayed. These can be edited if desired. Once the tabular body has been selected, position the cursor in the profile cross-section, click the left mouse button and drag a rectangle that will form the body outline. When the button is released, the body is created.

Note

You can display the magnetic response due to the created tabular body by clicking on the Compute button (or Compute menu item). Only the responses along the nominated active points of line 1500 are computed as no other readings in the dataset have been selected as active.

Step 7

Initially, the body location and orientation are unlikely to be correct for a match between the computed magnetic response and the observed data. It must therefore be edited to a correct position and shape. After each edit you can force ModelVision to update the computed response by toggling the Manual/Immediate mode of computation.

The tabular body can be positioned by selecting with the cursor and locating as appropriate. Its width can also be modified interactively by selecting a corner handle and dragging. You need to have ModelVision in the Pointer mode for these operations (select the Point button). By using the Reshape button you can edit the dip of the body.
Modify the location and orientation until there is a close match to the anomaly shape. Note that there is a level shift between the observed and theoretical traces. One of the fastest methods of removing the level difference and improving the model fit is to use inversion.

**Step 8**

The use of inversion in ModelVision is a powerful tool for rapidly refining models.

To initiate inversion, select the **Tools** > **Inversion** option (or click the right mouse button when the cursor is in the ModelVision screen window).

The Inversion toolbar is displayed and can be positioned on the screen.

Within the inversion option, ModelVision assumes that all parameters controlling bodies are initially fixed (that is, they are invariant). You have control over the parameters that are allowed to vary. Initially the regional level requires adjustment, so select the **Free** button to present the dialog to control parameter freedom (Free Parameters dialog). At the base of this dialog is a check box that controls the **Regional Level** and **Shape**. Enable these options and from the Inversion toolbar click the **Run** button. An inversion is executed and you can see the profile move and become closer to the observed data after each iteration.

Once the regional level is adjusted, disable the Regional options. You can commence freeing other body parameters. It is generally recommended that you locate the body first (use the Distance and depth-Z body properties), and allow parameters that control the shape and susceptibility to vary.

Note that the **Select Bodies** item at the top of the Free Parameters dialog is set to **All**. In this case, only one body exists but in more complex cases where additional bodies may be present, you can individually select the body and its free parameters.

**Step 9**

You may need to perform a few runs of the inversion to optimally fit the theoretical and observed response curves. If the appropriate parameters are freed sequentially, a good fit between the curves can be achieved quickly. This approach can save considerable time in evaluating even complex anomalies.

The final match between the modelled and observed magnetic responses is shown below.
Final inverted model and response fit over the active points of the profile
9 Working with Models

This section covers the operation of the controls and defaults of geophysical modelling in ModelVision.

A useful description of how to approach gravity and magnetic modelling is presented in Modelling Techniques. The ModelVision controls and settings for modelling are described in this section, together with a discussion of the importance and display of regional field variation. Issues associated with magnetic modelling such as the influence of the Earth’s magnetic field, remanence and demagnetisation are also described.

In this section:

• About Models
• Model Types
• Importing Models
• Exporting Models
• Modelling Tools
• Potential Field Modelling Controls
• Profile Modelling Controls
• Regional Field Controls
• Magnetic Field Controls
• Full Tensor Magnetic Gradiometer Computation
• Full Tensor Gravity Gradiometer Computation
• Default Model Parameters

About Models

Gravity and magnetic modelling is the core activity and purpose of ModelVision. Primary controls over the modelling are available from the Model menu option. The Model option functions include:

• Import and export of models
• Selection of lines or grid cells for computing model results
• Selection of drillholes or points to compute modelled responses
• Setting of the mode of computation including forward and inversion operation
• Specification of background properties. The physical contrast between background and individual bodies is fundamental to correct model response calculation.
ModelVision recognizes GRAV and MAG (in upper or lower case) as default names for the model input channels and GRAV_MOD and MAG_MOD as output channels. Generally, it is convenient to use these names. For certain operations, such as residual-regional calculations, these names must be used.

Most model controls are available from the Model Menu. The controls available from this menu are described in more detail in the following topics in this section:

- Model Types
- Importing Models
- Exporting Models
- Potential Field Modelling Controls
- Potential Field Modelling Controls
- Regional Field Controls
- Using a Regional Field
- Magnetic Field Controls
- Full Tensor Magnetic Gradiometer Computation
- Full Tensor Gravity Gradiometer Computation
- Default Model Parameters

Controls that you need to access often should be added to the speed toolbar (refer to Speed Tool). This particularly applies to the dialogs for manipulating the regional field.

**Model Types**

Each body type has special characteristics that are suited to modelling of magnetic and gravity anomalies. Simple shapes such as the tabular body are easy to manipulate and fast to compute. This is often used when little time is available for detailed analysis. The polygon and plunging prism allow you to build much more complex models but more time is usually required to achieve a match between field data and the model response. Body types are defined in Appendix B: Body Descriptions and the methods used to create them in Creating Bodies.
Importing Models

Models are typically saved in TKM format and can be loaded as a new model or appended to an existing model in the current session. This supports all the available body types.

Many other formats which support faceted or 3D vector models can be imported and loaded as general polyhedron type bodies. These must conform to particular rules to be valid for modelling and are checked for compliance upon import.

See Importing, Exporting, and Linking Data Files.
Checking the Integrity of Imported DXF Models

ModelVision has a special utility, the Topology Checker, to check the integrity of models imported from 3D DXF files. Previously it was essential for the software that created the file to use a consistent method of ordering the vertices of every face and that all surfaces were closed. This is a requirement of the modelling software and any gaps or incorrectly defined faces in a model will lead to errors in the model computations. The topology checker collates all faces and organizes them into closed surfaces reporting any that break the rules. It can then correct errors and export the intact surfaces as a new DXF file or as individual polyhedron bodies in a TKM file that will be automatically loaded into ModelVision. It has its own 3D visualizer with many features to identify and examine anything from the entire model right down to individual facets and their coordinates.

The controls available from the Topology Checker dialog are:

- **Input File**
- **List View**
- **Surface**
- **Global**
- **Rendering**

**Input File**

Selects the model file to load into the Topology Checker.
List View

The list view displays all surfaces for the input model. Right-click on the list view to display a shortcut menu with various options on how to sort and select cells with the list view columns.

- **Layer** - Name of the layer in the input file of one is provided.
- **Surface** - The surface number.
- **Show** - Select/Unselect the tick box to show/hide the surface.
- **# Facets** - The number of facets in the mesh for the surface.
- **Area** - The Area of the surface.
- **Volume** - The volume of the surface.
- **Closed** - Green tick indicates that the surface closed. Blue tick indicates the surface is closed but has a negative volume. Red cross indicates that the surface is not closed. A surface is closed if all edges of the triangles in the surfaces mesh are shared by another triangle in the mesh.
- **# Unclosed Edges** - the number of edges that are not shared in the surface.
- **Export** - Indicates whether the mesh for this surface should be added into the output file when saving.

Surface

The **Properties** button will open the Surface Properties dialog for the currently selected surface in the list view. This dialog displays a spreadsheet containing the X,Y, and Z coordinate for each vertex in each triangle for the surface. Triangles that are not closed, that is, have an edge that does not join another triangle are displayed in a different colour.

Global

**Define each layer in a separate mesh**

This control will determine whether a defined layer in the input file should be defined in its own mesh or whether all layers should be defined in a single mesh. This is done on loading the input file.

**Coincident Point Tolerance**

Tolerance value that is used to improve the mesh by detecting coincident points and reassigning the triangles to use the first instance of any repeated point. Set this to -1 for the Topology Checker to automatically calculate this value.

Advanced button

The Advanced button will open the Advanced Options dialog. This dialog allows the user to specify the **Body Density** and **Body Susceptibility** values for the model. These are used when saving the model to a .TKM file.
Rendering

Cull reverse facing
Turn on/off display of any back facing triangles.

Wireframe
Turn on/off display of the wireframe mesh for the model. The colour of the wireframe mesh can be chosen by using the appropriate Set... button.

Show unclosed
If this option is turned on then the colour of any triangle faces that are not closed will be overridden with the set colour. The override colour can be set using the appropriate Set... button.

Show selection bounding box
Turn on/off the bounding box for the model. The bounding box is defined for the currently selected surface in the list view.

Show selection normals
Turn on/off the display of normals for the model. The normals are defined for the currently selected surface in the list view only. The size of the normals can be modified using the Size slider control.

Transparency
Turn on/off transparency for the model. The percentage of transparency can be modified using the slider control.

3D View Controls
These controls are located at the bottom of the Topology Checker dialog.

Fit view to window
Fits the view so that the entire model can be seen.

Fit view to bounding box of selected surface
Fits the view so that the selected surface is the focus of the view.

Advanced settings for the axes scale
Allows the user to apply individual scales to the X, Y and Z axes, as well as defining the position where the user wants the view to look at.

Zoom speed
Changes the speed at which the user can zoom in/out to/from the model.

Background colour
Sets the colour of the background window for the 3D view.
Exporting Models

Model>Export allows you to save your models in a variety of formats. Files can be saved in a ModelVision file format with a default .TKM name extension. Alternatively, an external link to a user-supplied utility can be used to translate a model to or from ModelVision file format. Contact Tensor Research Pty Ltd for advice on preparing external link programs. Models saved from previous versions of ModelVision can be loaded and there is an option to export files in the previous format for import by ModelVision SE (16-bit version).

Export of models in DXF format can be used directly in other display software such as Discover PA (refer to Displaying ModelVision Data in Discover PA).

Model export normally applies to all existing bodies, but bodies which you wish to exclude from the export file can be made invisible using the Body Table and when the model export is chosen you will be asked if you wish to exclude those bodies. This applies to all export formats.

CSV Format

The Model>Export>CSV Format option will write information to a .CSV file on active bodies and in the case of prism bodies their vertices. Information exported includes:

- Body name
- Body type
- XYZ coordinates
• Susceptibility
• Density
• Magnetic remanence and departure angles (optional)
• Geometry (optional)

An option exists during the export to create and display small spheres at every location of the bodies exported to view what it is exporting. The exported .CSV file will open directly in Excel for review. It can also be exported without descriptive fields in a compatible format for re-importing into ModelVision as point sets using the General ASCII point file option.

The remanence parameters include Q, the remanence vector, resultant vector and apparent resultant rotation angle (ARRA). The ARRA angle is a first order indicator of remanent magnetisation (Pratt et al. 2012). You can import the csv to a point dataset and then plot the ARRA values in a map to study their amplitude and spatial relationships.

**Modelling Tools**

• Using the Active Line Tool
• Using the Traverse Tool
• Using the Next Line Tool
• Using the Active Points Tool
Using the Active Line Tool

The Active Line toolbar is used to graphically select lines for modelling, AutoMag, X-section display, and inversion. The term active line is used to provide status information to ModelVision for modelling, regional/residual and AutoMag calculations. This tool allows you to retain all your data but perform computations on a subset. Without this option you would need to continually subset the data to a manageable size to avoid large computational overheads.

To use this tool, ensure that your map window is active and has the flight lines displayed. With a map view displayed (either map, stacked profiles, contour or image) ensure the baselines are turned on (see Configuring Map Displays).

Select a tool option on the Active Line toolbar and then drag the cursor (hold down the left mouse button) across the lines that you want to activate. The selected flight lines change colour. If you perform the operation again, the lines are deactivated. The operation behaves as a status toggle. Use the Deselect All button to deactivate all currently active lines.

The X-Section option behaves differently. When lines are selected, a cross-section window view is opened for each selected line. This also activates the lines for modelling.

In addition to using the Active Line toolbar, the activity of lines can be specifically set by selecting them in one of a number of lists. Such lists are available in the Line Control menu item (see Profile Modelling Controls) and in the Magnetic or Gravity Regional computation dialogs (see Regional Field Controls). Selection of lines from either lists or graphically report the state of line activity. If one selection method is used, it reports the nominated active lines in the alternative method.

Using the Traverse Tool

New lines of data can be generated from grids with this tool, which is particularly useful for modelling when no flight line data is available. A traverse is created by specifying a start and end point that crosses an available grid. The grid may be imported or generated. When positioned, the new data line is stored within ModelVision with data values derived from the nominated grid or grids. The values at each traverse point are interpolated from the appropriate cell node points of the grid.

To use this tool, display a plan window of data (i.e. contours, stacked profiles or grid profiles), and then select the Traverse button from the toolbar. Now move the mouse pointer to the place where you wish to start the line, depress the left mouse button and hold it down while dragging the mouse pointer to the end of the line. Release the left mouse button and a dialog box appears that allows you to enter the new line name, sample interval and grids that you want to sample. You can also modify the start and end points of the profile.

After this has been completed, a window describing the start and end points, number of points, length, sample interval and azimuth are displayed.
Any of these parameters can be altered if desired. Various grids can also be used to create new channels for the traverse. By default, ModelVision selects and highlights the first available grid but it is possible to select one or more grid(s) to generate new channels.

**Note**

The Line Name for the newly created traverse is taken from the northing at the start of the traverse. If desired this name can be overwritten.

Also note that a traverse may be specified to extend past the limits of a grid. In this case the data points on the grid cannot be assigned data values from interpolation of the grid and so null values are used. This situation can also exist if the traverse passes over a 'gap' or break in the grid. If nulls are inserted in the traverse values they are present in modelling and displays which may not be desirable. If nulls are not required, select the Strip NULLs check box.

### Using the Next Line Tool

The Next Line button creates X-section displays for lines adjacent to the active displayed X-section. The orientation and line availability is taken into account when selecting the next adjacent line. For example, a line at the edge of a survey has only one 'next line'. For a line within other lines, the nearest parallel line is selected (unless it is already displayed). Note that the Next Line option only operates when a X-section window is active.

### Using the Active Points Tool

This tool makes it possible to use a subset of points in a X-section or Map view that becomes active for modelling and inversion. You can isolate single anomalies or groups of anomalies from a large data set. Multiple areas can be selected with this tool in both the X-section and Map views. Selection polygons can be saved in a file and retrieved for use in a later operation.

This feature is available for use with either:

- **Active Points in a Map**
- **Active Points in a Section**
The number of active points affects the time required for each model computation.

**Active Points in a Map**

When **Active Points** is selected with a map display window active, the following dialog is presented.
Options available include:

- **Operate only on open cross-sections.**
  
  When working in Map mode, the number of open sections can differ from the number of active lines. This is especially true when using the Target Wizard to open every second, third or fourth line in a large survey. This option is on by default when opened so that the inversion is limited to the visible cross-sections. You can turn this option off if you want to use all active points for inversion.

  This option is very useful when working with complex multi-body models and you only want to focus on a subset of the area while refining the models.

- **Select All** the points displayed in the map to be active for modelling

- **Deselect All** currently active points

- Select a number of points as defined by a graphically drawn region (polygon). The active points can be selected or deselected both inside or outside the polygon. If multiple regions are required, select the **Multiple Operations** before drawing polygons.

- Active points can be saved by storing the polygon(s) in a .PLG file. The file can be restored using the **Load** option.

- When creating polygons, select the **Draw Map Polygon** button and move the cursor to the map. The cursor is a ‘+’ symbol. Position the cursor at the first vertex of the polygon and click the left mouse button. Drag the cursor to the next vertex, click the mouse button again and repeat until the polygon shape is drawn. To close a polygon, double click the left mouse button, or bring it close to the first vertex and click.

**Active Points in a Section**

If a X-section window is active and the **Active Points** is selected, the following dialog is presented:
Options available are:

- **Select All** the points displayed in the X-section to be active for modelling
- **Deselect All** currently active points in the X-section
- Select a number of points in a portion of the X-section. The active points can be selected or deselected both inside or outside the region. If multiple regions are required, select the **Multiple Operations** before drawing.
- Active points can be saved by storing the polygon(s) in a .PLG file. The file can be restored using the **Load** option.
- When creating X-section regions, select the **Draw Map Polygon** button and move the cursor to the profile window. The cursor is a ‘+’ symbol. Position the cursor at one end of the region, depress the left mouse button and drag out a region. Release the button to define the active points of the profile. If Immediate mode is enabled, ModelVision immediately computes and displays the response of any active bodies.

**Saving Active Points Regions**

The **Save** button creates an ASCII file (with file extension .PLG) to store the active points/polygon regions.

The format of a line region is similar to:

```
Polygon File.ModelVision.Vers:3.00
Date: Fri May 07 16:21:40 1999
Company Name: Tensor Research Pty Ltd
LINE: [6204], [10068], [inside], [select], [1250]
```

For a map polygon(s), the active points file appears with the format:
Potential Field Modelling Controls

A number of Model menu items provide useful facilities for potential field modelling in ModelVision.

- **Data Compression**
- **Differential Mode**
- **Inversion**
- **Line Control**
- **Grid Control**
- **Edit Regional**
- **Magnetic Field**
- **Gravity and Magnetic Components**
- **Defaults**

**Data Compression**

Model>Data Compression causes a reduction in the number of stations at which the model output is computed. The compression factor is the frequency of computations. For example, a factor of 3 causes computation at every 3rd station. The model output at intermediate stations is obtained by a rapid interpolation procedure.
Differential Mode

Choose Model>Diff Mode to set Differential computation mode. ModelVision computes and stores the response of each active body. When you make a change to the model, the field of the altered body is recalculated and added to the fields of the other bodies to provide the model output. Differential calculation is only activated in Immediate mode. If you have selected differential calculation and are in Immediate mode, the status bar indicates ‘Immed/Diff’ as shown. The advantage of working with differential calculation increases with the number and complexity of the bodies and with the number of stations at which the model is computed. This mode provides increased performance, but a higher requirement on available memory and system resources. If you make several changes to the model before recomputing, it may be more efficient to work in manual mode.

**Note**

When Immediate/Diff mode is enabled, the push button displays Immediate mode but the Status Bar reports Immediate/Diff.

Inversion

Inversion is accessed through its own toolbar or from the Model menu. For more information, see Inversion.

Joint Inversion

Most parameters used in Joint Inversion are accessed through the Inversion toolbar. Selecting this option allows the mandatory specification of channels to invert on. For more information, see Joint Inversion.

Quick Inversion

Quick Inversion can be accessed from the Quick Invert toolbar button or from the Model menu. For more information, see Quick Inversion.

Line Control

Most modelling in ModelVision is done on profiles. The Line Control option (see Profile Modelling Controls), accessed from the Model menu, provides control over profile modelling.

Grid Control

Although most modelling is performed on profiles, model output can also be computed at grid nodes. The Grid Control option (see Grid Controls) controls this form of modelling. In grid model computations, any compression applies similarly to both grid rows and columns. For instance, a compression factor of 3 selects only those nodes in every 3rd row and 3rd column – that is, a sub-sample of 1 in 9 nodes.
Edit Regional

ModelVision provides a utility to create a broad, smoothly varying regional field by a polynomial surface. This approach can be used as an alternative to modelling a regional field. The controls for manipulating this surface are available in the Line Control dialog and the Model> Edit Regional>Magnetics and Model> Edit Regional>Gravity options. Regional field use in model computations is explained later in this chapter (see Regional Field Controls).

Magnetic Field

The strength and direction of the Earth’s magnetic field at the survey site must be specified in order to model magnetic data. Normally these are specified as project parameters when first starting a new project, but the Magnetic Field Parameters and IGRF options (see Magnetic Field Controls) are both also accessible through the Model menu and the Line Control dialog. Compute Remanence and Compute Demagnetisation must be enabled in the Magnetic Field Parameters dialog in order for these computations to be enabled. For additional information, refer to Remanence and Demagnetisation.

Gravity and Magnetic Components

Analytic computation of the full gravity and magnetic gradient tensors are available within ModelVision. The controls to enable computation of gravity and magnetic components, gradient tensor components and various secondary functions are available in the Model> Gravity Component and Model> Magnetic Component options. For more information, see Full Tensor Magnetic Gradiometer Computation and Full Tensor Gravity Gradiometer Computation.

Defaults

The Model Parameters option allows you to specify background density and susceptibility values. In this option, you can also define the default physical property values to be assigned to new bodies and set switches which control how the component bodies of a polygroup act. (see Changing Physical Parameters).

The X-Section defaults option allows you to set default display properties for model input and output channel traces in cross-section windows (see Cross-section View).

Profile Modelling Controls

- Line Controls
- Grid Controls
- Drillhole Controls
- Point Controls
Line Controls

Most modelling is conducted on profiles. Profiling of data is the main acquisition mode for input of geophysical data and provides a convenient means of developing models in vertical sections beneath the data. The Model>Line Control option provides access to the controls for most of the profile modelling modes. When selected, the Line Control option presents the following dialog:

![Line Control dialog](image)

Line Control dialog to provide control parameters of magnetic and gravity profile modelling

Gravity and magnetic modelling are activated independently. (There is a single selection of active lines which applies to both gravity and magnetic modelling.) Profile model responses are only computed for lines selected to be active. The activation of lines is undertaken from the Select Lines button. Modelling controls not available in the Line Control dialog such as manual/immediate mode, model compression and selection of differential mode apply simultaneously to gravity and/or magnetic modelling.
Two Components buttons are provided to enable component response activation for both magnetics and gravity.

![Magnetic Component](image1)

**Magnetic component selection for computation**

![Gravity Component](image2)

**Gravity component selection for computation**

The various components can be displayed in profiles, as stacked profiles in map displays or as vector plots in perspective displays. For additional information on the gravity tensor and components, refer to [Full Tensor Gravity Gradiometer Computation](#).

Some components are derived relative to a nominal line direction. If you have selected one of these components, the Nominal Line Direction text box will be displayed. Enter the nominal line direction.

**Note**

Instruments are usually placed on stabilized platforms so the nominal line direction is used instead of the true line direction which can vary.

**Model Magnetics and Model Gravity**

These controls toggle on and off magnetic and gravity computation respectively. Default displays of newly created cross-section views are created according to the current line control settings. With neither magnetic or gravity modelling selected, you are not able to open a new cross-section view. Without setting magnetic modelling active in the Line Control option, you are not able to run AutoMag (see *AutoMag (Optional Module)*).
Input and Output Channel Entries

The input channel name is displayed as the observed data in a cross-section. If there is no channel to be input (when modelling synthetic data), this entry should be blank. If there are channels other than easting, northing and the channel DIST_ABS, one must be selected for input. There are several instances in ModelVision where channels named GRAV and MAG are recognized as default input channels and it is recommended you follow this convention (channels can be renamed using the Utility>Data Maintenance>Line menu option). The output channel is the name given to the computed model output. Again, there are advantages to retaining the default names of GRAV_MOD and MAG.MOD.

Regional Option

Use Regional allows you to create and manipulate a polynomial surface to represent any broad variations across the survey area that you may not wish to model. This polynomial surface is added to the model output values. See the section Regional Field Controls for details of how to define and manipulate the regional. If the Regional option is unselected then the model output is as computed directly from the model around a base level of zero.

Compute Residual

This control toggles the computation of a residual on and off. The residual is the difference between computed and observed fields. While this control is active, the difference is updated each time a model is recomputed. The channel can be displayed in a track in the model cross-section. The residual is used to provide a convenient indicator of how the model mismatch varies along a profile.

Use Sensor Z Channel

This control toggles on and off the selection of a channel in the line data to provide a Z (elevation) value at which to make the station computation. For synthetic modelling you may wish to create an elevation channel using the Utility>Calculator to investigate the influence of flying height on anomaly amplitudes and resolution. If this control is toggled off, the computations are made at a zero elevation.

Display Topography Channel

This control allows you to select a channel available in the line data for display as a reference elevation trace. Usually this would be the ground surface but it might also be the water bottom for a marine profile or could be a reference depth-converted seismic horizon. This channel is for display only – it does not contribute to model computations. It does however provide a convenient means of digitizing a polygonal body to the topographic surface if you want to model gravity and/or magnetic terrain effects. Note that as a data channel the depth convention is positive upwards (topographic highs have higher absolute value than topographic lows). In displays you see the topographic trace displayed with opposite sign on ModelVision’s positive downward depth sections.
Select Lines

The Select Lines Active for Modelling dialog (enabled from the Select Lines button on the Line Control dialog) allows you to select and deselect lines as active for modelling. These lines are active for gravity and/or magnetic modelling according to the current Line Control settings. You only need to set lines active in this dialog when modelling in batch mode. When you open new cross-section views, those lines are automatically made active for modelling. You may find it more convenient to select and deselect lines in map views using the Active Lines toolbar that can toggle the state of the line activity. Active and inactive line states are indicated by the colour of their baselines and flight lines in map views.

Grid Controls

The individual controls in the Model>Grid Control option are identical to those in the Line Control dialog (see Profile Modelling Controls). Rather than making a selection of active lines, you specify a grid to which the computations are made. The grid can either be specified as Seed from Existing Grid or can be created using the option Specify Grid Dimensions. If the output is seeded from an existing grid, Clip Output Grid provides an option to report null values in the model output grid at the location of any nulls in the seed grid. Without this option enabled the output is reported at all grid nodes.

The Model>Grid Control option presents the following dialog:
By default, the model field is created at every node of a grid, but the grid can be sampled using Model>Data Compression. The compression factor is a desample rate for both grid rows and columns so that the computation time is reduced by approximately the square of the compression factor.

The Components button in the Gravity group box provides access to computation of components of the gravity and magnetic gradient tensors that are available in ModelVision. These tensor components and functions can be computed in grids as well as line mode.

**Drillhole Controls**

The individual controls in the Model>Drillhole Control option are identical to those in the Line Control dialog (see Profile Modelling Controls). Rather than making a selection of active lines, you specify the drillholes to which the computations are made. The drillholes can be derived from imported data files (see Importing, Exporting, and Linking Data Files) or from synthetic drillholes (refer to Drillhole Modelling).

The Model>Drillhole Control option presents the following dialog:
Once a drillhole is selected, responses for all readings designated with that hole are computed. If you wish to compute the magnetic responses for various components, you must enable these from the Model>Model Parameters dialog. Refer to the Drillhole Modelling section.

The Components button in the Magnetics and Gravity group boxes provide access to computation of components of magnetic and gravity components, tensor elements and functions that are available in ModelVision. These components and functions can be computed in drillholes as well as in line and grid modes.

Point Controls

The individual controls in the Model>Point Control option are identical to those in the Line Control dialog (see Profile Modelling Controls). Rather than making a selection of active lines, you specify the point groups to which the computations are made. Note that points are specified as ‘groups’ and are treated similarly to lines. Each point must have its own ‘group’ such as a station number or a collective group. The points are imported using the File>Import>Points menu option (see Importing, Exporting, and Linking Data Files).

The Model>Point Control option presents the following dialog. Use the Select Points button to specify the data points to be used for response calculations.
Once the required points are selected, magnetic or gravity responses can be computed. If you wish to compute the responses for various components, you must enable these from the Model>Model Parameters dialog.

The Components button in the Magnetics and Gravity group boxes provides access to computation of components of gravity and magnetic, tensors and all functions that are available in ModelVision.

Regional Field Controls

- **Using a Regional Field**
- **Computing a Regional Surface**

Using a Regional Field

There are many controls used in the generation of regional surfaces and there are significant benefits in understanding their use. Manipulation of the regional surface with ‘live’ modelling interaction is a powerful tool and is applicable to most modelling problems.

To incorporate a Regional field in your model you need only to specify that you wish to use a regional in the Line Control or Grid Control dialogs plus define the regional surface in the Model>Edit Regional option. Note that in joint modelling, ModelVision keeps the specification of the gravity and magnetic regional surfaces totally independent.

It can be difficult to manipulate the regional field when modelling of grid data with no accompanying profiles. In such a case, the most convenient solution is to create synthetic lines and interpolate the input grid onto them. You can set these lines active for regional computation and ModelVision creates the fixes to manipulate the regional polynomial surface.

Having selected lines and chosen the polynomial order you can first create the regional surface using the Compute from data option. The regional channel and associated polynomial fixes are defaulted and drawn in any new cross-section windows. These can also be easily added to map views as Stacked Profiles and Regional fixes respectively.
You can graphically adjust the regional by moving the fixes in either cross-section or map views. To do this, position the cursor over a regional fix, select it by a left mouse click, and ‘drag-and-drop’ it to a new location. The polynomial coefficients are recomputed as soon as one of the fixes is moved. In immediate mode changing the regional triggers recomputation of the model but in manual mode the revised regional is only added to the model output when the modelled field is next re-computed.

Example of a (3rd order) regional in a cross-section view. You can move the handlebars to manipulate the regional surface.

Working with a regional on a single profile basis is straightforward as the computed regional is displayed in the model track together with the input and output model channels. Working with regionals on multiple lines requires more management to ensure the modelling on all lines is developed with the same, final regional surface. This is generally an iterative process. As you revise the regional field on one line you need to subsequently adjust the model which may no longer match the data on the lines previously modelled.

Example of a regional in a map stacked profile view. Note that you can select and move groups of points.

If the regional field being used is complex or has local, steep gradients that are difficult to reproduce with a polynomial surface, you can position the regional fixes on the interpreted surface and convert the fixes to a point data set. The points can be gridded to give you an interpreted surface. You can interpolate this grid back onto the lines and use the Utility>Calculator option to make a residual separation (using the equation Residual = Input − Regional). This method allows you to define and remove regional fields of complex shape but it does not provide the flexibility of the interactive ‘live’ polynomial definition of a regional field.
Computing a Regional Surface

Regional computation is an important and powerful means of representing broad field variations. There are two ways of creating a regional to be added to the model output. If you already have a suitable grid of the regional field you can interpolate from it onto the data lines. Such a grid would usually be created by simulating the regional from the response of deeply buried sources. Alternatively, you can compute a polynomial surface to fit a set of samples (fixes) on selected lines.

ModelVision uses default channel names for regional computation. The MAG_REGIONAL channel is created when a regional surface is computed for magnetics, and GRAV_REGIONAL for gravity.

Use either the Model>Edit Regional>Magnetics or Gravity option to present the relevant regional control dialog.

The Magnetics Regional dialog

This dialog can also be accessed with the Compute Regional button on the Line Control dialog.

The Use Grid option allows you to select an existing grid. On exiting from the dialog with the OK button, a regional track is interpolated from that grid onto all lines that traverse it.

The more common form of regional modelling is to use the polynomial surface generator operated through the Compute Using Params Below option. In this method the regional field is defined as a polynomial surface of specified order that is first computed from all data on lines selected for its definition. Subsequently, the polynomial surface can be adjusted to match only what is interpreted to be regional variation. During modelling the regional surface can be adjusted as changes are made to the models so that the sum of regional and computed model output best fits the input data.
Input Channel

This is the channel from which the polynomial is first calculated. By default, this is the input channel for the modelling.

Polynomial Order

This number sets the order of the polynomial surface. A zero order regional has a single coefficient that is a constant to be added to the model output. A first order regional has two additional terms for gradients along the two horizontal axes, a second order regional has an additional three orthogonal terms. Complex regional fields may require third or fourth order polynomials but control of higher order polynomials rapidly becomes impractical and any sharp local gradients that are introduced may interfere with the modelled field variations. Separation into model and regional components of field variation is empirical and interpretive and most importantly it can be easily adjusted (including choice of the polynomial order) during model development.

Parameters

These are the coefficient values for the polynomial. The values are computed from the data or from the fixes but you can edit the values if you want to specify a particular surface.

Active Lines

The Active Lines button provides access to lists of lines active and inactive for computing the regional. The regional is computed only from the lines selected as active but is applied to all lines that are modelled while in Use Regional mode. For large surveys it is generally sufficient to sub-sample the lines so that 10 to 20 lines across the survey area may be selected. You can also toggle this line selection in a map view using the Active Lines toolbar.

Compute from Fixes or Compute from Data

Initially you need to compute the polynomial from the data using Compute from Data. This computation is used to give the initial values for the regional fixes on each line. You can graphically move those fixes to improve your interpretation of the regional field.
Recompute Fixes

In adjusting individual fixes to achieve the polynomial surface that you want, you may need to move the fixes some way from the regional surface. Moving regional fixes can be done interactively. Refer to Using a Regional Field for information on this. The **Recompute Fixes** button moves the fixes back onto the polynomial surface. This does not change the values of the coefficients or the regional field computed from them.

Convert Fixes to Point Sets

Having positioned the fixes on what you interpret to be the regional surface you can save the fixes as a point data set. From these points, you can create a regional grid that is not constrained to have any particular polynomial form.

Save / Load

The regional coefficients can be saved as an ASCII list in a file with a .REG extension. This file can subsequently be loaded to recover that regional field. After loading the coefficients, click the **Recompute Fixes** button so that the fixes take values according to the newly loaded coefficient set. Clicking the OK button to exit from the dialog sets the regional field to the newly loaded coefficient values.

Generate Regional Grid

This control enables the creation of a grid computed directly from the coefficient values. There is an option to **Use seed grid** or to **Specify** a new grid range and cell spacing. The **Auto Recompute** setting causes the regional grid to be recomputed as soon as there is any change to the polynomial coefficient values.

Generate Residual Grid

This control enables creation of a residual grid computed as the difference between the regional grid and the Reference grid. This computation requires the two grids being compared to have coincident nodes. The most direct way to ensure this is to set the **Reference** grid for the **Generate Residual Grid** operation to be the same as the **Seed** grid for the **Generate Regional Grid** operation.
Magnetic Field Controls

If you are modelling magnetic data, it is essential to have reasonable estimates of the strength, inclination and declination of the Earth’s magnetic field at the survey site. Correct inclination values in particular are essential to obtain reliable dip estimates in bodies. Most anomalies can be matched using incorrect geomagnetic inclination values, but the resulting models may be meaningless. The field strength is specified in nanoTesla (or gammas). The declination and inclination are specified in degrees, with inclination measured from the horizontal plane and declination measured from the north axis of the data coordinate system.

Dialog to define the Earth’s magnetic field, remanence, demagnetisation and field component

Magnetic field parameters are entered in the Project Parameters dialog and can be subsequently edited through the File>Project Properties or Model>Magnetic Field menu items or the Magnetic Field button in the Line Control dialog. Enter the field values if you know them or generate the values with the IGRF Calculator accessible through either of the above menu options.

IGRF Calculator

The IGRF calculator provides the Earth’s field parameters for a site that is specified by latitude and longitude values or graphically selected in any of the map views of the world. The IGRF is computed from standard tables of harmonic coefficients that incorporate variability with time and elevation. Date and elevation should match those relevant for the input data. Clicking the OK button updates the field parameters with the displayed values. The Cancel button closes the dialog with the parameters unchanged.
One of the many world map views for rapid estimation of the local strength and direction of the Earth’s magnetic field

**Remanence**

To compute the remanent magnetisation of a body you must first enable the **Compute Remanence** box in the Magnetic Field Parameters dialog. Remanent magnetisation properties can be specified for any body as the Koenigsberger Ratio (Q) and the inclination and declination of the remanence. Remanent magnetisation contributes to many magnetic field anomalies. It is however, generally ignored as far as possible because of lack of knowledge of the magnetisation properties. Dominant reverse remanent magnetisations are often modelled as negative susceptibilities. ModelVision uses the definition of the Koenigsberger Ratio (Q) as the ratio of remanent to induced magnetisation intensity:

\[ Q = \frac{M_{\text{Rem}}}{M_{\text{Ind}}} \]

where \( M_{\text{Rem}} \) is the remanent magnetisation intensity and \( M_{\text{Ind}} \) is the induced magnetisation intensity in the same units. \( M_{\text{Ind}} \) is derived by slightly different equations according to the units system (SI or cgs) but in both cases involves the product of susceptibility and inducing field strength.

**Demagnetisation**

It is incorrect to assume that the induced magnetisation of a high susceptibility body is directly proportional to the inducing field. Bodies sit in their own magnetic anomalies and the induced field from a high susceptibility body is a complex function of the inducing field, susceptibility, shape, size and orientation of the body. Allowing for the effect of the field modification by the body reduces the amplitude of the induced field which is why this effect is termed ‘demagnetisation’. There is no exact formulation of demagnetisation for generalized bodies. ModelVision uses exact analytic code for the special cases of the sphere and ellipsoid. For all other bodies, demagnetisation is computed by approximation using surface integrals with the body surface broken into facets. There are several special cases where the computations are invalid and requests to compute demagnetisation may produce warning messages that demagnetisation cannot be computed for a particular facet. Computation of demagnetisation is intensive and should be disabled unless you have high susceptibility bodies (0.2 SI or greater) where the demagnetisation effect is significant. Demagnetisation is enabled in the Magnetic Field Parameters dialog and is subsequently computed for all bodies with susceptibility in excess of 0.01 cgs.
Full Tensor Magnetic Gradiometer Computation

Instrumentation is now available to provide the full magnetic tensor within an absolute reference frame. The magnetic tensor is defined by the gradients of each Cartesian component $B_x$, $B_y$, $B_z$ along each Cartesian direction. The magnetic tensor is symmetric so the nine tensor terms reduce to six with $B_{xy}=B_{yx}$, $B_{xz}=B_{zx}$ and $B_{yz}=B_{zy}$. The magnetic tensor utility in ModelVision provides the ability to model such tensor data. Tensor components are computed analytically for all ModelVision body types to provide exact values at any point in space exterior to the bodies themselves.

The magnetic component option in ModelVision models:

- The principal components of the magnetic field computed in a fixed Cartesian reference frame
- The tensor of the gradients of those components along each principal axis
- Various statistics as functions of the tensor components and total field (TMI) gradients.

Enabling Magnetic Tensor Computations

The magnetic tensor computations are accessed from the Model>Magnetic Field menu item or alternatively, from the Component button in the magnetic modelling section of the Model>Line Control or Model>Grid Control dialogs.

The magnetic component dialog

Computing Magnetic Field Tensor Components

Magnetic field tensor computation is controlled in the magnetic component dialog as shown above. From left to right this dialog lists the available tensor components and derived parameters that can be computed. Each can be made active for calculation by enabling the accompanying check boxes. Selected items are updated on all active lines when a magnetic field computation is triggered.

The lower part of the dialog allows any one item to be selected for display as the primary computed magnetic response in cross-section views.

Note

Any of the other items can also be shown in cross-section views by adding them as auxiliary channels in the cross-section configuration dialog.
On selecting the computed response, you should check in the line control dialog that the equivalent data channel is set as the input channel. If you invert on magnetic field data, the inversion uses this input channel and modelled component pair. To invert on a different parameter you must change both the input channel and modelled component.

ModelVision uses the convention \( x = \text{east}, y = \text{north}, z = \text{down} \). The magnetic field components are:

- \( B_x \) The horizontal component in the easting direction
- \( B_y \) The horizontal component in the northing direction
- \( B_z \) The vertical component

**The Magnetic Field Gradient Tensor**

This is the tensor of the gradients of each component in each direction (for example, \( B_{xy} \) is the gradient in the northing direction of the easting component). The magnetic gradient tensor contains nine terms from the gradients in three principal directions of each of the three principal components. Symmetry across the diagonal and the zero sum of the diagonal components reduces the number of independent terms to five.

**Magnetic Gradiometer Units**

Magnetic gradiometer units used in ModelVision are in units of gammas per metre (nT/m).

**Working with Magnetic Field Tensor Computations**

The complexity of full tensor data can be overwhelming and difficult to immediately understand. Generally, to interpret tensor data, you need to look at the data in map form. You can do this either by computing the tensor along survey lines and gridding it (just as is done with measured data) or alternatively you can directly compute grids via the grid control dialog (using the Utility>Grid option).

To assist in interpretation of tensor data, ModelVision also provides automatic computation of a number of derived parameters and gradients of the total magnetic field intensity as listed below:

<table>
<thead>
<tr>
<th>Algebraic Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( dT_dx ), ( dT_dy ), ( dT_dz )</td>
<td>Easting, northing and vertical gradients of TMI</td>
</tr>
<tr>
<td>( dT_dH )</td>
<td>Horizontal gradient amplitude of TMI</td>
</tr>
<tr>
<td>( B_m )</td>
<td>The amplitude of the total field (TMI)</td>
</tr>
<tr>
<td>( B_p )</td>
<td>The component of the magnetic field along the profile direction</td>
</tr>
<tr>
<td>( BH )</td>
<td>Total horizontal component of the magnetic field</td>
</tr>
<tr>
<td>( BAS = \sqrt{(B_{xz}^2 + B_{yz}^2 + B_{zz}^2)} )</td>
<td>Analytic signal of the vertical component</td>
</tr>
<tr>
<td>( TAS = \sqrt{(dT_dx^2 + dT_dyB_{y}^2 + dT_dz^2)} )</td>
<td>Analytic signal of TMI</td>
</tr>
<tr>
<td>( NSS )</td>
<td>normalised source strength ( (\mu) ) (Appendix G)</td>
</tr>
<tr>
<td>( \phi )</td>
<td>co-inclination angle ( (\phi) ) (Appendix G)</td>
</tr>
<tr>
<td>( \lambda_2 )</td>
<td>second eigenvalue ( (\lambda_2) ) (Appendix G)</td>
</tr>
</tbody>
</table>
Full Tensor Gravity Gradiometer Computation

Most gravity surveys provide (relative) measurements of what is approximately the vertical component of gravity (component \( g_z \)). Instrumentation is now available to provide the full gravity tensor within an absolute reference frame (one that does not use gravity itself to define the vertical). The gravity tensor is defined by the gradients of each Cartesian component \( g_x \), \( g_y \), \( g_z \) along each Cartesian direction. The gravity tensor is symmetric so the nine tensor terms reduce to six with \( G_{xy}=G_{yx}, G_{xz}=G_{zx} \) and \( G_{yz}=G_{yz} \). The gravity tensor utility in ModelVision provides the ability to model such tensor data. Tensor components are computed analytically for all ModelVision body types to provide exact values at any point in space exterior to the bodies themselves.

The gravity component option in ModelVision models:

- The principal components of gravity computed in a fixed Cartesian reference frame
- The tensor of the gradients of those components along each principal axis
- Various statistics as functions of the tensor components.

Enabling Gravity Tensor Computations

The gravity tensor computations are accessed from the **Model>Gravity Component** menu item or alternatively, from the **Component** button of the **Model>Line Control** or **Model>Grid Control** dialogs.

![The gravity component dialog](image)

**Computing Tensor Components**

Gravity tensor computation is controlled in the gravity component dialog as shown above. From left to right this dialog lists the available tensor components and derived parameters that can be computed. Each can be made active for calculation by enabling the accompanying check boxes. Selected items are updated on all active lines when a gravity computation is triggered.

The lower part of the dialog allows any one item to be selected for display as the primary computed gravity response in cross-section views.
On selecting the computed response, you should check in the line control dialog that the equivalent data channel is set as the input channel. If you invert on gravity data, the inversion uses this input channel and modelled component pair. To invert on a different parameter you must change both the input channel and modelled component.

ModelVision uses the convention $x = \text{east}$, $y = \text{north}$, $z = \text{down}$. The gravity components are:

$\begin{align*}
g_x & \text{ The horizontal component in the easting direction} \\
g_y & \text{ The horizontal component in the northing direction} \\
g_z & \text{ The vertical component of gravity (the ‘traditional’ value of gravity).}
\end{align*}$

### The Gravity Gradient Tensor

This is the tensor of the gradients of each component in each direction (for example, $G_{xy}$ is the gradient in the northing direction of the easting component of gravity). Of all the component and gradient combinations, the most widely used gradient is the vertical gradient of gravity $G_{zz}$.

The gravity gradient tensor contains nine terms from the gradients in three principal directions of each of the three principal components. Symmetry across the diagonal and the zero sum of the diagonal components reduces the number of independent terms to five.

### Gravity Gradiometer Units

Gravity gradiometer units used in ModelVision are:

<table>
<thead>
<tr>
<th>Component</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gravity components $g_x$, $g_y$, $g_z$</td>
<td>milligals or µm·s$^2$</td>
</tr>
<tr>
<td>Tensor components $G_{uv}$, $G_{GH}$, $G_{GC}$</td>
<td>Eotvos units</td>
</tr>
<tr>
<td>Directions $AH$, $AC$</td>
<td>degrees clockwise from north</td>
</tr>
</tbody>
</table>

### Working with Gravity Tensor Computations

The complexity of full tensor data can be overwhelming and difficult to immediately understand. For example, the cross-horizontal tensor component ($G_{xy}$) over a sphere as shown below consists of 2 anomaly minimum/maximum pairs. Generally, to interpret tensor data you need to look at the data in map form. You can do this either by computing the tensor along survey lines and gridding it (just as is done with measured data) or alternatively you can directly compute grids via the grid control dialog (using the **Utility>Grid** option).

To assist in interpretation of tensor data, ModelVision also provides automatic computation of a number of derived parameters. These parameters are computed as algebraic functions of selected tensor terms as listed below:
**Examples of Gravity Tensor Computations**

Below are examples of typical theoretical and applied gravity tensor measurements computed in ModelVision. The cross-horizontal gravity tensor component over a sphere is shown here. The alternating high and low response of the tensor uniquely defines the centre of mass of the anomalous body.

<table>
<thead>
<tr>
<th>Algebraic Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$G_{uv} = (G_{yy} - G_{xx})/2$</td>
<td>An indicator of source horizontal asymmetry and orientation</td>
</tr>
<tr>
<td>$G_{H} = \sqrt{(G_{yz}^2 + G_{xz}^2)}$</td>
<td>Horizontal gradient amplitude of the vertical component</td>
</tr>
<tr>
<td>$AH = \arctan(-G_{yz}/G_{xz})$</td>
<td>Horizontal gradient direction of the vertical component</td>
</tr>
<tr>
<td>$G_{C} = \sqrt{(4G_{xy}^2 + (G_{yy}-G_{xx})^2)}$</td>
<td>Curvature gradient amplitude</td>
</tr>
<tr>
<td>$AC = \frac{1}{2} \arctan(-2G_{xy}/(G_{yy}-G_{xx}))$</td>
<td>Curvature gradient direction</td>
</tr>
<tr>
<td>$AS = \sqrt{(G_{xz}^2 + G_{yz}^2 + G_{zz}^2)}$</td>
<td>Analytic signal of the vertical component</td>
</tr>
<tr>
<td>$I_{1} = G_{xx}G_{yy} + G_{yy}G_{zz} + G_{xx}G_{zz} - (G_{xy}^2 + G_{zy}^2 + G_{yz}^2)$</td>
<td>Invariant 1</td>
</tr>
<tr>
<td>$I_{2} = G_{xx}(G_{yy}G_{zz} - G_{2yz}) + G_{xy}(G_{yz}G_{xz} - G_{xy}G_{zz}) + G_{xz}(G_{xy}G_{yz} - G_{xz}G_{yy})$</td>
<td>Invariant 2</td>
</tr>
<tr>
<td>$G_{aa}$</td>
<td>The along line gradient of the along line component calculated in the nominal line direction.</td>
</tr>
<tr>
<td>$G_{cc}$</td>
<td>The cross line gradient of the cross line component. This is perpendicular to the nominal line direction.</td>
</tr>
<tr>
<td>$G_{za} = G_{zz} - G_{aa}$</td>
<td>Component measured by the VK gravity gradiometer system when oriented along line. (Also called VKa)</td>
</tr>
<tr>
<td>$G_{zc} = G_{zz} - G_{cc}$</td>
<td>Component measured by the VK gravity gradiometer system when oriented cross line. (also called VKc)</td>
</tr>
</tbody>
</table>
The cross horizontal gravity tensor component over a sphere

In an applied case, a salt dome and a salt wall have been simulated and their gravity sensor response shown in both map and cross-section form. In this case, the Gxy cross-horizontal tensor component has been used to create a grid across many lines and the computed response gridded to display the image map. Note the magnitude of the data ranging between ± 6-7 gravity units.

A layout view showing map image, cross-section and perspective windows of gravity tensor modelling of a salt wall and salt dome

**Default Model Parameters**

Default model parameters and cross-section settings are set from the **Defaults** option on the **Model** menu.

- **Model Parameters**
• Cross-section Defaults

Model Parameters

The Model>Defaults>Model Parameters option provides access to change the background properties and the default model properties.

![Default Model Parameters dialog]

Background Properties

The background density and susceptibility are the values against which a contrast is computed with the property of each body. Changing background values changes the amplitude of the model output due to each body.

Body Default Values

These are the values ascribed to new bodies when they are created. If you wish to create a number of bodies with common physical properties it is worthwhile placing these values in the default property setting.

PolyGroup Body Settings

These checkboxes control whether the body visibility switches and active for computation switches apply to all components of the polygroup or just to the specified one.
Cross-section Defaults

This dialog allows you to set defaults for the display of the gravity and magnetic input and output model curves and the body display type.
10 Inversion

In this section:

• About Potential Field Data Inversion
• Inversion Techniques
• Quick Inversion
• General 3D Inversion
• Remanence Inversion
• Joint Inversion
• Performing an Inversion

About Potential Field Data Inversion

Potential field data inversion strategies can be broadly categorized as either following a pure processing approach or one that is geologically guided. The pure processing method is often defined as objective, whilst the geologically guided approach is subjective, the inference being that subjective is “not good”. Objective approaches are reproducible. If you apply the same parameters then you will get the same result, whereas subjective methods can produce a different result depending upon the starting model and processing path.

Pure processing methods transform the potential field data into information that generally resembles a fuzzy view of the geology. Examples include Euler deconvolution, Werner deconvolution, Naudy inversion and unconstrained UBC voxel inversions. Each of these methods uses simple geological concepts and tries to apply them to every anomaly. Some recent developments in the Euler method try to automatically determine the most appropriate structural index, but there is no guiding geological hand to arbitrate.

We use the term “user-guided inversion” to describe the subjective inversion process where inversion is a tool used to help create a model that matches the geophysical data and available geological constraints. In this context inversion is a productivity tool to build a geological model, rather than an end in itself. As soon as we introduce appropriate geological thinking, the inverted parameter quality is improved for properties such as magnetic susceptibility, density, depth and boundary locations.

Geological constraints can be in the form of hard facts from drilling or outcrop data or deduced constraints. These are based on the concepts of geological mapping of the potential field data and the application of a regional geological environment that is appropriate for the survey area.

One of the challenges for the geophysicist is the need to transfer our understanding of the confidence in our interpretations to the geologist. A perfect data machine does not necessarily mean a good geological solution. With User Guided Inversion, you can test a range of options to determine which is the one that provides the best geological solution.

For a more detailed overview of User Guided Inversion, the reader is referred to Pratt, Foss and Roberts (2006). Other research publications on inversion can be found on the Tensor Research website www.tensor-research.com.au.
Tensor Research’s geophysical research team is continually working at the leading edge of inversion technology and the public release of ModelVision includes three different implementations, each suited to a different workflow requirement. These include QuickInvert, Standard Inversion and Joint Inversion.

**Inversion Techniques**

Geophysical inversion is a complex topic for first-time users, so we recommend a thorough review of the reference documentation and practise on the tutorial examples. This guide will take you through the simple and advanced techniques that can be applied to modern survey datasets:

- **Quick Inversion**
  
  QuickInvert is a productivity tool designed to work on individual lines using the tabular body model for rapid depth estimation for long strike length magnetic anomalies. It is an easy place to start modelling, but it does not work for gravity or any of the other body types supported in ModelVision.

- **Direct Targeting Workflow**
  
  The direct targeting workflow methodology is the preferred way for undertaking full 3D modelling and inversion using multiple cross-sections, an integrated regional and simple active point selection. The technique bundles multiple single steps into a rapid workflow procedure that allows you to target an anomaly or anomaly complex for forward modelling and inversion. This process can save 5 to 15 minutes per anomaly in preparing your data for modelling and inversion. You can move easily between anomaly targets and as you complete each target, the models are added to the master session. Both the general and joint inversion methods can be used with this wizard.

- **General 3D Inversion**
  
  General 3D Inversion provides a standard single channel Marquardt style inversion process and multi-channel Joint inversion for multi-sensor instruments. Standard Inversion supports all body types and can be used on single or multiple lines of data. You can do cooperative inversion of gravity and magnetic data by alternately switching modes so that you end up with one consistent density and magnetic susceptibility model.

- **Remanence Inversion**
  
  Remanence Inversion is possible for both Standard and Joint Inversion methods. This chapter will explain how to invert for remanent magnetisation or resultant magnetisation and explain the limitations associated with this type of inversion.

- **Joint Inversion**
  
  Joint Inversion supports the use of multiple magnetic or gravity sensors for a multi-body geological model. Joint Inversion is essential for extracting the most geological information from the new generation of sensors such as full tensor gravity gradiometers, full tensor magnetic gradiometers and multi-sensor systems such as wing tip gradiometers and ground based towed arrays. Check the release notes to see which body types are supported. The tabular, sphere, ellipsoid, circular pipe, elliptic pipe, plunging prism, and frustum bodies are supported in version 16.0. Joint Inversion is a new technology for potential field interpretation, so we have included some background on the method plus a summary of the theory at the end of this chapter.
Quick Inversion

Quick Inversion is a productivity tool that is optimized for inversion of single magnetic anomalies using a tabular body source. It is easy to learn because it automates many of the steps used in Standard Inversion. This includes a single control dialog that automates the use of a 2D regional magnetic field, easy toggling between TMI and first vertical derivative inversion methods and the setting of geological constraints.

How it works:

Quick Inversion has a number of helpful features that make it easy to use. From the selected cross-section line, you first create a seed model by selecting a magnetic anomaly and Quick Inversion builds a starting model that is ready for inversion. It automatically calculates a regional and sets up the section for inversion on the first vertical derivative (1VD) or total magnetic field (TMI). When the Local regional check box is selected, Quick Inversion estimates the 2D regional from the magnetic grid in the immediate vicinity of the selected anomaly and disables the standard regional field calculation.

You then run the inversion in TMI or 1VD modes using the free/constrain options associated with the regional, susceptibility, position (distance), depth, width, dip and depth extent parameters. Each anomaly takes just a few seconds to interpret in this mode.

The Quick Inversion Dialog.

Note that the AutoMag button is functional only with an AutoMag license option and is used to create the tuning parameters for an AutoMag run (see AutoMag (Optional Module)).

- Creating the Seed Body
- Improving the Fit
- Auto Mode Inversion
- Manual Adjustment of Body Parameters
- Restoring Previous Models
- Manual Mode Inversion
Creating the Seed Body

The tool is started from the **quick inversion** button on the toolbar which brings up the Quick Inversion dialog. The title bar of the dialog will indicate which line you are currently working on.

If you have a TMI grid available select the grid channel containing the TMI data and press the **Create Seed** button. A prompt will appear asking you to drag out a region in the cross-section window. This message can be suppressed for the remainder of the ModelVision session. The cursor in the current cross-section will change to a cross and holding down the left mouse button drag out a region across an anomaly. When the button is released an analysis of the grid data in this region takes place, a regional is determined in this locality and an initial body is created.

If a TMI grid is not available then select <none> as your grid and proceed as above. A more basic analysis will take place using the line data on each side of the selected region in order to estimate a local regional and a body will be created at the centre of the selection.
Improving the Fit

The inversion phase uses line data from the chosen cross-section only. It will encompass the selected region and if the initial analysis has been successful will not extend far enough to include outlying anomalies.

You should select the parameters you want to be free to adjust. The others will be fixed and can be set to specific values if you want.

Auto Mode Inversion

Auto mode uses a preset scheme of inversion stages to obtain an optimum solution quickly. You have control over which parameters are free and the number of times it iterates through the cycle.

Selecting the Invert on TMI button will compute the inversion on the initial model.

The example above gives a single adjustment on susceptibility, then on susceptibility, position and depth, then on susceptibility, position, depth, width and dip:

- susceptibility
- susceptibility + position + depth
susceptibility + position + depth + width + dip

A total of 3 iterations are selected in the Quick Inversion dialog above so this cycle is repeated three times. If the regional level is set to be free then an adjustment for this would be made only at the start of each cycle and would be fixed while any other parameters are free.

**Note**

A body will have been created but it is possible that you might get a message that the best starting body was not achieved or that the solution was not found within drawn limits. You can choose to delete the body and try again or you can continue with the inversion phase. In many cases the inversion can cope with this and bring the body back into the correct solution space, but factors such as noise, adjacent anomalies or a bad regional could cause the inversion to fail.

**Manual Adjustment of Body Parameters**

The values current for each of the parameters is displayed in the dialog. The body can be moved in the cross-section window or changed via the **Body Properties** dialog or **Body Table** and the dialog will be updated with the new values. In addition any value which is not free for inversion can be edited in the dialog and when the **Apply to Body** button is selected the body will be modified and updated in any open window.

**Restoring Previous Models**

Restoring models computed from the previous inversion run can be done by pressing the **Revert** button. This may be necessary if the inversion has taken an undesirable course and allows you to go back and free different parameters.

**Manual Mode Inversion**

This mode turns off the preset scheme and allows you to do successive iterations just on the selected free parameters. This mode is not as fast as the **Auto** mode but it gives you more control over the process.

**Modelling Other Anomalies**

The process of creating a seed body and inversion can be done on other anomalies on the same line or on anomalies in other cross-section windows. Quick Inversion will keep track of which window you are currently in and update the dialog accordingly.

Each inversion is carried out using the selected data but the contribution from all bodies currently active for modelling is taken into account. At times it may be desirable to remove the influence of nearby bodies. That can be done by deactivating particular bodies from the **Body Table** or by pressing the **Deactivate** button in the Quick Inversion dialog which will deactivate all bodies other than the current body.

**Data and Body Selection**

The **Select** tab in the Quick Inversion dialog is an alternative to the seed body creation. It allows you to select the exact data region to use in the cross-section and to select an existing body. This means you can create your own starting body or go back to a previous one.
The Select Data button prompts you to drag out a region in the current cross-section and will update the cross-section highlighting only that data. If there are bodies nearby it will select the nearest and display its name and colour in the dialog.

The Select Body button allows you to override the previous body selection. Once data and a body selection have been made the Quick Inversion controls are enabled.

Selecting data and body with multiple anomalies

The Show All Data checkbox toggles between showing the response with all data points on the line active and just showing the response of the selected region. It is for display only and has no effect on the inversion process.

Regional Removal

If the regional is turned on for modelling in the Model>Line Control dialog then the regional field defined by the Magnetic Regional parameters will be used during Quick Inversion. The only adjustments made will be to the regional level if that parameter is inverted on or changed manually in the Quick Inversion dialog.

Local Regional

If the Local Regional checkbox is selected then the other regional parameters are allowed to change prior to inversion. In this case only the line current for Quick Inversion is active for regional and changing the line will cause a change in the line active for regional. This means that you can use the regional handles in the cross-section window to alter the regional to match the section of data you are working on.

If a seed body is created using a magnetics grid then the Local Regional option enables the program to compute a new regional based on the non-anomalous part of the data. This will override the existing regional. You can control how much data is used to determine this new regional by setting the Regional Extent.

Note

There is only one regional for magnetics so a change to the parameters to adjust the regional for the current line will cause a change over the whole regional surface. This may be inappropriate for other lines and should be kept in mind when moving between lines.
Regional Extent

The **Regional Extent** control is normally set to 3 and defines how much grid data perpendicular to the line direction gets used in determining the new local regional. The program will attempt to determine anomalous data in this region and exclude it from the regional calculation. However, if you want to make sure you eliminate interfering anomalies then you should reduce the regional extent.

Inversion on First Vertical Derivative

The **1VD** checkbox, when first selected, will create an in-line filter channel to be set up which is applied to both the field channel and the computed magnetics data channel. This will immediately appear as a supplementary track in the current cross-section window with two new curves which have a _FVD suffix. The filter is an FFT based filter which reduces end effects and eliminates the need to tailor the filter length to the data.

While the **1VD** checkbox is ticked inversions will try and match the 1VD channels. When turned off the supplementary track will remain but inversion will then be on TMI instead of 1VD. So you can change freely between these to optimize your inversion.

![](image)

*Quick Inversion on first vertical derivative*

General 3D Inversion

Standard Marquardt single channel and multi-channel joint inversion methods are provided for 3D inversion of magnetic and gravity data. Joint Inversion can be used on a single data channel, but in version 9.0 support is limited to a subset of the body types (tabular, circular pipe and elliptical pipe). We recommend that you use **Joint Inversion** for gravity and magnetic gradiometers, cross-wing magnetic gradiometers, sled mounted multi-sensor magnetometers and had held gradiometers. Magnetic gradients can be pure field component gradients from SQUID magnetometers and paired fluxgates or total field gradients as measured by cross-wing systems.

The mechanics of preparing for Standard and Joint Inversion are similar except for data specification, inversion engine tuning parameters and the treatment of regional fields.

- **Inversion Strategies**
- **Treatment of Regional Fields**
Inversion Strategies

The inversion facility in ModelVision is guided by statistical decision making. Because of the inherent ambiguity in interpretation of potential fields there are several requirements for producing a sensible geological model:

1. You must have a clear geological concept that shows how the model will explain the data.

2. Decide on the method for managing the background regional field as a model or a polynomial surface.

3. Start with a model that already provides an approximate match to the data and embodies your geological concepts.

4. Select appropriate free variables and constrain tolerances to restrict the inversion search within appropriate limits.

5. Guide the inversion through active intervention where necessary.

The first three conditions require a clear geological hypothesis and that significant interpretation is undertaken before turning to inversion. The last two conditions require that you continue to interpret as you initialize and run the inversion and that you develop the necessary skills to control the inversion procedure.

We recommend that you first experiment with some synthetic models and data where you know the answer, prior to working with instrument data. Create a profile or set of profiles using the Utility>Synthetic menu option. Create a simple model (say a tabular body), compute its field and use the calculator to copy that model output channel to a GRAV or MAG channel. You can save and delete your starting body, create a new and different body and experiment with inversion to investigate the capability and difficulties of reproducing the original. Conducting such exercises not only allows you to master the inversion controls but also provides insight into the fundamental aspects of potential field interpretation.
Treatment of Regional Fields

Two methods are supported for computation and management of the background potential field data, otherwise known as the regional. A 2D polynomial surface can be used to explain the background behaviour for a single channel inversion (see section on Regional Computation) but this is not suitable for Joint Inversion (multi-channel) where the regional field for each data channel must be explained by one or more regional bodies within the ModelVision model.

Bodies designated as “Regional” have a special significance in both styles of inversion. They can be inverted as a group, while keeping the target or primary geological model inactive during inversion. This process is controlled simply from the Inversion Free Parameters dialog and saves the many steps that would be required to deactivate a primary geological model with numerous individual bodies.

Conversely, when Target is activated, only the primary geological model bodies will be included in the inversion. Of course the regional body contribution is added to the total calculated response, but none of the Regional bodies are modified.

As the model matures and approaches a satisfactory match to the field data, you can invert on the Target and Regional bodies together by selecting the All radio button.

Limitations

The default number of free parameters and data points for any one step of an inversion is set to 100 and 1000 respectively. You can increase these numbers in the Config option in the inversion dialog, but you are likely to find that inversion is very slow and not suitable for interactive inversion outcomes. It is better to limit the size of the problem by focusing on a subset of the free parameters and use active point selection and compression to further limit the amount of data that is used in the inversion.

Joint inversion has some specific limits on the amount of data and free parameters that can be used during inversion. The limits for release 16.0 are:

- Total number of bodies: 200
- Total number of plunging prism and frustum bodies: 16
• Total number of free parameters: 800
• Data channels: 8
• Points per channel: 2048
• Vertices per plunging prism or frustum body: 100

In practice, an inversion will take a long time to run if these limits are fully utilized and convergence can be very slow.

**Inversion Controls**

<table>
<thead>
<tr>
<th>Tools</th>
<th>Modules</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AutoMag</td>
<td>Speed</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Active Line</td>
<td>Inversion</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Joint Inversion - Magnetic</td>
<td>Joint Inversion - Gravity</td>
<td></td>
</tr>
</tbody>
</table>

Inversion can be activated using either of the following methods.

1. Select the **Tools>Inversion or Tools>Joint Inversion** option.

2. Place the cursor on the open work area of the ModelVision screen and click the right mouse button. A pop-up dialog provides access to a number of frequently used functions, as well as inversion.

**The Inversion Toolbar**

The Inversion Toolbar appears the same for both the standard and joint inversion methods. Differences exist however, for the **Configure** and **Data** buttons.

The top button on the inversion toolbar indicates what data is selected for the inversion. If you start inversion with a cross-section as the active window, the name of that profile is shown. You can change focus to another displayed profile by clicking on the top button to open the **Inversion Line Selection** dialog and selecting the alternative window from the drop-down list.
Beside the list, the control **Fixed** keeps the focus of the inversion on the data in that window while **Tied to active window** shifts the focus of inversion as you change selection of active windows.

If you start an inversion with a map view as the active window, the toolbar reports a map selection and all active points are selected for the inversion. Other buttons on the Inversion toolbar are:

- The **Configure** button opens the **Inversion Configure** dialog. Most of the controls in this dialog rarely need to be changed and you should only change them when you are experienced with inversion.

- The **Data** button opens the **Inversion Data** dialog that allows you to select the data channels for modelling and to change the compression (sub-sampling) factor. The number displayed beside the button is the number of active points currently selected for inversion.

- The **Free** button opens the **Inversion Free Parameters** dialog in which you can select and deselect the free parameters for the inversion.

- The **List** button opens the **Inversion Parameter List** dialog. This dialog provides a more precise manipulation of the model parameters.

- **Current RMS** reports the percentage RMS difference between the model input and output channels computed for all those stations at which the field values are used in the inversion. This statistic is of key importance in inversion as it is used as a 'quality' criterion of a model and is the basis for making decisions about changing the model. For standard inversion, the RMS is expressed as a percentage of the dynamic range of the active data. In the case of joint inversion, the RMS is a expressed as a percentage of the normalized data range across all active channels for the selected data points.

- **Target RMS** (root mean square error measurement) is the value that has been set as an objective for the inversion. Inversion stops as soon as the current RMS value reaches the target value. The RMS target value is used in a test to switch off inversion once the match between observed and model fields is reduced below the specified value. The RMS target value can be reset between inversion steps. It plays no part in the inversion provided the current RMS value remains greater.

- The **Run** button starts an inversion after you have ensured that all the settings and parameters are as you want them.

- The **Revert** button allows you to undo the changes just made by an inversion. If you want to undo the changes of the last inversion you must do it before making any subsequent changes to the body as only parameters for a single inversion run are stored by ModelVision.
Inversion Progress Bar

When inversion is running a progress bar advises of the status of the inversion and provides an opportunity to halt the inversion. The percentage progress reported is measured by:

\[
\text{Progress} = 100 \times \frac{\text{current RMS} - \text{target RMS}}{\text{starting RMS} - \text{target RMS}}
\]

The RMS relates to the fit on the current line only. Also reported are the iteration number and the current epsilon value. The Cancel button or Esc key can be used to halt an inversion if you can see that the model is not changing as you wish or if the inversion has already met your requirements even though the target RMS has not been reached.

At completion of an inversion, a report window is displayed. The messages displayed can be scrolled to review progress of the inversion. Messages indicate the result of an individual inversion run and may report:

The maximum number of iterations has been reached if:

- The RMS threshold was met.
- One or more control parameters have been exceeded and the inversion cannot continue.
- An inappropriate model is being created.

An example of the report window is shown with incremental messages and suggestions to assist the inversion.

Standard Inversion Data Control

The Data button of the Inversion toolbar presents a dialog that reports the data set active for inversion (joint inversion is not yet implemented). If line modelling of either gravity or magnetics is not enabled, the option is greyed out.

ModelVision has the additional capability of performing inversion on data that is derived from an in-line filter by selecting the Use in-line filter check box. This allows you to access the first vertical derivative or in the case of noisy data an upward continuation filter. The same filter is applied to model and line data during the inversion. The tool can be applied to one line at a time.
Note that this method is different from the direct modelling of first vertical derivative data where you have an input channel that has been measured or calculated from a first vertical derivative grid and then resampled onto the line. This inversion is applied to filtered versions of the original data where the same filter is applied both to the model and the data.

**Compress** is a sub-sample factor used to reduce the number of active points. The total number of data points that can be inverted is limited only by computer memory (and can be configured – see Configuring Inversion) but realistically the number of data points should be kept relatively low (600-1000) to make computation times manageable. The initial value is the current setting of the **Model Compression** factor. This value is reset on exiting from inversion.

**Joint Inversion Data Control**

Apart from the compression number, the Data Control is significantly different to that used for standard inversion. You cannot switch between gravity and magnetic modelling in this control, it must be done from the **Model>Line Control** dialog. Note also that if both gravity and magnetic data is active in this dialog, then the **Joint Inversion Channel Selector** dialog will automatically select the magnetic method.

Check boxes allow you to select as many channels as you have data, however it is important that you select channels that are appropriate. For example Bx, By, Bz could be used for three component fluxgate magnetometers, Bxx, Byy, Bzz … for a full tensor magnetometer, dTdx and dTdy for a cross-wing total field gradiometer. Use the pull down list to match the computed channel (Bx, Bxx etc.) with a measured data channel.

A # button appears at the head of the tensor group which is used to search the data channel names for appropriate matches. For example a data channel name of rBxx would automatically map to Bxx.
The **Set Tracks** button makes it easy to display all the joint inversion data channels in auxiliary tracks above the primary section view because their display cannot be configured from the **Model>Line Control** menu. If you have multiple cross-section views open, then you can select them from the pull down list beside the **Set Tracks** button prior to the display of the auxiliary tracks.

---

**Example application of the set tracks button for the cross-wing gradiometer data example.**

### Using Joint Inversion for Single Channel Data

The joint inversion engine has more advanced convergence management than standard inversion and has some advantage for resolving multiple parameters during inversion. A good example is the simultaneous resolution of dip, geometry and resultant magnetisation during inversion.

You may consider using single channel joint inversion for total magnetic intensity, gravity of the magnetic components Bx, By, Bz each of which may be offset from zero by a DC regional field. Any higher order regional fields such as first or second order must be removed from the data prior to inversion, but often a residual DC offset remains that needs to be managed during inversion. The **Offset** data entry field is activated by ticking the checkbox next to the component selector.

The joint inversion engine has been updated to allow a floating offset or a manually controlled offset as shown in the figure below.
The data channel dialog provides a float option for joint inversion.

To adjust the DC regional during inversion check the Float check box next to the data channel. You can also activate or deactivate the DC regional in the inversion toolbar. When deactivated, it will use the last value derived from inversion or entered manually in the data channel selection dialog.

Configure Standard Inversion
This dialog controls the mechanism of inversion. Default settings for these controls are quite robust and rarely need to be changed. You should be well practiced in inversion before changing these settings.

- **Derivative scaling** adjusts the perturbation of the model parameters so that each parameter has a similar influence in varying the model response. The default setting is to have derivative scaling on and it should only be switched off if it appears that it is not working correctly for that model or to investigate absolute sensitivity to model parameters. If an inversion does not converge or is only converging slowly and you suspect that it is a derivative scaling problem, you can set some parameters inactive to investigate if the inversion can converge.

- **Maximum iterations** defines the number of iterations before inversion is automatically halted. This setting is of minor significance as you can intervene at any stage to stop an inversion. You can again restart an inversion with a single click on the Run button. To step through an inversion progressively you can set the maximum iterations to 1 or set it to an arbitrarily high number so that inversion proceeds if you need to leave the computer for a while.

- **Epsilon** is a measure of how much each model parameter is perturbed in the inversion. The epsilon value is initially determined by derivative scaling and is amended during the inversion to provide a variable focus on the parameter space. **Maximum epsilon** increase is a limit on the proportional increase of this value during inversion. If the epsilon factor reaches this limit, the inversion indicates this (by an audible beep if enabled) and the parameter is automatically fixed since it can no longer take part in further processing. The **epsilon factors** $/\text{ and } x$ are the scaling factors by which the epsilon value is revised during the inversion.

Once a successful step is made in improving the model the epsilon value is reduced by the divisor $/$ to tighten the search for the next improvement. If a cycle of tests does not find an improvement for the model, the epsilon value is increased by the multiplier $x$ to search for a solution in a wider parameter space. These divisor and multiplier values control the rate of convergence of an inversion and its ability to escape from local minima.

If you have problems with an inversion, you can experiment by changing these values, but the consequences of making changes are difficult to predict and optimum settings must be determined empirically for each individual inversion. Changes to the epsilon factors are usually a last resort if manual adjusting of the model or changing the selection of free parameters does not enable an inversion to converge.

- **Maximum Data Points** defines the upper limit of observations that are inverted in ModelVision. The maximum sets an upper limit that restricts computation time for inversions. Theoretically, no limit is placed on the number of readings that can be inverted, but as this number increases, the time for processing of the inversion increases. In practice, keep the upper limit to be within 600-1000.

- **Maximum Free Parameters** is similar to the maximum number of data points. The greater the number of allocated parameters, the larger the computation time of an inversion.

- **Default Target RMS** is the value for Target RMS used at the start of each inversion session. The additional controls determine what happens when inversion attempts to take a parameter beyond one of its limits. The **Beep** default setting advises that a limit has been reached. For greater intervention in the inversion, you can choose **Fix parameter** or **Stop inversion** to indicate if a limit is reached.
• **Minimum Length** defines the minimum dimension of a spatial parameter such as width, length, depth extent or radius.

• **Message Level** defines the level of information provided in the Inversion Report window. As an inversion progresses, status information is displayed in a report window. No messages are provided if the level is set to 0. Full, informative messages are provided if the level is 3.

**Configure Joint Inversion**

This dialog controls the mechanism of inversion. You should be well practiced in inversion before changing these settings.

• **Damping** selects the style of damping factor (*Pratt and McKenzie, 2009*) that is used to control the parameter steps during inversion. **Parabolic** allows the inversion to search a wide parameter range and helps avoid local minima. It is usually best to start with this option. **Quasi-linear** forces a much narrower parameter range and is often faster to converge, when your model is approaching a good match.

• **Max iterations** defines the number of iterations before inversion is automatically halted. A small number is best when starting a complex model, but as the model gets closer to a match, it can be beneficial to increase the number of iterations. You can again restart an inversion with a single click on the **Run** button. To step through an inversion progressively you can set the maximum iterations to 1.

• **Maximum Data Points** defines the upper limit of observations that are inverted in ModelVision. The maximum sets an upper limit that restricts computation time for inversions. Theoretically, no limit is placed on the number of readings that can be inverted, but as this number increases, the time for processing of the inversion increases. In practice, keep the upper limit to be within 600-1000.
• Maximum Free Parameters is similar to the maximum number of data points. The greater the number of allocated parameters, the larger the computation time of an inversion.

• Default Target RMS is the value for Target RMS used at the start of each inversion session. The additional controls determine what happens when inversion attempts to take a parameter beyond one of its limits. The Beep default setting advises that a limit has been reached. For greater intervention in the inversion, you can choose Fix parameter or Stop inversion to indicate if a limit is reached.

• Minimum Length defines the minimum dimension in metres of a spatial parameter such as width, length, depth extent or radius.

• Show Intermediate Models allows the inversion engine to update the cross-section display for each model that it generates during an inversion run.

• Minimum Length defines the minimum dimension of a spatial parameter such as width, length, depth extent or radius. The ms delay provides a pause between display updates to allow time for the observer to absorb the visual change.

• Sec Timeout provides an interrupt that cancels the inversion engine run, if it takes longer than the designated time in seconds.

Free Parameters in Inversions

All model parameters in ModelVision by default are initially set as fixed (that is, they do not vary during an inversion). Inversion cannot proceed until some model parameters have been set free to vary. The Free Parameters dialog is displayed if the Free button is clicked in the Inversion toolbar. The Select Bodies entry at the top of the dialog indicates which body is selected. The default selection All allows parameters to be selected and deselected for All bodies. Individual bodies can be selected from the drop-down list or by clicking on that body in the window active for inversion.

Parameters that are not relevant for the current body selection are greyed out.
Inversion behaviour is different for single and multiple lines and the behaviour of the Free Parameters dialog changes between standard and joint inversion. In the single line case where only one line is active for modelling, the position of bodies and vertices is based on the Distance along the line rather than the X and Y values. This is true for both the standard and joint inversion modes. This restriction ensures the bodies only move parallel to the line. The regional field is also computed as a function of distance.

When multiple lines are active for standard inversion, the X and Y parameters can be freed during the inversion. The regional polynomial is also computed from the X and Y locations. This means that a body can roam anywhere across the map. In the case of joint inversion, you can also constrain the bodies to move backwards and forwards along the line direction even if inverting on multiple lines. The Mode button is used in Joint Inversion to toggle between the Distance and X,Y methods, but is not required for Standard Inversion.

The following table lists the behaviour of the Free Parameter dialog depending upon the inversion engine. Clearly the joint inversion is more flexible and the ability to constrain the inversion direction across multiple lines provides a powerful capability for studying property changes along the length of a long geological target.

<table>
<thead>
<tr>
<th>Line Mode</th>
<th>Standard Inversion</th>
<th>Joint Inversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single line Distance</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Single line X,Y</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-line Distance(^a)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Multi-line X,Y</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

\(^a\) Multi-line Distance inversion is only available for the tabular body type.

The figure below shows the result of from an inversion of seven dipping tabular bodies across multiple flight lines where the bodies are constrained to move backwards and forwards along each survey line while maintaining the relative positions and azimuth of individual bodies. In standard inversion it would be difficult to achieve this result with X,Y free.
Joint inversion results for 7 tabular body segments constrained to move backwards and forwards in the same direction as the flight lines.

The regional inversion also behaves differently in standard and joint inversion. Standard inversion allows both the dc level and slope to change while joint inversion only allows a dc offset when a single channel is being inverted.

When more than one channel is inverted, the concept of a mathematical regional is replaced by the use of regional bodies. Bodies can be designated as being of type regional in the properties dialog which allows inversion to be restricted to regional, target or all body types. The inversion behaviour is controlled by check boxes in the Free Parameters dialog.

The All button provides a short cut to select or deselect all parameters for the selected body on the dialog and the Reset button is a short cut to deselect the entire list of free parameters including the regional. The Tolerance and List buttons open the Inversion Tolerances and the Inversion Parameters List dialogs respectively. The Cancel button closes the dialog. Note that Tolerances can only be set for standard inversion. The dialog closes automatically if you exit from inversion using the close (X) button at the top of the main Inversion toolbar.

**Inversion Tolerances**

The inversion tolerances are the range by which each parameter is allowed to vary about its current value. The tolerance control dialog is presented if the Tolerance button on the Free Parameters dialog is selected.
The name of the selected body or bodies that the settings apply to is recorded at the top of the dialog. When inversion is opened, default tolerances are applied to all parameter values to give minimum and maximum permitted values. The limits may be inappropriate or you may need to change them if a parameter reaches its limit. To change the limits for a parameter check the respective checkbox, edit the tolerance value if required and click on the Apply button. You can use the All button as a shortcut to enable or disable all checkboxes. The Retain settings checkbox refers to the values displayed in this dialog. If checked on then these values will appear the next time you bring up the dialog, otherwise the former values will appear. These values are retained in memory until ModelVision is closed down. This allows you to load other sessions in the same project without losing the values. The Reset button may be used to reinitialize the values based on the current data. This is likely to produce more reasonable values for the X, Y and Z tolerances.

Inversion tolerance control dialog

Inversion Constraint Parameters Spreadsheet

The List button of the Free Parameters dialog presents each inversion in a spreadsheet. The list of parameters can be scrolled. The spreadsheet shows all model parameters (such as individual body vertices) together with their free or fixed status, minimum and maximum values and the sensitivity of the model output. Note that the sensitivities are provided for guidance only as the absolute values can only be compared between parameters measured in the same units (eg. metres or degrees). Sensitivities are computed at each iteration of the inversion for free parameters only or on demand for all parameters by clicking on the Sensitivities button.
The list of inversion parameters and their individual settings

Except Joint Inversion (see below), the individual parameters can be toggled between free and fixed status by clicking on the respective status cell. The status for a selection of parameters can be set by selecting a block in the status column and using the **Free** and **Fixed** buttons. The minimum and maximum values for parameters can be edited. This list provides greater control than through the **Inversion Tolerances** dialog where the minimum and maximum values can only be set symmetrically about the current value.

In the case of Joint Inversion, individual parameters are either fixed or free and it is not possible to set limits on the parameter values. Sensitivities are managed automatically in Joint Inversion by constraining parameters that have little influence on the computed model.

The minimum and maximum constraints are retained after exiting inversion and they are also saved with the session file. This becomes important when working on large projects where you may want to work on the same constraints across multiple sessions or days. You can add or delete bodies outside inversion, but ModelVision will attempt to retain the relevant constraints.

**Setting Vertex Tolerances Graphically**

To assist in editing of polygon vertices there is a link between the currently selected vertex on the spreadsheet and the display of that vertex in cross-section view. The view shows a tolerance box drawn in red around the vertex as in the figure below.
Inversion Parameters

- Body  Type  Status  Value  Min  Max  Sensitivity
- Body x7  596.5  -585  1805  0.0
- Body x8  -2303.2  -2933  -1155  0.0
- Body x6  -2300.7  -4601  -1200  0.0
- Body 21  1047.0  -383  2447  0.0
- Body 22  1011.3  -587  2413  0.0
- Body 23  1411.9  -124  2810  0.0
- Body 24  2872.3  1572  4372  0.0
- Body 25  4188.2  2708  5988  0.0
- Body 26  4853.7  2557  5757  0.0
- Body 27  4661.0  3207  6037  0.0
- Body 28  4867.1  2067  6767  0.0
- Body 29  4053.1  -2653  6453  0.0

Linked spreadsheet selection and vertex tolerances box in a model cross-section window

This tolerance box can be selected and the handles at the four corners of the box can be dragged to new locations. When a handle has been re-positioned you see any changes to the minimum and maximum values for that parameter made in the spreadsheet. The Z values for the vertices are depths. The X values are the horizontal positions perpendicular to the body axis with respect to the reference position of the body. These coordinates are unaffected by the geographic or relative definition modes for the body (as set in the Polygon Edit dialog accessed through the Body properties dialog). The Z values correspond directly to the depth axis on the side of the cross-section window. The X values do not in general correspond to either the geographic X coordinates or to the DIST_ABS distance measure along the profile.

**Note**

You can still manually move a vertex in the cross-section, but the constraints rectangle do not move with it. You must remember to move or edit the constraints box after you move the vertex.

**Remanence Inversion**

Magnetisations that give rise to measured magnetic field anomalies are the vector sum of induced and remanent magnetisations. This magnetisation is called the Resultant magnetisation vector. An induced magnetisation has the same direction as the ambient earth’s geomagnetic field (except in extreme cases of anisotropy or self-demagnetisation effects) but a remanent magnetisation may be in any direction, according to its age and subsequent rotations of the rock carrying it.
Remanent magnetisation is usually ignored in magnetic field interpretation, but only because the relevant information about the remanent magnetisation is unavailable. The failure to correctly incorporate remanent magnetisation effects in an interpretation gives rise to errors in the resulting estimates of the source body parameters (including size, shape, dip and position).

ModelVision has the ability to invert for the remanent magnetisation vector or the resultant magnetisation vector. Our research shows that the resultant magnetisation is innately stable as an inversion parameter and is a property of the geological unit. By contrast, direct inversion for the remanent magnetic vector can produce wildly different directions depending upon the setting of the Konigsberger ratio or magnetic susceptibility.

In addition to inversion, ModelVision has the Remanence Calculator module used for direct estimation of the resultant magnetisation vector. The technique is based upon the magnetic moment method and is discussed in full later in this chapter.

**Remanence as an Exploration Parameter**

The magnetic method is now the most widely employed exploration method used to allow exploration geoscientists to explore the subsurface and extend the limited control provided by drilling and outcrop. It provides a three-dimensional understanding of the subsurface geology that allows geoscientists to build hypothetical models governing more detailed exploration and targeting. This information may be supplemented by lower resolution gravity and superficial remote sensing methods.

The parameter being mapped is the three-dimensional change in magnetic susceptibility. From this one parameter we are able to map geological boundaries, classify rock types, locate structures and determine depth distributions of the properties. The global impact of magnetic mapping on exploration outcomes has led to the successful detection of many world class mineral deposits. The ubiquitous use of the magnetic method tends to downplay its significance in exploration, yet the magnetic method played an important role in the initial targeting of Australian mineral deposits such as Olympic Dam, Ernest Henry and Cannington.

**Geological Parameters from Remote Remanence Detection**

If we can extract remanence as a new physical property in magnetic surveys, we must postulate what new deposits could be found by using both magnetic susceptibility and remanence. If we can detect the existence of remanence in a rock as well as its magnetic anomaly amplitude, this provides information on a range of potentially useful geological parameters.
Events

If a rock can be shown to have a remanent magnetisation as well as an induced magnetisation, then the existence of the remanence is indicative of an event in time. This event could have geological significance in a particular geological context. Something has happened to produce the remanent magnetisation. This may be a chemical, thermal, metamorphic or structural event.

Timing

Remanent magnetisation is the basis for the palaeomagnetism specialization within geophysics and is often seen as an academic part of our profession. Much of the work is focused on the study of changes in the magnetic polar direction over time. The integration of this knowledge with the ability to derive remanence directions in an exploration context will provide a powerful tool for adding new time information associated with detectable remanence events.

Differentiation

Once we can assign a remanent magnetisation to a particular suite of rocks then we have a new tool for improved geological classification. It is feasible that the timing could be used to differentiate similar intrusion, structural and alteration events.

Interpretation Precision

A classic problem in exploration geophysics is the interpretation of dip in the presence of a strong remanent magnetisation that perturbs the magnetic field away from that of the inducing field. If we can determine the direction of resultant magnetisation, then the precision of the interpretation of dip is significantly improved in any modelling exercise. This improvement will translate to complex geological shapes as well.

An Exploration Definition for Remanence

Remanence can be measured directly in the laboratory as a vector with both strength and direction. This however requires collection of fresh, oriented rock core, with sufficient samples to represent the geology despite high variability from centimetre up to kilometre scales. We are aiming for a useful proxy for this expensive and time consuming laboratory process, through a rapid and more cost effective analysis of magnetic field data. This proxy necessarily has some limitations of lower achievable precision, due in part to the superposition of magnetisations induced in the present earth’s field. However, there are also some advantages, for instance in providing remanence estimates at the same scale that we commonly interpret geology.

The total departure angle of the resultant magnetisation vector from the inducing magnetic field vector is a direct indicator of the existence of a remanence event. From this knowledge it is possible to derive or deduce additional geological information. The total magnetisation vector is the vector sum of the induced magnetisation and remanent magnetisation vectors. Useful parameters that can be plotted or displayed in map and 3D include:

- 3D total magnetisation vector symbols
- 2D magnetisation amplitude
- Total angular departure from the inducing field
- Inclination departure
- Declination departure
Physical Expressions of Remanence Maps

- **Dykes**
- **Folded Magnetic Sediments/Volcanics**
- **Intrusive Magnetic Pipes and Diatremes**
- **Alteration Events**
- **Pod**
- **Skarn**
- **Metamorphic Events**

**Dykes**

A change in magnetisation direction along a remanently magnetized dyke is a direct indication of an alteration event affecting part of the dyke. The presence of the alteration event could be useful in identifying nearby prospective host rocks that could be favourable for emplacement of mineralization during the same event. In this situation, the dyke provides evidence of the event rather than the mineralization itself.

![Diagram of change in magnetisation strength and direction in a remanently magnetized dyke](image)

*Diagrammatic view of the change in magnetisation strength and direction that could be detected in a remanently magnetized dyke*

The event may be thermally induced in which case there is a change to the magnetic properties but not magnetite destruction. A fluid invasion may produce magnetite destruction as well as a change in the magnetisation direction.

In a mining engineering context, the event may signal a change in rock competence associated with a hydrothermal event and require special attention to avoid mining hazards and production losses.

A change in the magnetisation direction is likely to be associated with a change in magnetisation amplitude which would most likely be expressed as a reduction in the anomaly amplitude. Such a change is ambiguous because thickness changes and susceptibility changes will produce equivalent results. The addition of a direction change reduces the interpretation ambiguity where a direction change indicates a higher likelihood of an alteration event.

**Folded Magnetic Sediments/Volcanics**

Sediments could have a similar expression and geological application as dykes for the detection of alteration events as shown in the figure below.
A change in magnetisation direction along the trend of magnetic sediments indicates the existence of an event.

Other scenarios are also possible where the change in magnetisation direction is associated with a change in the magnetic minerals. It is possible to have parallel banded sediments where some sediments have different magnetisation directions as illustrated below.

In this situation the explanation could be a difference in magnetic characteristics that have retained a remanence overprint, while others have not. In this scenario, it is possible to postulate different mineral assemblages and magnetizing events. For example pyrrhotite and magnetite/haematite will behave differently during upper greenschist facies metamorphism.

Field reversals during deposition could also be responsible for the cyclical nature of the remanence change.

Granites often exhibit a series of concentric rings that give the appearance of changes in rock chemistry. It is also possible to have an overprint of remanence relating to field reversals during cooling. Differentiation of these two extremes may provide useful insights into the granite and mineralization events.

**Intrusive Magnetic Pipes and Diatremes**

Just as magnetic susceptibility is a differentiator for intrusive magnetic pipes, remanent magnetisation is more so. For small pipes, magnetic susceptibility is difficult to estimate where the diameter of the pipe is less than the distance (depth) from the sensor. However, remanence can still be detected even for very narrow pipes. The precision is further enhanced if it is assumed that the pipe is near-vertical.

The difference in magnetisation direction may indicate a change in the time of emplacement of the pipes or a difference in the rock properties. This form of differentiation will be useful in a range of exploration situations, particularly kimberlite exploration. Grain size differentiation may also be a useful discriminator as the intrusions with fine grain size are likely to have higher remanence Q ratios than intrusions with coarse grained magnetitite.
Alteration Events

Remanently magnetized intrusions that occur within a generally magnetic host such as a granite can produce a well defined magnetic low that has a similar appearance to the magnetic low produced by a non-magnetic intrusion or alteration event. A distinction between these two geological scenarios is possible if we can determine the existence of strong remanence in the magnetic anomaly.

![Illustration of a remanently magnetized intrusion and a non-magnetic intrusion](image)

Pod

A pod of mineralization will have similar expression to an intrusive pipe, but its limited depth extent may mean that the associated magnetic anomaly has clearly recognizable side lobes.

![Remanent magnetisation will produce a distinctive anomaly for a pod shaped deposit](image)

Although it will be possible to detect the resultant magnetisation direction of the pod, with some assumption regarding geometry, it may even be possible to estimate the Koenigsberger ratio and hence the remanent magnetisation vector.

Skarn

A skarn at the edge of a major intrusion may be remanently magnetized and provide an indication of the mineralization styles particularly when it can be related to the host rocks.
Metamorphic Events

Metamorphic events have the potential to change the magnetic properties and remanence characteristics of rocks. There are many situations where tectonic events may bury part of a geological sequence and not another leading to differing magnetic expressions of the same rocks. Analogues of this scenario can be seen along the western margin of the Lachlan Fold belt in the Cobar region of New South Wales, Australia.

A study of the low grade metamorphic rocks, may lead to predictive geological models that can be guided by magnetic exploration principles.

Remanent Inversion

ModelVision allows the remanent magnetisation of any source body to be specified, and from the combination of induced magnetisation and remanent magnetisation a resultant magnetisation is calculated and used to derive the anomalous geomagnetic field arising from the body. If the remanent magnetisation of a body is unknown ModelVision inversion can be used to estimate its strength and direction. There are however two fundamental limitations that must be considered.

Firstly an external magnetic field is a complex function of the source body position, geometry and magnetisation, and non-uniqueness in solving the inverse problem does not allow that those parameters can be jointly recovered with any confidence. ModelVision is able to simultaneously invert on all source parameters, including magnetisation, but it is not recommended that you do this as it is not possible to sensibly discriminate between various sets of source parameters based on different assumed magnetisations if those parameter sets produce almost identical external fields. Inversion is only appropriate to estimate a source magnetisation if the other parameters can be supplied, or alternatively to estimate those other source parameters if the magnetisation is supplied.

The second limitation is that inversion provides the resultant magnetisation, and to resolve this into the correct induced and remanent magnetisations it is necessary to know the strength of the induced magnetisation (that is, to know the susceptibility). If the strength of the induced magnetisation is not known a continuous range of co-planar induced magnetisations of different direction and strength can be postulated to obtain the same resultant magnetisation. In theory this problem also has a unique solution if the Koenigsberger ratio (the ratio of remanent to induced magnetisations) is supplied. However, the Koenigsberger ratio is not a parameter which can be reliably predicted, and so this solution is of little practical value.
Specifying the Remanent Magnetisation

Before you can work with remanent magnetisation in ModelVision it is necessary to enable those computations in the Magnetic Field Parameters dialog (available from the drop-down menu item Model>Magnetic field) or the Body Properties dialog.

Enabling remanence computation in the Magnetic Field Parameters dialog

Once remanence computations have been enabled you are able to enter the remanence properties for any body in the Body Properties dialog. To gain access to the remanence properties first click on the Remanence radio button.

Remanence parameters report in the Body Properties dialog

There are three vectors used to calculate remanence:
• Induced magnetisation
• Natural remanent magnetisation (NRM)
• Resultant magnetisation

Another property called the **Koenigsberger ratio (Q ratio)** is the ratio of the remanent intensity over the induced intensity. A Q of zero means there is no remanent while high values of Q indicate strong remanent.

When specifying the remanent properties in the **Body Properties** dialog, you can enter the remanence intensity, declination and inclination or the resultant intensity, declination and inclination. As you leave a text box after changing a value, the other values are changed to be consistent with the new value. You can therefore use this as a remanence calculator.

You can view a 3D representation of these vectors by clicking the **View** button. This view will show that all vectors are in the same plane with resultant and remanent summing to give the resultant. The surrounding sphere is scaled to the largest vector and the projections of all vectors onto this sphere are shown as dots of the same colour are the vector. A black vector shows the location of the north pole (Dec=0, Inc=90) and a grey dot shows east.

Recalculation of the properties includes the Koenigsberger ratio (Q ratio). For example, once a value is entered for intensity the Koenigsberger ratio (Q ratio) is calculated. As an alternative to entering the remanence intensity you can enter the Koenigsberger value, and the remanence intensity is calculated.

Once a remanent magnetisation has been entered for a body that remanence is incorporated with the induced magnetisation into a resultant magnetisation which is used in the magnetic field computations.

**Inverting on Resultant Magnetisation**

Inversion on the resultant magnetisation vector is preferred to inversion on the remanence vector, because it is innately more stable and a property of the body. We discovered this characteristic while developing the **Remanence Calculator** L magnetic moment method for estimation of the resultant magnetisation vector. You can then fix Q or susceptibility and determine the remanent magnetisation vector that would give rise to the resultant vector.
A radio button has been added to the **Inversion Free Parameter** dialog shown below that allows you to switch between inversion for resultant magnetisation or remanence. When using the resultant magnetisation option, you should set all three parameters free.

![Inversion - Free Parameter Dialog](image)

**Inverting on Remanent magnetisation**

Once remanent magnetisation has been enabled in the **Magnetic Field Parameters** dialog it is automatically incorporated into inversion computations, and the remanence parameters are available as free variables in the inversion. For the reasons discussed above it is not recommended that remanence parameters be set free in an inversion that also frees many of the other body parameters. Once the magnetisation direction for a body is admitted to be unknown, any results of magnetic field modelling must be acknowledged as being of low reliability. In particular, if remanence properties are to be freed during inversion, the body dip should be locked to be vertical, or to some known regional geological dip value. It is also recommended that the regional field settings are not allowed to vary in the same inversion as the remanence properties.

Inversion of remanence properties allows the intensity, declination and inclination to be varied independently. The Koenigsberger ratio is automatically updated in all cases that the susceptibility and the remanence intensity of a body is varied, either by the user in forward modelling or by ModelVision during inversion. If the magnetic susceptibility and remanent magnetisation intensity are both free to vary in an inversion, the direction of the remanent magnetisation is not uniquely defined, and it will vary with the value of Koenigsberger ratio.
If the Koenigsberger ratio is small, the resultant magnetisation is dominated by the induced magnetisation, and as a result the direction of the remanent magnetisation is poorly constrained. Also, if the remanent magnetisation is nearly parallel, or anti-parallel to the induced magnetisation, the value of the Koenigsberger ratio, and the susceptibility and intensity of remanent magnetisation values will be poorly constrained because of the low sensitivity in separately resolving two magnetisations of similar direction. ‘Soft’ or ‘viscous’ remanent magnetisations acquired in the present direction of the earth’s magnetic field can be represented in magnetic field modelling by an increase in the apparent susceptibility of the body. Furthermore remanent magnetisations which are exactly reverse to the present direction of the earth’s magnetic field and are the cause of ‘reverse’ magnetic anomalies (as are found over Tertiary volcanics in many parts of the world) can be represented by an apparent negative susceptibility.

**Note**

In all cases remanent magnetisation intensity itself should be positive. Any apparent negative remanent magnetisation intensity should be replaced by the equivalent positive value, with its direction rotated by 180 degrees.

**Remanence Inversion Test Session**

The session file `START_TABULAR_REMANENCE.SES`, accessed from `C:\Program Files (x86)\Encom\Mvis 16.0\Examples\`, contains a synthetic model data set for testing inversion with remanence properties as free parameters. The starting body is also supplied as `TAB_REMANENCEualiIAL.TK`, which can be reloaded into the session to return at any time to the initial conditions. If you check the body properties for the starting model (double click on the body to open the **Body Properties** dialog) you should find that it has a susceptibility of 0.01 SI and a remanence intensity, inclination and declination of 100, -20 and 45 respectively. The Q ratio is 2.093.

Change the susceptibility to .002, close the dialog and force a recompute of the field by clicking on the **Recompute** button towards the centre of the main toolbar, or by toggling the Compute mode button (to the left of the **Recompute** button) from red M (for manual) to green I (for immediate). In the map window you will see the red stacked profiles of MAG_MOD diverge from the blue stacked profiles computed from the original model. You can now invert on the remanent magnetisation to find the remanent magnetisation which together with the new induced magnetisation gives an identical resultant magnetisation to that of the original model.

Turn on inversion from the **Tools>Inversion** menu. The Inversion tool should report that you have 970 points active for inversion, and that the current percentage RMS difference between the input and computed channels for those points is 29.4. Click the **Free** button on the inversion toolbar and in the **Inversion**

--- **Free parameters** dialog, enable the inversion of remanent magnetisation intensity, inclination and declination. Click the **Run** button at the bottom on the **Inversion** toolbar. You should see the MAG_MOD stacked profiles change as inversion adjusts the remanent magnetisation.

Note that you can achieve ever closer matches of the input and computed fields by resetting the target RMS value to smaller values and re-running inversion.

When inversion has stopped and you are satisfied with the match again, double click on the body and check the remanent magnetisation details in the **Body Properties** dialog. These should read 127.5, -31.8 and 37.8, with a Q factor of 13.35.
If you reset the susceptibility of the body to .015 SI you should find that the recomputed MAG_MOD stacked profiles again differ from the blue stacked profiles for the original model. Again click the Run button on the Inversion toolbar and inversion should find the new corresponding remanent magnetisation to reproduce the original resultant magnetisation. In this case, the remanent magnetisation values are 87, -8.9 and 50.6, with a Q ratio of 1.21.

In these inversions we have searched for the unique remanent magnetisation to be added to a specified induced magnetisation to give a required resultant magnetisation. This problem has a unique solution. If however you re-run the inversions with the Property parameter (susceptibility) also free to vary the convergence point of the inversion is not precisely predictable because both vectors giving the resultant are free to vary (the induced magnetisation in strength only), and the solution is non-unique. Also you can experiment with inversion to investigate the relationship between remanent magnetisation and other body parameters. For instance if you go to the Body Properties dialog, click on the Spatial radio button and change the body dip from 60 degrees to 20 or 90, you will discover that a subsequent inversion can find quite a close (though not perfect) match to the magnetic field of the original model even across this wide range of body dips, by finding an appropriate remanent magnetisation to compensate for that change of dip.

Clearly from these exercises the simultaneous inversion of all body properties, including remanent magnetisation is ill-posed as the scope for non-unique solutions is considerable.

**Remanence Calculator**

The calculation of remanence information from a magnetic anomaly has been made possible using a method first published by Helbig (1963), where he proposed that you could calculate the resultant magnetisation direction of a remanently magnetized body without having to create a model. While the resultant magnetisation does not allow you to calculation the remanent magnetisation vector or Konigsberger ratio (Q), it does provide a first order indicator of remanence.

From a knowledge of the resultant magnetisation direction, we can calculate other parameters such as:

- Inclination departure angle
- Declination departure angle
- Total departure angle

Large departure angles a director indicators of the existence of strong remanent magnetisation and departure angles greater than 45 degrees indicates that the Q value must be greater than 1. Of course a small departure angle does not mean that the Q value is low as it could be closely aligned with the existing magnetic field.

For a particular rock type, we may be able to make reasoned estimates of the magnetic susceptibility and thus compute the Q value directly for a given model using ModelVision.

Importantly, the initial values calculated by the Remanence Calculator can be used to seed and constrain ModelVision inversion to produce more reliable estimates of dip and geological boundaries.

The Remanence Calculator module in ModelVision is accessed from the toolbar button.
During our research, we have discovered some insights into Helbig’s method that he could not have foreseen as he had no access to modern computing methods at the time of his original work. We have found solutions to problems that make the Remanence Calculator module practical in a wide range of geological situations.

**Theory**

Helbig analysis (Helbig, 1963; Schmidt and Clark, 1998) provides a direct method for the estimation of magnetisation direction from the magnetic field itself. It is therefore a desirable aspect of all magnetic field interpretations, if only to confirm that magnetic anomalies are indeed caused by a magnetisation parallel to the geomagnetic field. Schmidt and Clark (1998) emphasized the value of this analysis and the suitability of present day computational power to apply the analysis and resolve magnetisation direction.

**The Helbig Integrals**

Consider a disturbing magnetic body or magnetic source with uniform magnetisation $J$ centred at $(x_c, y_c, z_c)$ whose anomalous magnetic field is $\Delta B(r) = [\Delta B_x(r), \Delta B_y(r), \Delta B_z(r)]$. Whence Helbig (1963) has shown that the magnetic dipole moment $M = (M_x, M_y, M_z)$ of the disturbing magnetic source may be calculated from the components of the anomalous magnetic field at any point $r = (x, y, z_0)$ in the horizontal plane $z = z_0$. In this instance the three components $M_x, M_y, M_z$ of the zero order magnetic dipole moment $M$ are the first order moments of $\Delta B_z(r)$ about the $x, y$ axes and the first order moments of $\Delta B_x(r)$ and $\Delta B_y(r)$ about the $x, y$ axes respectively. These relations between the zero order dipole moment of the body and the first order moments of its anomalous magnetic field may be expressed through the following double integrals, namely, for the $M_x$ moment we have:

$$M_x = -(1/2\pi) \int_{-\infty}^{+\infty} (x - x_c) \Delta B_z(x, y, z_0) \, dx \, dy \quad (1a)$$

and for the $M_y$ moment we have,

$$M_y = -(1/2\pi) \int_{-\infty}^{+\infty} (y - y_c) \Delta B_z(x, y, z_0) \, dx \, dy \quad (1b)$$

and for the $M_z$ moment we have,

$$M_z = -(1/2\pi) \int_{-\infty}^{+\infty} (x - x_c) \Delta B_z(x, y, z_0) \, dx \, dy \quad (1c)$$

or alternatively

$$M_z = -(1/2\pi) \int_{-\infty}^{+\infty} (y - y_c) \Delta B_z(x, y, z_0) \, dx \, dy \quad (1d)$$

Furthermore and importantly it is also noted that the following pair of integrals are identically zero

$$M_{x,y} = -(1/2\pi) \int_{-\infty}^{+\infty} (x - x_c) \Delta B_x(x, y, z_0) \, dx \, dy = 0 \quad (1e)$$

and also,
In addition to the above expressions, it is noted that the zero order moments of the anomalous magnetic field due to the disturbing body are all identically zero, namely

\[
M_{0,Bx} = (1/2\pi) \int_{-\infty}^{+\infty} \Delta B_y(x,y,z_0) \, dx \, dy = 0 \quad (2a)
\]

and

\[
M_{0,By} = (1/2\pi) \int_{-\infty}^{+\infty} \Delta B_x(x,y,z_0) \, dx \, dy = 0 \quad (2b)
\]

and

\[
M_{0,Bz} = (1/2\pi) \int_{-\infty}^{+\infty} \Delta B_z(x,y,z_0) \, dx \, dy = 0 \quad (2c)
\]

By inspection of equations (1a-1f), it is noted that the magnetic moment \( M \) is completely determined from measurements of a single pair of magnetic field components, i.e. either from \( \Delta B_x(x,y,z_0), \Delta B_z(x,y,z_0) \) or from \( \Delta B_y(x,y,z_0), \Delta B_z(x,y,z_0) \). In practice however a more stable estimator of the vertical component \( M_z \) of the magnetic moment is

\[
M_z = \sqrt{M_{2x}^2 + M_{2y}^2} \quad (3a)
\]

where \( M_{2x} \) and \( M_{2y} \) are given by equations 1c and 1d respectively. Also a further necessary condition for the existence of a reliable magnetic moment is that both integrals in equations (1e) and (1f) are approximately zero, namely,

\[
M_{x,y} \leq M_{x,y,B} \leq 0 \quad (3b)
\]

Other magnetic moment components which can be used are the horizontal moment,

\[
M_h = \sqrt{M_x^2 + M_y^2} \quad (4a)
\]

and the total magnetic moment,

\[
M_T = |M| = \sqrt{M_x^2 + M_y^2 + M_z^2} = \sqrt{M_{2x}^2 + M_{2y}^2} \quad (4b)
\]

Furthermore the declination \( D_m \) and inclination \( I_m \) of the magnetic moment vector \( M \) and also of the magnetization vector \( J \) (since \( J = M/v \) where \( v \) is the volume of the source body) are given by

\[
D_m = \arctan \left( \frac{M_y}{M_x} \right) \quad \text{for } 0 \leq D_m < 2\pi \quad (4c)
\]

\[
I_m = \arctan \left( \frac{M_z}{M_x} \right) \quad \text{for } -\pi/2 \leq I_m < \pi/2 \quad (4d)
\]

It is noted that the above formulae are for the zero order magnetic dipole moment of the disturbing body under the plane \( z = z_0 \) [see Helbig, 1963, p. 84].
Implementation of the Theory

Helbig’s theory requires the calculation of the magnetic field components in the x, y and z directions. This is done conveniently by using the discrete FFT procedure (Blakely, 1995) for transformation of the total magnetic field into the component directions for a finite data window surrounding the data. The components are then integrated numerically as set out in equation 1. These procedures are managed automatically within the Remanence Calculator module.

There are some practical limitations that need to be considered that are not properly covered by the theory. The calculations applied to a finite, rather than infinite window introduce two problems:

• Truncation of the integration and its implications
• The origin of the finite integral calculation for equation 1.

Helbig’s theory requires that the integration take place from minus to plus infinity in the x and y directions (equation 1), which means for a finite window, the integrals will underestimate the amplitude of the magnetic moments. Schmidt and Clark (1998) indicated that the error in the magnetic moment calculation can be as high as 30%. While a correction for the moment could be calculated, this is not entirely necessary if the moment is properly calculated during a ModelVision inversion.

Equations 4c and 4d show how the inclination and declination angles of the resultant magnetic field are calculated from ratios of the magnetic moments. Here the impact of the finite integration area will be similar for the numerator and denominator and this is verified in our experimentation with theoretical anomalies where the numeric values are normally recovered to a precision of around 2%.

The origin of integration is irrelevant according to Helbig’s theory, but in practice we found that the method is sensitive to the choice of origin and thus requires a procedure to be adopted that allows the user to optimize the selection of origin. The origin should be the centre of magnetisation which is equivalent to the centre of gravity and we identify this location by inserting an initial seed model at the centre of the anomaly window drawn by the interpreter. You can then adjust the location of the seed model to the optimum location for the integration and experiment with minor perturbations of the seed to determine the noise levels for the vector calculation.

ModelVision Procedure

The Remanence Calculator works from a total magnetic intensity grid, so the only information you require in addition to the grid is the inclination, declination and intensity of the inducing magnetic field. The process is applied to an individual anomaly, or anomaly group and ModelVision provides a drawing tool to isolate the anomaly.
After you start the Remanence Calculator, you select the anomaly by drawing a polygon around the anomaly as close as possible to avoid interference with other anomalies, but far enough out to be sampling the background magnetic field. In experiments with theoretical datasets, the quality of the computed results was generally better when using a rectangular area rather than a polygonal selection. It is however necessary to use the polygonal method to excise unwanted interference from adjacent magnetic anomalies.

The area that you select is padded to a distance of 25% of the bounding rectangle prior to running the FFT component transform. The minimum curvature method is preferred as the padding method as the error levels are 25% of those returned using the maximum entropy method. Experiments on theoretical datasets indicate that the optimal padding distance is 25% of the bounding rectangle.

The optimum size for the polygonal area is related to the depth of the magnetic material. As a general rule, shallow, near surface magnetic sources should use polygons that are very close to the edge of the anomaly. For deeper targets, it is important to capture the background field area to obtain the best results as this drops off slowly compared with the magnetic anomalies from shallow targets.

**The Remanence Calculator Dialog**

When you start the Remanence Calculator, the dialog shown below will appear and persist for the duration of the session.
Remanence Calculator dialog box showing key features of the resultant vector calculation process.

The following sections explain how the dialog is used to setup the session and then perform a sequence of Helbig analyses on one or more magnetic anomalies.

**Initial setup for Remanence Calculator dialog**

The Grid Processing component of the Remanence Calculator dialog is shown below and this controls your initial identification of the input magnetic grid, FFT parameters, regional adjustment and initiation of the remanence calculation.

Grid Processing controls for the Remanence Calculator procedure.

In Model Mode a body is created at the centre of the drawn area. The location, susceptibility and volume of this body is used to seed the Remanence Calculator dialog.

If the body is edited then the modifications are applied to the Remanence Calculator dialog and parameters may be adjusted in response to the changes.

**Anomaly Analysis Steps**

The following sequence of steps is applied to each magnetic anomaly that you wish to analyse.

1. Under **Grid Processing**, click **Select Area in Map** to define the area of the magnetic grid that will be used in the Helbig calculation.
2. Click **Compute** to apply the Helbig process to the selected region. You may need to wait several seconds while the FFT process is performed in the background and then the dialog will be populated with the results. A body called REMnn will be automatically created automatically at the centre of the polygon. “nn” refers to the anomaly sequence number and is a useful tag to tie specific bodies to the Helbig analysis.

Make sure that you move the body REMnn to where you believe the centre of mass should be positioned. You can experiment with this position and then click **Compute** each time you move the body. Note that REMnn is automatically detected if you come back at a later date to recalculate the specific anomaly. Remanence Calculator looks for a body of name “REM” within the area of the polygon and selects the closest to the polygon centre. If it does not find one, then it will create a new seed model.

3. Under **Helbig Analysis**, review the values returned by the analysis.

![Helbig Analysis Table](image)

The primary information of interest are the **Ires** and **Dres** values—the inclination and declination of the resultant magnetisation vector.

**Theta_res** is the total departure angle of the resultant magnetisation vector from the inducing field direction and a strong indicator of the strength of the remanent magnetic vector. For example if this angle is greater than 45 degrees, then Q must be greater than approximately 0.9. As this angle approaches 90 degrees, then Q is likely to be greater than 10.

4. Under **Derived Parameters**, select the **Show Vectors** check box, and then click **Update** to visualize to resulting vectors. You can rotate the sphere by selecting it with a double mouse click and then drag it around to a preferred view. The projections of the inducing field, remanent, resultant vectors and due north vectors are projected onto the surface of the sphere. The black north arrow shows the north magnetic pole rather than map geographic north.

**Theta_nrm** is the total departure of the remanent magnetic vector from the inducing field vector and **Theta_diff** is the difference in angle between the remanent magnetisation vector and the resultant vector.
5. Experiment with the values under **Model Parameters** by either adjusting the **Q ratio** or **Suscept** (magnetic susceptibility) of the volume. The **Volume** is derived from the seed model generated at the start. If you change the volume of the model REMnn, then the volume appearing in the dialog will update to the model volume and force a change in the magnetic susceptibility value.

By changing the Q ratio value and susceptibility, the remanent vector is recalculated and forces an update to the following parameters:

- **Jnrm** – remanent magnetisation field
- **Inrm** – inclination of the remanent magnetic vector
- **Dnrm** – declination of the remanent magnetic vector
- **Theta_nrm** – is the total departure of the remanent magnetic vector from the inducing field vector
- **Theta_diff** – difference in angle between the remanent magnetisation vector and the resultant vector.
6. To capture your Helbig analysis as a ModelVision in-memory point data set, under Log Result, click a quality button between 1 and 5. Each time you perform this action, the "log result" number is incremented and stored within the point dataset designated by the current "Region" number. The "Region" number is specific to the anomaly and a "Run" number is also incremented each time an analysis is performed, even if it is not logged into the point dataset.

Removal of Regional Magnetic Field

The regional magnetic field should be removed prior to the Helbig analysis, but this is not always practical. If there is any tilt or curvature in the background field that is unrelated to the magnetic anomaly of interest, then the results will be adversely influenced by the regional field. You can apply a minor tilt to the field by adjusting the x and y gradients in the field. When you press "Compute Regional" it will subtract the regional from the field and open a 3D view that shows the magnetic field within the selected polygon and the regional adjustment. You can then adjust the shape of the regional until you are satisfied with the correction.

Export Remanence Results

Each anomaly that you analyse can have one or more Helbig analyses logged to a named point series such as REM_nn. Individual groups or the complete suite of points can be exported to an ASCII csv file for the purpose of editing in Microsoft Excel. You export the points sets from the File>Export>Point Data>Text (.CSV). Once edited, you can use the general ASCII import (File>Import>Point Data>General ASCII) to re-import the points into a single point set for annotation as shown in the figure below. This process is more convenient for annotation than setting up individual controls for each point set.
Annotation of the total departure angle superimposed on the image, original pipe models and REMnn series models. The top row has Q = 0, the middle row has Q = 1 and the bottom row has Q = 10.

The channels and units used in the Remanence Calculator that are exported to the CSV output file are listed in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Easting</td>
<td>m</td>
</tr>
<tr>
<td>Y</td>
<td>Northing</td>
<td>m</td>
</tr>
<tr>
<td>Z</td>
<td>Elevation</td>
<td>M</td>
</tr>
<tr>
<td>region</td>
<td>Region number</td>
<td></td>
</tr>
<tr>
<td>run</td>
<td>Run number</td>
<td></td>
</tr>
<tr>
<td>log</td>
<td>Log number for this Region</td>
<td></td>
</tr>
<tr>
<td>quality</td>
<td>User defined quality when Logged</td>
<td></td>
</tr>
<tr>
<td>errEst</td>
<td>Normalized error estimate from Mx and My</td>
<td>%</td>
</tr>
<tr>
<td>moment</td>
<td>Total magnetic moment</td>
<td>Am²</td>
</tr>
<tr>
<td>volume</td>
<td>Volume estimated from the seed body</td>
<td>m³</td>
</tr>
<tr>
<td>suspect</td>
<td>Assigned or computed magnetic susceptibility (depends on MV Project settings)</td>
<td>cgs/ SI</td>
</tr>
<tr>
<td>Q</td>
<td>Konigsberger ratio</td>
<td></td>
</tr>
<tr>
<td>Jind</td>
<td>Induced magnetisation</td>
<td>nT</td>
</tr>
<tr>
<td>lInd</td>
<td>Inclination of the induced magnetic field</td>
<td>deg</td>
</tr>
<tr>
<td>Dind</td>
<td>Declination of the induced magnetic field</td>
<td>deg</td>
</tr>
<tr>
<td>Jnrm</td>
<td>Remanent magnetisation</td>
<td>nT</td>
</tr>
<tr>
<td>Inrm</td>
<td>Inclination of the remanent magnetic vector</td>
<td>deg</td>
</tr>
</tbody>
</table>
Work Tips

This section covers useful hints regarding the use of the Remanence Calculator technique on different problems.

- **Sample Synthetic Dataset**
- **Model Parameters**
- **Aspect Ratio**

Sample Synthetic Dataset

A synthetic Remanence Calculator dataset is supplied for training purpose using the same grid and models that are illustrated above. Data for the example shown above can be found in the folder for tutorial 14 “Tute14 Remanence from Magnetic Moments”. This includes three rows of intrusive pipes where the properties are set out in the table below.

<table>
<thead>
<tr>
<th>Row</th>
<th>Susceptibility cgs</th>
<th>Q</th>
<th>Inrm</th>
<th>Dnrm</th>
<th>Ires</th>
<th>Dres</th>
<th>thetaRes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.000796</td>
<td>0</td>
<td>-60</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>2</td>
<td>0.000796</td>
<td>1</td>
<td>0</td>
<td>90</td>
<td>-37.8</td>
<td>63.4</td>
<td>45.0</td>
</tr>
<tr>
<td>3</td>
<td>0.000796</td>
<td>10</td>
<td>0</td>
<td>90</td>
<td>-4.9</td>
<td>87.1</td>
<td>84.3</td>
</tr>
</tbody>
</table>

The first row has no remanence, row 2 has a Konigsberger ratio of 1 and row 3 is set to 10. For rows 2 and 3 the remanent vector is horizontal and pointing to the east. The last three columns show the theoretical results that you should recover from the Helbig analysis for the inclination, declination and total departure angle of the resultant magnetisation vector.

The following files are supplied for test purposes:

- `Remanent pipes D90 i00.grd` (total field grid in Geosoft format)
- `Remanent pipes D90 i00.tkm` (ModelVision model with variable remanence properties).

Note that the model field parameters are as follows:

60000 magnetic field intensity
Model Parameters

While it is not possible to directly calculate the remanent magnetic vector with the Helbig method, you can experiment with the process and use geological inference to gain more insight into the interpretation of specific anomalies. If you know two out of the following three parameters, then you can estimate the third:

- Volume
- Susceptibility
- Q ratio

Once you model an anomaly, then you have a reasonable quality estimate of its volume. We recommend that you limit the depth extent to approximately twice the depth to the top of the model as it is unlikely that the Helbig method to see the influence of magnetic material beyond this depth.

If you have been working in a specific terrain for some time you may be able to deduce the probable value of the magnetic source based on its geological setting. This will then give you an estimate of the Q value and hence the remanent magnetisation direction.

The interaction between the parameters in the “Model Components” segment of the Remanence Calculator dialog is detailed in the table below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change k with fixed V</th>
<th>Change Q with fixed V</th>
<th>Change V with fixed k</th>
<th>Change Q with fixed k</th>
<th>Change V with fixed Q</th>
<th>Change k with fixed Q</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jind</td>
<td>changes</td>
<td>changes</td>
<td>-</td>
<td>-</td>
<td>changes</td>
<td>changes</td>
</tr>
<tr>
<td>V</td>
<td>-</td>
<td>-</td>
<td>edit</td>
<td>changes</td>
<td>edit</td>
<td>changes</td>
</tr>
<tr>
<td>k</td>
<td>edit</td>
<td>changes</td>
<td>-</td>
<td>-</td>
<td>changes</td>
<td>edit</td>
</tr>
<tr>
<td>Q</td>
<td>changes</td>
<td>edit</td>
<td>changes</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Jnrm</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td></td>
</tr>
<tr>
<td>Inrm</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Dnrm</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jres</td>
<td>-</td>
<td>-</td>
<td>changes</td>
<td>changes</td>
<td>changes</td>
<td></td>
</tr>
</tbody>
</table>

The table indicates the effect of fixing one of the three check boxes, Volume, Suscept or Q ratio and altering the value of one of the other two parameters. For example, changing the geometry of the seed body causes a change in volume while the Volume check box is on will have the effect of scenario 3 in the table.

Aspect Ratio

When the aspect ratio of the pipe axes exceeds 5 – 6, the quality of the declination and inclination calculations degrade because the anomaly is beginning to look like a dyke. That is it looks like a 2D rather than 3D source.

While the information is degraded, it is still useful as a guide to use for inversion and you can apply the technique to dykes by using the polygon selection to select a part of the dyke anomaly. No systematic tests have yet been applied to this class of anomalies.
Joint Inversion

Magnetic instruments such as cross-wing gradiometers, vertical gradiometers and full tensor SQUID magnetometers presented challenges for geological interpretation and geophysical inversion. In particular, the full tensor magnetometer presents many new challenges for an interpreter where only the vertical derivative of the vertical magnetic component presents a useful geological analogue for visual interpretation. With six channels of information how do we make practical use of the other five channels which implicitly contain useful information about the 3D distribution of magnetic properties?

Joint inversion of all six channels is the logical solution whereby the data is inverted directly to a 3D magnetic susceptibility model. When compared with the scalar amplitude of the total magnetic intensity measurement, the magnetic tensor has valuable 3D information. For example just a few samples can provide sufficient information to immediately determine if an igneous pipe is on the left or right side of the flight line. A few more samples can locate the position and depth of a pipe that is off to the side of a flight line.

Joint inversion can be used with various combinations of sensors and derived parameters. For example a cross-wing total magnetic field gradiometer can be used with the centre point total field value to derive important off-line geological information. The first vertical derivative derived from gridded data can be combined with total magnetic intensity measurements for two channel joint inversion to optimize the quality of depth, width, dip and depth extent inversions.

In standard inversion, bounds constraints can be applied to limit the range of a free parameter, but this is not possible for joint inversion. A body parameter can only be free or fixed.

Examples are provided to illustrate the improvement in geological information extraction when compared with single channel inversion of total magnetic intensity data. The methods provide new opportunities to look at the latest generation of instruments and new ways to look at old surveys.

Joint Inversion Limits

Joint inversion has some internal limits on the number of bodies, free parameters, channels, and data that you can use.

<table>
<thead>
<tr>
<th>Limit</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>Bodies</td>
</tr>
<tr>
<td>16</td>
<td>Map polygonal bodies (not cross-sections)</td>
</tr>
<tr>
<td>800</td>
<td>Total free parameters across all bodies in model</td>
</tr>
<tr>
<td>8</td>
<td>Joint data channels</td>
</tr>
<tr>
<td>2048</td>
<td>Data points per channel</td>
</tr>
<tr>
<td>100</td>
<td>Vertices per map polygon shape</td>
</tr>
<tr>
<td>1440</td>
<td>Facet per map polygon or polyhedron</td>
</tr>
</tbody>
</table>

Note that:

- Horizontal polygonal bodies are not supported for joint inversion
- Distance based multiple data line inversion is limited to tabular bodies.
Theory

Our current implementation of joint inversion limits the problem to cover measurements from multiple sensors at a series of x, y, z locations where all data channels are available at each location. The algorithm does not presently support simultaneous inversion for multiple physical properties, although this can be done cooperatively by using the same model sequentially. The following section provides a brief overview of the theory behind our joint inversion algorithm development.

In the context of this paper, the joint inversion of multi-channel magnetic or gravity data is a constrained, cooperative, parametric non-linear inversion of fully overlapping data sets $d_{\text{obs}}=(d_1, d_2, ..., d_{N\text{chan}})^T$ gathered simultaneously at $N_s$ observation points $r_1, r_2, ..., r_{N_s}$. Each channel $(j)$ contains $N_s$ data points so that $d_j=(d_j(r_1), d_j(r_2), ..., d_j(r_{N_s}))^T$. Hence for all the $N_{\text{chan}}$ data channels there are a total of $N_d=N_sN_{\text{chan}}$ data observations, i.e.

$$d_{\text{obs}} = d_j(j=1,N_{\text{chan}}) = d_1 \cup d_2 \cup d_3 \cup ... \cup d_j \cup ... \cup d_{N_{\text{chan}}}$$

From a statistical viewpoint, the set of $N_d$ data observations $d_{\text{obs}}[1:N_d]$ are considered to be incomplete and insufficient with standard errors $\sigma_{d}[1:N_d]$. Whence the non-linear inverse problem may be stated as follows: given a forward modelling function $f(m; \{r_j\})$ containing $N_p$ model parameters $m=(m_1, m_2, ..., m_{N_p})^T$, then find an optimum solution vector $m_{\text{best}}$ such that the total standardized residual squared error $Q_d(m)=||e_d||^2$ is minimized subject to some constraints on the physical reliability of the model parameters themselves. In this instance the objective function or functional $Q_c(m)$ to be minimized is:

$$Q_c(m) = Q_d(m) + \mu Q_m(m) = [e_d^T, e_m] + \mu([e_m^T, e_m]) = ||e_d||^2 + \mu ||e_m||^2$$  (1)

where $Q_d(m) = ||e_d||^2$ is the measure of the data misfit (the $L_2$ norm); $Q_m(m) = ||e_m||^2$ is a measure of the relative change in the model parameters and $\mu>0$ is a Lagrange multiplier. The objective function $Q_c$ may be further expressed as:

$$Q_c(m) = [d_{\text{obs}}-f(m; \{r_j\})] / \sigma_{d} = \frac{1}{\sigma_{d}} ([d_{\text{obs}}-f(m; \{r_j\})] / \sigma_{d}) + \mu \left[ x_s^T x_s - R_0^2 \right]$$ (2)

where $y = e_d = [d_{\text{obs}}-f(m; \{r_j\})] / \sigma_{d}$ is the $(N_i x 1)$ column vector of standardized errors between the observed and modelled data measurements; $e_m^T$ is the transpose of $e_d$; $x_s = x_{s}\{j\}[1:N_p]$ is the scaled parameter step length vector and $R_0^2$ is the maximum bound placed on the energy level $x_s^2 x_s$ of the scaled parameter changes. The $Q_d(m)$ and $Q_m(m)$ functionals are computed as:

$$Q_d(m) = e_d^T e_d = \|e_d\|^2 = \sum_{i=1}^{N_d} y_i^2 = \sum_{i=1}^{N_d} \left[ \frac{d_{\text{obs}[i]} - d_{\text{mod}[i]}}{\sigma_{d[i]}} \right]^2$$ (3a)

and

$$Q_m(m) = e_m^T e_m = \|e_m\|^2 = \sum_{j=1}^{N_p} x_j^2 = \sum_{j=1}^{N_p} \left[ \frac{\delta m_j}{s_j} \right]^2$$ (3b)

where $s_j$ is the scaling factor for the $j$th parameter step $\delta m_j$. 
Ridge regression or the Marquardt-Levinburg method provides a stable method of solving the non-linear equation $B_{obs} = f(m_0; \{r_i\}) + e$ for an optimum $m_{\text{best}}$ such that the objective function $Q_L(m)$ is minimized. Ridge regression is essentially a constrained inversion method in which the step length $||\Delta m||$ of the solution vector $\Delta m$ is kept within physically realizable limits.

To apply the ridge regression method, we first convert this non-linear inversion problem into an approximate linear form by expanding the response or forward modelling function $f(m; r_i)$ in a Taylor series about an initial starting point $m^0$, namely,

$$f(m) = f(m^0) + \Delta m + O(||\Delta m||^2) \quad (4)$$

where $\Delta m = m - m^0$ and $A$ is the Jacobian or gradient matrix of partial derivatives of $f(m; r_i)$ with respect to each of the model parameters $m_j$, namely, $A_{ij} = \left(\frac{\partial f_i(m; r_i)}{\partial m_j}\right)$. Whence it may be shown (Meju, 1994) that the objective function $Q_L(m)$ in equation (2) is now:

$$Q_L = Q_d + \beta^2 Q_p = [y - Ax_s]^T[y - Ax_s] + \beta^2 [x_s^T x_s - R_0^2] \quad (5)$$

where $\beta^2 > 0$ is the ridge parameter or Lagrange multiplier $\mu$. The scaled least squares solution vector $x_s$ is found by expanding equation (5) and then differentiating the resulting expression with respect to $x_s$. Finally setting $\frac{\partial Q_L(m)}{\partial x_s} = 0$, we obtain the least squares solution for the scaled model parameter perturbation $x_s = \Delta m$:

$$x_s = (A^T A + \beta^2 I)^{-1} A^T y \quad (6)$$

Whence the new model $m_{k+1} = m_k + \Delta m_k$ is given by the relation:

$$m_{k+1} = m_k + s^{-1}(A^T A + \beta_k^2 I)^{-1} A^T y \quad \text{for } k = 0, 1, 2 \quad (7)$$

where $s^{-1} = \text{diag}(1/s_j)$ for $j = 1:N_p$ is a diagonal matrix of inverse scaling factors; $\beta_k$ is the optimum ridge parameter for the $k^{th}$ trial model step $\Delta m_k$ and $m_k$ is the vector of model parameters from the previous ($k^{th}$) iteration.

One means of accurately estimating the model parameters $m_{k+1}$ as well as investigating their sensitivities during the course of the inversion is via the use of singular value decomposition (SVD) of the Jacobian matrix $A$ or, in the case of joint inversion, its scaled and weighted equivalent $A_s = W A s^{-1}$ (for $W = 1/\sigma_d = \text{diag}(1/\sigma_{d(i)}); i = 1:N_d$). For example, the singular value decomposition of the $(N_d \times N_p)$ matrix $A_s$ is [see Menke, 1989; Press et al, 1992]

$$A_s = U \Lambda V^T \quad (8)$$

where $U$ and $V$ are the $(N_d \times N_p)$ and $(N_p \times N_p)$ column orthonormal matrices for the data space and parameter space respectively, i.e. $U^T U = I$ and $V^T V = I$, and $\Lambda$ is the $(N_p \times N_p)$ diagonal matrix of singular values $\lambda_i [1:N_p]$. In terms of the singular value decomposition of the scaled and weighted Jacobian or sensitivity matrix $A_s$, the solution vector $x_s[1:N_p]$ of scaled parameter steps is now computed as (Menke, 1989; Meju, 1994)

$$x_{s[i]} = v_i \Lambda_3 U^T y \quad \text{for } i = 1, 2, \ldots, N_p \quad (9)$$

where $v_i$ is the $i^{th}$ row vector in the right-side $V$ matrix and $\Lambda_3 = \text{diag}(\Lambda_{3(i)})$ is the diagonal matrix of damping factors $\Lambda_{d(i)}$ for the ridge regression defined as:

$$\Lambda_{d(i)} = \lambda_i / (\lambda_i^2 + \beta_k^2) \quad \text{for } i = 1, \ldots, N_p \quad (10)$$
where $\beta_k$ is the ridge parameter for the $k^{th}$ trial model step and $\lambda_i$ is the $i^{th}$ singular value.

The symmetrical $(N_p \times N_p)$ covariance matrix $C = C_{ij} = \text{cov}[x_i, x_j]$ is calculated using the relation [see Press et al, 1992, p.671]

$$c_{ij} = \text{cov}[x_i, x_j] = \sum_{k=1}^{n_p} \gamma_k^2 V_{ik} V_{jk} \quad (11)$$

where $\gamma_k = 1/\lambda_k$ for $\lambda_k \neq 0$ and $C_{ij} = C_{ji}$, from which estimates of the variances $\sigma_m[i]^2[1:N_p]$ are obtainable as the diagonal elements $C_{ij}$ of the covariance matrix $C$.

A major advantage of singular value decomposition over other matrix inversion or decomposition techniques, is that SVD enables the user to diagnose and rectify situations where the matrices $A$ and $\lambda$ are singular, i.e. when any $\lambda_k = 0$, or from a numerical standpoint, where any $\lambda_k \approx 0$. This latter situation in which $\lambda$ is ill-conditioned may be tested using the inequality

$$\lambda_k < \max(\lambda_k) \varepsilon_w \quad \text{where} \quad \varepsilon_w = N_p \varepsilon_m$$

and $\varepsilon_m$ is the machine accuracy or zero tolerance which is about $1.18 \times 10^{-7}$ for positive floating point numbers in standard IEEE representation (Press et al, 1992). Therefore in situations where $A$ is deemed as ill conditioned, the ridge parameter $\beta$ should be made sufficiently large so as to ensure that the parameter perturbation in equation (9) remains physically realizable and has not jumped outside the linear range.

Performing an Inversion

- **Selecting the Data**
- **Selecting Free Parameters**
- **Controlling Parameter Variation**
- **Running the Inversion**

Selecting the Data

Inversion is a highly intensive computation. It is worthwhile spending some time to restrict the computations to as few bodies and as few stations as required. When focussing on one area you may be able to delete or set distant bodies inactive so that they have little influence on the area of focus. You can also make inactive any lines that do not pass through the area of interest and use active point selection to window out those parts of any lines that are only partly within the anomalous area. The number of data points active for an inversion is displayed on the Inversion toolbar. Inversion does not run unless this number is less than that defined in the Inversion Configure option.

There are three approaches to reducing the number of points that are active for inversions:

1. You can use active point selection to clip the geographic extent.
2. You can reduce the number of active lines.
3. You can sub-sample the data points on the active lines.
None of these selection methods is specific to inversion and they are explained in other sections of this manual. For convenience, the utility for sub-sampling data is also made available through the Data button on the Inversion toolbar. The only difference from sub-sampling from the Inversion toolbar and with the Model>Data Compression utility on the main menu is that the sub-sampling in inversion is reset when the inversion is closed. The degree of sub-sampling you can use depends on the degree to which the steepest gradients of the field are over-sampled by the available data points. For large and complex inversions you may need to use a combination of these methods. As you change your selection of points the new total of active points is reported on the toolbar.

Selecting Free Parameters

You can set free any model parameters for inversion but with a summed total less than specified in the Configure Free Parameters setting. When first activated, the Inversion – Free Parameters dialog reports All as the body selection. With this setting you can select a parameter and all instances of that parameter for all bodies in the model are set free to vary. If, for instance, you have 6 bodies and set depth and property free with the All bodies option displayed, the number of free parameters reported on the inversion toolbar is 6x2=12. You can free parameters for individual bodies by first selecting that body in the active map or section window or by selecting it by name from the drop-down menu on the dialog.

Selecting the List button in the centre of the Inversion toolbar displays the list of model parameters (see Inversion Constraint Parameters Spreadsheet). This list reports all parameters of the model, their current status (free or fixed), and their value range in an inversion. You can toggle the status of the variables in the list to select or deselect them and you can also edit the current, minimum or maximum values.

Controlling Parameter Variation

It is important to limit the range of each free parameter. Initial minimum and maximum values are set by addition and subtraction of a default tolerance (1000 metres for most spatial parameters). In the Inversion Tolerances dialog, you can reset tolerances and, after changes have been made to the model, you can re-centre the permitted range for variables about their current value. For more precise control of the permitted range of variables you can use the Inversion Constraint Parameters Spreadsheet to set minimum and maximum values independently for any parameter. For example, you may want to use this spreadsheet to ensure that the depth to any model vertex is not permitted to rise above the ground surface by setting all minimum depths greater than the ground surface depth value.

Note that physical properties are allowed to take negative values. Negative properties may be meaningful. Negative density contrasts are normal in gravity modelling. A negative susceptibility often indicates the existence of remanence. If however negative properties are not meaningful, you should set the minimum limit on property for each body at or above zero.

Also note that freeing both the X and Z vertices in polygonal bodies can lead to geologically inappropriate body shapes although the inversion may satisfy the response criteria. In most instances, for example if modelling a layered horizon, it is normal to very the Z (depth) vertices only.
Running the Inversion

Once you have selected the data points and free parameters, you are ready to start the inversion using the Run button at the bottom of the Inversion toolbar. A progress bar reports the number of iterations and the percentage progress. As the model changes it is updated in all open windows so you can monitor the changes and intervene if necessary by stopping the inversion with the Cancel button. You may change the model or the inversion parameters and re-initiate the inversion. If inversion has caused some undesired changes to the model, selecting the Revert button returns the model to its starting condition before the previous inversion run. As the inversion saves only a single previous situation, it is sometimes appropriate to save either session or model files in case the inversion follows an undesirable course.

It is possible that some inversion predictions could produce an invalid body or be insensitive to a free parameter. In such cases, a message is displayed. There is unlikely to be any action required as ModelVision has taken appropriate steps when these inconsistencies are deleted.

During an inversion, an Inversion Report window is displayed. Messages appear in this window as the inversion progresses. The content of the messages is determined by the Message Level (see Configure Standard Inversion). Messages contained in the Inversion Report window can be scrolled up and down to view their content.

Messages displayed during an inversion run

At the end of an inversion two possible messages appear. If the maximum number of iterations has been reached, the inversion has terminated before reaching the required RMS value. This break provides a convenient occasion to consider making any changes to the model or the inversion parameters before continuing with the inversion. If the inversion has been unable to find an improvement to the model it stops and you need to either edit the model manually or reset the inversion parameters before proceeding further.

Once you start an inversion it is easy to confuse the ModelVision directive to minimize RMS difference with your objective of developing an acceptable model and testing geological hypotheses. A good RMS fit does not mean that you have a correct geological model. It means you have a good fit between the response derived from your model to the observed data. Inversion is a tool that should be used to accelerate the rate at which you can test your geological models, rather than a tool that is used to derive geology.
Page Layout

One of the most important aspects of operating ModelVision is to produce report-quality hard-copy of results. This section describes the operation of the Layout window. The Layout window provides an interactive tool for combining various ModelVision displays, annotating them and printing hardcopy in a form directly useful in reports and interpretations. The annotation tools can even be used for drawing sketch interpretations which can be plotted out.

In this section:
- The Layout Window
- Creating a New Layout
- Setting Page Size
- Adding Map Frames
- Changing Layout Properties
- Adding Text and Drawing Objects
- Saving a Layout

For information on generating the hard-copy output, see Printing.

The Layout Window

The layout window allows you to composite the displays of other windows for presentation. By creating a layout display you can:
- Plot one or more map, X-Section or perspective views on a single sheet of paper
- Add titles and other text to your printed maps
- Add your own graphical elements such as polygons, polylines, rectangles etc.
- Move and/or modify inserted text such as body names and title blocks
- Modify colours and line styles of annotation, lines etc.

Once created, the Layout window simulates a piece of paper on which you can place copies of graphical displays, annotations, text and graphical items. The size of the paper is initially set in a dialog when the display window opens with the initial default taken from the page setting of the default window’s print driver.

Windows placed in the Layout, retain the attributes of the source display. This means that as you alter the ‘source’ window, the Layout rendition is updated automatically. A multi-level Undo function is also available in the Layout to enable corrections to be performed and undone.

When operating within the Layout window, certain Edit menu items become available. In particular, the Undo item enables mistakes or editing steps to be reversed. This is especially useful when detailed object editing is being undertaken. The Delete item operates on selected drawing objects in the Layout.
Creating a New Layout

To create a layout display window, use the New Layout option on the View menu. A layout window similar to that shown on the next page is displayed. You can use the Layout window as a drawing tool without embedded objects if you wish.

Components of a Layout Window

A layout window consists of 5 main components:

- The **Page** is the printed area. Any objects (map frames, text strings, lines etc.) that are wholly contained within the Page are printed. Any objects that are partially contained within the Page are clipped at the edge of the Page. The margins of the drawing area are indicated by dotted lines displayed inside the edges of the Page.

- The **Pasteup** area is the grey area in the Layout window surrounding the Page. It is a ‘scratchpad’ area on which you can place objects that you want to retain but don’t want to print. Any objects that are wholly contained within the Pasteup area are not displayed. If an object extends from the Pasteup area into the Page, the portion that lies in the Page, is included in a print.

- The **Text Formatting Ribbon** is displayed along the top of the Layout window and is used to control text sizes, fonts and symbols.

- The **Toolbar** along the left margin displays buttons that represent different editing tools.

- The **Status Bar** is found along the bottom of the Layout window and is used to display messages relating to your current layout operations.

---

**Note**

The Cut and Copy options are also available for use from the Edit menu item. They do not write the selected objects to the Window’s Clipboard.
**Setting Page Size**

When a Layout is created, the page size and orientation defaults to the size of your currently attached printer. The area available for drawing is determined by the size of the printer page. If you use a large format printer, you can draw on an A0 page. If you want to include the plots in the body of a report, use the A4 page size supported by your printer. The page size is obtained from your default printer driver.

You can change page settings in two ways:

1. By selecting **Print Setup** from the **File** menu.
2. By selecting **Printer** from the Layout Configure dialog that is activated by right-clicking in the Layout window.

When page size or orientation is changed, ModelVision makes no attempt to re-organize elements on the new page. For example, if you change from portrait to landscape page orientation, any objects that were near the bottom of the page are now in the Pasteup area underneath it. Likewise, any objects that were in the Pasteup area to the right of the page are now on the page. It is your responsibility to move objects into their appropriate positions once page size or orientation has been modified.

![Example of page size setup and the link to the standard windows printer setup](image)

**Note**
The page width shown in ModelVision is the printable area of the output printer page rather than the size of the paper that is loaded.

**Adding Map Frames**

When you want to bring a ModelVision view into the Layout tool, you do so by creating a frame and linking it to the appropriate window. Once this link has been established, you can move and resize the frame on your layout and ModelVision takes care of making sure that the view you have selected is displayed within the frame. Note that a View in ModelVision can be a Map, Multi-Track, X-section or Perspective display.
If you go back to the linked View either by clicking on its window or by selecting it from the Window menu, you can Pan, Zoom and change the displayed elements within the displayed View and ModelVision adjusts the contents of the frame on your Layout accordingly.

Map Frames, therefore, provide a dynamic link between your Layout and any Views that you currently have active.

- **Creating a Frame**
- **Moving and Resizing Frames**

**Creating a Frame**

Map Frames can be created in two ways:

- Automatically if you create a new Layout from the Window menu and you have one or more Map Views active.
- Using the Frame tool on the Layout toolbar to drag out a new frame.

If the option to automatically create frames is nominated after selecting the New Layout option, the Page size defaults to the paper size and orientation (portrait or landscape) which is set in the **Printer Setup** option of the **File** menu. You can modify this prior to opening the Layout window by selecting the **Printer** button in the following dialog:

![New Layout dialog](image)

Create a new layout from the New Layout option on the Window menu

If you create a Layout as described above, ModelVision creates Frames for each of your Views and fills your Layout page with the most recently accessed one. The other views are positioned in Frames within the Pasteup area. You can use the pointer tool to move and resize the Frames.

When you create a Frame using the Frame tool, as described in 2 above, you are asked to select from a list of your displayed Views by the dialog below. This dialog automatically displays when a Frame tool is used and display views exist in ModelVision.
Placing a window into a created frame

You can select which View window is to be linked with the created frame (use the pull-down list to select it). The scale of the window in the frame can also be specified. Note that when a scale has been defined, the frame bounds are displayed in centimetres. In the case of maps, the scale is the same in the horizontal to vertical direction. For cross-section or multi-track plots, the scale is used to define the horizontal scale only.

If you have created a frame of a different shape from the View to which you are linking it, you can click on either the **Fit Frame to Source Window** or **Fit Source Window to Frame** button to adjust your Frame and its corresponding Map Window to the same aspect ratio.

**Note**

To create a Frame, at least one ModelVision View must be active. If you select the Frame tool and no Views are active, an error message appears.
Position each of the source windows in the location that you require and you can add additional drawing objects over the top of the windows. Note that fonts often appear larger than they are on the final printed page. If the font is a fixed size such as a coordinate box, it is correctly scaled on the final hardcopy output.
Moving and Resizing Frames

When you select a frame, it is highlighted by a dashed line and four handles at the corners of the bounding rectangle. You can select and drag any of these handles to resize the window. The source window redraws into the new area by choosing the best way to draw into the box. You can force the rectangle to match the window shape by accessing the object properties dialog with a double left mouse click and choosing the **Select Fit Frame to Source Window** option.

A frame can be moved by dragging and dropping. Click within the frame using the left mouse button and while holding the button down, drag the frame to reposition it and release the mouse button.

Initial presentation of the layout window with the first object positioned in the output page. The remaining window objects are positioned off the page.

Each time the window is moved or re-sized, it is re-drawn under control from the original source window. This means that you can make changes to the original windows and the changes appear in the layout window next time it is re-drawn.

To access the properties of a frame, select it with the left mouse and double click with the left mouse. The Frame Object dialog as shown above appears. Here you can set precise centimetre limits on the object position or give it a specific scale. This allows you to have a map view at 1:25 000, while a detailed cross-section could be at a scale of 1:5 000. You can also select other objects from the list and change their scales.
Changing Layout Properties

You can change various characteristics of a Layout window. Position the cursor in the window and click the right mouse button. The dialog below is displayed which permits you to enter Layout display attribute information.

The Layout Configure dialog allows you to change the characteristics of your Layout window.

Controlling the Redraw Speed

Because each frame is linked to a ModelVision view, each time you pan and zoom in Layout mode or move a frame, its contents are redrawn. Depending on the amount of information contained within the frame (view limits, displayed layers etc.), and the speed of your PC, this can take some time. You can speed up Layout's redraw by changing the Show Frame Contents setting:

- With the **Slow** option, the entire contents of the Frame are redrawn every time you change the view.

- With the **Faster** option, ModelVision does not redraw the contents of a Frame as it is moved or zoomed but simply redraws the screen bitmap which corresponds to the Frame. This is a fast redraw option, but it does have some side effects. If Faster is in effect and you zoom your Layout, you see that the image within each Frame become coarser. The further you zoom, the coarser and less detailed the display becomes. At any stage, you can click on the **Redraw** button of the main toolbar and your screen is re-drawn at full resolution.

- With the **Fastest** option, each frame is filled with a simple crosshatch pattern and the name of the Frame contents is drawn within it.

**Note**

Printed output is always drawn at full resolution irrespective of the setting of the Show Frame Contents option.

Zooming In and Out

The zoom option presents preset or definable levels of zooming for the Layout view. The dialog that provides zoom control is shown:
Adding Text and Drawing Objects

A toolbar is attached to the left side of the layout widow. These tools can add considerable annotation and interpretive information. A tool tip appears in the Status Bar at the bottom of the ModelVision window when the mouse is positioned over one of the toolbar buttons.

For more information see:

- Drawing Operations
- Drawing Tools
- Adding and Editing Text
- Editing Multiple Text Objects
- Changing the Display Order
- Aligning Objects

Drawing Operations

- **Nudge** - Use the keyboard arrow keys to move a selected object in small increments. This also applies to group selected objects.

- **Group Select** - Use the shift key with multiple left mouse selections to group objects. The objects can be moved as a group or have their attributes changed as a group.

- **Set Group Attributes** - Apply the attributes used when Get Attributes was selected to all objects in the currently selected group. You can change the line thickness and fill colour of multiple polygons.

- **Set Group Font** - Change the font style for all selected text in one operation.

- **Set Group Line Style** - Change the line style for all selected lines in one operation.

Drawing Tools

**Pointer tool** - Allows you to select items, to drag and drop, to resize etc. When the Layout window is active, you can also use the Pointer button on the main toolbar to perform these functions.
**Polyline** - Draw polylines (two or more connected line segments)

**Polygon** - Draw polygons

**Oval** - Draw ovals

**Rectangle** - Draw rectangles

**Rounded Rectangle** - Draw rectangles with rounded corners

**Text** - Add text to your Layout

**Frame** - Open a new window object where you can insert an additional window object. Use this if you deleted an object frame, or when you create a new source window that you would like to add to the layout. Note the windows are selected by name and it is possible to have multiple windows with the same name. The window name is generated from the view type and channel name. If a duplicate name occurs, rename one of the input channels or grid in the source window and recreate the source window.

**Bring to Front** - Redraw a selected item (or items) at the front of your layout

**Poly Edit** - Move vertices of a polyline or polygon. Vertices can also be added using this tool.

**Fill Colour** - Select a new colour for filling closed shapes (polygons, rectangles, ovals etc.). Any selected objects have fill colours modified and the selected colour used fills all subsequent objects until altered.

**Send to Back** - Send a selected item (or items) to the back of your layout

**Pen Colour** - Select a new pen colour. This affects lines, polylines, text and the bounding lines of filled shapes.

**Line Style** - Modify line style and line thickness. This affects lines, polylines and the bounding lines of filled shapes.

**Font** - Activate the font dialog which allows you to change the font, style and size of text items.

**Get Attributes** - Obtain the attributes of a currently selected object (text string, line, polygon etc.). These attributes can be applied to other items of the same type by selecting them and clicking on the Apply Attributes tool.

**Apply Attributes** - Apply the currently selected graphics attributes to one or more selected objects.

**Note**

The **Fill Colour, Pen Colour, Line Style** and **Font** tools set the current state for the addition of new objects and also apply the new attributes to any currently selected objects.
Adding and Editing Text

Adding text:

To add text, select the Text tool and move the cursor to the Layout area. The cursor changes to a text I-bar. Move to the point at which you wish to place your text and click the left mouse button. The text entry dialog appears.

Enter the text you want to display and optionally click on the **Font** button to change the text characteristics. The precise location and the angle of text can also be controlled by entries in the appropriate fields. Note that the location specified for text entries applies to the lower left position of the first character in the text string.

Modifying text:

After a text object has been created you can delete it, move it or modify it.

Editing text:

To edit a text object, double click on it with the Pointer tool and edit the contents of the text dialog. Click on the **Font** button to access the font control dialog.

Deleting text:

Text is deleted by first selecting it with the Pointer tool and pressing the Del key or selecting the **Delete** option in the **Edit** menu.

Moving text:

To reposition the text, select the text and drag the bounding box to the new location. If you select a box handle, the text is resized without changing the origin of the text.

You can move text items a pixel at a time by selecting one or more text objects using the Pointer tool, use the arrows keys to move the selected items. This is particularly useful where the precise positioning of text items is required.
Editing Multiple Text Objects

You may wish to select several text objects and apply the same text attributes (colour, font, style, size etc.) to each one. To do this you must:

1. Select a text object that has the desired attributes, or modify a text object so it has these characteristics. This is done by double clicking on it to enable the Modify Text dialog. If you need to change its colour, select the object and click on the **Pen Colour** tool.

2. Save the characteristics of the selected object by clicking on the **Get Attributes** tool.

3. Select the remaining text objects by clicking on each in turn while holding down the **SHIFT** key.

4. Click on the **Apply Attributes** tool to apply the saved attributes to the selected items.

Changing the Display Order

Since graphical objects can overlap, there are times where you wish to adjust the order in which objects are displayed.

When a Layout is created, ModelVision assigns the following priority to items within the Layout:

1. The background rectangles of all frames are placed at the back (drawn first).

2. All non-text objects which have been produced in ModelVision (X-Sections, maps, perspectives etc.) are placed next.

3. Locational symbols from ModelVision are placed next.

4. All text objects which have been produced by ModelVision (title boxes, body labels etc) are placed next.

5. All objects created using the Layout graphical tools are placed next with later objects being placed on top of earlier objects.

Layout provides you with limited capabilities for adjusting the priority of an item (or group of items) by allowing you to select it and to move it either to the front or back using the **Bring to Front** or **Send to Back** tool or menu item.

Aligning Objects

It is frequently useful to force an alignment and so make selected objects line up vertically or horizontally. To force an alignment, select two or more objects (by drawing out a select rectangle with the cursor or selecting objects individually with the **SHIFT** key depressed). Once selected, chose one of the **Layout>Align** options as shown. When the menu option is selected, the objects realign their positions.
Saving a Layout

In the current version of ModelVision, you can only have one Layout active within a single ModelVision session. You can close a Layout and start a new one. However, if you wish to save a Layout, you must do so by saving it as a component of a ModelVision session file. This is done using the Save option of the File menu.
Filters and their use are powerful geophysical tools. The various filter types (convolution, FFT and two-dimensional) and their controls are explained in this section with tips for optimal use. For descriptions of the available filters, see Appendix G: Filter Descriptions.

In-Line filters are also of great assistance to interpretation with their ability to highlight subtle responses. Adding filter displays to model sections and comparing filtered field data with them enables identification of model edges and features due to the high sensitivity of filtered output. The filter displays and their controls are discussed with examples in this chapter.

In this section:

- About Filters
- Convolution Filters
- FFT Filters
- In-Line Filters
- Grid Filters
- Normalised Source Strength

About Filters

ModelVision supports both Convolution and Fast Fourier Transform (FFT) line oriented filters as well as two-dimensional kernel filters and two-dimensional FFT filters for grid based data. Both convolution and FFT line filters can operate on any number of lines loaded into ModelVision.

In-Line filters allow any of the convolution or FFT filters to be used dynamically in the modelling process. An In-Line filter is applied in ‘real time’ and provides an improved sensitivity for examining your data in a variety of field and modelling situations. A subset of the main convolution filters (called Standard Filters) are In Line filters directly accessed through the cross-section view. For additional information on In-Line and Standard Filter operation, refer to Cross-section Controls.

All filters are designed to operate on one channel or grid at a time. Line filters can be applied to lines individually, in groups or to a complete project. When tests for an optimum filter design are being performed, it is advisable to reduce the computational overheads by applying the filter to one or two lines only. When satisfied with the output, run the filter on the complete project. This decision depends on the filter type, quantity of data and machine speed.
The major advantage of the convolution filter over the FFT filter is its simplicity of operation and speed for short filter lengths. Convolution filtering becomes slow at long filter lengths and is subject to major problems as the length of the filter operator becomes shortened. End effects of convolution filters are handled by reducing the length of the operator while trying to maintain its filter characteristics as the ends of the data set are approached. As the operator becomes smaller than the wavelengths that it is trying to remove, the integrity of the result begins to deteriorate.

2D convolution filters operate in the same way as kernel operations in ER Mapper. Kernel processing is a spatial operation generating output data based on the result of moving a template over the required grid. Kernels are used to detect and enhance edges, sharpen and smooth images and remove noise. A range of filter kernel functions are available. ModelVision uses the same kernel definition as ER Mapper and this is described in the ER Mapper Applications manual. The kernels supplied include averaging kernels, geophysical kernels, sun angle, Sobel, sharpening and edge enhancement kernels.

**Note**

In version 11.0, all gradient filter units were changed to units per metre rather than units per kilometre for consistency with industry practice.

**Convolution Filters**

Convolution filters are accessed through the main filter menu where a list of the available filters is presented.

Specialized geophysical filters as well as standard frequency cut-off filters are supplied. Select one of the filters from the menu list and a dialog box appropriate to the particular filter appears.
Example of filter dialog box for the band pass convolution filter

It is possible to filter on a selected line (highlighted) or on range of lines (by selecting with a combination of the mouse cursor and the CTRL or SHIFT keys). A further option is to use the **Filter all lines** radio button that forces the filter to operate over the complete loaded dataset. Use the **Channel Select** list to choose which channel to use as input for the filter. The **Output name** assigns this name to the filtered output channel. The name of the output filter channel is generated automatically by ModelVision appending 2 characters that indicate the type of filter. It is possible to override this name by editing the Output name field.

This has been intentionally designed to operate this way since comparison of filter results with slight modifications of settings can be important. The Multi-Track display can be used for designing optimal filter settings and comparing the filtered result with the original input channel. By using the overwrite facility of the channel Output name, the Multi-Track automatically redispals when the filtered channel is overwritten. This provides an immediately updated comparison of input and output channels.

**Average sample interval** is the average sample spacing computed from the DIST_ABS column.

**Nyquist Frequency** is the highest frequency distinguished in a discretely sampled set of data. This is equivalent to a wavelength equal to twice the sample interval.

**Fundamental Frequency** is the lowest frequency that the sample spacing is capable of defining.

After setting the line options and entering the parameters into the filter design box, click the **Apply Filter** push button. A 'busy' cursor (hourglass) appears while the computation is in progress. The wait time depends upon the amount of data being processed and the length of the convolution filter operator. When selecting the controlling parameters of a filter, in most instances only a single entry is required. For example, for the pass band filters (high, low or band pass), the operator length is automatically set to an optimal size after the wavelength or frequency for the filter design has been entered. The operator length can be overwritten if desired.

**Note**

If the **Output name** field is the same as that of an already existing channel, that channel is overwritten by the application of a new filter.
The default units of both displayed information and parameter entries can be changed. For instance, if you have a preference for defining a filter in terms of frequency rather than wavelength, choose the appropriate measurement unit located on the right of the entry field.

The In Line Filters and **Connect to ILF List** push button are explained in *In-Line Filters*.

**Convolution Filter Operation**

Most of the filter algorithms used (e.g. band-pass, low, high etc.) are those described by Johnson, B.D. (1971). The upward and downward continuation filters use the transfer functions of Bhattacharyya, B.K. (1972).

- **Low pass** filter outputs wavelengths that are longer than the specified wavelength. Selection of this filter requires specification of the cut-off wavelength and operator length.

  This filter is grouped with the high and band pass filters which all use a common specification for pass wavelengths and operator length. Operator lengths should be chosen such that they can properly resolve the longer wavelengths.

  For example, if the sample spacing is 10 metres and you wish to remove frequencies of 2 cycles per kilometre (500 m in wavelength), do not choose an operator length of 11 (110 metres). Maintain an operator length which is in the order of twice the longest wavelength that you are trying to remove from the data, that is, length = 2 x wavelength/data spacing. Within ModelVision, this formula is automatically applied in selecting the operator length.

- **High pass** filters output wavelengths that are shorter than the specified pass wavelength.

- **Band pass** filters require the specification of an upper and a lower wavelength. Output from this filter gives the same result as subtracting two low pass filters with cut-offs equivalent to the top and bottom wavelengths of the band pass.

- **Vertical magnetic gradients** can be computed for gravitational or magnetic fields. This is the vertical rate of change of the potential field. A high pass filter enhances the edges of shallow magnetic sources. The operator length should be as long as possible for accurate computation.

- **First derivative** filters compute the horizontal gradient of the selected column. No operator length is required as this is a simple 5 point numerical operator (weights - 0.125, -0.25, 0, 0.25, 0.125).

- **Second derivative** filters compute the second horizontal derivative of the selected data. A three point operator based on the work of McIntyre (1981) is used.

- **Square root of second derivative** is the square root of the amplitude of the second derivative filter. McIntyre demonstrated that this method provided an effective enhancement procedure for the recognition of small anomalies on the flanks of large amplitude anomalies. Care is required with this filter because it is also a noise enhancement filter. It is often desirable to low-pass filter the selected column prior to second derivative filtering.
• **Analytic signal** – The analytic signal filter uses the computation of the Hilbert Transform. The filter creates an amplitude spectrum which differs by 90 degrees from the original input data. This operation is especially useful in magnetic anomaly detection since the anomaly peaks created occur at inflection points of the original input.

The modulus of the (3-D) complex analytic signal of a function \( g(x, y, z) \) is given by:

\[
\mathcal{A}S(g) = \left[ (\frac{\partial g}{\partial x})^2 + (\frac{\partial g}{\partial y})^2 + (\frac{\partial g}{\partial z})^2 \right]^{1/2}
\]

This enhancement is popular for use in magnetic interpretation because it reduces complexity due to magnetisation direction. ModelVision provides the 2D version of the analytic signal given by:

\[
\mathcal{A}S_{2D}(g) = \left[ (\frac{\partial g}{\partial x})^2 + (\frac{\partial g}{\partial z})^2 \right]^{1/2}
\]

For inputs that vary perpendicularly to the profile, the 2-D analytic signal does not record the full variation of the 3-D function. The advantage of the 2-D version is that it can be computed rapidly along any individual line. The 2-D analytic signal is also available from the list of ‘standard filters’ in the cross-section configuration dialog. Selection of the analytic signal as a standard filter plots its output in the cross-section from both the model input and output channels. While the 2-D analytic signal provides only an approximation of the 3-D function it does produce a valid comparison of model input and output channels as it is applied identically to each.

• **Moving average** filters are similar to low pass filters. The major difference is that the cut-off is not as clean as the low pass filter and it allows considerable leakage of high frequencies into the filter output.

• **Median** or **Threshold** filter is a specifically designed filter for the removal of spikes or data having a specific wavelength and amplitude. In particular, this filter can be used for the removal of cultural noise in magnetics data. The filter operates by defining a threshold amplitude. An operator window is also specified by the user to define the wavelength. The filter moves incrementally along the required lines and compares the middle sample of the window with the difference between the median value of the window and the threshold. If the absolute value is greater than the threshold, the median is substituted for the value.

• **Fourth difference filters** are useful tools for the detection of noise spikes, especially in aeromagnetic data. This technique is commonly used for quality control of magnetic data recording systems. The amplitude of the operator is divided by 16 to normalize the output to equivalent noise levels.

• **Upward continuation** is a classic geophysical filter for low pass filtering of magnetic and gravity data. It is mathematically exact for two-dimensional geological sections. This is the case if the geology is uniform in a direction perpendicular to the direction of the data profile. Continuation height is specified in multiples of the sample interval or as a specific distance in metres. Operator lengths should be as long as possible to achieve accurate continuation.

• **AGC** filters apply a non-linear amplification process to a dataset intended to increase the amplitude of small anomalies and decrease the amplitude of large anomalies. A benefit of this filter is that it maintains an anomaly’s shape and wavelength as far as possible while filtering. That is, small amplitude features are amplified and large amplitude features are attenuated.
The AGC process is achieved by defining a window width and using the mean amplitude for the line or survey to define an amplification factor that is applied to the centre value for that window.

The formulation of the AGC filter is provided by Rajagopalan (1987) as:

\[ f_{out} = \frac{(f_{in} - f_{av}) \cdot f_{sdwin}}{f_{sdsur}} + f_{av} \]

where

- \( f_{out} \) = computed AGC output
- \( f_{in} \) = function input
- \( f_{av} \) = average value at point \( f \) in the moving window
- \( f_{sdwin} \) = standard deviation for window
- \( f_{sdsur} \) = standard deviation for survey

- **Noise Generator** – The Noise Generator filter can be used to study the application of other filters. You can artificially add ‘white’ noise from this filter to create a new channel of signal plus noise. This channel can be filtered to test the design and characteristics of a second filter in removing noise.

The Gaussian Noise Filter provides a powerful tool for survey design when added to the output of predictive models computed along synthetic survey lines. The Gaussian noise generator dialog allows the specification of a constant offset and standard deviation for the noise. The range, mean and standard deviation of the input channel are reported for reference. Gaussian noise can also be also added to grids from the **Filters>Grid filters>Noise generator** menu item. The filter parameters of a mean offset and standard deviation are identical to the parameters specified for adding noise to line data.

**FFT Filters**

Fast Fourier Transform Filters are selected from the main Filter Menu that presents a list of filters similar to that of the convolution filter set.
After a filter is selected, a dialog box appears to allow you to enter the control parameters appropriate to that filter. Fast Fourier Transform filters provide an alternative method to convolution filters for transforming data.

The major advantages of the FFT approach are its ability to look at the energy spectrum and to more efficiently process long wavelengths.

A disadvantage often associated with FFT is that it normally uses data sets with lengths that are powers of 2. To avoid this constraint, a mixed radix FFT that is based on prime factors up to a maximum of 23 has been used in ModelVision. With this algorithm, an FFT can normally be performed on a data set length that is within 1 percent of the total data length. This computation and adjustment is automatically made by ModelVision.

Example of an FFT dialog box for the vertical derivative filter

The In Line Filters and Connect to ILF List push button are explained in the section In-Line Filters.


The FFT dialog requests information on the channel to be transformed and on data spacing.

**Note**

New data channels may be created for the forward transformation process but, as for convolution filters, care must be taken in naming output channels since newly created channels overwrite previously generated data with the same channel name.

- **Low pass** filters pass frequencies below a specified frequency. The controlling parameters required are the low frequency cut-off and the cut-off rate.

  Frequencies are specified in a range of cycles or as wavelengths (in distance). Cut-off rates control the sharpness of the filter and the tapering of the energy spectrum. A high value for the cut-off rate has the effect of removing high frequencies, but causes ringing on the edges of large amplitude changes.

- **High pass** filters pass frequencies that are higher than the specified cut-off. As for low pass filters, the high frequency cut-off and cut-off rate are required.

- **Band pass** filters pass frequencies that lie between two specified frequencies or wavelengths. Information must be entered for high-frequency cut-off, low-frequency cut-off and the cut-off rate.
• **Horizontal derivative** filters are computed directly and the only additional information required is a choice of smoothing of the spectrum. This is often desirable because the horizontal derivative is a high pass filter.

• **Vertical derivative** filters are computed directly. As this is also a high pass filter, smoothing of the spectrum is recommended to enhance the usefulness of the results.

• **Upward continuation** filters allow either magnetic or gravity data to be filtered in such a manner that it appears to have been collected at a greater height than was actually the case. This is similar to a low pass filter operation. The height of continuation is specified in distance or multiples of the sample interval.

• **Downward continuation** is the reverse process to upward continuation. Care should be taken not to continue below the top of the shallowest magnetic or anomalous density contrasts, as in this circumstance the process becomes unstable.

• **Reduction to the Pole** performs a transformation on magnetic data to make it appear as though it were recorded at the Earth's magnetic pole. Information is required on the direction of the Earth's magnetic field (inclination and declination in degrees) and the direction of remanent magnetisation (if any). Field inclinations should be specified as negative for the Southern Hemisphere.

• **Pseudo gravity** filter can be computed from a magnetic profile in a manner similar to that of reduction to the pole. The information required is the Earth's field inclination and the field declination in degrees.

• **Band limited noise generator** enables low frequency, pseudo-random noise to be added to the data. The noise has a uniformly random distribution of amplitudes about a user-specified mean value. The root mean squared (rms) amplitude of the noise is determined from a user-specified standard deviation. You must also define a cutoff frequency or wavelength such that the generated noise is band limited in the spatial frequency or wave number domain. This ensures that short-wavelength random noise will not be present in the data at spatial frequencies much above the desired cutoff value.

**In-Line Filters**

Both the convolution and FFT line filters can be used as In Line filters during modelling. The use of In Line filters means that a computed magnetic or gravity model response can be filtered in real time as the model is edited and displayed in the same track as filtered field data.

As an example, in surveys with high regional gradients, it may be preferable to model the first vertical derivative of the observed magnetic response rather than the total field. In this case, the first vertical derivative of the measured magnetic field data can be computed and set as input in the Line Control option of the Model menu (see Line Control). After computation of the total magnetic field you can connect the model output to another first vertical derivative In Line filter.

In Line filters can be used and specified by two methods:

• An In Line filter can be specified in the X-section configuration dialog (refer to Standard Filters for a description of this method of applying filters in modelling). This technique is fast to create and automatically provides traces of filtered output for both the theoretical and observed responses. Only low pass, high pass, first vertical derivative upward continuation and analytic signal convolution filters are available using this technique.
A second method is provided which enables any filter type or design to be applied to any channel and presented in a cross-section view. The application of this method is described below. These steps describe the implementation of an FFT first vertical derivative filter applied to observed and modelled magnetic data.

After opening a new cross-section perform the following steps:

**Step 1**

After loading an observed magnetic dataset, apply the FFT first vertical derivative filter (Input MAG, Output MAG_VD) in the conventional manner.

**Step 2**

Compute the forward model response so that a channel called MAG_MOD is available for connection to the In Line filter.

**Step 3**

From the Filters menu item select the Filter List Maintenance option. When selected the following dialog is displayed:

![In Line filter configuration dialog](image)

**Step 4**

Choose the FFT vertical derivative filter from the list box of Available Types. By selecting the New button, the normal dialog for this filter type is displayed.
Configure the filter with parameters that match those specified for the observed magnetic data.

**Note**

The Channel Select item has been modified to operate on the data derived from modelling (channel MAG_MOD). The Output name is defaulted to MAG_MOD_FVD but you can override this. Also note that the In Line Filter name has been altered to FVD of Model.

**Step 5**

To update the In Line Filter list, select the Connect to ILF List button. When this is done, the filter configuration dialog disappears and the Filter File Maintenance window reappears. Note that the specified In Line Filter now appears in the Filter List.

**Step 6**

Any number of filters can be added to the Filter List. If the controlling parameters require modification, highlight the required filter and select the Parameters push button. Filters can be manipulated in their position on the list, or removed by the Delete button.

**Step 7**

To add the two In Line filter channels (MAG_FVD and MAG_MOD_FVD) to the current cross-section display use the right mouse button to access the cross-section configuration dialog.
Use the Aux Channels Add button to define the In Line filter channel.

Adding a curve to a X-section track

Use the Add Curve button to add the first filter as a new track. Next, double click the left mouse button in the new track. This displays an Add Curve dialog from which you can select the second curve. This is displayed at the same scale as the first curve.

Grid Filters

- 2-D Convolution Filters
- Grid Filter Tool
- Noise Generator
2-D Convolution Filters

2-D convolution filters operate in the same way as kernel operations in ER Mapper. Kernel processing is a spatial operation generating output based on the result of moving a template over the nominated grid. Filter kernels are used to detect and enhance edges, sharpen and smooth images and reduce noise. A range of filter kernel functions are available. ModelVision uses the same kernel definition as ER Mapper, as described in Appendix G: Filter Descriptions. The kernels supplied include averaging kernels, geophysical kernels, sun angle, Sobel, sharpening and edge enhancement kernels.

To filter a grid using the convolution kernels, select the 2-D Convolution Filter menu item. The dialog below is presented.

![2D Convolution Filter dialog](image)

Select a filter group and the range of appropriate filters is displayed. Use the cursor to highlight one of these and click the Select button. The selected filter is displayed and an Output grid name is required. Since some convolution filters can affect the margins of a grid, it is sometimes necessary to clip the grid margins. The clipping performed by this option is half the kernel filter width.

If detail on the filter design is required, select the Characteristics button. Information is displayed on kernel size and operator. If additional information is required, or new kernels are to be added, edit the ASCII files that describe the kernels. These files and their format are documented in Appendix G: Filter Descriptions.

The filter characteristics can be visualized by loading the filter coefficients into a grid. You can use the contour or grid profile view option to examine the two dimensional shape of the filter operator.

**Grid Filter Tool**

The Grid Filter option is a powerful tool that provides the following functionality:

- Numerous grid operations including padding, filtering and null filling can be undertaken
- A wide range of convolution grid filters can be applied including average, standard, Gaussian, geophysical, seismic and sun-angle filters
Using Filters

- FFT filtering using sophisticated operators to apply geophysical filter results such as reduction to the pole and reduction to the equator, component transforms and pseudo gravity transforms etc.

A detailed description of the various filters and their application is provided in Appendix G: Filter Descriptions.

To use Grid Filter, the grid must first be loaded into ModelVision. Grid Filter is initiated by the Filters, Grid filters and GridFilter menus. You then select a grid to filter from a list of currently loaded grids. This grid is then passed to the GridFilter plug-in via a temporary file.

ModelVision passes the grid data to the GridFilter plug-in via a temporary file. You apply the desired sequence of filters, and when happy with the preview of the output save this to a file. On closing GridFilter ModelVision will automatically read and display the output grid in a new map window.

How to Use the Grid Filter Tool

The grid passed from ModelVision is loaded and the grid content is displayed in the three preview windows.

Using the CONV (Convolution filters), FFT (FFT Filters) or Utils (Utilities) buttons and the provided pull-down lists, select the operations to be performed on the grid. Note that as operations are added, they are immediately performed on a portion of the input grid. The area over which the operations are applied is indicated by a square drawn in the top preview window. The content of this square is shown in the second, middle window. The output of the processing steps is shown in the bottom preview window.

Using the Preview Windows

If you wish to examine the effects of the processing more closely, you can position the cursor in the middle or lower preview windows and click the left mouse button. When placed in the window initially, the cursor changes to be a magnifying glass. Clicking the left mouse button zooms the view in the middle and output preview windows and allows you to see a portion of the processed area. A subsequent left mouse click returns the view back to the original size. If you wish to pan the zoomed view, click the right button and while the cursor hand is shown, you can drag-and-drop the zoomed image.

Note that the square drawn in the upper window indicates the area of processing. Since processing can take some time for complex operations, only this small (400 x 400 row/column) area is used. If you wish to move the processed area, position the cursor over the square in the upper preview window and with the left mouse pressed, drag-and-drop it to a new location. The processing is then applied to this new data.

When you request that the processed grid be output, using the Save As button, the processing is applied to the entire grid and written to the new file specification nominated from the Save As button.
The dialog for the Grid Filter with input, raw and output grids

More than one filter can be applied sequentially to the input grid. Filters and processing operations are applied in the order listed. Each operation may require you to specify some controls in the Filter parameters area. The controls and parameters for each operation and filter type are described in Appendix G: Filter Descriptions.

The processing is applied such that the output of one operation is the input of the next. This means that complex processing can be applied cumulatively. If you wish to alter the order of operation, use the Up and Down button to the right of the operation list. You can also remove an operation by selecting it and then clicking the Delete button.

Grid Information

Information relating to the size, rows/columns and data within each of the three preview buttons can be displayed by clicking the Information button. When zoomed and processing is applied, each preview window contains different grid data content and so the displayed dialog report indicates this:
Altering Settings

The Grid Filter allows you to control the zoom and padding of the Grid Filter. Select the Settings button to display a control dialog.

The zoom level can be specified as default. The integer indicates the increase of level such that an entry of 5 zooms the area to 5 rows/columns for each one seen in the original, upper preview window. The window titles (Full, Input and Filtered) can also be eliminated if required.

Padding controls permit an area surrounding the input grid to be created to minimize edge and filtering effects when certain filters are applied. Refer to Appendix G: Filter Descriptions for additional information. The area around the original grid to be processed can be set as a percentage of grid area around the perimeter. This is referred to as the Padding margin. Two methods are also provided for the padding. These are:

- **Padding by row and then by column** – This option duplicates the outer rows then columns of the input data grid and extends them outwards to the Padding margin to surround the grid.

- **Padding in 2D using gridding** – This method extends the grid margin by extending the grid data and gridding it over the extent of the Padding margin. This method produces a relatively seamless edge to the grid and allows for smooth filter application without edge effects. This method is superior in many cases to the first because it eliminates the horizontal and vertical streaks which padding by row and then by column can introduce.

The Padding Margin as it is appended to the original grid can be saved for examination if required. Enable the Save padded grid option to this.
It is recommended that padding is always used when running an FFT filter. If the input grid is not square then FFT filters cannot be used unless padding is selected. Padding squares up the grid.

**Fill Holes Operation**

The Grid Filter **Utils>Fill holes** option can be used to replace nulls in a grid by extrapolating the surrounding data. There are two options available for this module:

- Fill internal holes only.
- Fill internal holes and nulls surrounding grid.

If the first option is selected then only null values which are not connected by nulls to the outer edge of the grid are filled that is, internal holes. If the second option is selected, then all nulls in the grid are replaced with extrapolated values.

The method used to fill holes involves progressive extrapolation from the outer rim of the hole towards the centre until the entire hole is filled. This process can be slow for large holes.

**Noise Generator**

This allows noise with a Gaussian distribution to be added to an existing grid. The user specifies the mean noise level and standard deviation of the added noise about this mean.

**Normalised Source Strength**

The normalised source strength (NSS) is a theoretical concept originally developed by Wilson (1985) to track dipole sources using magnetic gradiometry. It is the magnitude $\mu$ of the normalised or scaled magnetic moment vector $\mu$ (Wilson, 1985; Wynn, 1999). More recently Clark (2012a,b) has further developed the theory of the normalised source strength and shown its relationship to the tensor invariants ($I_0$, $I_1$ and $I_2$) which were originally used in magnetic and gravity exploration by Pedersen and Rasmussen (1990). This new theory has been applied to the problem of determining the magnetic moment, the magnetisation direction and the position of magnetic sources. In particular the NSS has been especially useful in the study of remanently magnetised sources (Beiki et al, 2012; Clark, 2012b and 2014). It peaks directly over compact sources, linear sources and contacts and is independent of magnetisation direction. The NSS produces results that are similar to the analytic signal, but has the advantage of greater coherency of geological features and improved noise characteristics in low amplitude areas. A further advantage is that it allows for the quick estimation of the inclination and declination of magnetisation direction which can be used as a starting point in magnetic modelling and inversion.
The tensor is computed from the total magnetic intensity grid using the wave-number domain (FFT) filters for transforming TMI grids to any element of the magnetic gradient tensor (Appendix G). The whole process is automated through a simple user interface that makes it easy for interpreters to experiment with the normalised source strength method.

Three eigenvalues $\lambda_1, \lambda_2, \lambda_3$ are obtained by the eigenvector decomposition of the magnetic tensor $B$ (Clark, 2012b). This involves finding the three eigenvectors $e_1, e_2, e_3$ which satisfy the linear equation $B e = \lambda e$ where $\lambda$ is the eigenvalue corresponding to $e_j$. The eigenvalues are also found by solving the characteristic equation $\det (B - \lambda I) = 0$ which results in the following cubic equation in $\lambda$:

$$\lambda^3 + I_1 \lambda - I_2 = 0$$

where the coefficient $I_0$ of the $\lambda^2$ term is identically zero since, at a measurement point in a source free region, the gradient tensor $B$ is traceless, i.e.

$$I_0 = B_{xx} + B_{yy} + B_{zz} = 0 = \lambda_1 + \lambda_2 + \lambda_3$$

and where the $I_1$ and $I_2$ tensor invariants are (Pedersen et al, 1990; Clark, 2012):

$$I_1 = B_{yy}B_{zz} + B_{xx}B_{yy} + B_{zz}B_{xx} - B_{xy}^2 - B_{xz}^2 - B_{yz}^2 = \lambda_1 \lambda_2 + \lambda_2 \lambda_3 + \lambda_3 \lambda_1$$

and $I_2 = \det B = \lambda_1 \lambda_2 \lambda_3 = B_{xx}B_{yy}B_{zz} - B_{xx}B_{yz}^2 - B_{xx}B_{yz}^2 - B_{xx}B_{yz}^2 - B_{yy}B_{xz}^2 + 2B_{xy}B_{yz}B_{zx}$

From these eigenvalues, the following quantities may be defined, first the normalised source strength $\mu$ (Clark, 2012a,b)

$$\mu = \sqrt{-\lambda_2^2 - \lambda_1 \lambda_3} \quad \lambda_1 > \lambda_2 > \lambda_3$$

and second, the co-inclination angle (phi)

$$\cos \phi = \frac{\lambda_2}{\mu} \quad \text{or} \quad \phi = \cos^{-1} \left( \frac{\lambda_2}{\mu} \right) \quad (0 < \phi < \pi)$$

where $\lambda_2$ is the second or intermediate eigenvalue which has the smallest absolute value.

The following example shows images of these three parameters over a sphere. The lambda2 eigenvalue is almost circular and the centre of the sphere is offset from the peak value. The NSS parameter is perfectly symmetric and peaks immediately above the centre of the sphere. The co-inclination angle phi is zero when the magnetisation vector and the vector from the observation point to the centre of magnetisation are the same. If this zero location is not subject to interference, the coordinates can be used to determine the magnetisation vector and depth below the surface (see also Appendix G).

The peak of the NSS provides the location of the centre of magnetisation and a good indication of the inclination of resultant magnetisation (see Appendix G). The half-width of the NSS anomaly gives information on the depth and the shape of the magnetic source rocks (Clark, 2012b).
Clark (2012a) shows how to use lambda2 ($\lambda_2$) to compute the depth to a magnetic pole or line of poles using the formula:

$$h = \frac{b_Z}{\lambda_2}$$  

(Clark, 2012a, equation (15))

where $b_Z$ is the vertical component of the magnetic field. You can perform this calculation by first using the FFT filters to compute $b_Z$ and then the grid expression handler in the Calculator to derive $h$. You will need to do some upward continuation on data with wide line spacing as high frequency imperfections in the grid data will be exaggerated by this type of processing. Users should refer to Appendix G for more information on the normalised source strength method. In particular, expressions based on the half-width of the NSS anomaly may be used to determine the depth $h$ of a variety of simple sources including dipoles (compact sources), poles (pipe-like bodies), thin sheets (dykes), contacts etc. (see Clark, 2012b, Table 1, p. 273).

You access the normalised source strength filter from the Filters>Grid filters>Normalised Source Strength menu.

The dialog below allows you to select the input grid name, output grid name prefix and padding percentage. You can optionally save the intermediate tensor channels as grids, but these are not normally required for interpretation. Select the apply button to begin the process.
Dialog used to generated the NSS, phi and lambda2 parameters from an input total magnetic intensity grid.

The example below shows the total magnetic intensity (TMI) image and normalised source strength (NSS) images.

Map views of the input TMI grid and processed NSS grid over the Black Hill Norite region of South Australia.
ModelVision provides many useful data analysis and processing tools. Most of these tools have been placed in the main Utility menu item. This section describes the operation of most data maintenance, analysis and processing tools. The Utility menu is used frequently to assist other operations within ModelVision. For instance, imported line data can be rapidly gridded in the Grid option and displayed in the View option. Similarly, recomputation of channels of data using arithmetic relationships can be achieved by the Calculator feature.

- Computing New Channels
- Interpolating Values Along Lines and Drillholes
- Generating Grids from Channel Data
- Interpolating Channel Values from a Grid
- Manipulating Gridded Data
- Reporting and Statistics

Computing New Channels

The Calculator utility can be accessed from the Utility menu and provides a calculator style interface for the computation of new channels, grids or other data types from those existing and stored in memory. The option can also be used as a standard calculator within the ModelVision environment.

The calculator has six major functional units:

- Equation entry line
- Available data type names
- Mode control
- Keypad entry
- Push button options
- Object selection
Equations can be entered with channel names appearing in algebraic expression statements using trigonometric functions and operators shown on the calculator interface. The above example computes a new channel called DTM_CLIP using the statement:

\[
\text{DTM_CLIP} = \text{IF}(\text{DTM}<1000, \text{DTM}, 1000)
\]

Where the syntax for an IF statement is defined by:

\[
\text{IF(} \text{Boolean, result_if_true, result_if_false)}
\]

To use the calculator capability, type in a new or existing channel name followed by the = symbol, and then the formula, and then click the Compute button. If the channel name does not exist, it will be created as a new channel.

You can edit the equation and click Compute again for a new result.

Entries can be typed explicitly or selected from the keypad with the left mouse button.

---

**Note**

Trigonometric functions are entered in radians. A conversion button is provided to convert degrees to radians.

**Mode Control** - Computational operations are not restricted to line based channels. Operations can be performed on and between grids, channels in drillholes and on point data. For example, if the difference between a regional and a theoretical grid is to be computed, select the Grid mode of operation to display the available grids in the list box. Select (or type) the required computation and Compute the result.

Available input data names are displayed in the scrollable list box on the left hand side of the calculator. The names appearing reflect only the data type selected in the Mode Control option. This serves to remind you of the available data channel names and can be used to select a name and append it to the equation line by using the Select button.

---

**Note**

Output channel names should be chosen with caution. ModelVision has a number of reserved words that should not be used for channel names.

### Reserved Channel Names

<table>
<thead>
<tr>
<th>ABS</th>
<th>ACOS</th>
<th>AND</th>
<th>ASIN</th>
<th>ATAN</th>
</tr>
</thead>
<tbody>
<tr>
<td>COS</td>
<td>DATA</td>
<td>DATE</td>
<td>DEC</td>
<td>ELSE</td>
</tr>
<tr>
<td>EQV</td>
<td>EXEC</td>
<td>EXP</td>
<td>GINT</td>
<td>GRID</td>
</tr>
<tr>
<td>FIX</td>
<td>IF</td>
<td>IMP</td>
<td>INT</td>
<td>JOIN</td>
</tr>
<tr>
<td>LEFT</td>
<td>LEN</td>
<td>LOG</td>
<td>LOOP</td>
<td>LWRC</td>
</tr>
<tr>
<td>MAX</td>
<td>MENU</td>
<td>MID</td>
<td>MIN</td>
<td>MOD</td>
</tr>
<tr>
<td>MOVE</td>
<td>NOT</td>
<td>NPF</td>
<td>OR</td>
<td>POS</td>
</tr>
<tr>
<td>RUN</td>
<td>SIGN</td>
<td>SIN</td>
<td>SQRT</td>
<td>TAN</td>
</tr>
<tr>
<td>TIME</td>
<td>TRIM</td>
<td>UPRC</td>
<td>XOR</td>
<td>C</td>
</tr>
</tbody>
</table>
**Keypad entry** can be used as an alternative to direct typing of the equation.

---

**Note**

Keypad entries can only be appended to the current equation rather than inserted within it. Insertion and editing can be achieved by keyboard operation only.

---

**Minimize** - allows the Calculator dialog to be minimized without loss of the computation function. Once minimized, a second, maximize button is available to restore the original size.

**Load** - allows retrieval of a previously saved calculation stored in a file of type 'MVP'.

**Save** - stores the current equation in a file of your choice.

**Compute** - performs the computation on all data points and all lines in the current project.

**Close** - terminates the calculator session.

---

**Errors**

If you incorrectly specify a computational algorithm, or make an error in its definition, an error message is displayed. There are a number of circumstances under which this occurs. Some of these are:

- An inappropriate expression has been defined. For example:

  \[
  \text{MAGNEW}=20800-\text{MAG}\times\text{MAG\_REGIONAL}/10.0
  \]

- An error occurs if a constant value is used which is greater than 32000 but not defined as a real number. The first of the following expressions fails whereas the second computes successfully:

  \[
  \text{MAGNEW}=\text{MAG}+34000
  \\
  \text{MAGNEW}=\text{MAG}+34000.0
  \]

- The Compute function generates an error if a new channel name has a digit as the first character, for example:

  \[
  \text{2MAGNEW}
  \]

- Certain keywords are not recommended to be used as output channel names and these are listed in the reserved list (see **Reserved Channel Names**).

---

**Object Selection**

The Calculator enables requested operations to be performed on specified data only. You can perform computations on selected items by specifying Lines, Points or Holes using the **All** and **Select** options in the Object control of the Calculator. The **Mode** setting defines the Object type. If **All** is enabled, you cannot specify a data subset.

---

**Special Functions**

Some functions available within the Calculator perform specialist operations. These special functions include:
GINT

The GINT function creates a new data channel with values interpolated from a specified grid. The location of the derived values are determined by the easting and northing locations of loaded readings. The reading locations can be either along traverses or as point data.

The syntax for the GINT calculator function is:

\[
\text{NEWCHAN} = \text{GINT}(\text{h\_GRID}, X, Y)
\]

where

- `NEWCHAN` is the generated new channel name.
- `h\_GRID` is the name of the grid to be used for interpolated data values. Note that the `h\_` must be used to explicitly name the grid. For example, a grid with name MAG would be defined in the GINT function as `h\_MAG`.
- `X, Y` are the easting and northing locations channels of readings.

An example of using the GINT function would be to precisely match the locations of observations between magnetics and gravity. If a gravity grid (called GRAV) were available, to interpolate the data values from the grid (and call the output GRAVNEW) to the observed magnetic readings a Calculator command similar to that below could be used.

\[
\text{GRAVNEW} = \text{GINT}(\text{h\_GRAV}, \text{EAST}, \text{NRTH})
\]

Other uses of the GINT calculator function

- **Joint modelling of gravity and magnetic data**
  
  You can use this function to extract gravity points from a grid and store them in a new channel alongside the aeromagnetic data. This enables you to do joint modelling of magnetic and gravity data along the same line.

- **QC your contractor's grids**
  
  You can use the GINT function to resample your magnetic grid onto the same lines that were used to generate the grid. Use this to test the quality of your ModelVision gridding or QC your contractor's grids.

- **Synthetic airborne surveys**
  
  If you have a digital terrain model you can use the synthetic line generation to create a set of flight lines that traverse the digital terrain grid. From the synthetic lines you can use the GINT() function to extract the elevation data along a set of flight lines and tie lines if required. If you apply a long wavelength filter to the elevation data you can approximate the flying characteristics of an aircraft.
Once you have this simulated aircraft flight path with elevation you can construct a geological model that is appropriate to your exploration objectives and calculate the response for each \((x,y,z)\) point along each flight line.

You can simulate the response at the pole and the equator. Test your data processing routines or ask the contractor to apply his processing to your simulated survey. This helps validate the contractor’s processing procedures where methodologies are regarded as ‘proprietary’.

Any grid data including geochemistry, radiometrics, water table, electrical properties can be resampled onto your line and point data sets. A bilinear interpolation procedure is used to estimate the grid value at the data point location.

**Axis Translation**

Quite often it is useful to translate the easting and northing locations of data points associated with axes transformations. The Calculator utility can be used to do this with the following formulae:

**Clockwise Axis Transformation**

\[
X = X' \cos \theta + Y' \sin \theta \\
Y = -X' \sin \theta + Y' \cos \theta
\]

**Anticlockwise Axis Transformation**

\[
X' = x \cos \theta - y \sin \theta \\
Y' = x \sin \theta - y \cos \theta
\]

Where the following grid translation convention is used:

\[\text{Grid translation convention used for axis translation.}\]
Interpolating Values Along Lines and Drillholes

The Interpolate feature enables line or drillhole based data to be resampled to a user specified sampling interval. The operation can be applied to an irregularly sampled dataset as well as regularly sampled data.

Interpolation dialog control

Select the channel (usually a distance channel) on which the data is to be interpolated. Linear interpolation is used in this operation. That is, each data value is evaluated according to a straight line fitted between the data points.

Important

When performing interpolation, the original data in memory is lost. Before performing the interpolation, save a work session file to retain a copy of the dataset.

Generating Grids from Channel Data

If grids are not available for the project being analysed they can be generated from data that is loaded into memory. The gridding procedure uses a multi-stage algorithm that starts with surface fitting using local polynomials followed by grid cell size reduction and minimum curvature adjustment. The minimum curvature procedure is based on the publication of Briggs (1974). You have control over each of these stages if desired.

The gridding process, computation time and the quality of the resulting grid can be controlled by a number of variables. These include data quality, data distribution and grid parameters such as mesh size and consequent number of rows and columns. Another consideration in generating grids within ModelVision is that high quality, large grids take time to generate, display and model. It is recommended, therefore, that for large datasets gridding be undertaken only on the part of a dataset which is required for modelling rather than on the dataset as a whole.

To decrease the computation time of theoretical grids, it is possible to implement grid decimation which forces computation of responses for the grid at every nth mesh point rather than every point. This decimation is controlled by the Compression tool that is accessed via the Model>Compression menu option.
Gridding Fundamentals

The ModelVision gridding option is an efficient system for producing grids from a set of randomly located or line oriented data points. There is no effective limit to the number of input data points and grids generated. The gridding utility is capable of handling a wide variety of data distributions ranging from several randomly spaced points to large sets of line-oriented data such as airborne geophysical surveys.

The production of grids from raw data consists of creating a regular grid that approximates the surface that would pass through the input data points. The grid is used as the basis for generating images or contours by following lines of equal amplitude through the mesh of grid points.

Unlike some gridding packages which require you to choose a different gridding technique for different types of data, ModelVision uses one overall procedure for generating grids. However, it does use a variety of techniques for different stages in the production of the final grid surface. These have been developed on the basis of their speed, ability to handle a large number of input data points and quality of the final surface which they produce. It is necessary to use a multi-stage process to achieve both speed and accuracy. A combination of surface projection and minimum curvature techniques are used in ModelVision.

The process of grid generation can be thought of as successive approximation to a final surface that honours all the data points if enough iterations are used. In its most fundamental form the grid generation consists of the following stages:

1. Initial surface generation
2. Smoothing of the original surface
3. Reduction of the grid cell size
4. Minimum curvature
5. Repeat stages 3 and 4 (up to two times, if required)

Initial surface generation

This is performed to give the iteration process of minimum curvature a good starting point. This stages is performed in three major steps:

Evaluate grid points surrounding a data point

- The evaluation of grid points surrounding data points is performed very rapidly by the simple process of assigning the data value to the nearest grid point or points. The figure below illustrates the way in which this is achieved.

- Schematic presentation of the assignment of data values to mesh points as a function of location within the grid cell. (a) Nearest neighbour (b) Nearest neighbours (c) Central.

- The grid cell is divided into 9 segments and the proximity of the segment to a grid corner determines which corner is assigned the data value. This is a rapid and effective technique for producing a first approximation to the surface in the vicinity of the original data points. However, the output grid is not suitable for contouring as the process of shifting the data value introduces undesirable local oscillations in the surface.
• If more than one data point falls near a grid point, the old value for the grid point is added to the new data value and the sum divided by two. This is equivalent to applying a binary filter to the data and ensures that all data points have some influence on the evaluation of the initial grid. Although the weighting of data points is not equal, this is not important in obtaining the first approximation to the surface. This method also provides a rapid procedure for condensing a large data set.

**Evaluate grid points at every 4th row and column**

• Every 4th grid row and column intersection is evaluated using an eight sector search and surface projection procedure. For a mesh point to be assigned a value, there must be at least one evaluated grid point in five out of eight sectors. A maximum search radius can be specified for this evaluation stage. The default is to search the whole grid. For line oriented data, you would choose a search radius of 1.5 to 2.0 times the average line spacing. If no data is found, the value is assigned a null value which is commonly referred to as ZNIL.

• If the space assigned to the grid completely surrounds the data, a convex boundary is automatically generated with ZNIL values at the boundary. The contour tracking procedure stops when it encounters this boundary. Since the procedure works from left to right and bottom to top, there is some asymmetry in the process that means that more grid points are evaluated at the right hand boundary than the left.

**Evaluate remaining grid points**

• An initial evaluation of the remaining mesh points is computed using the same eight sector search procedure. The difference in this case is that the data search does not have to extend more than four mesh points in any direction. This greatly reduces the time required to complete the initial surface generation.

**Smoothing of the original surface**

This is performed to reduce the amplitude of the oscillations caused by using the nearest neighbour evaluation of mesh points. This process uses a simple first order surface fitting procedure to recalculate the grid points on the basis of the surrounding values. This improves the shape of the surface both near the data points and in the spaces between data points. It is the latter that takes the longest to adjust in the following minimum curvature procedure.

**Reduction of the grid cell size**

This is used to create a finer grid for the minimum curvature procedure. The finer grid is required to more accurately represent the shape of the surface, especially for closely spaced data points. The figure below shows an example of a 2 x 2 grid reduction.
In this process, the input rows and columns are first interpolated and then used to provide data for secondary interpolation of the grid cell centres.

**Minimum curvature**

This procedure is used to refine the grid. Minimum curvature algorithms are particularly useful for the contouring of potential field data and they generally produce an aesthetically pleasing representation of the surface that passes through the data points. The method used here is based on the paper by Briggs (1974). To speed up the calculations, some aspects of his algorithm have been modified.

Two stages are involved in the minimum curvature approach:

1. Re-evaluation of grid points near data points. Adjust the surface shape using the data points as anchors.

   Briggs provides a mathematically exact procedure for re-evaluation of grid points in the vicinity of data points. Unfortunately, this method is very expensive on computer time and requires considerable additional storage. Since this procedure is essentially an iterative one that uses approximations for the surrounding grid cell values, several approximations can be made which speed up the gridding process. An approximation to Briggs’ method is used with an algorithm which is similar to the grid cell reduction phase. Each mesh point that is evaluated is frozen and used as an anchor point in the minimum curvature iteration phase.

   This process can be thought of as a ‘data honouring’ stage. Despite this improvement in efficiency, it can be very time consuming especially if the complete grid cannot fit into memory and has to be paged from disc. In this case, the processing time is improved if the data is sorted in order of increasing ‘Northing’ or ‘Y’ value.

2. After the data honouring stage, an iteration stage is used in which all unfixed grid points are recalculated from the surrounding points based on the principles of minimum curvature. You control the number of iterations. The shape of the surface changes rapidly for the first 20 iterations and then more slowly as it approaches the ‘ideal’ shape. In most cases, 20 iterations provides a good representation of the final surface. Remember, that these iterations do not improve the data honouring, only the shape of the surface. Data honouring can be improved by running the Minimum Curvature operation multiple times on the one grid or by using a series of grid cell reductions (Reduce) and Minimum Curvature operations.
Grid Computation Procedure

To compute a grid in ModelVision, select the menu option provided. A dialog box is displayed as shown below:

![Dialog to control the gridding of channel data in ModelVision](image)

Data available for gridding can be of either line or point types. Select the data mode and the channel to be gridded. Modify the output grid name accordingly.

Grid limits can be defined manually or automatically. When using the automatic grid extent option, a masked outline is applied which extends a small distance beyond the limits of the channel dataset (usually 1-2 grid cells).

Grid controls enable the grid to be defined by either nominating a cell size, or defining the number of rows and columns desired. As a cell size is entered, the row and column numbers are automatically adjusted to cover the required grid origin and extent. The smaller the cell size, or the larger the numbers of rows or columns, the longer the grid takes to generate. Large grids can be created by ModelVision but usually this is not required.

As a general guide, for modelling purposes using theoretical response grids on portable computers, keep the grid size to approximately 100-200 rows and columns. Grids of this size are fast to generate and provide adequate resolution for screen display. If larger grids are required, for example with observed data, grid decimation can be implemented with the Model/Compression option.

If further control is required over the gridding process, the Expert Params push button can be selected. Modification of the gridding procedure is only recommended where the data must be honoured to a high degree and where the user has a detailed understanding of the processes involved in grid generation. When selected, the expert option dialog is presented as below.
The addition of extra Minimum Curvature and Reduce stages enhances the quality of the final grid but increase computation times. The gridding performs the list of operations as specified in the Selected box. The specific operations are:

- **Smooth** - This operation smooths the generated surface and reduces the amplitudes of oscillations caused by using the nearest neighbour evaluation of mesh points in the initial grid. The process uses a simple first order surface fitting procedure to recalculate the grid points on the basis of the surrounding values. The shape of the surface is improved both near the data points and in the spaces between data points. Usually only one Smooth operation is required.

- **Minimum Curvature** - This operation is used in two stages to refine a grid. The first stage re-evaluates grid points near data points but using the data as anchors. Each mesh point that is evaluated is 'frozen' and used as an anchor point in the following minimum curvature phase. This phase is called the 'data honouring' phase. The second stage is used to recalculate all unfixed grid points from surrounding points based on the principles of minimum curvature. The number of iterations is controlled by the entry in the dialog. The shape of the surface changes rapidly for the first 20 iterations and then more slowly as it approaches the ideal surface. These iterations do not improve the data honouring, only the shape of the surface.

Data honouring can be improved by selecting the Minimum Curvature operator several times or by combining it with the Reduce function.

- **Reduce** - The Reduce operator is used to create a finer grid for the minimum curvature procedure. The finer grid is required to more accurately represent the shape of the surface, particularly for closely spaced data points. In this process the input rows and columns are first interpolated and then used to provide for secondary interpolation of the grid cell centres.

**Note**

When initially displayed, the Grid Expert Parameters dialog has five gridding operations already selected. It is recommended that these operations remain as shown.
Interpolating Channel Values from a Grid

The Utility>Sample from Grid option permits the data locations of lines or points to have data interpolated from a nominated grid and assigned to a data channel. The operation of this feature is identical to the GINT function of the Calculator (see Special Functions).

You can specify which grids are to be interpolated and to which line locations. The operation works by computing the distances from each line reading location or data point to the grid nodes surrounding it. Based on the data values of the specified grid for each node, a value is computed, distance weighted and assigned to that reading. The values are placed in a named channel. The dialog for this operation is:

![Sample grid data into a line or point channel](Line/Grid Sample dialog for interpolating data values to lines)

Manipulating Gridded Data

The Grid Utility tool allows various operations to be performed on one or more specified input grids. These operations include:

- **Classify**
- **Clip** – exclude or include the data from a grid defined by an irregular polygonal region or by a rectangular region. The data can be clipped outside or inside the region.
- **Convert** – input a data grid in one format and save as another to convert the output format as required.
- **Create RGB** – combine separate grids having Red:Blue:Green colour signatures to a single, multi-banded RGB grid file.
- **Curvature**
- **Edit** – point to a grid node and the data values for it and its surrounding cells are displayed. You can edit the data values if required.
- **Fill Holes**
- **Flip** – the rows or the columns of a grid can be inverted in their location either horizontally or vertically.
- **Overlay**
• **Replace**—allow specific grid values (such as Nulls or nominated values) to be replaced by another data value or Null

• **Reproject**—permits the input grid to be reprojected to an alternative Projection and Spheroid/Datum combination.

• **Resample**—grids can be resampled to a new cell size using any of three available interpolation schemes.

• **Rotate**—a grid can be rotated about its defined origin by a specified angle. Interpolation processing is required for this procedure.

• **Shift**—apply an east or northing offset to the origin of a grid.

• **Split**—used for multi-banded grids, this operation outputs separate component grids of the individual single bands.

All functions are operated from a common dialog as shown below.

The upper portion of the dialog allows grids to be added to a list (from the **Browse** button). If you wish to apply operations on a created, flat grid, you can use the **Create Grid** button. By highlighting a grid in the list and clicking the **Information** button, a display of the grid statistics is provided. Other controls include a **Settings** button (to control the zoom level in the preview screens) and **Help**.

A **Utilities** pull-down list allows selection of the required operation and a **Description** for each is displayed when selected. As each Function is individually selected, the control parameters for that operation are displayed.
In the two Preview panes on the right side of the Grid Utility dialog are **Before** and **After** views of the selected grid. As you change the grid selection or the grid function, so the preview panes redraw and update with the changes. Note that the visual changes occur in memory only and are not permanently saved until you specify and save an output grid using the **Save As** button.

You can control the monochrome or colour appearance of the grids from the **Use Colour Look-Up table** button and a linear or equal area histogram stretch can be applied from the **Histogram Equalization** button. When the cursor is positioned in either of the Preview panes, its function (and appearance) alters depending on the selected button control at the bottom of the panes.

**Pointer mode** – Used to select a position or cell value in a grid.

**Zoom In or Out** – Click the button and move the cursor into the preview pane. Click again and the level of zoom doubles (or halves) each time the mouse is clicked. This zooming occurs in both Before and After panes.

**Pan the image content** in the preview pane by positioning the cursor, hold the left mouse button down and drag. When released the image is redrawn.

Return a zoomed or panned grid to its **default fitted preview** view.

Return a zoomed grid to a **1:1 zoom ratio**.
The **Settings** button allows a ‘cross-hairs’ cursor to be displayed in the After pane. A second setting toggles the display of the text After or Before if these are optionally not wanted. Beneath the various button controls (described above), the cursor position indicates the Column and Row location on the displayed grid.

At any time in the processing of a grid, the **Stop** button can be used to halt computation and return to the previous state.

### Classify

The Classify grid utility enables an input grid to have the value of each cell classified into one of a number of ranges. By default the input grid is automatically classified into 5 bins. Each bin represents an equal data range spread between the minimum and maximum grid values. The output cells are assigned a bin value of 1 to 5 based on the input cell value range.

Use the Auto button to automatically classify the grid cells. Use the **Auto classify** dialog to modify the **Input classification range** and the **Number of classifications** or bins in the output grid. By default the bin or classification values start at 1 and increase by 1 but these options can be changed by setting a new **Output value start** and **Output value step**. These are saved in the registry and are used as the defaults next time the Classify utility is opened. The input classification range is re-computed each time a new input grid is loaded.

Complete manual control of the classification process is possible by manually editing the bin ranges. In addition use the **Add row** and **Insert row** buttons to append or insert a row and the **Delete rows** button to remove rows from the classification. Hold down the SHIFT or CTRL keys to select multiple rows for deletion.

Note that to assign any classification of the grid ranges to their appropriate bins, you must:

- Turn on the option in the Settings to Use separate colour stretch after preview.
- Turn off the Histogram Equalization button for the colour stretch.

Specify the upper and lower range of data to be binned and the number and increment of bins.

Saving the output grid stores the binned data ranges with all null values being retained.
Clip

By opening a grid and selecting the **Clip** operation from the **Function** pull-down list, the following control parameters are displayed.

The Clipping process can operate in two ways:

- Define a rectangular area (using the Min and Max X and Y corner extents) and clip data as controlled by this region or

- Use a polygonal shape defined by a MapInfo .TAB or .MIF file, ESRI .SHP file or an Discover PA Features database polygon.

In both cases above, you can use the bounding region to clip data inside (using the **Clip grid to region**) or outside the area (using **Blank grid underneath region**).

Note that when a grid is clipped, where possible the size of the grid is minimized and nulls and unused whole rows or columns removed. This can substantially reduce the size of a large grid if only a small portion is extracted.

Convert

Selected grids can be converted to an alternate grid format. The formats available include:

- ER Mapper
- Geosoft
- Vertical Mapper
- Surfer
- Encom .GRD
- GeoTiff

No parameters are used for this option. Select the file required to be converted and then click the **Save As** button. From the **Save as type** pull-down list, nominate the output file format required and then give it a location and name. If you do not specify a file extension, the output file has the format’s default file extension added (refer to **Appendix A: File Formats**).
Create RGB

This operation combines single band grids into one multi-banded grid. This operation can be used for combining Red:Blue:Green grids to a single multi-banded RGB grid. It can also be used to combine multi-component data grids such as used in spectrometry (for example, Potassium, Uranium and Thorium).

Curvature

The Curvature utility calculates the curvature of a surface at each cell centre. Three types of curvature grids are available:

- **Profile** curvature is estimated along the direction of maximum slope
- **Plan** curvature is estimated across the direction of maximum slope
- **Surface** curvature is computed as the difference between the Profile and the Plan curvatures.

The method used to create the curvature grids is as follows:

Curvature is computed for the centre cell (e0) within a 3x3 kernel such as

<table>
<thead>
<tr>
<th>e1</th>
<th>e2</th>
<th>e3</th>
</tr>
</thead>
<tbody>
<tr>
<td>e4</td>
<td>e0</td>
<td>e5</td>
</tr>
<tr>
<td>e6</td>
<td>e7</td>
<td>e8</td>
</tr>
</tbody>
</table>

The first step is to estimate the coefficients D through H of a quadratic polynomial equation that fits the 3x3 window.

\[ z = Ax^2y^2 + Bx^2y + Cxy^2 + Dx^2 + Ey^2 + Fxy + Gx + Hy + I \]

where

\[ D = \frac{(e4+e5)/2-e0}{\text{CellSize}^2} \]
\[ E = \frac{(e2+e7)/2-e0}{\text{CellSize}^2} \]
\[ F = \frac{(-e1+e3+e6-e8)}{4\times\text{CellSize}^2} \]
\[ G = (-e_4+e_5)/2 \times \text{CellSize} \]
\[ H = (e_2-e_7)/2 \times \text{CellSize} \]

The Profile curvature is estimated along the direction of maximum slope and is computed as:

Profile Curvature = \(-2\left(\frac{DG^2+EH^2+FGH}{G^2+H^2}\right)\)

The Plan curvature is estimated across the direction of maximum slope and is computed as:

Plan Curvature = \(2\left(\frac{DH^2+EG^2-FGH}{G^2+H^2}\right)\)

The Surface Curvature is the difference between the Profile and Plan and is computed as:

Surface Curvature = \(-2(D+E)\)

If the output values are positive then the cell is upward convex, if negative it’s upward concave, if zero it’s flat. A positive curvature indicates that the surface is upwardly convex at that point, whilst a negative curvature indicates that the surface is upwardly concave. A value of zero indicates that the surface is flat.

**Edit**

The data values of grids can be individually selected and modified if required. Select a grid and highlight it in the grid list. The Preview panes show the grid after selection. After choosing **Edit** in the Function pull-down list, the Pointer mode can be used to select individual grid cells for editing. Select the **Pointer** mode button, move the cursor to the Preview pane and select the grid cell. When this is done, the spreadsheet reduplicates to indicate the data values of the selected cell and the various nodes around it.

If the level of zoom is inappropriate, select the magnifying glass **Zoom In** or **Zoom Out** buttons and adjust the view.

To more precisely locate the cursor and grid cell, you may also wish to display a line cursor (see diagram below). This is enabled from the **Settings** button.

Once a grid cell has been selected, double clicking inside the spreadsheet cell allows the data value to be edited with a new value typed from the keyboard.
Selected grid cell and displayed data value available for editing

Fill Holes

The Fill Holes utility is used to replace nulls in a grid by interpolating the surrounding data values. The following Fill Holes options are available:

- Fill internal holes only
- Only internal holes or null grid cells which are not connected by nulls to the outer edge of the grid are given a new interpolated value.
- Fill internal holes and nulls surrounding grid
- All null grid cells in the grid are replaced with interpolated values.

The method used to fill holes involves progressive interpolation from the outer rim of the hole towards the centre until the entire hole is filled. This process can be slow for large holes.

Flip

A selected grid can have the order of its rows reversed to produce a vertical flip and columns reversed to produce a horizontal flip. No change is made to the number of rows or columns of a grid in this operation and the extent and origin of the grid in unchanged.

Merge

The Merge grid tool allows multiple grids (overlapping or non-overlapping) to be combined into a single output grid. A number of data handling options are provided for overlapping cell values. This tool requires all grids to be in the same projection (use the Reproject Grid utility to convert grid projections).
In the **Merge grid** dialog, select the source grids from the pull-down list and use the **Add** button to add these to the **Grids to merge** window below. Selecting grids from this pull-down list will not force a refresh of the preview screen each time a grid is selected, which is useful when dealing with large grids. The preview screen can be manually refreshed using the **Update** button. Grids can be removed from the **Grids to merge** window using the **Remove** button.

A primary grid must be highlighted in the **Grids to merge** window; the Merge tool will use this grid's cell dimensions for the output grid.

A range of **Overlap combining methods** are provided for handling of overlapping grid cells: Minimum, Maximum, Average and Sum.

**Overlay**

The **Overlay** utility enables grid cells to be classified using polygons or polylines from a specified MapInfo TAB or MID/MIF vector file. The dialog is enabled once an appropriate vector file (polyline or polygons) is opened using the **Browse** button.

Grid cells may be attributed with a **Constant** overlay value by entering a numeric or text value into the **Overlay value** window. If the polygons or polylines in the vector file contain attributes then choose the **Overlay value from field** option and select the attribute field from the **Value** field pull-down list. All grid cells that are located within a polygon or polyline will have an output value equal to the overlay value of that polygon. Cells which are outside polygons or polylines in the vector file can be assigned a null value, the value of the input grid (unchanged) or a user-defined constant value.

In addition to the use of polygons in the input vector file, polylines and point objects are also supported. A **Buffer** zone may be specified by the user to control how wide these objects appear in the overlay output. The default buffer zone of 0 means that a polyline will create an overlay that is approximately one grid cell wide. For example, a buffer value of 15 will create a line overlay with a width of 30 metres (15 metres each side of the line). Points will result in a circular coverage with a radius equal to the buffer zone.

If the buffer zone value is non-zero then polygons will also have their boundaries extended by the amount specified. An example of an overlay with polygons used to define areas on a DEM surface is shown below:

![Use of a polygonal file to assign colour values over a grid surface plus the surface when displayed in a 3D view](image-url)
Replace

A specified grid data value or Nulls can be replaced globally within the specified input grid. This operation is especially useful when manipulating null values within grids. The value of a Null may differ with different grid formats but the Grid Utility compensates for this.

The dialog allows a ± Tolerance to be specified. An entered value allows the replacement process to vary about a range centred on the substitution value. For example, if a replacement value of 50,000 were used and a ± Tolerance of 10, then all values found in the grid between 49,990 and 50,010 would be replaced by the defined replacement entry.

Reproject

Most grids have a Projection and Spheroid/Datum specification either embedded in their format or in a separate header file (for example, .ERS in the case of ER Mapper files). This information can be re-specified by the Reproject option and used when a new output grid is written. Note that this operation relocates the various mesh points in the grid through an interpolation method to match the requested output Projection and Datum combination.

The Reproject dialog and associated controls

The dialog as shown allows the following functions:

- Both X/Y (Easting/Northing) or Latitude/Longitude grids can be reprojected.
- A wide range of Projections, Spheroids and Datums are supported for import and export.
- False Easting and False Northings can be defined
- The data can be interpolated using either Bilinear, Bicubic and Nearest Neighbour (see Resample).
Resample

Resampling a grid allows a resizing of the cell size of the grid. Select the Resample option in the Function pull-down list. The control parameters appear as below. You can specify a new height or width of the interpolated cells. By default these are set to be the same, but if you want to create rectangular mesh sizes for the grid, deselect the Lock cell width to cell height check box.

The resampling is done by interpolation of the specified input grid data values. The methods available include Bilinear, Bicubic and Nearest Neighbour.

These interpolation methods use a transformation (for scaling), where the row/column values \([u, v]\) describe a transformed plane and \([x, y]\) the original grid data plane. To determine the samples of the transformed grid \(g([m,n])\) from the samples of original \(f([k,l])\) the following steps are applied:

- Calculate \(c([k,l])\) from the grid values at each \(f([k,l])\) where \(c = \text{cell reference}\)
- For each \([m,n]\) of the transformed grid find corresponding source location \([x,y]\) in the input grid
- Compute \(f([x,y])\) using the spline model, where \(g([m,n])=f([x,y])\)

For the resampling of a grid to new cell sizes and comparing the fits using \(\phi_n([m,n])\), the order on the nth term determines the method applied where \(n=0\) (nearest neighbour), \(n=1\) (bilinear), \(n=3\) (bicubic).

Jagged or sharp edges using a nearest neighbour interpolation progressively smooth out in higher order spline-interpolation. Bicubic spline interpolation is popular as cubic splines appear smooth to the human eye.

After a cell size and method have been chosen, you can click the Update button to force the processing to proceed and review the result in the preview pane.

Rotate

Similarly to the Resample operation (see Resample), the interpolation methods of Bilinear, Bicubic and Nearest Neighbour can be used to rotate a grid around a fixed point (by default, its centre or the bottom left corner). The control parameters for this function are shown below:
An angle that is positive causes the rotation to be clockwise and vice versa.

**Shift**

The origin of a grid can be transformed horizontally and/or vertically using the Shift function of the Grid Utility. The control parameters appear as below. Entries of a New grid origin can be made or you can enter a specific Offset for either the east (X) or north (Y) directions. Once the shift parameters are entered, clicking the Update button causes the grid to redisplay with the adjustment in the After preview pane.

**Split**

The Split outputs the individual bands of a multi-banded grid (such as an RGB grid) and outputs individual, single band grids.

**Reporting and Statistics**

- *Calculating Statistics*
- *Generating Reports*

**Calculating Statistics**

Project, Project/Line, Drillhole, Points and Grid statistics can be obtained from this menu item.

- *Project and Line Statistics*
Drillhole Statistics

Point Statistics

Grid Statistics

Project and Line Statistics

This option presents a dialog that summarizes the basic statistics of a ModelVision project that is stored in memory.

The dialog shown below provides information on either project statistics or individual line statistics. This choice is controlled by the Project/Line buttons. When the Line option is selected, the list box displays the available lines for selection.

Statistics of a project

- **Project Limits** defines the spatial extent of the data set and the total line length in terms of the currently defined unit of distance (metres).

- **Line Attributes** provides information on line orientation, line length and average data spacing.

**Note**

When Line Statistics are being displayed, by double clicking while the cursor is located over a line name, the statistics display for that line are presented.

- **Project/Line Statistics** shows detailed statistics for each channel, including the number of points, minimum channel value (Min), maximum channel value (Max), average channel value (Average) and standard deviation (Std Dev). If the Line option is selected the statistics apply to the currently selected line name. A scrollable list is available to select the line required.

- **Report** option enables a data report to be created. Refer to the section on Reports for additional information.

- **Body Statistics** option is not yet implemented.
Drillhole Statistics

Display drillhole dataset statistics in a similar manner to line based statistics. Again, both project and individual drillhole statistics can be selected. Refer to Project and Line Statistics for additional information.

Point Statistics

Display point dataset statistics in a similar manner to line based statistics. Again, both project and individual drillhole statistics can be selected. Refer to Project and Line Statistics for additional information.

Grid Statistics

The grid statistics option provides origin, extent, mesh size, row/column numbers and null information on an imported or generated grid.

An example of a grid statistics display is shown below.

![Grid Data Statistics](image)

Grid statistics display showing relevant information for a selected grid

All grids loaded into memory can be accessed through the pull down list.

Generating Reports

The reporting option is available as part of the Calculating Statistics and Reporting and Statistics features of the Utility menu. Reports are available for projects, lines, points and drillholes. These files are written to named output files (with default file extension .RPT). Directory paths and browsing are available using the Browse push button. A descriptive comment can be added, as shown in the following dialog.
The created report is an ASCII file that can be viewed by a text editor or incorporated into larger reports and documents.
14 Graphical Output

In this section:

- Printing
- Making a Movie

Printing

The File>Print option enables ModelVision to create hardcopy output to a printer or plotter. Selection of the Print option automatically outputs a copy of the active window to a printer (where connected) or to a print file. The printing function operates on the active, highlighted display window only. The output can be scaled or simply made to fit a predefined page size. Output destination is controlled by the Print Setup options. When selected, the Print option determines the printer settings, device/paper size and window size. From these parameters, ModelVision estimates a suitable scale to fit the print.

Print Scaling

Hardcopy prints can be scaled to a user defined scale. Scaled output is limited in size by the physical size of the hardcopy media being used. For example, it is not possible to print a complete large scale map on a single A4 piece of paper if the scaling definition is too small. ModelVision takes the size of the requested paper and scale accordingly. If the print does not fit the paper, a warning is presented. If you print anyway, the print is performed but clipping occurs.

Scaling control is slightly different between the two display types of maps and profiles (or multi-tracks). Map scaling uses the same scale in both a vertical and horizontal direction. Profile scaling however, is scalable only in the horizontal direction. It is possible to define the height of a plot to be created but it is not feasible to scale individual tracks since numerous tracks, channels and individual ranges can be used in profile displays. It is possible in cross-section plots to force the horizontal to vertical scales to be identical. This is important where the cross-section plots are used for planning drillhole intersections with developed models.

An example of map scaling is shown below.
Map drawing limits, paper dimensions from the printer setup and the scaled drawing size are reported. The computed scale is unlikely to be a convenient size because of variable data and window extents. A precise scale can be entered, but if ModelVision computes that the desired scale is too large for the available paper, a message is displayed warning that clipping occurs. When this message is displayed, adjust the scale to match the print to the available page size.

In the case of profile scaling, when the Print option is requested, the following dialog is presented:

The dialog provides a summary of the requested paper and plot sizes at the nominated scale. Scaling of the print is similar to that of map scaling. However, the initial vertical scale defaults to the vertical size of the requested paper size. If either a vertical or horizontal scale is requested which is too small (resulting in a print size too large for the available paper), and a warning message is displayed.
Print Setup

Printer setup and connection to hardcopy devices is controlled by the File>Print Setup option. This feature enables access to various printer types, the orientation, paper size and destination of the print. For a more detailed explanation of the Print Setup utility, refer to the Microsoft Windows Users Guide.

Note

A wide range of printer types are supported by the Windows operating system. As well as printers, output can also be directed to plotters, ink jet and thermal printing devices for which Windows drivers are available from the manufacturer. Also note that output for a particular hard-copy device can usually be directed to a file. This situation is often necessary on networked installations or where the printer is not physically connected to the operating computer.

The Print Setup option displays a window like this:

![Print Setup menu options](image)

Specific printers can be selected by using this menu. Depending on which printer type is selected, the Options or Properties item displays various controls that can be set through subsequent menus.

Printer Error

In some cases an error will be generated when either electing to print or when changing the printer during printer setup.

![ModelVision Pro](image)

This is caused by either selecting a printer or having a default printer which is not supported.
The underlying platform for ModelVision is called XVT. Unfortunately XVT source code is not available to ModelVision developers so we cannot modify the code to add support for these printers.

You can get around this error by printing to an Adobe Acrobat (PDF) file. You may need to load a free PDF printer such as CutePDF (www.cutepdf.com) or one of the many free PDF printers available. (Conduct an Internet search using the term "free PDF printer" to find alternatives.)

Once you have a PDF printer installed and have printed your output to a PDF file, you will then be able to print to any printer that is supported by PDF.

This method of printing also allows easy electronic exchange of printed output.

**Making a Movie**

The **Movie Mode** is a utility, which allows the user to capture changes to a model made during inversion and then replay the changes as a movie.

Example session where a line inversion is performed on a tabular body while the Movie Mode utility is recording the sequence of changes made to the body parameters.

To open this utility, select the **Movie Mode** button on the main toolbar. This will display the toolbar as shown below:

The Movie Mode utility.

The operations available from this utility are:
Click | To do this
---|---
| **Record** movie
| **Stop** recording
| Show the **first model**
| **Play** or **Pause** the recording
| Show the **final model**
| **Configure** the speed of the movie replay. When selected, a slider appears at the bottom of the utility with which you can adjust the replay speed.
| **Delete** the recording
15 UBC Model Mesh Designer (Optional Module)

In this section:

- About UBC Software
- Working with UBC Software
- Installing UBC Software
- Before You Start
- Preparing Your Data
- Regional Modelling
- Model Conditioning for UBC Inversion
- UBC Mesh and Data File Creation

The UBC Model Mesh Designer module is not automatically available. A message is displayed when the tool is selected if the module is not licensed on the computer you are using. For licensing details, please contact Tensor Research Pty Ltd (see Getting Help).

About UBC Software

This section describes how ModelVision provides an effective interface to the UBC-GIF programs GRAV3D and MAG3D.

The University of British Columbia, Geophysical Inversion Facility developed the 3D voxel inversion programs called GRAV3D and MAG3D. These programs complement the ModelVision polyhedral modelling system by providing a method for modelling continuous magnetic and density changes. GRAV3D and MAG3D split the sub-surface into voxels (volume elements) where each cell is assigned a single density or susceptibility.
A UBC-GIF mesh model displayed in the Meshtools3D program supplied with GRAV3D and MAG3D

Each cell is rectilinear, but the size of cells can vary in the x, y and z directions. The UBC-GIF programs produce a smooth inversion of the physical properties within the fixed geometry mesh. By setting a threshold on the physical properties, it is possible to create a boundary through the mesh.

Example of a UBC-GIF gravity inversion with a threshold set for the display of the voxels that have a density greater than 0.096 g/cc.

The UBC-GIF smooth inversion method has many different parameters that can be used to control the characteristics of the resulting physical property distribution. Each method can produce a different distribution of physical properties. The difficulty is to decide which one produces the most realistic distribution that is consistent with the geology.

ModelVision provides an effective method for creation of the mesh, associated data files and geological constraints. The figure below illustrates the distribution of densities assigned to the mesh by using a ModelVision tabular body to represent the overburden and a plunging prism to populate a high density zone in the mesh.
ModelVision also provides an effective method for controlling the outcomes of the smooth inversion process, by allowing you to seed the mesh with a starting model, reference model and bounds model. Note that a bounds model is supported in both GRAV3D and MAG3D.

Effective use of the UBC inversion programs also requires careful removal of the regional magnetic and gravity fields. ModelVision has a powerful 2D regional modelling facility that is ideal for validating the regional in the context of the geological problem that you are trying to solve.

Model outputs from ModelVision and the UBC-GIF programs can be integrated with other data and model sources using Discover PA. Use Discover PA to integrate drillhole data, geophysical grids, geological maps, airborne EM ground EM and geochemistry with your ModelVision, GRAV3D and MAG3D outputs.
Working with UBC Software

The operating instructions for the UBC-GIF programs GRAV3D and MAG3D are included with the UBC software distribution. In this guide, you will learn about the following procedures required to condition the data and create ready-to-run models:

- **Installing UBC Software**
- **Before You Start**
- **Preparing Your Data**
- **Regional Modelling**
- **Model Conditioning for UBC Inversion**
- **UBC Mesh and Data File Creation**
- **GRAV3D and MAG3D Interface**

**Installing UBC Software**

A separate CD-ROM is provided for the installation of the UBC software. Also included on the CD are tutorials, documentation and instructions on the use of the various programs. To install the UBC modules, please follow the steps below:

**Copy the UBC files to your computer**

1. Copy the contents of the CD to your hard drive and place in a folder named `UBC`. This folder should reside beneath the root of the drive or as a subdirectory beneath other folders (but with no blank spaces in the pathname). For example, `D:\UBC` or `C:\My Programs\UBC`.

**Important**
The path name can have any directory structure but folder names in the path must not contain blank spaces. This limitation is imposed by UBC to maintain compatibility between UNIX and PC operating systems. The limitation applies to both the software installation path and also to data or project paths.

**Tell ModelVision where to find the UBC programs**

2. Navigate to the `\Program Files\Encom\MVIS` folder and open the `MVISION.INI` file in Notepad.

3. In the `[DIRECTORIES]` section, make an entry similar to that below (using your UBC program path name):

   ```ini
   UBCMag=D:\UBC\Mag3D
   or
   UBCGrav=D:\UBC\Grav3D
   ```

**Install the License Manager**

4. Run `Encom_License_Manager_Setup.exe`, which can be found on the UBC installation disk in the `\Licensing` folder and follow the on-screen prompts. Select **Single License** as the installation type. Proceed through and complete the steps to install the License Manager.
License the ModelVision UBC Model Mesh Designer module

5. The ModelVision UBC Model Mesh Designer license is optional. To check that you have a valid license, open the License Manager and check the installed software. For more information, see Installing ModelVision.

Before You Start

Before you create the UBC mesh models, you need to plan your strategy to achieve an optimal inversion result. This includes:

- Preparing Your Data
- Regional Modelling
- Model Conditioning for UBC Inversion
- UBC Mesh and Data File Creation

Before you start the exercise, you should familiarize yourself with the GRAV3D and MAG3D Interface and associated documentation.

In almost all cases, the preparation for GRAV3D and MAG3D is identical. The method is illustrated with a gravity modelling exercise.

Preparing Your Data

The different modelling styles of ModelVision and the UBC-GIF programs require an understanding of the methods and benefits of each method. Although the various data sets required for running a UBC inversion are well defined, they are not well suited to manual preparation methods. ModelVision has all the tools needed to pre-condition the geophysical data and generates all the files in the appropriate formats. The data that you will need includes:

Lines with data fields:

- Easting (X)
- Northing (Y)
- Elevation of sensor (Z) Note this is positive up.
- Bouguer gravity or total magnetic intensity at sensor elevation (Grav or Mag)

Grids of:

- Topography (optional)
- Bouguer gravity or total magnetic intensity

If you are using GRAV3D, you need to apply a vertical offset to the sensor channel to avoid measurement locations falling exactly on a mesh node. The UBC-GIF manual recommends adding 1 metre to the sensor elevation. Use the Utility>Calculator facility to create a new data channel. This avoids a potential singularity where the measurement points are coincident with the mesh. Name this channel Zplus1.
You also need to create an error channel for both the gravity and magnetic cases. In most cases you create a constant value channel with the Utility>Calculator. Use a value equal to the standard deviation of the noise. If you have an independent noise estimator that varies with each station, it can be used in the creation of the UBC model files. Name this channel GravSD or MagSD.

At this stage your ModelVision channel list should look like:

X
Y
Z
Zplus1
Grav or Mag
GravSD or MagSD

You can choose to model gravity at a fixed elevation above the shallowest mesh point. In this case Zplus1 is the elevation of the top of the mesh plus 1 metre.

**Subset a Project**

Most modelling exercises are focused on a limited area of a larger survey and ModelVision provides a convenient method for selecting a rectangular subset of a larger project area. Use the Clip Project toolbar button to clip a rectangular area from your project (see Using the Clip Project Tool). This tool clips out a subset of the lines, points, grids and drill holes from within the larger project area. Note that models are not clipped.

It is recommended that you save your main project as a master session file before you do the clipping. This means that you can generate multiple UBC-GIF sub-projects from the master session file.

Note also, that it is much easier to generate a local regional for a subset of the project than a large survey area.

**Regional Modelling**

Conditioning of the magnetic and gravity data is essential for achieving meaningful results from a UBC inversion. Inappropriate regional gradients can easily distort the lateral density and susceptibility distributions and hence the perception of geological boundaries.
ModelVision provides tools for creation and manipulation of a two dimensional regional gravity or magnetic field that is subtracted from the field data during modelling. The example above shows a cross-section view along one line out of a sequence of lines used to control the characteristics of the regional field surface.

Although you can let ModelVision determine this surface semi-automatically, the best results are achieved when the regional surface is treated as part of the interpretation. In the interpretation shown in the below example, the regional is a smoothly varying surface that is consistent from line to line and consistent with the geological model. The geological model is used to seed the GRAV3D inversion and provide constraints for the inversion process.

![Example map view showing a smoothly varying regional consistent with the geological model](image)

The stacked profile map view of the 2D regional used to provide a residual gravity field that is consistent with the geological model and surrounding geological influences.

The example in the above figure shows that a single model and a 3rd order regional gravity field can explain a significant proportion of the anomalies present in the survey. ModelVision could model the remaining anomalies, but the minor perturbations in the gravity profiles would take considerable effort for manual modelling. By using the starting model which is the focus of the inversion exercise, GRAV3D can be used conveniently to model the remainder of the gravity anomalies present in the field data.

Once you have produced a satisfactory regional gravity field, calculate the residual gravity field using the Line Calculator (see [Computing New Channels](#)). Your channel list should now look similar to that shown in the following figure.

![Statistics report showing the channel list used in preparation for running a GRAV3D inversion](image)
Model Conditioning for UBC Inversion

The UBC-GIF program GRAV3D provides a method for specifying the range of densities that are valid for every voxel in the model. This facility can be used to bias the outcomes of the inversion by incorporating geological knowledge into the inversion process. This provides a method that helps overcome the non-uniqueness problems in gravity inversion.

![ModelVision body property dialog showing the fields provided to insert density and susceptibility ranges](image)

The dialog in the above figure illustrates the method for entering ranges for density and susceptibility. Note that the UBC-GIF program MAG3D does not support susceptibility ranges and ModelVision provides this facility for possible future support by the University of British Columbia.

UBC Mesh and Data File Creation

Once you have prepared the data channels and grids within ModelVision, the creation of the UBC-GIF model mesh and associated data files is managed through the Modules>UBC Model Mesh Designer menu function. This opens a dialog similar to the one shown below that provides access to all the parameters required to define the mesh and associated data files. It also provides buttons to run the UBC-GIF, GRAV3D User Interface and MeshTools3D programs. The tabbed dialog provides control over the mesh geometry, physical property bounds and data outputs.

- **Mesh Design**
- **Density Bounds**
- **Data Outputs**

The Perspective view will provide the visualization of the mesh design being created by enabling the UBC display check box.
Mesh Design

The UBC mesh structure consists of a core volume that is the focus of the modelling and a padding region that is designed to manage the region surrounding your geological objective. The padding region may contain data, but this is not essential. The core region will normally have small voxel sizes while the padding region will have enlarged cells. The fine cells are required to preserve detail in the final geological model. Review the UBC-GIF documentation for recommendations on the cell sizes and data spacing.

Independent tab controls are provided for the X, Y and Z limits. The boundaries of the regions are seeded from the model and project limits. These can be manually controlled through the dialog entries. Use a map view of the model and data along with the 3D perspective view to provide feedback while entering parameters into the dialog.

It is recommended to first set the origin of the mesh. In plan view this is the south-west corner of the core whether or not you have an outer padding region. In the Z dimension it is the top of the mesh. The thickness of the core and padded regions should then be adjusted. As you adjust these values the boxes showing the perimeter of the regions will update. This should be done for each of the X, Y and Z tab pages.

As the core and padding regions are changed in the dialog, the bounding boxes of these regions are updated in the 3D perspective view as shown above. This facility makes it easier to see the relationship between the model and mesh limits to ensure that the target geology is properly covered.
The padding cells can be expanded progressively by using the geometric growth parameter in the above dialog. A value between 1.2 and 1.5 is recommended. This smooth increase in voxel size allows you to reduce the size of the core area while maintaining sensitivity in the vicinity of your target geology. This factor can significantly reduce the total number of cells required for modelling and hence the total inversion time.

Finally you should set the number of cells each region is divided into and whether they are equally spaced or not. The individual cells can be displayed by changing the drop-down list from Perimeter to All Cells. Cells are equally spaced initially so the upper pad region of 500 m had 5 cells of 100 m. If the geometric factor is changed to say 0.7 then successive cells are 0.7 of the thickness of the previous cell so they get thinner or if the factor is greater than 1 then they get bigger. The total thickness remains the same.

The number of cells cannot be set to zero so if you wish to remove the top padding but retain the bottom padding you should set the top padding thickness to zero.

In the X and Y dimensions the core can only have linear spaced divisions and the outer padding has a single geometric factor applying to all.

The cell property assigned to a voxel has two modes:

- **Add** means accumulate the properties of successive bodies that occupy the same voxel.

- **Replace** means replace the voxel value with the property of the last body in the list that occupies that voxel space. The body order is determined by the order in the ModelVision TKM file.
A thresholded UBC mesh view of the converted ModelVision model

The UBC-GIF mesh is populated with properties based on a set of rules.

- Fill all voxels with the background property of zero.
- Each voxel is analysed to see if it is dominantly inside or outside a body.
- If it is inside the body, the voxel value is replaced by the value of the body.
- If Add mode is turned on the body property is added to the existing value assigned to the voxel.

Density Bounds

A density bounds file can be created for use with GRAV3D. This file is used to limit the range of values that can be derived during inversion. This is useful for constraining an inversion where there is suitable geological information available to constrain the outcomes. Geological information can be inferred or assigned from specific density information from drilling or outcrop sample.

An example of inferred information is the assignment of a narrow density range for overburden. This has a focusing effect on the inversion by forcing most of the variation to be taken up below the unconformity layer.

Measurements of density values can be introduced as bodies that are used to spread the measurement information over a volume. This method of introducing physical property measurements works better with smooth inversion than the introduction of specific points of measurements. The latter tends to produce local anomalies that do not produce realistic geological solutions.
The background density range is assigned for all regions that are not occupied by a ModelVision model. The default value for this range is -2.0 to +2.0 g/cm³.

**Data Outputs**

The data files required by GRAV3D and MAG3D are controlled from the Data tab entry in the mesh designer dialog. Here you assign the ModelVision channels and grids to the appropriate outputs.

Some choices are allowed in the creation of the output files. For example you can choose to model the gravity at a constant elevation, in which case you use the assigned value instead of an internal channel created by ModelVision. The data error can be assigned a constant value by selecting the radio button under the fixed value field position.

The topography file used by GRAV3D and MAG3D must cover the complete area of the mesh and as a result it cannot be derived from the line data used in the project. As a result of this requirement, you must import a topographic grid that covers the map area of the mesh and ModelVision creates the UBC-GIF topographic file from this grid.
Note that you can also assign a constant value for the topography. All voxels above the topographic surface are assigned null values. The value of null is defined as -100 for density models and -1 for susceptibility models.

If your data is closely spaced, you can decimate the data by using a sample interval greater than 1. It is recommended in the UBC-GIF programs that the data spacing is approximately equivalent to the voxel spacing in the core of the mesh.

To create the mesh and output data files, select the Create button. This generates all the necessary files needed to run the inversion. Note that the Clear mesh button removes the design from memory and resets the bounds information of the body properties.

**GRAV3D and MAG3D Interface**

The UBC-GIF inversion programs GRAV3D and MAG3D each have their own graphical user interface. ModelVision provides a UBC-GUI button. Use this feature after you Create the mesh and the UBC dialog will automatically start with the correct files loaded.

There are many parameters available in the GRAV3D and MAG3D User Interfaces and you are referred to the UBC documentation for further information on these parameters. Once you run the inversion, you can use the MeshTools3D or Discover PA Voxel Modeller module to visualize the inversion results. ModelVision does not provide a visualization tools for the mesh models.

The UBC-GUI application provides an integrated approach to managing the various programs used to produce an inversion output. It produces the control files that are used by the individual programs defined in the UBC documentation.
Generated Files

ModelVision produces a set of files that are used by the UBC-GUI application.

Gravity data files

MESH.DAT – mesh file
MODEL.DEN – density file for MESH.DAT
BOUNDS.DEN – density bounds for each cell in the model
OBS.GRV – gravity observation with noise estimates
OBSGRAV.LOC – location of points for computation of the model data
TOPO.DAT – topography data that covers the area of the mesh.

Magnetic data files

MESH.DAT – mesh file
MODEL.SUS – magnetic susceptibility file for MESH.DAT
OBS.MAG – magnetic observation with noise estimates
OBSMAG.LOC – location of points for computation of the model data
TOPO.DAT – topography data that covers the area of the mesh.
In this section:

- About QuickDepth
- Background Theory
- Preparing Your Data
- QuickDepth Depth Interpretation

The QuickDepth module is not automatically available. A message is displayed when the tool is selected if the module is not licensed on the computer you are using. For licensing details, please contact Tensor Research Pty Ltd (see Getting Help).

About QuickDepth

QuickDepth is a new approach to calculating the depth to a magnetic source for isolated magnetic anomalies using a variety of techniques that do not require inversion. The method operates by dragging the mouse across the anomaly you want to interpret to produce immediate feedback on the depth to the source of the anomaly.

The input data is a high quality total magnetic intensity grid and the magnetic line data including the levelled magnetic field, sensor elevation and ground surface elevation or radar altimeter channels.

The magnetic tensor and a range of other magnetic field measures are computed from the total magnetic field grid. This data provides key geological information that is used to assist in the depth interpretation and improve the quality of the estimates compared with conventional automated processes. Importantly, the depth is estimated from the data along the flight line to preserve the highest quality gradient information to produce the best possible depth estimates.

The tensor of the total magnetic field is used to derive geological characteristics such as strike direction, body type, centre of magnetization and depth to the top of the magnetic unit. This information is used to constrain and improve the precision of the other geophysical methods which include:

- Euler 2D Method
- Peters’ Length Method
- Werner Deconvolution Method
- Tilt Depth Method
- Euler 3D Method

We use the peak of the normalised source strength (NSS) from Clark (2014) to define the horizontal (X, Y) location of the centre of magnetization which simplifies the calculations of depth for the Euler 2D, Werner and Tilt Depth methods.

The strike direction of the anomaly (Pederson & Rasmussen, 1990) is used to correct the depth estimates for acute angle flight lines for the Tensor, Peters’ Length, Werner Deconvolution and Tilt Depth methods.
The tensor analysis also provides a dimensionality index which automatically differentiates between pipe-like magnetic sources and linear magnetic formations or dykes. This allows for different depth correction techniques to be applied according to the geology. Some methods such as Euler 2D analysis are very sensitive to an incorrect choice of the geological magnetic source type.

The tensor also provides some information about the width of the magnetic source and classifies it as thin, intermediate or thick.

Importantly, you are in control of the geology. While the underlying code does its best to determine the characteristics of the geological target, you can override the automated selection when appropriate.

A quality estimator is presented as a guide, but it should not be used as an overriding principle for selection of the best solution. The rules for estimating quality are discussed below and are based on simplistic principles that rely heavily on interference estimation and robustness of the method.

**Background Theory**

The tensor analysis underpins much of the depth estimation procedures by providing geological information that can be used to improve the accuracy of the other methods. Information such as strike direction relative to the flight line direction, magnetic source width and shape, change the underlying assumptions used by the non-inversion depth estimation techniques.

The following sub-sections outline the basic theory that is used by each of the methods.

- **Magnetic Tensor**
- **Euler 2D Method**
- **Peters’ Length Method**
- **Werner Deconvolution Method**
- **Tilt Depth Method**
- **Euler 3D Method**

**Magnetic Tensor**

The geophysical properties of the magnetic tensor were introduced by Pederson & Rasmussen (1990) and Clark (2014) who developed the concept behind the normalised source strength (NSS) calculation using eigenvector analysis of the tensor. Important concepts from their research are discussed here to show how the theoretical concepts can be converted into practical geological applications.

**Dimensionality index (DI)**

The DI parameter is derived from the 1st and 2nd invariants $I_1$ and $I_2$ of the tensor $(B_{ij})$ using the formula

$$DI = -(I_2/2)^2/(I_1/3)^3$$

ranges between 0 and 1, and
\[ I_1 = B_{xx}B_{yy} + B_{yy}B_{zz} + B_{xx}B_{zz} - B_{xy}^2 - B_{yz}^2 - B_{xz}^2 \]
\[ I_2 = B_{xx}(B_{yy}B_{zz} - B_{yz}^2) + B_{xy}(B_{yz}B_{xz} - B_{xy}B_{zz}) + B_{xz}(B_{xy}B_{yz} - B_{xz}B_{yy}) \]

If \( DI \) is zero, then the magnetic source is linear like a dyke or linear magnetic formation. When it is 1 it is associated with a pipe-like magnetic source. In between it ranges from semi-linear to pipe-like. \( DI \) is used to make an initial interpretation of the shape of the source.

**Azimuth (Az)**

The azimuth or strike direction of the anomaly affects the depth calculation for linear magnetic sources if they are not perpendicular to the line direction. We compute the absolute azimuth of the anomaly from the tensor data and then we compare that direction with the line direction to apply a strike correction. Because this correction is very important, the value is displayed in the QuickDepth dialog so that you can make changes if you disagree with the computed direction. The calculation is reasonably robust for clean data.

The azimuth (\( \text{Az} \)) is computed using the formula:

\[
\tan(2\text{Az}) = \frac{2[B_{xy}(B_{xx} + B_{yy}) + B_{xz}B_{yz}]}{[B_{xx}^2 - B_{yy}^2 + B_{xz}^2 - B_{yz}^2]}
\]

**Thickness**

This parameter is used to describe the width of a linear magnetic source as a function of the sensor height above the magnetic source. If it is less than the sensor height, it is classified as thin because it is not possible to reliably estimate the thickness. You should also realise that the magnetic susceptibility x thickness product is valid, but no unique magnetic susceptibility can be computed. The dimensionality index and normalised source strength anomaly shape are used to estimate the thickness classification. This is not a robust method, so it is important for you to override the classification if you believe the result is inconsistent with your geological interpretation of the target.

Medium thickness is used where the body width is estimated to be between 1 and 2 times the depth from the sensor and a "thick" classification is used for bodies that are wider than twice the sensor height above the target source.

Some of the depth calculation methods use this parameter to apply a depth correction.

**Depth**

the depth is estimated from the shape characteristics of the anomaly and corrected for the Thickness classification and anomaly azimuth.

**Normalised Source Strength (NSS)**

Clark (2012, 2014) defined the normalised source strength in terms of the three eigenvalues derived from the magnetic tensor.

\[
\mu = (-\lambda_2^2 - \lambda_2\lambda_3)^{1/2}
\]

where are \( \lambda_1, \lambda_2, \lambda_3 \) are the eigenvalues of the magnetic gradient tensor sorted into descending order by absolute value and where

\[
\lambda_1 = -(\lambda_2 + \lambda_3)
\]

so that Laplace's equation is satisfied.
The NSS trace is very similar to the analytic signal, but it peaks over the centre of magnetization of the target, is not influenced by remanent magnetization, provides excellent shape characteristics for depth estimation and provides a direct indicator for the presence and magnitude of interference from adjacent magnetic anomalies. As the width of the target becomes thick, the peak splits into two with peaks over each edge of the body.

Magnetic susceptibility - is estimated from the following approximation formula (Nelson, 1988):

\[ k = 0.625 \frac{z}{T_g_0} / (B_{IGRF} (\sin^2 I + \cos^2 I \cos^2 D)) \]

where

- \( z \) is the depth below sensor of the target
- \( T_g_0 \) is the total gradient at the NSS maximum
- \( B_{IGRF} \) is the inducing field strength
- \( I \) is the field inclination
- \( D \) is the field declination.

And the total gradient is defined by

\[ T_g_0 = (B_{xz}^2 + B_{yz}^2 + B_{zz}^2)^{1/2} \]

**Quality**

is estimated in a qualitative way using direct estimation of anomaly interference and the general robustness of the method. The development of a quality estimator is meant as a rough guide and should not be taken as a direct estimator of the reliability of the depth estimate. It is still being developed and tested and the overall best guide relates to the standard deviation depth estimate for the selected body type in the Best row of the QuickDepth interpretation dialog.

**Euler 2D Method**

The Euler method is based on the original work by Thompson using the formula;

\[ (x-x_0) dB_{m}/dx + (y-y_0) dB_{m}/dy - z_0 dB_{m}/dz = -NB_{res} \]

Where \( B_{m} \) is the total measured field intensity at a general \( x, y \) location, \( B_{res} \) is the total field anomaly after subtraction of the regional,

- \( x_0, y_0 \) is the location of the centre of magnetization,
- \( z_0 \) is the depth,
- \( N \) is the structural index.

The structural index is normally defined in terms of poles and dipoles, but these terms have a physical geological equivalent.

- \( N=1 \) is a line of poles and equivalent to a thin sheet or magnetic formation.
- \( N=2 \) is a point pole and equivalent to a narrow vertical pipe.
N=2 is also a line of dipoles that can be used for a sill or channel fill.

N=3 is a point dipole that can be used for sphere and ellipsoids.

The user decides on the most appropriate geology and QuickDepth automatically uses the appropriate N value in the formula.

Now the centre of magnetization x₀, y₀ is derived directly from the location of the normalized source strength (NSS) peak which then means that (x - x₀) and (y - y₀) both equal zero at the peak and the Euler equation simplifies to

\[ z₀ = \frac{N B_{ref}}{(dB_m/ dz)} \]

The tensor analysis will produce an integer estimate for N that the user will override if required and the value of dB_m/ dz is the vertical gradient of the measured total magnetic field intensity at the centre of magnetization (x₀, y₀) derived from the NSS peak location.

Note that the use of a single point for the ellipsoid and pipe is unstable in high gradient areas and we generally expect much larger errors for this method.

**Peters’ Length Method**

Peters’ Length (Peters, 1949) is a robust analysis method that produces a depth estimate for almost any anomaly shape. It was developed before computing became widely available and could be performed graphically from the profile curve. The method is illustrated in the figure below and is easily implemented as a numerical process. The maximum gradient is estimated from the horizontal gradient and then the half slope intercepts are easily located on either side of the horizontal gradient peak. The distance between these intercepts is called the Peters’ Length.

This length is not equal to the depth, but it does approximate the depth depending upon the geological shape of the magnetic source. Correction multipliers are used for the various geological shapes to calculate a more reliable depth estimate. These correction factors are not as sensitive as the Euler 2D method where the wrong index can make a very large change to the calculated depth. Skilberi (1993) shows that the correction multiplier for sheets that converts the Peters’ Length to depth varies between 0.5 and 0.82 depending on the thickness of the sheet. We have derived correction factors for the various geological shapes using a range of theoretical models.
Illustration of the graphical method used to estimate the Peters' Length.

This method is robust because the shape of the anomaly between the half slope points is closely related to the depth.

**Werner Deconvolution Method**

The Werner deconvolution method is more complex than the Euler method because it resolves the local regional and solves for two thin sheets or an interface within the one window. The basic formula for the magnetic field is defined by Werner (1953) as:

\[
T_x = \left( A_1 z_1 + B_{m1} (x - x_1) \right) / \left( (x - x_1)^2 + z_1^2 \right) \\
+ \left( (A_2 z_2 + B_{m2} (x - x_2)) / \left( (x - x_2)^2 + z_2^2 \right) \right) \\
+ (a_0 + a_1 x + a_2 x^2)
\]

The first two bracketed terms in Werner's equation are the magnetic field response functions for two thin sheets and the last group in brackets is a second order regional field contribution.

Since we know we are solving for a single source magnetic anomaly with a linear regional, we can simplify the formula to,

\[
T_x = \left( A z + B_m (x) \right) / \left( x^2 + z^2 \right) + (a_0 + a_1 x)
\]

where \( x_1 \) is the NSS peak and the distance is set to zero. The last term represents the linear regional.

This equation is computed for a number of \( x \) locations and the matrix of equations is solved for the source parameters using singular value decomposition.

**Tilt Depth Method**

Salem et al. (2007) defined the tilt angle of the magnetic field as:

\[
Tilt = \tan^{-1} \left( dB_m / dz / dB_m / dh \right)
\]

where
\[
\frac{dB_m}{dh} = ((\frac{dB_m}{dx})^2 + (\frac{dB_m}{dy})^2)^{1/2}
\]

When applying the tilt method to RTP data it can be shown that the depth can be derived directly from the tilt angle using the formula;

\[
\text{Tilt} = \tan^{-1}(\frac{h}{z})
\]

where, \( h \) is the half the distance between +45 degree tilt and -45 degree tilt angles on either side of the wide body edge. The tilt depth \( h \) equals the depth at the ±45 degrees tilt angle locations on either side of the zero crossing.

The theory is based on the edge of a contact and thus is strictly only applicable to a contact. The method does not require the location of the contact, but it can be derived from the NSS peak or zero Tilt location.

**Euler 3D Method**

We use the tensor method for calculation of the Euler 3D solution which is based on the work of Schmidt et.al (2004). The method uses both the tensor and magnetic field components to solve for the structural index and depth. The basic formulation is shown in their equation 23 as follows,

\[
\begin{bmatrix}
\frac{\partial B_x}{\partial x} & \frac{\partial B_x}{\partial y} & \frac{\partial B_x}{\partial z} \\
\frac{\partial B_y}{\partial x} & \frac{\partial B_y}{\partial y} & \frac{\partial B_y}{\partial z} \\
\frac{\partial B_z}{\partial x} & \frac{\partial B_z}{\partial y} & \frac{\partial B_z}{\partial z}
\end{bmatrix}
\begin{bmatrix}
x - x_0 \\
y - y_0 \\
z - z_0
\end{bmatrix} = -n
\begin{bmatrix}
B_x \\
B_y \\
B_z
\end{bmatrix}
\]

where the tensor appears on the left-hand side and the components on the right. The map location for the centre of magnetization is known from the peak location of the normalised source strength (NSS) which means \( x - x_0 = 0 \) and \( y - y_0 = 0 \). The sensor location is equal to \( z \).

The equations are solved using five critical points along the profile that include the NSS peak location, upper Peter's Length half slope locations and inflection points. This provides an optimum value for the depth location \( z_0 \) and a fractional value for the structural index. Please note that the Euler 3D theory is based on integer values of the structural index \( n \) which correspond to specific geological body concepts. There is no theory that relates fractional values of \( n \) to a specific geological interpretation. The derived index is rounded up or down to the nearest integer value and translated to the equivalent geological shape. Our experiments show that this method gives significantly more reliable depth estimates than fractional values of \( n \).

The field components are calculated by Fourier transformation of the total magnetic intensity grid and assume that the local regional has been removed. The local regional in complex areas is unlikely to be correct and thus the field components will also be incorrect. We recommend that you only rely on the Euler 3D results when the magnetic anomalies are isolated from other disturbing sources.
Preparing Your Data

The broad range of methods requires the calculation of derived magnetic field parameters. The parameters are listed in the following table and are mostly derived from FFT processing of the total magnetic intensity (Bm) grid. The individual grids are then resampled onto the flight lines to create new data channels.

Table of Magnetic Field Parameters by Depth Method

<table>
<thead>
<tr>
<th>Input Channels</th>
<th>Tensor</th>
<th>Euler 2D</th>
<th>Euler 3D (d)</th>
<th>Peters' Length</th>
<th>Werner Decon.</th>
<th>Tilt Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tensor gradient components Bxx, Bxy, Bxz, Byy, Byz, Bzz</td>
<td>Yes(a)</td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Magnetic field components Bx, By, Bz</td>
<td></td>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Horizontal gradients dBm/dx, dBm/dy</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td>Yes(c)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vertical gradient dBm/dz</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NSS</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Bm (RTP)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Bm (original line data)</td>
<td>Yes(b)</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

(a) The tensor also provides the strike azimuth and body type
(b) Anomaly amplitude determined by Bm (max) - Bm (min) at NSS minima
(c) dBm/dx, dBm/dy calculated after RTP
(d) Not implemented in first release.

The grids are prepared by accessing the menu **Tools>QuickDepth>Prepare Data** option.

This will open the **QuickDepth Data Loading** dialog which has a section for the specification of the input magnetic grid and a second section for selection of the required input line data channels. Note that you must load your magnetic grid and flight line data into ModelVision prior to running the QuickDepth module.
QuickDepth data loading & grid processing dialog

The input grid must be the total magnetic intensity grid for the area to be investigated. A high resolution grid is preferred to preserve the gradient information on the edge of the anomalies. Once you have specified the input grid, you start with the Process grids button.

This processing can take a long time depending upon the size of the input grid and it will generate 19 output grids. This limits the size of the largest grid that can be used, so you may need to split your project into smaller sections. Use the Clip project toolbar button to create smaller projects from a master project that contains just your input grid and flight line data.

Line Data Channels

The Line Data Channels are quickly generated in the second part of the QuickDepth Data Loading dialog by interpolation of the grids onto the line data channels. The computed data channels listed in the following table will appear in ModelVision after selecting the Process Line button. The processing is very fast compared with the grid processing stage.

Our primary goal is to compute the depth below the ground surface, so you need to specify or create a sensor elevation channel (Zgps) and a ground surface elevation channel (DTM).

To generate these data channels, you need two of the following three parameters;

Zgps = sensor elevation
Alt = ground clearance from altimeter
DTM = ground surface elevation
You use the **Mode** button to cycle through the options and select the one that best suits your requirements. Note that altimeter data is often noisy and it may be appropriate to apply a low pass filter to the data if you plan to use it.

For older surveys, the Zgps and terrain elevation may not be available. If you have ground clearance information you can turn off the **Sensor elevation** and **Elevation DEM** check boxes and enter a fixed value for each. In general, you would set the ground surface elevation (DEM) to zero.

**UC height** – Grid FFT processing of derivative channels such as the tensor adds a small amount of noise to the output channels and it is necessary to upward continue the NSS channel which is derived from eigenvector analysis of the full tensor channels. We recommend a **UC height** value in metres of 50% of the grid cell size of your input magnetic grid. If the NSSFUC channel still looks noisy across the anomaly peaks, then you can experiment with larger continuation heights. Tensor depths are corrected for upward continuation. Enter the UC height before you run **Process lines**.

**Field Channel Names Created by Resampling of the Grids**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BFxx</td>
<td>Bxx tensor component</td>
</tr>
<tr>
<td>BFxy</td>
<td>Bxy tensor component</td>
</tr>
<tr>
<td>BFxz</td>
<td>Bxz tensor component</td>
</tr>
<tr>
<td>BFyy</td>
<td>Byy tensor component</td>
</tr>
<tr>
<td>BFyz</td>
<td>Byz tensor component</td>
</tr>
<tr>
<td>BFzz</td>
<td>Bzz tensor component</td>
</tr>
<tr>
<td>BFx</td>
<td>Bx field component</td>
</tr>
<tr>
<td>BFy</td>
<td>By field component</td>
</tr>
<tr>
<td>BFz</td>
<td>Bz field component</td>
</tr>
<tr>
<td>BmVD</td>
<td>Vertical derivative of total magnetic field</td>
</tr>
<tr>
<td>BmRTP</td>
<td>Reduction to pole of total magnetic field</td>
</tr>
<tr>
<td>NSSF</td>
<td>Normalised source strength</td>
</tr>
<tr>
<td>NSSFUC</td>
<td>Upward continued normalised source strength</td>
</tr>
<tr>
<td>NSSHD</td>
<td>Horizontal derivative of normalised source strength</td>
</tr>
<tr>
<td>BmHD</td>
<td>Horizontal derivative of total magnetic intensity</td>
</tr>
<tr>
<td>dBdz</td>
<td>Vertical gradient of the vertical magnetic field component</td>
</tr>
<tr>
<td>I1</td>
<td>First invariant of the magnetic tensor</td>
</tr>
<tr>
<td>I2</td>
<td>Second invariant of the magnetic tensor</td>
</tr>
<tr>
<td>Tilt</td>
<td>Tilt of the total magnetic field</td>
</tr>
</tbody>
</table>

You can delete all the grids apart from the total magnetic intensity grid when you have finished the initial processing. We recommend that you export useful grids such as BFzz, BFz, BmVD, BmRTP, NSSF, NSSFUC, dBdz which can be used to assist your geological interpretation.
First you must prepare the settings for the cross-section display of QuickDepth points. Use the **Model>Line Control** dialog and set the input channel to your corrected magnetic data channel (Mag) and check **Use Regional**. Make sure that the **Use Sensor Elevation** and the **Display Topography Channel** are allocated to the correct channel names. QuickDepth calculates both the elevation of the target and the depth below the ground surface (DEPTHBG).

**QuickDepth Depth Interpretation**

Processed grids displayed in Discover PA Professional
The Line Control dialog showing selection of the sensor elevation (Zgps) and the topographic channel (DEM).

The regional is computed line by line if you open one section line at a time and fit a first order regional to the line. This makes it easier to see the magnetic data because the MAG_MOD channel is always zero if no model is present and a regional has not been calculated. This can create a large separation between the Mag and MAG_MOD channels. The section will look something like that shown in the following figure.

Initial cross-section display with linear regional
It is helpful to display the upward continued NSS channel NSSFUC as part of the interpretation because it shows you the location of the target peaks and level of interference from surrounding anomalies. Use the Add aux tracks button in the QuickDepth>Prepare Data dialog to automatically bring up the channel selector as shown below.

Add NSSFUC to an auxiliary cross-section track

The NSSFUC channel is added to this cross-section and any other sections that are open. Change the cross-section vertical scale to one representative of the expected depth range and then use the right mouse click option Apply Scale to All.

Cross-section with auxiliary track added and pull-down menu access via the right mouse click

Note that you can also remove all auxiliary tracks using the Remove aux button in the QuickDepth>Prepare Data dialog.

Auxiliary track add and remove buttons for the display of the upward continued NSS channel NSSFUC
Start the Interpretation dialog from the **Tools>QuickDepth>Interpretation** menu. This dialog can stay open during the whole process while you open and close cross-section windows. You can close the dialog and reopen it whenever required and it will continue to save solutions into a Point dataset called QuickDepth points.

QuickDepth operates on cross-sections, but the results are also visualised in open map windows. You can have one or more cross-section windows open at any time and switch between them according to your focus.

**Anomaly Selection**

The process for interpretation involves the following steps:

- Make the target cross-section active
- Select a data range across the target anomaly
- Compute the depths
- Select the Best method
- Adjust the auto-detected body type
- Save the depth solution
After making the working cross-section active, select the **Refine selection in Xsection** button then use the mouse to select that data range by dragging the mouse (depressed left mouse button) across the data in the anomaly track. Two vertical dashed lines will indicate the location of the selection as shown in the above figure.

Select a broad area without including sections of adjacent anomalies.

**Depth Computation**

Select the **Compute depths** button and the dialog fields will be populated with the results for the different computation methods. The first column shows the depth below ground (**Depth BG**) which is calculated by subtracting the sensor height from the underlying depth computation. The depth below sensor is also available once the result is saved.
The second column contains the estimated **Azimuth** direction (compass bearing) of the anomaly trend which is derived from the tensor data. In this example the true azimuth is 135 degrees compared with the estimated 134 degrees. In general, this computation is reasonably robust for elongate anomalies.

The third column is populated with QuickDepth's best interpretation of the body type. In this case it has correctly picked the thin sheet using a combination of the dimensionality index and the anomaly shape characteristics. Note that the Tilt method only supports the Edge type so the Thin sheet is an inappropriate **Type**. While it has applied the analysis method in this case, the **Depth BG** is obviously different from the first four methods.

The quality estimator (**Qual%**) shows values ranging from 85% to 95% with the **Tensor** method showing the highest. This is meant to be a guide only and if the quality values are all within 10% to 15% then it is OK to select another method where the quality may not be the highest.

In this example, the **Best** method has been selected as the Tensor. The correct result for this model is 100 metres where the Werner method gave the closest match. In this context all results for the first four methods would be acceptable.

**Depth Statistics**

Below the results table is a line that shows the statistics for the best body type solutions. In the above example, there are four thin sheets with a mean of 101.3 metres and standard deviation of 4.4 metres. There are four solutions that support the thin sheet body style, but the Tilt method only supports the edge body type. The **Best Method** body **Type** determines which body will be included in the statistics.

**Save Your Best Result**

To save the result into the QuickDepth point data sets in memory, select the **Save this result** button. This will increment the **Total** counter for the current line and update the total number of **Solutions** across all lines.

Use the **File>Export>Point Data** menu option to create data for use in other applications. Use the **Oasis montaj GDB** option where you want to preserve the line identification or **CSV** when you want to export all points into a single entity.

Each QuickDepth solution has a set of attributes with the names of the attributes listed in the first column of the QuickDepth point table.
QuickDepth Point Table Definitions

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>Easting</td>
</tr>
<tr>
<td>Y</td>
<td>Northing</td>
</tr>
<tr>
<td>FID</td>
<td>Fiducial</td>
</tr>
<tr>
<td>ANOM</td>
<td>Anomaly number</td>
</tr>
<tr>
<td>METHOD</td>
<td>Interpretation method Tensor, Euler etc. #1</td>
</tr>
<tr>
<td>BTYPE</td>
<td>Body type #2</td>
</tr>
<tr>
<td>DEPTH</td>
<td>Depth below sea level (-ve above sea level)</td>
</tr>
<tr>
<td>RADALT</td>
<td>Ground clearance of sensor</td>
</tr>
<tr>
<td>ELEV</td>
<td>Elevation of sensor</td>
</tr>
<tr>
<td>DEM</td>
<td>Elevation of ground surface</td>
</tr>
<tr>
<td>DEPTHBG</td>
<td>QuickDepth solution depth below ground surface</td>
</tr>
<tr>
<td>ADELEV</td>
<td>QuickDepth solution elevation</td>
</tr>
<tr>
<td>SUSC</td>
<td>Susceptibility estimate</td>
</tr>
<tr>
<td>DIPAZIM</td>
<td>Azimuth of dip</td>
</tr>
<tr>
<td>STRIKEAZIM</td>
<td>Azimuth of strike</td>
</tr>
<tr>
<td>THICKNESS</td>
<td>Thickness estimate</td>
</tr>
<tr>
<td>STRIKELEN</td>
<td>Assigned strike length</td>
</tr>
<tr>
<td>DIPA</td>
<td>Dip angle (always 90)</td>
</tr>
<tr>
<td>REM</td>
<td>Reversal indicator (0 normal, -1 reversed)</td>
</tr>
<tr>
<td>DPTHXTNT</td>
<td>Assigned depth extent</td>
</tr>
<tr>
<td>SI</td>
<td>Structural index or dimensionality index (DI)</td>
</tr>
<tr>
<td>QUAL</td>
<td>Quality estimator</td>
</tr>
<tr>
<td>DBGAV</td>
<td>Average depth below ground for body type</td>
</tr>
<tr>
<td>DBGSD</td>
<td>Standard deviation of depth below ground</td>
</tr>
</tbody>
</table>

#1 METHOD is the number of interpretation method selected by the interpreter to provide the best possible solution.

<table>
<thead>
<tr>
<th>METHOD</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tensor</td>
<td>1</td>
</tr>
<tr>
<td>Euler(2D)</td>
<td>2</td>
</tr>
<tr>
<td>Werner</td>
<td>3</td>
</tr>
<tr>
<td>Peter's length</td>
<td>4</td>
</tr>
<tr>
<td>AutoMag</td>
<td>5</td>
</tr>
<tr>
<td>Tilt</td>
<td>6</td>
</tr>
<tr>
<td>Euler(3D)</td>
<td>7</td>
</tr>
</tbody>
</table>

#2 BTYPE is the number of the body type that was selected from the pull-down list associated with the best METHOD.

<table>
<thead>
<tr>
<th>BTYPE</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipe</td>
<td>1</td>
</tr>
<tr>
<td>Thin sheet</td>
<td>2</td>
</tr>
</tbody>
</table>
Save Other Results

Use the Export measures to save a summary of the results for the different methods that have been applied to the current anomaly.

Show Table of All Possible Results

Use the Show Full Table button to see all possible results for this anomaly. Here you can see individual results along with the dimensionality index (DI) and structural index (SI).

<table>
<thead>
<tr>
<th>BTYPE</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medium sheet</td>
<td>3</td>
</tr>
<tr>
<td>Thick sheet</td>
<td>4</td>
</tr>
<tr>
<td>Edge</td>
<td>5</td>
</tr>
<tr>
<td>Sill</td>
<td>6</td>
</tr>
<tr>
<td>Ellipsoid/sphere</td>
<td>7</td>
</tr>
</tbody>
</table>

Table showing all possible QuickDepth results. The solutions shown in the QuickDepth dialog are shown with a CHK and the final solution is also shown with a Best check box.

Section Display of Solutions

As you interpret each anomaly and save the solution, a symbol representing the top centre of the target (excluding the ellipsoid) is posted in the cross-section. In the case of the sphere or ellipsoid, only the centre of magnetization can be estimated.
Northern hemisphere example of the results from nine different model sections showing the QuickDepth solutions plotted as square symbols and colour modulated by body type (BTYPE)

You can change the symbol colour defaults by accessing the QuickDepth Solutions layer in the Cross Section Layers Table. You activate this table using a right mouse click in the section view and then select Configure Layers.

The modulation by BTYPE or body type is useful in this context as it helps differentiate the body types that you selected with the Best check box.

QuickDepth Solutions layer dialog for changing the display parameters of the solutions
Map Display of Solutions

QuickDepth symbols will be added to an open map view each time you save a new anomaly interpretation (see figure below). If the symbols are not displayed, they can be added to the view from the Map layers control dialog by selecting the QuickDepth Solutions. Use the right mouse click in the left-hand column and select the layer called QuickDepth points.

To change the appearance of the symbols or add depth annotations to the map, open the QuickDepth Points Modulation dialog by double clicking on the left-hand column of the QuickDepth Solution layer in the layer table.

The symbols use the STRIKEAZIM field for orienting the long symbol axis for bodies of type sheet, sill and edge. A circular symbol is used for pipe and ellipsoid body styles.

In the example below, all the model bodies are at a depth below ground of 100m and the numbers show the interpreted depth below the ground surface. Apart from line L 06, the depths are within 10% of the true depth. The thick pipe bodies used on line L 06 have width twice the depth from the sensor and only thin pipes are currently supported in QuickDepth where the width of the pipe is less than the depth below the sensor.
You access the symbol annotations by selecting the **Channel Annotation** button where you can select the point field (channel name), font, offset and orientation.
17 AutoMag (Optional Module)

In this section:

- About AutoMag
- AutoMag Overview
- Single Anomaly Tutorial
- AutoMag Controls
- Running AutoMag in Batch Mode

The AutoMag module is not automatically available. A message is displayed when the tool is selected if the module is not licensed on the computer you are using. For licensing details, please contact Tensor Research Pty Ltd (see Getting Help).

About AutoMag

Depth-to-magnetic source calculations have occupied geophysicists for months and years depending upon the scale and objectives of the project. Manual techniques such as the Straight Slope method and Peter's Length have been used for depth estimation for many decades. These procedures are mechanical, repetitive and time consuming but require a skilled geophysicist to reject inappropriate magnetic anomalies.

Manual methods are still used today because they produce consistent results with judicious rejection of spurious anomalies. Computer procedures for automatic depth interpretation have become increasingly popular to replace the tedium and high labour cost of manual procedures. One such procedure that has become very popular over the last five years is the Euler 2D method. These methods work well as a first pass assessment of the magnetic source distribution, but lack the critical input of the interpreter in rejecting spurious solution. Invariably there are too many solutions and the relationship between the magnetic anomaly and an individual solution is unclear.

Manual methods are tedious and time consuming and fully automated methods lack the critical intervention of the geophysical interpreter. AutoMag bridges this gap by providing a consistent automated process that removes the tedium of the manual process and provides the interpreter with the ability to quickly test any solution against forward model solutions. Interpreted depths can be plotted in cross-section, map view or exported to an ASCII file for use in another application. Depths from the AutoMag solutions can be gridded to produce a contoured map of 'depth to basement'.

AutoMag Overview

This section describes the background theory to the Naudy method on which AutoMag is based.

- AutoMag Versus Other Methods
- AutoMag Theory
AutoMag Versus Other Methods

Traditional methods of magnetic depth estimation that rely on only a few statistics of an anomaly have been largely rendered obsolete by the ability to analyse complete anomalies in digital form. Batch magnetic depth estimation generally using the Werner, Euler and Naudy methods have become popular.

Batch depth estimation refers to the procedure of automatic processing of a complete dataset. ModelVision is an interactive modelling system but it provides both interactive and batch capabilities for the operation of AutoMag.

In most implementations of magnetic depth estimators, quality criteria are set empirically through inspection of the number and distribution of the solutions with respect to the observed field variations. The greatest strength of AutoMag that sets it apart from other magnetic depth estimators is that it provides much greater discrimination in the generation of solutions. AutoMag solutions are fully specified as source bodies and are delivered in a modelling environment where they can be immediately tested against the observed data. This procedure allows you to investigate the field variation that is attributable to any one source. You are able to thereby tune AutoMag for maximum discrimination in generating required solutions while eliminating spurious ones. The ability to tune AutoMag while investigating the exact significance of any solution provides considerable power and versatility to the complex problem of depth estimation.

In cases where the geology is appropriate for representation by AutoMag derived bodies, the solutions provide excellent starting models that may require only minor modification by forward or inverse modelling to match complete data profiles.

AutoMag Theory

AutoMag is based on a curve-matching method devised by Naudy (1971) and further developed by Shi (1991,1993). The original Naudy’s method is a two stage process:

1. Locate the potential source locations
2. Revising the depth estimate for the solutions.

This basic structure has been retained in AutoMag. Naudy split the input curve into symmetric and anti-symmetric parts to help resolve ambiguities in locating anomalies. Shi (1991) refined this analysis using both horizontal and vertical field components and extended the analysis to include vertical gradient data.

Both the anomaly location and depth estimation phases of the process are based on the correlation of a theoretical anomaly response with the measured data.

Naudy defined a similarity coefficient $R$ as

$$R = (1 - |r|)^{10^5}$$

where $r$ is the correlation coefficient.

This statistic has a minimum value for a strong correlation. Traditionally $R$ is plotted on logarithmic displays to retain sensitivity across a wide variation range. To produce a statistic that is more easily manipulated we have redefined the similarity coefficient as:

$$R = 100 \ln 10((1 - |r|)^{10^5})$$
The value $R$ is generally between 100 and 400. The amount by which the threshold value of parameter is varied during tuning of AutoMag is almost independent of its absolute value.

In the first stage, the theoretical anomaly response from an initial depth guess is correlated with the measured magnetic data. The similarity coefficient trace is analysed to locate isolated minima. Each minimum is a candidate for the second stage of the depth analysis. An example of a profile with displayed similarity coefficient traces is shown below.

In the second stage, a segment of the measured data is extracted across each of the isolated anomalies and correlated with the theoretical model response. A series of correlations are performed for different model values of depth and thickness. Note that the values used are centred on the depth and width values used for the initial model guess. This produces a 2D table of similarity coefficients. The minimum in this table is used to obtain the depth and thickness of the body. Dip and susceptibility are computed using relationships for the vertical and horizontal components of the magnetic field Shi (1991).

**Single Anomaly Tutorial**

Although AutoMag is an automated depth analysis procedure, it requires parameters to be entered to control the process. Values assigned to these control parameters have a major impact on the quality of the estimated depths and other source parameters. For this reason, we begin describing the operations of AutoMag with a simple theoretical test case. You will learn how to set the parameters and extract a depth estimate for the theoretical source that closely matches the input model.

The steps involved in running AutoMag are:

- Set the Parameters
- Run the Analysis
- Display the Solution
- Modulate and Annotate the Solution
- Test the Solution
- Save Your Solutions
Setup the Data

Follow the example below to generate a synthetic data set for a simple tabular model.

1. Use the Utility>Synthetic Lines menu option to generate a single east-west line that has a sample spacing of 20 metres and is 4,000 metres long about a reference point of (2000,2000).

2. To create a magnetic channel, name the elevation channel “MAG”.

3. Make sure the line control has Model Magnetics set with the input channel selected as MAG. Uncheck Display Topography Channel.

4. Open a cross-section for the synthetic line and generate a tabular body model that has the following properties:

   Tabular Body Properties
   Depth 250
   Thickness 400
   Depth extent 2500
   Strike length 5000
   Dip 90 deg
   X position 2000
   Azimuth 0
   Susceptibility default

5. Compute the forward model response.

To create a synthetic input magnetic channel, use the calculator on Line data and use the following formula:

   \[ \text{MAG} = \text{MAG} \_\text{MOD} \]

You should have a display similar to that shown below. The amplitude response may be different depending upon the default magnetic susceptibility and magnetic units of measurement.

![Synthetic model for a single tabular body](image)
6. Start AutoMag from the AutoMag toolbar located in the Modules menu. Select Run and a dialog box is displayed with the available control parameters.

![Control dialog presented when AutoMag Run is selected](image)

The controls are grouped under Background Control and Operational Parameters. Background parameters normally remain the same throughout the project, while operational parameters are constantly varied for tuning of the AutoMag operations.

**Set the Parameters**

- **Background Control**
- **Operational Parameters**
- **Anomaly Location**
- **Depth Estimation**

You can also *Use Quick Inversion to Estimate Parameters.*

**Background Control**

![Background control parameters used by AutoMag](image)

- **Select Lines** controls the input data lines that AutoMag is run over. If you start AutoMag from a section display, this control will not be visible as the section will be the only active line.
• **Channel select** controls the input channel for depth calculation. If you have applied an upward continuation filter to the magnetic data you could select it as an alternative for input to AutoMag.

• **RTP** is an on/off control for using reduction to the pole data instead of raw magnetic field values. Research by Shi (1993) has shown that use of reduced to the pole data gives consistently better results for AutoMag depth calculations. When this option is turned on (default), the magnetic field values are reduced to the pole based on the current inclination and declination parameters. Make sure that these are set correctly in the **Model>Magnetic Field** menu options or from the Status Bar. If you want to use your own RTP data set, make sure that the inclination is set to 90 degrees and the declination is zero.

• **Vertical gradient** is computed internally from the magnetic field data if this option is enabled. AutoMag computations are performed on the vertical gradient, rather than the total magnetic intensity. Vertical gradient data provides better separation of anomalies when magnetic sources are close together. Results are consistently better when this option is turned on (default). With noisy magnetic data, the vertical gradient enhances noise and you may achieve improved results by applying an upward continuation filter first. A correction can be applied later in the ModelVision calculator by subtracting the upward continuation height from the AutoMag depths.

• **Constant Susceptibility** allows you to assign a constant susceptibility to all AutoMag solutions. AutoMag generates a thickness and susceptibility for every solution. For bodies where their thickness is less than 50% of their depth, the product of thickness and susceptibility has interesting properties. For a given value of the susceptibility-thickness product, the thickness and susceptibility can be varied through a wide range without significantly changing the amplitude or shape of the magnetic anomaly. We use this relationship to allow you to force a constant susceptibility on the solutions. This may be valid when studying dykes related to a particular intrusive event. Variations in magnetic properties may reasonably be expected to be consistent over large areas. If you have estimates for the magnetic properties, you can estimate the thickness of the dykes.

• **Strike length** of AutoMag solutions is determined by this value. Since AutoMag computes the solution from a profile, it assumes that the strike length is infinite. For modelling, you need to assign a strike length that is relevant to the scale of the project. In practice, an infinite strike length is approximated by a distance that is 5 to 10 times the depth to the source.

• **Body type** can be dyke, sheet or edge. AutoMag uses a different theoretical model for each body type during the inversion phase. Each body type is interpreted as a tabular body by ModelVision. Dyke is the default body type and its thickness can vary through a wide range. This is the most flexible body type for routine depth interpretation. A thin sheet is converted to a thin tabular body. An edge is converted to a thick tabular body where one side of the tabular body is equivalent to the edge and the other side is displaced far away from the edge. This rendering of the solution provides a convenient mechanism for testing the edge solution as the edge model is not explicitly supported in ModelVision. If it is thought that a pair of edge solutions are derived from opposite sides of a wide body, such a pair can be converted into a single thick tabular body.
Operational Parameters

Understanding the behaviour of the operational parameters is the key to successful depth estimation in AutoMag. For a large project you will access these controls many times to tune the parameters on a few key flight lines before applying the ‘standard parameters’ to the whole survey. It is recommended that you experiment with these parameters in controlled model situations. When first using AutoMag, you should use single body theoretical models where you know the answer and progress to more complex models - this teaches you how to tune the parameters. Even after you have gained this experience, it is recommended that you use synthetic models in the initial stages of real projects.

The synthetic models can be constructed to reflect typical geological environments in your project area. Key aspects of these models should include probable depth, thickness and susceptibility ranges. If you have interfering magnetic sources at shallow depth, what will their impact be on the interpretation? Should I use upward continuation to minimize the influence of shallow interfering magnetic sources?

Internally, AutoMag performs its analysis in two passes. The first pass is designed to locate the anomalies that will be analysed and the second performs the anomaly inversion. The philosophy of this two pass operation is discussed more fully in the original paper by Naudy (1971).

Anomaly Location

Anomalies are located by correlating the magnetic anomaly response of a starting model with the magnetic survey data. Naudy derives a correlation factor called a ‘similarity coefficient’ that is traditionally displayed on a logarithmic scale. These values vary between 1 and 100,000 where a low value represents a high similarity. Similarity coefficients are used constantly by the interpreter for specification of detection threshold values that range through three decades. Since it is difficult to think linearly in logarithmic space, AutoMag re-scales the similarity coefficients to a linear range by taking the log of the similarity coefficient and multiplied it by 100. As a result of this transformation, useful thresholds vary linearly between 200 and 400. See over for an example of these coefficients.
Control of both the anomaly location and inversion passes is provided by a single dialog box that is started from the Run button on the AutoMag toolbar. For a first time user this can be confusing and without a proper understanding of the control parameters, poor results may be obtained. In the above figure the relationship between the AutoMag controls and the cross-section is highlighted as well as highlighting parameters required in the anomaly location pass.

An initial dyke model is shown in black to represent the starting parameters shown in the dialog box where the dyke has an initial depth of 100m and width of 100m. This is compared with the final solution that is shown as an open rectangle below the magnetic anomaly. As the window size is increased, so are the initial model depth and thickness. On the third depth pass the correlation model depth has increased to 300m which is much closer to that of the final solution. This pass has the best defined similarity coefficient curve with a well-defined minimum centred on the anomaly.

**Note**

The initial body is not shown on ModelVision cross-sections but is used here for pictorial reasons.

Controls that influence the sensitivity of anomaly location are:
Top - Initial depth to correlation model

- Top is the depth to the top of the body that will be used for generating the similarity coefficients. This is the depth for the initial pass. For each pass of the operator, the depth is increased in multiples of the pass number. If the initial depth is 100m on pass one, it becomes 200m on pass two, 300m on pass three and so on. Start with an interval that is approximately half the expected depth to the magnetic sources.

Width - Initial width of correlation model

- Width is the initial body width used for generating the similarity coefficients. This also expands in multiples of the pass number. Unless you are specifically studying a thick (wide) magnetic source, use a starting value that is less than 50% of the expected width.

Sample spacing - Data interpolation interval

- Sample spacing determines the interval that is used to interpolate the field data for use by AutoMag in the inversion process. This interval also determines the total length of the AutoMag window. Total window length is determined by multiplying the sample spacing by the number of samples in the AutoMag operator.

Number of depth passes - Expand window for each pass

- Depth passes determines the number of expansions of the AutoMag operator. Sample spacing is increased as a multiple of the current pass number. This effectively increases the depth of investigation as the operator expands. If both shallow and deep sources exist, aliasing of the shallow source anomalies may take place as the operator expands. This will increase the noise in the solutions. For this reason, it is possible to individually select pass numbers.

Two options exist to help avoid the problem of interpreting both shallow and deep sources:

- You can increase the number of samples in the operator (see Window size) but this increases the computation time.

- Upward continue the data to reduce the influence of the shallow sources and do a specific AutoMag run that focuses on the deeper sources.

Window size - Total width of AutoMag window

- Window size can be set in terms of distance or samples. If you choose distance, the window size is determined by multiplying the sample interval by the number of samples in the AutoMag operator window. The default number of samples is 25 selected as an optimum value based on experience with the Naudy method. To change the number of samples in the window, click on the down arrow and select samples. Change the current value from 25 to some other appropriate value. Typically the window size should just encompass the minimum and maximum of an anomaly. The window size field will automatically be updated. It is recommended that you do not change this value from 25 until you have become an experienced AutoMag user.
**Similarity coefficient cutoff - Threshold for anomaly acceptance.**

- Similarity coefficient cut-off is the threshold value below which AutoMag will attempt to perform its model inversion. If the similarity coefficient is below this value, AutoMag searches for a local minimum in the coefficients. AutoMag uses this location as the centre of a window for performing a detailed analysis of the data within the window. In general, it is better to have a slightly higher similarity coefficient and use the filtering to adjust this value.

**Depth Estimation**

Depth estimation is the most important phase of the AutoMag process and it is numerically intensive. If the initial anomaly location process finds too many locations for analysis, the depth estimation process will take a long time to run, often analysing spurious anomalies. A brief summary is provided, however for full details of this procedure refer to Naudy’s original paper.

Given the starting depth, width and anomaly location, AutoMag performs a detailed analysis by varying the depth and width parameters over a suitable range of values. It generates a table of similarity coefficients for the parameter range and locates the minimum within the table. Depth and thickness are determined from the table. Magnetic susceptibility is computed and an arbitrary depth extent of 10 times the depth to the top is assigned to the solution for the dyke model.

Once the anomaly has been located, only three additional controls are required:

- **Window size** in the inversion stage is normally shorter than the initial location phase. This helps AutoMag to focus on a smaller part of the anomaly to minimize the interference from adjacent anomaly sources. Window size is controlled by the number of samples in the window. This is reduced from 25 samples for anomaly location to 19 samples for the depth calculation stage. It is recommended that you leave this at 19 until you have become an experienced AutoMag user.

- **Cutoff** for the similarity coefficient is also reduced because the inversion process is now well focussed and the minimum in the 2D depth-width table should provide a more discerning threshold. If this is not the case, there may be too much interference from adjacent anomalies and you want these rejected to minimize spurious depth calculations.

- **On** for depth estimation is a switch that allows you to perform only the initial anomaly location phase. This speeds up the process of selecting optimal parameters by avoiding the time consuming second depth estimation phase.

**Use Quick Inversion to Estimate Parameters**

As an alternative to setting up the parameters manually or by trial-and-error, you can run Quick Inversion on a typical anomaly in the area and have it generate AutoMag parameters from the Quick Inversion solution. For more information, see [Quick Inversion](#).

When selecting a typical anomaly, it is best to err on the side of shallow rather than deep as the expanding window will find deeper solutions.
Open a section with the typical anomaly and select the data. Run Quick Inversion to a satisfactory solution. Then click the **AutoMag** button in the lower right of the Quick Inversion dialog box. This will open AutoMag and populate the depth and width fields with appropriate values.

**Run the Analysis**

When the operational parameters have been selected (Set the Parameters), select OK and AutoMag will begin the analysis. You can see a progress bar appear and progressively work through the various sample passes. In more complex data sets, it speeds up and slows down depending upon how many anomalies are located in each pass. If you have five passes selected, usually you will find few solutions and AutoMag will speed through this pass. When multiple lines are made active, the progress bar starts again for each line to be analysed.

**Display the Solution**

To see the results, click the **Layer Table** button on the main toolbar. The standard Cross-section Layers table is displayed.

Similarity coefficients and AutoMag solutions can be added to the table. To do this, right-click on any layer and select **Add** from the shortcut menu, and then select the Similarity Coefficient layer. One auxiliary channel is generated for each sample interval pass. Symbols are plotted for each AutoMag solution and their attributes are controlled (modulated) by the **Modulate** button in the AutoMag toolba (see Modulate and Annotate the Solution).
Solutions turns on the symbol display of AutoMag depth solutions. These are displayed as a variable size rectangular box with a small tick at the upper side of the symbol.

**Similarity Coefficients** are an important part of the interpretation process for tuning the AutoMag procedure. Best results are generally obtained from similarity coefficient curves with the lowest values and narrowest troughs. An example of the similarity coefficient profiles for 5 sample interval passes was presented previously. The third pass has the narrowest trough and a minimum that is 150 below the troughs in the adjacent channels. This is not obvious in the figure as the vertical scale for each channel has been optimized for maximum contrast.

A different colour is used for each auxiliary track and the colour sequence is controlled by the AutoMag palette. These colours are used elsewhere to colour code the symbols so that the relationship between the pass number and the AutoMag solution is clearly visible. This helps you select the best solution by examination of the quality of the similarity coefficient trough.

At both ends of each coefficient track, the curve trace is flat for a distance equal to half the length of the AutoMag operator. No coefficients can be computed within a half operator width of the line end. In the example shown here pass 5 has over 60% of the trace with no coefficient values. As the depth of investigation increases, more data is required for evaluation of the operator. This means that we cannot use AutoMag or other operator based methods to evaluate partial anomalies at the ends of lines.

Selecting cut-off thresholds in AutoMag is aided by placing the cursor in the appropriate coefficient track and you can read the amplitude from the status line at the bottom of the screen. As you move the mouse from track to track, the status line will automatically register the curve value from the current track. This is often much easier to read than the axis labels on the left hand side of each track.

**Modulate and Annotate the Solution**

All AutoMag solutions have a number of attributes, each of which can provide useful feedback on the quality of the solution. These can be used to modulate several properties of the solution points and/or annotate the points.

The Automag Points Modulation dialog is activated from the AutoMag option in the Modules menu.

![AutoMag Points Modulation dialog box](image)

- Dip, susceptibility and level are the best parameters to use for modulating the solutions in a cross-section view. Easting, northing and depth are automatically used to display the position of the solution. The size of the solution symbol can also be controlled.
• Dip allows you to quickly assess the orientation of the dyke. Poor solutions often have very shallow dips.

• Susceptibility provides a method of quickly determining relative magnetic properties. It can also be used as a filter.

• Level colour modulation makes it easy to see what similarity coefficient trough is associated with each solution. The interpreter can quickly choose the best solution if they originate from different levels.

**Test the Solution**

In the example shown here, there is only one solution from the AutoMag run. In practice, there will be many solutions and we need to isolate only those solutions that are valid. This objective is best achieved by computing the theoretical response of the AutoMag solutions.

Any AutoMag solution can be converted to an equivalent ModelVision solid body.

1. Select the AutoMag solution with the mouse by positioning the cursor on the symbol followed by a left mouse button click (select).

2. Press the SPACEBAR to create a ModelVision tabular body. You can select multiple bodies by using the mouse to drag out a rectangle around a group of solutions. These are converted to bodies with the SPACEBAR or the **Pt-->Body** button on the AutoMag toolbar.

![Setting properties in Point to Body conversion](image)

The dialog enables you to assign constant properties of the converted solution if required. If you are in ‘Immediate’ compute mode at the time the response of the model will be computed each time a body is created from an AutoMag solution.

If you do not like the theoretical response of any solution, press the DEL key and any body just created will be automatically deleted and the model response recomputed.

You can use the converted bodies as a means of storing your results between AutoMag runs. If you change the AutoMag parameters and perform a new run, previous solutions will be deleted. You can use the saved bodies for comparison with new AutoMag solutions.

**Save Your Solutions**

Apart from converting AutoMag solutions to bodies, you can keep your ‘good’ solutions in another way. You can use the **Code** function to assign a code between 1 and 20 to any solution. Note that:
• It is the responsibility of the interpreter to keep track of the code number and its meaning.

• When AutoMag is run, all solutions with Code = 0 are deleted while all others are retained.

To set a code, select one or more solutions and slide the slider bar to the desired code number and click **Set**.

To later select all solutions with a particular code number, slide the slider bar to the desired code number and click **Select**.

To clear the code, either manually select the solutions or use the **Select** button; slide the slider bar to a code of 0 and click **Set**.

Solutions can be kept from separate runs of AutoMag with different parameters. This provides you with a method of accumulating solutions in preparation for a final depth map.

**AutoMag Controls**

The primary AutoMag controls are available from the AutoMag toolbar. This toolbar is available from selecting the **Modules>AutoMag** option of the main menu, or by placing the cursor over the background screen of ModelVision and clicking the right mouse button. When this is done a ‘pop-up’ menu is displayed.

The AutoMag options are described below:

• **AutoMag Tool**

• **Parameters Set from the AutoMag Run Dialog**

**AutoMag Tool**

The AutoMag tool is specifically designed to provide access to many frequently performed operations of the AutoMag interpretation module.
Run

Opens the AutoMag dialog in which you configure AutoMag. Click OK to execute AutoMag. AutoMag retains current settings as defaults for the next run so that minimal changes are required to switch between profiles as you tune AutoMag. The AutoMag dialog is described in Parameters Set from the AutoMag Run Dialog.

Filter

Opens the AutoMag Filter dialog. After running AutoMag to generate a set of solutions, you can use this dialog to remove any unexpected values associated with the solution parameters. The AutoMag Filter controls are described in Filtering Solutions.

Modulate

Opens the AutoMag Points Modulation dialog that provides control over the appearance of AutoMag solutions. This dialog is described below.

• Point to Body Conversion

The Point → Body button opens the Point to Body conversion dialog that enables you to convert currently selected AutoMag points to bodies. Converting solutions to bodies allows their significance to be tested by forward modelling and provides a convenient alternative method of retaining selected and tested points. Further information on using the point to body conversion option is described below. A shortcut for converting points to bodies is to select the points to be converted and press the space bar on the keyboard.

• Body to Point Conversion

The Body → Point button creates AutoMag points from the currently selected bodies. Tabular bodies (that may initially have been created from AutoMag points and subsequently modified with forward or inverse modelling) can be converted to points so that their depths can be gridded to map a depth surface.

• Kill Bodies

This button provides a shortcut to delete all bodies. You may wish to use this after creating a large number of bodies. You must be sure that you do not unintentionally delete bodies previously developed on other lines. Note: This function will delete all bodies including those not selected. To delete only selected bodies, use the keyboard delete key.

• Code Set and Select Option

The Code value of an AutoMag solution is a flag value used to assist in the retention of solutions. By default, AutoMag solutions are created with a code value of zero. These solutions are automatically deleted when AutoMag is re-run on the line. You can change the code value of a point by selecting it in a cross-section or map display, setting the code value to the required value using the slider bar and clicking the Set button. You can change codes on solutions at your discretion. Having set codes for different solutions you can select those solutions by sliding the code slider bar to the desired value and clicking the Select button. Selected solutions can be converted to bodies or deleted as required.
• **Standard Points**

Allows you to create a point data set from AutoMag points. A standard data set is typically one derived from importing a data file of randomly located points such as a geochemical sampling dataset or regional gravity data. ModelVision treats AutoMag points differently from those referred to as ‘standard’. AutoMag points have associated information (such as solution properties) and are treated as a special case for display purposes. Since standard points have more versatile display and annotation properties, you may wish to convert AutoMag solutions to a standard point data set to take advantage of these.

**Parameters Set from the AutoMag Run Dialog**

The main AutoMag run control dialog is accessible by selecting the **Run** button on the **AutoMag Tool**. This dialog controls the settings of the main AutoMag parameters. The dialog closes after running AutoMag with the settings updated so they have the same value when AutoMag is next initiated. You therefore only need to make changes to the parameters in this dialog that are different from the previous AutoMag run. Once the process of tuning the parameters on one, two or a representative number of test lines is successful, the same parameters can be used for processing results on a much larger portion or a complete survey data set.

![](image)

*The main AutoMag run control dialog*

**Select Data**

AutoMag runs on an individual profile if it is open with a cross-section window. In this case, the **Select Lines** button is not displayed in the dialog. If a map window is active, a selection dialog for profiles can also be specified for an AutoMag run.

Other methods of making multiple lines active for AutoMag analysis are also available. You can interactively select lines in a map view using the Active Line toolbar. Set the AutoMag mode on (select the AutoMag option in the toolbar) and position the cursor in the map window. By clicking and holding the left mouse button as you drag the cursor over the baselines of profiles, you can toggle those lines as active or inactive for AutoMag computation. The actual AutoMag run is not initiated until the OK button is selected in the AutoMag run dialog.
Channel Select

This list allows selection of the channel input to the AutoMag computation. By default, the channel selected as input to the magnetic modelling is used. AutoMag detects whether or not magnetic modelling uses a sensor elevation channel. If it does, the source depths are corrected for the elevation of that channel as interpolated at the location of the source depth. Estimation of the source depth does not take into account variation in sensor elevation across the cross-correlation window. AutoMag can be run on in-line filters of the selected channel to give some advantage in derivation of the depth solutions.

Reduction-To-The-Pole in AutoMag

If the RTP option is selected, AutoMag uses an in-line RTP filter to modify the input channel. The reference window curve is computed for a vertical inclination field. The RTP setting provides an advantage in anomaly resolution, as a magnetic anomaly is more compact in a vertical than an inclined field. The RTP option should not be enabled for profiles that are oriented east-west or in field inclinations of less than 20 degrees.

Vertical Gradient

Runs AutoMag computations on an in-line first vertical derivative filter of the input channel and matches the computed output against an identical filter of the reference window curve. The Vertical gradient setting considerably sharpens anomalies and thereby improves resolution of overlapping anomalies. The vertical gradient is also more sensitive to source depth than is the field itself.

The only two conditions for which this setting should be disabled are:

- There are high amplitude field variations of shorter wavelength than the anomalies of interest
- Where there is concern that the AutoMag reference bodies provide poor representations of the true sources.

Shorter wavelength field variations are enhanced in computation of the vertical gradient thereby increasing the noise level of the data. The vertical gradient is also more sensitive to source shape so the use of inappropriate reference bodies may be inappropriate with this data.

If the measured data has a high level of near surface geological noise or instrument noise, apply an upward continuation filter to the data prior to the AutoMag analysis. The continuation height can be subtracted from the solution depths using the Utility>Calculator option.

Body Type

AutoMag can be run with three different tabular body types.

- The Dyke body is the default for AutoMag and the most often used. This body type is a tabular body with a depth extent ten times greater than the depth to its top.
- The horizontal Sheet is also a tabular body but with a depth extent equal to the depth to its top.
- An Edge is used to match isolated anomaly edges. The edge body is created with a thickness one hundred times greater than the depth to its top.
You must make an interpretative decision as to which body type to use. For large surveys that may include sources best matched with different body types, you can run AutoMag several times and retain only those solutions interpreted to be appropriate to the anomaly they are derived from.

**Top and Width**

AutoMag uses a reference body (initial guess) to generate the anomaly curves used in cross-correlation with the data. You must specify not just the body type, but also the Top (depth to the top of the body) and Width. The width setting is not used for the Edge body type. These properties are used as an initial guess for the first depth pass. For subsequent depth passes, the property values of the guess are multiplied by the pass number (so that 2nd and 3rd passes have depths and widths twice and three times the primary setting).

The **Depth Estimation** stage takes these initial solutions and recalculates them to increase precision. If you run AutoMag with the second Depth estimation stage disabled you can see the depth estimates at precisely the specified depths to the reference bodies. If the reference bodies fit the target body shapes and there are no problems of overlapping anomalies, you may find that following the Depth Estimation stage solutions made on different passes with quite different initial depths end up tightly clustered at the source depth. The exact choice of depth in the Top setting is therefore not critical. The greatest sensitivity in using AutoMag is with the Top value set to about one half of the expected depth to source bodies. This means that passes 2 and 3 should be close to the source depth and passes 4 and 5 would pick any deeper sources.

**Anomaly Location**

The theoretical anomaly from the initial guess model (derived from depth and width) is correlated with the measured magnetic data. The theoretical anomaly is stored in an array window (Window Width) and convolved with the magnetic data to produce the similarity coefficient trace for the first depth pass. The Window Width is doubled and the process repeated for the second pass. This process of operator expansion can be repeated for up to 8 passes.

Note that the shape of the similarity coefficient is sensitive to the width of the operator. If the operator is too wide, it is sensitive to interference from adjacent anomalies. If it too narrow, it cannot properly resolve the anomaly.

**Sample Spacing**

AutoMag interpolates the input trace within the cross-correlation window. The cross-correlation window is 26 points wide. By changing either the Sample spacing or Window size in the Anomaly Location settings, the other parameter changes accordingly. To optimize AutoMag settings you must have a window that is wide enough to sufficiently sample anomalies while being narrow enough to avoid having more than one anomaly within it. It is easier to manipulate window sizes directly rather than change the sample spacing. Sample spacing and window size values relate to the first depth pass. For subsequent depth passes, these values are both multiplied by the depth pass number.

**Saving Correlation Coefficients**

This setting allows you to save the AutoMag analysis correlation coefficients. It is only appropriate to map view operation. The default setting is off as this requires the coefficients access to a large amount of memory. You can grid the coefficients to produce an image for each depth pass. These images sharpen geological features and often enhance discontinuities that are not evident in the original data. Use the **Save Correlation Coefficients** option to retain the coefficients.
Depth Passes

AutoMag can search for solutions across a range of depths by applying stepwise increases in Top and Width parameters of the reference body and width of the Anomaly Location and Depth Estimation windows. You control the number of these steps with the Depth Pass setting. Each depth pass generates an independent coefficient track that is scanned to search for potential solutions. The coefficient tracks and depth solutions can be displayed in cross-section views using a colour-coding scheme. It is rarely worth running more than 4 or 5 depth passes at one time. To search for solutions across a wider depth range you should run AutoMag with different settings to focus on the various sources.

Anomaly Location

The first phase of the AutoMag analysis is to locate potential solutions. This phase involves running a cross-correlation of horizontal and vertical components of the magnetic field or their vertical derivatives. These are computed from the reference body with the corresponding curves of the input field.

Window Size

The window size specified in either metres or sample points is the width of the cross-correlation window. The window should be wide enough to sufficiently sample anomalies but narrow enough to reduce problems of the simultaneous analysis of adjacent or overlapping anomalies. The most direct means of determining the appropriate window size is to first estimate a suitable value from inspection of anomaly widths and separations. Once this is done, run AutoMag at several different window widths to investigate the solutions generated. The Anomaly Location operator only reaches to within a half of the window width from either end of the profiles. The length of the sections at each end of the profiles is not analysed when wider window settings increases for larger depth pass numbers.

Display of Similarity Coefficients

As AutoMag progressively computes across a profile, it computes correlation factors called similarity coefficients. It is useful for setting threshold parameters (the similarity coefficient cut-off) to graphically display the similarity coefficients. This display is derived by positioning the cursor in the profile window after an AutoMag run and clicking the right mouse button. The controlling layer table can be displayed by clicking the Layer Table button on the main toolbar.

Cross-section configuration dialog for displaying AutoMag similarity coefficients

To display the similarity coefficients, select Add>AutoMag Coefficients. To adjust the rcoefficients, select Configure. One auxiliary channel is generated for each sample interval pass. Symbols are plotted for each AutoMag solution and their attributes are controlled (modulated) by the Modulate button in the AutoMag toolbar.

The AutoMag depth solutions are automatically displayed in the view after the AutoMag module has been run. These are displayed as a variable size rectangular box with a small tick at the upper side of the symbol.
A different colour is used for each auxiliary track and the AutoMag palette controls the colour sequence. These colours are used elsewhere to colour code the symbols so the relationship between the pass number and the AutoMag solution is clearly visible. This helps you select the best solution by examining the quality of the similarity coefficient trough.

At both ends of each coefficient track, the curve trace is flat for a distance equal to half the length of the AutoMag operator. No coefficients can be computed within a half operator width of the line end. As the depth of investigation increases, more data is required for evaluation of the operator. This means that AutoMag or other operator-based methods cannot be used to evaluate partial anomalies at the ends of lines.

**Similarity Coefficient Cut-off**

The similarity coefficient cut-off is the value of the similarity coefficient below which a potential solution is indicated. Each trough in the coefficient trace that cuts below this threshold generates a solution. As you increase this cut-off value you generate more solutions, but these are generally of lower quality and reliability. You need to run AutoMag several times on test lines to find the best combination of window width, body top/width and coefficient cut-off to give you solutions for the anomalies of interest.

Selecting cut-off thresholds in AutoMag is aided by placing the cursor in the appropriate coefficient track. You can read the amplitude from the status line at the bottom of the screen. As you move the mouse from track to track, the status line automatically registers the curve value from the current track. This is often much easier to read than the axis label on the left hand side of each track.

This setting is used specifically to locate an anomaly for inversion and AutoMag find the local minimum as the starting point for the inversion data centre. The Filter tool described below allows some flexibility with this setting so that you can use a high setting, and remove the low quality solutions later. If you are too tight at this stage, then you may lose some valid solutions that you would prefer to keep.

**Depth Estimation**

This is a second stage investigation of the solutions generated in the Anomaly Location pass. Improvement of the depth estimate should result in a closer match to the input data so a more demanding coefficient cut-off should be set. A differential of 10 to 30 is generally optimum (e.g. Anomaly location cut-off = 390, Depth estimation cut-off = 360). The window size should generally be slightly smaller than in the Anomaly location pass. This window width is automatically set as the Anomaly Location window width is varied and rarely needs to be reset manually.

This setting is used specifically for inversion of depth, dip, thickness and magnetic susceptibility. The Filter tool described below allows more flexibility with this setting so that you can use a high setting, and remove the low quality solutions later. If you are too tight at this stage, then you may lose some valid solutions that you would prefer to keep.

**Constant Dip, Susceptibility and Strike length**

These settings force values on the generated solutions. The interpreted dip of a source body is a factor of the anomaly asymmetry. Asymmetry can also be due to overprints of a regional field or adjacent anomaly. If the dip value can be predicted from geological knowledge, this value should be specified for the solutions. Susceptibility and width cannot be resolved independently for bodies at depths greater or equal to their width. If a susceptibility value is known, that value should be entered as a control. If a susceptibility value is specified, the body width is suitably adjusted to best fit the anomaly.
Strike length cannot be reliably determined from a single profile and an infinite strike length is assumed in the generation of the solutions. The strike length value is assigned to the solutions. If you use a short strike length you find that the field computed from the solution has lower amplitude than the anomaly from which it has been derived.

**Cancel and OK**

The Cancel button exits from the dialog without AutoMag running and without changing any of the opening values. The OK button causes AutoMag to run and subsequently closes the dialog with any revisions to the settings saved. While AutoMag is running, a progress bar is displayed.

**AutoMag Reporting**

When AutoMag runs successfully, it displays a message indicating the number of and pass (level) of solutions derived.

If the window size is larger than the profile length, AutoMag will not generate a solution. To fix this problem, you must reduce the window size or sample spacing, or remove one or more of the highest depth passes.

Once you have run AutoMag, you have a set of coefficients that can be displayed in the cross-section window. Display of these traces helps you to evaluate the depth solutions and to determine what changes to make to better tune the AutoMag settings. Display of the traces is controlled in the cross-section configuration (refer to Display of Similarity Coefficients). Enable the Solutions and Coefficients check-boxes on to display the similarity coefficients and solutions in the profile display. Colour the coefficient curves by also enabling the Fill Curves option. The scaling Range is best set automatically using the Zoom Fit option from the main menu.
Filtering Solutions

Interactive filtering allows tuning the parameters and filtering out poor solutions. It is activated by clicking the Filter button on the AutoMag Toolbar.

The AutoMag Filter dialog box

The following parameters can be interactively filtered:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dip</td>
<td>Dip of dyke</td>
</tr>
<tr>
<td>Thickness</td>
<td>Thickness of dyke</td>
</tr>
<tr>
<td>Suscept.</td>
<td>Magnetic susceptibility</td>
</tr>
<tr>
<td>Level</td>
<td>Depth pass number</td>
</tr>
<tr>
<td>SimCeof(A)</td>
<td>Similarity coefficient for the Anomaly location</td>
</tr>
<tr>
<td>SimCeof(D)</td>
<td>Similarity coefficient for the Depth determination</td>
</tr>
<tr>
<td>Confidence</td>
<td>Trend grid confidence value</td>
</tr>
<tr>
<td>Correctn angle</td>
<td>Trend grid correction angle</td>
</tr>
</tbody>
</table>

The Group Filter finds the best solution based upon similarity coefficients when there are more than one solution within a window equal to the window width. If similar coefficients are detected it looks for those that are grouped by depth. similar susceptibilities can also be used to refine the filter process. The Group Filter is only applied to the solutions that remain after all the preceding filters have been applied.

Each parameter has both a slider bar and manual entry fields for adjusting the minimum and/or maximum values. Values above and below these values are filtered out. By default these values are calculated as the minimum and maximum values for all solutions.
Check boxes allow each parameter to be enabled for filtering or to be turned off. The resultant solutions are the intersection of all enabled filter operations.

As you change parameters, solutions appear or disappear on map views and sections. This is achieved by using the visibility property of the solutions whereby all solutions are still present (although some are invisible) until you click the **Apply Filter** button. When you do this, the filter is applied to the actual solutions and solutions outside the filter ranges will be permanently removed. You can regenerate these by re-running AutoMag but you will not be able to recover them by setting broader filter parameters.

If you wish to save the current filter settings to use again, you can click on the **Save** button in the **Defaults** area. This will preserve these parameters. If you have another set of AutoMag solutions, you can click the **Use** button and the defaults will be retrieved into the filter. Note: the defaults are not automatically set when you first run the filter as the parameters used are still calculated from the set of solutions.

It is recommended that you use slightly higher similarity coefficients than you might otherwise choose. You can then use the filter to fine tune the similarity coefficients using the filter.

You can uncheck the **Auto Display** checkbox and use the **Display** button to update the display to save calculation time. However, unless the number of solutions are extremely large, using the auto display will normally be satisfactory and the interactive nature of the display will prove beneficial.

A status line showing how many solutions remain out of the total set of solutions is displayed above the **Close** button.

Clicking the **Reset** button recalculates the minimum and maximum values for each filter field.

**Point Modulation of Solutions**

To control the appearance of AutoMag solutions, select the **Modulate** button on the AutoMag toolbar.

**AutoMag Points Modulation dialog box**

Different settings are available for point displays in map and in cross-section views. The dialog refers to the appropriate settings according to which window is active when the dialog is opened. In map view, the display orientation of the points is by default controlled by azimuth, whereas in cross-section view their display orientation is by default controlled by dip.
All AutoMag solutions have a number of attributes, each of which can provide useful feedback on the quality of the solution. These can be used to modulate several properties of the solution points and/or annotate the points.

The solution symbol shown on sections and maps can have:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>X value (usually Easting)</td>
</tr>
<tr>
<td>Y</td>
<td>Y value (usually Northing)</td>
</tr>
<tr>
<td>BTYPE</td>
<td>Body type (1=dyke)</td>
</tr>
<tr>
<td>DEPTHBG</td>
<td>Depth below ground - Corrected</td>
</tr>
<tr>
<td>ELEV</td>
<td>Sensor elevation - Corrected</td>
</tr>
<tr>
<td>DEPTHC</td>
<td>Depth to top of dyke (from datum) - Corrected</td>
</tr>
<tr>
<td>SUSC</td>
<td>Susceptibility</td>
</tr>
<tr>
<td>DIPAZIMC</td>
<td>Dip Azimuth of dyke - Corrected</td>
</tr>
<tr>
<td>DIPC</td>
<td>Dip of dyke - Corrected</td>
</tr>
<tr>
<td>HALFWC</td>
<td>Dyke half width - Corrected</td>
</tr>
<tr>
<td>TRENDCONF</td>
<td>Trend grid confidence value</td>
</tr>
<tr>
<td>CORRANG</td>
<td>Trend grid correction angle</td>
</tr>
<tr>
<td>DEPTHBG</td>
<td>Depth below ground</td>
</tr>
<tr>
<td>ELEV</td>
<td>Sensor elevation</td>
</tr>
<tr>
<td>DEPTH</td>
<td>Depth to top of dyke (from datum)</td>
</tr>
<tr>
<td>SUSA</td>
<td>Magnetic susceptibility</td>
</tr>
<tr>
<td>DIPAZIM</td>
<td>Dip Azimuth of dyke</td>
</tr>
<tr>
<td>DIPA</td>
<td>Dip of dyke</td>
</tr>
<tr>
<td>DPTHXTNT</td>
<td>Depth extent of dyke</td>
</tr>
<tr>
<td>STRIKELEN</td>
<td>Strike length of dyke</td>
</tr>
<tr>
<td>HALFW</td>
<td>Half width of dyke</td>
</tr>
<tr>
<td>TOPO</td>
<td>Topographic elevation</td>
</tr>
<tr>
<td>SENSOR</td>
<td>Sensor Elevation</td>
</tr>
<tr>
<td>SCOEFDD</td>
<td>Similarity coefficient for the Depth determination</td>
</tr>
<tr>
<td>SCOEFAB</td>
<td>Similarity coefficient for the Anomaly location</td>
</tr>
<tr>
<td>CODE</td>
<td>Solution Code Value</td>
</tr>
<tr>
<td>LEVEL</td>
<td>Depth pass number</td>
</tr>
<tr>
<td>AZIMUTH</td>
<td>Dip Azimuth of dyke</td>
</tr>
</tbody>
</table>

Dip, susceptibility and level are the best parameters to use for modulating the solutions in a cross-section view. Easting, northing and depth are automatically used to display the position of the solution. The size of the solution symbol can also be controlled.

- Dip allows you to quickly assess the orientation of the dyke. Poor solutions often have very shallow dips.
- Susceptibility provides a method of quickly determining relative magnetic properties. It can also be used as a filter.
- Level colour modulation makes it easy to see what similarity coefficient trough is associated with each solution. The interpreter can quickly choose the best solution if they originate from different levels.
Annotation

In map view (but not section view), the Modulation dialog box also allows Channel Annotation by clicking the **Channel Annotation** button in the lower left. This brings up the annotation dialog box where you can select the channels that you want annotated for each solution and the properties for each annotation. It is advisable to set different angles and/or justifications to prevent overwriting annotation.

![AutoMag Point Annotation dialog box](image)

**AutoMag Point Annotation dialog box**

Strike Correction

AutoMag solutions are initially created with a strike perpendicular to the line direction. Correction to a more accurate strike direction can be made using the automatic trend correction function. This can be initiated from either the **Run** dialog box or the **Adjust Trend** dialog box, both started from the AutoMag toolbar.

If a trend grid does not already exist, it must first be created. Click on the **Create** button. Select a source grid which should relate to the channel used for AutoMag, e.g. an upward continuation of the TMI or 1VD of the TMI. Upward continuation prior to trend grid creation is recommended to get a more consistent trend grid. Clicking OK will start the grid utility module with the trend grid function and selected grid loaded. The only thing needed is to click the **Save As** button and supply a location and name for the trend grid.

Two grids will be created: `name_Trend` and `name_Confidence` where "name" is the name you supply in the Save As dialog box. If you end the name with "_Trend" it will be retained. Otherwise it will be added.

You will then be returned to ModelVision whereby the grids will be displayed in map windows.

The `_Trend` grid contains the trend azimuth (0-180 degrees) and can be used for the continuous estimation of strike within a grid. The trends are binned within 15 degree arcs from zero to 180 degrees.
The **Confidence** contains a confidence value (0-1) similar to a correlation coefficient. It can be thought of as the confidence that the trend value is correct for that grid point. A feature of the confidence grid is that it highlights trends and can be used for the enhancements of trends within a grid.

Once the trend grid has been created, it can be used in AutoMag to correct strike for each solution by either:

- In the **Run** dialog box, check the **Apply strike correction** checkbox and select the trend grid from the dropdown list of grids.
In the Adjust Trend dialog box, check the **Apply strike correction** checkbox, select **Trend Grid** radio button and select the trend grid from the dropdown list of grids. You can also assign a code at this point by typing in a number between 1 and 20 to flag these solutions.

Choosing **Fixed Orientation** and entering a value will apply that value to all the selected solutions.

If you select solutions sequentially along the axis of a single anomaly prior to starting the trend correction, you can choose **Sequential Points**, to adjust the strikes and strike lengths of the solutions such that all solutions form a single trend. When converted to bodies, the set of bodies will have adjusted strike length and azimuth that join end to end.

For all trend corrections, depths that were initially calculated on the assumption of body strike perpendicular to profile are corrected for the adjusted strike direction of the bodies. Estimates of dip and susceptibility are also revised. These corrections are to offset the apparent broadening of anomalies due to any obliqueness of their intersection with the profile. The correction results in a shallower depth for all cases other than a perpendicular intersection of the profile and anomaly axis, in which case the depth is unchanged.
Point to Body Conversion

AutoMag solutions can be converted to bodies by the **Pt->Body** button on the AutoMag toolbar or from the **Model>AutoMag>Points->Bodies** menu item.

![Point to body conversion dialog](image)

This option controls the conversion of points to bodies. The conversion can be made either by clicking the OK button on the dialog or by pressing the space bar on the keyboard. If any of the constant value tick boxes are enabled, the displayed value is given to that parameter of each body created from the currently selected points.

Running AutoMag in Batch Mode

To run AutoMag as a batch operation, first inspect the line data in a map view. A stacked profile plot generally gives the greatest sensitivity. You should decide whether the data can be treated as a homogeneous data set or whether it should be subset to tune AutoMag independently for areas of different source depths. You can use Multitrack views of selected lines to look more closely at anomaly shape and the influence of any superimposed high frequency noise etc. to decide whether you are able to use the vertical gradient filter.

Check that the magnetic modelling field settings are as required (note the values for field strength, inclination and declination in the Status Bar). Open a cross-section view of a representative line and add a vertical derivative trace from the standard filter selection in the cross-section configuration. Open the AutoMag toolbar from the main menu (**Tools>AutoMag**) and click the **Run** button to open the configuration dialog. Select the appropriate reference body type and set **Top** and **Width** to about one half of expected values for the sources. Set the **RTP** and **Vertical Gradient** options on or off as appropriate. Set the **Window size** in **Anomaly Location** to about one half of the anomaly width, or slightly less if there are overlapping anomalies. Click the OK button and a single run of AutoMag for the displayed profile is executed. At the conclusion of the run, AutoMag reports how many solutions have been generated.

- **Profile Results**
- **Map Results**

Profile Results

Open the X-section configuration dialog for the cross-section window and enable the **Coefficient display** and **Fill Curves** options. Set the **Min** and **Max** values in the **Depth Range** settings to cover the range of depths from which you expect to find solutions.
The coefficient traces are now displayed in the cross-section view together with any solutions that were generated. If there are suitable troughs in the correlation coefficient curves above the anomalies, you can generate any missing solutions by increasing the coefficient cut-off values for both anomaly location and depth estimation. If the anomalies do not have associated troughs in the coefficient traces you need to experiment with window size, body top and width settings.

In the cross-section, when you have solutions generated for the anomalies of interest convert these to bodies by selecting them and pressing the space bar (or the Pts->Body button). Run a model computation and examine the model response with the input curve. If you have enabled use of the Vertical Gradient in generating the AutoMag solutions you can see how AutoMag has analysed the profile by comparing the model input and output traces in the first vertical derivative track. If there are solutions you do not want, experiment with deleting them using the Filter option on the AutoMag toolbar.

Map Results

When you are satisfied that you have appropriate settings for the generation and filtering of solutions, switch to a map view. If the profile that you tuned AutoMag on is representative of the complete survey, use the Select All option in the Select Data group of the main AutoMag configuration dialog. If the profile is only representative of a sub-set of lines, activate those lines for running AutoMag using the Active Lines toolbar and dragging the mouse over the baselines for the required lines. Run AutoMag and examine the symbols in the map view.

If you have run AutoMag on multiple lines, you can open several other cross-section views and propagate the style of your current section using the right mouse click option Apply Style to All.
By plotting AutoMag symbols in a map view together with stacked profiles, contours or image displays you can manually edit the solutions by deleting those associated with less reliable or inappropriate anomalies. You can also make sequential selections of solutions along axes of individual anomalies so that the solutions and bodies created from them can be corrected for strike oblique to the profiles.

If you are satisfied that all solutions come from a common geological source, you can use the **Utility>Gridding** option in point mode to grid the depth channel. When you perform this gridding, experiment with the search radius setting to limit the distance from a solution to which the grid is interpolated. You should generally display the solution set together with any contour or image display of the grid derived from them.

AutoMag solutions usually provide a good starting point for developing full models. In suitable situations you can add a regional field to the field computed from bodies converted from AutoMag solutions and proceed directly to an inversion to give a final model. Display of the AutoMag solutions in the cross-sections allows you to monitor by how much the interpreted depth has changed from the depth solution to the final model.
Appendices

A  File Formats
B  Body Descriptions
C  External Data Links
D  Defaults and Settings
E  Model Files
F  Symbols
G  Filter Descriptions
H  Back Door Features
I  Bibliography
J  Acknowledgements
Loading data into or exporting data from ModelVision uses either a number of standard file formats or alternatively, a user definable format specification. The standard formats are reasonably accepted throughout the scientific and geoscience community and are simple and flexible enough to accommodate most data situations. User definable formats involve data consisting of delimited columns with or without headings but having a line name column. For additional information on user definable file formats, refer to Importing General ASCII Data.

In general, line formats fall into two categories:

- Files containing one traverse or profile line of data
- Files containing more than one profile line of data (concatenated line files)

The two file types have different formats and are described below. ModelVision adopts a policy of using the line name specifications contained within the relevant files formats. Where a line name is not contained in the file, the filename is used to assign it.

- Conventions
- Importing General ASCII Data
- Supported Single- and Multi-Line Data Formats
- Point Data Format
- Drillhole Data Format
- Supported Grid Formats

Conventions

- Null Values
- Channel Naming Conventions

Null Values

Nulls can be embedded in the line file formats. Null values differ for the various file formats used. Refer to these formats for definitions of which null value to use. Note for all file formats, line names can be alphanumeric but cannot contain greater than 2 '_' or '-'. For example, line name 10_2_200 would be illegal.

Note

For all file formats, there is no upper limit to the number of data points per single line (other than restricted by computer memory).
Channel Naming Conventions

To assist in internal operations, it is necessary to refer to data by a set of channel names. For example, ModelVision relies upon certain data for positional information (namely, easting (X) and northing (Y) information). These data channels are determined at import by either their assigned channel names, or their placement in the file. For example, in the Geosoft file formats, the first two columns define easting and northing data, even though column headings may not be provided. Alternatively, the LIN format can have the east and north data in any column, but the header is used to define the correct column data locations.

To assist in column (and therefore channel) naming, ModelVision provides a number of commonly used ‘aliases’ for naming data columns. These are:

Location easting aliases
EAST, X, E, AMGE, EASTING.

Location northing aliases
NORTH, Y, N, NRTH, AMGN, NORTHING.

Distance aliases
DIST, DISTANCE, DIST_ABS, DIST-ABS, FID, SP, STN, STATION.

Elevation aliases
TOPO, TOPOGRAPHY, ELEV, ELEVATION, HGHT, HEIGHT, AGL, ASL.

Magnetics aliases
MAG, MAGNETICS, RMAG.

Gravity aliases
GRAV, GRV, GRAVITY.

Importing General ASCII Data

The File>Profile>General ASCII import facility provides a method of interactively defining data formats for single or multi-line files. The option provides the following facilities:

• Interactive specification of column widths
• Assign column/channel names as desired
• Define null values precisely (individually for each column if necessary)
• Automatically parse a data format to specify column widths
• Header and comment lines can be skipped and identified.
Limitations of the general ASCII import are that the file must have data within columns and use a format that does not change from one record to the next (apart from header or comment records). Additional columns must also be available to define a Line channel and reading location (Easting and northing). The line channel has a constant value for each consecutive reading along a line, and may change to a new line. The line names default to the line column entries.

Once the ASCII file to import is selected, the Text Import dialog screen is displayed. In the example that follows, a fixed width ASCII file with no headers, in multi-column format is used. If the data is not suited for loading (such as a binary file, or an inappropriate text file), a warning message is displayed. If no data is loaded, a message saying ‘No data loaded’ is displayed in the data preview area.

The dialog is divided into a series of controls with a data preview area at the bottom. In the preview area, the first 100 data records of the file specified for import are displayed. By default, the Text Import tool initially interrogates the file and determines if it is a Fixed Width or Delimited format. It then computes the column widths and displays these with vertical separator lines in the preview area. The dialog and its controls allow modification of the program’s initial review of the import file.

Once column widths and format are determined, the second purpose of the dialog is to assign column names to each required column. This can be done automatically (using a header record), or manually by naming each column.

The import procedures for the most common types of files are described below:

- Importing Fixed-Width Data
- Importing Delimited Data
Importing Fixed-Width Data

A fixed-width data file is one where each column is confined to fixed character positions on each line of the file. To import a simple fixed-width file, follow these steps:

1. Choose an input file using the file dialog.
2. Check the **Fixed width** box in the column format area.
3. Ensure that the correct number of header lines are selected. Header lines are displayed in the data preview area in green and are separated from the data by a horizontal line.
4. In most cases, the Text Import tool automatically determines the column widths. If there are fields that are not separated by any white space, you may have to add and/or drag your own column lines in the data preview area. To do this, click in the data area to add a column break or double click to delete a column break. If you hold the button down you can select a column separator and drag it to a preferred position. If you hold the CTRL key plus move the mouse, it drags all columns to the right of the current column.
5. Choose a Line field by right-clicking on a column label. This field should contain a value that is constant for each station along a line, but changes for each separate survey line or flight line in the data. If you do not choose a line field, when you click the Import button, you are asked if you wish to import point data.
6. If required, choose an X (East) and Y (North) by right-clicking on the appropriate column labels.
7. Name all the other fields that you wish to import. The simplest way to do this is to left click on the column label, type a name, and then press the Tab key to move to the next column. An alternative way is to double-click on the column label to bring up its Properties dialog. Fields named Skip are not imported.
8. Click the **Import** button in the top-right corner of the dialog.
Importing Delimited Data

A delimited data file is one where each column is separated from the others by some delimiter character or characters. Delimiters can be spaces, tabs, commas, or any other characters you enter in the Other field. To import a simple delimited file, follow these steps:

1. Choose an input file using the file dialog.
2. Check the Delimited or Comma Delimited item in the Columns format area.
3. Ensure that the correct number of header lines is specified. Header lines are displayed in the data preview area in green and are separated from the data by a horizontal line.
4. Choose the appropriate delimiter characters for your data. By default, space and tab characters are already selected, but if needed, you can enter other delimiter characters.
5. Choose a Line field by right-clicking on a column label. This field should contain a value that is constant for each station along a line, but changes for each separate survey line or flight line in the data.
6. If required, choose an X (Eastings) and Y (Northing) by right-clicking on the appropriate column labels.
7. Name all the other fields that you wish to import. The simplest way to do this is to left-click on the column label, type a name and then press the Tab key to move to the next column. An alternative way is to double-click on the column label to bring up its properties dialog. Fields named Skip are not imported.
8. Click the Import button in the top-right corner of the dialog. You are then prompted to select the name of the Geosoft database that is created to hold your imported data.

Importing Data with Interspersed Line Numbers

In some cases, there is not a line field in your survey data. Instead, the file contains lines that specify the start of a new survey line. The simplest example of this is for the line simply to contain the string Line x, where x is a survey line name e.g. 1020.

To import data from files with such interspersed line numbers, simply check the box that says Has interspersed line numbers and select an appropriate line number marker string from the drop down list. If you need a string that is not in this drop-down list, type one in.
When the **Has interspersed line numbers** option is enabled, there is no need to select a field to be the line field.

### Importing Point Data

By definition, point data has no line-related column. Instead each record represents a point usually with some sample data acquired at an Easting and Northing position but randomly distributed. An example of point data:

```
POINT X Y Elev ObsGrav FreeAir Boug2.67
601293 286861.3 6557450.5 287 9793745.0 29.3 -291.9
601298 285206.5 6563530.0 225 9793608.0 11.5 -240.6
601303 285111.2 6563139.5 243 9793674.0 29.4 -241.6
601308 285976.0 6553271.5 312 9793608.0 -3.5 -353.0
601313 286368.0 6567701.5 320 9793491.0 -37.6 -395.6
601318 286959.1 6569595.0 330 9793355.0 -107.0 -476.3
601323 287311.8 6571065.0 376 9793209.0 -62.8 -484.2
601328 287002.8 6572854.0 431 9793255.0 182.0 -301.2
601333 286495.7 6574801.0 680 9792787.0 490.1 -271.6
```

Note that each point has its own station number identifier (column Point), but this is not essential. Only the XYZ and measurement columns are necessary. When the file is accessed by the Text Import tool you are required to ensure each data column to be imported is displayed in the Column headers. You can use the software to do this or you can define them interactively.

When the column headers and nulls are specified, select the **Import** button. The Text Importer recognizes that a Line column has not been specified. It therefore displays a message asking if the data is point data and do you wish to continue. This message is shown in the dialog below:

![Text Import dialog with message displayed if point data is being imported](image)

If you respond that the data is point data, the software creates a database in memory and opens it within ModelVision.
Point data would not normally be displayed in line profiles or graphs since this would usually not be meaningful. Points can however be shown in maps or scattergrams. An example of a point display with modulated colour and size (dependent on a nominated data field) is shown below using a Curve with Line Styles disabled and Symbols enabled.

Example display of point data within a map as modulated symbols

Reading Field Names from the Header

In some data files, the names of the fields are contained in a comment line in the file header. If you wish to use these field names without re-typing them, ensure that the appropriate number of header lines are selected, and check the Field names are in header box. Next, choose which line of the header contains the field names. Finally, click the Get field names button. Note that only field names starting with alphabetic characters or underscores are allowed.

In rare cases, you may need to offset the character position of the start of the field names, using the Starting at char entry field.

Input Null Values

Input data fields containing an asterisk, a solitary minus sign, or just white space are automatically treated as null values and when imported are written out to the Geosoft database as the Geosoft null value (−1.0E32).

If you have input data fields that contain a different null specifier string, (e.g. −999.99), then you must enter this string in the Nulls area of the Field Properties dialog. To open this dialog, just double-click on the column/field label.
If you wish to apply the same null string to all input fields, click the **Apply to all fields** button on the field properties dialog.

**Saving and Reloading a Current Layout**

If you need to import a number of files with the same data layouts it may be useful to save your layout ‘template’ for later use. To do this, simply click the **Save Format** button and you are prompted for a filename. Be sure to do this before you start importing the data, otherwise your layout information is lost. When you want to import another data file with an identical layout, just reload your template using the **Load Format** button and all your field names, field properties, delimiters, column widths, etc are restored.

Note that the format used by Text Import for the format specification is the same as for a Geosoft database import template. Where used with Geosoft, your same files can be used with Text Import.

**Auto Classification**

Text Import has been designed to assist with formats of data files by automatically recognizing certain file types. If a file type and structure are recognized, the format should automatically be decoded and presented for you.

The available automatically decoded format types include:

- ER Mapper ASCII format
- AMIRA Time Domain .TEM files
- Datamine standard input data files
- GEMSys (GEM Systems) magnetometer raw data files
- Geosoft XYZ files
- LAS (Log ASCII Format) data files
- ModelVision located data files
- SRG (Station Referencing) data files.

The automatic classification operates from the **Auto classify** button, or you can select one of a range of types if you think the specified file is one of the available formats.
A variety of standard industry data formats are supported. An example of this is the Station Referencing format (.SRG) that allows the station field to determine where a new line starts. The station field must increment within a line. If the station field value decreases, this also indicates the start of a new line. An example of this format is:

```
X,Y,Z,Station
100,200,50,1 // Line with 4 stations
105,200,50,2
110,200,50,3
115,200,50,4
100,205,50,1 // Line with 3 stations
105,205,50,2
110,205,50,3
100,210,50,1 // Line with 1 station
100,215,50,1 // Line with 1 station
```

In this case, set the field named 'Station' to be a station field using the rightclick menu. The SRG Classifier then interprets the remaining fields.

**Other Features**

There are three buttons in the **Columns** area of the Text Import dialog:

- The first of these is called **Reset Column widths**. This is rarely needed as the column widths are usually automatically updated as the result of changes you make to other entry fields on the dialog. If you manually drag and add columns, then clicking this button resets your changes.

- The **Clear names** button resets the names of all unnamed columns/fields back to Skip. Columns with this name are not imported.

- The **Auto-name** button provides a quick way to select all fields for import. It names all columns with a prefix that you choose and the column number for a suffix (e.g. Field1, Field2, etc.)

Import ASCII automatically detects when fields have the DMS format. This format is DDMSS.SSC or DDDMSS.SSC where C is a compass direction (N,S,E, or W) and the fractional seconds part (.SS) is optional and can be arbitrarily long if present.

An Expand/Contract button in the dialog allows a simplified dialog to be displayed when contracted. To display the complete suite of controls, click the **Expand** button.

**Importing the File**

If inconsistent or invalid readings are found during the import of data, a warning message defining the record number is displayed:
Error message displayed if a record is unable to be parsed and read during import

If you select the **Continue** button, ModelVision skips the offending record and continues importing the file. If you select the **Abort** option, the data is not read further.

## Supported Single- and Multi-Line Data Formats

Single-line formats supported include:

- **TOOLKIT Format (TK)**
- **Single Line Geosoft Format (DAT)**
- **ER Mapper ASCII Format Profile**

Multi-line formats supported include:

- **Simple XYZ Line Format (LIN)**
- **XYZ Multi-line Format with Separate Header (LIN+HDR)**
- **Multi-line Geosoft XYZ File (XYZ)**
- **Geosoft Database (GDB)**
- **ASEG-GDF2 File Format**
- **AMIRA Multi-line Format (TEM)**

As with single line formats, these data formats may have descriptive header records followed by data arranged in column or open format.

---

**Note**

With all file names, the file extensions are recommendations only

## TOOLKIT Format (TK)

These files contain a number of header lines which provide a title, description of the columns and defined null values or numbers of points. The defined null value for the TK format is -999999. The recommended file extension for this file type is .TK.

An example of the TOOLKIT single line format is:

**Single Line Example Dataset**

```
TK DIST EAST NRTH MAG
```
The file has any number of headers, but must have an identification line commencing with the characters 'TK'. A number of four character mnemonics are used to describe the data channels. ModelVision automatically decodes the file and select all the columns of data as input.

**Note**

Records commencing with numeric characters (even if a comment or header record) are be treated as data.

Input processing assumes the East and Nrth columns and create another channel called DIST_ABS. This channel is the computed distance from the first point stored in the file to each successive point. A line name can be defined within the data file by specifying a header record with a 'Line' character string. For example:

```
Line=1200.0 Example Dataset
```

```
TK DIST EAST NRTH MAG
.00 1200.00 0.00 56848.66
40.00 1200.00 40.00 56845.78
80.00 1200.00 80.00 56843.78
120.00 1200.00 120.00 56842.30
160.00 1200.00 160.00 56840.38
200.00 1200.00 200.00 56836.80
```

**Single Line Geosoft Format (DAT)**

The Geosoft file format is described in detail by Reeves and Macleod (1986, First Break v4, No.2, pp9-17). In this format each file begins with a title record, followed by a record that can be used to provide specific application or constant information about the data records that follow. A third record contains column labels that describe the data within columns that follow beneath the labels. All files must start with these three records. Nulls may be embedded in the file and have a value of '*'. The recommended file extension is DAT.

An example of a Geosoft single line file follows:

**Title record - Example of single line Geosoft file**

```
Line:19800.0 MAGFLD=TOTAL TOTAL_CNT:UNCORRECTED
EAST NORTH Mag Total
49000.0 19800.0 50424.3  119.4
49010.0 19800.0 50510.0  113.6
49020.0 19800.0 50573.9  66.2
49030.0 19800.0 50622.2  111.1
49040.0 19800.0 50599.0 *
49050.0 19800.0 50668.8 *
49060.0 19800.0 50686.0  272.5
49070.0 19800.0 50727.5  309.4
49080.0 19800.0 50774.3  364.7
49090.0 19800.0 50838.1  410.6
49100.0 19800.0 50902.4  421.1
49110.0 19800.0 50972.4  418.3
```
ModelVision assigns the line name specified in the second record (Line: 19800.0 in this example). Note also that ModelVision can access more than one of these line types by specifying a new import file each time and appending the data while reading.

Any number of Geosoft single line format files can be multiply defined and appended in ModelVision using the File>Import>Profiles>Multifile single Line (.DAT) option. Using this facility, you can position the cursor over one or more file names and select them using the CTRL and/or SHIFT keys. When OK is selected, the files are sequentially read and appended.

ER Mapper ASCII Format Profile

ER Mapper has the capability of creating a 'traverse' from a line drawn across an image. A description of this procedure can be found in the ER Mapper Reference documentation. The traverses are saved as an X (Easting), Y (Northing) and Z column free format file.

Changes have accrued with different releases of the ER Mapper software. Currently, only two format types exist and these are produced by ER Mapper Versions 4.x, 5.x and 6.x. No channel or line names are available from within the ER Mapper traverse files therefore ModelVision assigns the filename to the line name and uses the generic channel numbering of Z01, Z02 etc. The easting and northing columns are assumed to be the first and second columns contained in the file respectively.

ER Mapper Version 4.x File Format

No header records are written. Null value is set as -9999999. These files by default have the file extension ASC. An example of an ER Mapper traverse file is:

```
319738.7005179  6039825.1626095 44260.25604025
319743.6851914  6039826.9023722 44266.50016745
319748.6691548  6039828.6421346 44269.0728362
319753.6581183  6039830.3818971 44269.0728362
319758.6470818  6039832.1216697 44255.36273272
319763.6260452  6039833.8614222 44244.96281881
319768.6110087  6039835.6011848 44239.64391992
```

ER Mapper Version 5.x and 6.x File Format

This data type is similar to Version 4.x files however data records are preceded by header records flagged in the first column by '#'. Null values are set by values equal to -9999999. These files by default have the file extension TXT.

```
#
# Traverse from dataset :/erm/dataset/examples/bouguer.ers
# Number of traverse points: 704
#
# X location Y location        Value
384576.9249673 6523981.032161 -66.1868271429
384580.0938723  6523982.995928 -66.1896563684
384583.2627767  6523984.959995 -66.192410263
384586.4316714  6523986.923762 -66.1951211167
384589.6005761  6523988.887529 -66.1974334412
384592.7694708  6523990.850296 -66.1995182842
384595.9383755  6523992.814063 -66.2015584616
384599.1072802  6523994.778833 -66.2035539734
```
Simple XYZ Line Format (LIN)

This simple multi line format is comprised of a single header line followed by a number of data records that contain the multi-column data. The channel data may be positioned in any column but must be fixed length. Each channel value should occur in the same column location as the previous record. One of the columns contains the Linename. When a change in linename is detected, a new traverse is assumed. This format has a default file extension of LIN. Null value is set to be -999999.

An example of the Multi-Line format follows:

<table>
<thead>
<tr>
<th>LINE</th>
<th>EAST</th>
<th>NRTH</th>
<th>MAG</th>
<th>GRAV</th>
</tr>
</thead>
<tbody>
<tr>
<td>1700</td>
<td>1000</td>
<td>5400</td>
<td>56021</td>
<td>-.02</td>
</tr>
<tr>
<td>1700</td>
<td>1010</td>
<td>5405</td>
<td>56042</td>
<td>.01</td>
</tr>
<tr>
<td>1700</td>
<td>1020</td>
<td>5410</td>
<td>56503</td>
<td>.06</td>
</tr>
<tr>
<td>1700</td>
<td>1030</td>
<td>5415</td>
<td>56604</td>
<td>.10</td>
</tr>
<tr>
<td>1700</td>
<td>1040</td>
<td>5420</td>
<td>56805</td>
<td>.12</td>
</tr>
<tr>
<td>1700</td>
<td>1100</td>
<td>5495</td>
<td>56418</td>
<td>.04</td>
</tr>
<tr>
<td>1700</td>
<td>1110</td>
<td>5500</td>
<td>56018</td>
<td>.00</td>
</tr>
<tr>
<td>1700</td>
<td>1120</td>
<td>5505</td>
<td>55919</td>
<td>-.03</td>
</tr>
<tr>
<td>2000</td>
<td>1000</td>
<td>5700</td>
<td>56021</td>
<td>-.02</td>
</tr>
<tr>
<td>2000</td>
<td>1010</td>
<td>5705</td>
<td>56042</td>
<td>.01</td>
</tr>
<tr>
<td>2000</td>
<td>1020</td>
<td>5710</td>
<td>56503</td>
<td>.06</td>
</tr>
<tr>
<td>2000</td>
<td>1030</td>
<td>5795</td>
<td>56418</td>
<td>.04</td>
</tr>
<tr>
<td>2000</td>
<td>1100</td>
<td>5800</td>
<td>56018</td>
<td>.00</td>
</tr>
<tr>
<td>2000</td>
<td>1110</td>
<td>5805</td>
<td>55919</td>
<td>-.03</td>
</tr>
<tr>
<td>1900</td>
<td>1000</td>
<td>5600</td>
<td>56021</td>
<td>-.02</td>
</tr>
<tr>
<td>1900</td>
<td>1010</td>
<td>5605</td>
<td>56042</td>
<td>.01</td>
</tr>
<tr>
<td>1900</td>
<td>1020</td>
<td>5610</td>
<td>56503</td>
<td>.06</td>
</tr>
</tbody>
</table>

XYZ Multi-line Format with Separate Header (LIN+HDR)

This file import format uses data columns as detailed in the above Simple XYZ format, but the data file has no header. For this style of import, a separate file is used to specify the names and order of the columns of the data file. By default the data file has the extension of LIN but the separate header file has the extension HDR. This format style is useful in situations where large data files are to be imported into ModelVision. Editing a separate header file is much quicker and easier than editing the data file as a whole.

As for the single XYZ format, the channel data may be positioned in any column but must be fixed length and each channel value named in the header file should occur in the same column location as the previous record in the data file. One of the columns contains the Linename. When a change in linename is detected, a new traverse is assumed. The columns can be separated by either blank spaces or tabs. Null value is set to be -999999.

---

**Note**

The linename can be alphanumeric.

---

An example of a LIN and HDR file is provided below:
Data file (LIN):

1700.  1000.  5400.  56021.   -.02
1700.  1010.  5405.  56042.   .01
1700.  1020.  5410.  56503.   .06
1700.  1030.  5415.  56604.   .10
1700.  1040.  5420.  56805.   .12
1700.  1100.  5495.  56418.   .04
1700.  1110.  5500.  56018.   .00
1700.  1120.  5505.  55919.  -.03
2000.  1000.  5700.  56021.  -.02
2000.  1010.  5705.  56042.  -.06
2000.  1020.  5710.  56503.  -.04
2000.  1030.  5795.  56418.  -.02
2000.  1100.  5800.  56018.  -.02
2000.  1110.  5805.  55919.  -.03
1900.  1000.  5600.  56021.  -.02
1900.  1010.  5605.  56042.  -.06
1900.  1020.  5610.  56503.  -.06

Header file (HDR) :
LINE   EAST   NRTH   MAG   GRAV

Multi-line Geosoft XYZ File (XYZ)

The Geosoft file format is described in detail by Reeves and MacLeod (1986, First Break v4, No.2, pp9-17). These multi-line text files have the file extension XYZ. The file contains a single header record describing the Linetype and Linename, followed by data records. The survey Linetypes may be one of:

- LINE Regular survey lines
- BASE Base lines
- TIE Tie lines
- TREND Trend lines
- TEST Test lines

Normally the first Z column (after the X and Y columns) is used for the station number and the others are used for the actual readings. Although not necessary, this convention allows each data location to be identified by a unique and unchanging line-number/station-number pair.

Comment lines, indicated by a forward slash in the first column, may be used anywhere in the file. A null or dummy, null reading can also be specified within a reading of a Z column by a '*' character.

An example of a Geosoft multi-line file follows:

/ ------------------------------------------------
/ XYZ EXPORT [05/10/99]
/ DATABASE [EXAMPLE3.gdb : SUPER]
/ ------------------------------------------------
/ X Y  Dist  Ralt  Final_mag
/ ========= =========  ========= ========= =========
/ Line 1
242024.16 7649803 50 439.3587 57643.2
Geosoft Database (GDB)

The Geosoft database allows import of Oasis montaj™ databases (with default GDB file extension). These files should contain line data with data fields containing location information such as East and North (or suitable alias e.g. Easting/Northing or X/Y).

The import facility for these databases interrogate the data and determine the lines and data fields contained in the selected file. Lines, plus other data channels such as MAG, GRAV, FID etc can be selected from the import dialog.

Select the required lines and data channels for database import.

Once the lines and data channels are selected, click OK. You can then choose which channels to use for the X and Y fields.
The channels selected will be renamed either X and Y or East and North when the data is imported into ModelVision.

It is possible to import data which does not have X and Y information by selecting None in place of the field names. On import ModelVision will create X and Y channels based on the specified interval. This is so that a DIST_ABS channel can be created for use in ModelVision’s displays.

**ASEG-GDF2 File Format**

ASEG-GDF2 is an ASCII data exchange and archive standard for geophysical point and line data. The standard has evolved from an earlier ASEG-GDF standard defined in Dampney et al (1985) and an SEG draft standard (Dampney et al 1978). It defines the way in which data such as aeromagnetic, airborne EM, gravity and other point or line located data sets should be exchanged and archived. The objective of the standard is to provide a self-documenting and consistent method for exchanging and archiving located geophysical data between organizations with different hardware and software systems.

The ASEG-GDF is a self-defining format that allows located data to be automatically identified and loaded. An ASEG-GDF2 data exchange contains a decodable description of the data in one file plus the geophysical data in one or more additional files. The description file defines information such as field names, units of measurement, format, comments and missing data substitution values (nulls). The data is contained in simple, multi-column ASCII files (tables).

The data definitions are called DEFN records (usually retained in a file with file extension DFN). A separate DEFN record is used for each data set type that is included in the data exchange set. A set of DEFN records could be used to describe final processed aeromagnetic and radiometric data, base station magnetometer data and spectral calibration information. When ModelVision imports an ASEG-GDF file, each record is identified by its name and the corresponding format information in the DEFN record is used for automatic decoding of the data.

To initially identify the correct import data fields of Linename, Easting and Northing, on choosing the option **File>Import>Profiles>ASEG-GDF** the following dialog is presented.
Appendix A File Formats

Two files are used for the ASEG-GDF2 format. One file is a DFN (Definition) file while the other is a data (DAT) file. The contents of the DFN file specifies the columns, names and format.

An example of the DFN file format is provided below:

```
DEFN   ST=RECD,RT=COMM;RT:A4;COMMENTS:A76
DEFN 0 ST=RECD,RT=;FLTLINE:A10:NAME=Line
DEFN 1 ST=RECD,RT=;X:F13.1:NULL=-1E30:NAME=X
DEFN 2 ST=RECD,RT=;Y:F13.1:NULL=-1E30:NAME=Y
DEFN 3 ST=RECD,RT=;MAG:F13.1:NULL=-1E30:NAME=MAG
DEFN 4 ST=RECD,RT=;GRAV:F13.5:NULL=-1E30:NAME=GRAV
DEFN 5 ST=RECD,RT=;DIST_ABS:F13.1:NULL=-1E30:NAME=DIST_ABS
```

An example of the data (DAT) file for the above definition is:

```
1600  200.0    53800.0      56481.0     -0.01000
1600  220.0    53810.0      56479.5        -1E30
1600  240.0    53820.0      56478.4     -0.00300
1600  260.0    53830.0      56477.5     -0.00100
1600  280.0    53840.0      56477.0      0.00000
1600  300.0    53850.0      56476.8      0.00000
1600  320.0    53860.0      56476.7     -0.00100
1600  340.0    53870.0      56476.7     -0.00300
1600  360.0    53880.0      56476.7     -0.00500
```

**AMIRA Multi-line Format (TEM)**

The AMIRA file format is similar to the Geosoft single line format as defined in the previous section, but with some modifications specific to the recording of Time Domain Electromagnetic data. A detailed description of the AMIRA format is available from Tensor Research Pty Ltd and is in documentation associated with the EM Vision program.

As for the Geosoft format, the file can define a single traverse line but it can also be used for multi-line data. In this case, a column label of LINE is used to define the appropriate column. Three header lines are used as follows:
Comment lines commence with a back slash (\) or forward slash (/) in column 1. A number of reserved constant and label names are used specifically for defining EM parameters. Some examples of these are LOOP (Transmitter loop identifier), RMP (decay ramp time), F or Frequency (transmitter waveform cycle setting) etc. ModelVision makes no use of these labels. Null value is set to be -1.0E33.

An example of the AMIRA TEM format is provided below:

AMIRA Format example file - Zonge data - In-loop configuration

UNITS:(uV/A)  LINE=5800  F=Z16 RMP=127  INITDELAY=0.127  LSIDE:100
\ Project: Demonstration
\ Date: 93-01-19
\ Window Times: .1288 .2504 .3720 .4936

STN C NCH CH1 CH2 CH3 CH4
4800.00 I 28 1.1699e+4 3.2773e+3 1.4177e+3 7.7495e+2
4900.00 I 28 8.8746e+3 2.7975e+3 1.3107e+3 7.4890e+2
5000.00 I 28 1.0569e+4 3.5472e+3 1.6956e+3 9.8539e+2
5100.00 I 28 1.4407e+4 4.9145e+3 2.2899e+3 1.3079e+3
5200.00 I 28 1.1142e+4 3.8580e+3 1.8373e+3 1.0715e+3
5300.00 I 28 9.0130e+3 2.5832e+3 1.2214e+3 7.3895e+2
5400.00 I 28 9.2846e+3 2.6141e+3 1.1563e+3 6.7040e+2
5500.00 I 28 1.1543e+4 4.1221e+3 1.5998e+3 8.0849e+2
5600.00 I 28 8.8624e+3 3.0271e+3 1.4144e+3 7.7529e+2

Point Data Format

Point data uses the same multi-column format as the LIN multi-line format, the Toolkit format, the Geosoft DAT or the .ASC (ER Mapper) formats all described above. The LIN format used for points comprises a single header line followed by a number of data records. Data can be imported as a number of point data sets. The header line contains the keyword 'Point' which defines the file as point data to ModelVision.

The channel data may be positioned in any column but must be fixed length and each channel value should occur in the same column location as in the previous record. One of the columns defines the Point dataset. When a change in Point dataset is detected, a new group of points is assumed. This file format type has a default file extension of LIN.

An example of two point datasets is shown below:

POINT X Y Elev Obs Grav FreeAir Boug2.67
1000 290317.813 6567573.000 287.12 9793745.22 29.27 -291.94
1000 285590.000 6590143.000 225.25 9793607.75 11.51 240.49
1000 285317.688 6583827.000 242.32 9793674.09 29.44 241.65
1000 289011.313 6562047.000 262.74 9793678.59 8.42 -285.52
1000 287788.688 6555632.500 312.42 9793608.15 -3.48 -352.99
1000 288908.688 6596862.000 320.04 9793491.49 -37.59 -395.63
1000 290597.313 6602272.000 330.10 9793354.62 -107.01 -476.30
1000 291605.000 6606471.500 376.73 9793208.64 -62.78 -484.24
Drillhole Data Format

Drillhole data uses the same multi-column format as the LIN (XYZ) multi-line format described above. This simple format is comprised of a single header record followed by a number of data records which contain the multi-column data. The channel data may be positioned in any column but must be fixed length and each channel value should occur in the same column location as in the previous record. One of the columns defines the Drillhole (HOLE column). When a change in drillhole is detected, a new hole is assumed. This file format type has a default file extension of LIN.

Drillhole data can contain three-component vector data. This data and the orientations of the vectors are discussed in the section Drillhole Data and Vector Information. Note too that drillhole readings can be used to compute magnetic and gravitational responses (refer to Drillhole Modelling).

An example of two drillholes with vectors is shown below:

<table>
<thead>
<tr>
<th>HOLE</th>
<th>EAST</th>
<th>NRTH</th>
<th>DEPTH</th>
<th>VX</th>
<th>VY</th>
<th>VZ</th>
<th>MAG</th>
<th>MDEL</th>
</tr>
</thead>
<tbody>
<tr>
<td>DDH1800</td>
<td>-20.0</td>
<td>4200.0</td>
<td>20.00</td>
<td>2.0</td>
<td>-5.98</td>
<td>0.0</td>
<td>56507.1</td>
<td>5.9</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-18.0</td>
<td>4201.0</td>
<td>25.00</td>
<td>2.0</td>
<td>-6.69</td>
<td>2.0</td>
<td>56507.0</td>
<td>6.6</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-17.0</td>
<td>4202.0</td>
<td>29.00</td>
<td>4.0</td>
<td>-7.53</td>
<td>4.0</td>
<td>56507.0</td>
<td>7.5</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-16.0</td>
<td>4202.0</td>
<td>32.00</td>
<td>6.0</td>
<td>-8.52</td>
<td>6.0</td>
<td>56507.0</td>
<td>8.5</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-15.0</td>
<td>4203.0</td>
<td>37.00</td>
<td>8.0</td>
<td>-9.69</td>
<td>8.0</td>
<td>56507.0</td>
<td>9.6</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-12.0</td>
<td>4203.0</td>
<td>40.00</td>
<td>0.0</td>
<td>11.07</td>
<td>0.0</td>
<td>56507.0</td>
<td>1.0</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-9.0</td>
<td>4204.0</td>
<td>43.00</td>
<td>2.0</td>
<td>12.63</td>
<td>2.0</td>
<td>56507.0</td>
<td>2.6</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-7.0</td>
<td>4204.0</td>
<td>47.00</td>
<td>4.0</td>
<td>14.33</td>
<td>4.0</td>
<td>56507.1</td>
<td>4.3</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-4.0</td>
<td>4205.0</td>
<td>51.00</td>
<td>6.0</td>
<td>16.06</td>
<td>6.0</td>
<td>56507.1</td>
<td>6.0</td>
</tr>
<tr>
<td>DDH1800</td>
<td>-2.0</td>
<td>4205.0</td>
<td>54.00</td>
<td>8.0</td>
<td>17.59</td>
<td>8.0</td>
<td>56507.2</td>
<td>7.5</td>
</tr>
<tr>
<td>DDH1800</td>
<td>0.0</td>
<td>4206.0</td>
<td>57.00</td>
<td>0.0</td>
<td>18.65</td>
<td>0.0</td>
<td>56507.3</td>
<td>8.6</td>
</tr>
<tr>
<td>DDH1800</td>
<td>2.0</td>
<td>4208.9</td>
<td>60.00</td>
<td>2.0</td>
<td>18.97</td>
<td>2.0</td>
<td>56507.5</td>
<td>8.9</td>
</tr>
<tr>
<td>DDH1920</td>
<td>72.0</td>
<td>5101.0</td>
<td>35.00</td>
<td>2.0</td>
<td>-6.69</td>
<td>2.0</td>
<td>56507.0</td>
<td>6.5</td>
</tr>
<tr>
<td>DDH1920</td>
<td>73.0</td>
<td>5102.0</td>
<td>39.00</td>
<td>4.0</td>
<td>-7.53</td>
<td>4.0</td>
<td>56507.0</td>
<td>7.5</td>
</tr>
<tr>
<td>DDH1920</td>
<td>76.0</td>
<td>5102.0</td>
<td>42.00</td>
<td>6.0</td>
<td>-8.52</td>
<td>6.0</td>
<td>56507.0</td>
<td>8.5</td>
</tr>
<tr>
<td>DDH1920</td>
<td>78.0</td>
<td>5103.0</td>
<td>47.00</td>
<td>8.0</td>
<td>-9.69</td>
<td>8.0</td>
<td>56507.0</td>
<td>9.6</td>
</tr>
<tr>
<td>DDH1920</td>
<td>79.0</td>
<td>5103.0</td>
<td>50.00</td>
<td>0.0</td>
<td>11.07</td>
<td>0.0</td>
<td>56507.0</td>
<td>1.0</td>
</tr>
<tr>
<td>DDH1920</td>
<td>82.0</td>
<td>5104.0</td>
<td>53.00</td>
<td>2.0</td>
<td>12.63</td>
<td>2.0</td>
<td>56507.0</td>
<td>2.6</td>
</tr>
<tr>
<td>DDH1920</td>
<td>87.0</td>
<td>5104.0</td>
<td>57.00</td>
<td>4.0</td>
<td>14.33</td>
<td>4.0</td>
<td>56507.1</td>
<td>4.3</td>
</tr>
<tr>
<td>DDH1920</td>
<td>94.0</td>
<td>5105.0</td>
<td>61.00</td>
<td>6.0</td>
<td>16.06</td>
<td>6.0</td>
<td>56507.1</td>
<td>6.0</td>
</tr>
<tr>
<td>DDH1920</td>
<td>96.0</td>
<td>5105.0</td>
<td>64.00</td>
<td>8.0</td>
<td>17.59</td>
<td>8.0</td>
<td>56507.2</td>
<td>7.5</td>
</tr>
<tr>
<td>DDH1920</td>
<td>100.0</td>
<td>5106.0</td>
<td>67.00</td>
<td>0.0</td>
<td>18.65</td>
<td>0.0</td>
<td>56507.3</td>
<td>8.6</td>
</tr>
<tr>
<td>DDH1920</td>
<td>102.0</td>
<td>5108.9</td>
<td>70.00</td>
<td>2.0</td>
<td>18.97</td>
<td>2.0</td>
<td>56507.5</td>
<td>8.9</td>
</tr>
<tr>
<td>DDH1920</td>
<td>104.0</td>
<td>5110.7</td>
<td>72.00</td>
<td>4.0</td>
<td>18.60</td>
<td>4.0</td>
<td>56507.7</td>
<td>8.6</td>
</tr>
<tr>
<td>DDH1920</td>
<td>106.0</td>
<td>5112.6</td>
<td>79.00</td>
<td>6.0</td>
<td>17.70</td>
<td>6.0</td>
<td>56508.0</td>
<td>7.7</td>
</tr>
</tbody>
</table>
Supported Grid Formats

- Encom Grid Format
- ER Mapper Grid Format
- Geosoft Binary Grid Format
- ASEG GXF format
- Geopak Grid File Format
- USGS Binary Grid File

Encom Grid Format

An Encom grid file is a binary file that is composed of a header of 240 bytes followed by the grid values written row-wise from an origin at the bottom left corner. The location reference for the origin grid cell (1,1) is at the centre of the cell.

HEADER

1 - 80  file origin  (character*80)
81 - 160 file title  (character*80)
161 - 168 reference name  (character*8)
169 - 172 'GRID'  (character*4)
173 - 176 'FPT'  (character*4)
177 - 184 'ZNIL', null value for file  (character*4,real*4)
185 - 192 'ROWS', no. of rows  (character*4,real*4)
193 - 200 'COLS', no. of columns  (character*4,real*4)
201 - 208 'XORG', minimum x value  (character*4,real*4)
209 - 216 'YORG', minimum y value  (character*4,real*4)
217 - 224 'DX', x grid cell size  (character*4,real*4)
225 - 232 'DY', y grid cell size  (character*4,real*4)
233 - 240 'DEGR', degrees anticlockwise from north to y-axis  (character*4,real*4)

DATA

Real*4 values in order shown:

\[(r2,c1),(r2,c2),(r2,c3),\ldots,(r2,ncol)\]
\[\ldots\]
\[(nrow,c1),(nrow,c2),(nrow,c3),\ldots,(nrow,ncol)\]

The total size of the file is therefore \((ncol * nrow * 4) + 240\) bytes.
**ER Mapper Grid Format**

The ER Mapper software image/grid format is described in detail in the *ER Mapper Open Standards* documentation. The grid format is unchanged from Versions 3.x, 4.x, 5.x and 6.x of ER Mapper. The standard raster image which may be displayed by ER Mapper software can be imported as a ModelVision grid. The image/grid is actually defined by two files, a header (.ers file) plus a binary BIL (Band Interleaved by Line) data file. The content of the .ers file is defined in ER Mapper documentation but an example is shown below:

```plaintext
DatasetHeader Begin
  Version = '5.5'
  LastUpdated = Thu Mar 3 23:38:11 GMT 1995
  SensorName = 'GEOTEM'
  SenseDate = Fri Nov 19 06:07:58 GMT 1996
  DataSetType = ERStorage
  DataType = Raster
  ByteOrder = MSBFirst
  CoordinateSpace Begin
    Datum = 'AGD66'
    Projection = 'TMAM53'
    CoordinateType = EN
    Units = 'METERS'
    Rotation = 0:0:0.0
  CoordinateSpace End
  RasterInfo Begin
    CellType = Signed32BitInteger
    NullCellValue = -9999999
    CellInfo Begin
      Xdimension = 50
      Ydimension = 50
    CellInfo End
    NrOfLines = 128
    NrOfCellsPerLine = 320
    RegistrationCoord Begin
      Eastings = 327600
      Northings = 8595050
    RegistrationCoord End
    NrOfBands = 2
    BandId Begin
      Value = 'Channel 16'
      Units = 'ppm'
    BandId End
    BandId Begin
      Value = 'Channel 3'
      Units = 'ppm'
    BandId End
  RasterInfo End
DatasetHeader End
```

**Note**

When ER Mapper grids are being output using the ModelVision Export option, the projection and spheroid of the created grid can be automatically defaulted from the PROJECTION parameter of the MVISION.INI file (see *Appendix D: Defaults and Settings*).
Geosoft Binary Grid Format

The Geosoft binary grid format is composed of two elements:

- A 512 byte grid header
- The grid/image data

Specific details of the contents of these files can be obtained from Geosoft (Toronto, Canada). Some revisions of the grid format have been made and the import utility within ModelVision has been established to comply with the grid format current as of February 1994.

ASEG GXF format

This grid format is an ASCII file with a series of header lines which define origin, rows, columns, mesh size etc. This format has been developed by Mr Steve Collins (Arctan Services Pty Limited, Sydney, Australia) in conjunction with Geosoft, (Canada). The format has been adopted by the Australian Society of Exploration Geophysicists (ASEG) as a grid standard and is documented in *Exploration Geophysics (1991)* V.22, pp593-614.

An example of a GXF grid format is:

```plaintext
#TITLE
Channel 16
#XORIGIN
327600.000
#YORIGIN
8595050.000
#ROWS
128
#POINTS
320
#RWSEPARATION
50.000
#PTSEPARATION
50.000
#ZMAXIMUM
27533.000
#ZMINIMUM
-2203.546
#DUMMY
-999999999
#ROTATION
0.000
#GRID
```

The grid format also supports a compressed form using base 90. The compressed grid format is not currently supported by ModelVision.
**Geopak Grid File Format**

The Geopak standard grid format is structured as an unformatted Microsoft Fortran Binary file where each row of the file is read as one record. The first row of information contains a header, consisting of thirty two REAL*4 words.

All remaining rows in the file contain scaled INTEGER*2 records, column sorted from left to right. The first row of data (second record in the file) is the bottom row of the grid. The third record in the file is the second row and so on until the last record in the file corresponds to the final top row of the input grid. The header structure is 32 REAL*4 words, where:

- **Header(1)**  Number of rows of grid
- **Header(2)**  Number of columns
- **Header(3)**  Multiplier (See Header (21))
- **Header(4)**  Constant (See Header (22))
- **Header(5)**  X origin
- **Header(6)**  Y origin
- **Header(7)**  Grid rotation angle (Radians positive clockwise)
- **Header(8)**  Dummy value (See Header(26))
- **Header(9)**  Map scale (e.g. 5000 for 1:5000)
- **Header(10)** Number of ground units per cell in X direction
- **Header(11)** Number of ground units per cell in Y direction
- **Header(12)** Number of inches per ground unit (12 if feet, 39.37 if metres)
- **Header(13)** X offset. Points to the original origin if the grid has been rotated
- **Header(14)** Y offset. Points to the original origin if the grid has been rotated
- **Header(15)** Version number
- **Header(16)** Dummy value set to zero
- **Header(17)** Number of rows in grid
- **Header(18)** Number of columns in grid
- **Header(19)** Dummy value set to zero
- **Header(20)** Dummy value set to zero
- **Header(21)** The number each grid has been multiplied by to scale it to Integer*2
- **Header(22)** The value subtracted from the grid before the value was scaled to be Integer*2
- **Header(23)** Prescaled maximum of grid
- **Header(24)** Prescaled minimum of grid
- **Header(25)** Dummy value of zero
- **Header(26)** Default value (usually -32767 or -32768) or non-data null
- **Header(27)** Inclination - Used in Geopak software for shade imaging
- **Header(28)** Declination - Used in Geopak software for shade imaging
- **Header(29)** Contrast - Used in Geopak software for shade imaging

**Note**

Header words 16, 19, 20, 25, 30, 31 and 32 are not used and should be set to zero.
USGS Binary Grid File

The definition of the USGS (United States Geological Survey) grid file is provided in a paper by Cordell et al (1992).

The grid file consists of a header record followed by one record for each row of data. The origin of the grid is lower left (southwest) corner, starting at row 1, column 1. Row numbers increase upwards (north) and column numbers increase right (east). The header record (234 byte words) comprises:

- **id**: 56 ASCII identification (character*56)
- **pgm**: 8 ASCII identification of creating program (character*8)
- **ncol**: Number of columns. (integer)
- **nrow**: Number of rows (integer)
- **nz**: Number of words per data element. (integer)
- **x0**: Position of first column of data in km. (real*4) or degrees of latitude
- **dx**: Spacing interval of columns (same units as x0)
- **y0**: Position of first row of data in km or degrees of latitude (real*4)
- **dy**: Spacing interval of rows (same units as y0) (real*4)

Each data record contains one row of scalar, real-valued data. The first word contains the row coordinate and subsequent words contain data:

\[ f(1,j), f(2,j) \ldots f(n\text{col},j) \text{ for the } j\text{-th row of data.} \]
ModelVision supports a range of standard body types. See General Guidelines for guidelines on defining bodies. A model refers to a combination of one or more of these bodies. The individual body types supported include:

- **Polygonal**
- **Plunging Prism**
- **Frustum**
- **Elliptic and Circular Pipe**
- **Tabular**
- **Sphere**
- **General 3D Ellipsoid**
- **Polyhedron**

**General Guidelines**

Bodies can be selected from either map or section views and individual dialogs are used for editing the various body types. Remanence, susceptibility and density are common to all bodies. Other parameters such as dip or strike length may apply to some bodies (e.g. tabular) but not others (e.g. spheres).

A few guidelines for defining bodies include:

- **Depth** is always defined as positive downwards.
- Strike direction (called 'horizontal azimuth of strike' or just 'azimuth') is referenced to a clockwise rotation from true north - not magnetic north (see Figures below).
- If two or more bodies overlap in space from that a potential field contribution is provided by each separate body, the program adds their individual responses. This situation applies to both magnetics and gravity modelling.

**Polygonal**

The parameters required to define the 3D plunging polygon are:

A series of at least three x-axis and z-axis (depth) coordinates that describe the corners of cross-sectional outline of the body. These coordinates describe the principal polygonal section of the body perpendicular to the strike direction. There is no theoretical upper limit to the number of x,z coordinate pairs permitted for an individual body. In practice it is recommended that the number be kept less than 200 x, z pairs. The polygon coordinate pairs can be input in either a clockwise or an anticlockwise sense. However, they must be continuous with no sides crossing other sides. Any repeated points are ignored.

A line along the polygon strike axis (in distance units) defines the strike length of the polygon. The centre point of the line can be offset from the modelled profile such that the body can be partially, entirely, or not intersected by a vertical plane through the calculation profile.
Azimuth of strike for the polygonal body is measured in degrees positive and clockwise from the positive y-axis.

Although created with zero plunge initially, the polygon can plunge at an angle (0 ≤ plunge ≤ 90°) relative to the horizontal along the line of azimuth.

**Plunging Prism**

The Plunging Prism is a flexible and powerful body that offers advantages over the Polygon. Although it can be created in both map or section windows, other than a rectangular plan shape must be created in a plan (map) display. The Plunging Prism can simulate geological structures such as anticlines, synclines and lenticular bodies. The body has the following characteristics.

The body is usually created by digitizing its outline in a map view. This outline is duplicated vertically below the upper surface to define the base of the body.

Body plunge can be changed from vertical by assigning a plunge angle and azimuth to the prism axis.
The top surface of the body can also be assigned a dip angle (up to 90°) and azimuth.

Complex bodies can be created with this simple interface. The outline shape initially extends vertically downwards and maintains the defined outline. If a plunge is used, the outline of the body is maintained but in the plunging orientation towards a specified azimuth. A final modification that can be applied is to add a dip to the top surface of the body, again in a specified azimuthal direction. Care must be taken that any dip applied to the top surface does not cause the top surface to intersect the bottom surface. ModelVision detects this situation and warns you if this arises.

The location and reference point of the body is initially located at the centroid of the top face. If this face is made to dip, the reference point is at the same location and so is outside the body.

Limitations that apply to the Plunging Prism are:

- The top surface must not intersect the bottom surface. This can happen if too large a dip is used for the top surface.
- The bottom face of the body is always horizontal.
Frustum

The Frustum body type has a similar polygonal cross-section to the plunging prism. The two principal differences between these body types are that the top of the frustum is constrained to be horizontal, and that the size of the frustum can be set to vary with depth. Size variation of the frustum body with depth is controlled by the taper factor. If the taper has a value of one the body has a constant cross-sectional size with depth, if the taper has a value greater than one the size of the body increases with depth, and if the taper is less than one the size of the body decreases with depth. A frustum body with taper greater than one can be used to represent a domal structure or pluton, and a taper less than one can be used to represent a basin or a section of a river channel or syncline.

A frustum body is usually created by digitizing its outline in a map view. Body plunge can be changed from vertical by assigning a plunge angle and azimuth to the prism axis, and the size of the body can be set to vary with depth. Each vertex on the top surface has a corresponding vertex on the base, and these pairs of vertices have common bearing from the centroid of the body. The ratio of horizontal distance from the centroid to a vertex on the base of the body and to its corresponding vertex on the top surface is specified by the taper factor. If this value is greater than one the size of the body increases with depth, if less than one the size of the body reduces with depth. The location of the centroid of the body is defined when the body is first created and is repositioned by any shift of the body so that the shape of the body with depth is constant as the body is moved from one position to another. However to avoid any unintended changes in shape with depth the centroid is not updated as vertices are added, deleted or moved. The location of the centroid can be reset as required using the **Re-centre** button in the body dialog.

Elliptic and Circular Pipe

The pipe body can have a variable size with depth controlled by a taper factor similar to the frustum body type. The difference between the frustum and pipe body types is that the pipe is constrained to an elliptic or circular horizontal section. For the pipe body the taper factor is defined as the ratio of the radii of the bottom and top surface ellipses. The pipe body is suitable for representing many volcanic pipes and kimberlites. The advantage of defining the horizontal section by an analytic shape is most evident on inversion of the body. Inversion of body shapes defined by vertices typically results in ragged body outlines, whereas inversion of cross-section radii is a lot more stable.

The elliptic pipe can sometimes be not easily constrained in a single profile because of the 2 axes lengths. In this case it is recommended to use the circular pipe because it only has a single radius parameter required to be edited.

Parameters which can be manipulated are: vertical Extent, Plunge Azimuth, Plunge, Semi Axis Length A, Semi Axis Length B, Axis Azimuth and Taper.

The circular pipe body type contains two less parameters than the elliptic pipe body – length of A and B axes and the axes azimuth have been removed. Parameters which can be manipulated are: Vertical Extent, Plunge Azimuth, Plunge, Radius and Taper.

Tabular

The tabular body has the following characteristics:

The top and bottom faces of the tabular body are horizontal. The end pair of sides is vertical and the remaining two sides can be made to dip at a defined dip angle.
Section and Plan of theoretical axes for a Tabular Body

The location of the centre of the tabular body top face (x,y,z) defines the position of the body. See the above figure for details. Initially the tabular body is created symmetrically about the cross-section. Its position however is independent of the profile and can be moved in map views.

The thickness parameter controls the horizontal face widths. The extent or depth parameter defines the vertical distance between the top and bottom faces of the body.

The dip of the side faces is defined as degrees clockwise from the horizontal when viewed in the strike direction. The range of dip is from $0^\circ < \text{dip} \leq 180^\circ$. Note that if the dip angle of the body is made too small such that the extent approaches zero, a message indicating the body is too small is displayed.

The azimuth of the principal axis of the body is defined as a clockwise rotation in degrees from true north to the principal axis. See the section on Changing Spatial Properties for additional information.

**Sphere**

The parameters required to define a spherical body are as follows:

- The radius of the sphere.
- The location of the sphere centre (X,Y,Z). See the figure below for details.
Section and Plan of theoretical axes for a Sphere

General 3D Ellipsoid

The generalized 3D ellipsoid is one of the most difficult of bodies to visualize and characterize by simple axis and rotation parameters. For this reason a detailed illustration is provided. For additional information on this body, refer to Emerson et al (1985).

The generalized ellipsoid is a complete but flexible body type that approximates each of:

- General ellipsoid.
- Sphere, where all ellipsoid axes are equal
- Prolate ellipsoid. That is, similar in shape to a football, where the ellipse rotates about the long axis and the shorter axes are equal in length
- Oblate ellipsoid. That is, similar in shape to a discus, where the axis of revolution is short, and the two other axes are long and equal in length.
Appendix B Body Descriptions

Ellipsoid angles defined on two orthogonal cross sections a map view and 3D perspective view.

The parameters defining all cases of the general ellipsoid body are:

- Location X,Y,Z defines the ellipsoid centre.
- Ellipsoid axes are referred to as A, B and C (see the above figure). Axis A is referred to as the major axis, B as the semi-major or intermediate axis and C as the minor axis. The lengths of each ellipsoid semi-axis define the ellipsoid shape.
- Horizontal azimuth of the +A-axis is measured as the rotation in degrees of the +A axis looking in the down-dip direction. The azimuth is clockwise positive clockwise map north. The A-axis azimuth ranges from 0° to 360°.
- The +A-axis dip is measured in degrees from the horizontal plane such that 0° ≤ dip ≤ 90°.
- The ellipsoid rotation is the anticlockwise angle between the vertical plane along the A axis and the B-axis while looking down dip. See the above figure for the details. The ellipsoid rotation can range from -90° to 90°.

The following dialog shows the axis parameters for the above figure.
Polyhedron

The polyhedral body provides the most complex of all body types. Its three-dimensional complexity is built from individual boundary three-sided facets that are each connected to the adjacent facet along one edge.

The boundary surfaces of a polyhedron body can be determined by external bounding surfaces having irregular shapes but the faceted edge limits of the body mould their shape to these surfaces.

The physical properties (magnetic susceptibility and density) of any single polyhedron body are uniform within these body types.
External Data Links

ModelVision supports links to external databases and data files via a table driven system of link programs. It is possible to interrogate, enquire, import and export data from these external databases and files from within ModelVision.

To create a link, three utility programs in any language or script that can produce an executable file are required. Import and export utilities are necessary to convert between your data format and any format supported internally by ModelVision (e.g. Geosoft). An enquiry program is required to return information about your data such as a list of line and channel names.

Once written, these programs can be accessed from ModelVision menus and it appears that ModelVision has native support for the external data. The \texttt{MVISION.INI} default file (see Appendix A: File Formats) is used to define the program names, paths and necessary file types for ModelVision to access the external data. This can be done from within ModelVision via a dialog box. Each entry in this table describes the attributes and program names for that link.

- **External Link Operation**
- **Creation of External Link Programs**
- **Linking to Intrepid Databases**
- **External Model Link**

**External Link Operation**

From the File Import menu item, select the External Links option and a dialog describing the available links is presented.

The import external link dialog can also be used to create, delete and update the entries in the \texttt{MVISION.INI} file with details of available link programs. For example, if the Update button is selected, a dialog which defines the linkage program names, file types etc. is displayed.
External links Update dialog describing programs used for the linkage

Entries placed in this dialog are written to the MVISION.INI file when OK is clicked. The File Filter entry provides a file extension which is used as the default when searching for the external file input. Greater detail is provided in *Example Intrepid Link Definition in MVISION.INI File* for importing data from Intrepid.

To transfer data from the external data source into ModelVision, select the external link to be used. If you select the **Execute** option in the Import dialog, you are requested to define the path and file or database which contains the external data. When this is done, a dialog which contains information about the external data is presented.

Dialog to select the data lines, channels or data within certain limits

From this dialog, select the lines and the channels to be exported out of the database and read into ModelVision. Note that if data is to be exported from the database that covers only a specific area, data export limits can be defined.
When the external input file and data are defined, the named Import program is executed to access the data. This program extracts only the data lines and channels requested. It is important that the channels nominated comply with the data format type selected. For example, in the case above the data channels for East and North would be required to satisfy the Geosoft format requirement that the first two channels of the data file be X and Y locations information.

During execution of the export program, exported data is written to a temporary file (in the above example, in Geosoft XYZ multi-line format) which is automatically read into ModelVision. The temporary file is deleted after the data is loaded into ModelVision.

**Creation of External Link Programs**

Although the export, enquiry and import programs required for the transfer of data can be created in any language which can make an executable, there are some guidelines which must be followed to generate the executable files.

Tensor Research Pty Ltd can supply a number of external linkage executable programs suitable for access to existing software and databases. To assist with the creation of new programs, contact Tensor Research Pty Ltd for a detailed description and program specification.

It is not necessary to have both an export and import programs for a particular format. If you wish to have only the import capability but not the export facility, this is satisfactory for ModelVision to have access to the external data. It means however that modelled, or modified data from ModelVision cannot be written out to the external data source. This situation is referred to as a partial link.

**Examples of Link Definitions in MVISION.INI File**

Example of a Link Definition for an external data source is:

```ini
[LINK_XYZ]
name=XYZ
descr=XYZ Link
ext=
format=amira_tem
enquiry=c:\Program Files\encom\mvis_pro\links\myenq
import=c:\Program Files\encom\mvis_pro\links\myimport
export=
type=profile
```

Example of a Link Definition for file-selectable data:

```ini
[LINK_ABC]
name=ABC
descr=ABC Link
ext=tem
format=amira_tem
enquiry=c:\Program Files\encom\mvis_pro\links\myenq
import=c:\Program Files\encom\mvis_pro\links\myimport
export=c:\Program Files\encom\mvis_pro\links\myexp
type=profile
```
Linking to Intrepid Databases

The Intrepid dynamic link is accessed through ModelVision’s import facility using an external executable to directly access the Intrepid database structures. Data is transferred via an intermediate exchange file.

Select the External Link option from the File>Import>Line menu option

Select the Intrepid link option and click Execute. A pathing option screen is presented if the link is configured correctly.

Path to the required Intrepid project

Select the desired project and enter the path. Select OK and the ModelVision link program interrogates the Intrepid database designated by the pathing information.
The link displays a list of the available projects based on the standard Intrepid directory structures. You can select a subset of the total project that filters the available data based on:

- Channel list
- Line list
- Easting, northing bounding rectangle

![Select import channels from the available list](image1)

![Select the required lines from the available list](image2)

You can navigate between the selection of Lines and Channels by using the push buttons on these dialogs. When satisfied with the selection, click OK and the link program initiates the transfer of data from the Intrepid database into ModelVision.
Large amounts of data can be transferred in this manner. The transfer can take some time if large datasets are to be transferred.

**Example Intrepid Link Definition in MVISION.INI File**

To ensure the Intrepid link is operational, a correct MVISION.INI entry is required. An example of the correct format of this entry is presented below:

```
[LINK_INTREPID]
name=INTREPID
descr=Import data from Intrepid to MV
extent=
format=intrepid
enquiry=c:\Program Files\encom\mvis_pro\links\int2mv.exe
import=c:\Program Files\encom\mvis_pro\links\int2mv.exe
export=
type=profile
```

**External Model Link**

External model links are available in ModelVision to provide a method for building import routines to other software systems. A model link exists as a separate executable program that communicates with ModelVision via file exchange. As an example, during installation a link is supplied which is a simple import routine that allows conversion of a series of closed polygons to ModelVision compatible 3D body polygons.

These polygons could be derived from a simple digitized mine cross section, schematic model or seismic section (depth corrected).

- **Input File Preparation**
- **Running the External Link**
- **Specifying External Link in MVISION.INI and TOPO2.INI**

**Input File Preparation**

The import file is defined by a line of section plus the polygons that lie along the section. Start and end points define the real world location of the traverse, while the polygons are defined by distance from the start of the traverse (X) and depth below the ground surface (Z). The input file contains two header lines that define the real world coordinates for the start and end of the straight line section (X0,Y0 and X1,Y1), followed by a series of polygon coordinates. Each polygon is defined in units of distance (metres), depth (metres) and polygon number. The input file format is similar to that shown.

```
0.0 0.0
26000.0 0.0
25003.8 7840.3 2 GEOLOGY 3
25003.8 2002.5 2 GEOLOGY 3
16010.9 2002.5 2 GEOLOGY 3
15215.8 3014.0 2 GEOLOGY 3
14209.4 4250.3 2 GEOLOGY 3
```
Example file showing the format of an external polygon file. The last two fields in this example are ignored by the import routine.

Additional fields can appear in the file following the polygon number, but they are ignored by the import module.

Provision is provided within ModelVision to translate and scale the coordinates. This is presented in a dialog which is displayed after the file is accessed through the external link. Definition of a polygon body is terminated when the polygon name/number changes. Any extra column information is ignored.

Running the External Link

The import sequence for conversion of an external ASCII file to a series of ModelVision polygon bodies is covered in the following steps:

Step 1

From the ModelVision menu select Model>Import>External Link.
Step 2

Choose TOPO2 and Execute. TOPO2 is the name assigned to the external link in the MVISION.INI file. See details of the inclusion in the .INI file below. You can use the Update button to modify the search criteria or specifications of the link if desired. In the example below, the link automatically finds files with the filename suffix of .ACO.

If you are modelling without field data, you need to use the Utility>Synthetic menu option to create a line for the model. The model import does not create this line for you.

Step 3

Select Data from the new menu, and enter appropriate values to scale and offset the input coordinates.
The input coordinates for distance along the profile and depth can be scaled from arbitrary digitizer units to metres using a transform formula equivalent to:

\[ z = (y-a) \times b \]

and

\[ x = (x-c) \times d \]

where,

- \( a \) is a constant that represents the height offset to apply to the digitizer \( y \) values.
- \( b \) is a constant multiplier to convert digitizer height units to metres. This is useful to convert digitizer \( y \) values that are positive up to depths. This value is negative if heights are used for \( y \) and positive if depths are used for \( y \).
- \( y \) is the digitizer height or depth value.
- \( c \) is a constant that represents the distance offset to apply to the digitizer coordinates. This would normally be the left hand origin of the section.
- \( d \) is a constant multiplier to convert digitizer distance units to metres.
- \( x \) is the digitizer value for distance along the cross section.

Other parameters in the control dialog box include compression tolerance, and sample interval. These parameters are used to decimate large digitizer files that generate more points than are required for modelling.

Compression is used as a guide to retention of detail in the model and is the distance in metres that an intermediate point can depart from a straight line before it is retained in the model.
Sample interval allows you to select every second, third, fourth etc. point in the sequence. The first and last points are always retained.

**Step 4**

Select **Model** from the menu to change model parameters for the imported bodies.

The Model Parameter dialog box allows you to associate initial magnetic and density properties to all the polygons in the import file. Properties for individual polygons can be changed after the file has been imported. Strike length, plunge and remanence values can also be assigned at import time.

![TOPO2 Model Parameters dialog](image)

**Step 5**

Select **Run** to load the polygon data.

**Specifying External Link in MVISION.INI and TOPO2.INI**

External import modules are implemented as standalone executable files that communicate with ModelVision through INI files. The name of the external program (TOPO2.EXE) and other parameters are included in the **MVISION.INI** file. Details of the External Link and associated files are described below. In addition, the external link program uses its own INI file (**TOPO2.INI**) to retain the current model parameters that appear in the link dialog boxes.
The external link parameters are supplied with ModelVision and should be installed automatically. If problems with the link arise, the **Update** option which is available from the External Link menu can be used to check or modify paths.

**An example External Link entry in MVISION.INI looks like:**

```
[LINK_TOPO2]
name=TOPO2
descr=Simple polygon data.
ext=ACO
format=MV-format
enquiry=
import=C:\Program Files\Encom\MVIS_Pro\LINKS\TOPO2.EXE
export=
type=model
```

**An example TOPO2.INI file is shown below:**

```
[FILES]
       datafile=C:\Program Files\Encom\MVIS_Pro\EXAMPLES\TOPO.ACO
       modelfile= C:\ProgramFiles\Encom\MVIS_Pro\EXAMPLES\IMPORT.TMP

[BACKGROUND]
baksusc=0.0
bakdens=2.67

[PROPERTIES]
bodysusc=0.0012
bodydens=2.77
remQ=0.0000
remazim=0.0
remdip=0.00

[GEOMETRY]
lenStrike=10000.0
plunge=0.00

[SCALING]
zoffset=10000.0
zfact=-1.0
xoffset=0.0
xfact=1.0

[COMPRESSION]
compressTol=500 (departure from a straight line required to keep a point)
step=1
reverse=0

[REGIONAL]
regbase=0.0
regslope=0.0
regcurv=0.0
```
In this section:

- **System Defaults (MVISION.INI)**
- **Project Defaults (MVPROJ.INI)**
- **Datums and Projections**
- **IGRF Settings**

### System Defaults (MVISION.INI)

A number of parameters are defined in a default file that is used by ModelVision whenever it is executed. The filename assumed by ModelVision is `MVISION.INI`. If, while ModelVision is being executed, changes are made to any of the default parameters, updated values of the items are written to the `MVISION.INI` file. The default file is an ASCII file that may be edited by the user to assign preferred defaults. The purpose of the `MVISION.INI` file is to provide logical control over a number of operational defaults when ModelVision is initially executed.

The defaults file must be called `MVISION.INI` to be recognized by ModelVision and must reside in the directory that contains the MVIS executable as defined by the Properties setup within MS-Windows.

If no default file is found, ModelVision uses defaults set within the program.

---

**Note**

An entry within the `MVISION.INI` file can specify the location for ModelVision projects. Separate project INI files contained within project directories are used to individually specify project parameters and default preferences. These files are called `MVPROJ.INI` and are described in **Project Defaults (MVPROJ.INI)**.

Parameters that can be set within the `MVISION.INI` file use a specific keyword followed by a parameter value. When reading and interpreting the file, text is divided into groups using square brackets. Keywords within each group tend to be obvious in their meaning. The contents of a keyword group are separated by a blank line. A list and description of the main groups follows:

**File Specification**

```ini
[PROJECTS]
Projectn Project pathing where n is an integer from 1 to 5.

[DIRECTORIES]
HelpDir Default directory of help files.
LUTDir Default Look-Up Table (palette) directory.
KernelDir Default directory containing filter kernel files.
```
UBCDir  Default directory for UBC executable programs. Note that both the executable programs and project (data) directories used within UBC-GIF projects cannot have blank spaces within the path names of the directories. This limitation is imposed by UBC to ensure compatibility with UNIX operating systems.

[LINKSOFTWARE]  Refer to the section on External Links for additional name, format and filenames of the program external links. Note that the word SOFTWARE is replaced by the link name e.g. for INTREPID the External Link entry would be LINK_INTREPID.

Name  External Link software name
e.g. INTREPID.

Descr  Description used by External Linkage.

Format  Preferred format to be used in External Link.

Enquiry  Enquiry program and path name.

Import  Import program and path name.

Export  Export program and path name.

Type  Data type supported in External Link.

[MAP]  Display attribute defaults associated with map displays. Axis and grid tick sizes in centimetres can be defaulted.

MajAxisAnnoSize  Major axis annotation text size.

MinAxisAnnoSize  Minor axis annotation text size.

MajAxisTicSize  Default major axis tick size length.

MinAxisTicSize  Default minor axis tick size length.

[MULTICHANDISP]  Display attribute defaults associated with multi-track displays. Axis and grid tick sizes in centimetres can be defaulted.

MajAxisAnnoSize  Default major axis annotation text size.

MinAxisAnnoSize  Default minor axis annotation text size.

MajAxisTicSize  Default major axis tick size length.

MinAxisTicSize  Default minor axis tick size length.

[PROFILE]  Display attribute defaults associated with X-section displays. Axis and grid tick sizes in centimetres can be defaulted.

MajAxisAnnoSize  Default major axis annotation text size.

MinAxisAnnoSize  Default minor axis annotation text size.

MajAxisTicSize  Default major axis tick size length.

MinAxisTicSize  Default minor axis tick size length.

[SPEED]  Display and assign a group of functions to the push buttons on the Speed toolbar.

AutoLoad  True or False settings control if the Speed toolbar is automatically displayed when ModelVision initially executes.

Position  The pixel row and column positions of the Speed toolbar when it is initially displayed.

B1 - B10  Assignment functions for up to 10 push buttons created by user.

[MISCELLANEOUS]  Used for airborne gravity gradiometer analysis.

AGGNotation  Coordinate definition for vector directions of gravity gradiometer.

Beep  Snap of polygon vertex confirmation

Snap  Pixel tolerance for vertex snapping.
Example

To further explain the layout and usage of the above keywords an example of a MVISION.INI file is shown below.

```
[PROJECTS]
Project1=C:\Program Files\Encom\MVis_Pro\examples
Project2=C:\Program Files\Encom\MVis_Pro\Myproj
Project3=C:\Program Files\Explor\geophys\Proj1
Project4=C:\Program Files\Explor\geophys\Proj2

[SPEED]
Autoload=TRUE
Position=779.99
B1=New layout
B2=Contour map
B3=Grid control

[DIRECTORIES]
HelpDir=C:\Program Files\Encom\MVis_Pro
LutDir=C:\Program Files\Encom\MVis_Pro\LUT
KernelDir=C:\Program Files\Encom\MVis_Pro\KERNEL

[MISCELLANEOUS]
AGGNotation=XYZ
Beep=Yes
Snap=5
BodyTableMode=0
BodyPropMode=2
AutoFlip=1
Volume=OFF
GroupVis=0
GroupActive=0

[COLOURS]
Default=VGA
Bodies=Rock-1
Multitrack=Automag
Modulation=Pseudocolor

[MAP]
MajAxisAnnoSize=0.30
MinAxisAnnoSize=0.30
MajAxisTicSize=0.25
MinAxisTicSize=0.10

[MULTICHANDISP]
MajAxisAnnoSize=0.30
MinAxisAnnoSize=0.20
MajAxisTicSize=0.30
MinAxisTicSize=0.15

[PROFILE]
MajAxisAnnoSize=0.25
MinAxisAnnoSize=0.18
MajAxisTicSize=0.25
MinAxisTicSize=0.15
```
Project Defaults (MVPROJ.INI)

ModelVision operates on individual projects where all project session files are stored in a specific folder (directory). The MVPROJ.INI stores project defaults, modelling and projection parameters. Although the ‘global’ defaults of ModelVision are kept in the MVVISION.INI file (see System Defaults (MVVISION.INI)), the details of a project are kept within files which reside in the individual project directories.

[PROJECT DESCRIPTION]
Specifies titles and creation date of the project

DateCreated
Creation date of project

DateModified
Modification date

Description
Text description

Name
Summary title of project

Author
Person creating project

[MODEL]
Relates to default settings associated with background values used in ModelVision

Parameters available under this keyword are:

Density
Model (not body) default background

Suscept
Model (not body) default background
Appendix D Defaults and Settings

MagUnits The magnetic system to be used by default in either the SI or cgs units system. Note that:
1 SI unit = 4* cgs units.

ComputeRemanence Set this parameter to compute remanence (YES) or if not required, set to NO

ComputeDemag Set this parameter to compute demagnetisation for bodies which support it (sphere and ellipsoid only)

[MAGNETICS] Default magnetic field parameters which define the inducing magnetic field. Total field strength, inclination and declination are defined

Intensity Default Earth's magnetic field strength (in nanoTeslas)
Inclination Default Earth's magnetic field inclination (in degrees)
Declination Default Earth's magnetic field Declination (in degrees)
Orientation Default for the Local grid north (in degrees). In cases where True (Geographic) North is used as the data and model reference, this value is set to 0.0. In instances where the data and modelling use a north direction which is at an angle to True North, this angle needs to be specified. The Orientation angle is used in combination with the Declination to ensure the correct magnetic response is calculated.

[BODY DEFAULTS] Default magnetic and gravity body properties are defined. These defaults provide body property values for magnetic susceptibility, specific gravity (density) and remanence.

Density Default body density
Suscept Default body magnetic susceptibility
RemanenceRatio Default body Koenigsberger Ratio (Q value)
RemanenceMag Default body magnetisation field strength
RemanenceAzim Default body remanence vector azimuth in degrees relative to True North
RemanenceDip Default body remanence vector inclination (in degrees)

[AUTOMAG] Defaults specific to the AutoMag interpretation module are defined by this keyword group

DipMin Minimum dip angle which can be computed by AutoMag for model solutions
DipMax Maximum dip angle which can be computed by AutoMag for model solutions
ThicknessMin Minimum body thickness which can be computed by AutoMag for model solutions
ThicknessMax Maximum body thickness which can be computed by AutoMag for model solutions
SuscsMin Minimum body magnetic susceptibility which can be computed by AutoMag for model solutions
SuscsMax Maximum body magnetic susceptibility which can be computed by AutoMag for model solutions
SuscsConst Default magnetic susceptibility which is adopted initially for AutoMag body solutions
StrikeLength Default body strike length to be adopted by AutoMag models
LevelMin Threshold minimum for AutoMag
LevelMax Threshold maximum for AutoMag

[PROJECTION] Default spheroid and projection parameters to be used by exported ER Mapper grid output by ModelVision
Datum

Datum as defined in the ER Mapper Reference Manual e.g. AGD66

Projection

Projection as defined in the ER Mapper Reference Manual e.g. TMAMG56

ProjDescr

Description of the specified projection for the project

[MISCELLANEOUS]

Specification of toolbox or button display

Toolbar

Toolbar or button setting

Example

[PROJECT_DESCRIPTION]
DateCreated=05/05/99
DateModified=05/05/99
Description=Default project example
Name=Default example
Author=PRG

[MODEL]
Density=2.6700
Suscept=0.0000
MagUnits=SI
GravUnits=none
ComputeRemanence=FALSE
ComputeDemag=FALSE

[MAGNETICS]
Intensity=60000.00
Inclination=-60.00
Orientation=0.00
Declination=0.00

[BODY_DEFAULTS]
Suscept=0.0100
Density=2.7700
RemanenceRatio=0.0000
RemanenceMag=0.0000
RemanenceAzim=0.0000
RemanenceDip=0.0000

[AUTOMAG]
DipMin=45.0
DipMax=135.0
ThicknessMin=100.0
ThicknessMax=10000.0
SuscMin=0.0001
SuscMax=0.0100
LevelMin=0
LevelMax=25
SuscConst=0.0010
StrikeLength=1000

[PROJECTION]
Projection=TM36
Datum=AGD84
ProjDescr=Australian Map Grid
Datums and Projections

ModelVision requires you to organize your work into project directories. When you create a new project using the File>New>Project menu item, a project definition file (MVPROJ.INI) is created in a pre-existing directory. Information specific to the project is stored in the file and updated whenever you exit ModelVision. One of the components of the Project relate to the specification of projections and datums. Although not used internally by ModelVision, the program supports a wide range of these and can use them for export of grids and other data to external systems such as ER Mapper.

The datum and projection information for ModelVision is stored in two files, DATUM.DAT and PROJECTION.DAT. The format of these files is ASCII and they contain all the necessary information to define a wide range of spheroids and projections with curvature, zone and ellipticity details.

ModelVision has used ER Mapper compatible files to build a database of Map Projection information that supports various projections in use across the globe. To fully specify a Map Projection, both the DATUM and the PROJECTION for the map must be specified. The following description of Datums, Spheroids and Projections has been derived from documentation made available by ER Mapper (a product of Earth Resource Mapping, Perth, Australia).

Grid data that has the same Map Projection (in other words the same Datum and Projection) can be automatically registered by ModelVision, regardless of the grid cell resolution or data format.

To assist you in choosing which Datum and Projections to use, there are a number of on-line help files which list commonly used Map Projections and the Datum and Projection to use for each map projection.

Each on-line help file has the following columns:

<table>
<thead>
<tr>
<th>NAME</th>
<th>PROJ.TYPE</th>
<th>PROJECTION</th>
<th>DATUM</th>
</tr>
</thead>
<tbody>
<tr>
<td>CALIF VII</td>
<td>lambert2</td>
<td>LM2CAL7F</td>
<td>NAD27</td>
</tr>
<tr>
<td>AMG, Zone 54</td>
<td>transmerc</td>
<td>TMAMG54</td>
<td>AGD66</td>
</tr>
</tbody>
</table>

NAME is the name of the map projection you may be familiar with, for example Australian Map Grid (AMG) or CALIF VII. This name is provided for convenience only as the full Datum and Projection name must be specified to identify the map. PROJECTION TYPE is the type of map projection such as lambert or transmerc.

PROJECTION is the map projection used for this map, for example TMAMG54 for the Zone 54 AMG Transverse Mercator projection or LM2CAL7F for the California State Plane 7. The Projection is used in image header files, in dynamic links and in rectifying images.

DATUM is the map datum used for this map, for example AGD66 or NAD27. The Datum is used in image header files, in dynamic links and in rectifying images.

For more information, see:

- Supported Map Projections and Datums
Supported Map Projections and Datums

ModelVision supports a large number of projections and spheroids. These are listed in the following pages in the following sections:

- **Universal Transverse Mercator Zone Locations**
- **USA Map Projections**
- **Australian Map Projections**
- **Projections File (PROJECT.DAT)**
- **Spheroids**

### Universal Transverse Mercator Zone Locations

The UTM Zone Locations and Central Meridians are listed below. Courtesy of the United States Geological Survey.

<table>
<thead>
<tr>
<th>Zone</th>
<th>C.M.</th>
<th>Range</th>
<th>Zone</th>
<th>C.M.</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>177W</td>
<td>171W</td>
<td>165W</td>
<td>159W</td>
<td>153W</td>
<td>147W</td>
</tr>
<tr>
<td>135W</td>
<td>129W</td>
<td>123W</td>
<td>117W</td>
<td>111W</td>
<td>105W</td>
</tr>
<tr>
<td>093W</td>
<td>087W</td>
<td>081W</td>
<td>075W</td>
<td>069W</td>
<td>063W</td>
</tr>
<tr>
<td>051W</td>
<td>045W</td>
<td>039W</td>
<td>033W</td>
<td>027W</td>
<td>021W</td>
</tr>
<tr>
<td>009W</td>
<td>003W</td>
<td>180W</td>
<td>-174W</td>
<td>174W</td>
<td>-168W</td>
</tr>
<tr>
<td>162W</td>
<td>162W</td>
<td>-156W</td>
<td>156W</td>
<td>-150W</td>
<td>150W</td>
</tr>
</tbody>
</table>
UTM zone numbers in the Southern Hemisphere are indicated by a negative sign before the zone number.

Example: Zone -17 has a central meridian of 81°W and a false northing (Y) of 10,000,000 meters at the Equator.

**USA Map Projections**

The United States of America use a system of map projections for various regions. This system is known as the 'State Plane Coordinate System (SPCS)'. The majority of these projections are Transverse Mercator projections, used for States with predominantly north to south extent. Some of these are broken down into a number of zones within the State. The Lambert Conformal Conic projection is used for most other States, with the exception of the panhandle of Alaska, which is mapped using the Oblique Mercator projection.

Older maps are projected onto the Clarke 1866 spheroid with tie point at Meade's Ranch in Kansas (datum NAD27). More recent maps are projected onto the 1983 datum (datum NAD83).

A list of currently supported projections appears below.

<table>
<thead>
<tr>
<th>Name</th>
<th>Projection</th>
<th>Type</th>
<th>Projection Datum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama East</td>
<td>tranmerc</td>
<td>TMALABEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alabama West</td>
<td>tranmerc</td>
<td>TMALABWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 1</td>
<td>obmerc_b</td>
<td>OMALSK1M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 2</td>
<td>tranmerc</td>
<td>TMALSK2M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 3</td>
<td>tranmerc</td>
<td>TMALSK3M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Name</td>
<td>Projection</td>
<td>Type</td>
<td>Projection Datum</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Alaska State Plane 4</td>
<td>tranmerc</td>
<td>TMALSK4M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 5</td>
<td>tranmerc</td>
<td>TMALSK5M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 6</td>
<td>tranmerc</td>
<td>TMALSK6M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 7</td>
<td>tranmerc</td>
<td>TMALSK7M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 8</td>
<td>tranmerc</td>
<td>TMALSK8M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Alaska State Plane 9</td>
<td>tranmerc</td>
<td>TMALSK9M</td>
<td>NAD27</td>
</tr>
<tr>
<td>Arizona East</td>
<td>tranmerc</td>
<td>TMARIZEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Arizona Central</td>
<td>tranmerc</td>
<td>TMARIZCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Arizona West</td>
<td>tranmerc</td>
<td>TMARIZWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Arkansas North</td>
<td>lambert2</td>
<td>LM2ARKNM</td>
<td>NAD27</td>
</tr>
<tr>
<td>Arkansas South</td>
<td>lambert2</td>
<td>LM2ARKSM</td>
<td>NAD27</td>
</tr>
<tr>
<td>California I</td>
<td>lambert2</td>
<td>LM2CAL1F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California II</td>
<td>lambert2</td>
<td>LM2CAL2F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California III</td>
<td>lambert2</td>
<td>LM2CAL3F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California IV</td>
<td>lambert2</td>
<td>LM2CAL4F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California V</td>
<td>lambert2</td>
<td>LM2CAL5F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California VI</td>
<td>lambert2</td>
<td>LM2CAL6F</td>
<td>NAD27</td>
</tr>
<tr>
<td>California VII</td>
<td>lambert2</td>
<td>LM2CAL7F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Colorado North</td>
<td>lambert2</td>
<td>LM2COLNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Colorado Central</td>
<td>lambert2</td>
<td>LM2COLCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Colorado South</td>
<td>lambert2</td>
<td>LM2COLSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Connecticut State</td>
<td>lambert2</td>
<td>LM2CONN</td>
<td>NAD27</td>
</tr>
<tr>
<td>Delaware State</td>
<td>tranmerc</td>
<td>TMDELWRF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Florida North</td>
<td>lambert2</td>
<td>LM2FLANF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Florida East</td>
<td>tranmerc</td>
<td>TMFLRAEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Florida West</td>
<td>tranmerc</td>
<td>TMFLRAWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Georgia East</td>
<td>tranmerc</td>
<td>TMGEOREF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Georgia West</td>
<td>tranmerc</td>
<td>TMGEORWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Hawaii State Plane 1</td>
<td>tranmerc</td>
<td>TMHAW1F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Hawaii State Plane 2</td>
<td>tranmerc</td>
<td>TMHAW2F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Hawaii State Plane 3</td>
<td>tranmerc</td>
<td>TMHAW3F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Hawaii State Plane 4</td>
<td>tranmerc</td>
<td>TMHAW4F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Hawaii State Plane 5</td>
<td>tranmerc</td>
<td>TMHAW5F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Idaho East</td>
<td>tranmerc</td>
<td>TMIDAETF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Idaho Central</td>
<td>tranmerc</td>
<td>TMIDACFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Idaho West</td>
<td>tranmerc</td>
<td>TMIDAWFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Illinois East</td>
<td>tranmerc</td>
<td>TMILLEFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Illinois West</td>
<td>tranmerc</td>
<td>TMILLWFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Indiana East</td>
<td>tranmerc</td>
<td>TMINDEFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Indiana West</td>
<td>tranmerc</td>
<td>TMINDWFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Iowa North</td>
<td>lambert2</td>
<td>LM2IOWNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Iowa South</td>
<td>lambert2</td>
<td>LM2IOWSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Kansas North (NAD27)</td>
<td>lambert2</td>
<td>LM2KANNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Kansas North (NAD83)</td>
<td>lambert2</td>
<td>LM2KANNM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Kentucky North</td>
<td>lambert2</td>
<td>LM2KYNFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Name</td>
<td>Projection</td>
<td>Type</td>
<td>Projection Datum</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Kentucky South</td>
<td>lambert2</td>
<td>LM2KYSFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Louisiana North</td>
<td>lambert2</td>
<td>LM2LANFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Louisiana North</td>
<td>lambert2</td>
<td>LM2LANM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Louisiana South</td>
<td>lambert2</td>
<td>LM2LASFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Louisiana South</td>
<td>lambert2</td>
<td>LM2LASM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Louisiana Offshore</td>
<td>lambert2</td>
<td>LM2LAOFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Maine East</td>
<td>tranmerc</td>
<td>TMMAINEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Maine West</td>
<td>tranmerc</td>
<td>TMMAINWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Maryland State</td>
<td>lambert2</td>
<td>LM2MARYF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Massachusetts Mainland</td>
<td>lambert2</td>
<td>LM2MASMF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Massachusetts Island</td>
<td>lambert2</td>
<td>LM2MASIF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Michigan East (old)</td>
<td>tranmerc</td>
<td>TMMICHCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Michigan West (old)</td>
<td>tranmerc</td>
<td>TMMICHWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Michigan North (current)</td>
<td>lambert2</td>
<td>LM2MICNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Michigan Cent (current)</td>
<td>lambert2</td>
<td>LM2MICCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Michigan Sth (current)</td>
<td>lambert2</td>
<td>LM2MICSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Minnesota North</td>
<td>lambert2</td>
<td>LM2MINNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Minnesota Central</td>
<td>lambert2</td>
<td>LM2MINCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Minnesota South</td>
<td>lambert2</td>
<td>LM2MINSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Mississippi East</td>
<td>tranmerc</td>
<td>TMMISSSEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Mississippi East</td>
<td>tranmerc</td>
<td>TMMISSEM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Mississippi West</td>
<td>tranmerc</td>
<td>TMMISSSWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Mississippi West</td>
<td>tranmerc</td>
<td>TMMISSWM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Missouri East</td>
<td>tranmerc</td>
<td>TMMISOEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Missouri Central</td>
<td>tranmerc</td>
<td>TMMISOFC</td>
<td>NAD27</td>
</tr>
<tr>
<td>Missouri West</td>
<td>tranmerc</td>
<td>TMMISOWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Montana North</td>
<td>lambert2</td>
<td>LM2MTNFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Montana Central</td>
<td>lambert2</td>
<td>LM2MTCFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Montana South</td>
<td>lambert2</td>
<td>LM2MTSFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nebraska North</td>
<td>lambert2</td>
<td>LM2NEBNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nebraska South</td>
<td>lambert2</td>
<td>LM2NEBSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nevada East (NAD27)</td>
<td>tranmerc</td>
<td>TMNEVAEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nevada East (NAD83)</td>
<td>tranmerc</td>
<td>TMNEVAFM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Nevada Central (NAD27)</td>
<td>tranmerc</td>
<td>TMNEVACF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nevada Central (NAD83)</td>
<td>tranmerc</td>
<td>TMNEVACM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Nevada West (NAD27)</td>
<td>tranmerc</td>
<td>TMNEVAWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Nevada West (NAD83)</td>
<td>tranmerc</td>
<td>TMNEVAWM</td>
<td>NAD83</td>
</tr>
<tr>
<td>New Hampshire</td>
<td>tranmerc</td>
<td>TMNEWHFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>New Jersey</td>
<td>tranmerc</td>
<td>TMNEWJFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>New Mexico East</td>
<td>tranmerc</td>
<td>TMNEWMEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>New Mexico Central</td>
<td>tranmerc</td>
<td>TMNEWMCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>New Mexico West</td>
<td>tranmerc</td>
<td>TMNEWMMWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>New York State East</td>
<td>tranmerc</td>
<td>TMNEWYEF</td>
<td>NAD27</td>
</tr>
<tr>
<td>New York State Central</td>
<td>tranmerc</td>
<td>TMNEWYCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Name</td>
<td>Projection</td>
<td>Type</td>
<td>Projection Datum</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>New York State West</td>
<td>tranmerc</td>
<td>TMNEWYWF</td>
<td>NAD27</td>
</tr>
<tr>
<td>New York Long Island</td>
<td>lambert2</td>
<td>LM2NEWYF</td>
<td>NAD27</td>
</tr>
<tr>
<td>North Carolina</td>
<td>lambert2</td>
<td>LM2NCAFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>North Dakota North</td>
<td>lambert2</td>
<td>LM2NDNFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>North Dakota South</td>
<td>lambert2</td>
<td>LM2NDSFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Ohio North</td>
<td>lambert2</td>
<td>LM2OHINF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Ohio South</td>
<td>lambert2</td>
<td>LM2OHISF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Oklahoma North</td>
<td>lambert2</td>
<td>LM2OKLNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Oklahoma South</td>
<td>lambert2</td>
<td>LM2OKLSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Oregon North</td>
<td>lambert2</td>
<td>LM2ORENF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Oregon South</td>
<td>lambert2</td>
<td>LM2ORESF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Pennsylvania North</td>
<td>lambert2</td>
<td>LM2PANFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Pennsylvania South</td>
<td>lambert2</td>
<td>LM2PANST</td>
<td>NAD27</td>
</tr>
<tr>
<td>Puerto Rico</td>
<td>lambert2</td>
<td>LM2PRV1F</td>
<td>NAD27</td>
</tr>
<tr>
<td>Rhode Island</td>
<td>tranmerc</td>
<td>TMRHODIF</td>
<td>NAD27</td>
</tr>
<tr>
<td>South Carolina North</td>
<td>lambert2</td>
<td>LM2SCNFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>South Carolina South</td>
<td>lambert2</td>
<td>LM2SCSFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>South Dakota North</td>
<td>lambert2</td>
<td>LM2SDNFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>South Dakota South</td>
<td>lambert2</td>
<td>LM2SDSFT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Tennessee</td>
<td>lambert2</td>
<td>LM2TENNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas North (NAD27)</td>
<td>lambert2</td>
<td>LM2TXNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas North Central</td>
<td>lambert2</td>
<td>LM2TXNCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas North Central</td>
<td>lambert2</td>
<td>LM2TXNCFM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Texas Central (NAD27)</td>
<td>lambert2</td>
<td>LM2TXCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas Central (NAD83)</td>
<td>lambert2</td>
<td>LM2TXCM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Texas South Central</td>
<td>lambert2</td>
<td>LM2TXSCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas South Central</td>
<td>lambert2</td>
<td>LM2TXSCM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Texas South (NAD27)</td>
<td>lambert2</td>
<td>LM2TXSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Texas South (NAD83)</td>
<td>lambert2</td>
<td>LM2TXSM</td>
<td>NAD83</td>
</tr>
<tr>
<td>Utah North</td>
<td>lambert2</td>
<td>LM2UTHNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Utah Central</td>
<td>lambert2</td>
<td>LM2UTHCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Utah South</td>
<td>lambert2</td>
<td>LM2UTHSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Vermont</td>
<td>tranmerc</td>
<td>TMVERMTF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Virginia North</td>
<td>lambert2</td>
<td>LM2VIRNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Virginia South</td>
<td>lambert2</td>
<td>LM2VIRSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Washington North</td>
<td>lambert2</td>
<td>LM2WSHNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Washington South</td>
<td>lambert2</td>
<td>LM2WSHSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>West Virginia North</td>
<td>lambert2</td>
<td>LM2WVANF</td>
<td>NAD27</td>
</tr>
<tr>
<td>West Virginia South</td>
<td>lambert2</td>
<td>LM2WVASF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wisconsin North</td>
<td>lambert2</td>
<td>LM2WISNF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wisconsin Central</td>
<td>lambert2</td>
<td>LM2WISCF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wisconsin South</td>
<td>lambert2</td>
<td>LM2WISSF</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wyoming East</td>
<td>tranmerc</td>
<td>TMWYO1FT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wyoming East Central</td>
<td>tranmerc</td>
<td>TMWYO2FT</td>
<td>NAD27</td>
</tr>
<tr>
<td>Wyoming West Central</td>
<td>tranmerc</td>
<td>TMWYO3FT</td>
<td>NAD27</td>
</tr>
</tbody>
</table>
Commonly Used USA Datums

The following table shows some commonly used USA projection/datum combinations, with units being in feet or meters.

<table>
<thead>
<tr>
<th>Case</th>
<th>Datum / Projection</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAD27 with State Plane</td>
<td>NAD27AFT / &quot;F&quot; version projections in foot-based projection lamber2 or tranmerc</td>
</tr>
<tr>
<td>NAD27 with State Plane</td>
<td>NAD27 or NAD27MTR / &quot;M&quot; meter-based projection version projections in lamber2 or tranmerc</td>
</tr>
<tr>
<td>NAD83 with State Plane</td>
<td>NAD83 / Projections in lamber2 or foot-based projection projections in tranmerc with &quot;F83&quot; in the name. NAD27 or NAD27MTR &quot;M&quot;</td>
</tr>
<tr>
<td>NAD83 with State Plane</td>
<td>NAD83 / &quot;M&quot; version projections in tranmerc meter-based projection</td>
</tr>
<tr>
<td>NAD27 with UTM</td>
<td>NAD27AFT or TMAFT15, 16 and 17 foot-based projection projections in tranmerc</td>
</tr>
<tr>
<td>NAD27MOD</td>
<td>NUTMxx projections in UTM NAD27 with UTM meter-based projection NAD27 or NAD27MTR NUTMxx projections in UTM</td>
</tr>
<tr>
<td>NAD83 with UTM</td>
<td>NAD83 / NUTMxx projections in UTM foot-based projection</td>
</tr>
<tr>
<td>NAD83 with UTM</td>
<td>NAD83 / NUTMxx projections in UTM meter-based projection</td>
</tr>
</tbody>
</table>

**Note**
The use of NAD* datums is not restricted to the above set of projections. There are other valid combinations (e.g. other projection types like albers equal area etc).

**Australian Map Projections**

Australia mainly uses the AMG (Australian Map Grid) and the MGA (Map Grid of Australia that are projected onto Transverse Mercator projections for each zone.

<table>
<thead>
<tr>
<th>Map</th>
<th>Projection</th>
<th>Datum</th>
<th>Projection, Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMG48</td>
<td>AGD66</td>
<td>TMAMG48</td>
<td>Australian Map Grid, Zone 48</td>
</tr>
<tr>
<td>AMG49</td>
<td>AGD66</td>
<td>TMAMG49</td>
<td>Australian Map Grid, Zone 49</td>
</tr>
<tr>
<td>AMG50</td>
<td>AGD66</td>
<td>TMAMG50</td>
<td>Australian Map Grid, Zone 50</td>
</tr>
<tr>
<td>AMG51</td>
<td>AGD66</td>
<td>TMAMG51</td>
<td>Australian Map Grid, Zone 51</td>
</tr>
<tr>
<td>AMG52</td>
<td>AGD66</td>
<td>TMAMG52</td>
<td>Australian Map Grid, Zone 52</td>
</tr>
<tr>
<td>AMG53</td>
<td>AGD66</td>
<td>TMAMG53</td>
<td>Australian Map Grid, Zone 53</td>
</tr>
<tr>
<td>AMG54</td>
<td>AGD66</td>
<td>TMAMG54</td>
<td>Australian Map Grid, Zone 54</td>
</tr>
<tr>
<td>AMG55</td>
<td>AGD66</td>
<td>TMAMG55</td>
<td>Australian Map Grid, Zone 55</td>
</tr>
<tr>
<td>AMG56</td>
<td>AGD66</td>
<td>TMAMG56</td>
<td>Australian Map Grid, Zone 56</td>
</tr>
<tr>
<td>AMG57</td>
<td>AGD66</td>
<td>TMAMG57</td>
<td>Australian Map Grid, Zone 57</td>
</tr>
<tr>
<td>AMG58</td>
<td>AGD66</td>
<td>TMAMG58</td>
<td>Australian Map Grid, Zone 58</td>
</tr>
<tr>
<td>MGA48</td>
<td>GDA94</td>
<td>MGA48</td>
<td>Map Grid of Australia, Zone 48</td>
</tr>
<tr>
<td>MGA49</td>
<td>GDA94</td>
<td>MGA49</td>
<td>Map Grid of Australia, Zone 49</td>
</tr>
<tr>
<td>MGA50</td>
<td>GDA94</td>
<td>MGA50</td>
<td>Map Grid of Australia, Zone 50</td>
</tr>
</tbody>
</table>
ModelVision supports the following spheroids:

Airy 1830 (AIRY)
Airy Modified 1849 (AIRYMOD)
Australian National (ANS)
Bessel 1841 (BESS1841)
Bessel Modified (BESSMOD)
Clarke 1858 (CLA58MTR)
Clarke 1866 (CLA66MTR) (CLA66MOD) (CLA66AFT)
Clarke 1880 (CLA80RSA) (CLA80IFT) (CLA80BEN)
Clarke 1880 (IGN) (CLA80IGN)
Clarke Modified 1880 (CLA80MOD)
Everest (1937) (EV37ADJ)
Everest (1967) (EVERST67)
G.R.S. 1967 (GRS67)
G.R.S. 1980 (GRS80)
Hayford 1910 (HAYF1910)
Helmert 1906 (HELM1906)
International 1924 (INT24)
International 1967 (INT67)
Krassowsky 1940 (KRAS1940)
NWL10D
NWL9D
ModelVision has approximately 700 projections available. These are listed in the file PROJECT.DAT. For each projection, the file gives the projection name and projection type, the units of length and angle measurements, a description of the projection, the date it was added to the database, and details of the source of the projection. The list is likely to be updated from time to time.

<table>
<thead>
<tr>
<th>Projection</th>
<th>Description</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPHERE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WGS 84</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projections File (PROJECT.DAT)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>albersea</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALALASKA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALCIAL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALGEMEXICAL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MENAAL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>azimated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AEAFRICA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>biococco</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BCSHIRE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>borneo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BORNEOMT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>cassini</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAISREAL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAQATMOD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAVANUA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>coniced</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CEAUST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CECASPAN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CERUSS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>dutch</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DUTCHNEW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>griten</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VG120E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VG30E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VG90EAST</td>
<td></td>
<td></td>
</tr>
<tr>
<td>labordom</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LABORDE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lambazea</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEEON16E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEAMERIC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEMONG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEUSAO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>lambert1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1ADEN</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1BLSEA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1AFNDX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1BURMA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1ALGND</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1ALGSD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1BANG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1CARIB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1CAUC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LM1COLC</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Code</td>
<td>Code</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>LM2SDNFT</td>
<td>LM2SDSFT</td>
<td>LM2SEYCH</td>
</tr>
<tr>
<td>LM2TAIW</td>
<td>LM2TARIM</td>
<td>LM2TENNFF</td>
</tr>
<tr>
<td>LM2TURKG</td>
<td>LM2TURKY</td>
<td>LM2TXCF</td>
</tr>
<tr>
<td>LM2TXNMC</td>
<td>LM2TXNF</td>
<td>LM2TXSCF</td>
</tr>
<tr>
<td>LM2TXSM</td>
<td>LM2UKMN</td>
<td>LM2USSR</td>
</tr>
<tr>
<td>LM2UTHNFO</td>
<td>LM2UTHSF</td>
<td>LM2VEN</td>
</tr>
<tr>
<td>LM2VENPC</td>
<td>LM2VIET</td>
<td>LM2VIRNF</td>
</tr>
<tr>
<td>LM2WISNF</td>
<td>LM2WISSF</td>
<td>LM2WSHNF</td>
</tr>
<tr>
<td>LM2WVASF</td>
<td>local</td>
<td>LOCAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MR1630N</td>
<td>MR21N</td>
<td>MR36N</td>
</tr>
<tr>
<td>MR65N</td>
<td>MR7S</td>
<td>MRAFRICA</td>
</tr>
<tr>
<td>MRCAMER</td>
<td>MRCARIB</td>
<td>MRCONGO</td>
</tr>
<tr>
<td>MRINDO</td>
<td>MRINDON</td>
<td>MRMALAY</td>
</tr>
<tr>
<td>MRNEWFND</td>
<td>MRNSEA</td>
<td>MRNLWR10D</td>
</tr>
<tr>
<td>MRWORLD</td>
<td>MRWORLD1</td>
<td>MRWORLD2</td>
</tr>
<tr>
<td>modpol</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MRCALIF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>modstero</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MSAFRICA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>nzmapgrd</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NZMG</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mollweid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>MW180E</td>
<td>MW90EAST</td>
<td>MW90WEST</td>
</tr>
<tr>
<td>obmerc_b</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OMALSK1F</td>
<td>OMALSK1M</td>
<td></td>
</tr>
<tr>
<td>orthog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OG45N45E</td>
<td>OG55N80E</td>
<td>OGEQU90W</td>
</tr>
<tr>
<td>orthog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OG45N45E</td>
<td>OG55N80E</td>
<td>OGEQU90W</td>
</tr>
<tr>
<td>orthog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCALASKA</td>
<td>PCALBERT</td>
<td>PCNSLOPE</td>
</tr>
<tr>
<td>PCWORLD</td>
<td></td>
<td></td>
</tr>
<tr>
<td>regpol</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RPMON</td>
<td>RPNAM</td>
<td>RPSIB</td>
</tr>
<tr>
<td>robinson</td>
<td></td>
<td></td>
</tr>
<tr>
<td>R090E</td>
<td>R090W</td>
<td>ROBINSON</td>
</tr>
<tr>
<td>sinusoid</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SNSPHERE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>stereo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OSAexA</td>
<td>OSNAMER</td>
<td>OSSYRIA</td>
</tr>
<tr>
<td>PSCREEN</td>
<td>PSN150W</td>
<td>PSNORTH</td>
</tr>
<tr>
<td>PSNTH045</td>
<td>PSNTH180</td>
<td>PSSOUTH</td>
</tr>
<tr>
<td>stm</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STMLO11</td>
<td>STMLO21</td>
<td>STMLO27F</td>
</tr>
<tr>
<td>STMLO23</td>
<td>STMLO29</td>
<td>STMLO39</td>
</tr>
<tr>
<td>TMNSEA</td>
<td>TMNYEMEN</td>
<td>TMNZNI</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>TMOMAN</td>
<td>TMOSGB</td>
<td>TMOSIRL</td>
</tr>
<tr>
<td>TMPARAG3</td>
<td>TMPARAG4</td>
<td>TUPERUBE</td>
</tr>
<tr>
<td>TEMPERUW</td>
<td>TMPHI1</td>
<td>TMPHI2</td>
</tr>
<tr>
<td>TMPHI5</td>
<td>TMPORT</td>
<td>TPORTL</td>
</tr>
<tr>
<td>TMRHODIM</td>
<td>TMS114E</td>
<td>TMS116E</td>
</tr>
<tr>
<td>TMSHABWA</td>
<td>TMSHK167</td>
<td>TMSLCNS</td>
</tr>
<tr>
<td>TMSUDAN</td>
<td>TMSURNAM</td>
<td>TMSVIET</td>
</tr>
<tr>
<td>TMTRUCST</td>
<td>TMTUNIS</td>
<td>TMTURK</td>
</tr>
<tr>
<td>TMUNZ170</td>
<td>TMVERMTF</td>
<td>TMVICMAP</td>
</tr>
<tr>
<td>TMWYO3FT</td>
<td>TMWYO4FT</td>
<td>TMWYOECM</td>
</tr>
<tr>
<td>TMYEMEN</td>
<td>TMYUG5</td>
<td>TMYUG5S</td>
</tr>
<tr>
<td>TMYUG7</td>
<td>TMYUG7SF</td>
<td></td>
</tr>
<tr>
<td>utm</td>
<td>NUTM01</td>
<td>NUTM02</td>
</tr>
<tr>
<td></td>
<td>NUTM05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM06</td>
<td>NUTM07</td>
</tr>
<tr>
<td></td>
<td>NUTM10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM11</td>
<td>NUTM12</td>
</tr>
<tr>
<td></td>
<td>NUTM15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM16</td>
<td>NUTM17</td>
</tr>
<tr>
<td></td>
<td>NUTM20</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM21</td>
<td>NUTM22</td>
</tr>
<tr>
<td></td>
<td>NUTM25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM26</td>
<td>NUTM27</td>
</tr>
<tr>
<td></td>
<td>NUTM30</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM31</td>
<td>NUTM32</td>
</tr>
<tr>
<td></td>
<td>NUTM35</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM36</td>
<td>NUTM37</td>
</tr>
<tr>
<td></td>
<td>NUTM40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM41</td>
<td>NUTM42</td>
</tr>
<tr>
<td></td>
<td>NUTM45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM46</td>
<td>NUTM47</td>
</tr>
<tr>
<td></td>
<td>NUTM50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM51</td>
<td>NUTM52</td>
</tr>
<tr>
<td></td>
<td>NUTM55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NUTM56</td>
<td>NUTM57</td>
</tr>
<tr>
<td></td>
<td>NUTM60</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM01</td>
<td>SUTM02</td>
</tr>
<tr>
<td></td>
<td>SUTM05</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM06</td>
<td>SUTM07</td>
</tr>
<tr>
<td></td>
<td>SUTM10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM11</td>
<td>SUTM12</td>
</tr>
<tr>
<td></td>
<td>SUTM15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM16</td>
<td>SUTM17</td>
</tr>
<tr>
<td></td>
<td>SUTM20</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM21</td>
<td>SUTM22</td>
</tr>
<tr>
<td></td>
<td>SUTM25</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM26</td>
<td>SUTM27</td>
</tr>
<tr>
<td></td>
<td>SUTM30</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM31</td>
<td>SUTM32</td>
</tr>
<tr>
<td></td>
<td>SUTM35</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM36</td>
<td>SUTM37</td>
</tr>
<tr>
<td></td>
<td>SUTM40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM41</td>
<td>SUTM42</td>
</tr>
<tr>
<td></td>
<td>SUTM45</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM46</td>
<td>SUTM47</td>
</tr>
<tr>
<td></td>
<td>SUTM50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM51</td>
<td>SUTM52</td>
</tr>
<tr>
<td></td>
<td>SUTM55</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUTM56</td>
<td>SUTM57</td>
</tr>
<tr>
<td></td>
<td>SUTM60</td>
<td></td>
</tr>
</tbody>
</table>

The NUTMFxx projections are feet based equivalent projections to be used with feet based datums (e.g. NAD27MOD).
**Datum File (DATUM.DAT)**

The datum information is stored in file DATUM.DAT. The file lists every datum supported by ModelVision with information such as the coordinates of the tie point, the prime meridian, a short description and the source of the datum. The datums, with their spheroids and tie points are listed below.

<table>
<thead>
<tr>
<th>Datum</th>
<th>Spheroid</th>
<th>Tie Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACCRA:</td>
<td>WAROFFFT</td>
<td>G.C.S. Station 547</td>
</tr>
<tr>
<td>ADINDAN:</td>
<td>CLA80MOD</td>
<td>STA.15 Adindan</td>
</tr>
<tr>
<td>AGD66:</td>
<td>ANS</td>
<td>Johnson Memorial</td>
</tr>
<tr>
<td>AGD84:</td>
<td>ANS</td>
<td>Johnson Memorial</td>
</tr>
<tr>
<td>AINABD70:</td>
<td>INT24</td>
<td>AIN EL ABD</td>
</tr>
<tr>
<td>ARATU:</td>
<td>INT24</td>
<td>not specified</td>
</tr>
<tr>
<td>ARC1950:</td>
<td>CLA80RSA</td>
<td>BUFFELSFORTEIN</td>
</tr>
<tr>
<td>ARC1960:</td>
<td>CLA80MOD</td>
<td>BUFFELSFORTEIN</td>
</tr>
<tr>
<td>BAHRAIN:</td>
<td>INT24</td>
<td>JEBEL DUKHAN</td>
</tr>
<tr>
<td>BATAVIA:</td>
<td>BESS1841</td>
<td>BATAVIA ASTRO STN</td>
</tr>
<tr>
<td>BEDUARAM:</td>
<td>CLA80IGN</td>
<td>not specified</td>
</tr>
<tr>
<td>BEIJING:</td>
<td>KRAS1940</td>
<td>not specified</td>
</tr>
<tr>
<td>BELG50:</td>
<td>INT24</td>
<td>not specified</td>
</tr>
<tr>
<td>BERNNEW:</td>
<td>BESS1841</td>
<td>Bern Observatory</td>
</tr>
<tr>
<td>BOGOTA:</td>
<td>INT24</td>
<td>Bogota Observatory</td>
</tr>
<tr>
<td>CAMACUPA:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>CAPE:</td>
<td>CLA80MOD</td>
<td>BURENKAMP</td>
</tr>
<tr>
<td>CARTHAGE:</td>
<td>CLA80IGN</td>
<td>not specified</td>
</tr>
<tr>
<td>CHUA:</td>
<td>INT24</td>
<td>CHUA</td>
</tr>
<tr>
<td>CLARK1866:</td>
<td>CLARK66MTR</td>
<td>MEADE'S RANCH</td>
</tr>
<tr>
<td>CMPOINC:</td>
<td>INT24</td>
<td>CAMPO INCHAUSTE</td>
</tr>
<tr>
<td>CORRALEG:</td>
<td>INT24</td>
<td>CORREGO ALEGRE</td>
</tr>
<tr>
<td>DEIR:</td>
<td>CLA80IGN</td>
<td>TRIG 254 AT DEIR</td>
</tr>
<tr>
<td>ED50:</td>
<td>INT24</td>
<td>POTSDAM(HELMERT TWR)</td>
</tr>
<tr>
<td>ED50EGYT:</td>
<td>INT24</td>
<td>POINT F1</td>
</tr>
<tr>
<td>ED50SVAL:</td>
<td>INT24</td>
<td>POTSDAM HELMERT TWR</td>
</tr>
<tr>
<td>EDMCE75:</td>
<td>INT24</td>
<td>not specified</td>
</tr>
<tr>
<td>EGYPT07:</td>
<td>HELM1906</td>
<td>STATION F1</td>
</tr>
<tr>
<td>EGYPT24:</td>
<td>INT24</td>
<td>STATION F1</td>
</tr>
<tr>
<td>EVVIETNM:</td>
<td>EV37ADJ</td>
<td>not specified</td>
</tr>
<tr>
<td>FAHU:</td>
<td>CLA80MOD</td>
<td>STA. NO68/024 FAHU</td>
</tr>
<tr>
<td>GDA94:</td>
<td>GRS80</td>
<td>not specified</td>
</tr>
<tr>
<td>GEM6:</td>
<td>not specified</td>
<td>not specified</td>
</tr>
<tr>
<td>IND74:</td>
<td>INDNAT</td>
<td>PADANG</td>
</tr>
<tr>
<td>INDIAN54:</td>
<td>EV37ADJ</td>
<td>KALIANPUR</td>
</tr>
<tr>
<td>INDIAN60:</td>
<td>EVERST1830</td>
<td>not specified</td>
</tr>
<tr>
<td>INDIAN75:</td>
<td>EV37ADJ</td>
<td>KHAU SAKAERANG</td>
</tr>
<tr>
<td>ISRLURIM:</td>
<td>URI</td>
<td>CLA80BEN</td>
</tr>
<tr>
<td>JA1875:</td>
<td>CLA80IFT</td>
<td>FORT CHARLES F/STAFF</td>
</tr>
<tr>
<td>Datum</td>
<td>Spheroid</td>
<td>Tie Point</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------</td>
<td>------------------------------------</td>
</tr>
<tr>
<td>JAD69:</td>
<td>CLA66MTR</td>
<td>FORT CHARLES F/STAFF</td>
</tr>
<tr>
<td>KALIANPR:</td>
<td>EVINDMTR</td>
<td>KALIANPUR</td>
</tr>
<tr>
<td>KARBALA:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>KERTAU:</td>
<td>EVMODMAL</td>
<td>KERTAU</td>
</tr>
<tr>
<td>KOC:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>LACANOA:</td>
<td>INT24</td>
<td>LA CANOA</td>
</tr>
<tr>
<td>LEIGON:</td>
<td>CLA80MOD</td>
<td>GCS STATION121</td>
</tr>
<tr>
<td>LISBOA:</td>
<td>INT24</td>
<td>CASTELLO DE S. JORGE</td>
</tr>
<tr>
<td>LISBON:</td>
<td>INT24</td>
<td>CASTELLO DE S. JORGE</td>
</tr>
<tr>
<td>LUZON11:</td>
<td>CLA66MTR</td>
<td>BALACAN</td>
</tr>
<tr>
<td>MAHE71:</td>
<td>CLA80MOD</td>
<td>MAHE</td>
</tr>
<tr>
<td>MAKASSAR:</td>
<td>BESS1841</td>
<td>MONCONGLOE</td>
</tr>
<tr>
<td>MALONG79:</td>
<td>INT24</td>
<td>MALONGO STATION Y</td>
</tr>
<tr>
<td>MALONG90:</td>
<td>INT24</td>
<td>MALONGO STATION Y</td>
</tr>
<tr>
<td>MANOKA:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>MINAA:</td>
<td>CLA80MOD</td>
<td>MINAA BASE STAT. L40</td>
</tr>
<tr>
<td>MONTEMAR:</td>
<td>INT24</td>
<td>MONTE MARIO</td>
</tr>
<tr>
<td>MONTROME:</td>
<td>INT24</td>
<td>MONTE MARIO</td>
</tr>
<tr>
<td>MPORO:</td>
<td>CLA80IGN</td>
<td>not specified</td>
</tr>
<tr>
<td>NAD27:</td>
<td>CLA66MTR</td>
<td>MEADE'S RANCH</td>
</tr>
<tr>
<td>NAD27AFT:</td>
<td>CLA66AFT</td>
<td>MEADE'S RANCH</td>
</tr>
<tr>
<td>NAD27MOD:</td>
<td>CLA66MOD</td>
<td>MEADE'S RANCH</td>
</tr>
<tr>
<td>NAD27MTR:</td>
<td>CLA66MTR</td>
<td>MEADE'S RANCH</td>
</tr>
<tr>
<td>NAD83:</td>
<td>GRS80</td>
<td>GEOCENTRE</td>
</tr>
<tr>
<td>NAHRWAN:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>NTF:</td>
<td>CLA80IGN</td>
<td>PANTHEON</td>
</tr>
<tr>
<td>NTFPARA:</td>
<td>CLA80IGN</td>
<td>PANTHEON</td>
</tr>
<tr>
<td>NTFPARIS:</td>
<td>CLA80IGN</td>
<td>PANTHEON</td>
</tr>
<tr>
<td>NWL9D:</td>
<td>NWL9D</td>
<td>GEOCENTRE</td>
</tr>
<tr>
<td>NZGD49:</td>
<td>INT24</td>
<td>PAPATAHI</td>
</tr>
<tr>
<td>OSGB36:</td>
<td>AIRY</td>
<td>HERSTMONCEUX</td>
</tr>
<tr>
<td>OSGB70:</td>
<td>AIRY</td>
<td>HERSTMONCEUX</td>
</tr>
<tr>
<td>OSSN80:</td>
<td>AIRY</td>
<td>HERSTMONCEUX</td>
</tr>
<tr>
<td>PADANG:</td>
<td>BESS1841</td>
<td>PADANG</td>
</tr>
<tr>
<td>PALEST23:</td>
<td>CLA80BEN</td>
<td>JERUSALEM</td>
</tr>
<tr>
<td>POTSDAM:</td>
<td>BESS1841</td>
<td>POTSDAM(HELMERT TWR)</td>
</tr>
<tr>
<td>PRS92:</td>
<td>CLA66MTR</td>
<td>BALANACAN</td>
</tr>
<tr>
<td>PSA56:</td>
<td>INT24</td>
<td>LA CANOA</td>
</tr>
<tr>
<td>PTNOIRE:</td>
<td>CLA80IGN</td>
<td>POINT NOIRE (ASTRO)</td>
</tr>
<tr>
<td>PULKOVO:</td>
<td>KRAS1940</td>
<td>PULKOVO OBSERVATORY</td>
</tr>
<tr>
<td>QATAR:</td>
<td>INT24</td>
<td>STATION G3</td>
</tr>
<tr>
<td>QATAR51:</td>
<td>HELM1906</td>
<td>SOKEY O M</td>
</tr>
<tr>
<td>QORNOQ:</td>
<td>INT24</td>
<td>not specified</td>
</tr>
<tr>
<td>RD:</td>
<td>BESS1841</td>
<td>AMERSFOORT</td>
</tr>
<tr>
<td>SAD69:</td>
<td>INT67</td>
<td>not specified</td>
</tr>
<tr>
<td>Datum</td>
<td>Spheroid</td>
<td>Tie Point</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>SPHERE:</td>
<td>SPHERE</td>
<td>not specified</td>
</tr>
<tr>
<td>SPHERE2</td>
<td>SPHERE</td>
<td>not specified</td>
</tr>
<tr>
<td>SUDAN:</td>
<td>CLA80IGN</td>
<td>not specified</td>
</tr>
<tr>
<td>TANANAR:</td>
<td>INT24</td>
<td>TANANARIVE OBSERV.</td>
</tr>
<tr>
<td>TANANPAR:</td>
<td>INT24</td>
<td>TANANARIVE OBSERV.</td>
</tr>
<tr>
<td>TIMBALAI:</td>
<td>EVREST67</td>
<td>TIMBALAI</td>
</tr>
<tr>
<td>TIMBALFT:</td>
<td>EVIMPFT</td>
<td>TIMBALAI</td>
</tr>
<tr>
<td>TM65:</td>
<td>AIRYMOD</td>
<td>not specified</td>
</tr>
<tr>
<td>TM75:</td>
<td>AIRYMOD</td>
<td>not specified</td>
</tr>
<tr>
<td>TOKYO:</td>
<td>BESS1841</td>
<td>TOKYO OBSERVATORY</td>
</tr>
<tr>
<td>TRUCIAL:</td>
<td>HELM1906</td>
<td>TC1</td>
</tr>
<tr>
<td>USAIRMOD:</td>
<td>AIRYMOD</td>
<td>not specified</td>
</tr>
<tr>
<td>USAIRY:</td>
<td>AIRY</td>
<td>not specified</td>
</tr>
<tr>
<td>USANS:</td>
<td>ANS</td>
<td>not specified</td>
</tr>
<tr>
<td>USBESMOD:</td>
<td>BESSMOD</td>
<td>not specified</td>
</tr>
<tr>
<td>USBESS:</td>
<td>BESS1841</td>
<td>not specified</td>
</tr>
<tr>
<td>USC58MTR:</td>
<td>CLA58MTR</td>
<td>not specified</td>
</tr>
<tr>
<td>USC66AFT:</td>
<td>CLA66AFT</td>
<td>not specified</td>
</tr>
<tr>
<td>USC66MTR:</td>
<td>CLA66MTR</td>
<td>not specified</td>
</tr>
<tr>
<td>USC80IGN:</td>
<td>CLA80IGN</td>
<td>not specified</td>
</tr>
<tr>
<td>USC80MOD:</td>
<td>CLA80MOD</td>
<td>not specified</td>
</tr>
<tr>
<td>USC80RSA:</td>
<td>CLA80RSA</td>
<td>not specified</td>
</tr>
<tr>
<td>USEV37AD:</td>
<td>EV37ADJ</td>
<td>not specified</td>
</tr>
<tr>
<td>USEV67:</td>
<td>EVERST67</td>
<td>not specified</td>
</tr>
<tr>
<td>USGRS67:</td>
<td>GRS67</td>
<td>not specified</td>
</tr>
<tr>
<td>USGRS80:</td>
<td>GRS80</td>
<td>not specified</td>
</tr>
<tr>
<td>USINT24:</td>
<td>INT24</td>
<td>not specified</td>
</tr>
<tr>
<td>USINT67:</td>
<td>INT67</td>
<td>not specified</td>
</tr>
<tr>
<td>USKRAS40:</td>
<td>KRAS1940</td>
<td>not specified</td>
</tr>
<tr>
<td>USNWL10D:</td>
<td>NWL10D</td>
<td>not specified</td>
</tr>
<tr>
<td>USNWL9D:</td>
<td>NWL9D</td>
<td>not specified</td>
</tr>
<tr>
<td>USSPHERE:</td>
<td>SPHERE</td>
<td>not specified</td>
</tr>
<tr>
<td>WGS72BE:</td>
<td>NWL10D</td>
<td>GEOCENTRE</td>
</tr>
<tr>
<td>WGS72DOD:</td>
<td>NWL10D</td>
<td>GEOCENTRE</td>
</tr>
<tr>
<td>WGS84:</td>
<td>GRS80</td>
<td>not specified</td>
</tr>
<tr>
<td>XIAN80:</td>
<td>GRS80</td>
<td>XIAN OBSERVATORY</td>
</tr>
<tr>
<td>YEMHSL:</td>
<td>INT24</td>
<td>HSL 1</td>
</tr>
<tr>
<td>YOFF2000:</td>
<td>CLA80IGN</td>
<td>SENEGAL</td>
</tr>
<tr>
<td>VENUS</td>
<td>VENUS</td>
<td>EVE</td>
</tr>
</tbody>
</table>

**Note**

NAD27 and NAD27MTR are identical and use the CLA66MTR spheroid and the international meter as the natural length unit.
IGRF Settings

ModelVision provides an IGRF calculator to estimate the magnetic field parameters required for modelling. The International Geomagnetic Reference Field (IGRF) is a standard specification of the harmonic component values and their rates of change from which the background strength and direction of the earth's field can be derived as functions of space and time.

The coefficients used to define the IGRF for a range of years (1970 to the present) are listed in files IGRFyear.DAT where year is the start of the half decade and covers from the commencing year to the end of the decade (e.g. IGRF1975.DAT for years 1975 through to 1979).

The IGRF data files are stored in the directory containing the ModelVision executable file (MVIS.EXE).

In addition to the coefficient files is a file called IGRFMAP.DAT which provides ModelVision with information relating to the various map backdrops used in the IGRF Calculator.
Model Vision can create, save and load ASCII model files for all supported body types. Model files are composed of the individual body definitions plus specification of the regional and background physical properties.

Historically, the model file format (with file extension .TKM) has evolved with different versions of the ModelVision family of modelling applications (commencing with Toolkit, ModelVision and currently ModelVision). As a consequence, the model file formats have changed. ModelVision can import all file formats, and can export any of the required formats.

Examples of the various formats are provided in ModelVision Model File Format. For differences between the current format and previous versions, see Previous Versions.

ModelVision Model File Format

ModelVision Ver.10.00 11/02/09
File name: C:\ModelVision\mvfmt.tkm

NO. OF BODIES [ 8]

PROJECTION [NO]

IGRF (F,D,I) [ 58667.0],[ 12.7],[ -66.4]

Screen origin [ 0.0],[ 0.0],[ 0.0] [metres ]

Background density [ 2.670000] [g/cc ] [Background ]

Fix point [ 0.0],[ 0.0],[ 0.0]

Label [ 0.0],[ 0.0],[ 0.0]

BODY [ 1] [Polygon ] [Polygon Body ] [ 0] [T]

PROPERTIES

Density [ 0.100000] [g/cc ] [ 2.770000] absolute [ 0.000000] [ 4.000000]

Suscept [0.0007958] [CGS ] [0.0007958] absolute [0.000000][0.100000]

Remanence

Q ratio [ 0.000]

magnetisation [ 0.000] [nT ]

Azimuth [ 0.000] [degrees]

Dip of rem. [ 0.0] [degrees]

Volume [1.93e+010] [cubic metres]

DIMENSIONS

Colour [ 127] [ 127] [ 127]

No. of Corners [ 6]

x y z [metres ]

Centroid [ 471316.4],[6265440.2],[ 1343.6]

Fix point [ 471316.4],[6265440.2],[ 1343.6]

Label [ 471316.4],[6265440.2],[ 1343.6]

Strike azimuth [ -20.700] [degrees]

Strike length [ 5000.0] [metres ]

Plunge [ 0.000] [degrees]

Face 1 dip [ 90.000] [degrees]

Face 1 azimuth [ 0.000] [degrees]

Face 2 dip [ 90.000] [degrees]

Face 2 azimuth [ 0.000] [degrees]

Corners x y z [metres ]

[ 1] [ -830.6],[ 0.0],[ -647.8]

[ 2] [ 112.2],[ 0.0],[ -791.8]
BODY [  2]  [Ellipsoid       ]  [Body:1          ]  [  0]  [T]

PROPERTIES
Density  [ 0.100000]  [g/cc   ]  [ 2.770000] absolute  [ 0.000000]  [4.0000000]
Suscept  [0.0007958]  [CGS    ]  [0.0007958] absolute  [0.0000000]

Remanence
Q ratio  [  0.000]
magnetisation [  0.000]  [nT   ]
Azimuth  [   0.000]  [degrees]
Dip of rem.  [   0.0]  [degrees]
Volume  [1.48e+010]  [cubic metres]

DIMENSIONS
Colour  [  255]  [  0]  [ 255]
Location x,y,z  [ 474235.9],[6266542.0], [ 1343.6] [metres ]
Fix point  [ 474235.9],[6266542.0], [ 1343.6]
Label  [ 474235.9],[6266542.0], [ 1343.6]
a axis length  [  5000.0]  [metres ]
a axis plunge  [   0.00]  [degrees]
a axis azimuth  [  159.32]  [degrees]
b axis length  [  1055.1]  [metres ]
b axis rotat.  [  270.00]  [degrees]
c axis length  [  671.8]  [metres ]

BODY [  3]  [Sphere       ]  [Body:2          ]  [  0]  [T]

PROPERTIES
Density  [ 0.100000]  [g/cc   ]  [ 2.770000] absolute  [ 0.000000]  [4.0000000]
Suscept  [0.0007958]  [CGS    ]  [0.0007958] absolute  [0.0000000]

Remanence
Q ratio  [  0.000]
magnetisation [  0.000]  [nT   ]
Azimuth  [   0.000]  [degrees]
Dip of rem.  [   0.0]  [degrees]
Volume  [4.92e+009]  [cubic metres]

DIMENSIONS
Colour  [   0]  [ 255]  [ 255]
Location x,y,z  [ 476399.3],[6267358.4], [ 1295.6] [metres ]
Fix point  [ 476399.3],[6267358.4], [ 1295.6]
Label  [ 476399.3],[6267358.4], [ 1295.6]
Radius  [  1055.1]  [metres ]

BODY [  4]  [Tabular      ]  [Body:3          ]  [  0]  [T]

PROPERTIES
Density  [ 0.100000]  [g/cc   ]  [ 2.770000] absolute  [ 0.000000]  [4.0000000]
Suscept  [0.0007958]  [CGS    ]  [0.0007958] absolute  [0.0000000]

Remanence
Q ratio  [  0.000]
magnetisation [  0.000]  [nT   ]
Azimuth  [   0.000]  [degrees]
Dip of rem.  [   0.0]  [degrees]
Volume  [ 4e+009]  [cubic metres]
Appendix E Model Files

E.1 Volume 1 (1922) - Frustum

Properties
Density: 0.100000 g/cc 2.770000 absolute 0.000000 4.000000
Susceptibility: 0.0007958 CGS 0.0007958 absolute 0.000000 0.100000
Remanence
Q ratio: 0.000
magnetisation: 0.000 nT
Azimuth: 0.000 [degrees]
Dip of rem.: 0.000 [degrees]
Volume: 9.14e+009 cubic metres

Dimensions
Colour: [ 192] [ 192] [ 192]
No. of Corners: 7

Centroid: [481990.6], [6269510.5], [5000.0] metres
Fix point: [481990.6], [6269510.5], [5000.0] metres

E.2 Volume 2 (1981) - Plunging Prism

Properties
Density: 0.100000 g/cc 2.770000 absolute 0.000000 4.000000
Susceptibility: 0.0007958 CGS 0.0007958 absolute 0.000000 0.100000
Remanence
Q ratio: 0.000
magnetisation: 0.000 nT
Azimuth: 0.000 [degrees]
Dip of rem.: 0.000 [degrees]
Volume: 2.77e+010 cubic metres

Dimensions
Colour: [ 0] [ 0] [ 255]
No. of Corners: 6

Centroid: [479705.1], [6268766.6], [513.4] metres
Fix point: [479705.1], [6268766.6], [513.4] metres
Label: [479705.1], [6268766.6], [513.4] metres
Depth extent: 5000.0 metres
Plunge: 80.000 [degrees]
Plunge azimuth: 140.000 [degrees]
Top face dip: 3.000 [degrees]
Top face azim: 20.000 [degrees]

Corners
[1] [-877.5], [1811.6], [-5000.0] metres
[2] [-311.4], [1585.2], [-5000.0] metres
[3] [1245.5], [-113.2], [-5000.0] metres
[4] [1330.4], [-1811.6], [-5000.0] metres
[5] [-594.4], [-1075.6], [-5000.0] metres
[6] [-1330.4], [169.8], [-5000.0] metres

Body
[5] Plunging Prism Body:4 0 T

Body
[6] Frustum Body:4 0 T

Notes:
- The model files contain geometrical and physical properties of two volumes.
- Volume 1 is a frustum with specific dimensions, density, and susceptibility.
- Volume 2 is a plunging prism with similar properties.
- Centroids, fix points, and labels are specified for both volumes.
- The volumes are oriented with specific dips and azimuths.
Label          [ 481990.6],[6269510.5],[   5000.0]
Depth extent   [ 2000.0]   [metres ]
Plunge         [ 85.000]   [degrees]
Plunge azimuth [ 150.000]   [degrees]
Top face dip   [  0.000]   [degrees]
Top face azim  [  0.000]   [degrees]
Taper          [  1.000]  [base/top]

Corners         x   y   z [metres ]
[  1]         [ -707.7],[ 1868.2],[ -5000.0]
[  2]         [  -28.3],[ 1585.2],[ -5000.0]
[  3]         [  509.5],[  396.3],[ -5000.0]
[  4]         [ 1047.3],[ -651.1],[ -5000.0]
[  5]         [  877.5],[ -1968.2],[ -5000.0]
[  6]         [ -396.3],[ -1302.1],[ -5000.0]
[  7]         [ -1047.3],[  254.8],[ -5000.0]

BODY [  7]       [Elliptic Pipe ] [Body:5              ] [   0] [T]

PROPERTIES
Density        [ 0.100000]   [g/cc   ]  [ 2.770000] absolute  [ 0.000000]  [ 4.000000] [0.1000000]

Suscept        [0.0007958]   [CGS    ]  [0.0007958] absolute  [0.0000000]

Remanence
Q   ratio     [    0.000]   [nT     ]
magnetisation [    0.000]  [nT     ]

Azimuth       [    0.000]   [degrees]
Dip of rem.   [    0.000]   [degrees]

Volume          [5.76e+009]   [cubic metres]

DIMENSIONS

COLOUR
[ 0] [ 140] [ 0]

Location x,y,z [483830.5],[6271180.6],[   5000.0] [metres ]
Fix point      [483830.5],[6271180.6],[   5000.0]
Label          [483830.5],[6271180.6],[   5000.0]

Depth extent   [ 2000.0]   [metres ]
Plunge         [ 80.000]   [degrees]
Plunge azimuth [ 130.000]   [degrees]
A-axis radius  [ 1200.0]   [metres ]
A-axis azimuth [ 160.00]   [degrees]
B-axis radius  [ 800.0]   [metres ]
Taper          [  1.000]  [base/top]

BODY [  8]       [Circular Pipe ] [Body:6              ] [   0] [T]

PROPERTIES
Density        [ 0.100000]   [g/cc   ]  [ 2.770000] absolute  [ 0.000000]  [ 4.000000] [0.1000000]

Suscept        [0.0007958]   [CGS    ]  [0.0007958] absolute  [0.0000000]

Remanence
Q   ratio     [    0.000]   [nT     ]
magnetisation [    0.000]  [nT     ]

Azimuth       [    0.000]   [degrees]
Dip of rem.   [    0.000]   [degrees]

Volume          [ 1.5e+009]   [cubic metres]

DIMENSIONS

Colour         [ 255] [ 173] [ 91]
Location x,y,z [485670.5],[6272143.0],[   5000.0] [metres ]
Fix point      [485670.5],[6272143.0],[   5000.0]
Label          [485670.5],[6272143.0],[   5000.0]

Depth extent   [ 2000.0]   [metres ]
Plunge         [  75.000]   [degrees]
Appendix E Model Files

Plunge azimuth [ 170.000] [degrees]
Radius [ 500.0] [metres ]
Taper [ 1.000] [base/top]

Previous Versions

The only difference between ASCII model files derived from ModelVision SE and the version above is in the Dimension block for each body type, where ModelVision files have an entry for body Colour. This is not present in earlier versions. The Colour entry defines levels of Red:Green:Blue for display purposes. An example of this is:

Colour [ 192] [ 102] [ 256]

Differences between ModelVision (and SE) versions compared with older Toolkit .TKM ASCII model files are more pronounced. As well as the Colour difference described above, Toolkit files used the Reference Point (Centroid) locations for each body type and used local body offsets to define vertex positions. An example for the Polygon is shown below:

DIMENSIONS
No. of Corners [ 8]

<table>
<thead>
<tr>
<th>x</th>
<th>y</th>
<th>z</th>
</tr>
</thead>
<tbody>
<tr>
<td>488449.2</td>
<td>6254729.2</td>
<td>279.2</td>
</tr>
</tbody>
</table>

Strike azimuth [ -19.146] [degrees]
Strike length [ 720.3] [metres ]
Plunge [ 0.000] [degrees]
Face 1 dip [ 90.000] [degrees]
Face 1 azimuth [ 0.000] [degrees]
Face 2 dip [ 90.000] [degrees]
Face 2 azimuth [ 0.000] [degrees]

Corners

[ 1] [ -166.2], [ 0.0], [ -36.4]
[ 2] [ -122.7], [ 0.0], [ -88.0]
[ 3] [ 138.5], [ 0.0], [ -94.1]
[ 4] [ 170.2], [ 0.0], [ 33.4]
[ 5] [ 7.9], [ 0.0], [ 54.6]
[ 6] [ -87.1], [ 0.0], [ 97.1]
[ 7] [ -138.5], [ 0.0], [ 21.2]

Note

In the Toolkit program the Plunging Prism was not available as a supported body type.
### Symbols

The following symbols are available for use in ModelVision.

- Small Circle
- Proposed Location
- Small Cross
- Large Cross
- Small Triangle
- Large Triangle
- Small Filled Circle
- Oil Well
- Small Filled Triangle
- Large Filled Triangle
- Oil Shows
- Gas Shows
- Oil And Gas Shows
- Gas Well
- Oil And Gas Well
- Dry Hole
- Crossed Circle marker
- Dry Hole [Oil Shows]
- Oil Well [Gas Shows]
- Gas Well [Oil Shows]
- Small Open Square
- Large Open Square
- Small Filled Square
- Large Filled Square
- Dual Oil Well
- Dual Gas Well
- Dual Oil and Gas Well
- Suspended Well
- Suspended Oil Well
- Suspended Well [Oil Shows]
- Suspended Well [Gas Shows]
- Suspended Well Oil and Gas
- Suspended Gas Well
- Suspended Oil and Gas
- Suspended Dry Well [Oil Shows]
- Suspended Oil Well [Gas Shows]
- Suspended Gas Well [with Oil]
- Well with Injection
- Oil Well Completed
- Well with Oil Shows [Compl. Inject]
- Well with Gas Shows [Compl. Inject]
- Well with Oil and Gas Show
- Gas Well [Compl. Inject]
- Oil And Gas Well [Compl. Inject]
- Dry Hole [Compl. Inject]
- Dry Hole with Oil Show
- Oil Well with Gas Show
- Gas Well with Oil Show
- Abandoned Gas Well
- Abandoned Oil Well
- Abandoned Oil and Gas
- Abandoned Gas Well with Oil
- Abandoned Oil Well with Gas
- Gas Condensate
- Gas Condensate Show
Filter Descriptions

Filtering of gridded surface data can be done in the frequency domain (using FFTs and the Grid Filter option) or in the spatial domain using convolution filter methods in the Grid Filter tool. A broad suite of smoothing (low-pass) filters, contrast enhancement filters, edge detection filters, geophysical and general high-pass filters, are provided. Several user-defined filters also enable you to create and apply your own designs.

In this section:

- Convolution Filters
- One-Dimensional FFT Line Filter Descriptions
- Two Dimensional FFT Filter Descriptions
- FFT Derivative Filters
- FFT Magnetic Component or Phase Transformation Filters
- Normalised Source Strength

The grids supported by ModelVision are listed in Appendix A: File Formats.

Convolution Filters

- The Convolution Filtering Process
- Convolution Filter Descriptions
- Smoothing Filters
- Enhancement Filters
- Applying Convolution Filters in ModelVision

The Convolution Filtering Process

Grids are comprised of equi-spaced data values located along rows and columns. The intersection of these rows and columns is called a mesh point or node. When filtering a grid, each grid node of the output grid is calculated as a function of the corresponding node and its neighbors. The size of the neighbourhood used in the filtering process is defined by the size and shape of the filter (or kernel). Filters are generally defined as a rectangular sub-array of nodes, which are assigned a set of filter weights. Because the filter neighborhood needs to be centered on a grid node during the filtering process, filters are generally defined by an odd number of rows and columns. For example, if the width and the height of the filter neighborhood are both three, then the neighborhood of the output grid node centred at (row 40, column 32) is the following rectangular sub-array:

\[
\begin{array}{ccc}
(39,33) & (40,33) & (41,32) \\
(39,32) & (40,32) & (41,32) \\
(39,31) & (40,31) & (41,31)
\end{array}
\]
Shifting the filter neighbourhood across the grid and computing a new value for each grid node produces the filtered output of the image. If the heights of the neighborhood nodes are represented by $H$ and the width by $W$, the number of nodes in the neighborhood equals $H \times W$. Therefore, any nodes in the neighborhood can be defined as:

$$i = \left\lfloor \frac{H}{2} \right\rfloor, \ldots, \left\lfloor \frac{H}{2} \right\rfloor$$

and

$$j = \left\lfloor \frac{W}{2} \right\rfloor, \ldots, \left\lfloor \frac{W}{2} \right\rfloor$$

(1)

where each array is the largest integer less than or equal to its neighbour array.

When using the Grid Filter module, the Rows and Columns in the dialog specify the neighbourhood size of the selected filter. The weights for each grid node in the neighbourhood are displayed below. Each element of the matrix is used to weight the grid node that lies below it. The products are computed and then summed, normalized, and assigned to the value below the centre node. The filter is then shifted to the next node and the process is repeated until all nodes of the input grid have been processed.

**Convolution Filter Descriptions**

The filters supplied with the Grid Filter utility are text files (with file extension of .KER) and are located in the \FILTER folder of the main Grid Filter directory. The kernel files used are identical in format to those specified for use by ER Mapper.

Below is a list of the provided filter types and a brief summary of their application:

- **Smoothing Filters**
  - **Averaging Filters**
  - **Gaussian Filters**

**Smoothing Filters**

- **Averaging Filters**
- **Gaussian Filters**

**Averaging Filters**

Averaging filters preserve the low frequency components in an image by reducing the amount of intensity variation between one grid cell value and the next. They achieve this by simply replacing each grid cell value in an image with the average (mean) value of its neighbours, including itself. Averaging filters have the effect of eliminating grid cell values, which are unrepresentative of their surroundings, thereby removing noise and smoothing its appearance.

A 3x3 square kernel will generally provide sufficient smoothing for most datasets, although larger kernels (e.g. 5x5 or 7x7) can be used for more severe smoothing. In some situations applying a small (3x3) averaging filter to a grid several times may produce a slightly better result than filtering once with a larger kernel.
Averaging filters can also be used to enhance the sharpness of an image or improve the appearance of edges (high frequency components). This technique is commonly known as the “Unsharp” filtering method. To sharpen an image using a smoothing filter, first apply the smoothing filter to the grid. Then subtract the smoothed grid from the original grid to produce the Unsharp image. This technique can be used for crispening the appearance of images prior to printing.

The averaging filters supplied with Grid Filter include:

- 3x3 Average
- 3x3 Diagonal
- 5x5 Average
- 7x7 Average
- 9x9 Average

**Gaussian Filters**

Gaussian convolution filters are smoothing filters that can be used to blur images, thereby removing high frequency detail and noise. The degree of smoothing produced by a Gaussian filter is largely determined by the standard deviation of the filter kernel. The Gaussian filters output a “weighted average” value for each grid cell's neighbourhood, with the average weighted more towards the value of the central grid cells. This is in contrast to an averaging filter, which uses a uniform weighting for all cells. Because of this property, a Gaussian filter provides gentler smoothing and preserves edges better than a similarly sized averaging filter. Because Gaussian smoothing filters remove high spatial frequency components from an image they are often used as a pre-processing step to edge enhancement filters such as the Laplacian and Sobel filters. In most situations a Gaussian filter will provide the best smoothing for grids with high frequency noise such as geochemistry or magnetics.

The Gaussian filters supplied with Grid Filter are:

- 3x3 Gaussian, Standard Deviation = 0.391
- 5x5 Gaussian, Standard Deviation = 0.625
- 5x5 Gaussian, Standard Deviation = 1.0
- 9x9 Gaussian, Standard Deviation = 1.0
- 11x11 Gaussian, Standard Deviation = 1.6

**Enhancement Filters**

- *Sharpening Filters*
- *Line and Edge Enhance Filters*
- *Laplacian Filter*
- *Laplacian of Gaussian*
- *Sobel Filters*
- *Roberts Cross Filters*
- *Sun Angle Filters*
- *User-Defined Custom Filters*
Sharpening Filters

Sharpening filters enhance areas of high spatial frequency or contrasting gradients in an image by removing the low frequency components. These filters can be useful for enhancing edges in an image as well as “sharpening” the overall appearance. Applying a sharpening filter to a digital terrain image prior to performing a lineament analysis for example, may help emphasize structural discontinuities.

Four general sharpening filters are provided with Grid Filter:

- 5x5 Horizontal Edge Enhance
- 5x5 Vertical Edge Enhance
- 3x3 Edge Sharpen
- 5x5 Edge Sharpen

Line and Edge Enhance Filters

Line and edge enhance filters are designed to selectively enhance image features with specific directional components (gradients). The filters output an approximation of the first derivative and therefore enhance edges in an image. The sum of the directional filter kernel elements is zero, so areas within an image with uniform intensity (or grid cell values) will compute to zero in the output grid. Areas of variable intensity or contrast will be amplified and appear as bright edges.

Grid Filter provides the following directional filters:

- 3x3 Horizontal Edge Enhance
- 3x3 Vertical Edge Enhance
- 3x3 Horizontal Line Enhance
- 3x3 Vertical Line Enhance

Laplacian Filter

Laplacian filters approximate a 2D isotropic measure of the second spatial derivative of an image. Therefore they highlight regions of rapid intensity change, which are often associated with edges. Laplacian filters emphasize maximum values within an image by using a kernel with a high central value, surrounded by negative weighted values with lower weights. Laplacian filters can be very sensitive to noise (high spatial frequency data) so it is often best to apply a Gaussian smoothing filter prior to convolving the image with the Laplacian filter. Laplacian filters are normally applied to scaled graylevel images.

Grid Filter provides the following Laplacian filters:

- 3x3 Laplacian
- 9x9 Laplacian
Laplacian of Gaussian

A Laplacian of Gaussian filter (LoG) is similar to a Laplacian filter, with the only exception being that it has already been convolved with a Gaussian filter. The advantage of using a LoG filter over the standard Laplacian filter is that you not required to smooth the grid prior to applying the LoG as the whole process is achieved in a single pass. This property makes the LoG filter faster to compute on large datasets. LoG filters calculate an approximation of the second spatial derivative of an image. Therefore areas in an image that have a constant intensity (or a gradient of zero) will produce values of zero in the Laplacian image, while areas of high intensity variation (or gradient) will produce positive or negative values. Adding the LoG filtered grid back to the original grid will have the effect of enhancing contrast in the original image and making edges appear much sharper.

Grid Filter provides the following LoG filter:

9x9 Laplacian of Gaussian (Standard Deviation = 1.4)

Sobel Filters

Like the Laplacian filter, the Sobel filter approximates a 2D spatial gradient measurement on an image and therefore emphasizes regions of high spatial frequency. This type of filter is typically used to find the approximate absolute gradient magnitude at each point in an input grayscale image. Two Sobel filters are provided in Grid Filter. These are a pair of 3x3 filters, where one filter is simply the other rotated by 90°. The filters provided are designed to respond maximally to edges running vertically and horizontally relative to the grid cell orientation. One filter is supplied for each of the two perpendicular orientations (horizontal and vertical). The filters can be applied separately to the input grid, to produce separate measurements of the gradient component in each orientation or they can be combined together to find the absolute magnitude and orientation of the gradient at each point. The Sobel filter will often reduce edges in an input image to lines in the output image. This property makes the filter useful for assisting with lineament interpretations and structural mapping.

Grid Filter provides two Sobel filters:

Sobel Horizontal
Sobel Vertical

Roberts Cross Filters

Roberts’s filters perform a simple and quick 2D spatial gradient measurement on a grid. The filter is very similar to the Sobel filter with each grid cell value in the output image representing an estimate of the absolute magnitude of the spatial gradient. The filter therefore highlights regions of high spatial frequency. The Roberts filters provided with Discover are approximations of the true Roberts function and are designed to produce maximum responses over edges running at 45° to the pixel grid. One filter kernel is supplied for each of the two perpendicular orientations (Gx and Gy). The filters can be applied individually to measure the gradient component in each orientation or they can be combined to find the absolute magnitude and orientation of the gradient at each point in an image. The main disadvantage of the Roberts filter over the Sobel filter for edge detection is that it is extremely sensitive to noise due to the very small kernel. It also produces a much weaker response over genuine edges unless they are very sharp.

The Roberts Cross filters are:

Roberts Cross Gx
Roberts Cross Gy
Sun Angle Filters

These filters provide directional enhancement to grid surfaces. The filter kernels are designed to amplify gradients perpendicular to the direction of perceived ambient lighting. For example, an East-West sun angle filter enhances frequency content for artificial illumination from the north or south. Supplied filters include:

North
North East
East
South East
South
South West
West
North West

User-Defined Custom Filters

The following three user-defined filters are supplied with Grid Filter:

- General user-defined (mxn) filter
- Average mxn filter
- Gaussian mxn filter

These filters can be used as templates for designing and creating your own custom filters and offer a convenient way of experimenting with the properties of digital filtering. When you have designed a filter you wish to save click the **Save Filter** button and assign a name. The filter is stored in a **CUSTOM** sub-folder in the Filters directory.

Once a filter has been saved it will be displayed using the assigned name in the **Filters Available** list and can be reapplied during a subsequent filtering session.

Applying Convolution Filters in ModelVision

A two-dimensional convolution filter in ModelVision is defined to be equivalent to an ER Mapper filter kernel. These filter operators use the same file formats and layout. Filter operators are applied by choosing the **2D Convolution Filter** option in the **Filter** menu item.

Filter processing is a spatial operation generating output data based on the result of moving a convolution operator over the nominated grid. Filters are used to detect and enhance edges, sharpen, smooth and reduce noise in images. A range of filter functions is available. Those supplied are average, geophysical, sun angle, Sobel, sharpening and edge enhancement filters.
By highlighting one of the filter groups, a range of filters is displayed. Use the cursor to highlight one of these and choose the Select button. The selected filter is displayed and an Output grid name is required. Since some convolution filters can affect the margins of a grid, it is sometimes necessary to clip the grid margins. The clipping performed by this option is half the filter width.

If detail on the filter design is required, select the Characteristics button. The information on the filter size and operator is provided. If additional information is required, or new filters are to be added, this can be done by editing the ASCII files that describe the filters. These files and their formats are documented later in this appendix.

The filter characteristics can be displayed by loading the filter coefficients into a grid. Use the contour or grid profile view option to examine the two dimensional shape of the filter operator.

Some of the filters provided with ModelVision are described below:

- Geophysical Filters
- Averaging Filters
- Sunangle Filters
- Standard Filters
- Gaussian Filters

Geophysical Filters

Frequency filter operators are pass filters derived at spectral wavelengths of approximately a multiple of grid spacing. They are useful in some cases when removing surface noise from aeromagnetic data. Examples include:

- High_pass_4

This filter passes high frequency, long wavelength data with wavelengths less than or equal to approximately four times the grid spacing. Similar filters exist for low frequency and band pass operators:
Averaging Filters

Average 5 x 5 filter:

```
Kernel Begin
    Name = '5x5_average'
    Description = '5x5 average filter'
    Type = Convolution
    Rows = 5
    Columns = 5
    OkOnSubsampledData = Yes
    Array = {
        1 1 1 1 1
        1 1 1 1 1
        1 1 1 1 1
        1 1 1 1 1
        1 1 1 1 1
    }
    Scalefactor = 1
Kernel End
```

Sunangle Filters

East-West filter:

```
Kernel Begin
    Name = 'EW_Sun'
    Description = '3x3 East West Sun filter'
    Type = Convolution
    Rows = 3
    Columns = 3
    Array = {
        -1 0 1
        -1 0 1
        -1 0 1
    }
    Scalefactor = 1
Kernel End
```

Standard Filters

Laplacian 3 x 3 filter:

```
Kernel Begin
    Name = 'Laplacian'
    Description = 'Laplacian filter'
    Type = Convolution
    Rows = 3
    Columns = 3
    Array = {
        -1 -1 -1
        -1 8 -1
        -1 -1 -1
    }
Kernel End
```
-1 -1 -1

Kernel Begin
Name = 'sharpen'
Description = '3x3 Edge Sharpen filter'
Type = Convolution
Rows = 3
Columns = 3
Array = {
-1 -1 -1
-1 9 -1
-1 -1 -1
}
Scalefactor = 1
Kernel End

Sharpening 3 x 3 filter:

Kernel Begin
Name = 'Sobel_1'
Description = '3x3 Sobel kernel #1'
Type = Convolution
Rows = 3
Columns = 3
Array = {
1 2 1
0 0 0
-1 -2 -1
}
Scalefactor = 1
Kernel End

Sobel Filter:

Kernel Begin
Name = 'std_dev_0.391'
Description = 'Gaussian: Standard Deviation=0.391'
Type = Convolution
Rows = 3
Columns = 3
Array = {
1 4 1
4 12 4
1 4 1
}
Scalefactor = 32
Kernel End

Gaussian Filters

Standard Deviation Filter:
One-Dimensional FFT Line Filter Descriptions

- The General Linear Filter
- The 1D FFT Vertical Continuation Filter $G_{VC}(k)$
- General Expression for the 1D FFT Directional Derivative Filter $G_{qdd}(k)$
- The 1D FFT Vertical Derivative Filters $G_{vdd}(k)$ and $G_{1vd}(k)$
- The 1D FFT Horizontal Derivative Filters
- The General 1D Phase Transformation Filter $G_{T2q}(k)$
- The $B_T(k)$ to $B_{rf}(k)$ Transformation Filter $G_{T2rf}(k)$
- The $B_T(k)$ to $B_z(k)$ Transformation Filter
- The 1D FFT Reduction to the Magnetic Pole Filter $G_{rpf}(k)$
- The 1D FFT Reduction to the Magnetic Equator Filter $G_{re}(k)$
- The 1D FFT Pseudogravity Filter $G_{pg}(k)$
- The 1D FFT Pseudomagnetic Filter $G_{pm}(k)$
- The 1D FFT Low-Pass and High-Pass Butterworth Filters

The General Linear Filter

A one-dimensional line profile of scalar potential field data representing a harmonic scalar potential field function $\mathbf{F}_1(k; z=z_0)$ may be transformed to another scalar potential field function $\mathbf{F}_2(k; z=z_0)$ in the one-dimensional wave-number domain via use of the convolution theorem, namely, if the transfer function is $G(k)$ then:
\[ F_2(k; z_0) = G(k) \cdot F_1(k; z_0) \]  \hspace{1cm} (2)

Here it is noted that \( F_1(k, z_0) \) is the one-dimensional Fourier transform of the input scalar potential field function \( f_1(x, z_0) \), namely,

\[ F_1(k; z_0) = F_1(k_x, 0; z_0) = \int_{-\infty}^{\infty} f_1(x; z_0) \exp[-ikx] \, dx \]  \hspace{1cm} (3)

where \( k = k_x \) and \( k_y \equiv 0 \).

For measurements of a scalar potential field function \( f_1(x_i, 0; z=z_0) \) defined on a one-dimensional profile line \( 1 \leq i \leq N_x \), the one-dimensional discrete Fourier transform is defined as a complex Hermitian function \( F_1(k_1, z_0) \) such that:

\[ F_1(k_i; z_0) = \sum_{i=1}^{N_x} f_1(x_i; z_0) \exp[-2\pi ik_i x_i / N_x \Delta x] \]  \hspace{1cm} (4)

where \( x_i = (i - 1) \Delta x \) and the discrete \( k_x \) wave number is given by the relation:

\[ k = k_x = 2\pi (k_1 - 1) / N_x \Delta x \ ; \ 1 \leq k_1 \leq N_x \]  \hspace{1cm} (5)

The 1D FFT Vertical Continuation Filter \( G_{VC}(k) \)

The expression for the vertical continuation operator \( G_{VC}(k) \) for a line profile of potential field data at a point \( k = k_x \) in the 1D wave number domain is given by:

\[ G_{DC}(k) = \exp(|k| \delta z); \ \delta z < 0 \ for \ upward \ continuation \ to \ z_1 \]  \hspace{1cm} (6a)

\[ G_{DC}(k) = \exp(|k| \delta z); \ \delta z > 0 \ for \ downward \ continuation \ to \ z_1 \]  \hspace{1cm} (6b)

where \( \delta z = (z_1 - z_0) \) is the change in vertical datum from \( z_0 \) to \( z_1 \) for the 1D line profile, and \( |k| \) is the modulus of the 1D wave number \( k = k_x \).

General Expression for the 1D FFT Directional Derivative Filter \( G_{qdd}(k) \)

The equivalent expressions for calculating the \( p^{th} \) order \( (p \geq 0) \) directional derivative of a 2D harmonic scalar potential field function \( F(x, y=0, z=z_0) \) in the 1D wave number domain are derived by setting \( k = k_x \) and \( k_y \equiv 0 \) in equations (37) and (38) below. Hence for the \(-i\) forward Fourier transform, the expression for the complex gradient vector \( g_{1D} \) in the 1D wave number domain is

\[ g_{1D} = [ik_x, ik_y, |k|] = [ik, 0, |k|] \]  \hspace{1cm} (7)

where \( |k| \) is the modulus of the 1D wave number \( k = k_x \). Also since the direction of measurement \( q \) is within the vertical plane containing the line profile then the direction cosines are now \( \mathbf{q}_{1D} = (q_x, 0, q_z) \). Whence the equivalent expression for the transfer function \( G_{qdd}(k, z=z_0) \) for computing the \( p^{th} \) order \( (p \geq 0) \) directional derivative at a point \( k = k_x \) in the 1D wave number domain is now given by the following vector dot (scalar) product relation:

\[ G_{qdd}(k; z_0) = (\mathbf{g}_{1D} \cdot \mathbf{q}_{1D})^p \]  \hspace{1cm} (8)
It is noted that the order \( p \) of the directional or partial derivative may be a whole or fractional non-negative number, i.e. \( p \geq 0 \).

**The 1D FFT Vertical Derivative Filters \( G_{vdd}(k) \) and \( G_{1vd}(k) \)**

The transfer function \( G_{vdd}(k; z=z_0) \) for the vertical derivative operator of order \( p > 0 \) acting upon a line of scalar potential field data in the 1D wave number domain is derived from equation (8) by putting the direction cosine vector \( q_{1D} = (0, 0, 1) \). Hence:

\[
G_{vdd}(k) = |k|^p ; \text{ for } p > 0
\]  

where \( |k| \) is the modulus of the 1D wave number vector \( k \). Whence the expression for the first vertical derivative operator (i.e. for \( p = 1 \)) is:

\[
G_{1vd}(k) = |k|
\]  

Note the constant observation height \( z=z_0 \) is implicit in each expression for a filter function but is omitted for compactness.

**The 1D FFT Horizontal Derivative Filters**

The transfer function \( G(k) \) for the horizontal directional derivative operator of order \( p > 0 \) acting upon a line of scalar potential field data in the 1D wave number domain is derived from equation (8) by putting the direction cosine vector \( q_{1D} = (1, 0, 0) \). Hence from equations (7) and (8),

\[
G_{xdd}(k) = [ikx]^p = [ik]^p
\]

**The General 1D Phase Transformation Filter \( G_{T2q}(k) \)**

The equivalent expressions for transforming a 1D line profile of total magnetic field intensity (TMI) measurements \( B_T(k; z_0) \) to a line profile of scalar magnetic field measurements \( B_q(k; z_0) \) along a newly specified directional component \( q_{1D} \) with direction cosines \((q_x, 0, q_z)\) in the 1D wave number domain are derived by setting \( k = k_x \) and \( k_y \equiv 0 \) in equations (16) to (17) below.

\[
G_{T2q}(k) = (g_{1D} \cdot q_{1D})/(g_{1D} \cdot f_{2D}) \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0)
\]

or in terms of the transformed 1D Hilbert operator

\[
H_{1D} = g_{1D}/|k| = (H, 0, 1) ; H = H_x(k) = ik/|k| = i \text{ sgn } k
\]

Then,

\[
G_{T2q}(k) = (H_{1D} \cdot q_{1D})/(H_{1D} \cdot f_{2D}) \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0)
\]

or in terms of \( \Theta'_{f} \) and \( \Theta'_{q} \) where \( \Theta'_{f} = H_{1D} \cdot f_{2D} \) and \( \Theta'_{q} = H_{1D} \cdot q_{1D} \), then

\[
G_{T2q}(k) = \Theta'_{q}/\Theta'_{f} \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0)
\]
The $B_T(k)$ to $B_H(k)$ Transformation Filter $G_{T2H}(k)$

From the general 1D relations in equations (12) to (15) and after noting that the vector of
direction cosines $\mathbf{q}_{1D}$ is $(1,0,0)$ for the in-line horizontal field component along the x profile
axis, then the transformation to $B_x(k)$ becomes:

$$G_{T2H}(k) = \frac{ik_x}{(\mathbf{g}_{1D} \cdot \mathbf{f}_{2D})} = \frac{H_x}{(\mathbf{H}_{1D} \cdot \mathbf{f}_{2D})} = \frac{H}{\Theta'_{\mathbf{f}}} \tag{16}$$

The $B_T(k)$ to $B_z(k)$ Transformation Filter

Similarly, after noting that the vector of direction cosines $\mathbf{q}_{1D}$ is $(0,0,1)$ for the vertically down
or $Z_d$ field component, then the transformation to $B_z(k)$ becomes

$$G_{T2z}(k) = \frac{|k|}{(\mathbf{g}_{1D} \cdot \mathbf{f}_{2D})} = \frac{1}{(\mathbf{H}_{1D} \cdot \mathbf{f}_{2D})} = \frac{1}{\Theta'_{\mathbf{f}}} \tag{17}$$

The 1D FFT Reduction to the Magnetic Pole Filter $G_{tp}(k)$

The equivalent expressions for calculating the reduction to the pole (RTP) transfer filter for a
line of total magnetic field intensity (TMI) measurements $B_T(k,z=z_0)$ in the 1D wave number
domain are derived by setting $k = k_x$ and $k_y \equiv 0$ in equations (43) to (47) below. The following relation applies:

$$G_{tp}(k) = \frac{|k|^2}{[(\mathbf{g}_{1D} \cdot \mathbf{f}_{2D}) ((\mathbf{g}_{1D} \cdot \mathbf{m}_{2D})]} \tag{18}$$

where

$$\mathbf{g}_{1D} = (ik, 0, |k|)$$

is the complex gradient vector in the 1D wave number domain

$$\mathbf{f}_{2D} = (f'_{x}, 0, f'_{z})$$

is the vector of direction cosines for the local geomagnetic field
vector expressed within the $[x', 0, z]$ coordinate system of the line profile

$$\mathbf{m}_{2D} = (m'_{x}, 0, m'_{z})$$

is the vector of direction cosines for the resultant magnetisation
vector expressed within the $[x', 0, z]$ coordinate system of the line profile.

The one-dimensional RTP transfer function may also be expressed in terms of the transformed
1D Hilbert operator $\mathbf{H}_{1D} = \mathbf{g}_{1D}/|k| = (H_x, 0, 1)$ as defined in equation (13) above:

$$G_{tp}(k) = [((\mathbf{H}_{1D} \cdot \mathbf{f}_{2D}) ((\mathbf{H}_{1D} \cdot \mathbf{m}_{2D}))^{-1} \tag{19}$$

or in terms of $\Theta'_{\mathbf{f}}$ and $\Theta'_{\mathbf{m}}$ where $\Theta'_{\mathbf{f}} = \mathbf{H}_{1D} \cdot \mathbf{f}_{2D}$ and $\Theta'_{\mathbf{m}} = \mathbf{H}_{1D} \cdot \mathbf{m}_{2D}$, then:

$$G_{tp}(k) = 1/[ \Theta'_{\mathbf{f}} \Theta'_{\mathbf{m}}] \tag{20}$$

And for the induced magnetisation case in which the direction cosines $\mathbf{m}_{2D}$ of the resultant
magnetisation vector are identical to the direction cosines $\mathbf{f}_{2D}$ of the ambient geomagnetic field,
then equation (20) becomes:

$$G_{tp}(k) = 1/[\Theta'_{\mathbf{f}}]^{2} \tag{21}$$
The 1D FFT Reduction to the Magnetic Equator Filter $G_{\text{RTE}}(k)$

The equivalent expressions for calculating the reduction to the equator (RTE) transfer filter for a line of total magnetic field intensity measurements in the 1D wave number domain are derived by setting $k = k_x$ and $k_y = 0$ in equations (48) to (51) below. The following relationship applies:

$$G_{\text{RTE}}(k) = \frac{(g_{\text{H}1D} \cdot n_{2D})^2}{(g_{\text{H}1D} \cdot f_{2D}) (g_{\text{H}1D} \cdot m_{2D})}$$

where

- $g_{\text{H}1D} = (ik,0,0)$ is the horizontal complex gradient vector in the 1D wave number domain
- $g_{\text{H}1D} = (ik,0,|k|)$ is the complex gradient vector in the 1D wave number domain
- $f_{2D} = (f'_x,0,f'_z)$ is the vector of direction cosines for the local geomagnetic field vector expressed within the $[x',0,z]$ coordinate system of the line profile
- $m_{2D} = (m'_x,0,m'_z)$ is the vector of direction cosines for the resultant magnetisation vector expressed within the $[x',0,z]$ coordinate system of the line profile
- $n_{2D} = (n'_x,0,0)$ is the vector of direction cosines for the specified true north or magnetic north direction within the $[x',0,z]$ coordinate system of the line profile

The one-dimensional RTE transfer function may also be expressed in terms of the transformed 1D Hilbert operator $H_{1D} = g_{1D}/|k| = (H,0,1)$ as defined in equation (13) above:

$$G_{\text{RTE}}(k) = \frac{(H_{1D} \cdot n_{2D})^2}{(H_{1D} \cdot f_{2D}) (H_{1D} \cdot m_{2D})}$$

or in terms of $\Theta'_{n}, \Theta'_{f}$ and $\Theta'_{m}$ where $\Theta'_{n} = H_{1D} \cdot n_{2D}, \Theta'_{f} = H_{1D} \cdot f_{2D}$ and $\Theta'_{m} = H_{1D} \cdot m_{2D}$, then

$$G_{\text{RTE}}(k) = \frac{\Theta'_{n}^2}{[\Theta'_{f} \Theta'_{m}]}$$

For the induced magnetisation case in which the direction cosines $m_{2D}$ of the resultant magnetisation vector are identical to the direction cosines $f_{2D}$ of the ambient geomagnetic field, then the expression for the 1D RTE operator becomes:

$$G_{\text{RTE}}(k) = [\frac{\Theta'_{n}}{\Theta'_{f}}]^2$$

The 1D FFT Pseudogravity Filter $G_{\text{PSG}}(k)$

The equivalent expressions for calculating the 1D pseudogravity transfer filter for a line of total magnetic field intensity measurements in the 1D wave number domain are derived by setting $k = k_x$; $k_y = 0$ and $|k| = |k|$ in equations (52) and (53) below. The following relationship applies:

$$G_{\text{PSG}}(k) = C_{\text{PSG}}/ (\Theta'_{f} \Theta'_{n} |k|)$$

where $\Theta'_{f} = H_{1D} \cdot f_{2D}$; $\Theta'_{n} = H_{1D} \cdot m_{2D}$ and $C_{\text{PSG}}$ is the same quantity as defined in equation (53) below. And for the induced magnetisation case in which the direction cosines $m_{2D}$ of the effective resultant magnetisation vector are identical to the direction cosines $f_{2D}$ of the ambient geomagnetic field, then equation (26) becomes
\[ G_{psg}(k) = C_{psg}/[(\Theta' f)^2 |k|] \]  

(27)

**The 1D FFT Pseudomagnetic Filter \( G_{psm}(k) \)**

The equivalent expressions for calculating the 1D pseudomagnetic transfer filter for a line of total magnetic field intensity measurements in the 1D wave number domain are derived by setting \( k = k_x \); \( k_y = 0 \) and \( |k| = |k| \) in equations (55) and (56) below. The following relationship applies:

\[ G_{psm}(k) = C_{psm} |k|/(\Theta' f \Theta' m) \]  

(28)

where \( \Theta' f = H_{1D} f_{2D} \); \( \Theta' m = H_{1D} m_{2D} \) and \( C_{psg} \) is the same quantity as defined in equation (56) below. And for the induced magnetisation case in which the direction cosines \( m_{2D} \) of the effective resultant magnetisation vector are identical to the direction cosines \( f_{2D} \) of the ambient geomagnetic field, then equation (28) becomes:

\[ G_{psm}(k) = C_{psm} |k| / [\Theta' f]^2 \]  

(29)

**The 1D FFT Low-Pass and High-Pass Butterworth Filters**

The equivalent expressions for calculating the 1D low-pass and high-pass Butterworth filters are derived by setting \( k = k_x \); \( k_y = 0 \) and \( |k| = |k| \) in equations (66) and (69) below. The expression for the low-pass Butterworth filter of degree \( m \) and central wave number \( k_0 \) at a point \( k = k_x \) in the 1D wave number domain is given by:

\[ G_{lpb}(k) = 1/[1 + (|k|/k_0)^m] \]  

(30)

where \( k_0 = 2\pi/\lambda_0 \) and \( \lambda_0 \) is the cutoff wavelength (metres). The expression for the high-pass Butterworth filter of degree \( m \) and central wave number \( k_0 \) at a point \( k = k_x \) in the 1D wave number domain is given by

\[ G_{hpb}(k) = 1 - G_{lp}(k) = (|k|/k_0)^m/[1 + (|k|/k_0)^m] \]  

(31)

**Two Dimensional FFT Filter Descriptions**

Frequencies of filters are specified in terms of wavelengths (distance in metres). Cut-off rates determine the sharpness of the filter and the tapering of the energy spectrum. A high value of the cut-off has the effect of removing high frequencies, but causes ringing on the edges of large amplitude changes.

A theoretical description of the filters available in the Grid Filter option is provided below.

A 2D grid of scalar potential field data representing a harmonic scalar potential field function \( F_1(k, z_0) \) may be transformed to another scalar potential field function \( F_2(k, z_0) \) in the 2D wave-number domain \( k = (k_x, k_y) \) via use of the convolution theorem, namely, if the transfer function is \( G(k) \) then:

\[ F_2(k; z=z_0) = G(k) F_1(k, z=z_0) \]  

(32)

Here it is noted that \( F_1(k, z_0) \) is the two-dimensional Fourier transform of the input scalar potential field function, namely,
\[
F_1(k_z = z_0) = F_2(k_x, k_y; z_0) = \int \int f_1(x, y, z_0) \exp[-i(k_x x + k_y y)] \, dx \, dy
\]

(33)

Whence for measurements of a scalar potential field function \(f_1(x_i, y_j; z=z_0)\) defined over the 2D grid \(1 \leq i \leq N_x, 1 \leq j \leq N_y\), the 2D discrete Fourier transform is defined as a complex Hermitian function \(F_1(k_1, k_2; z_0)\) defined over the same size \((N_x \times N_y)\) grid, namely,

\[
F_1(k_1, k_2; z_0) = \sum_{i=1}^{N_x} \sum_{j=1}^{N_y} f_1(x_i, y_j, z_0) \exp[-2\pi i k_1 x_i / N_x \Delta x] \exp[-2\pi i k_2 y_j / N_y \Delta y]
\]

(34)

where \(x_i = (i-1) \Delta x\) and \(y_j = (j-1) \Delta y\) and the discrete \(k_x, k_y\) wave-numbers are given by the relations:

\[
k_x = 2\pi (k_1 - 1) / N_x \Delta x \quad ; \quad 1 \leq k_1 \leq N_x
\]

\[
k_y = 2\pi (k_2 - 1) / N_y \Delta y \quad ; \quad 1 \leq k_2 \leq N_y
\]

**FFT Derivative Filters**

- **Derivative Filter of nth Order (Advanced)**
- **The General Expression for FFT Directional Derivative Filters**
- **The FFT TMI Reduction to the Pole Filter \(G_{nP}(k)\)**
- **The FFT TMI Reduction to the Equator Filter \(G_{nte}(k)\)**
- **The FFT Pseudo-gravity Transform Filter \(G_{psg}(k)\)**
- **The 2D FFT Pseudo-magnetic Transform Filter \(G_{psm}(k)\)**

**Derivative Filter of nth Order (Advanced)**

Derivative filters can be applied in any direction with options of East, North, Vertical or Any defined orientation. If any direction is selected, an Azimuth and Inclination need to be specified.

The horizontal derivative (east or north) can be used for creating shaded images. The operator used for this computation is simply:

\[
G(k) = (g \cdot q)^p = (ik_x)^p \text{ for direction } x \text{ i.e. } q = (1, 0, 0)
\]

or

\[
G(k) = (g \cdot q)^p = (ik_y)^p \text{ for direction } y \text{ i.e. } q = (0, 1, 0)
\]

where:

\(p\) is the order of differentiation
and \(k_y\) are the wave number components in the x and y directions

\(i\) is the square root of \(-1\) (the imaginary component)

\(g = [ik_x, ik_y, |k|]\) is the complex gradient operator—see equation (37)

The vertical derivative is commonly applied to potential field data to enhance shallow geological sources. As with other filters that enhance the high frequency components of the spectrum, you can also apply low-pass filters to remove high frequency noise.

**The General Expression for FFT Directional Derivative Filters**

The transfer function \(G(k, z_0)\) for computing the \(p^{th}\) order \((p \geq 0)\) directional derivative of a harmonic scalar potential field function along a specified direction \(\mathbf{q} = (q_x, q_y, q_z)\) at a point \(k = (k_x, k_y)\) in the 2D wave number domain is given by the following vector dot (scalar) product relation—see for example, Blakely (1995):

\[
G_{qdd}(k) = (g \cdot \mathbf{q})^p \tag{36}
\]

where \(g\) is the complex gradient vector in the 2D wave number domain. For a \(-i\) forward Fourier transform (see above) the gradient operator \(g\) is defined as the complex vector:

\[
g = [ik_x, ik_y, |k|] \tag{37}
\]

where \(|k|\) is the modulus of the 2D wave number vector \(k\), namely,

\[
|k| = (k_x^2 + k_y^2)^{1/2} \tag{38}
\]

It is further noted that the order \(p\) of the directional or partial derivative may be a whole or fractional non-negative number, i.e. \(p \geq 0\).

**The FFT Vertical Derivative Filters \(G_{vdd}(k)\) and \(G_{1vd}(k)\)**

The transfer function \(G_{zdd}(k)\) for the vertical derivative operator of order \(p > 0\) acting upon a grid of harmonic scalar potential field data \(F(k; z=z_0)\) in the 2D wave number domain is derived from equation (36) by putting the direction cosine vector \(\mathbf{q} = (0, 0, 1)\). Hence:

\[
G_{zdd}(k) = |k|^p \text{; for } p > 0 \tag{39}
\]

where \(|k|\) is the modulus of the 2D wave number vector \(k\). Whence the expression for the first vertical derivative operator is

\[
G_{1vd}(k) = |k| \tag{40}
\]

**The FFT Horizontal Derivative Filter \(G_{xdd}(k)\) and \(G_{ydd}(k)\)**

The transfer function \(G(k)\) for the \(x\)- or \(y\)-horizontal directional derivative operator filters of order \(p > 0\) acting upon a grid of harmonic scalar potential field data in the 2D wave number domain \(k = (k_x, k_y)\) is derived from equation (36) by putting the direction cosine vector \(\mathbf{q} = (1, 0, 0)\) for the \(x\)-direction or \(\mathbf{q} = (0, 1, 0)\) for the \(y\)-direction. Hence

\[
G_{xdd}(k) = [ik_x]^p \text{ the } x \text{-directional derivative of order } p > 0 \tag{41}
\]

\[
G_{ydd}(k) = [ik_y]^p \text{ the } y \text{-directional derivative of order } p > 0 \tag{42}
\]
and

$$G_{ydd}(k) = [ik_y]^p \text{ the y-directional derivative of order } p > 0 \quad (42)$$

Here it is noted that x and y are the east and north directions respectively for the Encom grid coordinate system whereas x and y are north and east respectively in the IGRF coordinate system.

**The FFT Integration Filter**

The integration filter is the inverse of the derivative filter, i.e. the order of integration p is negative in equations (37) to (42) above. Integration can be performed in any direction including vertically by specifying a declination and inclination. The order of integration p may be an integer or a fractional number (p < 0).

**The FFT TMI Reduction to the Pole Filter** $G_{rtp}(k)$

The reduction to the pole (RTP) filter is used to transform a grid of total magnetic field intensity measurements to a grid of magnetic intensity measurements that would be observed at the north magnetic pole. The expression for the RTP transform operator $G_{rtp}(k)$ at a point $k = (k_x, k_y)$ in the 2D in the wave number domain is given by Gibert & Guillamin (1985) and Blakely (1995) as follows:

$$G_{rtp}(k) = \frac{|k|^2}{(|g|f)(g \cdot m)} \quad (43)$$

where

$$g(k) = (ik_x, ik_y, |k|) \text{ is the complex gradient vector in the 2D wave number domain}$$

$$f = (f_x, f_y, f_z) \text{ is the unit vector of direction cosines for the local geomagnetic field vector}$$

$$m = (m_x, m_y, m_z) \text{ is the unit vector of direction cosines for the resultant magnetisation vector}.$$  

Here it is noted that the direction cosines are measured using the International Geomagnetic Reference Field (IGRF) coordinate system, namely, x-north; y-east, z–vertically down. Furthermore, it is possible to express the RTP transfer function in terms of the transformed 2D Hilbert operators $H_x(k), H_y(k)$ (Nabighian, 1983) in the $k = (k_x, k_y)$ wave number domain, namely,

$$H_x(k) = ik_x / |k| \quad ; \quad H_y(k) = ik_y / |k| \quad (44)$$

After putting $H = g / |k| = (H_x, H_y, 1)$, then:

$$G_{rtp}(k) = [ (H \cdot f)(H \cdot m) ]^{-1} \quad (45)$$

Or, after putting $\Theta_f = H \cdot f$ and $\Theta_m = H \cdot m$, in the notation of Blakely (1995, Ch. 12), then:

$$G_{rtp}(k) = 1 / [\Theta_f \Theta_m] \quad (46)$$
Whence for the induced magnetisation case in which the direction cosines \( \mathbf{m} \) of the resultant magnetisation vector is identical to the direction cosines \( \mathbf{f} \) of the ambient geomagnetic field, then equation (46) becomes:

\[
G_{\text{te}}(\mathbf{k}) = 1/\Theta_{z}^{2}
\]  

(47)

**The FFT TMI Reduction to the Equator Filter \( G_{\text{te}}(\mathbf{k}) \)**

The reduction to the equator (RTE) filter is used to transform a grid of total magnetic field intensity measurements to a grid of magnetic intensity measurements that would be observed at the magnetic equator, i.e. where the inclination of the geomagnetic field is zero degrees. The expression for the RTE transform operator \( G_{\text{te}}(\mathbf{k}) \) in the wave number domain is given by Gibert & Guillamin (1985) and Blakely (1995) as follows:

\[
G_{\text{te}}(\mathbf{k}) = \frac{(\mathbf{g}_{\text{H}} \cdot \mathbf{n})^{2}}{(\mathbf{g} \cdot \mathbf{f})(\mathbf{g} \cdot \mathbf{m})}
\]  

(48)

where

\[
\mathbf{g} = (ik_{x}, ik_{y}, |\mathbf{k}|) \text{ is the complex gradient vector in the 2D wave number domain}
\]

\[
\mathbf{g}_{\text{H}} = (ik_{x}, ik_{y}) \text{ is the horizontal gradient vector in the 2D wave number domain}
\]

\[
\mathbf{f} = (f_{x}, f_{y}, f_{z}) \text{ is the unit vector of direction cosines for the local geomagnetic field vector}
\]

\[
\mathbf{m} = (m_{x}, m_{y}, m_{z}) \text{ is the unit vector of direction cosines for the resultant magnetisation vector}
\]

\[
\mathbf{n} = (n_{x}, n_{y}, 0) \text{ is the unit vector of direction cosines for the specified true north or magnetic north direction}
\]

As noted previously the direction cosines are measured using the International Geomagnetic Reference Field (IGRF) coordinate system. From equations (44) above it is possible to express the RTE transfer function in terms of the transformed 2D Hilbert operators \( H_{x}(\mathbf{k}), H_{y}(\mathbf{k}) \) in the \( \mathbf{k} = (k_{x}, k_{y}) \) wave number domain, namely,

After putting \( \mathbf{H} = \mathbf{g}/|\mathbf{k}| = (H_{x}, H_{y}, 1) \), and \( \mathbf{H}_{2D} = \mathbf{g}_{\text{H}}/|\mathbf{k}| = (H_{x}, H_{y}) \), then:

\[
G_{\text{te}}(\mathbf{k}) = \frac{(\mathbf{H}_{2D} \cdot \mathbf{n})^{2}}{(\mathbf{H} \cdot \mathbf{f})(\mathbf{H} \cdot \mathbf{m})}
\]  

(49)

Or, after putting \( \Theta_{z} = \mathbf{H} \cdot \mathbf{f} \) and \( \Theta_{n} = \mathbf{H} \cdot \mathbf{m} \) and \( \Theta_{n} = \mathbf{H}_{2D} \cdot \mathbf{n} \), then:

\[
G_{\text{te}}(\mathbf{k}) = \Theta_{n}^{2}/[\Theta_{z} \Theta_{n}]
\]  

(50)

Whence for the induced magnetisation case in which the direction cosines \( \mathbf{m} \) of the resultant magnetisation vector is identical to the direction cosines \( \mathbf{f} \) of the ambient geomagnetic field, then equation (50) becomes

\[
G_{\text{te}}(\mathbf{k}) = \left[\Theta_{n}/\Theta_{z}\right]^{2}
\]  

(51)
The FFT Pseudo-gravity Transform Filter $G_{psg}(k)$

The pseudogravity filter is used to transform a grid of total magnetic field intensity measurements $B_z(k, z=z_0)$ to a grid of vertical gravity component $g_z(k, z=z_0)$ data in the wave number domain. The expression for the pseudogravity transform operator $G_{psg}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by Blakely (1995) as follows:

$$
G_{psg}(k) = C_{psg} / (\Theta_f \Theta_m |k|)
$$

where $\Theta_f = H \cdot f$ and $\Theta_m = H \cdot m$ are the same quantities as those defined above in and identical to those in Blakely (1995). The quantity $C_{psg}$ is a constant given by

$$
C_{psg} = (G/C_m)(\rho/M_{res})
$$

where

- $G$ is the Universal Gravitational Constant [$= 6.6726 \times 10^{-11} \text{ N} \cdot \text{m}^2/\text{kg}^2$]
- $\rho$ is the density [kg/m$^3$]
- $M_{res}$ is the resultant magnetisation in ampere/metre [A/m]
- $C_m$ is a constant equal to $\mu_0/4\pi$ in henry/metre [H/m]
- $\mu_0$ is the magnetic permeability of free space = $4\pi \times 10^{-7}$ H/m.

Note for the induced magnetisation case in which the direction cosines $m$ of the resultant magnetisation vector are identical to the direction cosines $f$ of the ambient geomagnetic field, then equation (52) becomes

$$
G_{psg}(k) = C_{psg} / (\Theta_f^2 |k|)
$$

The 2D FFT Pseudo-magnetic Transform Filter $G_{psm}(k)$

The pseudomagnetic filter is used to transform a grid of vertical gravity component data $g_z(k, z=z_0)$ to a grid of total magnetic field intensity $B_z(k, z_0)$ data in the wave number domain. The expression for the pseudomagnetic transform operator $G_{psm}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by Blakely (1995) as follows:

$$
G_{psm}(k) = C_{psm} |k| / (\Theta_f \Theta_m)
$$

where $\Theta_f = H \cdot f$ and $\Theta_m = H \cdot m$ are the same quantities as those defined above and in Blakely (1995). The quantity $C_{psm}$ is a constant given by:

$$
C_{psm} = (C_m/G)(M_{res}/\rho) = 1/C_{psg}
$$

where

- $G$ is the Universal Gravitational Constant [$= 6.6726 \times 10^{-11} \text{ N} \cdot \text{m}^2/\text{kg}^2$]
- $\rho$ is the density [kg/m$^3$]
- $M_{res}$ is the resultant magnetisation in ampere/metre [A/m]
- $C_m$ is a constant equal to $\mu_0/4\pi$ in henry/metre [H/m]
\( \mu_0 \) is the magnetic permeability of free space = \( 4\pi \times 10^{-7} \text{ H/m} \).

\( C_{psm} \) is a constant given by equation (53).

Note for the induced magnetisation case in which the direction cosines \( \mathbf{m} \) of the resultant magnetisation vector are identical to the direction cosines \( \mathbf{f} \) of the ambient geomagnetic field, then equation (55) becomes

\[
G_{psm}(k) = C_{psm}|k| / |\Theta_f|^2
\]  

(57)

**FFT Magnetic Component or Phase Transformation Filters**

- The TMI General Phase Transformation \( G_{T2q}(k) \)
- The \( B_T(k) \) to \( B_4(k) \) Transformation Filter \( G_{T2x}(k) \)
- The \( B_T(k) \) to \( B_5(k) \) Transformation Filter \( G_{T2y}(k) \)
- The FFT Vertical Continuation Filter \( G_{uc}(k) \) and \( G_{dc}(k) \)
- The 2D FFT Low-Pass and High-Pass Butterworth Filters
- The FFT Band-Pass and Band-Reject Directional Cosine Filters
- The First Order Magnetic Moment Transformation
- The FFT Filters for Transforming TMI Grids to Any Element of the Magnetic Gradient Tensor (MGT)
- The \( B_T(k) \) to \( B_{pq}(k) \) MGT Transformation Filters
- The FFT Filters for Transforming Grids of Gravity Measurements \( g_z(k) \) to Any Element of the Gravity Gradient Tensor (GGT)
- FFT TMI Reduction to the Pole (Low Latitude) Processing
- Aspects of Numerical Computation
- Computation of the Magnetic Moments
- Low Pass Filter
- High Pass Filter
- Band Pass Filter
- Directional Pie Slice Filter
The TMI General Phase Transformation $G_{T2q}(k)$

The phase transformation filter is used to transform a grid of total magnetic field intensity (TMI) measurements $B_T(k; z_0)$ to a grid of scalar magnetic field measurements $B_q(k; z_0)$ along a newly specified component direction $q$ with direction cosines $(q_x, q_y, q_z)$. The expression for the general phase transformation operator $G_{T2q}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by the following relation—see for example, Blakely (1995) or Schmidt & Clark (1998):

$$G_{T2q}(k) = (\mathbf{g} \cdot \mathbf{q}) / (\mathbf{g} \cdot \mathbf{f}) \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0) \quad (58)$$

or in terms of the transformed 2D Hilbert operator $\mathbf{H} = g/|k| = (H_x, H_y, 1)$ as defined in equation (44) above:

$$G_{T2q}(k) = (\mathbf{H} \cdot \mathbf{q}) / (\mathbf{H} \cdot \mathbf{f}) \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0) \quad (59)$$

or in terms of $\Theta_f$ and $\Theta_q$ where $\Theta_f = \mathbf{H} \cdot \mathbf{f}$ and $\Theta_q = \mathbf{H} \cdot \mathbf{q}$, then:

$$G_{T2q}(k) = \Theta_q / \Theta_f \text{ for } B_T(k; z_0) \rightarrow B_q(k; z_0) \quad (60)$$

The $B_T(k)$ to $B_x(k)$ Transformation Filter $G_{T2x}(k)$

From the general relations in (58 to 60) and after noting that unit vector of direction cosines $\mathbf{q}$ is $(1, 0, 0)$ for the north or $x$ field component, then for the transformation to $B_x(k; z=z_0)$ then:

$$G_{T2x}(k) = ik_x / (\mathbf{g} \cdot \mathbf{f}) = H_x / (\mathbf{H} \cdot \mathbf{f}) = H_x / \Theta_x \quad (61)$$

The $B_T(k)$ to $B_y(k)$ Transformation Filter $G_{T2y}(k)$

Similarly after noting that unit vector of direction cosines $\mathbf{q}$ is $(0, 1, 0)$ for the east or $y$ field component, then for the transformation to $B_y(k; z=z_0)$ then:

$$G_{T2y}(k) = ik_y / (\mathbf{g} \cdot \mathbf{f}) = H_y / (\mathbf{H} \cdot \mathbf{f}) = H_y / \Theta_y \quad (62)$$

The $B_T(k)$ to $B_z(k)$ Transformation Filter $G_{T2z}(k)$

Similarly after noting that unit vector of direction cosines $\mathbf{q}$ is $(0, 1, 0)$ for the depth or $z$-down field component, then for the transformation to $B_z(k)$ then:

$$G_{T2z}(k) = |k| / (\mathbf{g} \cdot \mathbf{f}) = 1 / (\mathbf{H} \cdot \mathbf{f}) = 1 / \Theta_z \quad (63)$$

The FFT Vertical Continuation Filter $G_{uc}(k)$ and $G_{dc}(k)$

The vertical continuation filter is used to transform a 2D grid of scalar potential field (magnetic or gravity) measurements from one datum level at $z=z_0$ to another datum level at $z=z_1$ in either an upward or downward direction. The expression for the vertical continuation operator $G_{UDC}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by the following relation—see for example, Blakely (1995):

$$G_{UDC}(k) = \exp \{ |k| \delta z \} \delta z < 0 \text{ for upward continuation to } z_1 \quad (64)$$
\[ G_{\text{UDC}}(k) = \exp \left| k \right| \delta z \quad \delta z > 0 \quad \text{for downward continuation to} \quad z_1 \quad (65) \]

where \( \delta z = (z_1 - z_0) \) is the change in vertical datum from \( z_0 \) to \( z_1 \) for the 2D grid and \( |k| \) is the modulus of the 2D wavenumber vector \( k \) as defined in equation (67). Here it is noted that \( z \) is measured positive downwards which is in keeping with both the IGRF and the Encom grid coordinate systems.

The 2D FFT Low-Pass and High-Pass Butterworth Filters

The Butterworth filter is used to apply either low-pass or high-pass filtering to a grid of transformed potential field measurements. The high- or low-pass filters are employed to reject regional or residual scale features respectively in grids of scalar potential field data. The rate of amplitude roll-off for the Butterworth filter is controlled by its degree \( m \) whereas its cutoff wavelength is specified via the central wave number \( k_0 \) or wavelength \( \lambda_0 \) parameter, namely, \( k_0 = 2\pi/\lambda_0 \) (i.e. the half-amplitude point). The expression for the low-pass Butterworth filter of degree \( m \) and central wave number \( k_0 \) at a point \( k = (k_x, k_y) \) in the 2D wave number domain is given by:

\[ G_{\text{lpb}}(k) = \frac{1}{1 + \left( \frac{|k|}{|k_0|} \right)^m} \quad (66) \]

where

\[ k = |k| = \left[ k_x^2 + k_y^2 \right]^{1/2} ; \quad k_0 = \frac{2\pi}{\lambda_0} \quad (67) \]

and \( \lambda_0 \) is the cutoff wavelength (metres).

The expression for the 2D high-pass Butterworth filter of degree \( m \) and central wave number \( k_0 \) at a point \( k = (k_x, k_y) \) in 2D the wave domain is given by

\[ G_{\text{hp}}(k) = 1 - \frac{1}{1 + \left( \frac{|k|}{|k_0|} \right)^m} \quad (68) \]

The FFT Band-Pass and Band-Reject Directional Cosine Filters

The directional filter is used to pass or reject regional or residual scale features in grids of transformed scalar potential field data. These features have a preferred azimuth or strike direction which is specified by an angle \( \alpha_0 \) while the angular bandwidth of the directional cosine filter is controlled by its degree \( m \). The expression for the response function of a band-pass directional cosine filter of degree \( m \) and azimuthal strike direction \( \alpha_0 \) (the maximum amplitude point) at a point \( k = (k_x, k_y) \) in the 2D wave number domain is given by

\[ G_{\text{bpaz}}(k) = \left( |\cos(\alpha_0 - \theta(k))| \right)^m \quad (69) \]

where

\[ \theta(k) = \arctan \left( \frac{k_x}{k_y} \right) ; \quad -\pi/2 \leq \theta(k) \leq \pi/2 \quad (70) \]

The expression for the response function of a band-reject directional cosine filter of degree \( m \) and azimuthal strike direction \( \alpha_0 \) (the zero amplitude point) at a point \( k = (k_x, k_y) \) in the 2D wave number domain is given by

\[ G_{\text{braz}}(k) = 1 - \left( |\cos(\alpha_0 - \theta(k))| \right)^m \quad (71) \]
The First Order Magnetic Moment Transformation

Consider a disturbing magnetic body or magnetic source centred at \((x_c, y_c, z_c)\) whose anomalous magnetic field is \(\Delta B(\mathbf{r}) = [\Delta B_x(\mathbf{r}), \Delta B_y(\mathbf{r}), \Delta B_z(\mathbf{r})]\). Helbig (1963) has shown that the magnetic dipole moment \(\mathbf{M} = (M_x, M_y, M_z)\) of the disturbing magnetic source may be calculated from the components of the anomalous magnetic field at any point \(\mathbf{r} = (x, y, z_0)\) on the horizontal plane \(z = z_0\). In this instance the three components \(M_x, M_y, M_z\) of the zero-th order magnetic moment \(\mathbf{M}\) are the first order moments of \(\Delta B_z(\mathbf{r})\) about the \(x, y\) axes and the first order moments of \(\Delta B_x(\mathbf{r})\) and \(\Delta B_y(\mathbf{r})\) about the \(x, y\) axes respectively. These relations between the magnetic moment of the body and the first order moments of the magnetic field may be expressed through the following double integrals, namely, for the \(M_x\) moment:

\[
M_x = (1/2\pi) \iint_{-\infty}^{\infty} (x - x_0) \Delta B_z(x, y, z_0) \, dx \, dy \tag{72}
\]

and for the \(M_y\) moment,

\[
M_y = (1/2\pi) \iint_{-\infty}^{\infty} (y - y_0) \Delta B_z(x, y, z_0) \, dx \, dy \tag{73}
\]

and for the \(M_z\) moment

\[
M_z = (1/2\pi) \iint_{-\infty}^{\infty} (x - x_0) \Delta B_x(x, y, z_0) \, dx \, dy \tag{74}
\]

or alternatively

\[
M_z = (1/2\pi) \iint_{-\infty}^{\infty} (y - y_0) \Delta B_y(x, y, z_0) \, dx \, dy \tag{75}
\]

Furthermore and importantly it is also noted that the following pair of integrals are identically zero.

\[
M_{x,y} = (1/2\pi) \iint_{-\infty}^{\infty} (x - x_0) \Delta B_y(x, y, z_0) \, dx \, dy = 0 \tag{76}
\]

and also,

\[
M_{y,x} = (1/2\pi) \iint_{-\infty}^{\infty} (y - y_0) \Delta B_x(x, y, z_0) \, dx \, dy = 0 \tag{77}
\]

By inspection of equations (72 to 75), it is noted that the magnetic moment \(\mathbf{M}\) is completely determined from measurements of a single pair of magnetic field components, i.e. either from \(\Delta B_x(x, y, z_0), \Delta B_z(x, y, z_0)\) or from \(\Delta B_y(x, y, z_0), \Delta B_z(x, y, z_0)\). In practice however a more stable estimator of the vertical component \(M_z\) of the magnetic moment is

\[
M_z = \frac{M_z(x) + M_z(y)}{2} \tag{78}
\]

where \(M_z(x)\) and \(M_z(y)\) are given by equations (74) and (75) respectively. Also a further necessary condition for the existence of a reliable magnetic moment is that the integrals in equations (76) and (77) are both approximately zero, namely,

\[
M_{x,y} \equiv M_{y,x} \equiv 0 \tag{79}
\]

Other magnetic moment components which can be used are the horizontal moment,

\[
M_H = (M_x^2 + M_y^2)^{1/2} \tag{80}
\]

and the total magnetic moment,
\[ M_T = |M| = [M_x^2 + M_y^2 + M_z^2]^{1/2} = [M_h^2 + M_z^2]^{1/2} \quad (81) \]

Furthermore the declination \( D_m \) and inclination \( I_m \) of the magnetic moment vector \( M \) (in IGRF coordinates x is north and y is east) are given by

\[ D_m = \arctan \left[ \frac{M_y}{M_x} \right] \text{ for } 0 \leq D_m < 2\pi \quad (82) \]

\[ I_m = \arctan \left[ \frac{M_h}{M_z} \right] \text{ for } 0 \leq I_m < 2\pi \quad (83) \]

It is noted that the above formulae are for the zero order magnetic dipole moment of the disturbing body under the plane \( z = z_0 \) (Helbig 1963, p. 84). This is related to the reduced multipole moments of Grant (1952) and Grant & West (1965, pp. 222–225). Expressions exist for the zero, first and second order dipole moments of various simple bodies including spheres, ellipsoids of revolution, triaxial ellipsoids, finite length elliptic cylinders, rectangular prisms and wedges. Medeiros & Silva (1995) have estimated the total intensity, direction of magnetisation and the 3D spatial orientation of a seamount source using inversion based on dipole moments up to second order.

**The FFT Filters for Transforming TMI Grids to Any Element of the Magnetic Gradient Tensor (MGT)**

It is possible to compute the magnetic tensor grids from the total magnetic field intensity grid using the fast Fourier transform and the equivalent can be computed from a grid of gravity (Gz). The full tensor of the magnetic field can be used for computing many useful parameters for further interpretation such as the invariants \( I_1, I_2 \), dimensionality and more advance functions such as those introduced by Beiki et al. (2012). The gravity tensor transformation is useful for the conversion of a gravity survey grid to a tensor to see what it looks like as a tensor or for testing different geological models to determine their response characteristics of a gravity gradiometer survey. There is a lot of 3D spatial information in tensor data that cannot be resolved from the primary field or vertical gradient.

These two new filters have been added to the Grid Filter dialog and are accessed from the FFT>Tensor menu selection.
The new Grid Filter Tensor transformation selection options.

In the magnetic case you need the IGRF inclination and declination as well as a selection of the tensor components. This is normally limited to the upper diagonal matrix, but the symmetric terms can be selected as well. In the gravity case you just need to select the tensor components. Don’t forget to set the padding amount that best suits your data.

The following example image displayed in ModelVision shows images of the original total field grid (Bm) generated from a vertical, elliptic pipe model and the FFT transformed tensor grids. Also shown is a map view of the upper surface of the pipe and a 3D perspective view of the pipe.
Appendix G Filter Descriptions

Example display of the tensor results as a sequence of image maps where the upper diagonal matrix shows the tensor results of the grid Bm in the lower left corner.

The transfer function $G_{T2Bpq}(k)$ for transforming a grid of total magnetic field intensity TMI measurements to an element $B_{pq}(k) = \Im \left\{ \partial B_p(r) / \partial q \right\}$ of the magnetic gradient tensor (MGT) in the 2D wave number domain is derived from equations for the general phase transformation of a TMI field $B_T(k)$ to a new component $B_p$ along direction $p = (px, py, pz)$ followed by application of the directional derivative filter along a direction $q = (qx, qy, qz)$.

$$G_{T2Bpq}(k) = G_{T2p}(k) G_{qdd}(k) \tag{84}$$

The expression for the general phase transformation operator $G_{T2p}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by the following relation—see for example, Blakely (1995) or Schmidt & Clark (1998, eq. 8):

$$G_{T2p}(k) = (g \cdot p) / (g \cdot f) \quad \text{for} \quad B_T(k;z_0) \rightarrow B_p(k;z_0) \tag{85}$$

where,

$g(k) = (ik_x, ik_y, |k|)$ is the complex gradient vector in the 2D wave number domain

$f = (f_x, f_y, f_z)$ is the unit vector of direction cosines for the local geomagnetic field vector
\(|\mathbf{k}| = (k_x^2 + k_y^2)^{1/2}\) is the modulus of the 2D wave number vector \(\mathbf{k}\).

\(z_0\) is plane of observation of the 2D grid of magnetic potential field data.

In terms of the transformed 2D Hilbert operator \(\mathbf{H}(\mathbf{k}) = \mathbf{g}(\mathbf{k}) / |\mathbf{k}| = (H_x, H_y, 1)\) where \(H_x = ik_x / |\mathbf{k}| \) and \(H_y = ik_y / |\mathbf{k}|\), we have

\[ G_{T2q}(\mathbf{k}) = (\mathbf{H} \cdot \mathbf{p}) / (\mathbf{H} \cdot \mathbf{f}) \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_q(\mathbf{k};z_0) \quad (86) \]

or in terms of \(\Theta_f\) and \(\Theta_p\) where \(\Theta_f = \mathbf{H} \cdot \mathbf{f}\) and \(\Theta_p = \mathbf{H} \cdot \mathbf{p}\), we have

\[ G_{T2q}(\mathbf{k}) = \Theta_p / \Theta_f \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_p(\mathbf{k};z_0) \quad (87) \]

Here it is noted that the \(\mathbf{k}\) dependence of the \(\mathbf{g}\) and \(\mathbf{H}\) complex vector quantities although not shown is implicit in all expressions involving these quantities. The filter function \(G_{T2q}(\mathbf{k})\) in equations (85)–(87) are identical to equations (58)–(60).

The transfer function \(G_{qdd}(\mathbf{k})\) for calculating the directional derivative \((\partial / \partial q)\) of field component \(B_p\) along a specified direction \(\mathbf{q} = (q_x, q_y, q_z)\) is:

\[ G_{T2q}(\mathbf{k}) = (\mathbf{g} \cdot \mathbf{q}) \quad \text{for} \quad B_q(\mathbf{k};z_0) \rightarrow \partial B_p(\mathbf{k};z_0) / \partial q = B_{pq}(\mathbf{k};z_0) \quad (88) \]

Hence from equations (84), (87) and (88), the transfer function \(G_{T2Bpq}(\mathbf{k})\) for transforming a grid of TMI measurements \(B_t(\mathbf{k};z_0)\) to a grid of magnetic gradient tensor measurements \(B_{pq}(\mathbf{k};z_0) = \partial B_p / \partial q(\mathbf{k};z_0)\) may be expressed:

\[ G_{T2Bpq}(\mathbf{k}) = (\mathbf{g} \cdot \mathbf{q}) \; (\mathbf{g} \cdot \mathbf{p}) / (\mathbf{g} \cdot f) = (\mathbf{g} \cdot \mathbf{q}) \{\Theta_p / \Theta_f\} \quad (89) \]

The expression in equation is completely general and applies to any tensor element \(B_{pq}(\mathbf{k};z_0) = B_{qp}(\mathbf{k};z_0)\). Some special cases where \(p\) and \(q\) are along the \(x,y,z\) survey directions are now outlined.

The \(B_T(\mathbf{k})\) to \(B_{pq}(\mathbf{k})\) MGT Transformation Filters

For the \(x\) field component and \(x\) directional derivative, we have that \(\mathbf{p} = (1,0,0) = q\). Therefore from the general expression in equation (89), we have that \(\Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = ik_x / |\mathbf{k}|\) and \((\mathbf{g} \cdot \mathbf{q}) = ik_x\), so that the kernel function \(G_{T2Bxx}(\mathbf{k})\) for the transformation from \(B_T(\mathbf{k})\) to \(B_{xx}(\mathbf{k})\) is:

\[ G_{T2Bxx}(\mathbf{k}) = -[k_x^2 / |\mathbf{k}|] \Theta_f^{-1} \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{xx}(\mathbf{k};z_0) \quad (90) \]

Similarly for the \(x\) field component and \(y\) directional derivative, we have that \(\mathbf{p} = (1,0,0)\); \(\mathbf{q} = (0,1,0)\); \(\Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = ik_x / |\mathbf{k}|\) and \((\mathbf{g} \cdot \mathbf{q}) = ik_y\), so that the kernel function \(G_{T2Bxy}(\mathbf{k})\) for transformation from \(B_T(\mathbf{k})\) to \(B_{xy}(\mathbf{k})\) is:

\[ G_{T2Bxy}(\mathbf{k}) = -[k_xk_y / |\mathbf{k}|] \Theta_f^{-1} \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{xy}(\mathbf{k};z_0) \quad (91) \]

and, interchanging \(x\) and \(y\) directions, we see that the transformation to \(B_{yx}(\mathbf{k})\) is identical to \(B_{xy}(\mathbf{k})\):

\[ G_{T2Byx}(\mathbf{k}) = -[k_yk_x / |\mathbf{k}|] \Theta_f^{-1} = -[k_xk_y / |\mathbf{k}|] \Theta_f^{-1} \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{yx}(\mathbf{k};z_0) \quad (92) \]
Similarly for the \(x\) field component and \(z\) directional derivative, we have that

\[ p = (1, 0, 0); \quad q = (0, 0, 1); \quad \Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = ik_x/|\mathbf{k}| \quad \text{and} \quad (\mathbf{g} \cdot \mathbf{q}) = |\mathbf{k}|, \]

so that the kernel function \(G_{T2Bxz}(\mathbf{k})\) for transformation from \(B_T(\mathbf{k})\) to \(B_{xz}(\mathbf{k})\) is:

\[
G_{T2Bxz}(\mathbf{k}) = [ik_x/|\mathbf{k}|] \Theta_z^{-1} = ik_x/\Theta_z \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{xz}(\mathbf{k};z_0) \quad (93)
\]

and, interchanging \(x\) and \(z\) directions, we see that the transformation to \(B_{zx}(\mathbf{k})\) is identical to \(B_{xz}(\mathbf{k})\) in equation (93):

\[
G_{T2Bzx}(\mathbf{k}) = [ik_x/|\mathbf{k}|] \Theta_z^{-1} = ik_x/\Theta_z \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{zx}(\mathbf{k};z_0) \quad (94)
\]

For the \(y\) field component and \(y\) directional derivative, we have that

\[ p = (0, 1, 0); \quad q = (0, 1, 0); \quad \Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = ik_y/|\mathbf{k}| \quad \text{and} \quad \Theta_q = (\mathbf{g} \cdot \mathbf{q}) = i|\mathbf{k}|, \]

so that the kernel function \(G_{T2Byy}(\mathbf{k})\) for transformation from \(B_T(\mathbf{k})\) to \(B_{zy}(\mathbf{k})\) is:

\[
G_{T2Byy}(\mathbf{k}) = -[k_y^2/|\mathbf{k}|] \Theta_y^{-1} \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{yy}(\mathbf{k};z_0) \quad (95)
\]

Similarly for the \(y\) field component and \(z\) directional derivative, we have that

\[ p = (0, 1, 0); \quad q = (0, 0, 1); \quad \Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = ik_y/|\mathbf{k}| \quad \text{and} \quad \Theta_q = (\mathbf{g} \cdot \mathbf{q}) = |\mathbf{k}|, \]

so that the kernel function \(G_{T2Byz}(\mathbf{k})\) for transformation from \(B_T(\mathbf{k})\) to \(B_{yz}(\mathbf{k})\) is:

\[
G_{T2Byz}(\mathbf{k}) = [ik_y/|\mathbf{k}|] \Theta_z^{-1} = ik_y/\Theta_z \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{yz}(\mathbf{k};z_0) \quad (96)
\]

and, interchanging \(y\) and \(z\) directions, we see that the transformation to \(B_{zy}(\mathbf{k})\) is identical to \(B_{yz}(\mathbf{k})\):

\[
G_{T2Bzy}(\mathbf{k}) = [ik_y/|\mathbf{k}|] \Theta_z^{-1} = ik_y/\Theta_z \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{zy}(\mathbf{k};z_0) \quad (97)
\]

For the \(z\) field component and \(z\) directional derivative, we have that

\[ p = (0, 0, 1); \quad q = (0, 0, 1); \quad \Theta_p = (\mathbf{g} \cdot \mathbf{p}) / |\mathbf{k}| = |\mathbf{k}| / |\mathbf{k}| = 1 \quad \text{and} \quad \Theta_q = (\mathbf{g} \cdot \mathbf{q}) = |\mathbf{k}|, \]

so that the kernel function \(G_{T2Bzz}(\mathbf{k})\) for transformation from \(B_T(\mathbf{k})\) to \(B_{zz}(\mathbf{k})\) is:

\[
G_{T2Bzz}(\mathbf{k}) = |\mathbf{k}|/\Theta_z \quad \text{for} \quad B_T(\mathbf{k};z_0) \rightarrow B_{zz}(\mathbf{k};z_0) \quad (98)
\]

The FFT Filters for Transforming Grids of Gravity Measurements \(g_z(\mathbf{k})\) to Any Element of the Gravity Gradient Tensor (GGT)

The gravity tensor transformation is useful for the conversion of a gravity survey grid to a tensor to see what it looks like as a tensor or for testing different geological models to determine their response characteristics of a gravity gradiometer survey.

The expression for the transformation of the gravitational scalar potential \(U(\mathbf{k})\) to the gravitational field vector \(g(\mathbf{k})\) in the 2D wave number domain \(\mathbf{k} = (k_x, k_y)\) is given by the relation (Blakely 1995, ch. 12, p. 327, eq. 12.20):
\[ g(\mathbf{k}) = \mathbf{S}(g(\mathbf{r})) = \mathbf{S}(\nabla U(\mathbf{r})) = (i k_x, i k_y, |\mathbf{k}|) \mathbf{S}(U(\mathbf{r})) \]
\[ = \mathbf{h}(\mathbf{k}) \mathbf{S}(U(\mathbf{r})) = \mathbf{h}(\mathbf{k}) U(\mathbf{k}) \] \hspace{1cm} (99)

where,
\[ \mathbf{h}(\mathbf{k}) = (i k_x, i k_y, |\mathbf{k}|) \] is the complex gradient vector in the 2D wave number domain
\[ |\mathbf{k}| = (k_x^2 + k_y^2)^{1/2} \] is the modulus of the 2D wave number vector
\[ U(\mathbf{k}) = \mathbf{S}(U(\mathbf{r})) \] denotes the 2D Fourier transform of the scalar potential field \( U(\mathbf{r}) \)
\[ g(\mathbf{r}) = \nabla U(\mathbf{r}) \] is the gradient of the scalar potential \( U(\mathbf{r}) \), i.e.
\[ g(\mathbf{r}) = [u_x \partial U(\mathbf{r}) / \partial x + u_y \partial U(\mathbf{r}) / \partial y + u_z \partial U(\mathbf{r}) / \partial z], \] which by the derivative theorem for a harmonic potential field is
\[ (i k_x, i k_y, |\mathbf{k}|) \mathbf{S}(U(\mathbf{r})) \] in the 2D wave number domain.
\[ \mathbf{r} = (x, y, z_0) \] is an arbitrary point on the plane of observation \( z = z_0 \).

The expression for a component of the gravitational field \( g_p(\mathbf{k}) \) along an arbitrary direction \( \mathbf{p} = (p_x, p_y, p_z) \) in the 2D wave number domain is derived by taking the directional gradient of the scalar potential \( U(\mathbf{r}) \) (Blakely 1995, ch. 12, p. 327, eq. 12.21)
\[ g_p(\mathbf{k}) = \mathbf{S}(\mathbf{p} \cdot g(\mathbf{r})) = [\mathbf{p} \cdot \mathbf{h}(\mathbf{k})] \mathbf{S}(U(\mathbf{r})) = [\mathbf{p} \cdot \mathbf{h}(\mathbf{k})] U(\mathbf{k}; z_0) \] \hspace{1cm} (100)

Whence the \( x, y, z \) components of the gravitational field are:
\[ g_x(\mathbf{k}) = (ik_x / |\mathbf{k}|) g_z(\mathbf{k}) \] for \( \mathbf{p} = u_x = (1, 0, 0) \) \hspace{1cm} (101)
\[ g_y(\mathbf{k}) = (ik_y / |\mathbf{k}|) g_z(\mathbf{k}) \] for \( \mathbf{p} = u_y = (0, 1, 0) \) \hspace{1cm} (102)
\[ g_z(\mathbf{k}) = |\mathbf{k}| U(\mathbf{k}; z_0) \] for \( \mathbf{p} = u_z = (0, 0, 1) \) \hspace{1cm} (103)

From equation (103) we deduce that \( U(\mathbf{k}) = g_z(\mathbf{k}) / |\mathbf{k}| \), and on substitution of this expression into equations (101) and (102) we find that (omitting the \( z_0 \) dependence which is implicit)
\[ g_x(\mathbf{k}) = (ik_x / |\mathbf{k}|) g_z(\mathbf{k}) = H_{gz2x}(\mathbf{k}) g_z(\mathbf{k}) \] for \( H_{gz2x}(\mathbf{k}) = ik_x / |\mathbf{k}| \) \hspace{1cm} (104)

and
\[ g_y(\mathbf{k}) = (ik_y / |\mathbf{k}|) g_z(\mathbf{k}) = H_{gz2y}(\mathbf{k}) g_y(\mathbf{k}) \] for \( H_{gz2y}(\mathbf{k}) = ik_y / |\mathbf{k}| \) \hspace{1cm} (105)

First, to transform a grid of gravity data observations \( g_z(\mathbf{k}) \) to each of the three elements \( G_{xx}(\mathbf{k}), G_{xy}(\mathbf{k}), G_{xz}(\mathbf{k}) \) in row 1 of the gravity gradient tensor, we take the \( x, y, z \) directional derivatives respectively of the \( g_x(\mathbf{k}) \) component of the gravitational field in equation (104):
\[ G_{xx}(\mathbf{k}) = \partial g_x(\mathbf{k}) / \partial x = (ik_x) [ik_x / |\mathbf{k}|] g_z(\mathbf{k}) \]
\[ = -[k_x^2 / |\mathbf{k}|] g_z(\mathbf{k}) \] \hspace{1cm} (106)
\[ G_{xy}(\mathbf{k}) = \partial g_x(\mathbf{k}) / \partial y = (ik_y) [ik_x / |\mathbf{k}|] g_z(\mathbf{k}) \]
\[ = -[k_x k_y / |\mathbf{k}|] g_z(\mathbf{k}) \] \hspace{1cm} (107)


\[ G_{xz}(k) = \frac{\partial g_x(k)}{\partial z} = ik \frac{|k_x/|k||}{g_z(k)} \]

(108)

Second, to transform a grid of gravity data observations \(g_z(k)\) to each of the three elements \(G_{yx}(k), G_{yy}(k), G_{yz}(k)\) in row 2 of the gravity gradient tensor, we take the \(x, y, z\) directional derivatives respectively of the \(g_y(k)\) component of the gravitational field in equation (105):

\[ G_{yx}(k) = \frac{\partial g_y(k)}{\partial x} = (ik_x) \frac{|k_y/|k||}{g_z(k)} \]

(109)

\[ G_{yy}(k) = \frac{\partial g_y(k)}{\partial y} = (ik_y) \frac{|k_y/|k||}{g_z(k)} \]

(110)

\[ G_{yz}(k) = \frac{\partial g_y(k)}{\partial z} = \frac{|k|}{|k|} \frac{|k_y/|k||}{g_z(k)} \]

(111)

Third, to transform a grid of gravity data observations \(g_z(k)\) to each of the three elements \(G_{zx}(k), G_{zy}(k), G_{zz}(k)\) in row 3 of the gravity gradient tensor, we take the \(x, y, z\) directional derivatives respectively of the \(g_z(k)\) component of the gravitational field:

\[ G_{zx}(k) = \frac{\partial g_z(k)}{\partial x} = ik_x g_z(k) = G_{xz}(k) \]

(112)

\[ G_{zy}(k) = \frac{\partial g_z(k)}{\partial y} = ik_y g_z(k) = G_{yz}(k) \]

(113)

\[ G_{zz}(k) = \frac{\partial g_z(k)}{\partial z} = |k| g_z(k) \]

(114)

By inspection, it is evident that the gravity gradient tensor \(G(k)\) is symmetric, i.e.

\[ G_{ij}(k) = G_{ji}(k) \text{ for } i \neq j = x, y, z \]

Furthermore, the trace of the tensor \(G(k)\) is zero since

\[ G_{xx}(k) + G_{yy}(k) + G_{zz}(k) = 0 \]

namely,

\[ G_{xx}(k) + G_{yy}(k) = -\frac{|k_x^2/|k|| + k_y^2/|k||}{g_z(k)} \]

\[ = -\frac{|k|^2/|k||}{g_z(k)} \]

\[ = -|k| g_z(k) = -G_{zz}(k) \]

(115)

This is in keeping with the fact that the gravity potential \(U(r)\) and its derivatives are harmonic potential field functions and that \(U(r)\) satisfies Laplace's equation, i.e.

\[ \Im \{ \nabla U(r) \} = \Im \{ \nabla \cdot \nabla U(r) \} \]

\[ = \Im \{ \nabla \cdot \nabla (\nabla U(r)/\partial x^2 + \nabla U(r)/\partial y^2 + \nabla U(r)/\partial z^2) \} = 0 \]

or

\[ \Im \{ \nabla U(r) \} = \Im \{ \nabla \cdot g(r) \} \]

\[ = \Im \{ \partial g_x/\partial x \} + \Im \{ \partial g_y/\partial y \} + \Im \{ \partial g_z/\partial z \} = 0 \]

\[ = G_{xx}(k) + G_{yy}(k) + G_{zz}(k) = 0 \]

(116)
Finally by inspection of equations (106) to (114), the filter functions for the \( g_z(k) \) to \( G_{ij}(k) \) transformations are as follows:

\[
\begin{align*}
H_{Gxx}(k) &= -k_x^2 / |k| \\
H_{Gxy}(k) &= -k_x k_y / |k| \\
H_{Gxz}(k) &= i k_x \\
H_{GYx}(k) &= -k_x k_y / |k| \\
H_{GYy}(k) &= -k_y^2 / |k| \\
H_{GYz}(k) &= i k_y \\
H_{Gzx}(k) &= i k_x \\
H_{Gzy}(k) &= i k_y \\
H_{Gxz}(k) &= |k| 
\end{align*}
\]

\( (117) - (119) \)

\( (120) - (122) \)

\( (123) - (125) \)

**FFT TMI Reduction to the Pole (Low Latitude) Processing**

In addition to the standard RTP filter provided for Reduction-To-the-Pole processing (see above), an additional filter specifically for use with magnetic data acquired at low magnetic latitudes is provided. This FFT filter uses analytic signal computation to calculate simplified responses from magnetic data acquired at magnetic latitudes less than approximately 30° of inclination. As the analytic signal computation produces response maxima over magnetic contacts irrespective of the direction of magnetisation, this can be used to assist the processing of observed magnetic data acquired near the magnetic equator.

The formulation used for the low latitude computation is described in *Low Latitude Processing Theory*.

The Low Latitude filter dialog appears as below. Operation of the filter computes both a phase and an amplitude component. A compensation applied to the phase component can be used to prevent the amplitude increasing and causing the equation to become unstable. This instability is primarily due to any anomalies oriented north-south within the observed data.

The Minimum angle factor defaults to a value of 20° but in the filter’s implementation, if it specified less than the data’s inclination (I), then the Minimum angle correction is reset to the value of 20° to maintain stability.
Use the IGRF calculator to automatically assign the Declination and Inclination. A default Minimum angle of 20° is assigned.

The effect of changing the Minimum angle factor alters the relative sizes of the phase and amplitude. If the factor is increased (to a maximum of 90°), the phase component increases and amplitude adjustment is reduced (to be zero at 90°). If the correction factor is reduced, the phase and amplitude components become evenly applied.

**Low Latitude Processing Theory**

The Reduction-To-the-Pole (RTP) filter is used to transform a grid of total magnetic field intensity measurements to a grid of magnetic intensity measurements that would be observed at the north magnetic pole. The expression for the RTP transform operator $G_{\text{RTP}}(k)$ at a point $k = (k_x, k_y)$ in the 2D wave number domain is given by Gibert and Guillamin (1985) and Blakely (1995) as follows:

$$G_{\text{RTP}}(k) = \frac{|k|^2}{(g \cdot f) (g \cdot m)}$$  \hspace{1cm} (126)

where

$g = (ik_x, ik_y, |k|)$ is the complex gradient vector in the 2D wave number domain

$f = (f_x, f_y, f_z)$ is the unit vector of direction cosines for the local geomagnetic field vector

$m = (m_x, m_y, m_z)$ is the unit vector of direction cosines for the resultant magnetisation vector.

Here it is noted that the direction cosines are measured using the International Geomagnetic Reference Field (IGRF) coordinate system, namely, x-north; y-east, z-vertically down. Furthermore, it is possible to express the RTP transfer function in terms of the transformed 2D Hilbert operators $H_x(k)$, $H_y(k)$ (Nabighan 1983) in the $k = (k_x, k_y)$ wave number domain, namely,
\[
H_x(k) = ik_x/|k| = i \cos \alpha(k)
\]
\[
H_y(k) = ik_y/|k| = i \sin \alpha(k)
\] (127)

where \(\alpha(k)\) is the horizontal azimuth of a point \(k = (k_x, k_y)\) in the 2D wave number domain,

\[
\alpha(k) = \arctan k_y/k_x
\] (128)

Then after putting \(H = g/|k| = (H_x, H_y, 1)\), we have omitting the \(k\) dependence of \(H(k)\), \(H_x(k)\) and \(H_y(k)\) from now on

\[
G_{\text{RTP}}(k) = 1/[(H \cdot f)(H \cdot m)]
\] (129)

Or, after putting \(\Theta_f = H \cdot f\) and \(\Theta_m = H \cdot m\), we have in the notation of Blakely (1995, ch. 12) and omitting the \(k\) dependence of \(\Theta_f(k)\) and \(\Theta_m(k)\) from now on

\[
G_{\text{RTP}}(k) = 1/[(\Theta_f \Theta_m)]
\] (130)

Whence for the induced magnetisation case in which the direction cosines \(m\) of the resultant magnetisation vector are identical to the direction cosines \(f\) of the ambient geomagnetic field, then equation (130) becomes:

\[
G_{\text{RTP}}(k) = 1/\Theta_f^2
\] (131)

Or, noting that \(\Theta_f = H \cdot f\) is a complex quantity with complex conjugate \(\Theta_f^*\) then it maybe shown that \([\Theta_f^*]^2 = [\Theta_f^*]^2 = (H \cdot f)^2\). Hence multiplying the numerator and denominator by \([\Theta_f^*]^2\) and noting that \(|\Theta_f| = |\Theta_f^*| = |\Theta_f| = (\Theta_f^2)\): \[\Theta_f^*\] :

\[
G_{\text{RTP}}(k) = [\Theta_f^2]^*/[\Theta_f]^4 = [\Theta_f^*]^2/|\Theta_f|^4
\] (132)

The direction cosines \(f\) of the geomagnetic field \(F\) are given by:

\[
f = (f_x, f_y, f_z) = (\cos I_f \cos D_f, \cos I_f \cos D_f, \sin I_f)
\] (133)

where \(D_f\) is the declination of the geomagnetic field and \(I_f\) is its inclination. Now if we expand the expression for \(\Theta_f\) we have,

\[
\Theta_f = H \cdot f = [f_x + H_x f_x + H_y f_y]
\] (134)

or

\[
\Theta_f = H \cdot f = [\sin I_f + \cos I_f [H_x \cos D_f + H_y \sin D_f]]
\] (135)

And, after substitution for \(H_x\) and \(H_y\) from equation (127) above, we have

\[
\Theta_f = H \cdot f = [\sin I_f + i \cos I_f [\cos \alpha \cos D_f + \sin \alpha \sin D_f]]
\]

Hence, it is easily shown that

\[
\Theta_f = H \cdot f = [\sin I_f + i \cos I_f \cos (D_f - \alpha)]
\] (136)

and

\[
|\Theta_f|^4 = (\Theta_f \Theta_f^*)^2 = [\sin^2 I_f + \cos^2 I_f \cos^2 (D_f - \alpha)]^2
\] (137)
From equations (136) and (137), it is easily deduced that the transfer function for reduction to
the pole \( G_{\text{tp}}(k) \) in a zero inclination geomagnetic field is given by the relation,

\[
G_{\text{tp}}(k) = \frac{[\Theta_f^*]^2}{|\Theta_f|^4} = \frac{1}{\cos^2(D_f - \alpha)} \text{ for } |\xi_f| = 0 \quad (138)
\]

Therefore if the angle \(|D_f - \alpha|\) is an odd multiple of \(\pi/2\) such that \(\cos(D_f - \alpha)\) is zero, then
\( G_{\text{tp}}(k) \) will become infinitely large. Even at low geomagnetic latitudes (say \(0^\circ < |\xi_f| < 20^\circ\)) there is very significant directionally selective amplification of any noise present within a
grid of total magnetic intensity measurements—see for example, Blakely (1995), Silva (1989),
and Hansen & Pawlowski (1989). This amplification has the effect of producing short
wavelength artifacts which trend parallel to the direction of the declination \(D_f\) (Blakely 1995).

One means of overcoming this difficulty is to retain the phase information in the numerator term 
\([\Theta_f^*]^2\) above but make a modification to the denominator \(|\Theta_f|^4\) in equation (137 etc.) which
prevents it from becoming too large. This may be achieved by introducing a second inclination
angle \(I'_f\), (referred to as the minimum angle factor) as follows—see for example, McLeod et
al. (1993):

\[
G_{\text{tp}}(k) = \frac{[\Theta_f^*]^2}{|\Theta_f|^2 |\Theta_f'|^2} \text{ ; for } |\xi_f| < I'_f \quad (139)
\]

where

\[
\Theta_f = \mathbf{H} \cdot \mathbf{f}' = [\sin I'_f + i \cos I'_f \cos(D_f - \alpha)] \text{ for } |\xi_f| < I'_f \quad (140)
\]

Whence from equations (137), (139) and (140), the modified expression for the reduction to
the pole operator at low latitudes, i.e. for \(|\xi_f| < I'_f\), is given by,

\[
G_{\text{tp}}(k) = \frac{[\sin I_f - i \cos I_f \cos(D_f - \alpha)]^2}{[\sin I_f + \cos^2 I_f \cos^2(D_f - \alpha)][\sin^2 I_f + \cos^2 I_f \cos^2(D_f - \alpha)]}
\]

Aspects of Numerical Computation

In most cases, magnetic survey data will consist of raw total magnetic intensity (TMI)
measurements \(B_m(x_i, y_j; z_0)\) which have been interpolated over a two-dimensional grid \(1 \leq i \leq n_x, 1 \leq j \leq n_y\). Therefore, in order to calculate the magnetic moments using Helbig’s
method, calculate the anomalous magnetic field components \(\Delta B_x(x_i, y_j; z_0)\),
\(\Delta B_y(x_i, y_j; z_0)\), \(\Delta B_z(x_i, y_j; z_0)\) from the original TMI data. This involves several steps
namely:

1. Anomaly isolation.
2. Removal of a constant background field \(B_p(x_i, y_j; z_0)\) from the original TMI data
   \(B_m(x_i, y_j; z_0)\) to reveal the raw total magnetic field anomaly \(\Delta B_{\text{raw}}(x_i, y_j; z_0)\), i.e.
   \(\Delta B_{\text{raw}}(x_i, y_j; z_0) = B_m(x_i, y_j; z_0) - B_p(x_i, y_j; z_0)\).
3. Computation of a regional field \(\Delta B_{\text{reg}}(x_i, y_j; z_0)\) for the raw anomalous total field
   \(\Delta B_{\text{raw}}(x_i, y_j; z_0)\) over the area of interest.
4. Removal of the computed regional field \(\Delta B_{\text{reg}}(x_i, y_j; z_0)\) from raw anomalous total
   field \(\Delta B_{\text{raw}}(x_i, y_j; z_0)\) to reveal the final corrected total magnetic field anomaly
   \(\Delta B_{\text{cor}}(x_i, y_j; z_0)\), i.e.
5. Pad the grid of corrected total magnetic field anomaly measurements \( \Delta B_{cor}(x_i, y_j; z_0) \) ready for 2D Fourier transformation [new grid size is \( N_x \times N_y \)].

6. Fourier transform the corrected anomalous TMI grid \( \Delta B_{cor}(x_i, y_j; z_0) \) and keep a copy of it [see equation (34) for the 2D discrete Fourier Transform above].

7. Apply the \( B_x(k) \) to \( B_x(k) \) (x-north) transformation filter \( G_{T2x}(k) \) to the Fourier transformed TMI grid, namely, compute
   
   \[
   \Delta B_x(k) = G_{T2x}(k) \Delta B_x(k), \quad \text{where the filter function } G_{T2x}(k) \text{ is}
   \]
   
   \[
   G_{T2x}(k) = i k_x / (g \cdot f) = H_x / (H \cdot f) = H_x / \Theta_f.
   \]

   Apply the \( B_y(k) \) to \( B_y(k) \) (y-east) transformation filter \( G_{T2y}(k) \) to the Fourier transformed TMI grid, namely, compute
   
   \[
   \Delta B_y(k) = G_{T2y}(k) \Delta B_y(k), \quad \text{where the filter function } G_{T2y}(k) \text{ is}
   \]
   
   \[
   G_{T2y}(k) = i k_y / (g \cdot f) = H_y / (H \cdot f) = H_y / \Theta_f.
   \]

   Apply the \( B_z(k) \) to \( B_z(k) \) (z-down) transformation filter \( G_{T2z}(k) \) to the Fourier transformed TMI grid, namely, compute
   
   \[
   \Delta B_z(k) = G_{T2z}(k) \Delta B_z(k), \quad \text{where the filter function } G_{T2z}(k) \text{ is}
   \]
   
   \[
   G_{T2z}(k) = |k| / (g \cdot f) = 1 / (H \cdot f) = 1 / \Theta_f.
   \]

8. Apply the inverse 2D Fourier transform to each of the three transformed grids of magnetic component data, namely, \( \Delta B_x(k) \), \( \Delta B_y(k) \), \( \Delta B_z(k) \) in the x-north, y-east, z-down directions respectively.

9. Extract the real component parts of the inverse Fourier transformed grid scaled by the size of the padded grid, i.e. by the factor \( 1 / (N_x \times N_y) \). Importantly the extracted grids containing the anomalous magnetic field components \( \Delta B_x(x_i, y_j; z_0) \), \( \Delta B_y(x_i, y_j; z_0) \), \( \Delta B_z(x_i, y_j; z_0) \) should exactly equivalent in size and location to the original and corrected TMI grids, e.g. \( \Delta B_{cor}(x_i, y_j; z_0) \).

10. Remove any DC trends from the \( \Delta B_x(x_i, y_j; z_0) \), \( \Delta B_y(x_i, y_j; z_0) \), \( \Delta B_z(x_i, y_j; z_0) \) grids This is to ensure that the zero order moments of the \( \Delta B_x(x_i, y_j; z_0) \), \( \Delta B_y(x_i, y_j; z_0) \) and \( \Delta B_z(x_i, y_j; z_0) \) field components are zero (see Helbig, 1963). The data are now ready for magnetic moment computation.
Computation of the Magnetic Moments

The magnetic moments method is used by the remanence calculator tool. In order to calculate the magnetic moments using Helbig’s method, replace the continuous double integrals in equations (72) to (75) with their discrete equivalents. This involves numerical integration of the anomalous magnetic field components $\Delta B_x(x_i, y_j; z_0)$, $\Delta B_y(x_i, y_j; z_0)$, $\Delta B_z(x_i, y_j; z_0)$ defined over the two-dimensional grid $1 \leq i \leq n_x$, $1 \leq j \leq n_y$. Here it is assumed that the anomaly of interest is quite compact and isolated. Furthermore, it assumes that the anomalous field components have been sufficiently closely sampled over a wide enough area of interest so that the first order moments can be accurately determined. A number of tests can be conducted to ensure this is approximately true. First the zero order moments of $\Delta B_x(x_i, y_j; z_0)$, $\Delta B_y(x_i, y_j; z_0)$ and $\Delta B_z(x_i, y_j; z_0)$ should be approximately zero as should the two cross moments $M_x, M_y$ and $M_y, M_z$ in equations (76) and (77) respectively. The double integrals in equations (72) to (77) may be each be evaluated numerically using a double application of the extended Simpson’s Rule, closed 1D formula (Press et al. 1992, ch. 4, pp. 127–129, eq. 4.1.13) in the x and y grid directions. For the x grid direction then:

$$\int_{x_n} f(x) dx = h \left[ \frac{1}{3} f_1 + \frac{4}{3} f_2 + \frac{2}{3} f_3 + \frac{4}{3} f_4 + \ldots \right. $$

$$\left. \left. \ldots + \frac{4}{3} f_{n-2} + \frac{4}{3} f_{n-1} + \frac{1}{3} f_n \right] + O([x_n - x_1]^5 f^{\prime\prime\prime\prime}) \right)$$

where $f^{\prime\prime\prime\prime}$ indicates the fourth derivative of the function $f(x)$.

Once the numerical integrals corresponding to those in equations (72) to (77) have been computed the $M_x, M_y, M_z$ components of the magnetic moment may be calculated. The $M_z$ magnetic moment is best computed using equation (78). The total magnetic moment $M_\theta$, its declination $D_\theta$ and inclination $I_\theta$ are calculated using equations (80) to (83). The declination and inclination are equivalent to the average values for the source body magnetisation. The computed value of the magnetic moment may be increasingly underestimated as the grid size becomes progressively smaller. Schmidt & Clark (1998) have attempted to compensate for this in their paper (see the correction factors in Table 1).

Low Pass Filter

The FFT Low Pass Filter applies an operator to remove high frequency content with wavelengths above (that is, smaller than the defined wavelength cut-off). The cut-off rate specifies the severity of the filter at its wavelength margins. The higher the cut-off, the greater and the sharper the cut-off effect of removing a particular wavelength cut-off.

High Pass Filter

This FFT filter is the converse of the Low Pass filter. The High Pass filters pass frequencies that are higher than the specified cut-off.

Band Pass Filter

Band Pass filters remove wavelengths that lie between two specified wavelength limits. A common cut-off is applied for both the high and low ranges of the wavelengths. Applying a simple cutoff filter to an energy spectrum (such as a Band Pass filter) almost invariably introduces a significant amount of ringing (referred to as the Gibbs’ Phenomena).
Directional Pie Slice Filter

The directional filter is used to pass or reject residual scale features with strike in a nominated direction. The drop off with angular response is specified via a half width angle which determines the angle plus or minus from the specified strike where the filter taper is applied in the wave number domain. The degree of taper can also be specified.

Normalised Source Strength

The theory behind the normalised source strength parameter was developed by Clark (2012a,b) and a summary of the principles is presented here. The principles are based on eigenvector analysis of the magnetic gradient tensor $\mathbf{B}$ and are an extension of the work published by Pedersen and Rasmussen (1990). At a measurement point $P(r)$ in source free regions of space, the magnetic gradient tensor $\mathbf{B}(r)$ is derived from the gradient of the magnetic field vector $\mathbf{b}(r) = (b_x, b_y, b_z)$:

$$
\mathbf{B}(r) = \begin{bmatrix}
B_{xx} & B_{xy} & B_{xz} \\
B_{yx} & B_{yy} & B_{yz} \\
B_{zx} & B_{zy} & B_{zz}
\end{bmatrix} = \begin{bmatrix}
\frac{\partial b_x}{\partial x} & \frac{\partial b_x}{\partial y} & \frac{\partial b_x}{\partial z} \\
\frac{\partial b_y}{\partial x} & \frac{\partial b_y}{\partial y} & \frac{\partial b_y}{\partial z} \\
\frac{\partial b_z}{\partial x} & \frac{\partial b_z}{\partial y} & \frac{\partial b_z}{\partial z}
\end{bmatrix}
$$

Since $\mathbf{B}$ is a real symmetric $3 \times 3$ matrix, all its eigenvalues $(\lambda_1, \lambda_2, \lambda_3)$ are real; its eigenvectors corresponding to distinct eigenvalues are orthogonal, and an orthonormal set of three eigenvectors can always be found (Clark, 2012a,b).

The canonical or rotationally invariant parameters $I_1$ and $I_2$ are given by Pedersen and Rasmussen (1990) and Clark (2012b) as,

$$I_1 = B_{yy}B_{zz} + B_{xx}B_{yy} + B_{zz}B_{xx} - B_{xy}^2 - B_{yz}^2 - B_{zx}^2 = \lambda_1 \lambda_2 + \lambda_2 \lambda_3 + \lambda_3 \lambda_1$$

$$I_2 = \text{det} \mathbf{B} = \lambda_1 \lambda_2 \lambda_3 = B_{xx}B_{yy}B_{zz} - B_{xx}B_{yz}^2 - B_{yy}B_{xz}^2 - B_{zz}B_{xy}^2 + 2B_{xy}B_{yz}B_{zx}
$$

The normalised source strength parameter $\mu$ is defined by Clark (2012b) as,

$$\mu = \sqrt{-\lambda_2^2 - \lambda_1 \lambda_3} \quad \lambda_1 > \lambda_2 > \lambda_3$$

The phi or co-inclination angle $\phi$ is given by Beiki et al (2012) and Clark (2012b) as

$$\cos \phi = \frac{\lambda_2}{\mu} \quad \text{or} \quad \phi = \cos^{-1} \left( \frac{\lambda_2}{\mu} \right) \quad (0 < \phi < \pi)$$

where $\lambda_2$ is the second or intermediate eigenvalue.

Importantly over the point $P(r)$ of maximum $\mu$ the co-inclination angle of resultant magnetisation $I'_{\text{res}}$ is given by

$$I'_{\text{res}} = \phi(r) = \cos^{-1} \left( \frac{\lambda_2(r)}{\mu_{\text{max}}} \right) \quad (0 < \phi < \pi)$$

So that the inclination angle $I_{\text{res}}$ is
Here it is noted that the co-inclination angle \( I_{\text{res}} \) exceeds 90° for resultant magnetisations in the northern hemisphere and is below 90° for resultant magnetisations in the southern hemisphere. Also the azimuth of the line joining the point where \( \mu \) is at a maximum to the point where \( \mu \) is at a minimum yields the declination of resultant magnetisation \( D_{\text{res}} \). By inspection of the figure for the synthetic example above, the direction of resultant magnetisation is \( D_{\text{res}} = 0° \) N and \( I_{\text{res}} = -60° \). For Anomaly A of the Black Hill Norite, the inclination of resultant magnetisation is about 10° which is in agreement with results derived from inversion and Helbig magnetic moment analysis in Foss and McKenzie (2011).

The angle between the magnetisation vector and the vector from the centre of magnetisation to the observation points defines the angle phi. See the following figure from Beiki et al (2012) for a visual specification.

![Image NSS5.png](Image NSS5.png) The co-inclination angle \( \phi \) is defined by the vector from the centre of magnetisation and the observation point and the magnetisation vector (after Beiki, Clark, Austin and Foss, 2012).

When the observation point is aligned with the magnetisation vector, \( \phi \) is at a minimum near zero (repeated see above).

Note that the parameters \( \mu \), and \( \lambda_2 \) can be computed directly during modelling of line data or grids for comparison with the values generated through grid processing.

\[
I_{\text{res}} = \phi(r) - \frac{\pi}{2} = \cos^{-1} \left( \frac{\lambda_2}{\mu_{\text{max}}} \right) - \frac{\pi}{2} \quad (-\pi/2 < I_{\text{res}} < \pi/2)
\]
Back Door Features

Back Door Features allow access to non-standard behaviour in ModelVision where changes in the software have led to the removal of features such as match Average Regionals, or slight variation in operating system behaviour. Do not depend on these features for future support as we may decide to remove them in future releases.

In this section:

- Match Average Regional
- Convert UBC Modeller Models to TKM Models
- Table Mode Priority

Match Average Regional

Match Average adds a constant value to the model output so its average value is the same as the average of the input values. When a subset of points is selected using active point selection, the average is derived from only the active points. When used with multiple lines Match Average does not use the active point selection. It uses the project averages for the field and model channels and adjusts the model results by the difference. This results in an overall shift for the survey retaining the background variation between lines.

To enable this feature, you need to add an entry in the registry under,

HKEY_CURRENT_USER\Software\Encom\ModelVision

as

Match_average = 1 (REG_DWORD).

Convert UBC Modeller Models to TKM Models

ModelVision creates UBC compatible MAG3D and GRAV3D models and it is possible to convert the underlying voxels into ModelVision tabular bodies. This feature is normally disabled as it is not often required and can generate very large models if a fine voxel model is in use at the time.

The feature is activated with a registry setting in the ModelVision section:

UBCTKM = 1 (REG_DWORD).

It is possible to import isosurfaces that have been created from a UBC model via the topology Checker module. Each isosurface is assigned a physical property and the UBC Model Builder can then be used to convert the isosurfaces into a suite of tabular bodies corresponding to each voxel in the UBC model. Regions set to the background property are ignored and no tabular body is created when the property is the same as the background.
Table Mode Priority

Table Mode changes the priority of Layer and Body Tables when windows can pop-up over the top of them. The setting has the attributes of priority and position. If the priority is set to on top, then a warning pop-up could be obscured behind a large table, making it impossible to cancel the pop-up. The position setting can restrict the table to limited to the ModelVision task window (TASKWIN) or anywhere on screen or screens (SCREEN).

To enable the feature, set the following entry in the registry under,

HKEY_CURRENT_USER\Software\Encom\ModelVision

as

table_mode = 0 SCREEN and on top (REG_DWORD)
table_mode = 1 SCREEN and not on top
table_mode = 2 TASKWIN and on top
table_mode = 3 TASKWIN and not on top.
Bibliography


Shuey, RT & Pasquale, AS 1973, “End corrections in magnetic profile interpretation”, 

Silva, JBC 1986, “Reduction to the pole as an inverse problem and its application to low-


Singleton, R 1969, “An algorithm for computing the mixed radix fast forward Fourier transform 
IEEE trans audio and electroacoustics”, AU-17, 2, p. 93.

Skilberi, JR 1993, “The straight slope method for basement depth determination revisited”, 
*Geophysics* 58(4), pp. 593–595.

Talwani, M & Ewing, M 1960, “Rapid computation of gravitational attraction of three-
dimensional bodies of arbitrary shape”, *Geophysics*, 25, pp. 203–225


Thompson, DT “EULDPH: A new technique for making computer-assisted depth estimates 

Tough, JG 1988, “Computation of the centroid of polygonal bodies”, *Computers and 
Geoscience*, 14, no.5, pp. 715–717

Werner, S 1953, “Interpretation of magnetic anomalies at sheet-like bodies”, *Sveriges 
Geologiska Undersok Series CC Arsbok* 43, N:06.

Wilson, H,1985. “Analysis of the magnetic gradient tensor”, *Defence Research Establishment, 
Pacific, Canada, Technical Memorandum*, 85–13, 47.

Won, IJ & Bevis, MG 1987, “Computing the gravitational and magnetic anomalies due to a 

sources”, in CE Baum, ed, “Detection and identification of visually obscured targets”, *Taylor 
Acknowledgements

ModelVision software is developed and supported by:

Tensor Research Pty Ltd.
PO Box 5189
Greenwich NSW 2065
www.tensor-research.com.au
support@tensor-research.com.au

ModelVision development team:

Design and Testing: D Pratt, K Parfrey
Development and Maintenance: A White
Algorithm Development: B Mackenzie
Index

Numerics
2D convolution filters 348
   polygon description 478, 480
2D convolution
   filter options 530
3D cursor 114
3D Model Generator 210
   Toolbar button 23
3D point
   displays 121
3D visualization 1

A
About
   File option 19
active
   windows 8
Active Line
   cross-section view 243
      Toolbar 243
         Toolbar button 243
Active Lines button 260
Active Lines toolbar 260
Active Points 231
   Toolbar button 244
active region
   in tutorial 231
Add Label
   push button on body dialogs 149
additional
   curves option for X-sections 196
AGC
   filter described 342
aliases
   for channel names 454
alignment
   of Layout objects 335
AMIRA
   TEM data format 469
analytic signal computation 556
   angle
      of text in the Layout window 334
annual support 12
anticlines
   modelling of 478
Apply Attributes
   tool in Layout toolbar 333
Apply Filter
   operation of 339
artificial drillholes 194
ASC
ER Mapper single traverse file extension 464
ASCII
   file import 28
ASEG
   GXF grid format 474
aspect ratio
   of Layout windows 328
Associated Channels
   items of the Body Configuration dialog 197
Auto Recompute setting 261
AutoCAD digital exchange format (DXF) 32
AutoMag
   introduction 422
      toolbar usage 435
AutoMag solutions 120
automatic
   depth source estimation - AutoMag 422
Automatic Gain Control
   filter described 342
average
   filters 348
azimuth
   of 3D polygon 478
      of polygons 169
      of tabular body 169, 481
      of traverse line 243

B
B key
   used to determine body drawing order 148
background
   control parameters in AutoMag 426
      density and enclosed bodies 198
background property
   for UBC modules 397
band pass
   description 340
band-pass
   FFT 343
bodies
   display modes 163
body
   3D polygon 477
      cloning and duplication 147
      definitions 477
      drawn in front - force to rear 148
      editing 148
      ellipsoid 482
      lock property 165
      moving multiple bodies 148
      overlap and selection 149
      parameters 149
      plunging prism 145
selection 148
single or multiple creation 140
sphere 481
spheres, cylinders, ellipsoids 143
tabular 480
tabular type 144
body display
modes explained 163
body editing
and undoing 165
Body Lock
to prevent deletion 165
Body Parameters 176, 220
Body Position 220
Body Table
Sorting bodies 176
Toolbar button 23
body type
option in AutoMag 427
Bring To Front
tool in Layout toolbar 333
Bring to Front
tool usage 335
browse
for reports 380
Browse button 49
for session files 27

C
calculator option 356
cell property
of UBC modules 396
Centroid
of bodies 523
CGS
system of measurement 50, 53
cgs units 50
channel
creation with synthetic data 195
edits, renaming and deletion 36
naming conventions 454
channel maintenance
option described 36
Channel select
AutoMag background control 426, 427
channel select
for filtering 339
Characteristics
button of 2D filters 531
characteristics
of 2D filters 348
clip
a grid 37
option for lines 37
Clip Grid
Toolbar button 38
Clip Output Grid
option 254
Clip Project
Toolbar button 38
Clone
creation of a body 147
Close
project option 26
collar height
of drillhole 195
colour
modulation of AutoMag solutions 434, 445
used for AutoMag coefficients 433, 441
colour mode 116
column
definitions for data 29
naming conventions 454
of drillhole format 471
of multi-line format 465
of point format 470
Component
button 264, 266
Components button 256
compressed
grid format 474
Compression factor
used in strata models 187
Compute
reserved words 357
compute
function 148
operations on grids, data 357
Compute from Data 260
in tutorial 229
Compute from data option 257
Compute Remanence 263
Compute Using Params Below option 259
ComputeDemag
in MVPRO.INI file 500
computer
license transfer 5
various platforms 2
ComputeRemanence
in MVPRO.INI file 500
Configuration pop-up
in perspective 114
Constant Susceptibility
option in AutoMag 427
constraining an inversion
of UBC modules 397
context sensitive help
available 11
continuation
filter - convolution 341
control
of gridding 361
convolution
2D filters 338, 348
advantages 338
filters 337
filters available 338
Index

Convolution filters 349
Copy
   editing option in Layout 325
copyright 4
core and padding regions
   of UBC modules 395
Create
   certain body types in map displays 140
create
   a Layout window 325
Create Strata
dialog 187
   Toolbar button 23
cross-horizontal tensor component 267
crossing
   body outlines 188
cross-section
   model display 72
CTRL
   use to select overlapping bodies 148
Cut
   editing option in Layout 325
Cutoff
   parameter in AutoMag 431
cutoff
   of filters 343

D

data
   channel naming conventions 454
drillhole format 471
   multi-line format 465
point format 470
   single line import 463
   single lines 462
data files
   of UBC modules 398
data maintenance
   option described 35
databases
   accessed by external links 33
   available through external links 485
DataDir
   default data directory 496
Datum
   MVPRO.INI ER Mapper default parameter 501
datum information 54
datum.dat
   datum information 54
decimating 116
decimation
   of grids 361
decimation factor 116
Default
   body presentation 164
default
   background and physical properties 198
   body display mode 164
Delete
   button solutions in AutoMag 434
   Edit menu item in Layout 324
delete
   a channel or line 36
   a polygon vertex on entry 141
   vertices during plunging prism entry 144
demagnetisation
   in MVPRO.INI file 500
demagnetization 1, 263
Density
   in MVPRO.INI file 499
   setting default body value 500
density
   of bodies 149
   units 50
density bounds
   of UBC modules 397
depth
   attributes of AutoMag solutions 433, 445
   for strata bodies 188
   to define 477
Depth (+ve down) option 188
depth analysis 1
depth estimation
   within AutoMag 431
depth extent
   of strata models 187
Depth sorting
   for strata modelling 188
depth to basement
   from AutoMag 422
Descr
   default description for External Link 497
description
   of projects 54
Deselect
   channel option 123
   items on the Speed toolbar 24
design drillholes 194
dialog boxes
   for configuring 8
digitized
   model import 490
dip
   attributes of AutoMag solutions 433, 445
   of tabular body 480
DipMax
   AutoMag default parameter 500
DipMin
   AutoMag default parameter 500
direct targeting workflow 39
direction
   of defining polygon vertices 141
directory
   of project 49
directory tree 49
disk
   storage requirements 3
Display
  button of the Body Configuration dialog 197
display
  body modes 164
  modes for bodies 163
  properties of bodies 163
DIST_ABS
  channel 463
  used in filtering 339
Distance Along Profile
  in tutorial 230
downward continuation
  FFT 344
Draw Profile Region
  in tutorial 231
Drillhole
  statistics 380
  drillhole
    data export 32
    data format 471
    data maintenance 35
    import 29
    specified in import 471
  drillhole data
    used for strata 186
  drillhole parameters 195
  drillholes created 194
  DXF format
    for models 32
Dyke
  body type in AutoMag 427

E
Earth's magnetic field 51
Earth's magnetic field 262
edge detection filters 525
Edit
  menu described 10
  menu items in Layout 324
edit
  bodies which overlap in section 148
  text in the Layout window 334
editing
  by the Layout toolbar 325
editing operations
  and undos 165
elevation 253
  for strata bodies 188
Elevation (+ve up) option 188
ellipsoid
  creation 143
  description of 482
EMU
  system of measurement 50, 53
enclosed
  bodies and modelling 198
Encom
  grid files 472
end faces
  of a polygon body 142
energy spectrum
  description 343
Enquire
  to software using links 485
Enquiry
  default External Link program 497
Eotvos units 50
equation entry 357
ER Mapper
  2D filters 348
  filter kernels 338
  format description 464
  grid formats 473
error
  in computation 358
Error, printing 384
ERS
  ER Mapper grid header 473
Euler
  technique 422
Execute
  external link 488
exercises
  and tutorials 11
expert parameters
  grid option 365
Export
  default External Link program 497
  File option 31
  formats available 31
export
  from external links 485
export models
  in DXF format 32
Extend out
  option in strata 187
extended
  memory use 3
extent
  of grids 365
  of tabular body 481
external
  creating link programs 487
  external link descriptions 485
  links defined in MVISION.INI file 485
external data 28
External Link
  menu option 491
external link
  used for data transfer 33
external links
  exports 33
Extrusion Wizard 211
  Choose Body Properties 214
  Choose Output File 216
  Set Azimuth and Dip 214
  Set Extruded Surface Properties 213
Set Primary Surface Properties 212
extrusion Wizard
Set Appearance 215

F

faces
  at the ends of polygon bodies 142
facet
  of bodies 164
facets
  used to build polyhedra 484
Fast Fourier Transform
description of 343
Faster
drawing option in Layout 331
Feature Maintenance 47
FFT
  see Fast Fourier Transform 343
FFT Filters 349
FFT filters 337
field strength 262
File
  menu described 10
file
  formats and introduction 453
File>License tool 7
File>New>Project menu item 48, 502
File>Profile>General ASCII import 454
Fill Colour
tool in Layout toolbar 333
fill internal holes 352
Filter
  2D introduction 530
filter
  2d types available 348
  band pass 340
  band-pass FFT 343
  examining a 2D convolution operator 348, 531
  FFT high pass 343
  first derivative 340
  fourth difference 341
  gradient types 340
  horizontal derivative FFT 344
  low pass 340
  moving average 341
  operators 338
  square root of second deriv 340
  upward continuation 344
  vertical derivative FFT 344
Filter all lines
  button 339
Filter parameters 350
filter types 526
filtering
  in Grid Filter 348
Filtering of gridded surface data 525
Filters
  roberts cross 529
  filters
    available - convolution 340
    overview 337
  fine detail in data 122
  first derivative
    description 340
  first vertical derivative
    as an In-Line filter 344
Fit
  option of display toolbar 59
Fit Frame to Source Window
  option in Layout 328
Fit Source Window to Frame
  option in Layout 328
Font
tool in Layout toolbar 333
format
  of model files 519
  of multi-line files 462
fourth difference
description 341
Frame
tool in Layout toolbar 333
frame
  bringing into Layout 326
  moving 330
Frame Object 330
Free Parameters
  in tutorial 233
frequency 339
  see Wavelength 339
full gravity tensor 264, 266

G

gamma
  units 50
Gaussian
  filters 348
general ASCII import 455
Generate Lines
  option from grid rows 36
Geopak
  grid format 475
geophysical filters 349
Geosoft
  format description 463
  grid format 474
  links with ModelVision 33
  multi-line files 466
Get Attributes
tool in Layout toolbar 333
Gibbs' Phenomena 561
GINT function 359
graphics
  recommended 3
graphics track 124
GRAV3D
UBC module 387
gravity
  body descriptions 477
Gravity Component
    menu option 264, 266
gravity surveys
  and tensor computation 266
gravity tensor 264, 266
gravity tensor computation 264, 266
gravity tensor measurements 268
GravSD
  error channel 392
grid
  arithmetic computation 357
  controls 361
  create a traverse from 243
  generation of 361
  mesh reduction 366
  modelling using decimation 361
  operations described 366
  smoothing 366
  statistics 380
  traverse creation from rows 36
Grid Filter option 348
grid formats 30
grid interpolation
  to create strata 186
grid origin
  define 365
grid size 365
Grid Utilities
  Classify 367, 370
  Clip 371
  Clipping 367
  Convert 367, 371
  Create RGB 367, 372
  Edit 367, 373
  Fill 374
  Flip 367, 374
  Merge 374
  Overlay 375
  Replace 368, 376
  Reproject 368, 376
  Resample 368, 377
  Rotate 368, 377
  Shift 368, 378
  Split 368, 378
gridding
  theoretical discussion 362
guidelines
  for operation 8
GX
  usage with ModelVision 33
GXF
  ASEG grid format 474

H
  handles
  for selecting bodies 148
  hardcopy
    output 384
  hardcopy output 329
header
  formats 462
  in ASCII files 462
  in drillhole format 471
  in multi-line format 465
  in point format 470
  used in formats 465
height
  continuation filters 344
Help
  menu described 10
  help
    online 11
      sources available 11
HelpDir
  default help directory setting 496
Hidden
  lines of bodies 163
high latitudes 52
high pass
  description of 340
  filter described 343
  high-pass filters 525
Hole
  tool for modelling downhole data 66
horizontal derivative
  FFT filter 344
IGRF 1
  IGRF calculator 52, 262, 518, 557
immediate
  mode described 21
Import
  default import file name 497
  from external links 485
  of data 28
import
  model link 491
In Line
  introduction 337
Inclination
  set in MVPRO.INI file 500
inclination 556
  of drillhole 195
  reduction to the pole 344
inclination values 262
individual
  body responses 197
induced magnetization 558
induced magnetization intensity 263
induction
  of magnetics 52
Information
in Grid Filter 350
In-Line filter
example of use 344
In-Line Filters
introduction 344
input
of data 28
single line import 463
installation
of the software 3
installation directory 4
Intensity
set in MVPRO.INI file 500
Interleaved beds
for strata 188
International Geomagnetic Reference Field 52, 518
interpolate
feature described 361
option in data maintenance 36
interpolated
grid values 359
Intrepid
link example 488
Inversion
Free Parameters 290, 322
Limitations 281
on in-line filter 284
on Remanence 295
Parameter Variation 322
Parameters Spreadsheet 293
Performing an Inversion 321
Running the inversion 323
Strategies 280
Tolerances 292
Vertex Tolerances 294
inversion
and snapped vertices 175
in tutorial 233
using UBC software 394
Inversion Toolbar 282

J

Joint Inversion
Configure 289
Data Control 285

K

KernelDir
default filter kernels 496
keypad entry
in compute option 358

L

label
of body 149
large multi-column data 227
latitudes 52
Layout
menu described 10
pasteup area 325
Status Bar described 325
text controls in the Text Formatting Ribbon 325
tool for composition of multiple views and CAD 65
window described 324
layout
to create 325
Layout Window 134
learning
with tutorials 9
length
of traverse line 243
level shift
in tutorial 233
LevelMax
AutoMag default parameter 500
LevelMin
AutoMag default parameter 500
license
transfer 5
LIN
file extension 465, 470, 471
files used with headers 465
line
creation from a grid 37
format categories 453
lengths 379
Line Control option 252
Line Style
tool in Layout toolbar 333
Linename
specified in multi-line 465
linename
specified in multi-line 465
link
external links described 33
to external data 485
to Intrepid 488
link map windows 59
linking
vertices 174
links
overview 485
load
session files 26
Load at Startup
option for enabling the Speed toolbar 25
Local Grid option 49
location
specifying for text in Layout 334
Lock status of bodies 165
look-up
tables and loading 62
low geomagnetic latitudes 559
low latitude 556
Low Latitude filter 556
low latitudes 52
low magnetic latitudes 556
low pass
   FFT type 343
low pass filter
description 340
LUTDir
   Look-Up Table directory default 496

M

MAG3D
   UBC module 387
magnetic
   body descriptions 477
   gradient filters 340
   pseudo gravity 344
   reduction to the pole 344
   source depths - AutoMag 422
   susceptibility setting 149
magnetic anomaly
   location in AutoMag 428
magnetic field 51
Magnetic Field Parameters dialog 263
Mag3D
   error channel 392
MagUnits
   in MVPRO.INI file 500
maintenance
   of data, channels and drillholes 35
 MajAxisAnnoSize
   default setting of major axis text 497
   Multi Channel Display default parameter 497
X-Section default parameter 497
 MajAxisTicSize
   default setting of major axis tick size 497
   Default X-Section parameter 497
   Multi Channel Display default parameter 497
manual
   mode described 21
Manual/Immediate mode
   in tutorial 232
Map Configuration 86
Map Frames
   used in Layout 327
map projection 54
Map View 84
median
   filter described 341
mesh
   point values determined 362
mesh designer
   of UBC modules 398
mesh size
   of grids 361
MeshTools3D program 394
Microsoft Word files 9
mid latitudes 52
milligal
   units 50
MinAxisAnnoSize
   default setting of minor axis text 497
Default X-Section parameter 497
Multi Channel Display default parameter 497
MinAxisTicSize
   default setting of minor axis tick size 497
Default X-Section parameter 497
Multi Channel default display parameter 497
Minimum angle factor 556
minimum curvature
   described 364
   gridding 366
   operation described 366
   phase of gridding 364
mode
   of body display 164
   of Compute operation 357
Mode Control option 357
Model
   menu described 10
model
   shift operation 148
model export in DXF format 32
model files 519
Model>Drillhole Control option 255
Model>Edit Regional option 257
Model>Magnetic Field 52, 262
Model>Point Control option 256
ModelVision
   File option 26
   file output 31
   introduction 1
   rules of use 8
montaj™
   link 1, 28, 33
move
   bodies in section 148
movement of vertices 175
moving
   a frame in Layout 330
Moving average
   description of 341
Multi line
   data import 29
multi-column
   file formats 29
multi-line
   format defined 462
Multi-Track
   displays used for filter comparisons 339
   tool for detailed graphing of individual lines 65
Multi-track view 122
MVISION.INI
   default file 55, 496
MVP - compute program file type 358
MVPROJ.INI 49
N

Name
External Link default setting 497
nanoteslas magnetic field measurement 51
nearest neighbour method used in gridding 363
New project option 26
New Layout option under Window menu 325
Next Line Toolbar button 244
north magnetic pole 557
null for single line Geosoft format 463
processing with traverses 244
used in Geosoft multi line files 466
value defined for AMIRA file format 470
value defined for ER Mapper 4.x format 464
value defined for ER Mapper 5.x format 464
value defined for LIN file format 465
value definition 453
value for TK file format 462
null filling in Grid Filter 348
nulls in grids 352
number of depth passes used in AutoMag 430
number of points of traverse line 243

O

OASIS link 1, 28, 33
objects and aligning in Layout 335
and drawing order in Layout 335
and selection 8
oersted magnetic field measurement 53
On parameter switch in AutoMag 431
One body only option for body creation 140
one hole only option 195
online help 11
Open project option 26
operating instructions for UBC 390
operation rules 8
operational parameters in AutoMag 428
operator for low pass filter 340
length of filters 339
length selection 340
lengths for filters 338
of gradient filters 340
of second derivative 340
sizes of 2D filters 531
operator window used in AutoMag 430
orientation of print output 384
orientation defaults 326
outline body presentation 163
output of files 31
output grid name of 2D filters 348
output name of filter 339
Oval tool in Layout toolbar 333
overlap of bodies and selecting 148
of bodies and selection 148
Overlapping beds 188

P

Padding by row and then by column 351
padding controls 351
Padding in 2D using gridding 351
Padding margin 351
padding region of UBC modules 395
page size 326
page width 326
paper sizes for printing 384
parameter of body 149
partial link import without export of an external link 487
Pasteup area of the Layout window 325
Pasteup area 326
PDF printer 385
Pen Colour tool in Layout toolbar 333
Perspective full 3D visualisation of model, lines and surfaces 65
perspective displays 113
Perspective View UBC display 394
physical properties of polyhedra 484
pick bodies which overlap 148
platforms computer 2
plunging prism
creation 144
defined 478, 480
ing editing 169
point
data exports 32
data format 470
import 30
specified in import 470
statistics 380
point data sets 30
point set identifier 30
Pointer
Layout tool 332
pointer
cursor mode 20
mode 147
Pointer mode
in tutorial 232
Poly Edit
tool in Layout toolbar 333
Polygon
tool in Layout tools 333
polygon
creation 141
editing 169
strike length 477
polygon bodies
imported by a link 491
polygonal models
for simulating strata 186
polyhedral body 484
Polyline
tool in Layout option 333
polynomial order
of regionals 260
Prefix
of synthetic lines 193, 194
Print
File option 382
print
files 14, 382
tutorial files 9
Print Setup 14
Print Setup...
File option 384
printed page 329
Printer
error 384
layout option 326
PDF 385
setup 384
priority
of drawing objects in Layout 335
project
creation 48, 502
maintenance and clipping 37
management 26
statistics 379
project description 54
project details 49
project files 26
project.dat
projection information 54
Projection
MVPRO.INI ER Mapper default parameter 501
projection
for ER Mapper files 473
projection details 49
properties
of display of bodies 163
pseudo gravity
FFT filter 344
Pt-->Body
push button for AutoMag 434
Q
Quick Inversion 274
Toolbar button 23
R
radius
of sphere 481
spatial property 158
Recompute Fixes button 261
Rectangle
tool in the Layout toolbar 333
Redraw
option from Display toolbar 59
Reduce
phase of grid generation 364
reduce
operator described 366
reduction to the pole 557
FFT filter 344
option in AutoMag 427
Reduction-To-the-Pole 556
Reference grid 261
Reference Point
of bodies 523
reference track 127
regional
modelling for UBC 392
regional computation 259
Regional Field
Inversion 281
regional field 259
regional gravity field 259
regional grid 261
regional handles
in tutorial 230
Regional Level
in tutorial 233
regional surface 261
regional variation 259
relative
  properties of bodies 198
remanence 1
  set in MVISION.INI file 500
Remanence Calculator 306
RemanenceAzim
  set body default 500
RemanenceDip
  body default setting 500
RemanenceMag
  default body parameter 500
RemanenceRatio
  value set in MVPRO.INI file 500
remanent magnetisation 295
remanent magnetization 52, 263
remanent magnetization intensity 263
Rename
  a channel 36
reports
  creation 380
  of data 379
Resample
  see Interpolate 36
reserved
  words for Compute 357
Reshape
  Toolbar button 23
re-shape
  editing bodies 168
residual 253
Restore Displays option 27
resultant magnetization 296
reverse remanet magnetizations 263
Revert to Saved 14
Rounded Rectangle
  tool in Layout toolbar 333
Rows and Columns
  of filters 526
RPT
  report naming 380
RTP
  AutoMag option 427
RTP filter 556
RTP transform operator 557
Run
  button for AutoMag 429

S

sample interval
  of traverse line 243
sample spacing
  parameter used in AutoMag 430
Save
  project option 26
Save As button 349
Save as...
  project option 26
Save As... option 14
Save padded grid option 351
scales 330
second derivative
  description 340
Seed from Existing Grid 254
seed grid 254
seismic
  data used for strata 186
seismic section
  model import 490
Select
  2D filters 348
  channel option 123
  menu items for the Speed buttons 24
  option for 2D filters 531
select
  bodies which overlap 148
  to select bodies 148
Select All
  channel option 123
Select Bodies
  in tutorial 233
Select Fit Frame to Source Window option 330
Select Lines Active for Modelling dialog 254
Select Lines button 251
Select Points
  button 256
Selected Horizons
  of strata models 188
self-demagnetisation effects 295
Send to Back
  tool in Layout toolbar 333
  tool usage 335
Separate Header
  option of import 227
session file
  usage 26
session files 26
session of ModelVision 26
Set
  push button of the Speed toolbar 24
Settings button 351
setup
  of printers 384
SHIFT
  key usage 8
shifted
  bodies and snapped vertices 175
shortcuts 9
Show Frame Contents
  of Layout configuration 331
SI
  system of measurement 50, 53
SI units 50
similarity coefficient
  controlling display in AutoMag 433
  cut-off threshold 431
similarity coefficients
    used for anomaly locations 428
Single
    line data import 29
single
    body responses 197
Single Channel Joint Inversion
    Data Control 286
smooth
    operation described 366
smooth inversion process 389
smoothing
    of a grid 363
solid
    body presentation 163
solutions
    from AutoMag as symbols 433, 440
sound
    used to indicate snapping vertices 174
spatial properties
    dialog 158
specific scale 330
Speed
    toolbar assignments in MVISION.INI 497
    toolbar usage 23
speed
    of computing grids 362
sphere
    creation 143
    description of 481
spheroid
    for ER Mapper files 473
spikes
    and filter removal 341
spreadsheet 124
Spreadsheet table 124
square root of second deriv 340
standard
    filters 348
Standard Filters
    subset of In Line filters 337
Standard Inversion
    Configure 287
    Data Control 284
statistics
    of projects 379
Status Bar
    of the Layout window 325
StatWatch 83
step discontinuities
    in strata models 188
strata bodies 188
    creation 187
strike
    angle of 3D polygon 478
    of 3D polygon 477
    to define 477
Strike length
    option in AutoMag 427
strike length
    of bodies 158
    of polygons 169
    of tabular body 169
StrikeLength
    AutoMag default parameter 500
Strip NULLS
    for traverses 244
sun-angle filters 348
support
    described 12
surface for all bodies
    in strata models 188
SuscConst
    AutoMag default parameter 500
Suscept
    in MVPRO.INI file 499
    setting body default 500
susceptibility
    attributes of AutoMag solutions 433, 445
    magnetic - of bodies 149
SuscMax
    AutoMag default parameter 500
SuscMin
    AutoMag default parameter 500
SVGA
    graphics 3
symbols
    for AutoMag solutions 432, 440
    synchronous move button
    usage 174
Synthetic 216
    line creation from a grid 37
Synthetic Drillhole option 195
    synthetic drillholes 195, 255
T
Table Look-up mode 116
tabular
    description of 480
tabular body
    creation 144, 146
Target Wizard
    Toolbar button 41
target workspace 42
tensor
    of gravity 264, 266
tensor components 255
terrain effects
    and modelling 186
Text
    tool in Layout toolbar 333
text
    position and angle controls 334
Text Formatting Ribbon
    used in the Layout window 325
thickness
    of tabular body 481
ThicknessMax
  AutoMag default parameter 500
ThicknessMin
  AutoMag default parameter 500
thin sheet
  model type in AutoMag 427
threshold
  filter described 341
time
  to compute grids 361
TKM
  model file extension 519
tolerance limit
  for snapping 174
Toolbar
  used for the Layout window 325
Toolkit
  model files 519
Tools
  menu described 10
Tools>Inversion
    in tutorial 233
top
  parameter of AutoMag models 430
TOPO2
  import model link 492
topographic simulation 1
topography 253
topography file
  of UBC modules 398
Track Control
  of Multi-Track displays 124
track displays 124
tracks
  added in X-section displays 196
transfer the license 5
transparency slider 117
transparent
  images 116
Traverse
  alternative for creating lines 37
  Toolbar button 243
traverse
  creating channel data 244
  defining from a grid 243
trig functions 357
trigonometric
  functions in compute 357
tutorial 226
  exercises 11
tutorial data 9
tutorials
  access 9
TXT
  ER Mapper single traverse file extension (Vers.5.x) 464
Type
  default data type for External Link 497

U
  UBC GUI button 399
  UBC mesh structure 395
  UBC Model Mesh Designer
    Clear Mesh button 399
    Create button 399
    geometric factor 396
    original of the mesh 395
    Show All Cells 396
    Show Perimeter 396
  UBC software distribution 390
  UBC-GIF mesh 397
  UBC-GIF model mesh 394
  UBC-GIF programs 390
  UBC-GIF smooth inversion 388
  Undo
    edit function for Layout 324
    editing operation 324
  Undo feature 165
  units of measurements 50
  University of British Columbia 387
  UNIX and PC operating systems 390
  updates subscription
    support 12
  upward continuation
    description 341
    FFT filter 344
  Use Regional 253
  Use Regional mode 260
  Use seed grid 261
  User Guide described 11
  USGS
    binary grid file format 476
  Utilities
    in Grid Filter 349
  Utility
    menu described 10
  Utility>Synthetic Drillholes 194
  Utility>Synthetic option 192
  Utilis>Fill holes 352

V
  vertex
    adding while editing 169
    editing 169
    selection 169
  vertical component of gravity 266
  vertical derivative
    FFT filter 344
  vertical exaggeration 116
  Vertical gradient
    option in AutoMag 427
  vertices of adjacent polygons
    linking 174
  View
    menu described 10, 65
volume elements 387
voxel
  modelling 387
voxel sizes
  for UBC modelling 395

W

wavelength
  and FFT 343
  for band pass filter 340
  for high pass filter 340
  for low pass filter 340
  Nyquist frequency 339
  of filters 340
wavelengths
  of filters 338
weight the grid node 526
width
  parameter of AutoMag models 430
Window
  menu described 10
Window size
  parameter in AutoMag 431
window size
  parameter used in AutoMag 430
Windows 7 3
Windows 8 3

X

X-section
  cross section view of model, field data and model
  responses 65
  model display 72
X-section View
  Export as Georeferenced Images 83
XYZ
  format without header 465

Z

zoom
  how to 57
  mode described 20
zoom In
  option 57
zoom out
  option 57
zooms
  in Grid Filter 349